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Introduction 

Audience 
This manual is intended primarily for the SoftPath System Administrator and secondarily for all 
SoftPath system users. It provides the information necessary to set up and operate the Soft Computer 
Consultants, Inc. (SCC) SoftPath system. 

System 
SoftPath is a feature-rich, fourth-generation pathology/cytology laboratory management system. 
SoftPath manages specimens, tests, results, workflow, and follow-through procedures for even the 
most complicated surgical, medical cytology, gynecological cytology, and autopsy cases.  SoftPath is 
designed to service 50 to 1000 bed facilities with 3,000 to 200,000 surgical and cytology cases per 
year and is compatible with all other SCC laboratory systems and most HIS systems. It uses state-of-
the-art technology in both hardware and software design to provide all of the features and unique 
functions needed in a busy laboratory. 

How to Use This Manual 
This manual is both a reference tool and “how-to” guide for your SCC software. It is designed to 
provide the necessary instructions for system administrators and supplement the workstation 
NCCLS-based procedure manuals. 
Most workstations will not need a copy of the entire manual. Sections that the system administrator 
or laboratory supervisor determine to be necessary for workstation operators can be copied and made 
into a manual for that workstation. 
NOTE: The Introduction should be included in every workstation manual. 
Portions of this manual may be copied for training or for inclusion in your workstation manuals, but 
for no other purpose. 

Manual Structure 
This manual has a loose-leaf design with a modular format.  It has chapters that consist of 
numbered sections that follow the hierarchical design of the system’s menu structure. 
Each SCC system is extremely flexible and the options can be used in different ways and for 
different purposes. Although this flexibility makes the system convenient and adaptable for 
clients (e.g., clients may not need some options, or some of their fields may be optional), it 
also means that there is no single procedure for using the system that applies to everyone. 
Therefore, although this manual attempts to give as many instructions as possible, it does not 
have a step-by-step approach.  Rather, it follows the hierarchical structure of the software 
and describes each option’s capabilities, fields, and function keys.  Each client may decide 
the best way to use the system’s capabilities in order to suit their needs. 
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Each section begins with a title that indicates which menu option is covered. When possible, 
section titles reflect the wording used in the software. Each section first describes the 
purpose of the option and then gives instructions for accessing and using the option. This 
information is often followed by descriptions of individual fields, buttons, and functions 
within the window. If a field or button is not described in the section where it appears, a 
description can be found in the Common Fields and Common Button sections located in 
this chapter. These sections contain information on fields and buttons found in many places 
throughout the system. 
The color-coded Table of Contents at the front of the manual identifies the chapters 
separated by color tabs.  The detailed Table of Contents follow the color-coded Table of 
Contents and lists all of the chapters, sections, and most headings in the conventional 
manner, using indention to show the hierarchical structure of both the system and the 
manual. 

Introduction 
The Introduction provides introductory, prerequisite, and common 
information, as well as the Main Menu and its drop-down menus. 
Beginning with Chapter 1, color tabs mark all chapters; each describes a 
drop-down menu on the Main Menu. 

Chapter 1 Order 
Chapter 2 Processing 
Chapter 3 Results 
Chapter 4 Query 
Chapter 5 Reports 
Chapter 6 Setup 
Chapter 7 Utility 
Chapter 8 Work Assignment 

Page references are included throughout the manual to help you quickly find related 
instructions. 
Chapters and sections in the manual have headings, which enable the user to find specific 
information about a function, field, procedure, etc. in a particular section, without having to 
read through the entire section.  These headings are bolded throughout the manual and have 
a larger font than the rest of the text on the page.  They may also have subheadings that 
provide detailed information about the topic discusses in a particular heading.  These are also 
bolded, but in order to distinguish between the heading and the subheading, the font size is 
not increased. 
A complete index is included at the end of the manual for quick reference by subject.  All 
fields that appear on system screens are listed alphabetically under the Fields heading.  If 
you are in doubt about what data to enter into a field or what a function key does, look up the 
field or function key name in the Index and turn to the page listed to find the instructions. 

Related Documents 
The SoftSecurity User Manual contains information on defining user privileges to permit or restrict 
access to SoftPath system options and features. Ask SCC for this manual if necessary. 
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Windows Basics for SoftPath 

Using the Mouse  

Moving the Mouse 
The mouse is a computer interface that you use to tell the computer what you want to do.  
The mouse uses a roller ball to transfer the movement of the mouse to the cursor on the 
screen.  There are small rollers in the mouse against which the roller ball moves; one rolls up 
and down, and one moves right and left. 

The mouse cursor has several different shapes.  Four common cursor shapes you will use 
frequently in SoftPath are the pointer, the open arrow, the open plus sign, and the I-bar.  The 
pointer shape has a hot spot at the tip of the arrow, which you will use when pointing to and 
clicking on icons, tool buttons, or objects.  The mouse pointer changes to an open plus sign 
when it is pointing to data in a grid window. 

Pointing and Clicking 
The mouse may have two or three buttons.  Generally, the right mouse button is used only 
for specific program functions, although the mouse can be switched so that the right mouse 
button becomes the main button you use in an application.  Unless otherwise stated in this 
manual, a click of the mouse will refer to a click of the left mouse button. 
The mouse is set up to fit within the palm of your right hand; the mouse can be set up to 
accommodate left-handed users.  For a two-button mouse set up for right-handed use, when 
you rest your hand on the mouse, your index finger should comfortably reach the left mouse 
button and your middle finger should comfortably reach the right mouse button.  Lightly 
grasp the outer left and right sides of the mouse with your thumb and fourth finger. 
As a pointing tool, the mouse is used to select items on the screen.  When you point to the 
item you want to select, click the button once.  This will select the item to which you are 
pointing.  If the item is an icon, it will turn dark to indicate that it has been selected; if the 
item is a tool button, it will appear to be pressed down.  If you point to and click another 
icon or tool button, the selected icon or tool button will return to normal since it has been 
deselected.  When a new item is selected, the previous item automatically deselects. 

Double-Clicking 
To double-click, press the mouse button twice rapidly.  It might take some practice to get the 
feel for this if you have never used a mouse before.  Double-clicking can launch an 
application, close an active window, open a directory, or select a word.  When you double-
click an icon, the represented module of SoftPath will open.  You can double-click a 
highlighted record to open that record, but be aware that not all records respond to double-
clicking. 
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Clicking and Dragging 
You can move objects, such as icons, folders, and graphics, by clicking and dragging the 
mouse.  For example, to move an icon, click the icon without releasing the mouse button.  
Drag the pointer to the new location.  The icon will move along under the pointer as you 
drag.  When you release the mouse button, the icon will be dropped.  This process is similar 
to dragging paper clips across your desk with a magnet. 

Right-Clicking 
A right-click is used to open context menus.  To open a context menu, point to the desired 
item on your screen and right-click.  A context menu for that item will open. 

Movement within Screens 

Menus 
All menu options are accessible through the main menu, located across the top of the 
SoftPath Desktop window.  From this menu, you can access drop-down menus, which list 
the available commands.  If an option has a small, right-pointing arrow (8) next to it, then 
the option has a submenu.  Click that menu item to see the submenu.  Items that are not 
easily visible (e.g., “grayed”) are not available for use, due to Personnel settings or SoftSec 
permissions. 

Tool Buttons 
Tool buttons offer one-click shortcuts to many often-used options and tools.  The toolbar is 
located at the top of the window, just under the main menu. 
NOTE: When you point the mouse on a toolbar button or a field, the system displays a 

ToolTip Window explaining that button or field. 

Control Buttons 

The SoftPath program window and document windows include control 
buttons in the upper right corner of the window(s).  

To minimize the window, click the Minimize button (0).  To maximize a reduced window 
to the full screen size, click the Maximize button ( ).  The restore function makes a full 
size window smaller or viewable as a window within a window.  To restore a window, click 
the Restore button (2).  To close the window, click the Close button (r). 
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System Security 

User access to the SCC system is controlled by the sophisticated SoftSecurity system.  Only a user 
registered by the System Administrator can access selected functions.  The System Administrator 
assigns the following items to all new users: 

• An ID to be entered when you log on to the system. 
• Initials which tag all records when you enter or edit data (e.g., modifying test results 

automatically captures your initials into the test record). 
• Main Menu options accessibility (e.g., you may be allowed to enter new orders into the 

system, but not allowed to enter or edit results).  As you move about the screen, if you 
cannot access a menu or if your cursor skips an option, this indicates that you do not have 
the security privileges necessary to enter these options.  To distinguish accessible options 
from inaccessible ones, they are displayed in different colors or different levels of 
brightness. 

• Special passwords to access critical functions requiring strict security protection. 
• A list of terminals, etc., that you can use.  

User ID and Passwords 
Memorize your ID and passwords.  DO NOT give them to other users.  If you forget your ID or 
passwords, ask the LIS Administrator for assistance.  The System Administrator will introduce any 
appropriate changes in your security records and inform you of them.  If you want to change your 
password for any reason, you can use the SCC Utility function (Shift+F11).  See SCC Utility Menu 
section in this Introduction for details.  The only item that cannot be changed is your initials 
because they uniquely identify your security records and are historically attached to all of your 
transactions. 
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Logon/Logoff 

Logon to SoftPath 
To log on to SoftPath, double-click the SoftPath icon on your Windows desktop or launch SoftPath 
using the Windows Start menu. The Logon to SOFTPATH dialog box displays similar to Figure 
Intro-1.  

 
Figure Intro-1. Logon to SoftPath Dialog Box 

Press the TAB key to advance between the fields on the Logon screen; press SHIFT + TAB to 
move in reverse. 
User ID 

The system administrator assigns your user ID (identification). 
Type your user ID, usually your initials, in the field labeled User ID. 
NOTE: You can log on to SoftPath as a different user by selecting File > Log On from the 

SoftPath main menu. 
Password 

The system administrator assigns your initial password, but you may be required to select a 
new one the first time you log on. 
Type your password in the field labeled Password.  As you type your password, asterisks 
(*****) display rather than the characters you are typing.  This security feature prevents 
others from seeing your password. 
NOTE: You can change your password at any time by selecting File > Change Password 

from the main menu. The Change User’s Password dialog box displays similar to 
Figure Intro-2. Enter your current password in the Password field. Enter your new 
password in the New Password and Confirm Password fields. 
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Figure Intro-2. Change User Password Dialog Box 

Extended Security Features 
If desired, hosparams are available in SoftSecurity that dictate some extended security 
features for user IDs and passwords. For example, the system can be set to allow only the 
administrator to establish a user’s ID or the user can be allowed to define it for themselves. 
NOTE: If a new user ID is established, it must match the user ID as found in the 

Personnel Setup File in SoftPath, otherwise the user will not be able to log 
in. 

Also, passwords can be defined to have a minimum of eight (8) characters. The passwords 
may also be dictated to include a mandatory capital letter, number, and/or special character. 
When a new password meets the set criteria, the checkboxes next to the password rules on 
the change password screen will light up. The system keeps a log of the previous five (5) 
passwords used by the user and will not allow you to use one of those five passwords when 
establishing a new password. 

Command Buttons 
After you have entered your user ID and password, click the OK button or press ENTER to 
logon. 
If for any reason you decide not to logon to the system, click the Cancel button to close the 
logon screen. 
If you need help at any time during the logon process, click the Help button.  This opens the 
SoftPath Logon Help Information Message window similar to Figure Intro-3. 

 
Figure Intro-3. SoftPath Logon Help Information Window 
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To close the help information message window, click the OK button or Close (r) button in 
the upper right corner of the information box. 
NOTE: If you type your user ID or password incorrectly, or if your user ID and/or 

password have not been registered, a warning message, similar to Figure Intro-4, 
will display and you cannot enter the system. 

 

If this occurs, click the OK button or the 
close button in the upper right corner of the 
message box to close it and return to the 
Logon screen. 
Retype your user ID and password, and 
click the OK button or press ENTER to 
logon. 

 

If you are still unable to logon, contact your 
system administrator to verify your user ID 
and password. 

Figure Intro-4. Logon Warning Messages  

NOTE: Upon a successful logon, local Microsoft Word templates are automatically 
synchronized with those that appear in the SoftPath system. 

NOTE: Upon a successful logon, the system will display the previous success and 
unsuccessful login attempts on the system so you can verify the integrity of your 
installation. 

Log Off 
To log off the system, you can either choose File > Exit from the SoftPath main menu or click the 
Exit button located on the SoftPath toolbar. 
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SoftComm 

SoftComm is a user-to-user communication utility that allows you to send mail to other SoftPath 
users. Access the SoftComm utility by selecting File > User to User from the main menu. 
Alternately, you click the Mail button  located on the main SoftPath toolbar. The SoftComm 
window displays similar to Figure Intro-5. 
The top portion of the window lists mail you have received from other SoftPath users. The system 
displays the user that sent the letter, the user that the letter was addressed to, the date and time the 
letter was sent, and the current status of the letter (Read or New). The lower portion of the window 
is the preview pane. The preview pane displays the contents of the currently selected letter. 

 
Figure Intro-5. SoftComm Window 

Click any letter to select it. You can then use the options in the Action menu (see page 14) or the 
SoftComm toolbar to delete, reply to, or forward the selected letter. The preview pane displays the 
content of the currently selected letter, but you can also double-click the letter to open it in the 
Letter window, similar to Figure Intro-6. 
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Figure Intro-6. Letter Window 

Mail Menu 
The Mail menu allows you to create new letters and messages, print received messages, and 
define SoftComm options. 
New Mail/Message 

These options are used to create new letters and messages. Refer to the sections 
describing the New Mail and New Message options (see page 14) for the Action 
menu for more information. 

Print 
Select Mail > Print from the SoftComm main menu to print the currently selected 
letter. The Select Printer window displays similar to Figure Intro- 7. Select the 
printer that you want to use to print the letter from the Print To drop-down list and 
click OK. 

 
Figure Intro- 7. Select Printer Window 

Options 
Select Mail > Options from the SoftComm main menu to change your default 
SoftComm preferences and customize the way you use SoftComm. The SoftComm 
Client Options window displays similar to Figure Intro-8. After you select which 
options you want to use, click Save to save your changes. Click Close to return to 
the SoftComm window. 
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Figure Intro-8. SoftComm Client Options Window 

Show Main Window at Startup 
Mark this checkbox if you want the SoftComm window (see Figure Intro-5) 
to display when SoftPath is started. 

Display Icon in the Tray 

Mark this checkbox to display the SoftComm Mail Client icon  in the 
Windows system tray when the utility is running. You can access the 
SoftComm window at any time by right-clicking this icon and selecting 
Activate from the context menu. 

Minimize to System Tray 
If you mark this checkbox, minimizing the SoftComm window removes it 
from the Windows taskbar. However, the program continues to run and can 
be accessed at any time by right-clicking the SoftComm Mail Client icon 

 in the Windows system tray and selecting Activate from the context 
menu. 

Enable Preview Pane 
If you mark this checkbox, the preview pane will be displayed at the bottom 
of the SoftComm window, allowing you to view the content of any selected 
letter without having to open the letter by double-clicking it. 

Auto Mark as Read 
If this checkbox is marked, any new letters that are viewed by using the 
preview pane or by double-clicking have their status automatically changed 
from New to Read. 

Show Reply Fields in Open Mail Window 
If you mark this checkbox, the Reply button will be enabled in the Letter 
window that displays when you double-click a letter to open it. You can 
click this button to reply to a letter. 

Fill To and Title Fields in Reply Window 
If you mark this checkbox, the system automatically populates the To and 
Title fields when you use the Reply button to reply to a message sent to you 
by another user. 
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Display Notification When Mail Arrives 
If you mark this checkbox, the system automatically displays a notification 
when new mail arrives in your inbox. 

Check Mail During Login 
If you mark this checkbox, the system automatically checks for new 
messages during login. 

Check Mail Every (#) Second 
If you mark this checkbox and type in a number, the system automatically 
checks for new mail during the interval you specify. 

Exit 
Select Mail > Exit from the SoftComm main menu to exit the SoftComm Mail 
Client and close the SoftComm window. 

Edit Menu  
The Edit menu options allow you to copy, cut, and paste text within the SoftComm Mail 
Client. You can also use this menu to undo actions and keystrokes when editing text. 

View Menu 
The View menu options allow you to select which pane(s) will be displayed: Preview Pane, 
Toolbar, Status Bar, and/or Preview Letters. 

Actions Menu 
This menu is used to create new letters/messages, retrieve new letters, and to forward, delete, 
and reply to letters.  
New Mail 

Select Actions > New Mail to send a new SoftComm letter to another SoftPath user. 
You can also click the  icon on the SoftComm toolbar. When you select this 
option, the New Letter window displays similar to Figure Intro-9. 

 
Figure Intro-9. New Letter Window 

To 
Enter the user ID you want to send the letter to or click the  button to 
search for a specific user. After you select a user, the user’s name displays 
in the adjacent field. 

Title 
Enter the subject/topic of the letter or a brief description of the letter. 
Maximum 15 alphanumeric characters. 
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Text Area 
Enter the body of the letter in the large text field. 

Registered Mail 
Mark this checkbox if you want to send the letter by registered mail. 

Close Button 
Click the Close button to close the New Letter window without sending the 
letter. 

Send Button 
After you have entered the body of the letter, click the Send button to 
transmit the letter to the user specified in the To field. 

New Message 
Select Actions > New Message to send a brief SoftComm instant message to another 
SoftPath user. When you select this option, the New Message window displays 
similar to Figure Intro-10. 

 
Figure Intro-10. New Message Window 

To 
Enter the user ID you want to send the message to or click the  button to 
search for a specific user. After you select a user, the user’s name displays 
in the adjacent field. 

Title 
Enter the subject/topic of the letter or a brief description of the message. 
Maximum 15 alphanumeric characters. 

Text Area 
Enter the body of the letter in the large text field. 

Registered Mail 
Mark this checkbox if you want to send the message by registered mail. 

Close Button 
Click the Close button to close the New Message window without sending 
the message. 

Send Button 
After you have entered the body of the letter, click the Send button to 
transmit the letter to the user specified in the To field. 
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Check New Mail 
Select Actions > Check New Mail from the SoftComm main menu or click the 
Check New Mail toolbar button  to retrieve new letters addressed to you. The 
new letters display in the top portion of the SoftComm window and have the status 
New. 

Delete  
To delete a letter, click the letter to highlight it. Then select Actions > Delete or 
click the Delete toolbar icon  to delete the letter. The system will ask you to 
confirm the deletion. Click Yes to delete the letter or click No to cancel the deletion. 

Reply 
To reply to a letter that was sent to you, first click the letter to highlight it. Then 
select Actions > Reply or click the Reply toolbar icon  to display the Letter 
window similar to Figure Intro-11. This window allows you to create a new letter in 
order to reply to the original letter. Enter your reply to the letter in the large text area 
at the bottom of the window and click Send to send the reply. If necessary, you can 
enter a new recipient and/or title for the letter.  

 
Figure Intro-11. Letter Window 

Forward 
To forward a letter to another user, first click the letter to highlight it. Then select 
Actions > Forward or click the Forward toolbar icon  to display the Letter 
window. Enter the user that you want to forward the letter to in the To field and 
click Send. 

Mark As Read 
To mark a letter as read, first click the letter to highlight it. Then select Actions > 
Mark as Read. 
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SoftPath Main Menu 

After you log on and access the system, the SoftPath main window displays similar to Figure Intro-
12. The menu is located at the top of the window, just below the window title bar. 

 
Figure Intro-12. SoftPath Main Window 

Main Menu Option Descriptions 
File Menu 

The File menu options allow you to log on to the system as a different user and to exit the 
system. You can also use the File menu to access SoftComm, an internal communications 
program. 

View Menu 
The View menu options allow you to customize the toolbars displayed on the screen. 
SoftPath toolbars provide quick and convenient access to many important functions. You can 
customize which toolbars are currently displayed in the system by using the View menu. This 
menu contains four options (a check mark next to the option indicates that it is currently 
active): 
Toolbar 

This option shows/hides the toolbar that runs along the top of the window. This 
toolbar contains such functions as Save, Edit, New, etc. Refer to the section 
Toolbar Functions for more information on this toolbar. 

Status Bar 
This option shows/hides the status bar located at the bottom of the application 
window. The status bar displays the environment name, keyboard status, current 
time, and currently logged on user. 
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Shortcut Bar 
This option shows/hides the shortcut bar located on the left side of the application 
window. The shortcut bar provides quick access to commonly used SoftPath 
functions. You can customize the functions available from the shortcut bar. 

Notification Panel 
This option shows/hides the notification panel located on the bottom of the 
application window. The notification panel notifies a user ID of work that has been 
assigned to them. This list is constantly updating. However, the Hold button can be 
used to keep a notification available. 

Orders Menu 
The Order menu options allow you to identify patients, assign case numbers, register 
specimens, schedule and track follow up phone calls/consultations, and maintain old case 
histories. Most initial SoftPath data entry is performed using the Order options.   
See Chapter 1 – Orders. 

Processing Menu 
The Processing menu options are used to process registered specimens at the various 
workstations typically found in a pathology laboratory. Two methods are used: computer 
interactive and non-interactive. Both methods accommodate workload capturing with 
SoftWorkload™ or ODBC and logs.  
The interactive method processes the specimens with electronic worksheets, which allows 
real-time completion of the work on computer screens where the technologist enters data. 
The non-interactive method assumes that printed worksheets are created and used to 
distribute the work. The data is written on the worksheets and later batch-entered into the 
database by a technologist. The associated processing logs are produced from the data 
entered. 
See Chapter 2 – Processing. 

Results Menu 
The Results menu options allow you to enter different kinds of results information, as it 
becomes available, in the form of free text, diagnosis codes, or canned messages. 
Preliminary, Final, Supplemental, and Revised Reports can all be created from this option. 
The Results options also allow you to enter quality assurance (QA) results and sign out 
cases.   
See Chapter 3 – Results. 

Query Menu 
The Query menu options allow you to view the following information for selected cases: 
patient demographics, specimen information (including source code and name, date and time 
when the case was registered and signed out), call information, letters, priority, specimen 
adequacy codes, QA information, final diagnoses, and diagnosis groups.   
See Chapter 4 – Query. 

Reports Menu 
The Reports menu options allow you to create and print the standard system reports used on 
an everyday basis, such as worksheets, final reports, and follow-up letters.  You can also 
access all quality assurance (QA) reports and any ad-hoc reports previously created and 
saved in the ODBC or SQL report writer. 
The Reports options also allow you to view or print the various system logs. The system 
logs provide a summary of completed work by listing cases (completed or pending) at key 
workstations. System logs include: daily accessions, processed specimens, embedded blocks, 
processed blocks, special stained slides, autopsies, case statuses, parent sources, revised 
cases, daily results, deleted specimens.   
See Chapter 5 – Reports. 
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Setup Menu 
The Setup menu options allow you to define and establish the files necessary to identify and 
code stains, tests, specimen sources, locations, personnel, etc. These options allow you to 
configure the system to the way you do business in your lab. The Setup options are used 
most extensively before and during system installation.   
See Chapter 6 – Setup. 

Utility Menu 
The Utility menu options include an audit trail utility, archive utility, action entry, billing 
entry, screening evidence entry, and remote printing (including fax) control. You can also 
bridge to Microsoft Access™ to create new, or edit existing ODBC reports.   
See Chapter 7 – Utilities. 

Work Assignment Menu 
The Work Assignment menu allow you to manage the assignment of cases to specific 
personnel and provide a single option for those personnel to perform all activities assigned to 
them.   
See Chapter 8 – Work Assignment. 

Help Menu 
The Help menu options allow you to access SoftPath online help. Select the Help Topics 
option to access overview information for the current window. You can also click the Help 

 button on the toolbar and then click any field to display help information for that field. 



Introduction: SoftPath Main Menu SoftPath GUI v.4.2.1 User Manual  

Page 20   PATH4.2-G-U (6th Ed, Rel. 11/23/05) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



SoftPath GUI v.4.2.1 User Manual Introduction: System Features 

PATH4.2-G-U (6th Ed, Rel. 01/31/07)   Page 21 

System Features 

Autopsy Module 
Provisional Anatomic Diagnosis (PAD) and Final Anatomic Diagnosis (FAD) reports are 
edited in MS Word and slide processing is integrated with other case types (surgical and 
cytology). Report formats are dependent on accession base, allowing for different autopsy 
report formats. Clinicopathologic correlation is available for data entry, which in turn 
qualifies the case for autopsy QA. Autopsy QA allows the pathologist or resident to correlate 
the clinicopathologic information given with the final diagnosis. 

Entry Block IDs 
Automatic block and slide IDs are standard. 

Specimen Labels 
Labels are printed for specimens and requisition forms, and can be user-defined based on the 
accession sequence. Bar codes can also be included for quick case identification. Labels can 
be printed automatically by case type or manually printed. 

Histology and Cytology Slide Labels 
Slide labels are user-defined and can be different for each accession sequence. 

Histology and Cytology Worksheets 
Worksheets are user-defined and can be different for each accession sequence. The 
information displayed on the worksheet depends on the format setup. 

Billing 
Billing is fully automatic. The two most distinctive features of the billing procedure are the 
setup dependent charge calculation and the minimum user input for billing purposes. A large 
array of billing routines is included to accommodate a variety of users. Technical billing is 
fully automated and professional billing requires only minimal user interaction (service units 
for CPT 88300-88309). Pathology labs with more than one billing agency can set up 
different billing codes for different patient types (e.g. inpatient, outpatient). 

Text Editing 
Word-processing may be performed using MS Word editor or an RTF editor from the Case 
Results option. Context-sensitive canned messages can be inserted and edited. 

Electronic Signature 
An image of the pathologist’s signature can be stored in the system and printed on the 
reports when included in the user-defined report template. 

Remote Printing of Reports 
Remote printing is featured in all SCC LIS products. 

Direct Fax Reports 
Automatic faxing is featured in all SCC LIS products. 

Retrieval by Diagnostic Codes and Diagnosis Text 
The Complex Query option allows the retrieval of cases by diagnostic code or by key words 
in the final diagnosis or gross description. 

Automated Diagnostic Coding 
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Scanning the final diagnosis produces a list of codes that describes the diagnosis. You can 
choose from the displayed list to insert selective codes or accept all of the codes. For GYN 
cases utilizing cascading windows during result entry, the diagnosis codes can be 
automatically inserted based on the windows you select. 

Management Reports 
Management reports are incorporated in the system. All information stored in the database 
can be retrieved and used to generate charts, trending reports, and tabulated daily logs. 

Letters 
Follow-up letters can be generated for all cytology and histology cases. 

Automated QA Qualification 
The system allows automatic selection of cases for rescreen, peer review, retro-review, and 
follow up correlation. The qualification is based on the options selected during initial system 
setup. 

HIS Interface: ADT 
The availability of this interface depends on the package purchased. Admission/registration, 
change demographics, discharge, and transfer transactions are supported. In addition, the 
ability to cancel admission, merge patients, and merge admitting/billing numbers is 
supported. 

HIS Interface: Result Reporting 
The availability of this interface depends on the package purchased. The Result Reporting 
interface is standardized and provides the ability to transmit preliminary reports, final 
reports, supplemental reports, and revised reports. 

HL7 
The availability of this interface depends on the package purchased. The HL7 standard is 
used for data transmission. 

Stain QC 
The Stain QC option has the ability to capture stain batches within the system and perform 
QC. The batch number is available for the slide labels and control labels and can be printed 
with the batch. 

Stain Panels 
The system provides the ability to define stain panels for use in processing to cut down on 
data entry. The user will also have the added ability to bill the stains individually or as one 
charge dependent on the billing and stain panel setup. 

High Risk Patient 
The system has the ability to mark a patient as high risk based on the diagnosis category 
associated with the final diagnosis. A patient can also be flagged as high risk by the risk 
factors associated with the patient record. Once flagged as high risk, the patient remains in 
the high risk category until you manually change the patient status. 

Context Manager (CCOW) 
Context Manager functionality makes it possible for patient and case information to 
automatically update between different SCC products, including SoftPath. For example, data 
would appear in SoftLab just as it would in SoftPath for patients being used by both systems.  

Work Assignment  
Manager’s Dashboard allows managers to graphically assign cases using a drag-and-drop 
interface and My Workspace allows personnel to visually see and complete tasks on their 
workloads.  
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Customizable Help Screens 

An SCC Help System with the available customization feature includes HTML help pages with a 
Create/Edit Custom Help button that appears at the top of the page, as shown in Figure Intro-13. 
To add customized text to the help file, click this button. 
NOTE: This customization system does not allow users to change the help text as given to 

the client by SCC. The customization system allows users to simply add important, 
client-specific text to the top of each help topic that appears in the system. 

 
Figure Intro-13. HTML Help screen with Custom Help Button 

Once the button is selected, a password entry window appears on the screen, shown in Figure Intro- 
14. Enter the password given to you by SCC. 

 
Figure Intro- 14. Custom Help Password Entry Window 

Upon entry of the correct password, a Microsoft Word screen will appear, as shown in Figure Intro- 
15. Select the default, “SCC Help Template” text and change it to whatever you wish to enter.  
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Figure Intro- 15. Microsoft Word screen with Custom Help Template 

When your entry is complete, select the small FTP button that appears on the left side of the Word 
window. The system will ask you to confirm that you would like to upload your edited file to the 
server. Once confirmation is received, a status bar showing the progress of the upload is briefly 
displayed. Once that bar disappears, the upload is complete. The next time that particular help file is 
accessed, your edits will be included at the top of that help topic. 
NOTE: If your system is upgraded to a future version of SCC software, whatever editable 

helps you have completed during the use of the previous version will follow you to 
the new version. The customized helps are saved in a different location on your 
server than the SCC Help System and this location is not subject to the upgrade 
process. 
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Toolbar Buttons 

A toolbar is displayed in the top portion of most SoftPath windows. The buttons contained in each 
toolbar vary depending on which menu option you have selected. This section lists these toolbar 
buttons and their functions. 

 
Arrows Click these buttons to display the next or previous record. These 

buttons also allow you to move to the first record or last record in a 
list. 

 
Blood Bank Click this button to query the SoftBank database to search for 

results for the current patient. This is a READ ONLY function. 

 
Clear Click this button to clear data from all the active fields displayed. 

 
Cmpl Click this button to mark the current action for the case as 

completed. Depending on the Action Entry settings in the Options 
file, you may not be able to modify actions marked as completed. 

 
Delete Click this button to delete the currently displayed record or patient 

from the database.  
When you click the Del toolbar button, the system displays a 
message allowing you to confirm the action. 

  
If you click Yes, the system displays a message similar to the one 
below that confirms the action. If you click No then the system 
does not delete the record. 

 

 
Edit Click this button to edit the currently displayed record if it has 

already been saved in the database. 

 
Exit Click this button to exit the SoftPath application. If you have 

modified the currently displayed record, the system prompts you to 
save the data. The system then asks you to confirm that you want 
to exit the program. 

 
Find Click this button to initiate a search based on the criteria you enter 

in the available fields of a search window or tab. 

 
Help Click this button and then click any field to display help 

information for that field. 

 
History Click this button to display the processing history of the current 

case or specimen. 
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Lab Query Click this button to query the SoftLab database to search for lab 

results for the current patient. This is a READ ONLY function. 

 
Merge Click this button to merge two records for the same patient when 

information exists in the database for the same patient under two 
different MRN numbers. 

 
Mic Query Click this button to query the SoftMic database to search for 

microbiology results for the current patient. This is a READ 
ONLY function. 

 
New   Click this button to display to add a new record to the database. 

 
Open Click this button to display a search window for the current option. 

This allows you to open and then edit/view an existing record. 

 
Omove Click this button to remove a stay from a specific patient record 

and add that stay to another patient record as a new stay. 

 
Options Click this button to open the Options window, which contains the 

user-defined default settings for SoftPath. 

 
Patient Click this button to display the Patient Maintenance window, 

allowing you to add or edit SoftPath patients. 

 
Print Click this button to print the current record to a file or printer. You 

can also view the record on your screen. 

 
Query  Click this button to display a window that allows you to query the 

SoftPath database. 

 
Refresh Click this button to update the data contained in the fields of the 

current window with the most current information from the 
database. 

 
Save Click this button to writes the current record to the database. 

 
SoftWeb Click this button to activate the bridge to SoftWeb. 

 
Vmerge Click this button to merge two stay records for the same patient if 

two different billing numbers have been assigned to the patient. 

 Image 
Repository 

Click this button to open the SoftMedia Image Repository. 
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User Interface Glossary 

The following glossary defines words, phrases, and commonly used terms for user interface items 
found throughout the SoftPath system.  

 

 

Checkbox Checkboxes are used to turn a feature on or off. Click the empty box to mark 
the checkbox with an x. This indicates that the corresponding feature is 
active. You can click a marked checkbox to unmark it and remove the x. 
This indicates that the corresponding feature is inactive. Checkboxes are also 
used when more than one option in a group can be selected at the same time. 

 Close Click this button to close the current window. 

 
Drop-
Down List 

Drop-down lists contain a static list of appropriate choices for the field. To 
select an option from a drop-down list, click the drop-down list button  and 
then click the desired option. Alternately, you can use the arrow keys to cycle 
through the available options in the list. You can also type the first letter of 
the choice. Drop-down lists appear similar to that shown below: 

 

 
Browser 
Button 

Clicking this button displays a dynamic list of acceptable entries for the 
associated field. The information displays in a lookup window similar to that 
shown below. The fields in the lookup window can be used to enter search 
criteria in order to locate specific entries. The information contained in this 
list is determined by the data present in the database and parameters you 
define during setup. Also, if this button is located next to a date field, a 
calendar will display for selection. 

 

 Minimize  Click this button to minimize the window. The window name displays in the 
Windows taskbar at the bottom of your screen. 

 Maximize  Click this button to maximize the window in order to view as much of the 
window as your screen permits. 
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Option 
Button 

Option buttons provide a means of selecting one or more options within a 
group. Click the option button to activate or deactivate the corresponding 
option. Often, the system will only allow you to select one option from the 
group (i.e., when you activate an option, the other options are deactivated). 

 
Restore 
Window 

Click this button to restore a window to its original size. 

SoftPath User Interface Diagram 
Common objects found throughout SoftPath designed to enter, modify, and view data are 
shown in the diagram below. More detailed explanations of these objects can be found in the 
User Interface Glossary on page 27. 

 
Figure Intro- 16. SoftPath User Interface Diagram 
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Common Buttons 

The following buttons, which are described in alphabetical order, appear in many windows and have 
the same use in each. Therefore, they are described once here rather than multiple times throughout 
the manual. 

 The Add Record button allows you to add a new record of the appropriate 
type to the database. For example, if you access the Source option (Setup > 
Setup Files > Source) and click the Add Record button in the Source 
Lookup window, the system displays a blank Source Setup window. This 
window allows you to enter data and create a new source record. 

 
The Cancel button allows you to exit the active window or dialog box 
without executing a command or function. Clicking Cancel will cause you 
to lose any information you may have entered in any fields of that window. 

 
Click the Clear button to erase information displayed in a window without 
exiting that window.  

 Click the Comment button to display a window where you can enter free-
text comments for the current record. You can also enter canned messages 
in addition to text (if this option is defined during system setup). 

 
Click the Defaults button to view or change the settings in the Browser 
Properties window. Default settings are used each time unless you change 
the settings, either temporarily or permanently. 

 
Click the Delete button to erase the currently selected information or record 
from the database. Always use caution when deleting any information in 
SoftPath.  

 The Deselect All button de-selects all currently selected options or records. 

 
Click the Find button to execute the current search or query based on any 
search criteria you may have specified. 

 Click this button to select all items in a list or grid. Once the items are 
selected, you can use other window functions to modify, delete, or process 
the items. 

 Click this button to select the currently highlighted item in a list or grid. 
Once an item is selected, you can use other window functions to modify, 
delete, or process the item. 

 
 

Click the New button to open a window that allows you to enter new 
information and/or data records that do not yet existing in the system. For 
example, if you click the New button in the Patient Maintenance window, 
you can enter data for a new patient. 

 Clicking the Next button allows you to view additional records retrieved 
during searches. 
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Click the No button to indicate a negative response to specific questions the 
system asks you. For example, if you delete a record, the system will ask 
you to confirm that you want to delete the record. You could then click No 
to indicate that you do not want to delete the record. 

 
The OK button allows you to confirm an action or to acknowledge a 
specific system request or message. 

 The Prev button allows you to view previous records retrieved during 
searches. 

 
 

Click the Restore Defaults button to restore the original default settings 
after temporarily changing the settings for particular windows or searches.  

 Click the Run button to generate a report based on any report criteria you 
may have specified. 

 Click this button to save any new information that you have entered or to 
save any changes you have made to the existing information. 

 The Select All button allows you to select all available options or records 
without individually selecting each of them. 

 Click this button to display the User Defined Flag window similar to 
Figure Intro- 17. The available flags are defined in the User Flags option 
(Setup > User Flags). 

 
Figure Intro- 17. User Defined Flag Window 

 Click this button deselect all selected items in a list.  

 Click this button to deselect the currently highlighted item in a list. 

 Click the View button to preview reports or other printed information on 
your screen before you send it to a printer. 

 
Click the Yes button to indicate an affirmative response to specific 
questions the system asks you. For example, if you delete a record, the 
system will ask you to confirm that you want to delete the record. You 
could then click Yes to indicate that you want to delete the record. 
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Common Fields 

The following fields appear in many windows throughout SoftPath. They are described here once, in 
alphabetical order, rather than multiple times throughout the manual. 
Active Checkbox 

If this checkbox is marked, then the currently displayed record is active and available for use 
during system operations. 

Adequacy Field 
You can enter up to three specimen adequacy codes in these fields. Click the  button to 
display the Specimen Adequacy Lookup window. Select an appropriate code from the list. 

Adm (Admitting) Doctor Field 
Enter the doctor ID of the admitting doctor or click the  button to select from a list of valid 
doctors. 

Allowed Case Types Area 
Mark the appropriate checkboxes to indicate which cases to include in this search, report, or 
record. A maximum of 4 case types can be selected.  

 
Figure Intro-18. Allowed Case Types 

Billing # Field 
Enter the billing number for the patient’s stay. SoftPath automatically generates a billing 
number if you leave this field blank, but you can manually enter a billing number if 
necessary. 

Body Site Field 
Enter the body site where the specimen source is located on the patient. Click the  button 
to select from a list of valid body site codes. 

City Field 
Enter the name of the city for the address. Maximum 14 alphanumeric characters. 

Clinic or Clinic ID Field 
Enter a unique clinic ID code. Click the  button to select from a list of valid clinic codes. 

Code Field 
This field is used to enter a unique identifier in dynamic list lookup windows to locate 
specific records or codes. 

Coll. Method 
Enter the collection method code that describes how the specimen was procured (e.g. biopsy, 
surgical procedure, etc.). If a collection method is associated with a source, the default 
collection method code is automatically entered when you enter a source code if this feature 
is set up in the Source file. To select a collection method, click the  button to display the 
Collection Method Lookup window. Select the appropriate code from the list. 
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Comment Field 
Enter a free-text comment in this field related to the current record or information. 

Doctor or Doctor ID Field 
Enter a unique doctor ID code or click the  button to select from a list of valid doctors. 

Done By Field 
Enter the user ID of the person performing the procedure. Click the  button to select from a 
list of valid ID codes for this field.  

Employee ID Field 
Enter a unique employee ID code or click the  button to select from a list of valid 
employees. 

Employee Type Drop-Down List 
Select an employee type from the drop-down list. 

First Name Field 
Enter the first name of the employee, doctor, or patient depending on the current window 
and the information required. Maximum 13 alphanumeric characters. 

Last Name Field 
Enter the last name of the employee, doctor, or patient, depending on the current window 
and the information required. Maximum 17 alphanumeric characters. 

Marital Status 
Select the current marital status of the patient from the drop-down list. 

Modifier Field 
If the source code does not adequately define the source, enter an additional free-text 
definition. If the source files are constructed with only the basic source types, the modifier is 
required in order to provide a specific description of the source. Maximum 44 
alphanumeric characters. 

Middle Name Field 
Enter the middle initial of the employee, doctor, or patient, depending on the current window 
and the information required. 

MPI 
Search by, or electronically accept, the MPI (Master Patient Index) number. Maximum of 
13 alphanumeric characters.  

# of Pieces 
Enter the number of pieces submitted for the specimen that were received during specimen 
registration. The default is zero (0). Maximum 3 numeric characters. 

Pathologist Field 
Enter a pathologist ID or click the  button to select from a list of valid pathologists. 

Phone Field 
Enter the appropriate phone number using the format (xxx) xxx-xxxx. Maximum 10 
numeric characters. 

Previous Last Name Field 
Enter the previous last name of the patient (e.g., a maiden name). 

Priority Field 
Click the drop-down list button to display a list of options: Routine, Stat (Rush), 
Undetermined, and Priority. Select the appropriate priority from the drop-down list.  
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Procedure D&T Fields 
Enter the procedure date and time. These fields indicate the date and time the procedure was 
performed. This information can be entered manually or you can click the  button to 
display a calendar to make a selection. Maximum 8 numeric characters using the 
mm/dd/yyyy format. 
NOTE:  Only dates equal to or prior to the current date and time will be accepted in this 

field. 
Processing Problems Fields 

You can enter up to three processing problem codes in these fields. Click the  button to 
display the Processing Problems Lookup window. Select an appropriate code from the list. 

Received D&T 
Enter the date and time that the specimen was received. This can be entered manually or you 
can click the  button to display a calendar to make a selection. Maximum 8 numeric 
characters using the mm/dd/yyyy format. 
NOTE:  Only dates equal to or prior to the current date and time will be accepted in this 

field 
Requested By 

Select either Pathologist or Physician from the drop-down list. If you select Pathologist, 
the dynamic list for the adjacent ID field contains all active ID codes that are defined as 
pathologists in the Personnel setup file. If you select Pathologist, the dynamic list for the 
adjacent ID field contains only doctors defined in the Doctor file. Click the  button and 
select an appropriate requesting physician/pathologist from the list. This field is required. 

Req. Doctor Field 
Enter the doctor ID code of the requesting doctor or click the  button to select from a list of 
valid doctors. 

Registration D&T Field 
The registration date and time defaults to the current date and time for all new cases. This 
information can be modified if necessary. These fields indicate the date and time the case 
was registered. 

Resident Field 
Enter the resident ID of the case or click the  button to select from a list of valid resident 
ID codes. You can enter up to four resident ID codes per case. 

Signout Level Field 
Select the level for signout privileges from the following: 
• Level I - Technologist 
• Level II - Supervisor 
• Level III - Pathologist 
The level entered for the current personnel record restricts the user from signing out cases 
where the diagnostic coding has been assigned a level higher than the user's settings. 
For example, if an employee has a sign out level of I-Technologist. The current case 
pending sign out has an associated diagnosis code with a level of II-Supervisor. In this case, 
the system will not allow the I-Technologist to perform the sign out, thereby, limiting the 
sign out based on the diagnosis of the case. 
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Soundex Field 
Soundex is a tool that can be used when the exact spelling of a name is not known. You can 
enter a name that sounds similar to the one you want to locate to retrieve all records with 
names similar to the soundex specified. However, the first letter of the last name has to be 
correct. 

Source Field 
Enter the source of the specimen or click the  button to select from a list of valid source 
codes.  

Specimen ID or Spec ID Field 
This field displays the specimen designation within the case as either a numeral or alphabetic 
character, depending on the initial system setup or the setup for individual clients defined in 
the Client Profile setup file. 

State Field 
Enter the name of the state using the appropriate two-letter U.S. General Post Office 
abbreviation. Maximum 2 alphabetic characters. 

Street Field 
Enter the street address. Maximum 22 alphanumeric characters. 

Tag Letters Field 
Select up to three tag letters from the drop-down list. Tag letters are defined during file setup 
using the Simple Codes option. 

Title Field 
Enter the professional title used by the doctor or employee (e.g., MD, Ph.D., MD 
Pathologist). Maximum 36 alphanumeric characters. 

Total Specimens 
This field displays the total number of specimens for the current case. 

Zip Field 
Enter the ZIP code 
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Chapter 1. Order 

The Order menu options allow you to identify and maintain patient information, assign case 
numbers, and enter old cases from paper files. These options also allow you to schedule and track 
follow-up phone calls and consultations.  

 
Figure 1-1. Order Menu 
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SoftPath Order Menu Options 
The SoftPath Order option contains the following features and applications: 

Receiving/Accessioning 
To keep track of orders coming in and going out of your facility, whether you are online or 
not, select the features in Receiving/Accessioning.  
See Chapter 1.1—Order: Receiving/Accessioning. 

Specimen Registration 
To register specimens for all available case types, including MED, GYN, Surgical, and 
Autopsy, select Specimen Registration.  
See Chapter 1.2—Order: Specimen Registration. 

Call List Requests 
To identify cases with pending telephone calls, select Call List Requests.  
See Chapter 1.3—Order: Call List Requests. 

Consultations 
To track the consultation activity coming in and going out of your facility, select 
Consultations.  
See Chapter 1.4—Order: Consultations. 

Patient Maintenance 
To register, edit, and view patient information, including demographic and insurance data, 
select Patient Maintenance.  
See Chapter 1.5—Order: Patient Maintenance. 

Old Cases 
To enter old cases from your facility’s existing paper files, select Old Cases.  
See Chapter 1.6—Order: Old Cases. 

 



SoftPath GUI v.4.2.1 User Manual Chapter 1.1 – Order: Receiving/Accessioning 

PATH4.2-G-U (6th Ed, Rel. 01/31/07)  Page 1-3 

Receiving/Accessioning 

The Receiving/Accessioning options allow you to keep track of orders coming in and going out of 
your facility, whether you are online or not. 

 
Figure 1-2. Orders - Receiving/Accessioning Sub-Menu 

The Receiving/Accessioning menu contains the following sub-options: 
• Receiving/Accessioning 
• Down Time 
• Delete Orders 
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Receiving/Accessioning  

The Receiving/Accessioning option is available for facilities that have a pathology order entry 
interface with the Hospital Information System (HIS). The Receiving/Accessioning option allows 
you to receive and accession specimens, which can be run separately or combined into one process.  
To access the Receiving/Accessioning option, select Order > Receiving/Accessioning > 
Receiving/Accessioning from the main menu. The Receiving/Accessioning - Lookup window 
(Figure 1-3) is displayed. 

 
Figure 1-3. Receiving/Accessioning - Lookup Window 

Before performing a search for the cases(s) that you want to receive/accession, you must select a 
mode. To select a mode, mark the appropriate checkbox(es) in the Mode area.  
• Receiving: Mark the Receiving checkbox to generate a list of cases entered into the system 

through HIS Order Entry Interface. 
• Accessioning: Mark the Accessioning checkbox to generate a list of all cases that have been 

marked as Received in the system. This option bridges you directly to the Specimen 
Registration window on a case-by-case basis. 

• Marking both checkboxes generates a combined list, which allows you to mark the case as 
received and then bridge to the Specimen Registration window to register the case.  
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After selecting a mode, enter search criteria for the case(s) that you want to receive/accession and 
click Find. The system displays a list of orders that match the specified criteria on the Orders tab. 
The Orders tab displays the details of the information received from the HIS, including the status (R 
for received), HIS number, patient name, originating clinic, date and time of order, and case type. 
Select a case and click the Info button to display the Order Information tab, which contains 
demographic information for the selected case. To return to the list of cases, click the Orders tab. 
NOTE: Clicking the More button displays the next series of cases that match the specified 

search criteria. 

Receiving Mode 
Select the orders you want to receive by highlighting the cases and clicking the Mark Sel button. 
Click OK. The system prompts you to confirm that you want to receive the orders. If you click Yes, 
the cases will be marked as received (R) and will qualify for the Accessioning mode list. 

Accessioning or Receiving/Accessioning Mode 
Select the orders you want to accession by highlighting the cases and clicking OK. The system 
prompts you to confirm that you want to accession the cases. 
If you click Yes, the system displays the Specimen Registration window to allow you to complete 
the accessioning. See page 1-11 for more information about the Specimen Registration window. 
After completing specimen registration, close the Specimen Registration window to return to the 
Receiving/Accessioning window. The accessioned order is updated and removed from the list.  
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Down Time  

When the HIS system is unable to send orders electronically, you can manually accession orders and 
merge them with the HIS order when the transmission occurs. If the order number is entered 
incorrectly during manual accessioning, it can be corrected using the Down Time menu option. 
After the correction is made, the Down Time window can be used to merge the HIS order with the 
manually accessioned order.  
To access the Down Time option, select Order > Receiving/Accessioning > Down Time from the 
main menu. The Down Time - Lookup window (Figure 1-4) is displayed. 

 
Figure 1-4. Down Time - Lookup Window 

Enter search criteria to locate the appropriate orders and click Find. A list of orders displays on the 
Orders tab. To correct the order number, highlight the order and click the Info button. The Order 
Information tab displays. Enter the correct order number in the Order field and click the Orders 
tab to return to the orders grid. Click OK to merge the corrected order.  
A dialog box displays asking you to confirm the merger. 
Click Yes to merge the current order and removed it from the orders grid, or click No if you do not 
wish to merge the current order. 
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Delete Orders 

The Delete Orders option allows you to delete orders from the database. You can only delete 
Received and Not Received orders. 
To access the Delete Orders option, select Order > Receiving/Accessioning > Delete Orders from 
the main menu. The Delete Orders - Lookup window (Figure 1-5) is displayed.  

 
Figure 1-5. Delete Orders - Lookup Window 

Enter search criteria to locate the order(s) you want to delete, and click Find to display a list of 
matching orders on the Orders tab. The Delete Orders message (Figure 1-6) is displayed.  

 
Figure 1-6. Delete Orders Message 

Click OK. A list of orders retrieved by the search is displayed on the Orders tab. Select the order(s) 
you want to delete and click Delete. The system asks you to confirm the deletion; click Yes to delete 
the current order or No if you do not want to delete the current order.  
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Specimen Registration  

The Specimen Registration window is used to register cases and specimens for all case types 
(Surgical, Medical Cytology, Gynecological Cytology, and Autopsy). The Specimen Registration 
window also allows you to enter incoming consultations, order letters, order and place calls, process 
specimens, print labels, and view patient history. 
When you register a new specimen, the system automatically generates the next available accession 
number for each predefined case type or you can enter the number manually. Because of processing 
differences, surgical pathology specimens, medical cytology specimens, and gynecological cytology 
specimens should be registered under separate accession bases. 
The Specimen Registration window operates in three modes (add, edit, and read), allowing you to 
add new records, edit existing records, or read (but not modify) records. A case can be deleted only 
by a person with the proper authorization and only if the conditions specified in the Options file for 
case deletion are met. The accession numbers of deleted cases can be reused within the time frame 
specified in the Options file. 
To access the Specimen Registration sub-menu, select Order > Specimen Registration from the 
main menu.  

 
Figure 1-7. Specimen Registration Sub-Menu 
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This Specimen Registration sub-menu contains six specimen registration options: 

Custom Registration 
All Cases 

Use this option to register all case types using the User Designed 
Registration Windows.  For further information, see Setup/Custom 
Registration Setup. 

All Cases Use this option if there is more than one type of case (surgical, MED 
cytology, or GYN cytology) to register in one session. New autopsy cases 
cannot be added using this option. 

MED Cytology 
Specimens 

Use this option to register specimens for MED cytology cases. This 
allows you to use the default accession sequence for MED cytology. 

GYN Cytology 
Specimens 

Use this option to register specimens for GYN cytology cases. This 
allows you to use the default accession sequence for GYN cytology. 

Surgical Specimens Use this option to register specimens for surgical pathology cases. This 
allows you to use the default accession sequence for surgical pathology. 

Autopsy Cases Use this option to register specimens for autopsy cases. This allows you 
to use the default accession sequence for autopsy cases. This option can 
also be used as a death registration log if an autopsy is not performed. 

Once you select an option, the Specimen Registration Lookup window (Figure 1-8) is displayed.  

 
Figure 1-8. Specimen Registration Lookup Window 

Enter search criteria to locate the patients for which you want to register specimens.  
Using the Lab Order Number field to search allows you to retrieve case information from the Lab 
database. When used as an exclusive search field, the system will import the Lab order information, 
which includes Patient Stay information, Requesting Doctor, Collected Date and Time, Copies To, 
and any SoftLab Order comments.  
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NOTE:   The system displays patients or cases depending on the search criteria you enter. If the 
accession base is used as part of the search criteria, the system displays cases that match 
the criteria. If only patient data (such as a last name) is used during the search, the 
system displays patient records that match the criteria. 

Click Find and the system displays a list of patients matching the entered search criteria on the 
Patients tab at the bottom of the screen.  
Click the Add Patient button to add a new patient. This system bridges you to the Patient 
Maintenance window where you can add the patient (see page 1-77). Once the new patient is added, 
the patient record becomes available for specimen registration.  
To register specimens for an existing patient, highlight the patient record and click OK. A list of 
stays for the selected patient displays on the Stays tab (Figure 1-9).  

 
Figure 1-9. Specimen Registration Lookup Window - Stays Tab 

The Stays tab consists of a grid containing the following information: billing number, clinic, 
admitting doctor ID, attending doctor ID, admission date, and discharge date.  
NOTE: If a prior stay is selected that does not have a clinic ID assigned, the system will require 

the user to update the stay information in Patient Maintenance before it can be selected. 
Click Add Stay to add a new stay for the patient. Click Yes when prompted to bridge to the Stays 
tab of the Patient Maintenance window. You can use this tab to add a new stay. After the new stay 
is added, the stay record becomes available for specimen registration.  
To register specimens for an existing stay, highlight the stay and click OK. A list of cases for the 
selected stay displays on the Cases tab (Figure 1-10).  

 
Figure 1-10. Specimen Registration Lookup Window - Cases Tab 
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The Cases tab consists of a grid that contains the following information: case Number, order date, 
requesting doctor ID, pathologist, and sign out date. Click the Add Case button to display the 
Accession Sequence Lookup window. Select an accession sequence to create a new case for the 
currently selected patient/stay.  
Based on the setting Number of Days Lookback for Existing Cases for Patient (See Chapter 6 – 
Setup: Options – Specimen Registration Tab – Standard Settings, Cont. Tab) if the system 
finds an earlier case for the same patient that falls within the number of days defined, an 
informational message similar to the following is displayed listing the case number and the assigned 
pathologist’s ID allowing the user to assign the new case to the same pathologist, if desired: 

 
NOTE: If a pathologist was not assigned to the previous case, the displayed message will say 

that the case the assigned to “unknown.” 
To register specimens for an existing case, highlight the case and click OK. The Specimen 
Registration window (Figure 1-11) is displayed with data for the selected patient and case type. 

 
Figure 1-11. Specimen Registration Window 
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Patient demographics display at the top of the window. The remainder of the window consists of 
series of tabs; the available tab types depend on the type of case you are registering. The Specimen 
Registration window shown in Figure 1-11 is for a MED cytology case. Most of the tabs displayed 
are for all case types, but there are some unique tabs for specific case types; these tabs include: GYN 
Info, MED Info, Body Release To, and Autopsy Info. To view all of the tabs, press the View All 
Tabs button located on the tool bar. 
NOTE: To prevent static updates from being made to your system through the CCOW interface, 

click the Leave Context button found on the main toolbar in Specimen Registration. 
Once selected, this button will turn into the Rejoin Context button, which is used to 
return your system to CCOW updating. 

To edit an existing case, perform a search for the case in the Specimen Registration Lookup 
window. When the Specimen Registration window displays for the specified case, click the Edit 
button on the toolbar. Enter the desired changes and click the Save button on the toolbar. If a case 
has been signed out, it cannot be edited. 
The Specimen Registration window can contain a combination of the following tabs: 

• Case Data Tab 
• Specimens Tab 
• Calls Tab 
• Undergo QA Tab 
• Patient History Tab 
• Other Case Data Tab 
• MED Info Tab 
• Letters Tab 

• Accounting Tab 
• Adequacy Problems Tab 
• Incoming Consultation Tab 
• Risk Factors Tab 
• HIS Numbers Tab 
• Body Release To Tab 
• GYN Info Tab 
• Autopsy Info Tab 
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Case Data Tab 
The Case Data tab (Figure 1-12) contains information concerning the selected case. 

 
Figure 1-12. Specimen Registration Window - Case Data Tab 

Total Spec. 
Enter the total number of specimens to be submitted. When any number greater than one (1) 
is entered, the Specimen tab displays for specimen data entry. When zero (0) is entered, the 
Incoming Consultation tab displays for consultation data entry. 

Received D&T 
Enter the date and time that the specimen was received. This can be entered manually or you 
can click the  button to display a calendar to make a selection. By default, the system 
inserts the current date and time in this field. Maximum 8 numeric characters using the 
mm/dd/yyyy format. 

# of Pieces 
Enter the number of pieces of the specimen that were received during specimen registration. 
The default is zero (1). Maximum of three numeric characters. 
NOTE: This field only applies to surgical and autopsy cases. 

Multiple Pieces 
Mark this check box to flag the specimen for multiple (uncounted) pieces. When this check 
box is marked, the Number of Pieces field is disabled. 
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# of Slides 
Enter the number of slides received during specimen registration. If the number of slides has 
been defined in the source associated with the case, the system automatically inserts this 
information in the field. Maximum of three numeric characters (depending on the 
numbering convention of slides specified during the initial system setup, this field may only 
contain a maximum of two numeric characters).  
NOTE: This field only applies to gynecological cases. 

Special Tests Button 
Clicking this button displays the Special Tests window (Figure 1-13). Enter a special 
stain/test for each specimen code. The field automatically defaults to the special stain/test 
assigned to the specimen in the Source setup file (if defined).  
Click the  button for each field to display the Special Stains/Tests/Stain Panel Lookup 
window. Select a special stain/test from the list. Materials selected for the case are applied in 
the Fast Processing option. 

 
Figure 1-13. Special Tests Window 

Lab Tests Button 
Click this button to display the Laboratory Tests window (Figure 1-14), which allows you 
to enter the test codes for tests expected from the SoftLab system. Once those tests are 
resulted, results will be made available for inclusion in SoftPath reports in Results Entry. For 
more information, see Chapter 3.1 – Results: Results Entry – Lab Results Button. Click 

 to display the Lab Tests Lookup window and select the appropriate code from the list. 
NOTE: This option does not order lab tests. It only retrieves results (if available) from 

the SoftLab module. 

 
Figure 1-14. Laboratory Test Window 
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Micro Tests Button 
Click this button to display the Micro Tests window (Figure 1-14), which allows you to 
enter the test codes for tests expected from the SoftMic system. Once those tests are resulted, 
results will be made available for inclusion in SoftPath reports in Results Entry. Click  to 
display the Micro Tests Lookup window and select the appropriate code from the list.  See 
Chapter 3.1 Result Entry:  Micro Results button 
NOTE: This option does not order Micro tests. It only retrieves results (if available) 

from the SoftMic module. 

 
Figure 1-15. Micro Test Window 

Gross Description Button 
Click this button to display the Gross Description window (Figure 1-16), which allows you 
to enter Gross Description information such as the color, volume, and appearance of the 
specimen. This information will be included in the gross description section of any reports 
for this case. 
NOTE:  This button is only available for MED cytology and autopsy cases. 

 
Figure 1-16. Gross Description Window 
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Source Flags Button 
Click this button to display the Source Flags window (Figure 1-17). These flags use the 
same descriptions as those in other sections (e.g. IOC, GIO, specimen adequacy, tag letters, 
etc.). The source flags entered are associated with the specimen and NOT the case level. 

 
Figure 1-17. Source Flags Window 

Specimen Adequacy 
Enter up to three specimen adequacy codes in these fields. If needed, click the  button to 
select from a list of valid adequacy codes. If any specimen adequacy codes are entered, the 
Info button becomes active; click the Info button to display a free-text comment window 
where you can enter additional information about the specimen adequacy. 

Specimen Processing  
Enter up to three processing problem codes in these fields. If needed, click the  button to 
select from a list of valid process problem codes. 

Specimen Photography 
If you mark this checkbox, the adjacent Info button becomes active. Click the Info button to 
display a free-text comment window for entering specimen photography comments. 

Specimen Radiography 
If you mark this checkbox, the adjacent Info button becomes active. Click the Info button to 
display a free-text comment window for entering specimen radiography comments. 

Delayed Dissection 
If you mark this checkbox, the adjacent Info button becomes active. Click the Info button to 
display a free-text comment window for entering comments regarding delayed dissection. 

Gross Description Only 
Enter the number of specimens that are examined for gross description only. If you enter a 
value, the case will not be pending for final result entry.  

Extensive Gross Description  
Mark this checkbox if the case has had an extensive gross description performed. This flag is 
used in the SoftWorkload™ module. 

Gross Assistance 
Mark this checkbox if the pathologist is required to assist in performing the gross description 
for this case. This flag is used in the SoftWorkload™ module. 
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Specimens Tab 
The Specimens tab is used to register specimens for the current case. The Specimens tab contains a 
grid that displays specimen ID, source code, source description, body site, and collection method. 

 
Figure 1-18. Specimen Registration Window - Specimens Tab 

Add Specimen Button 
Click the Add Specimen button to add a new specimen to the case. A duplicate of the first 
or previous specimen is added to the grid, depending on the settings specified in the Options 
file. To change the source, click the  button next to the Source field and the Source 
Lookup window is displayed; select the appropriate source code from the list. The Source 
field and grid are updated to reflect the changes. 

Del. Specimen Button 
To delete a specimen, highlight the specimen in the grid and click the Del Specimen button. 
The system asks you to confirm the deletion. Click Yes to delete the specimen and remove it 
from the grid or No to cancel the action. 
NOTE:   The deleted specimen log captures specimens that were previously saved with 

the case and then later deleted. If a specimen is added and then deleted without 
being saved, it will not be included in the Deleted Specimen Log. If you want a 
comment concerning the deletion to print on the Deleted Specimen Log, enter an 
appropriate specimen comment before deleting the specimen. 
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# of Smears (GYN Cytology Cases Only) 
This field only displays if you are registering a GYN cytology specimen. Enter the number 
of PAP smears associated with this specimen. 
NOTE: This field is replaced with the # of Pieces and Multiple Pieces fields when you 

are registering specimens for cases types other than GYN cytology.  
Special Tests Button 

Click this button to display the Special Tests window (Figure 1-13). 
Lab Tests Button 

Click this button to display the Laboratory Test window (Figure 1-14). 
Micro Tests Button 

Click this button to display the Micro Test window (Figure 1-15). 
Gross Description Button 

Click this button to display the Gross Description window (Figure 1-16). 
Source Flags Button 

Click this button to display the Source Flags window (Figure 1-17). 
Labels Button 

Click the Labels button to display the Label Print window (Figure 1-19), which allows you 
to print a label, save a label to an electronic file, or unflag all of the labels (allowing you to 
make the labels pending for printing). 

 
Figure 1-19. Label Print Window 

Print Labels Button 
Click this button to display the Select Printer window. Select the server you want to 
print from in the Server drop-down list and then select the printer you want to use to 
print the report. Click Print to send the labels to the specified printer. 



Chapter 1.2 – Order: Specimen Registration SoftPath GUI v.4.2.1 User Manual 

Page 1-22  PATH4.2-G-U (6th Ed, Rel. 01/31/07) 

Processing Button 
Click the Processing button to display the Specimen Processing window (Figure 1-20). The 
Specimen tab contains information concerning the current specimen. You can use this tab to 
add or change the number of blocks, smear slides, etc., for the current specimen. 

 
Figure 1-20. Specimen Processing Window 

Processing Button - Specimen Processing Window – Specimen Tab 
Complete 

Mark this checkbox if processing is complete for the specimen. 
Primary Block 

Enter the total number of blocks created for each specimen received for the case 
during initial specimen processing.  

Cell Block 
Enter the total number of cell blocks created for MED cytology and autopsy cases. 
This number is used in processing to capture workload and billing information. 

FS Block 
Enter the total number of frozen section blocks. This number is used to capture 
workload and billing information and determines whether the status of the case will 
be pending for IOC entry. 

FS D&T 
Enter the date and time the frozen section was reported to the surgeon.  This field 
will default to the current date and time when the first FS block is entered but is 
modifiable.  This field is used in the calculation of the FS TAT report. 

Regross Block 
Enter the total number of blocks created in addition to the regular blocks. Regross 
blocks are processed in the same manner but are not added to the regular blocks. 
Regross blocks will also have a different slide labeling nomenclature (this is 
dependent on your Hosparam settings). 

Membrane Filters 
Enter the total number of membrane filters used with the MED cytology specimens 
for both MED cytology and autopsy cases. This number is used during specimen 
processing and to capture workload and billing. 
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Cytocentrifuges 
Enter the total number of cytocentrifuge slides prepared for the medical cytology 
specimens for both MED Cytology and Autopsy cases. This number is used to 
capture workload and billing. 

Smear 
Enter the total number of smear slides prepared for this specimen. 

Monolayers 
Enter the total number of monolayers prepared for this specimen. 

Touch Prep 
Enter the total number of touch preps prepared for this specimen. This field is only 
available for surgical cases. 

Defaults Button 
Click this button to have the system enter the default values defined for this 
specimen into the appropriate fields. 

Stains Buttons 
The Stains buttons allow you to add or delete standard and special stains. These 
buttons become active when any value greater than zero (0) is entered in the 
Membrane Filters, Cytocentrifuges, Smears, Monolayers or Touch Prep fields. 
Clicking these buttons displays the Stain Slides window (Figure 1-21), which lists 
all stain slides for the current specimen. When values in any of the above mentioned 
fields are modified, the grid in the Stain Slides window is updated. 

 
Figure 1-21. Stain Slides Window 
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Processing Button Specimen Processing Window – Blocks Tab 
This Blocks tab is used to process specimen blocks. 

 
Figure 1-22. Specimen Processing Window - Blocks Tab 

Number of Pieces 
Enter the number of pieces submitted for the selected block.  

Multiple Pieces 
Mark this check box to flag the specimen for multiple (uncounted) pieces. When this 
check box is marked, the Number of Pieces field is disabled. 

Complete Cutting 
Mark this checkbox if the block has been completely used. 

Embed/Unembed 
Click the Embed button to change the block status from Prepared to Embedded. If 
the block status is Embedded, click Unembed to change the status to Prepared. 

Add Slide Button 
To add new slides to the block, enter the number of slides you want to add in the 
adjacent field and click Add Slide. If the block has the status Prepared, the system 
asks you to change the status to Embedded before adding slides with the message 
“Block Not Embedded. Confirm Embedding?” Click Yes to embed the block and 
add the new slide(s) or No to cancel the operation. 

Add Recut Button 
 Click this button to add a Recut to the selected block. 
Delete Last Slide Button 
 Click this button to delete the last slide from the selected block. 
Update Last Slide Button 

Click this button to update the last cut slide in the selected block with the value 
entered in the adjacent field.  
For example, assume that the selected block has one slide cut erroneously that 
should have been a 7. Rather than deleting and then adding a new slide, enter 7 in 
the field adjacent to the Update Last Slide button. Click the Update Last Slide 
button to replace the entry of 1 with the new entry of 7. 
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Add Default Slide Button 
Click this button to add the default number of slides to the selected block. The 
default value is defined in the Source file. 

Block Flags 
Click Block Flags on to display the Block Flags window (Figure 1-23). Use this 
window to attach the appropriate flags to the selected block. 

 
Figure 1-23. Block Flags Window 

Block Code 
This field displays the sequence code for the selected block. 

EM Block 
Mark this checkbox if the block should be processed for electron 
microscopy studies. 

Cryo Tissue Bank 
Mark this checkbox if the selected block should be sent to the cryogenic 
tissue bank. 

Decal Block 
Mark this checkbox to tag a specific block for the decalcification procedure. 
If you mark this checkbox, the workload units (for SoftWorkload™) and 
billing charges will be captured. 

Block with B5 
Mark this checkbox to tag the block for a B5 procedure. If you mark this 
checkbox, the workload units (for SoftWorkload™) and billing charges will 
be captured. 

Control Reference 
Mark this checkbox if the block is suitable for use as a stain control block. 
Click the  button to display the Special Stains/Tests Lookup window and 
select the required stain code for the block from the list. 

Cell Suspensions 
Mark this checkbox if the block was produced from a suspension. 
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Hold for One Day 
Mark this checkbox to hold the block until the next day. In the Options file, 
you can specify that you want the block to be released after 24 hours. If this 
setting is not active, the block will not be released. 

Canceled 
Mark this checkbox to stop the block processing. The system removes the 
block from all further processing procedures and worklists. All of the billing 
charges and workload activities are captured and incurred up to this point.  
To cancel a block after the night billing run or after labels have been printed, 
all labels and recuts must first be removed. A block can only be canceled 
after all the slides and stains are removed. A credit is automatically captured 
if the block has been canceled prior to the first billing/workload run. You 
can manually credit previously billed blocks by using the Billing Entry 
option.  

Completely Used 
Mark this checkbox to indicate that the whole block/specimen was used 
during the procedure and that no further processing is possible. 

Fixatives 
Select the fixatives used when applying a specific fixative to a given block 
other than the standard fixative. Click the drop-down list button to display a 
list of defined fixatives. The available fixatives are defined in the Simple 
Codes option. Up to three fixatives can be selecte. 

Number of Recuts 
The Number of Recuts field displays the number of previously ordered 
recuts. This is a READ ONLY field. 

Number of Restains 
The Number of Restains field displays the number of previously ordered 
restains. This is a READ ONLY field. 

Stains Button 
The Stains buttons allow you to add or delete standard and special stains. Refer to 
the description of the Stains button on page 1-23 for more information 
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Calls Tab 
The Calls tab (Figure 1-24) allows you to order call requests for results of the current case. 

 
Figure 1-24. Specimen Registration Window - Calls Tab 

Add Button 
Click the Add button to add a new call. A new row displays on the grid allowing you to 
enter data concerning the new call. 

Delete Button 
Click this button to delete the currently selected call. 

Call Type 
Select the type of call from one of the following: 

 Call Results - Select this option if the call should be performed after sign out. 
 Reminding Call After Days  - Select this option if the call should be performed on 

a specified date. Enter the date in the On field or enter the number of days after 
which the call should be performed in the other field. 

Called 
Mark the Called checkbox if the call has been performed. This activates the fields in the 
Called area. 
The date and time the call was completed and the ID of the person that performed the call is 
displayed in the Called section. The system automatically inserts the current date and time in 
this field. This information cannot be modified on this tab.  
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The Confirmation field is a free-text field that allows you to enter the name of the person 
who received the call (maximum 60 alphanumeric characters). 

Call Comment Button 
Click this button to display a free-text comment window. If a comment has already been 
entered, the box next to the button is checked. 

Call Again 
Click this button to unmark the Called checkbox to indicate that the call should be repeated. 
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Undergo QA Tab 
The Undergo QA tab contains information regarding QA procedures and allows you to set flags to 
manually force personnel to perform a certain QA procedure.  These procedures include rescreen, 
proreview, and retroreview QA procedures. 

 
Figure 1-25. Specimen Registration Window - Undergo QA Tab 

Rescreen, Proreview, Retroreview 
Mark the Rescreen, Proreview, and/or Retroreview checkboxes to indicate that the case 
should undergo the selected QA procedure(s). Multiple procedures can be selected, if 
necessary. 

Completed, By, and Result 
If the Completed checkbox is marked, the corresponding QA procedure has been completed 
for the case, and the date and time of the procedure displays in the adjacent field. The By 
field displays the ID of the person who performed the procedure, and the Result field 
displays the QA discrepancy code for the procedure. 

Exclude from Future Follow Up Correlations 
Mark this checkbox to indicate if you want to exclude the current case from future follow up 
correlations.  

Tumor Registry 
Mark this checkbox to flag the case for the Tumor Registry, which provides the opportunity 
to automatically print final reports that have been flagged in Results Entry for the Tumor 
Registry. See Chapter 6.4 – Setup: Options for information about the parameter that 
governs this feature. 
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Patient History Tab 
The Patient History tab (Figure 1-26) contains information regarding the patient’s previous cases, 
including case number, billing number, requesting doctor, and ordered date. From this tab, you can 
click a case number for which to perform a results query.  

 
Figure 1-26. Specimen Registration Window - Patient History Tab 
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Other Case Data Tab 
The Other Case Data tab allows you to enter detailed information about the current case. 

 
Figure 1-27. Specimen Registration Window - Other Case Data Tab 

Reported To 
Enter up to four (4) doctors who should receive the report for the current case. Click the  
button to display the Doctor Lookup window, and select a doctor code from the list. The 
available codes are defined in the Doctor file (Setup > Setup Files > Doctors File). 
NOTE:   Doctors that have not been defined in the Doctor file can still be entered in this 

field on a one-time basis. To do this, enter an asterisk (*) in the field and then 
press the Tab key. The Auxiliary Doctor window (Figure 1-28) is displayed. 
The Last Name field is the only field required in this window. Banner pages for 
all doctors that are entered using this method will use the auxiliary banner 
template defined in the Banner Setup option when batch printing is used. 

 
Figure 1-28. Auxiliary Doctor Window 
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Stillbirth 
Mark this checkbox to indicate a stillbirth. By default this checkbox is unmarked. This field 
is only available if it has been activated in the Options window - Specimen Registration 
tab - Flags tab. 

Partial Autopsy 
Mark this checkbox if a partial autopsy was performed for this case. This checkbox is 
unmarked by default. This field is only available if it has been activated in the Options 
window - Specimen Registration tab - Flags tab. 

Complete Autopsy 
Mark this checkbox if a complete autopsy was performed for this case. This checkbox is 
unmarked by default. This field is only available if it has been activated in the Options 
window - Specimen Registration tab - Flags tab. 

Undiagnosed Infection 
Mark this checkbox to indicate that the patient has an undiagnosed infection. By default this 
box is unchecked. This field is only available if it has been activated in the Options window 
- Specimen Registration tab - Flags tab. 

HIS # 
If the connection with the HIS has been interrupted, you can enter a temporary HIS number 
for the current case. This number can be corrected using the Down Time option. 

For ID Only 
Enter the number of Gross Identification Only specimens to be examined macroscopically 
with no block processing requirements. This field is only available if it has been activated in 
the Options window - Specimen Registration tab - Flags tab. 

Intraoperative Consultations 
Enter the number of Intraoperative Consultation specimens submitted. This field is only 
available if it has been activated in the Options window - Specimen Registration tab - 
Flags tab. 

Foreign Case # 
Enter the foreign case number for the case. This number is the actual case number from 
another institution for cases received as incoming consultations. 

Case Comment 
Click this button to display a free-text window where you can enter comments concerning 
the current case. This field accepts canned message entries. Click OK after you enter the 
comment, and the box next to the Comment button is marked. 

Clinical Info button 
Click this button to display a free-text window where you can enter text and clinical 
information. This field accepts canned message entries. 

Operation Info 
Click this button to display a free-text window where you can enter text and pre-operative 
information. This field accepts canned message entries. 

UDF Button 
Click this button to display the User Defined Flag. 

Display Tag Data 
Click the Display Tag Data button to display the Tag Data window. This window contains 
the text of a message taken from SoftLab and attached to the current case (if applicable). 
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MED Info Tab 
The MED Info tab (Figure 1-29) is only displayed for medical cytology cases and is used to enter 
specific case information for MED cytology cases. 

 
Figure 1-29. Specimen Registration Window - MED Info Tab 

Size of Lesion 
Enter the size of the patient’s lesion in centimeters. Maximum of 6 numeric characters 
including decimal point (if used).  

Clinical History 
Enter the patient’s clinical history. This is a free-text field. Maximum 32 alphanumeric 
characters. 

Clinical Prediction 
Enter a clinical prediction for the patient. This is a free-text field. Maximum 32 
alphanumeric characters. 

Radiologic Prediction 
Enter a radiological prediction for the patient. This is a free-text field. Maximum 32 
alphanumeric characters. 

Mammography Findings 
Enter the mammography findings for the patient. This is a free-text field. Maximum 32 
alphanumeric characters. 
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Ultrasound Findings 
Enter the ultrasound findings for the patient. This is a free-text field. Maximum 32 
alphanumeric characters. 

Patient’s HX of CA 
Enter the patient’s history of cancer. This is a free-text field. Maximum 32 alphanumeric 
characters. 

Previous Biopsy 
Enter information on the patient’s previous biopsy, if any. This is a free-text field. 
Maximum 32 alphanumeric characters. 

Comment 
Enter a free-text comment, if needed. Maximum 100 alphanumeric characters. 

Calcification 
Enter information concerning the presence of calcifications in the patient’s body. This is a 
free-text field. Maximum 32 alphanumeric characters. 

Round/Oval Mass 
Mark this checkbox if the patient has a round/oval mass. 

Family Hx Breast CA 
Mark this checkbox if the patient has a family history of breast cancer. 

Post-Partum 
Mark this checkbox if the patient is currently in the postpartum period. 

Hormones 
Mark this checkbox if hormones are being prescribed to the patient. 

Radiation 
Mark this checkbox if the patient is receiving radiation treatment. 

Spiculated Mass 
Mark this checkbox flag if the patient has a spiculated mass. 

Pregnant 
Mark this checkbox if the patient is currently pregnant. 

Post-Menopausal 
Mark this checkbox if the patient is currently postmenopausal. 

Chemotherapy 
Mark this checkbox if the patient is currently receiving chemotherapy treatment. 
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Letters Tab 
This Letters tab (Figure 1-30) allows you to assign a letter to the current case. You can also print the 
letter using the Print Reports option or on a scheduled basis using the Scheduler option. 

 
Figure 1-30. Specimen Registration Window - Letters Tab 

Display Letter Button 
Click Display Letter to preview the selected letter on the screen. 

Add New Button 
Click Add New to add a new letter.  

Delete Button 
Click Delete to delete the currently selected letter. A letter cannot be deleted after printing. 

Date Section 
Select one of the two options for the letter date by clicking the appropriate option button: 
Number of Days After Sign-Out 

Enter the number of days after sign out that the letter is to be sent.  
Recall Date 

When you select the Recall Call option button, the Date field becomes active. Either 
enter the date manually or click  to display a calendar from which to make a selection. 
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Letter Code 
Enter the code of the letter type being sent. Click the  button to display the Letter 
Lookup, and select an appropriate code from the list. This is a required field. 

Printed 
Mark this checkbox if the letter has already been printed. This field is for informational 
purposes only and cannot be modified. 
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Accounting Tab 
The Accounting tab (Figure 1-31) displays information regarding the default performing locations 
and the default patient insurance information for the case. 

 
Figure 1-31. Specimen Registration Window - Accounting Tab 

Technical Performing Location  
If you enter a technical performing location, the system will use this location as the default 
technical performing location for this case. If you do not enter a technical performing 
location, the system uses the technical performing location assigned to the case’s accession 
sequence. If you do not enter a technical performing location in this window and there is no 
technical performing location assigned to the accession sequence, no technical performing 
locations are defined.  

Professional Performing Location 
If you enter a professional performing location, the system will use this location as the 
default professional performing location for this case. If you do not enter a professional 
performing location, the system uses the professional performing location assigned to the 
case’s accession sequence. If you do not enter a professional performing location in this 
window and there is no professional performing location assigned to the accession sequence, 
no default professional performing locations are defined.  
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Case Insurances 
Enter insurances for the case on the Case Insurances grid. In the Code column, select 
insurances for the case from the drop-down list. The allowable insurances for these fields 
default from information entered in the patient record. The Name column displays the 
name/description of the insurance code you select in the Code column.  
In the Authorization # column, enter the appropriate authorization number for the insurance 
(maximum 19 alphanumeric characters). The authorization number is required if the 
Authorization Number Required checkbox is marked in the Insurances file for the 
currently selected insurance. 
NOTE: The system displays the first three insurance providers for this case if they were 

entered in the Patient Maintenance option. 
Application To Billing 

Mark this checkbox if the insurance will apply to part A, part B, or all billing. 
Ordering Diagnosis 

Enter up to four diagnosis codes for the specimen or click the  buttons to select from a list 
of active diagnosis codes. These diagnosis codes are used for billing the insurance company.  
NOTE: The system displays four diagnosis codes for this case if they were entered 

during SoftLab order entry. 
Print ABN Form 

The system provides the ability to print an ABN form if one has not been supplied with the 
case.  Select Yes or No from the drop-down menu to print the form to the printer defined in 
the Options setup file. 

ABN Form Printed 
This checkbox shows whether an ABN form has already been printed for this case. 
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Adequacy Problems Tab 
The Adequacy/Problems tab (Figure 1-32) allows you to enter information regarding specimen 
adequacy or processing problems. The fields on the left side of the Adequacy and Processing 
Problems areas allow you to assign adequacy/processing problem codes at the case level. The cells 
within the grid allow you to assign adequacy/processing problem codes at the specimen level. The 
adequacy or processing problem codes assigned in this window are used when generating QA 
Management reports. 

 
Figure 1-32. Specimen Registration Window - Adequacy Problems Tab 

To enter an adequacy or processing problem code for the case, place the cursor in one of the Case 
fields and click the  button. The Quality Codes Lookup window is displayed; select the up to 
three (3) required codes. Quality codes are defined in the Quality Codes setup file (Setup > Setup 
Files > Quality Codes).  
To enter an adequacy code or processing problem code for a specimen, click the Code cell located in 
the same row as the specimen. Click the  button, and the Quality Codes Lookup window is 
displayed. Select up to three (3) required codes. The available codes are defined in the Quality Codes 
setup file (Setup > Setup Files > Quality Codes). 
You can enter free-text comments in the Specimen Adequacy Info window if one or more specimen 
adequacy codes have been entered. 
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Incoming Consultations Tab 
The Incoming Consultations tab (Figure 1-33) allows you to track cases received from outside 
laboratories or consultants for review or a second opinion. Frequently, a request is made by an 
attending physician to obtain a case (slide and outside report) for review by the pathology lab. Data 
entry fields are only available after a consultation has been added. 

 
Figure 1-33. Specimen Registration Window - Incoming Consultation Tab 

Add Consult. Button 
To register an incoming consultation, click the Add Consult button. Click Yes when the 
system prompts you to confirm the creation of a new consultation.  

Del Consult. Button 
To delete an incoming consultation, select the consultation on the grid and click the Del 
Consultation button. The system displays a message prompting you to confirm the deletion. 

Requested By 
Select either Pathologist or Physician from the drop-down list. If you select Pathologist, 
you can click the  button for the adjacent ID field to view all active ID codes that are 
defined as pathologists in the Personnel setup file. If you select Physician, the dynamic list 
for the adjacent ID field contains only doctors defined in the Doctor file. Click the dynamic 
list button and select an appropriate code from the list. This field is required. 
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NOTE:   Doctors that have not been defined in the Doctor file can still be entered in this 
field on a one-time basis. To do this, enter an asterisk (*) in the field and then 
press the Tab key. The Auxiliary Doctor window (Figure 1-34) is displayed. 
The Last Name field is the only field required in this window. Banner pages for 
all doctors that are entered using this method will use the auxiliary banner 
template defined in the Banner Setup option when batch printing is used. 

 
Figure 1-34. Auxiliary Doctor Window 

Referring Lab/Physician ID 
Enter the referring lab code (where the case was sent from) or the consultant’s ID code. 
Click the  button to display the Consultant’s Lookup window. Select an appropriate code 
from the list of active ID codes defined in the Consultants setup file. This field is required. 

Discrepancy 
Select a discrepancy for the case from the drop-down list. Discrepancy codes are defined in 
the Quality Assurance Categories option (Setup > Setup Files > Quality Codes). 

Request Registration Date 
Enter the date the incoming consultation was accessioned. You can enter the date manually 
or you can click the  button to display a calendar to make your selection. Maximum 8 
numeric characters using the mm/dd/yyyy format. 

Material Received Date 
Enter the date that the material(s) were received. You can enter the date manually or you can 
click the  button to display a calendar to make your selection. Maximum 8 numeric 
characters using the mm/dd/yyyy format. 

Materials Received  
Click the Materials Received button to open the Material Received window (Figure 1-35). 

 
Figure 1-35. Material Received Window 

Slides # 
 Enter the number of slides received. 
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Blocks # 
 Enter the total number of blocks received. 
Source 
 Enter the source code for the specimen 
Body Site 

Enter the body site code of the specimen. 
Outside Case Number 

Enter the case number from the originating site of the incoming specimen. 
Maximum 20 alphanumeric characters. 

Processing Button 
Click this button to display the Processed Materials window (Figure 1-36) where 
you can view all of the materials received for the consultation. All materials are 
marked by default to indicate that they require processing. You can deselect all 
materials by clicking the Unmark All button. Mark the materials you want to 
process and click OK. 

 
Figure 1-36. Processed Materials Window 

Labels Button 
Click this button to print labels for the consultation. The Label Print window for 
Consultation Labels (Figure 1-37) is displayed.  See page 1-21 for more information 
on the Label Print window. 

 
Figure 1-37. Labels Print Window - Consultation Labels 
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More 
Click the More button to display the Materials window (Figure 1-38), which shows 
detailed information about the materials. 

  
Figure 1-38. More Window 

Material Return Date 
Once the consultation is complete, enter the date when the material(s) are returned. You can 
manually enter the date or click the  button to display a calendar to make your selection. 
Maximum 8 numeric characters using the mm/dd/yyyy format. 

Comment 
Click this button to open the Consultation Comment window for adding a comment about 
the consultation. 

Consultation Report Date 
Enter the date the consultation report is completed. You can enter the date manually or click 
the  button to display a calendar to make your selection. Maximum 8 numeric characters 
using the mm/dd/yyyy format. 

Request Letter Date 
Enter the date the request letter was sent. You can enter the date manually or click the  
button to display a calendar to make your selection. Maximum 8 numeric characters using 
the mm/dd/yyyy format. 
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Req. Letter Button 
Click this button to display the Select Letter window (Figure 1-39), which lists all available 
requesting letters. Click either View/Edit to preview/edit the letter or the Print button to 
print the letter. 

 
Figure 1-39. Select Letter Window 

Ret. Letter Button 
Click this button to display the Select Letter window (Figure 1-39), which lists all available 
requesting letters. Click either View/Edit to preview/edit the letter or the Print button to 
print the letter. 

Report Button 
Click the Report button to view the report for the case and print a copy of the report if it has 
been signed out.  
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Risk Factors Tab  
This Risk Factors tab (Figure 1-40) is used to enter, modify, and view risk factors for the current 
patient. The grid on this tab displays the code, name, severity level, assigned date, expiration date, 
and MRN of all risk factors associated with the patient. For detailed information on associating risk 
factors with patients, refer to page 1-84. 

 
Figure 1-40. Specimen Registration Window - Risk Factors Tab 
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HIS Numbers Tab 
The HIS Numbers tab (Figure 1-41) allows you to view and enter HIS numbers for each specimen 
associated with the current case.  
This tab only appears if the rh_HIS_OPTION parameter in RPARAM file contains the letter M (for 
multi-specimen). In this instance, each specimen has an HIS number assigned to it.  

 
Figure 1-41. Specimen Registration Window - HIS Numbers Tab 
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Body Release To Tab 
The Body Release To tab (Figure 1-42) is displayed for autopsy cases and can only be viewed by 
users with the proper security privileges assigned in the Personnel setup file. The Body Release To 
tab allows you to enter, modify, or view data concerning the person to whom the body has been 
released.  

 
Figure 1-42. Specimen Registration Window - Body Release To Tab 
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GYN Info Tab 
This GYN Info tab (Figure 1-43) only displays for gynecological (GYN) specimen registration and 
contains gynecological information for the current patient.  

 
Figure 1-43. Specimen Registration Window - GYN Info Tab 

LMP 
Enter the date of the patient’s last menstrual period. The date can be entered manually or you 
can click the  button to display a calendar for selection. Maximum 8 numeric characters 
using the mm/dd/yyyy format. 
NOTE: If the exact date is unknown, you can enter a partial date instead consisting of 

only the day, month, year, or any combination of the three. 
Gravida 

Enter the total number of pregnancies for the patient. Maximum of 4 numeric characters. 
Para 

Enter the total number of births. Maximum of 4 numeric characters. 
Contraceptive 

Enter any contraceptive(s) used by the patient. This is a free-text field. Maximum 25 
alphanumeric characters. 

Hormonal TX 
Enter any hormonal pharmaceutical information for the patient. This is a free-text field. 
Maximum 25 alphanumeric characters. 
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Radiation 
Enter any radiation information for the patient. This is a free-text field. Maximum 25 
alphanumeric characters. 

History of CA 
Enter any family history of cancer for the patient. This is a free-text field. Maximum 25 
alphanumeric characters. 

Prev. Smear Date 
Enter the date of the patient’s last PAP smear (if known). The date can be entered manually 
or you can click the  button to display a calendar to make your selection. Maximum 8 
numeric characters using the mm/dd/yyyy format. 
NOTE: If the exact date is unknown, you can enter a partial date instead consisting of 

only the day, month, year, or any combination of the three. 
Prev. Abnormal 

Enter any previous abnormal PAP smear information for the patient. This is a free-text field. 
Maximum 25 alphanumeric characters. 

Prev. Normal 
Enter any previous normal PAP smear information for the patient. This is a free-text field. 
Maximum 25 alphanumeric characters. 

Pregnant 
Mark this checkbox if the patient is pregnant. 

Postpartum 
Mark this checkbox if the patient is currently in the postpartum period. 

Menarche 
Mark this checkbox if the patient is at the establishment/beginning of menstruation. 

Cesarean 
Mark this checkbox if the patient has had a delivery by cesarean section. 

Pessary 
Mark this checkbox if the patient has had a vaginal suppository used to support the uterus, 
remedy a malposition, or prevent conception. 

IUD 
Mark this checkbox if the patient has an intrauterine device. 

PMB 
Mark this checkbox if the patient has post-menopausal bleeding. 

Hysterectomy 
Mark this checkbox if the patient has had a hysterectomy. 

Menopause 
Mark this checkbox if the patient has entered menopause. 

Weeks of Pregnancy 
If the Pregnant checkbox is marked, enter the number of weeks the patient has been 
pregnant.  

Weeks After Delivery 
If the Postpartum checkbox is marked, enter the number of weeks the patient has been in 
the postpartum period.  
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Cryo TX 
Enter any cryogenic treatment information for the patient. This is a free-text field. 
Maximum 23 alphanumeric characters. 

Chemo TX 
Enter any chemotherapy treatment information for the patient. This is a free-text field. 
Maximum 23 alphanumeric characters. 

Laser TX 
Enter any laser treatment information for the patient. This is a free-text field. Maximum 23 
alphanumeric characters. 

Other TX 
Enter any other treatment information for the patient. This is a free-text field. Maximum 23 
alphanumeric characters. 

Colposcopy 
Enter any colposcopy treatment information for the patient. This is a free-text field. 
Maximum 23 alphanumeric characters. 

Menop Info Button 
Click the Menop Info button to display a free-text comment window where you can enter 
any menopausal information for the patient. 
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Autopsy Info Tab 
The Autopsy Info tab (Figure 1-44) is only displayed for autopsy cases. In this tab, you can view, 
enter, or modify information concerning the autopsy. 

 
Figure 1-44. Specimen Registration Window - Autopsy Info Tab 

Hospital Where Death Occurred 
Enter the name of the hospital where the patient’s death occurred. Click the  button to 
display the Clinic Code Lookup window and select an appropriate code from the list. 

County Where Death Occurred 
Enter the county where the patient’s death occurred. This is a free-text field. Maximum 32 
alphanumeric characters. 

County of Incident 
Enter the county where the incident leading to the death occurred. This is a free-text field. 
Maximum 32 alphanumeric characters. 

Coroner Case Number 
Enter the coroner case number for the death. This is a free-text field. Maximum 15 
alphanumeric characters 

Coroner Name 
Enter the name of the coroner who performed the autopsy. This is a free-text field. 
Maximum 76 alphanumeric characters. 
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Chart Return Date 
Enter the date that the chart was returned to the Medical Records department. You can enter 
the date manually or you can click the  button to display a calendar to make your selection. 
Maximum 8 numeric characters using the mm/dd/yyyy format. 

Blood Ethanol 
Enter the patient’s blood ethanol value in the free-text box. Click the drop-down list button 
and select either (%) percentage for medical or LEGAL for legal blood ethanol. 

Cause of Death 
Enter the cause of death. This is a free-text field. 

Police Agency 
Enter the name of the police agency investigating the incident. This is a free-text field. 

Autopsy Type 
Select an autopsy type code from the drop-down list. The available case types are defined in 
the Simple Codes option. 

Scene 
Select a code describing the scene of death from the drop-down list. The available scenes are 
defined in the Simple Codes option. 

Manner of Death 
Select a code that describes the manner of death from the drop-down list. The available 
codes are defined in the Simple Codes option. 

Other Drugs 
Select other drugs found in the patient’s system from the drop-down list. The available drugs 
are defined in the Simple Codes option. 
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Call List Requests 

The Call List Requests option allows you to identify cases with pending telephone calls. The cases 
can be marked to request a call that informs patients of final results as soon as the cases are signed 
out. You can also mark cases to provide the patient with a reminder call for required follow-up visits.  
Clinic-based calls display the patient clinic information. The information entered sorts the pending 
calls and presents them in a way designed to minimize the number of different calls and the time 
required to complete each call. The system automatically registers the date and time the call is 
completed and the ID of the person that performed the call. 
You can print a Call List Report to list pending or completed calls within a specified date range. In 
addition, calls can be displayed by patient type, call reason (result or reminder calls), requesting 
physician, patient clinic, or case priority. The patient demographics, case information, and final 
diagnosis are also displayed for each case placed on the call list. If the final diagnosis is not complete 
or the case has not been signed out, the pending status is displayed. 
To access the Call List Request option, select Order > Call List Request from the main menu. The 
Call Request Search Screen window (Figure 1-45) is displayed. 

 
Figure 1-45. Call Request Search Window 

Enter search criteria and click the Find button. Calls matching the search criteria display in the Call 
Reminder area. The total number of cases that qualify are displayed next to each call list type. Select 
a call list by clicking the corresponding option button and then clicking the Select button. The Call 
List Request window is then displayed for the specified call list.  
If there are any pending calls in the call list, select the List of Cases to Call option and click Select. 
Select a call list and click Select. The Calls window (Figure 1-46) system is displayed.  
NOTE: The list of cases to call is sorted by the scheduled date of the call. 
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Figure 1-46. Calls Window 

Printing Call List Requests Lists 
Click the Print button to print a list of cases that require calls.  

Processing Call List Requests 
Highlight the call you want to process and click OK. The Call List Request window (Figure 1-47) 
for the selected case is displayed, which allows you to enter and view call information. The 
information for the selected case displays at the top of the window and cannot be modified. To 
modify a call list request, click the Edit button on the toolbar.  

 
Figure 1-47. Call List Requests Window – Requested Call Tab 



SoftPath GUI v.4.2.1 User Manual Chapter 1.3 – Order: Call List Requests 

PATH4.2-G-U (6th Ed, Rel. 01/31/07)  Page 1-55 

Relevant phone numbers, clinic information, and doctor information for the call are displayed on this 
tab and cannot be modified. You can view, enter, or edit comments attached to the call by clicking 
the Comment button. 
You can move to the next or previous case by clicking the corresponding arrow buttons on the 
toolbar. By moving your cursor to the left-hand side of the window, you can also move between 
cases on the displayed pending list. Double-click a case to select it. 
Called  

Verify the call by marking the Called box. The current date, time, and the initials of the 
currently logged-on user are captured by the system and display in the Date, Time, and By 
fields. This information cannot be modified. 

Confirmation 
Enter any confirming or call-related information in the Confirmation field. If one line is not 
sufficient for your confirmation information, click the Comment button, which opens a free 
text window for entering any additional information. 

Report Button 
Click the Report button to display the Select Report window (Figure 1-48), which can be 
used to print reports created for the current case. Highlight a report and click Mark Selected 
to select the report. Click View preview the report or Print to print the report.  

 
Figure 1-48. Select Report Window 
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Consultations 

The Consultations menu options allow you to enter information about consultations performed in 
your facility as well as consultations requested by outside facilities.  

 
Figure 1-49. Order - Consultations Sub-Menu 

The Consultations menu contains the following sub-options: 
 Outgoing Consultation Requests 
 Consultation Discrepancy Entry 
 Incoming Consultation Requests 
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Outgoing Consultation Requests 

Outgoing Consultation Request is used for tracking cases sent to an outside laboratory or 
consultant.  
To access the Outgoing Consultation Requests option, select Order > Consultations > Outgoing 
Consultations from the main menu. The Outgoing Consultations - Enter Search Criteria window 
(Figure 1-50) is displayed. 

 
Figure 1-50. Outgoing Consultation - Enter Search Criteria Window 

After entering search criteria, click the Find button. The system displays a list of cases that match 
the specified search criteria on the Cases tab. The Cases tab displays the patient last name, first 
name, case number, medical record number (MRN), and source code. If a consultation already exists 
for a case, the Cons checkbox will be marked.  
To edit an existing outgoing consultation for a patient, highlight the patient and click Select. The 
Outgoing Consultation window (Figure 1-51) is displayed. To make changes to the consultation, 
click the Edit button on the toolbar. 
If there are no outgoing consultations for the selected patient, the Cons checkbox is unmarked. 
Highlight a patient and click Select to add a new outgoing consultation for the specified patient. 
Click Yes when the system prompts you to create a new consultation. The Outgoing Consultation 
window (Figure 1-51) is displayed. 
NOTE: The patient demographic information displays in READ ONLY mode. 
NOTE: When materials are sent out, processing is blocked on that specimen. 
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Figure 1-51. Outgoing Consultation Window – Outgoing Consultation Tab 

Add Consult 
Click this button to add an outgoing consultation.  

Del Consult 
Click this button to delete an outgoing consultation. 
NOTE: If you delete an outgoing consultation, make sure that you first mark the 

material as received or you will be blocked from accessing the material. 
Req By 

Select either Pathologist or Physician from the drop-down list. If you select Pathologist, 
the dynamic list for the adjacent ID field contains all active ID codes that are defined as 
pathologists in the Personnel setup file. If you select Physician, the dynamic list for the 
adjacent ID field contains only doctors defined in the Doctor file. Click the  button and 
select an appropriate code from the list. This field is required. 
NOTE:   Doctors that have not been defined in the Doctor file can still be entered in this 

field on a one-time basis. To do this, enter an asterisk (*) in the field and then 
press the Tab key. The Auxiliary Doctor window (Figure 1-52) is displayed. 
The Last Name field is the only field required in this window. Banner pages for 
all doctors that are entered using this method will use the auxiliary banner 
template defined in the Banner Setup option when batch printing is used. 
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Figure 1-52. Auxiliary Doctor Window 

Referring Lab/Physician ID 
Enter the referring lab code (where the case was sent from) or the consultant’s ID code. 
Click the  button to display the Consultant’s Lookup window. Select an appropriate code 
from the list of active ID codes defined in the Consultants setup file. This field is required. 

Request Registration Date 
This is a required field. This field automatically defaults to the current date but it can be 
changed, if necessary. To change the registration date, enter a new date or click the  button 
to display a calendar to make your selection. Maximum 8 numeric characters using the 
mm/dd/yyyy format. 

Send Out Date 
Enter the date the consultation was sent out. Enter the date manually or click the  button to 
display a calendar to make your selection. Maximum 8 numeric characters using the 
mm/dd/yyyy format. 

Material Received Date 
If editing an existing consultation, enter the date the material was returned. Enter the date 
manually or click the  button to display a calendar to make your selection. Maximum 8 
numeric characters using the mm/dd/yyyy format. 

Report Received Date 
If editing an existing consultation, enter the date the report was received. Enter the date 
manually or click the  button to display a calendar to make your selection. Maximum 8 
numeric characters using the mm/dd/yyyy format.  

Discrepancy Category 
If you are editing an existing consultation, select a discrepancy category code from the drop-
down list. A discrepancy code should be assigned to the case to register the correlation of the 
primary diagnosis and the diagnosis established by the consulting pathologist. The 
discrepancy code is also used for the correlation log. Discrepancy codes are defined in the 
Quality Codes option (Setup > Setup Files > Quality Codes). 
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Slide Sel Button 
If there are slides to be sent with the consultation, click the Slide Sel button to display the 
Select Slides window. This window lists the available slides for the case. To select a single 
slide, double-click the slide and click OK. To mark all of the slides, click the Mark All 
button.  

 
Figure 1-53. Select Slides Window 

Block Sel Button 
If there are blocks to be sent with the consultation, click the Block Sel button to display the 
Select Blocks window. This window lists all available blocks for the case. To select a single 
block, double-click the block and click OK. To mark all the blocks, click Mark All. 

 
Figure 1-54. Select Blocks Window 

Comment Button 
Click the Comment button to open the Consultation Comment window where you can 
enter any needed comments or view previously entered comments. 
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Returned Mat Button 
If editing an existing consultation, click the Returned Mat button to display the Returned 
Materials window. This window lists the materials sent out. Double-click the materials that 
have been returned. 

 
Figure 1-55. Returned Materials Window 

Material Must Return 
Mark this checkbox if the materials must be returned. 

Letter Button 
To print a letter for the current consultation, click the Letter button, which displays the 
Select Letter window. This window lists outgoing letters currently defined in your system. 
The types of documents available in this list are determined in Setup Options. Letters can be 
viewed, edited, printed, or faxed. 

 
Figure 1-56. Select Letter Window 

Ins Form Button 
To print an insurance form for the current consultation, click the Ins Form button, which 
displays the Select Letter window. This window lists the insurance form letters currently 
defined in your system. The types of documents available in this list are determined in Setup 
Options. Insurance forms can be viewed, printed, or faxed. 
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Report Button 
To print the case report for the current consultation, click the Report button. This displays 
the Select Report window. This window lists the available reports for the case. The selected 
report can be viewed, printed or faxed. 

 
Figure 1-57. Select Report Window 
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Tracking Tab 
The Tracking tab displays the status of materials that were sent and/or returned for the consult 
including, the date and time of send out and return, as well as, the destination of the send out. 

 
Figure 1-58.  Outgoing Consultation Window – Tracking Tab 
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Consultation Discrepancy Entry 

The Consultation Discrepancy Entry option provides you with a worksheet to enter discrepancy 
results for one or more consultations. The Discrepancy Category Management reports can then be 
generated on demand. 
To access the Consultation Discrepancy Entry option, select Order > Consultations > 
Consultation Discrepancy Entry from the main menu. The Discrepancy Entry - Lookup window 
(Figure 1-59) is displayed. 

 
Figure 1-59. Discrepancy Entry - Lookup Window 

To limit the search, select the case type and consultation status by marking the appropriate check 
boxes. Leave all of the choices unmarked to include all cases in the search.  
After entering the required search criteria, click the Find button. Cases that match the search criteria 
display on the Cases tab. Highlight the desired case and click Select. The Discrepancy Entry 
window (Figure 1-60) for the selected case is displayed.  
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Discrepancy Entry Tab 

 
Figure 1-60. Discrepancy Entry Window  

The Discrepancy Entry tab (Figure 1-60) displays the order date, request registration date, and the 
name of the requesting pathologist/physician in addition to the following data entry fields. To enter 
or change any information on this, click Edit ( ) from the toolbar. 
Discrepancy Category 

Select a discrepancy category code from the drop-down list. Discrepancy codes are defined 
in the Quality Assurance Categories option (Setup > Setup Files > Quality Codes). 

Consultation Report Date 
Enter the date the consultation report was completed or click the  button to display a 
calendar to make your selection. Maximum 8 numeric characters using the mm/dd/yyyy 
format. 

Consultation Text 
This is a free-text section to record discrepancy categories, comments and any other 
information pertinent to the consultation. 
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Case Description Tab 
This tab is in READ ONLY format. The information displayed is specific to the case and provides 
hyperlinks to the Results Query option. Click the blue underlined text to perform a results query for 
the item.  
NOTE: The information displayed on this tab varies depending on the user currently logged on 

to the system and that user’s security permissions set in the Security file. 

 
Figure 1-61. Discrepancy Entry Window - Case Description Tab 
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Incoming Consultation Requests 

The Incoming Consultation Requests option tracks cases received from an outside laboratory or 
consultant.  
To access the Incoming Consultant Requests option, select Order > Consultations > Incoming 
Consultation Requests from the main menu. The Incoming Consultation - Enter Search Criteria 
window (Figure 1-62) is displayed.  

 
Figure 1-62. Incoming Consultations - Enter Search Criteria Window 

After entering search criteria in the Incoming Consultation search window, click Find. All cases 
matching the criteria entered display on the Cases tab. 
Add Temporary Button 

The Temporary Data functionality allows you to enter an incoming consultation that does 
not have any materials entered or require any further action. The case remains temporary 
until it is registered in the Specimen Registration window with materials entered.  
To use the Temporary Data functionality, click the Add Temporary button. The system 
prompts you to confirm the addition of temporary data. The Temporary Data window 
displays in Edit mode. Enter the available data in the appropriate fields. 
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Figure 1-63. Temporary Data Window 

If the selected patient does not have an incoming consultation, the Cons box is unmarked. Highlight 
a patient that does not have an incoming consultation and click Select to add a new incoming 
consultation for the patient. When prompted, click Yes to confirm the creation of a new consultation. 
The Incoming Consultation window (Figure 1-64) is displayed. This option functions identically to 
the Incoming Consultations tab located in the Specimen Registration option.  
NOTE: The patient demographic information is displayed in a READ ONLY format. 



SoftPath GUI v.4.2.1 User Manual Chapter 1.4 – Order: Consultations 

PATH4.2-G-U (6th Ed, Rel. 01/31/07)  Page 1-73 

 
Figure 1-64. Incoming Consultation Window 

Add Consult. Button 
To register a new incoming consultation, click the Add Consult button. Click Yes when the 
system prompts you to confirm the creation of a new consultation.  

Del Consult. Button 
To delete an incoming consultation, select the consultation on the grid and click the Del 
Consultation button. The system displays a message prompting you to confirm the deletion. 

Requested By 
Select either Pathologist or Physician from the drop-down list. If you select Pathologist, 
you can click the  button for the adjacent ID field to view all active ID codes that are 
defined as pathologists in the Personnel setup file. If you select Physician, the dynamic list 
for the adjacent ID field contains only doctors defined in the Doctor file. Click the dynamic 
list button and select an appropriate code from the list. This field is required. 
NOTE:   Doctors that have not been defined in the Doctor file can still be entered in this 

field on a one-time basis. To do this, enter an asterisk (*) in the field and then 
press the Tab key. The Auxiliary Doctor window (Figure 1-52) is displayed. 
The Last Name field is the only field required in this window. Banner pages for 
all doctors that are entered using this method will use the auxiliary banner 
template defined in the Banner Setup option when batch printing is used. 

Referring Lab/Physician ID 
Enter the referring lab code (where the case was sent from) or the consultant’s ID code. 
Click the  button to display the Consultants Lookup window. Select an appropriate code 
from the list of active ID codes defined in the Consultants setup file. This field is required. 
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Discrepancy 
Select a discrepancy for the case from the drop-down list. Discrepancy codes are defined in 
the Quality Assurance Categories option (Setup > Setup Files > Quality Codes). 

Request Registration Date 
Enter the date the incoming consultation was accessioned. You can enter the date manually 
or you can click the  button to display a calendar to make your selection. Maximum 8 
numeric characters using the mm/dd/yyyy format. 

Material Received Date 
Enter the date that the material(s) were received. You can enter the date manually or you can 
click the  button to display a calendar to make your selection. Maximum 8 numeric 
characters using the mm/dd/yyyy format. 

Materials Received  
Click the Materials Received button to display the Material Received window (Figure 
1-35). 

 
Figure 1-65. Material Received Window 

Slides # 
 Enter the number of slides received. 
Blocks # 
 Enter the total number of blocks received. 
Source 
 Enter the source code for the specimen 
Body Site 

Enter the body site code of the specimen. 
Outside Case Number 

Enter the case number from the originating site of the incoming specimen. 
Maximum 20 alphanumeric characters. 
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Processing Button 
Click this button to display the Processed Materials window (Figure 1-66) where 
you can view all of the materials received for the consultation. All materials are 
marked by default to indicate that they require processing. You can deselect all 
materials by clicking the Unmark All button. Mark the materials you want to 
process and click OK. 

 
Figure 1-66. Processed Materials Window 

Labels Button 
Click the Labels button to print labels for the consultation. See page 1-21 for more 
information on the Label Print window. 

More 
Click the More button to display the Materials window (Figure 1-67), which shows 
more detailed information about the materials. 

  
Figure 1-67. More Window 

Material Return Date 
Once the consultation is complete, enter the date when the material(s) will be returned. You 
can enter the date manually or you can click the  button to display a calendar to make your 
selection. Maximum 8 numeric characters using the mm/dd/yyyy format. 

Comment Button 
Click the Comment button to open the Consultation Comment window where you can 
enter any needed comments or view previously entered comments. 
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Consultation Report Date 
Enter the date the consultation report is completed. You can enter the date manually or you 
can click the  button to display a calendar to make your selection. Maximum 8 numeric 
characters using the mm/dd/yyyy format. 

Request Letter Date 
Enter the date the request letter was sent. You can enter the date manually or you can click 
the  button to display a calendar to make your selection. Maximum 8 numeric characters 
using the mm/dd/yyyy format. 

Req. Letter Button 
Click this button to display the Select Letter window (Figure 1-39), which lists all available 
requesting letters. Click either View/Edit to preview/edit the letter or the Print button to 
print the letter. 

 
Figure 1-68. Select Letter Window 

Ret. Letter Button 
Click the Returning Letter button to display the Select Letter window (Figure 1-68), 
which lists all available returning letters. Click either View/Edit to preview/edit the letter or 
the Print button to print the letter. 

Report Button 
Click the Report button to view the report for the selected case.  
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Patient Maintenance 

The Patient Maintenance option allows you to enter new patients and view existing patient 
demographic data, insurance and billing information, emergency contact information, and patient 
risk factors. You can also enter/view historical data for all of a patient’s stays in the hospital. The 
term stay describes a stay in the hospital and each outpatient visit. The information commonly 
entered for a patient includes MRN (medical record number), social security number, sex, race, last 
name, first name, middle name, date of birth, age, patient comment, address (city, state, zip code), 
telephone number, current stay number, location, and billing data. 
To access the Patient Maintenance option, select Order > Patient Maintenance from the main 
menu. The Patient Maintenance Browser window (Figure 1-69) is displayed.  

 
Figure 1-69. Patient Maintenance Browser Window 

After entering the desired search criteria, click Find. The system displays a list of patients matching 
the specified criteria. If there are no patients that match the search criteria, click the Import Lab 
button to import qualifying patients and their stay records from the SoftLab database. 
SoftPath also provides the ability to maintain patient records between two or more SCC products 
using the Context Manager functionality. Using the Leave/Rejoin context buttons, users can 
choose to have patient data automatically updated between the Soft products found in their lab. 
When one system changes data, the other systems will see that change. 
To select a patient, highlight the patient and click OK. The Patient Maintenance window (Figure 
1-70) for the selected patient is displayed. To add a new patient record from the Patient 
Maintenance Browser window, click the Add Patient button, which allows you to enter data for 
the patient. 



Chapter 1.5 – Order: Patient Maintenance SoftPath GUI v.4.2.1 User Manual 

Page 1-78  PATH4.2-G-U (6th Ed, Rel. 01/31/07) 

 
Figure 1-70. Patient Maintenance Window 

The top portion of the Patient Maintenance window contains basic demographic information for the 
patient. This section is always displayed in READ ONLY format and cannot be edited. You can 
modify the contents of any of the data fields in this area on the Patient tab. When adding a new 
record, these fields are blank. To add a new patient record in the Patient Maintenance window, 
click the New button on the toolbar. To delete a patient record, click the Delete button. 
NOTE: If you attempt to delete a patient record in Patient Maintenance and there is at least one 

case (signed or unsigned) in the system, the following message is displayed: "Cases exist 
for this patient record.  Delete cases using Specimen Registration option before 
attempting to delete patient record."  
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Patient Tab 
The Patient tab contains data entry fields that allow you to define patient demographics. Patient 
demographics include MRN, social security number (SSN), patient name, sex, race, DOB, date and 
time of death, age, marital status, and address. Other fields in this window are described below. 

 
Figure 1-71. Patient Maintenance Window - Patient Tab 

Third Patient ID 
Enter a third patient ID code for the patient. Maximum 21 alphanumeric characters.  

High Risk 
The High Risk box is checked if the patient has been flagged as high risk for abnormal 
results based on a previous case report. Only users with permission in the Personnel file have 
clearance to remove this flag from the Patient Maintenance record. 

Patient Comment 
Enter a free text comment concerning the current patient in this field. The toolbar buttons 
above this field can be used to format and modify the text of the comment. 
NOTE: A standard comment will be inserted into this field when an Auto Merge is 

performed from an HIS system.   
Display Lab Tags Button 

Select the Display Lab Tags button to display any tag data imported with the patient, stay, 
and insurance record from the Lab database. 
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Stays Tab 
The Stays tab contains a table that lists the stays and the selected stay’s information. To add a new 
stay, click the Add Stay button. A new row for the patient stay displays in the grid. Enter the patient 
stay information in the fields provided.  
NOTE: If a billing number is not assigned to the patient, press TAB when in the Billing # field 

and a billing number is automatically generated for the stay.  
To delete an existing stay, highlight the stay record on the grid and click Delete Stay. Click Yes to 
delete the stay record or No to cancel the operation.  
NOTE: The system will not allow you to delete a stay if a signed out case exists for that stay. 
NOTE: The Add Stay and Delete Stay buttons are unavailable if you are adding a new stay by 

clicking the Add Stay button in the Specimen Registration Lookup window. 

 
Figure 1-72. Patient Maintenance Window - Stays Tab 

Primary Dgn: 
Enter the ICD9 code for the primary diagnosis. The system accepts the ordering ICD9 from 
the HIS. 

Secondary Dgn: 
Enter the ICD9 code for the primary diagnosis. The system accepts the ordering ICD9 from 
the HIS. 

Final Dgn: 
Enter the ICD9 code for the primary diagnosis. 
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Emergency Contact Tab 
The Emergency Contact tab allows you to enter general information regarding the person to contact 
in case of an emergency. Enter all available contact information for the emergency contact in the 
appropriate fields.  

 
Figure 1-73. Patient Maintenance Window - Emergency Contact Tab 
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Insurances Tab 
The Insurances tab allows you to enter specific information regarding the patient’s health insurance.  

 
Figure 1-74. Patient Maintenance Window - Insurances Tab 

The information displayed in the insurance grid is used for billing in SoftPath. The system interprets 
the first insurance code in the list as the primary insurance, the second code as the secondary 
insurance, the third code as the tertiary insurance, and the fourth code as the quaternary insurance. 
To move an insurance up or down in this hierarchy, highlight the insurance and press the up and 
down arrows on your keyboard or the buttons to the left of the grid.  
NOTE: The system allows you to define up to four different insurances per patient. 
The order these insurances appear in is very important because only the first three insurances are 
used as defaults in the Accounting tab of the Specimen Registration option when entering a new 
case for the patient. The insurances can be changed in the Specimen Registration option, but SCC 
recommends updating the insurances in the Patient Maintenance option to avoid repeating data 
entry steps and increasing the chance for errors. 
Add Button 

To add insurance information for the current patient, click the Add button. A new row 
appears in the grid; enter insurance data into the appropriate fields of the Selected 
Insurance area, and the grid display is updated as you enter in the data.  

Delete Button  
To delete one of the patient’s insurances, highlight the insurance in the grid and click the 
Delete button. The system prompts you to confirm the deletion: click Yes, to delete the 
record or No to cancel the operation. 

Insurance Code 
Enter the insurance company code or click  to display a list of valid insurance codes. 
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Insurance # 
Enter the number of the patient’s insurance plan. Maximum 15 numeric characters. 

Comment Button 
Click the Comment button to display a free-text comment window. If a comment has 
already been entered, the box next to the button is checked. 

Prefix 
Contact your billing department for the appropriate entry for this field. Maximum 15 
alphanumeric characters. 

Group Identification 
Enter the group number that appears on the patient’s insurance card. Maximum 19 
alphanumeric characters. 

Date of Expiration 
Enter the expiration date for the selected insurance. Once the date has expired, the insurance 
will no longer be available at the case level. 

Insured Personal Information Area 
Enter the insured’s personal information such as name, address, and phone number in the 
Insured Personal Information area. 

Full Pay, Co Pay, or Undefine 
Choose whether the insured person’s coverage requires full payment for services, a co-
payment, or the form of payment is unknown. 

SSN 
Enter the Social Security number of the insured person. 

Employer Name 
Enter the name of the employer of the insured person. 

Related to Insured 
Click the appropriate option button to select the relationship of the patient to the insured 
person. Options include Self, Spouse, Child, or Other. 

Address Label 
Mark this checkbox if an address label will be needed for this patient’s insurance. 

Employment 
Mark this checkbox if the insurance benefit is related to the insured person’s place of 
employment. 

Family Plan 
Mark this checkbox if the insurance is a family plan. 
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Risk Factors Tab 
The Risk Factors tab is used to enter risk factors for the current patient. The grid on this tab displays 
the risk factor code, name, severity level, effective date, and expiration date of all risk factors 
associated with the patient.  

 
Figure 1-75. Patient Maintenance Window - Risk Factors Tab 

To associate a new risk factor with the patient, click the Add button. The Risk Factor Lookup 
window displays, allowing you to select from the active risk factors that have been defined in the 
Risk Factor setup file. After you select a risk factor, click OK to add the risk factor to the patient 
record. 
Code 

Enter the unique identifier for the risk code. You can select an empty field and click the  
to select a new risk factor from a list of active codes. 

Name 
This field displays the full name/short description of the risk factor code specified in the 
Code field. 

Severity 
If “Risk” displays in the Severity column, the corresponding risk factor has been flagged as 
high risk in the Risk Factor setup file. If a risk factor that has been flagged as high risk is 
associated with the patient record, the system automatically marks the High Risk checkbox 
at the patient level. 

Assigned Date 
Enter the date the risk factor goes into effect for the patient. This field defaults to the current 
date but can be modified, if necessary. 
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Expired Date 
Enter the expiration date for the risk factor. The default expiration period for the risk factor 
is defined in the Risk Factors setup file but can be modified, if necessary. Once the 
expiration date has passed, the risk factor is no be longer active for the patient, so leave this 
field blank if you do not want the risk factor to expire. 

MRN 
This field displays the Medical Record Number under which the Risk Factor was applied to 
the patient record. 

Add Button 
Click the Add button to add a new risk factor for the patient. 

Delete Button 
Highlight a risk factor in the grid and click the Delete button to remove a risk factor from the 
patient record. 
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Merging Patient Records 
The Merge toolbar button  provides the ability to merge two patient records into one record. 
To merge patients, search for the patient that you would like to merge with another patient record. 
When the Patient Maintenance window (Figure 1-70) is displayed, click the Edit button on the 
toolbar and the Merge button on the toolbar becomes active. Click the Merge toolbar button to 
display the Merge Patient window (Figure 1-76), which allows you to merge the selected patient 
record with another existing patient record. 

 
Figure 1-76. Merge Patient Window 

Merge To 
The Merge To area contains information about the TO patient record. The TO patient 
record is the target record that remains after all patients are merged. The data defaults to the 
patient selected during the initial search. To change the patient, click the  button and make 
a new selection. 

Merge From 
In the Merge From area, click the  button to select the FROM patient record. The FROM 
patient record is the record that you want to merge with the TO patient record.  

Merge Patient Button 
After you select both a TO and FROM patient record, click the Merge Patient button to 
merge the two patient records into a single record. The new record retains the medical record 
number of the TO record. Stays, orders, insurance, etc. from both records are included in the 
new record. If there are any discrepancies between data in the TO and FROM record, only 
data from the TO record is retained. 

OK Button 
Confirm and complete the move by clicking OK. 
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Merging Patient Stays 
The VMerge toolbar button  provides the ability to merge two patient stays into one stay. It 
also isolates a specific case to move from one stay to the other.  
To merge stays, search for the patient that contains the stays you would like to combine. When the 
Patient Maintenance window (Figure 1-70) is displayed, select the Stays tab and click the Edit 
button on the toolbar. The VMerge button on the toolbar becomes active. Click the VMerge toolbar 
button to display the Visit Stay window (Figure 1-77). This window allows you to merge the 
selected patient stay with another existing stay. 

 
Figure 1-77. Visit Stay Window 

Merge To 
The Merge To area contains information about the TO patient stay. The TO patient stay is 
the target stay that remains after all stays are merged. The data defaults to the stay selected 
during the initial search. To change the stay, click the  button and make a new selection. 

Merge From 
In the Merge From area, click the  button to select the FROM patient stay. The FROM 
patient stay is the stay that you want to merge with the TO patient stay.  

Merge Stay Button 
After you select both a TO and FROM patient stay, click the Merge Stay button to merge 
the two patient stays into a single record. If there are any discrepancies between data in the 
TO and FROM stay, only data from the TO stay is retained. 

Move Case Button 
After selecting a specific case from the FROM stay, click this button to move that case over 
to the TO stay. 

OK Button 
Confirm and complete the move by clicking OK. 
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Moving Patient Stays 
The Omove toolbar button  removes a stay from a specific patient record and adds that stay to 
another patient record as a new stay. The original demographics of the stay record are replaced with 
the demographics of the new patient record. 
To move a stay record, first search for the patient record that you want to move.  When the Patient 
Maintenance window displays for the selected patient, click the Edit button on the toolbar. Then 
click the Omove toolbar button. The Move Stay window (Figure 1-78) is displayed. 

 
Figure 1-78. Move Stay Window 

Merge To 
The Merge To area contains information regarding the patient where the new stay will be 
moved. The Stays To field lists stays already associated with the patient. The data defaults 
to the patient selected during the initial search. To change the patient, click the  button and 
select a new patient. 

Merge From 
Select the patient record from which you want to move the stay. Click the  button to 
display the Patient Lookup window to make a selection.  

Move Stays Button 
After entering all of the necessary data, click the Move Stays button to move the stay in the 
Stays From field to the patient record in Merge To area. 

Arrow Buttons 

To move a stay from the Stays To field back to the Stays From field, click . 
OK Button 

Confirm and complete the move by clicking OK. 
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Old Cases 

The Old Cases option allows you to enter old cases from paper files into SoftPath. This option is 
helpful if old cases were not transferred from a previous computer system or were manually entered 
during the installation process. The system archives this information and associates all cases with the 
appropriate patient record. The old cases can be stored indefinitely and accessed online from all 
options. 
To access the Old Cases option, select Order > Old Cases from the main menu. The Old Cases 
Browser window (Figure 1-79) is displayed. 

 
Figure 1-79. Old Cases Browser Window 

The Old Cases Browser window allows you to search for patients from the active database, the lab 
database, and the old cases database. In addition, new patients and cases can be added to the archive 
database. 
Enter any necessary search criteria for searching for a patient and then choose one of the following 
buttons:  
Find Button  

Click the Find button to search for patients and cases registered in the archive database. If 
you are searching by case number, clicking the Find button displays the Old Cases window 
for this case, allowing you to enter old case data. If you are searching using the patient 
demographic criteria, clicking the Find button displays a list of matching patients in the grid. 
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Import Active Button 
Click the Import Active button to search the Active database using the entered search 
criteria. 

Import LAB 
Click the Import LAB button to search the Lab database using the entered search criteria. 

After the search results have displayed, select the desired patient by highlighting the appropriate row 
and clicking OK. If any old cases are found for the patient, they are displayed on the Cases tab with 
the most recent cases listed first. Click the New Case button to add an old case to an existing patient 
record. 
If you select an existing case, the Old Cases window (Figure 1-80) is displayed with the required 
patient demographics inserted. If you are adding a new patient, the Old Cases window displays with 
blank fields. The top portion of the window contains patient demographics for the selected patient 
and the case number in READ ONLY format. 

 
Figure 1-80. Old Cases Window 
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Patient/Case Tab 
The Patient/Case tab allows you to enter patient demographics and case data for the current record. 
Enter the original case number, as it appears on the paper file or as registered by a previous system, 
in the Old Case Number field. The required fields on this tab are the MRN, Case Type, and Sign 
Out Date fields. After the old case is saved, you cannot modify the Sign Out Date field because it 
determines which accession number is assigned to the case.  

 
Figure 1-81. Old Cases Window – Patient/Case Tab 
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Specimens Tab 
The Specimens tab allows you to enter data describing the specimens submitted for the old case. 
You must enter at least one specimen. 

 
Figure 1-82. Old Cases Window - Specimen Tab 

Received Date 
Enter the date the specimen was received or click the  button to display a calendar to make 
a selection. Maximum 8 numeric characters using the mm/dd/yyyy format. 

Add Button 
Click this button to add a new specimen to the case. Enter specimen data in the available 
fields. 

Delete Button 
Click this button to delete the currently selected specimen from the case. 
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Diagnoses Tab 
The Diagnosis tab is used to enter new diagnosis codes or to delete existing diagnosis codes for the 
old case. The diagnosis codes are specific for each case type (e.g., surgical, gynecological, medical, 
etc.). This tab displays the diagnosis code, the class of the diagnosis code, and a description of the 
diagnosis code.  

 
Figure 1-83. Old Cases Window - Diagnoses Tab 

Add Code Button 
Click this button to add a new diagnosis code to the old case. This procedure is described in 
detail in Chapter 4 - Results Entry. 
NOTE: Diagnosis codes are only available if the case type is defined in the system. 

Delete Code Button 
Click the Delete Code button to delete the currently selected diagnosis code. 

DX Cascade Button  
If an appropriate diagnostic cascade has been defined for the case type, click the Dx 
Cascade button to automatically insert the diagnosis text and codes in the appropriate fields. 
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Final Diagnosis Tab 
This tab provides a text window that allows you to enter the final diagnosis text for the old case. If 
cascading windows have been set up, you have the option of cascading the windows that are defined. 
By doing this, the codes associated with the diagnosis text and the text associated with the windows 
is automatically inserted. After the text has been inserted, it can be edited. 

 
Figure 1-84. Old Cases Window - Final Diagnoses Tab 
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Old Reports Tab 
The Old Reports tab displays all reports for old cases that have been converted into PDF format. 
Select the reports you want to view/print by marking the corresponding checkboxes in the Sel 
column. You can also click Mark All to select all displayed reports.  
NOTE: This tab only displays if the database contains old reports from SoftPath with Word 

Perfect that have been converted into PDF format. 
Click View to preview the selected reports on your screen. Click Print to send the selected reports to 
a designated printer. 

 
Figure 1-85. Old Cases Window - Old Reports Tab 
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Chapter 2. Processing 

The Processing menu options allow you to access various methods of processing specimens. The 
Processing menu also allows you to record and track the staining quality of new reagent lots used for 
staining and monitor trends in stain quality. 

 
Figure 2-1. Processing Menu 
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SoftPath Processing Menu Options 
The SoftPath Processing option contains the following features and applications: 

One Case Processing 
To process one case at a time, select the One Case Processing option.  
See Chapter 2.1—Processing: One Case Processing. 

Worklists 
To process the registered specimens in real-time through all processing milestone at all 
workstations in the laboratory, select Worklists.  
See Chapter 2.2—Processing: Worklists. 

Fast Processing 
To batch-select cases for specimen processing, block embedding, block processing, slide 
staining, and slide labels select Fast Processing.  
See Chapter 2.3—Processing: Fast Processing. 

Slide Labels 
To print no signed out or reprinted labels in batch mode, select the Slide Labels option.  
See Chapter 2.4—Processing: Slide Labels.  

Print Cassettes 
To print cassette labels for selected cases, select the Print Cassettes option.  
See Chapter 2.5 – Processing: Print Cassettes. 

Recuts  
To add a recut to a particular block and apply a selected stain to slides, select the Recuts 
option.  
See Chapter 2.6—Processing: Recuts. 

Stain Evaluation 
To enter quality control information for stain batches, select the Stain Evaluation option.  
See Chapter 2.7—Processing: Stain Evaluation. 
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One Case Processing 

The One Case Processing option allows you to process a single case, including specimen 
processing, block processing, block embedding, block cutting, and slide staining. 
To access the One Case Processing option, select Processing > One Case Processing from the main 
menu. The One Case Processing Search window (Figure 2-2) is displayed.  

 
Figure 2-2. One Case Processing Search Window 

Select the Advanced Search tab to perform a more specific search. Included on this screen are fields 
for outside case number (for incoming consultations) and procedure date.  

 
Figure 2-3. One Case Processing Search Window – Advanced Search Criteria 

Select the Pending Cases tab to perform a search for pending cases.  
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Figure 2-4. One Case Processing Search Window – Pending Cases Tab 

Enter search criteria for the case that you want to process and click Find; the system displays a list of 
cases that match the specified criteria on the Cases tab. Select a case and click OK. The Specimen 
Processing window (Figure 2-5) is displayed, containing data for the case. 

 
Figure 2-5. Specimen Processing Window – One Case Processing Tab 
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Case Subtab 
The Case tab (Figure 2-6) displays the case demographics that were entered during Specimen 
Registration. This tab also contains buttons that allow you to enter additional case-specific 
information. 

 
Figure 2-6. Specimen Processing Window – One Case Processing Tab – Case Subtab 

Case Flags Button 
Click the Case Flags button to display the Case Flags window (Figure 2-7), which is used to 
enter processing problem codes for the case. 

 
Figure 2-7. Case Flags Window 

Intraoperative Consultation 
Displays the number of intraoperative consultations for the case. 

NOTE:  This field will only display as active if the system is configured to capture billing charges at 
the case level. 
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For ID Only 
Enter the number of units. This number is used for billing procedures. 

Clinical Info Button 
Click the Clinical Info button to display the clinical information entered during specimen 
registration. You can enter additional free-text comments in this window. 

Operation Button 
Click the Operation button to display the operation information entered during specimen 
registration. You can enter additional free-text comments in this window. 
UDF ButtonClick this button to display the User Defined Flag(s).   
Orders ButtonClick the Orders button to review and process additional orders placed for the 
case from Results Entry, Quality Assurance, and Sign Out Entry options. 
 

NOTE:  Cassettes can automatically be printed when saving the block information if the option 
setting “AutoPrint Cassettes from One Case Processing” is activated. 
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Specimen Surgical Subtab 
The Specimen Surgical subtab (Figure 2-8) only displays for surgical cases and is used to process 
specimen information for the current case. 
NOTE: On every specimen tab, data will display in read-only mode if the specimen has been 

flagged as rejected. See Chapter 6.1 – Setup: Setup Files, Quality Codes section for 
more information.  

 
Figure 2-8. Specimen Processing Window - One Case Processing Tab - Specimen Surgical 
Subtab 

Primary Blocks 
Enter the number of primary blocks. 

Regross Blocks 
Enter the number of regross blocks. 

Touch Prep Slides 
Enter the number of touch prep slides. 

FS Blocks 
Enter the number of FS blocks. 

Pieces 
Enter the number of pieces of tissue submitted for the case. 

Smear Slides 
Enter the number of smear slides 
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FS D&T 
Enter the date and time that the frozen section was reported to the surgeon. This field 
defaults to the current date and time when the first FS block is entered and is modifiable. 
This field is used in the calculation of the FS TAT report. 

Gross IOC 
Enter the number of specimens submitted for Gross IOC. 

IOC 
Enter the number of Intraoperative consultations performed for the specimen. Display of this 
field is dependant on the parameter rh_HOW_BILL. 

Modifier 
If the source code does not adequately define the source, enter an additional free-text 
definition. If the source files are constructed with the basic source types, this will be needed 
for more specification. 

Source Flags Button 
Click the Source Flags button to display the Source Flags window (Figure 2-9) for entering 
additional information concerning the specimen source.  

 
Figure 2-9. Source Flags Window 

Multiple Pieces 
Mark this check box to flag the specimen for multiple (uncounted) pieces. When this check 
box is marked, the Number of Pieces field is disabled. 

Comment Button 
Click this button to add a specimen comment in the Specimen Comment window. 



SoftPath GUI v.4.2.1 User Manual Chapter 2.1 – Processing: One Case Processing 

PATH4.2-G-U (6th Ed, Rel. 01/31/07)   Page 2-9 

Special Tests Button 
Click the Special Tests button to display the Special Tests window (Figure 2-10) for adding 
a special stain to a specimen.  

 
Figure 2-10. Special Tests Window 

Special Test 
Enter the special stain/test code for the specimen in the Special Test field or click 
the  button to select an appropriate code from the list. 

Block/Material 
Use the drop-down list to select a block or slide for the material to be stained. 



Chapter 2.1 – Processing: One Case Processing SoftPath GUI v.4.2.1 User Manual 

Page 2-10   PATH4.2-G-U (6th Ed, Rel. 01/31/07) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 



SoftPath GUI v.4.2.1 User Manual Chapter 2.1 – Processing: One Case Processing 

PATH4.2-G-U (6th Ed, Rel. 01/31/07)   Page 2-11 

Specimen Autopsy Subtab 
The Specimen Autopsy subtab (Figure 2-11) only displays for autopsy cases and is used to process 
specimen information for the current case. Enter the appropriate number of blocks and slide 
information for the specimen.  

 
Figure 2-11. Specimen Processing Window – One Case Processing Tab - 
Specimen Autopsy SubtabPrimary Block 

Enter the number of primary blocks. 
Cell Block 

Enter the number of cell blocks for the specimen. 
Smear 

Enter the number of smears. 
Regross Block 

Enter the number of regross blocks. 
Pieces 

Enter the number of pieces of tissue submitted for the case. 
Gross IOC 

Enter the number of specimens submitted for Gross IOC. 
Touch Prep. 

Enter the number of touch prep slides. 
Cytocentrifuges 

Enter the number of cytocentrifuges. 
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Membrane Filters 
Enter the number of membrane filters. 

Monolayers 
Enter the number of monolayers. 

IOC 
Enter the number of Intraoperative consultations performed for the specimen. Display of this 
field is dependant on the parameter rh_HOW_BILL. 

FS Block 
Enter the number of FS blocks. 

FS D&T 
Enter the date and time that the frozen section was reported to the surgeon. This field 
defaults to the current date and time when the first FS block is entered and is modifiable. 
This field is used in the calculation of the FS TAT report. 

Modifier 
If the source code does not adequately define the source, enter an additional free-text 
definition. If the source files are constructed with the basic source types, this will be needed 
for more specification.  
Gross Description ButtonClick the Gross Description button to display the Gross 
Description window (Figure 2-12), which allows you to enter Gross Description 
information such as the color, volume, and appearance of the specimen. This information 
will be included in the gross description section of any reports for this case. 

 
Figure 2-12. Gross Description Window 

Source Flags Button 
Click the Source Flags button to display the Source Flags window (Figure 2-9) for entering 
additional information concerning the specimen source.  

Special Tests Button 
Click the Special Tests button to display the Special Tests window (Figure 2-10) for adding 
a special stain to a specimen.  

Multiple Pieces 
Mark this check box to flag the specimen for multiple (uncounted) pieces. When this check 
box is marked, the Number of Pieces field is disabled. 
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Comment Button 
Click the Comment button to open the Specimen Comment window for adding a comment 
about the specimen. 
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Specimen Gynecological Subtab 
The Specimen Gynecological subtab (Figure 2-13) only displays for gynecological cases and is used 
to process specimen information for the current case. Enter the appropriate number of monolayers 
and smear slides for the specimen. 

 
Figure 2-13. Specimen Processing Window – One Case Processing Tab - 
Specimen Gynecological Subtab 

Smear Slides 
Enter the number of smear slides submitted if not entered during Specimen Registration. 

Monolayers 
Enter the number of monolayers submitted if not entered during Specimen Registration. 

IOC 
Enter the number of Intraoperative consultations performed for the specimen. Display of this 
field is dependant on the parameter rh_HOW_BILL. 

Modifier 
If the source code does not adequately define the source, enter an additional free-text 
definition. If the source files are constructed with the basic source types, this will be needed 
for more specification. 

Source Flags Button 
Click the Source Flags button to display the Source Flags window (Figure 2-9) for entering 
additional information concerning the specimen source. 

Special Tests Button 
Click the Special Tests button to display the Special Tests window (Figure 2-10) for adding 
a special stain to a specimen. 
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Comment Button 
Click the Comment button to open the Specimen Comment window for adding a comment 
about the specimen. 
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Specimen Medical Subtab 
This Specimen Medical subtab (Figure 2-14) only displays for MED cytology cases and is used to 
process specimen information for the current case. Enter the appropriate number of smear slides, 
monolayers, cytocentrifuges, membrane filters, and cell blocks for the specimen 

 
Figure 2-14. Specimen Processing Window – One Case Processing Tab - Specimen 
Medical Subtab 

Smear Slides 
Enter the number of smear slides. 

Monolayers 
Enter the number of monolayers. 

Cytocentrifuges 
Enter the number of cytocentrifuges. 

Membrane Filters 
Enter the number of membrane filters. 

Cell Blocks 
Enter the number of cell blocks. 

IOC 
Enter the number of Intraoperative consultations performed for the specimen. Display of this 
field is dependant on the parameter rh_HOW_BILL. 

Touch Preps 
Enter the number of touch prep slides. 
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Modifier 
If the source code does not adequately define the source, enter an additional free-text 
definition. If the source files are constructed with the basic source types, this will be needed 
for more specification. 

Gross Description Button 
Click the Gross Description button to display the Gross Description window (Figure 2-15), 
which allows you to enter Gross Description information such as the color, volume, and 
appearance of the specimen. This information will be included in the gross description 
section of any reports for this case. 

 
Figure 2-15. Gross Description Window 

Special Tests Button 
Click the Special Tests button to display the Special Tests window (Figure 2-10) for adding 
a special stain to a specimen. 

Source Flags Button 
Click the Source Flags button to display the Source Flags window (Figure 2-9) for entering 
additional information concerning the specimen source. 

Comment Button 
Click the Comment button to open the Specimen Comment window for adding a comment 
about the specimen. 
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Blocks Subtab 
The Blocks subtab (Figure 2-16) displays for all case types except for gynecological cases. 
Information on this tab includes the specimen code, number of blocks submitted for the case, 
processing status of the blocks, and the number of pieces submitted for each block. 
The Blocks tab allows you to complete block-specific actions, including block 
embedding/unembedding, block re-embedding, adding slides and recuts to selected blocks, splitting 
blocks, deleting blocks, and deleting and updating slides. 

 
Figure 2-16. Specimen Processing Window – One Case Processing Tab - Blocks Subtab 

Complete Cutting 
Mark the Complete Cutting checkbox to flag cutting as complete. 

Multiple Pieces 
Mark this check box to flag the specimen for multiple (uncounted) pieces. When this check 
box is marked, the Number of Pieces field is disabled. 

Number of Pieces 
Enter the number of pieces submitted for the selected block. 

Embed/Unembed Button 
Click the Embed button to change the block status from Prepared to Embedded. If the 
block status is Embedded, click Unembed to change the status to Prepared. 
NOTE: You cannot unembed a block if slides are associated with the block. 

Re-Embed Button 
Click the Re-Embed button to re-embed the selected block(s). If the selected blocks have 
not been embedded, the system prompts that the block was not successfully re-embedded. 
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Add Slide Button 
To add new slides to the block, enter the number of slides you want to add in the adjacent 
field and click the Add Slide button.  
 
If the block has a Prepared status, the system prompts: “Block Not Embedded. Confirm 
Embedding?” Click Yes to embed the block and add the new slide(s) or No to cancel the 
operation. 

Add Recut Button 
Select a block and click Add Recut to add a recut to the selected block. You can only add 
recuts to blocks that have been embedded. If the selected block has not been embedded, the 
system asks if you want to embed the block when you click Add Recut. If you click Yes, the 
block is embedded and a new recut is added. 

Delete Last Slide Button 
Click the Delete Las Slide button to remove the last level from the selected block. If the last 
level cannot be deleted, the system prompts that you cannot delete the level. 
NOTE: If the slides are stained, you must first delete the stain. 

Update Last Slide Button 
Click the Update Last Slide button to update the last cut slide in the selected block with the 
value entered in the adjacent field.  
EXAMPLE: If a selected block was entered as 1 but should have been a 7, enter 7 in the 

adjacent field and click the Update Last Slide button instead of having to 
delete and add a new slide. The entry of 1 is now replaced as 7. 

Add Default Slides Button 
Click the Add Default Slides button to add a default level to the selected block. Default 
values are defined in the Source file for the specimen code. If the default levels in the Source 
file have not been defined, the system uses the default levels from the Options file. 

Split/Unsplit Block Button 
This button allows you to split one block into two or more separate blocks. In the adjacent 
field, enter the number of pieces that you want the block to be split into and then click the 
Split Block button.  
EXAMPLE: If you split a block into three separate blocks, two new rows with the blocks 

appear on the list of blocks. 
Delete Curr Block Button 

Select the block you want to delete and click the Delete Curr Block button to remove the 
selected block from the grid and the tree. 
NOTE: If any slides are associated with the block, the slides must be deleted before the 

block can be deleted. 
Block Flags Button 

Select a block and click the Block Flags button to display the Block Flags window (Figure 
2-17), which window allows you to set flags that specify additional information for the 
selected block.  The available block flags are system defined. 
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Figure 2-17. Block Flags Window 

Block Code 
This field displays the sequence code for the selected block. 

EM Block 
Mark this checkbox if the block is to be processed for electron microscopy 
studies. 

Cryo Tissue Bank 
Mark this checkbox if the selected block is to be sent to the cryogenic tissue 
bank. 

Decal Block 
Mark this checkbox to tag a specific block for the decalcification procedure. 
If you mark this checkbox, the workload units (for SoftWorkload™) and 
billing charges will be captured. 

Block with B5 
Mark this checkbox to tag the block for a B5 procedure. If you mark this 
checkbox, the workload units (for SoftWorkload™) and billing charges will 
be captured. 

Control Reference 
Mark this checkbox if the block is suitable for use as a stain control block. 
Click the  button to display the Special Stains/Tests Lookup window. 
Select the required stain code for the block from the list.  Blocks marked as 
control reference are recorded in the ODBC report “Control Reference 
Block Cases Log”. 

Cell Suspensions 
 Mark this checkbox if the block was produced from a suspension. 
Hold for One Day 

Mark this checkbox to hold the block until the next day.  
NOTE: In the Options file, you can specify that the block should be 

released after 24 hours; if this setting is not active, the block 
will not be released. 

Cancelled 
Mark this checkbox to stop the block processing. The system removes the 
block from all further processing procedures and worklists. All of the billing 
charges and workload activities are captured and incurred up to this point. 
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To cancel a block after the night billing run or after labels have been printed, 
remove all of the labels and recuts first. A block can only be canceled after 
all the slides and stains have been removed. A credit is automatically 
captured if the block has been canceled prior to the first billing/workload 
run. You can manually credit previously billed blocks by using the Billing 
Entry option.  

Completely Used 
Mark this checkbox to indicate that the whole block/specimen was used 
during the procedure and that no further processing is permitted. 

Fixatives 
Use the drop-down list button to select the fixatives used when applying a 
specific fixative to a given block other than the standard fixative. The 
available fixatives are defined in the Simple Codes option. Up to three 
fixatives can be selected. 

Number of Recuts 
This field displays the number of previously ordered recuts. This is a READ 
ONLY field. 

Number of Restains 
This field displays the number of previously ordered restains. This is a 
READ ONLY field. 

Inventory Button 
Click the Inventory button to display the Block Inventory Information window (Figure 
2-18), which allows you to enter information concerning the block and slide locations. The 
default locations are specified in the Options > Specimen Processing tab > Universal 
Settings subtab.  
Select a slide from the drop-down list. The default location code associated with the slide 
displays in the corresponding Location field.  

 
Figure 2-18. Block Inventory Information Window 
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Slide Stain Subtab 
The Slide Stain subtab (Figure 2-19) allows you to add or delete standard and special stains to/from 
a selected slide. Select a slide by highlighting the slide on the list and then clicking Mark Selected. 
Click Mark All to select all displayed blocks. 
NOTE:  When a standard stain is not specified in Options, the system will display the "Standard 

stain is not defined" message. 

 
Figure 2-19. Specimen Processing Window – One Case Processing Tab - Slide Stain 
Subtab 

Add Standard Stain Button 
Click the Add Standard Stain button to add a standard stain to the selected slide. The 
default standard stain is defined in Setup > Options > Specimen Processing tab > 
Universal Settings subtab. 
NOTE: If a standard stain has not been defined, the “Standard Stain not defined” 

message is displayed and the action is cancelled. 
Add Special Stain Button 

To add a special stain to the currently selected slide, click the  button and select the special 
stain from the Special Stains/Tests Lookup window. Click the Add Special Stain button to 
add the special stain and update the list. 

Add Std All Button 
Click this button to add the standard stain to all slides. The default standard stain is defined 
in Setup > Options > Specimen Processing tab > Universal Settings subtab. 
NOTE: If a standard stain has not been defined, the “Standard Stain not defined” 

message is displayed and the action is cancelled. 
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Del Std All Button 
Click the Del Std All button to delete the standard stain from all of the slides. 

Delete Stain Button  
Click the Delete Stain button to delete the last stain from the selected slides. 

Mark All 
Click the Mark All button to mark all of the stains. 

Mark Selected 
Click the Mark Selected button to mark only the selected stains. 

Stain Panel Wizard 
Click the Stain Panel Wizard button to open the Stain Panel Wizard window (Figure 
2-20), which provides greater control over panels and the slides that should be stained by 
those panels.  

 
Figure 2-20. Stain Panel Wizard Window 

To begin, select an available panel from the Panel drop-down list near the top of the 
window. A list of the stains contained within that panel will populate. The list of slides 
already included in the block is shown on the right side of the window. From there, select a 
slide and click the left direction arrow to add that slide to the panel. To remove that slide, 
simply click the right-facing arrow. To add or remove all of your slides, click the left or 
right-facing double arrows. 
Ordered Panels 

The Ordered Panels grid displays previously ordered panels that have not yet been 
completed. The Apply button allows you to apply your slides to those panels as well. 

Add Recuts 
Click the Add Recuts button to order additional recuts for the block. 

Add Slides 
Click the Add Slides button to order additional slides for the block. 
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Worklists 

The Worklists option is used to process registered specimens at the various workstations typically 
found in a pathology laboratory. This processing can be computer interactive or non-interactive. 
Both methods accommodate workload capturing. The associated processing logs are produced from 
the data regardless of the method used. 
The interactive method processes the specimen with electronic worksheets, which allows for real-
time distribution of the assigned work on the workstation where the technologist is entering data. 
The non-interactive method assumes that printed worksheets are created and used to distribute 
work. The data is written on the worksheets and later entered into the database by a technologist. 
To access the Worklists option, select Processing > Worklists from the main menu. The Worklists 
Search Screen window (Figure 2-21) is displayed.  

 
Figure 2-21. Worklists Search Screen Window 

To search for pending cases, specify the date range you want to search and select a sorting method 
for the displayed results. To further narrow the search, enter additional search criteria in the available 
fields. After entering all search criteria, click the Find button. All cases matching the specified 
criteria are displayed on the Specimen Processing Worklist tab (Figure 2-22). 
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Specimen Processing Worklist Tab 
The Specimen Processing Worklist tab (Figure 2-22) is used to process large numbers of 
cases/specimens. Only specimens that have been registered, but not processed, qualify for this 
worklist. Primary blocks, additional blocks, cytocentrifuges, membrane filters, smear slides, cell 
blocks, frozen section blocks, regross blocks, monolayers, and touch preps can be entered for each 
case. You can also add or remove blocks, regross blocks, cytocentrifuges, membrane filters, smear 
slides, cell blocks, frozen section blocks, monolayers, and touch preps. The default values for each of 
the material types are defined in the Source file. You can choose to have SoftPath® automatically 
add these defaults to the worklists in the Options file. 
NOTE: The specimen processing worklist can be printed for non-interactive use. 
The left side of the Specimen Processing Worklist tab consists of the Case Tree. The first level of 
the tree is the case number. Click  to expand the tree and display the specimen(s) registered for the 
case. Highlight the specimen you want to process and then enter data concerning the selected 
specimen in the fields on the right side of the tab.  
NOTE: If a specimen has been flagged as rejected, the specimen’s information will appear in 

read-only format. See Chapter 6.1 – Setup: Setup Files, Quality Codes section for 
more information. 

 
Figure 2-22. Specimen Processing Window – Worklists Tab – Specimen Processing 
Worklist Subtab 
Source 

Edit the source of the specimen by keystroke or click the  button to select from a list of 
valid source codes. 

Modifier 
If the source code does not adequately define the source, enter an additional free-text 
definition. If the source files are constructed with the basic source types, this will be needed 
for more specification. 
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Specimen Comment 
Enter a free-text specimen comment, if needed.  

Block 
Enter the number of blocks. 

TP 
Enter the number of touch prep slides. 

Smear 
Enter the number of smear slides for the specimen. 

Regross 
Enter the number of regross blocks. 

Multiple Pieces 
Mark this check box to flag the specimen for multiple (uncounted) pieces. When this check 
box is marked, the Number of Pieces field is disabled. 

Compl. 
Select the Compl. Check box to mark the slide as completed. 

Monol 
Enter the number of monolayers for the specimen. 

Cytoc 
Enter the number of cytocentrifuge slides for the specimen. 

Membr 
Enter the number of membrane filters for the specimen. 

Cell 
Enter the number of cell blocks for the specimen. 

Pieces 
Enter the number of pieces of tissue submitted for the case. 

FS 
Enter the number of frozen section blocks. 

FS D&T 
Enter the date and time that the frozen section was reported to the surgeon. This field 
defaults to the current date and time when the first FS block is entered and is modifiable. 
This field is used in the calculation of the FS TAT report. 

Gross IOC 
Enter the number of specimens submitted for Gross IOC. 



Chapter 2.2 – Processing: Worklists SoftPath GUI v.4.2.1 User Manual 

Page 2-28   PATH4.2-G-U (6th Ed, Rel. 01/31/07) 

Block Pieces Button 
Click the Block Pieces button to display the Block Pieces window, which contains 
information about how many pieces the block is cut into. You can change the number of 
pieces by clicking the Pieces column and entering the new number. 

 
Figure 2-23. Block Pieces Window 

Source Flags Button 
Click the Source Flags button to display the Source Flags window (Figure 2-24) for 
entering additional information concerning the specimen source. This can also be done at the 
specimen level by highlighting the specimen id first. 

 
Figure 2-24. Source Flags Window 

Mark/Unmark All Button 
Click this button to mark or unmark all cases as completed. 

Find Case Button 
Click the Find Case button to display the Processing/Worklists, Find window (Figure 
2-25) for quickly searching for a case contained in the case tree. Enter the case number to 
search for in the Case # field and the system searches and highlights the case. Click Close to 
return to the list.  
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Figure 2-25. Processing/Worklists, Find Window 

Processing History Button 
Click the Processing History button to display the Processing History window (Figure 
2-26), which contains information concerning all of the actions performed on the case, 
including the date and time the operation was performed, the ID of the person that performed 
the action, and the procedure/action performed. 
NOTE: The Processing History window displays in READ ONLY format and cannot 

be edited. 

 
Figure 2-26. Processing History Window 

The Orders History button displays the Orders History window (Figure 2-27), a read-only 
window that displays all activity related to orders collected from the Order Stains/Slides 
window. 
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Figure 2-27. Orders History Window 

Print List Button 
Click the Print List button to print a list of cases that need to be processed.  

Print Preview Button 
Click the Print Preview button to preview the worklist on your screen. 
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Block Embedding Worklist Subtab 
The Blocks Embedding Worklist subtab (Figure 2-28) provides information specific to each block 
(such as the number of tissue pieces, special embedding instructions, etc.) and can be printed for 
non-interactive use.  
Select the blocks you want to embed by double-clicking them. Click the Save button on the toolbar 
to complete the embedding process. Embedded blocks are removed from the tree. 

 
Figure 2-28. Specimen Processing Window – Worklists Tab – Block Embedding Worklist 
Subtab 

Embed All 
Click this button to embed all. 

Find Case, Processing History, Print Preview and Print List Buttons 
These function buttons are described page 2-29. 
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Block Processing Worklist Subtab 
The Block Processing Worklist subtab (Figure 2-29) is used to add levels and/or recuts to 
embedded blocks. The block processing worklist can be printed for non-interactive use. The cases, 
slides, and blocks appear on the tree located on the left side of the tab in the Cases Tree. 
Data entered during specimen registration and/or specimen processing and information entered on 
the Specimen Processing Worklist and Blocks Embedding Worklist tabs is displayed. The case 
number, source, and priority fields cannot be modified. 
Select the block that you want to process by highlighting it on the Cases Tree. 

 
Figure 2-29. Specimen Processing Window – Worklists Tab – Block Processing Worklist 
Subtab 

Add Slide Button 
To add an additional slide to the selected block, enter the number of slides you want to add 
in the adjacent field and then click the Add Slide button. The block is updated immediately. 

Update Slide Button 
If you want to update the last number of slides cut on a block, highlight the block on the tree 
and enter the new number of slides in the adjacent field. Click the Update Slide button to 
change the slide count to the specified value. 

Completed 
Select the Completed checkbox to complete the selected block. A completed block is 
marked with a red checkmark on the Cases Tree. 

Add Recut Button 
Click this button to perform a recut for the selected block. Recuts are displayed as a lower 
case r. The block is updated immediately. 
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Delete Last Slide Button 
To delete the last slide assigned to a block, select the block on the tree and click the Delete 
Last Slide button. 

Pieces # 
Enter the number of pieces of the specimen that were received during specimen registration. 
The default is zero (0). Maximum of three numeric characters. 
Orders ButtonIf orders have been placed from the Order Stains/Slides window, the 
checkbox next to this button will be marked. Click the Orders button to review and process 
these 

orders.  
Figure 2-22. Orders window 

Selecting the Process button for the selected (highlighted) material will change the status to 
Sld Done and allow the order to be pending for the Stains Worklist. Click the Close button 
to return to the Block Processing Worklist tab.  

Mark/Unmark All Button 
Click this button to mark or unmark all. 

Find Case, Processing History, Print Preview and Print List Buttons 
These function buttons are described page 2-29. 
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Stains Worklist Subtab 
The Stains Worklist subtab (Figure 2-30) is used to add and/or delete stains from processed blocks. 
The stains worklist can be printed for non-interactive use.  
The Stains Worklist subtab displays a tree that contains slides for processing. The information 
displayed varies depending on the type of specimen. Data entered during specimen registration 
and/or specimen processing and information entered on the Specimen Processing Worklist, Blocks 
Embedding Worklist, and Blocks Processing Worklist tabs is displayed. The case number, source, 
and priority fields cannot be modified.  
NOTE:  When a standard stain is not specified in Options, the system will display the "Standard 

stain is not defined" message. 

 
Figure 2-30. Specimen Processing Window – Worklists Tab – Stains Worklist Subtab 

Add Std Stain Button 
Click the Add Std Stain button to add a standard stain to the selected slide. The default 
standard stain is defined in the Options file. 

Add Spec. Stain Button 
To add a special stain to the selected slide, click the  button for the field below this button 
and select the appropriate stain from the Special Stains/Tests Lookup window. Click the 
Add Special Stain button to add the specified special stain. 

Add Std All Button 
Click the Add Std All button to add the standard stain to all slides. The default standard 
stain is defined in the Options file. 

Del Std All Button 
Click the Del All button to delete the standard stain from all of the slides in the selected 
block. 
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Delete Stain Button 
Click the Delete Stain button to delete the last stain from the selected slides. 

Unmark/Mark All Button 
Click the Unmark/Mark All button to unmark or mark all the stains. 

Unmark/Mark Select Button 
Click the Unmark/Mark Select button to unmark or mark the selected stains. 

Orders Button 
Click the Orders button to review and process orders placed from Result Entry/QA/Sign 
Out for additional materials on the case.  Select the process button for the select material to 
change the status to Done. 
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Fast Processing 

The Fast Processing option allows you to batch-select cases for specimen processing, block 
embedding, block processing, slide staining, and slide labels. In addition, this option allows you to 
process a group of cases based on a specified case type and priority level. 
To access the Fast Processing option, select Processing > Fast Processing from the main menu. The 
Fast Processing Search window (Figure 2-31) is displayed. 

 
Figure 2-31. Fast Processing Search Screen Window 

To search for a batch of cases to process, enter a date range and the case types that you want to 
include in the search. You can enter additional search criteria, such as case priority, clinic code, case 
prefix, or cases pending for specified processing procedures. After entering all search criteria, click 
the Find button. The Fast Processing tab (Figure 2-32) is displayed with a list of cases that match 
the search criteria. The displayed information includes the case number, number of blocks, special 
stains, cell blocks, smears, etc. 

 
Figure 2-32. Specimen Processing Window – Fast Processing Tab 
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If the value in a column is divided by a slash (e.g. Embed 1/1), then read it as follows: 

Left / Right 

Number of materials processed  / Total amount of materials,  
both processed and un-processed. 

If you highlight a row with a case, the source and stains for the case appear in the Sources and 
Stains fields below the grid, and the case number appears in the Current Case # field to the right of 
the grid. 
Select any number of cases. Determine the processing functions to be performed on the currently 
selected cases by marking the appropriate Process With checkboxes. The default actions are defined 
in the Options file. 
After you select the cases and processing options, click the Print List button to display the Print 
dialog box. Select a printer to print the list of cases that are available for processing. 
NOTE: If you process the cases prior to printing the list, do not print the list later because the 

cases are no longer pending for processing and will not print on the report. 
At the bottom of the Process With checkboxes are the options for printing slide labels and cassettes. 
The drop-down menus under those options allow you to select the appropriate printer for those tasks. 
The defaults for those printers can be defined in options. For more information about printing slide 
labels, see Slide Labels. For more information about printing cassettes, see Print Cassettes. 
Cassette Printing is only available if it has been selected in Options. 
Select the cases you want to process, confirm the default printer or select a different slide label 
printer, and then click the Process button. The system will process the case(s), print the slide labels, 
and remove the cases from the list.  
NOTE: If all cases have been removed from the list, the following message displays:  “No cases 

found.” Click OK.
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Slide Labels 

The Slide Labels Entry option allows you to print labels in batch mode. Labels for individual cases 
can be printed at various places within the system (e.g. during specimen registration and specimen 
processing). Free text labels with ad hoc information entered can also be printed. 
To access the Slide Labels option, select Processing > Slide Labels from the main menu. The Slide 
Labels Search Screen window (Figure 2-33) is displayed. 

 
Figure 2-33. Slide Labels Search Screen Window 

The Slide Labels Search window allows you to search for a batch of slide labels that you want to 
print. Alternatively, you can click Free Text Labels… to print ad hoc free text labels. To perform a 
search, enter a date range, a case range, the case types you want to include in the search, an accession 
group, and the label print status of the cases you want to include in the list. You may even define 
rules by which your slides will be sorted. The default values for the date range, case types, and label 
print status are defined in the Options file. 
After entering all necessary search criteria, click the Find button. The Slide Labels tab (Figure 2-36) 
is displayed containing a list of cases that match the specified search criteria. 
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Figure 2-34. Specimen Processing Window – Slide Labels Tab 

The left side of the Slide Labels tab contains the Cases Tree. The levels of the tree are as follows: 
• The first level of the tree is the case number 
• The next lowest level is the specimen code 
• The third level is the block code 
• The lowest level is the slides cut 

The right side of the Slide Labels tab consists of read-only fields that display basic information for 
the currently selected case, including the case number, case priority, specimen code, block, and slide 
ID.  
View Button 

After you select labels, click the View button to view the labels on screen. 
Select/Unselect Button 

Click the Select/Unselect button to select/unselect all of the slides displayed on the tree. 
Individual slides can be selected by double-clicking a specific slide within the tree. Selected 
slides are marked with a red checkmark. 

Print Button 
After you select labels, click the Print button. The Select Printer window displays, 
allowing you to view, save, fax, or print the labels. 
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Printing Free Text Labels 
To print free text labels, click the Free Text Label… button on the Slide Labels Search Screen 
window (Figure 2-33).  The Free Text Label Definition Grid window (Figure 2-35) is displayed.  

 
Figure 2-35. Free Text Label Definition Grid Window 

Click the Add button and the Free Text Label window (Figure 2-36) is displayed. 

 
Figure 2-36. Free Text Label Window 

Enter the case number that you want to print the label or click the  button to select from a list of 
cases. Next, enter up to six lines of free text information that you want printed on the slide label. 
Enter the number of copies to be printed and click OK. The Free Text Label Definition Grid 
window displays, displaying the label you just created in the system. 
To define multiple free text at the same time, use the Add function until all desired labels are 
defined. 
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Figure 2-37. Free Text Label Definition Grid Window (with Label) 

If needed, select a label and click the Edit button to edit it. Click the Print button to print all labels 
listed in the grid. Once printing is complete, all entries will be cleared. 
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Print Cassettes 

The Print Cassettes option allows you to send block information to cassette labelers. You can search 
for appropriate cases by accession group or case numbers. Cassette printing can also be performed in 
various places throughout the system, including One Case Processing, Worklists, and Fast 
Processing. 
NOTE: This functionality must be enabled in Setup > Options for this information to be 

applicable for your system. 
To access the Print Cassettes option, select Processing > Print Cassettes from the main menu. The 
Print Cassettes Search Screen window (Figure 2-38) is displayed. 

 
Figure 2-38. Print Cassettes Search Screen Window 

After you enter all search criteria, click the Find button. The Print Cassettes tab (Figure 2-39) is 
displayed with a list of cases that match the specified search criteria. 
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Figure 2-39. Specimen Processing Window – Print Cassettes Tab 

The left side of the Slide Labels tab contains the Cases Tree. The levels of the tree are as follows: 
• The first level of the tree is the case number 
• The next lowest level is the specimen code 
• The third level is the block code 
• The lowest level is the slides cut 

The right side of the Print Cassettes tab consists of read-only fields that display basic information 
for the currently selected case, including the case number, source code, case priority, specimen code, 
and block.  
Select/Unselect Button 

Click the Select/Unselect button to select/unselect all of the slides displayed on the tree. 
Individual slides can be selected by double-clicking a specific slide within the tree. Selected 
slides are marked with a red checkmark. 

Print Button 
After you select labels, click the Print button. The Select Printer window displays, allowing you to 
view, save, or print the labels to the selected printer. The default printer name is defined in the 
Options setup file. 
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Recuts 

The Recuts option allows you to add a recut to a particular block and apply a selected stain to slides. 
This option also allows you to enter the number of levels for each recut, special stains for a particular 
slide, and restains on a single-case basis.   
NOTE: This option is used to process Signed Out cases only. 
To access the Recuts option, select Processing > Recuts from the main menu. The Recuts window 
(Figure 2-40) is displayed. 

 
Figure 2-40. Recuts Search Window 

After entering the search criteria, click the Find button. The system displays all cases matching the 
specified search criteria. Highlight a case and click OK. The Recuts window for the selected case 
displays similar to Figure 2-41. 
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Recuts Tab 

 
Figure 2-41. Recuts Window – Recuts Tab 

The Recuts tab (Figure 2-41) allows you to add recuts, add slides, delete recuts, delete slides, add 
default slides, re-embed blocks, split blocks, and add new blocks. 
Add Recut Button 

Clicking the Add Recut button to add a recut to the selected block. Recuts can only be 
added to blocks that are embedded. If the selected block is not embedded, the system asks 
you to confirm the action after you click the Add Recut button. If you click Yes, the new 
recut is added to the selected block and the list is updated. 

Add Slide Button 
After entering the number of slides you want to add, click the Add Slide button. The new 
slide(s) is added and the grid is updated.  

Delete Recut Button 
Select a block and click the Delete Recut button to delete the last recut for the selected 
block.  

Delete Slide Button 
Click Delete Slide to remove the last slide from the currently selected block.  

Add Def. Slide Button 
Click the Add Def. Slide button to adds the default slide to the currently selected block. The 
default values are defined in the Source file for the specimen code. If there are no default 
slides defined in the Source file, the system takes the default from the Options file instead. 

Re-Embed Button 
Click the Re-Embed button to change the status of the selected block to Embedded.  
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Split/Unsplit Block Button 
The Split/Unsplit Block button is used to split one block into two or more separate blocks. 
Enter the number of pieces to split the block into and click the Split Block button; the block 
is split into the defined number of pieces and the grid is updated. 
EXAMPLE: If you split a block into three separate blocks, two new rows with the blocks 

appear on the grid. 
Mark/Unmark Selected Button 

Click the Mark/Unmark Selected button to mark or unmark the currently selected block. 
Mark/Unmark All Button 

Click the Mark/Unmark All button to mark or unmark all of the blocks on the list. 
Add New Block Button 

Select the option button corresponding to the type of block you want to create (e.g., primary, 
regross, frozen section, or cell block) and click the Add New Block button. The system 
prompts you to confirm embedding of the new block. If you click Yes, the new block is 
added to the grid. 

Multiple Pieces 
Mark this check box to flag the specimen for multiple (uncounted) pieces. When this check 
box is marked, the Number of Pieces field is disabled. 

Number of Pieces 
Enter the number of pieces submitted for the selected block. 

Block Flags Button 
Click the Block Flags button to display the Block Flags window (Figure 2-17). See page 2-
19 for more information about this window.. 

Block Location 
The default block storage location displays in the Block Location field. To change the 
storage location (or if a default location has not been defined), click the  button to display 
the Storage Lookup window. Select a new storage location from the list. 

Save All Data button 
Click this button to save the entered/modified information. The system asks you to confirm 
that all processing has been completed. Click Yes to confirm your changes/additions. 
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Stains Tab 
The Stains tab (Figure 2-42) allows you to add stains to selected slides. 

 
Figure 2-42. Recuts Window - Stains Tab 

To select a slide for performing actions, highlight the slide’s row in the grid and click the Mark 
Selected button. When a slide is selected, the Sel. field is marked. 
Add Regular Stain Button 

Click the Add Regular Stain button to add the default standard stain to the selected slide(s). 
The new stain is added to the selected slide and appears in the Stain column. 
NOTE: If a regular (standard) stain has not been defined, the “Standard Stain not 

defined” message is displayed and the action is cancelled. 
Add Special Stain Button 

In the field adjacent to the Add Special Stain button, click the  button and select the 
special stain to apply to the selected slide; click the Add Special Stain button to apply the 
special stain to the selected slides.  

Delete Stain Button 
Click the Delete Stain button to delete previously applied stain from the selected slide(s). 

Slide Location 
The default slide storage location displays in the Slide Location field. To change the storage 
location (or if a default location has not been defined), click the  button to display the 
Storage Lookup window. Select a new storage location from the list. 

Add New Cytoslide Button 
Select the type of slide you want to add by clicking the corresponding option button (e.g., 
Smear, Monolayer, Cytocentryfuge, and Membrane). Click the Add New Cytology Slide 
button to add a new cytology slide. 

Mark/Unmark Selected  
Click this button to mark or unmark selected stains. 
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Mark/Unmark All 
Click this button to mark or unmark all stains. 

Labels Button 
Click the Labels button to display the Label Print window (Figure 43). Select one or more 
printing options from the list by marking the corresponding Print checkbox. Click  View 
Labels to preview the labels on your screen or Print Labels to send the labels to a specified 
printer or fax machine. 

 
Figure 43. Label Print Window 

Save All Data Button 
Click the Save All Data button to save the information you entered/modified. The system 
asks you to confirm that all processing has been completed. Click Yes to confirm saving all 
changes and additions. 

 



Chapter 2.5 – Processing: Recuts SoftPath GUI v.4.2.1 User Manual 

Page 2-50   PATH4.2-G-U (6th Ed, Rel. 01/31/07) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



SoftPath GUI v.4.2.1 User Manual Chapter 2.6 – Processing: Stain Evaluation 

PATH4.2-G-U (6th Ed, Rel. 01/31/07)   Page 2-51 

Stain Evaluation 

The Stain Evaluation option allows you to enter information about the QC process on batches and 
individual stains as well as documenting QC procedures. 

 
Figure 2-44. Processing Menu – Stain Evaluation Submenu 
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Batch Assignment 

The Batch Assignment option allows you to record quality control (QC) results for new batches of 
stain reagents. 
To access the Batch Assignment option, select Processing > Stain Evaluation > Batch Assignment 
from the main menu. The Batch Assignment Search window (Figure 2-45) is displayed.  

 
Figure 2-45. Batch Assignment Search Window 

To create a new batch click Add New Batch. To edit an existing batch, enter search criteria in the 
appropriate fields and click the Find button. The system displays a list of existing QC batches that 
match the specified criteria. Highlight a batch and click Select to edit the batch in the Batch 
Assignment window. 
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Adding a New Stain Batch 
Click the Add New Batch button to display the Batch Assignment window (Figure 2-46), which 
allows you to add a new stain batch. 

 
Figure 2-46. Batch Assignment Window 

Batch # 
Enter the batch or lot number. You can either manually enter a batch number or leave the 
field blank and the system will automatically generate a batch number. Maximum of 12 
alphanumeric characters, which can be modified in the Options file. 

Stain ID 
Enter the stain code, or click the  button to display the Special Stains/Tests Lookup 
window to make a selection. 

Tech ID 
The Tech ID field defaults to the ID of the user currently logged into the system. To change 
the ID, click the  button to display the Personnel Lookup window to make a selection. 

Created On Date and Time 
Enter the date and time the batch record was created. This field defaults to the current date 
and time. To change the date, click the  button to display a calendar to make a selection. 

Available From and To 
Enter the dates the reagent can be used. This range of dates defines the shelf life of the 
reagent and also determines the period of time allowed for quality control to be completed. 
The dates can be entered manually or you can click the  button to display a calendar to 
make a selection.  

Batch Comment 
Enter any extra information regarding the reagent in this section.  
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# of Control Labels 
Enter the number of control labels that you want to print. The batch control label can contain 
the stain ID, batch ID, creation date and time, ID of the person that created the label, and the 
dates the batch is usable (i.e. shelf life). The actual format of the labels is defined during 
initial system setup. 

Print Labels 
Click the Print Labels button to print the batch labels to a specified printer. The system 
prints the number of control labels you specify in the # of Control Labels field. 

View Labels 
Click the View Labels button to view the labels on screen. The system displays the number 
of control labels you specify in the # of Control Labels field. 
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Stain QC 

The Stain QC option allows you to search for stain batches and record individual stain QC for the 
selected batch. 
To access the Stain QC option, select Processing > Stain Evaluation > Stain QC from the main 
menu. The Stain QC Search window (Figure 2-47) is displayed. Enter search criteria to search for 
stain QC batches pending quality control.  

 
Figure 2-47. Stain QC Search Window – Stain QC Search Tab 

After entering the required search criteria, click the Find button. The system displays a list of 
records that match the specified criteria. Select the record you want to view/modify by highlighting it 
and clicking Select. The Stain QC window (Figure 2-48) is displayed. Batch information is 
displayed in READ ONLY mode. To make changes or add information, click the Edit button on the 
toolbar. 



Chapter 2.6 – Processing: Stain Evaluation SoftPath GUI v.4.2.1 User Manual 

Page 2-58   PATH4.2-G-U (6th Ed, Rel. 01/31/07) 

 
Figure 2-48. Stain QC Window 

Done By 
This field automatically defaults to the ID of the user currently logged into the system, but 
another user ID can be entered, if necessary. To change the ID, click the  button to display 
the Personnel Lookup window. Select a user ID from the list. 

Date and Time 
Enter the date of the stain QC. This field automatically defaults to the current date and time. 
To change the date, click the  button to display a calendar for selection. 

Code 
Select a QC code from the drop-down list. The codes available in the list are defined in the 
Simple Codes option. 

QC Comment 
Enter free text or canned messages in this field to provide additional information regarding 
the stain QC. The QC Comment entered will be displayed in the QC Report. 



SoftPath GUI v.4.2.1 User Manual Chapter 2.6 – Processing: Stain Evaluation 

PATH4.2-G-U (6th Ed, Rel. 01/31/07)   Page 2-59 

Stain QC Report Tab 
The Stain QC Report tab (Figure 2-49) allows you to produce a report containing previously 
entered stain QC results. 

 
Figure 2-49. Stain QC Search Window – Stain QC Report Tab 

Enter the criteria for the report in the appropriate fields and select up to three sort rules for the report 
from the Sort Criteria drop-down lists. Click the Find button to display the report.  
The Stain QC Report contains the stain name, batch comment, QC date and time, user ID of the 
person performing the QC, QC comment, QC code, and batch creation date. Stains that did not have 
QC performed within the time limit are marked with an asterisk (*). 



Chapter 2.6 – Processing: Stain Evaluation SoftPath GUI v.4.2.1 User Manual 

Page 2-60   PATH4.2-G-U (6th Ed, Rel. 01/31/07) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 



SoftPath GUI v.4.2.1 User Manual Chapter 2.6 – Processing: Stain Evaluation 

PATH4.2-G-U (6th Ed, Rel. 01/31/07)   Page 2-61 

Overdue Stain QC 

The Overdue Stain QC option allows you to document overdue stain QC procedures. When the 
user-defined date range for the completion of the stain QC has expired, the pending stain QC is only 
available from the Overdue Stain QC option. 
To access the Overdue Stain QC option, select Processing > Stain Evaluation > Overdue Stain QC 
from the main menu. The Overdue Stain QC Search window (Figure 2-50) is displayed. 

 
Figure 2-50. Overdue Stain QC Search Window 

After entering search criteria, click the Find button. A list of cases that match the specified criteria is 
displayed. Select the case by highlighting it and clicking Select; the Overdue Stain QC window 
(Figure 2-51) will display. 
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Figure 2-51. Overdue Stain QC Window 

The batch information fields are displayed in a READ ONLY format. Click the Edit button on the 
toolbar to complete the stain QC entry. 
Done By 

Enter the user ID of the user that performed the stain QC or click the  button to select a 
user from the Personnel Lookup window. 

Date and Time 
Enter the date and time of the stain QC. 

Category 
Enter the QA category code or click the  button to select from a list of active QC category 
codes. 

Action Comment 
Enter an action comment for the overdue stain QC in this area. Use the toolbar buttons to 
format the text. 
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Chapter 3. Results 

The Results menu options allow you to enter results information in the form of free text, codes or 
canned messages. These menu options also allow you to enter quality assurance information and sign 
out cases. 

 
Figure 3-1. Results Menu 
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SoftPath Results Menu Options 
The SoftPath Results option contains the following features and applications: 

Case Result 
To enter diagnoses and reports for cases, select the Case Result option.  
See Chapter 3.1—Results: Case Result. 

Quality Assurance 
To perform quality assurance procedures, select the Quality Assurance option.  
See Chapter 3.2—Results: Quality Assurance. 

Sign Out Entry 
To perform a sign out procedure on a case, select the Sign Out Entry option.  
See Chapter 3.3—Results: Sign Out Entry. 

IntraDepartmental Consultation 
To enter a Interdepartmental consultation, select the IntraDepartmental Consultation 
option.  
See Chapter 3.4—Results: IntraDepartmental Consultation. 
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Case Result 

The Case Result options allow you to enter diagnoses and reports for cases. 

 
Figure 3-2. Results Menu – Case Result Submenu 

The Case Result menu contains the following sub-options: 
• Results Entry 
• My Results Worklist 
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Results Entry 

The Results Entry option is used to enter intraoperative diagnoses, gross descriptions, 
preliminary/provisional reports, final diagnoses, supplemental reports, and revised reports. If a case 
is completed, but not signed out, you can modify this text without creating a revised report. After a 
case is signed out, you can only make changes by creating a revised report. Importing and modifying 
the final report text is possible when creatinga supplemental or revised report. Alternately you can 
choose to create a new report that contains no text from the previous final report. 
To access the Results Entry option, select Results > Case Result > Results Entry from the main 
menu. The Select Report window (Figure 3-3) is displayed.  

 
Figure 3-3. Select Report Window – Simple Search Tab 

The Select Report window opens with three tabs:  
• The Simple Search tab allows you to search for a single case. Use this option if you know 

the case number, patient name, or MRN. This is also the only option that you can use to 
initially create a revised report or supplemental report.  The screen will be cleared of search 
criteria after a case result has been completed.  A new search can now be started without 
having to clear the previous search criteria. 

• The Advanced Result Search tab allows you to search for and select a range of cases for 
batch entry of diagnostic information. Only cases qualified by the system are available in 
this option. The preliminary, revised, or supplemental report cannot be initially created from 
this option. Cases registered within the system do not automatically qualify for a 
preliminary, revised, or supplemental report; however, once a preliminary, revised or 
supplemental report is created (but is not signed out), it can be edited using this option. 

• The Advanced QA Search tab allows you to search for cases by QA procedures, QA 
screeners, and other QA-related fields.  
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Entered search criteria on any one of the three tabs and click Find; a list of matching cases is 
displayed on the Cases List tab (Figure 3-4). 
NOTE: If only one case matches the specified criteria, the Results tab (Figure 3-5) is displayed. 

 
Figure 3-4. Select Report Window – Cases List Tab 

The Cases List tab provides information such as case number, patient name, pathologist ID, the 
types of reports created for the cases, patient MRN, ward, order date, requesting doctor ID and 
patient billing number.  
To apply the Standard Diagnosis without invoking each report, select the case(s) from the list and 
click the Standard Dx button. The status of the selected case(s) is updated to Final Diagnosis 
complete and is removed from the grid when refreshed. The Final Diagnosis D&T matches the time 
the Standard Dx button is clicked. The Done By ID is captured from the login ID. 
NOTE: When selecting multiple cases, all cases must be the same case type or the Standard Dx 

button is disabled on the window. Also, all cases must all have a status of pending Final 
Diagnosis. 

The Scr Evid portion of the toolbar displays the real-time number of slides previously screened on 
the current day for the Login ID. Based on the Daily Slides Screening limit defined in the Personnel 
Setup File for the login ID, this value displays in green when 11or more slides can still be screened 
or red when the user has 10 or fewer available slides to screen. 
NOTE: If the total number of slides associated to the selected case(s) exceeds the Daily Slides 

Screen Limit value defined in the Personnel setup file, a warning message is displayed 
when trying to open the case(s). Depending upon the options setting "Permission to 
Over-ride Maximum slide limit message", the user is either blocked from proceeding or 
given an option to override and continue. 

Select a case by highlighting the case row and then clicking the OK button. The Results tab (Figure 
3-5) is displayed, which allows you to view and edit the reports available for the first selected case. 
Multiple cases can be selected by marking the Sel checkboxes next to the desired cases before 
clicking OK.  
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Figure 3-5. Select Report Window – Results Tab 

Reports Grid 
The Reports grid displays the creation date, report type, status, and sign out date (if 
available) for the selected case. After a final report is signed out, you cannot select the 
preliminary report type on the Results tab. Multiple preliminary, supplemental, and revised 
reports can be created for one case. The multiple reports are denoted with an incrementing 
alphabetic designation (e.g., Supplemental A, Supplemental B, etc.). The associated case 
number is displayed to the right of the Reports grid for easy reference. 
If another instance of the document is opened, the document is locked and the following 
message is displayed: 

 
Figure 3-6. Locked Document Error Message 

Patient Information Area 
The Patient Information area displays the case number and the patient’s first and last name. 

QA Procedures Grid 
The QA Procedures grid contains a list of available QA procedures for the current case. If 
the procedure status is set to New, then you can perform a new procedure. If the status is set 
to New To Do, then the procedure is pending and must be performed. Click the desired 
editor button to enter a new procedure or edit the selected procedure. When you enter new 
follow-up correlation information, the system displays a list of previous cases for selection.  

Cancel Sign Out 
If a case is in Hold Release status, click the Cancel Sign Out button to cancel the sign out of 
the Report and return the case to Pending Sign Out status.   
NOTE: Permission to cancel the sign out of the case is limited to the login ID that 

matches the Sign Out ID.  
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RTF Editor 
The RTF Editor allows you to enter text in the defined section of the report without opening 
MS Word. The user will be able to use canned messages and/or cascade window selections, 
in addition to free text typing.  
NOTE: Once you create a report in the RTF Editor, you can open that report with either 

the RTF or Word Editors. 
Word Editor 

The Word Editor button will invoke MS Word for editing the case. 
NOTE: The Repair Document utility enables repair on missing bookmarks, duplicate 

bookmarks, and End bookmark in the same position as a start bookmark, section 
inside another section, and part of a section inside another section. 

Undergo QA Button 
Clicking the Undergo QA button displays the Undergo QA window that allows you to 
mark the selected case for QA procedures. Cases with QA that has already been completed 
will have a date, time, and result and cannot be unmarked.   

 
Figure 3-7. Undergo QA Window 

Screener Evidence  
The Scr Evid portion of the toolbar displays the real-time number of slides previously 
screened on the current day for the Login ID. Based on the Daily Slides Screening limit 
defined in the Personnel Setup File for the login ID, this value displays in green when 11or 
more slides can still be screened or red when the user has 10 or fewer available slides to 
screen. 
NOTE: If the total number of slides associated to the selected case(s) exceeds the Daily 

Slides Screen Limit value defined in the Personnel setup file, a warning message 
is displayed when trying to open the case(s). Depending upon the options setting 
"Permission to Over-ride Maximum slide limit message", the user is either 
blocked from proceeding or given an option to override and continue. 
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Editing Reports with MS Word Editor 
To view a report without making any changes, select the report type you want to view and click the 
View button. The report is displayed in READ ONLY mode and you can print the report to any 
network printer or an electronic file. 
To select the type of report you want to edit, highlight the report type and click the Word Editor 
button. The system displays the report in a MS Word Editor window (Figure 3-8). The cursor 
defaults to the section specified in the criteria used for the search (e.g., IOC, Gross Description, etc.). 
If you do not specify a section in the search criteria, the cursor defaults to the first text block in the 
document. All of the features and functionality of MS Word are available for use, including tables, 
images, clip art, various fonts, drawing tools, spell check, etc. 

 
Figure 3-8. MS Word Editor Window 

You can use the tabs that border the top of the document to quickly move the cursor to a specific 
section of the report. Type any information you want to include in the report under the appropriate 
headings. Also, if canned text is defined for the section in the Canned Messages setup file, click the 
Canned Message button to display a list of available canned messages. 
NOTE: When adding your hospital’s logo to the document template, it is the best practice to use 

the JPEG image format. JPEG has the smallest size of the image formats. Try to keep the 
size of the logo under 5 kilobytes. You can use a graphic editor program to resize the 
image if your logo is too large. Resizing the image in Word itself will not change the 
actual size of the image file but only the size of the image on the page. 
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Editing Reports with the RTF Editor 
To select the type of report you want to edit, highlight the report type and click the RTF Editor 
button. The system displays the report in a RTF Editor window (Figure 3-9). The cursor defaults to 
the section specified in the criteria used for the search (e.g., IOC, Gross Description, etc.). If you do 
not specify a section in the search criteria, the cursor defaults to the first text block in the document. 
The RTF Editor has the standard RTF functionality, including Spell Check. 
Use the tabs that border the top of the document to quickly move the cursor to a specific section of 
the report. Type any information you want to include in the report under the appropriate headings. 
Also, if canned text is defined for the section in the Canned Messages setup file, you can click the 
Canned Message button to display a list of available canned messages. 

 
Figure 3-9 RTF Editor Window 

NOTE: If a final report has been signed out, you can only view it. If you try to edit a signed out 
final report, the system displays the following message: “Report has been signed-out and 
cannot be edited. Do you want to view it?” Click Yes to view the signed out report or No 
to cancel the action. 

NOTE: Inserting special characters into the text of a report by using the ALT key and the 
numerical keyboard or copying to/from another application through the clipboard may 
cause the text of the diagnosis to display in a different part of the software or lead to 
differences in the appearance of the document.  
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Result Entry Navigation 
Screener Evidence  

The Scr Evid portion of the toolbar displays the real-time number of slides previously 
screened on the current day for the Login ID. Based on the Daily Slides Screening limit 
defined in the Personnel Setup File for the login ID, this value displays in green when 11or 
more slides can still be screened or red when the user has 10 or fewer available slides to 
screen. 

Canned Messages Button   
Place the cursor where you want to insert the message and click the Canned Message 
button; the Canned Message Lookup window is displayed. Select a canned message code 
and click OK. The Canned Message window (Figure 3-10) is displayed. You can Spell 
Check the canned message. Canned messages defined as MS Word documents are directly 
imported into the document, so this window does not display. 

 
Figure 3-10. Canned Message Window 

To insert more than one canned message, click the  button located in the top right corner of 
the Canned Message window. The Canned Message Lookup window is displayed; select 
an appropriate message and click OK to insert the message(s) into the document. 

Lab Results Button  
Click the Lab Results button to display the results of tests ordered in SoftLab that were 
requested in SoftPath specimen registration. The tests are displayed in the Lab Results 
window (Figure 3-11). Mark the corresponding checkbox(es) of the results to include in the 
report and click OK.  

 
Figure 3-11. Lab Results Window 
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Mic Results Button  
Click the Mic Results button to display the results of tests and associated comments ordered 
in SoftMic that were requested in SoftPath specimen registration. The tests are displayed in 
the Mic Results window. Mark the corresponding checkbox(es) of the results to include in 
the report and click OK. 

Dx History Button   
Click the Dx History button to display a summary of all diagnosis codes for the selected 
case and the IDs associated with these codes. 

 
Figure 3-12. Hx Report – Dx History Window 

Patient History Button  
The Patient History button has three different appearances, which depend on the patient’s 
history. If the button is grayed-out, the button is disabled and there is no previous history for 
the patient. If the button is blue, the patient has a history with no abnormal case results. If the 
button is red, the patient has a history with abnormal case results. 
Click the Patient History button to open the Patient History Report (Figure 3-13), which is 
a synopsis of each case for the current patient. This report includes entries from both the 
active and archive databases and displays the search criteria used to collate the report. 

 
Figure 3-13. Patient History Report 

Each synopsis contains three elements in the table: an Accession Number, the Specimen 
Source (if this particular case had multiple specimens, each specimen is listed), and a Final 
Diagnosis. The font color of the synopsis signifies the status of a diagnosis. Blue text 
signifies a normal diagnosis while red text signifies an abnormal diagnosis. 
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Save Data Button   
When all data entry is complete, click the Save Data button and the appropriate completion 
window is displayed. The completion windows are unique to each case type, report, or report 
section and allow you enter information required to complete the case. See Completion 
Windows for more information. 

NOTE:  When a user is saving results for a case and the system encounters a non-recoverable error, 
an error message will display to alert the user to review the contents of the report for 
any discrepancy. 

Save Section Button  
The Save Section button only displays for final reports and is used to save a particular 
section of the report (e.g., the Gross Description section). If the cursor is not currently 
positioned in the section where changes were made, the system displays the Select Section 
window (Figure 3-14), which allows you to select the section you want to save. When more 
than one section has been modified during the current session, the system opens the save 
scenarios for all of the modified sections. 

 
Figure 3-14. Select Section Window 

Right (Next) and Left (Previous) Arrow Buttons   
Use the arrow buttons to move between the reports for marked cases on the Results tab. If no 
cases were marked on the Results tab, clicking the arrow buttons takes you to the 
next/previous unmarked case on the list. 

Query Button   
Click the Query button to go to Result Query. 

Dx Cascade Button   
The Dx Cascade button enables you to quickly enter a final diagnosis. If a final diagnosis 
already exists, then the system asks if you want to replace the existing diagnosis after you 
click the Dx Cascade button. Click Yes to enter a new diagnosis or No to cancel the action 
and retain the current diagnosis. 
If you click Yes, the system displays two windows; the sequence in which the windows are 
displayed is defined in the Delimiter Order option. The title of this cascading diagnosis 
window and the list of diagnoses that it contains are defined in the Dx Coding window. A 
sample cascading diagnosis window is shown in Figure 3-15. 
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Figure 3-15. Categorization Window 

NOTE: DX Cascade functionality is only available within main document sections, not 
sub-sections. 

Also, you may choose to have the Dx codes displayed in a tree-like list rather than as a series 
of windows (Figure 3-16). See Chapter 6 – Setup: Options – System Settings Tab – 
Common Settings Tab. 

 
Figure 3-16. Tree Cascade Display 

Mark the checkboxes next to the codes that you want to use to define the final diagnosis and 
then click the Next Root button to move to the next defined root window. The selected 
diagnosis codes are added to the Codes grid in the Diagnosis (Cascade) window (Figure 
3-17). The description of these diagnosis codes appears in the Diagnoses area. The diagnosis 
text appears below the proper title. If you want to add more diagnoses, follow the procedure 
described above. If you need to clear all of your selections and re-enter your diagnosis, click 
the Clear button. If you want to close the diagnosis cascade, click OK.  
If no selection is made for the diagnosis title, the titles (without any description) are removed 
from the Diagnoses area in the Diagnosis (Cascade) window. You can add or modify the 
text in this window. To save the diagnosis/ diagnoses click OK. Diagnoses that have been 
defined appear in the MS Word document in the Final Diagnosis section. 

 
Figure 3-17. Diagnosis (cascade) Window 

Standard Diagnosis   
Click the Standard Diagnosis button to enter the default diagnosis codes, descriptions and 
final diagnosis text defined in the Standard Dx function of the cascade window setup.  For 
more information about this option, see Chapter 3.1 – Results: Results Entry – Pre-
Defined and Standard Diagnosis. 

Intradepartmental Consolation  
Click the Consultations button where up to ten (10) pathologist IDs and their associated 
comments to be used for interdepartmental consultations. The pathologist ID can be entered 
manually or you can click the  button to select from a list of valid ID’s. 
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NOTE:   Functionality to add, edit, or delete are limited to users with a personnel type of 
pathologist in the Personnel Setup File. 

NOTE:   This button is only available for the Final Report template only. 

 
Figure 3-18. Consultations Window 

Order Stains Button  
Click the Order Stains button to open the Order Stains/Slides window for ordering 
additional stains and slides. 

 
Figure 3-19. Order Stains/Slides Window 
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Synoptic Reporting – Insert Fragment  
Click the Insert Fragment button to insert a synoptic reporting fragment in the current 
cursor position. Fragments are defined in the Synoptic Reporting Setup utility. Once this 
button is clicked, a selection window will appear listing the appropriate fragments available 
for the source code on record for the case. Click one of the fragments and select OK. 

 
Figure 3-20.  Fragments to Insert Window 

Synoptic Reporting – Delete Fragment  
Click the Delete Fragment button to delete the currently selected fragment from the report.  

Synoptic Reporting – Fragment Defaults  
Click the Fragment Defaults button to apply the default entries to the selected fragment, as 
defined in the Synoptic Reporting Setup utility. 

SoftMedia Button  
Click the SoftMedia button to access the SoftMedia Image Repository. For more 
information on using SoftMedia with SoftPath, see Appendix I. 

Instant Image Acquire Button  

Click the One Touch Image Require button to automatically insert an image from a Twain 
device. The image will insert at the current cursor position and will automatically be added 
to the SoftMedia Image Repository.  
NOTE: After adding images with a TWAIN device, it is best if you go into SoftMedia 

and ensure that they have been labeled correctly and assign any placeholders or 
other necessary information. 

Specimen Registration  
Click the Specimen Registration button to bridge to the Specimen Registration option for 
the current case.  The Specimen Registration option will open in edit mode. Any changes 
made and saved will update any macros fields in the document. 

One Case Processing  
Click the One Case Processing button to bridge to the One Case Processing option for the 
current case. The One Case Processing option will open in edit mode. Any changes made 
and saved will update any macros fields in the document. 

Patient Maintenance  
Click the Patient Maintenance button to bridge to the Patient Maintenance option for the 
current case. The Patient Maintenance option will open in edit mode. Any changes made 
and saved will update any macros fields in the document. 
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Pre-Defined Diagnosis  
Select one of the pre-defined diagnoses (numbers 1 – 10) to insert into the current cursor 
location. Buttons that have been assigned or that you have permission to use are red, while 
unassigned buttons are grayed out. For assistance with selecting a diagnosis, tool tips are 
available as you mouse-over the available shortcut buttons. Additionally, if a pre-defined 
diagnosis has not been assigned to one of the buttons, it can be selected from the drop-down 
list. When multiple diagnoses are assigned, they are appended to the end of the Final 
Diagnosis text. For more information about this option, see Chapter 3.1 – Results: Results 
Entry – Pre-Defined and Standard Diagnosis. 
NOTE: Use of pre-defined diagnoses is tracked in the processing history. 
NOTE: To use this functionality, users must have permission in the Personnel Setup file. 

Temporary Backup 
To access the Temporary Backup option, select File > Temporary Backup from the report 
window used to create/edit result reports.   
The Temporary Backup option allows you to save the whole report as a temporary 
document in the SoftPath database without entering data in any completion windows. You 
can return to the document at a later time to complete the result entry. After you use this 
feature to save changes to the document, any user that attempts to access the case in result 
entry will be informed that a temporary document exists. The user will then be allowed to 
decide whether to retrieve the temporary document or use the default empty template. 

NOTE:  The Repair Document utility enables repair on missing bookmarks, duplicate bookmarks, 
an End bookmark in the same position as a Start bookmark, section inside another 
section, and part of a section inside another section. 

Source Display  

Select a Specimen ID from the drop-down list and that specimen registered for the case is 
displayed in the source field with the corresponding source code and description.  
NOTE: This option only displays in the RTF Editor. 
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Pre-Defined and Standard Diagnosis 
The Pre-Defined Diagnosis and Standard Diagnosis functionalities allow you to apply a pre-
defined diagnosis or a Standard Dx, to a case without invoking the standard cascade window 
functionality. 
To use the Standard Dx functionality, the following must be done in Setup: 

• The user’s login ID must have permissions set allowing them to use Pre-Defined and/or 
Standard Dx. See Chapter 6 – Setup: Setup Files – Personnel File.  

• A Pre-defined or Standard Dx must be defined for the desired coding system and a Dx Cat 
must be defined for that Dx in the Cascade window setup. See Chapter 6 – Setup: Dx 
Coding Setup. 

Standard Diagnosis Using the Cases List Tab 
To apply the standard diagnosis to a case from the Cases List tab (Figure 3-4), first search 
for the case. After searching, select the case(s), by marking the Sel. check box, from the list 
of qualifying cases on the Cases List tab (Figure 3-4). Once marked, click the Standard Dx 
button to apply the final diagnosis text, diagnosis codes, and Dx Cat defined for the Standard 
Dx to the selected case(s).  The Final Diagnosis D&T will match the time the Standard Dx 
button is clicked. The Done By ID is captured from the login ID. The status of the selected 
cases is updated to Final Diagnosis complete and those cases will be removed from the grid 
when refreshed. 
NOTE: When selecting multiple cases, all cases must be the same case type or the 

Standard Dx button is disabled on the window. Also, all cases must have a status 
of pending Final Diagnosis.  

NOTE: If the Options setting Case Types Requiring Gross Description is selected, the 
Standard Dx button is not displayed for cases with no gross description entered. 
In addition, the Standard Dx button is not displayed for cases where the 
Preliminary report is inserted into the Final Report. 

Pre-Defined Diagnosis Using Result Entry: 
To apply a pre-defined diagnosis from Result Entry, access the desired case in either the 
Word editor or the RTF editor.  Ensure that the Final Diagnosis section is empty, click the 
Final Diagnosis tab, and either click one of the 10 Pre-Defined Dx buttons or select a pre-
defined Dx from the drop-down list. The diagnosis text is imported into the report.  Save the 
case and the Dx Codes and Dx Cat associated to the Standard Dx are defaulted to the 
appropriate fields. 

Standard Diagnosis Using Result Entry: 
To apply the standard diagnosis from Result Entry, access the desired case in either the 
Word editor or the RTF editor. Click the Final Diagnosis tab, and click the Standard Dx 
button. The Standard Dx  can also be selected from the Pre-defined drop-down menu. The 
diagnosis text is imported into the report.  Save the case and the Dx Codes and Dx Cat 
associated to the Standard Dx are defaulted to the appropriate fields. 
NOTE: If a final diagnosis was previously entered, using the Std Dx button will remove 

all previous text and replace it with the defined Standard Diagnosis text. 

Editing a Case with a Pre-defined or Standard Dx:  
To edit a case with a standard diagnosis or a pre-defined diagnosis added to it, access the 
desired case in either the Word editor or the RTF editor. This may be performed through 
Result Entry or any QA procedure performed prior to sign out. Make changes, as needed, 
and click the Save button. The report is updated with the new diagnosis text.  



SoftPath GUI v.4.2.1 User Manual Chapter 3.1 – Results: Results Entry 

PATH4.2-G-U (6th Ed, Rel. 01/31/07)   Page 3-19 

Completion Windows 
When you save a report after creating/modifying it in the MS Word or RTF Editor report window, 
the system displays a completion window (Figure 3-21). Completion windows vary according to the 
section and/or case type, but many functions are similar. The general functionality, which is the same 
for all cases, is described below. Completion windows for autopsy cases are discussed on page 3-29. 

 
Figure 3-21. Report Completion Window 

Consultations Button 
Click the Consultations button to enter up to ten (10) pathologist IDs and their associated 
comments to be used for interdepartmental consultations. The pathologist ID can be entered 
manually or you can click the  button to select from a list of valid ID’s.  

 
Figure 3-22. Consultations Window 
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Billing Button 
Click the Billing button to display the Billing Codes window (Figure 3-23). 

 
Figure 3-23. Billing Codes Window 

Billing codes can be entered manually or you can click the Add button to select from a list 
of billing codes. If you click Add, either the Professional or Technical Charge lookup 
window displays. Within this window, you can search for the desired code by case type, 
code, name, and/or CPT code. After entering search criteria, click the Find button. All codes 
matching the specified criteria are displayed. To select a code, highlight it and click OK.  
To remove a billing code entered in error, highlight the code and click the Delete button.  
To modify the location of any billing code, enter a new location code in the Change To field 
or click the  button to display a list of valid locations. To change all locations in the 
window to the default location, click the Reassign Loc button. 

Copies To Button 
Click the Copies To button to open the Copies To window. This window allows you to send 
additional copies of the report to a maximum of four specified doctors. Enter the doctors that 
you want to send the additional copies to in the available fields or click the  button to 
select from a list of active doctor codes. 

 
Figure 3-24. Copies To Window 

Residents Button 
Click the Residents button to open the Residents window, which allows you to enter up to a 
maximum of four residents in the available fields. You can click the  button to select from 
a list of active resident ID codes. 

Undergo QA Button 
Click the Undergo QA button to manually mark the case for the following QA procedures: 
rescreen, proreview, and retroreview. The cases can only be marked for QA from this option. 
QA results must be entered in the Quality Assurance option.  
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Add Code Button 
Click the Add Code button to display the Diagnosis Code lookup window. The codes 
available in this window change depending on the diagnostic codes in use for the selected 
case type. You can search by code or by the first string of text contained within the 
document. For example, you were searching for the Acute Dermatitis diagnosis code, you 
could enter Acute in the Word Pattern field to locate the code. 

 
Figure 3-25. Diagnosis Code Lookup Window 

After you click Find, select the appropriate diagnosis code and click the Add button to add 
the new code to the current case. The selected diagnoses display in the Selected Codes grid. 
To remove a diagnosis code from the list, highlight the code and click the Delete Code 
button. 
After selecting the diagnosis codes, click the OK button. The codes are inserted into the 
appropriate fields of the completion window.  

Qualifies for Cancer Agency Report 
Mark this checkbox to flag the case as qualifying for the Cancer Agency Report. For more 
information, consult Chapter 5.3 – Reports: Cancer Agency Report.  
NOTE: This checkbox will only appear if Cancer Agency Reporting is enabled in 

Options. 
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Dx Find Button 
Click the Dx Find button to prompt SoftPath to read the final diagnosis text and look for the 
appropriate codes. If the Auto Insertion of Dx Codes and Case Types Having Automatic 
Insertion of Dx Codes checkboxes are marked in the Dx Coding tab of the Options 
window, the diagnosis codes derived by the system from the final diagnosis text are inserted 
without any further prompting. If these checkboxes are not marked for the current case type, 
the Select Codes window (Figure 3-26) is displayed containing all diagnosis codes the 
system derived from the final diagnosis text. Mark all the codes that apply to the final 
diagnosis and then click Insert. The system inserts all of the marked diagnosis codes into the 
appropriate fields of the completion window.  

 
Figure 3-26. Select Codes Window 

Synoptic Dx 
Click the Synoptic Dx button to automatically enter the SNOMED codes attached to the 
synoptic diagnosis specified. These codes can be attached using the Synoptic Reporting 
setup utility. 

Saving the Completed Information 
After all information has been entered, click one of the following buttons:  

 
Click the Save button to save the case without exiting MS Word. 

 
Click the Save and Close button to save the case and exit MS Word. 

 
Click the Cancel button to return to the Done By window for the 
chosen section. 

The Gross Description Complete check box will display as active, marked, or unmarked 
based on the setting in Options (see Chapter 6.4 – Setup: Options – Result Entry Tab – 
Gross Description Tab). The system will default the gross description as complete, 
incomplete, or prompt the user for confirmation of complete status. 

Result Comment Button 
Click the Result Comment button to open a 500-character free text window for entering any 
comments regarding the result. 
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Intraoperative Consultations 
The instructions below allow you to include an intraoperative diagnosis on worksheets and the final 
report.  
The pending status for this section depends on the case types selected in the Case Types Available 
for IOC area located in the Options window - Result Entry tab - Intraoperative Consultation tab. 
Only case types marked as available for IOC and cases that contain a frozen section or with cases 
flagged for IOC will be pending for IOC entry. However, an intraoperative consultation can be 
completed for any report that uses a template with an Intraoperative Consultation section. An 
intraoperative consultation can also be completed when the case is associated with a frozen section 
or when the case is flagged for IOC.  
To enter an intraoperative diagnosis, access the Result Entry option and select the appropriate case 
as described on page 3-5. Select the Final Report report type and the desired editor. Click the 
Intraoperative Consultation tab and enter the text of the intraoperative diagnosis. After you save 
the section, the IOC/FS/GIC completion window (Figure 3-27) is displayed.  

 
Figure 3-27. Report Completion Window - IOC/FS/GIC Tab  

The only required field in this window is the Done By ID field. After saving your changes, you can 
enter text in another section, return to the main menu (click Save and Close), or return to the case 
list (click Save). 
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Gross Descriptions (All Case Types) 
The instructions below allow you to include a gross description in the final worksheet and the final 
report.  
The pending status for this section depends on the case types selected in the Case Types Requiring 
Gross Description area located in the Options window - Result Entry tab - Gross Description tab. 
Only case types marked on this tab will be pending for gross description entry. However, a gross 
description can be completed for any report that uses a template with a Gross Description section. 
To enter a gross description, access the Result Entry option and select the appropriate case as 
described on page 3-5. Select the Final Report report type and click Edit. After opening the 
document, select the Gross Description tab and enter the text of the gross description.  
After you save the gross description section, the Gross Examination completion window (Figure 
3-28) is displayed. Complete the Done By field to indicate the person that performed the gross 
description and save your data.  
The Gross Description Complete check box will display as active, marked, or unmarked based on 
the setting in Options (see Chapter 6.4 – Setup: Options – Result Entry Tab – Gross Description 
Tab). The system will default the gross description as complete, incomplete, or prompt the user for 
confirmation of complete status.  

 
Figure 3-28. Report Completion Window - Gross Examination Tab 
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Creating Preliminary Reports for GYN Cytology, MED Cytology, and 
Surgical Cases 

A preliminary report can be used to release the available pathology results before a final diagnosis is 
stated. For example, in a case where additional stains or test results are pending, a tentative diagnosis 
can be issued to allow a clinician to begin treatment prior to the release of the final report. A 
preliminary report can contain the specimen gross description and a tentative (preliminary) 
diagnosis.  
Features of Preliminary Reports 

• Preliminary reports provide flexibility within the lab group to distribute diagnostic results. 
The signature on a particular preliminary report can be different from the signatures on the 
final report, supplemental report, or another preliminary report related to the case.  

• Signed-out preliminary reports can be made available while some materials associated with 
the case are still being processed. The final report remains active, awaiting the pending 
results.  

• Multiple preliminary reports can be issued for any case. The reports are sequentially 
identified with a prefix (Pa, Pb, Pc, etc.)  

• A preliminary report cannot be created after the final report for the case is signed out.  
• A field is available for comments about the preliminary report. It is commonly used to 

explain why the preliminary report was created.  
• Preliminary reports are never pending result entry. You must select the Simple Search tab 

and enter the case number to create the preliminary report.  
• Once the preliminary report is created, it can be found using the Simple Search or 

Advanced Result Search tabs in the Result Entry option. A simple search requires you to 
enter the case number. An advanced result search requires the date range of the case. 

• Information in preliminary reports is not accessible to, or through, the following functions: 
revised reports, the Quality Assurance option, ODBC reports, the Complex Query option, 
the Fast Sign Out option, the Collated Patient History report, the Old Cases option. 

• The Preliminary Report or sections of the Preliminary Report can be imported into the 
Final Report by adjusting the settings in Setup. 

To create a preliminary report, access the Result Entry option and select the appropriate case as 
described on page 3-5. Select the Preliminary Report report type and click the button for report 
editor of choice (RTF or Word). If an unsigned final report or signed preliminary report exists for the 
case, the Report Matrix window displays. The preliminary report can be based on the current final 
report or preliminary report if desired. Alternately, you can create a new preliminary report. After 
opening the document, you can click any of the available tabs to enter information for the 
corresponding section of the report. The Canned Message button can also be used to add canned 
messages to the document. 
After you save the preliminary report, the Preliminary Report completion window (Figure 3-29) is 
displayed.  

 
Figure 3-29. Preliminary Report Completion Window 

The only required field in this window is the Done By field. After saving your data, you can sign out 
the case, enter text in another section, return to the main menu, or return to the case list. 
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Entering the Provisional Anatomic Diagnosis (PAD) 
The Provisional Report report type allows you to issue a preliminary autopsy report. A case 
qualifies for a provisional report as soon as it is registered in the Autopsy Specimen Registration 
option.  
To enter a provisional anatomic diagnosis (PAD), access the Result Entry option and select the 
appropriate case as described on page 3-5. Select the Provisional Report report type and click the 
button for your report editor of choice (RTF or Word). After opening the document, you can click 
any of the available tabs to enter information for the corresponding section of the report. The 
Canned Message button can also be used to add canned messages to the document. 
After you save your data, the Provisional Report completion window (Figure 3-30) is displayed.  

 
Figure 3-30. Provisional Report Completion Window 

The only required field in this window is the Done By field. After saving your data, you can then 
sign the case out, enter text in another section, return to the main menu, or return to the case list.  
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Entering the Final Diagnosis (GYN Cytology, MED Cytology, and 
Surgical) 

The Final Report report type allows you to create a final report that contains the final diagnosis for 
the case. If a case is completed without a QA entry and not signed out, you can modify the diagnosis 
text without creating a revised report. After a case has been signed out, you can only make changes 
by creating a revised report. Additional information that does not affect the diagnosis can be entered 
in a supplemental report.  
Qualification for the final report depends on the case type and system settings. Surgical cases may 
require gross descriptions and intraoperative consultations (for those requiring IOC) before the case 
is established as pending for final diagnosis. GYN cytology and MED cytology cases may require 
specimen processing. The conditions can change depending on your system setup.  
To enter a final diagnosis, access the Result Entry option and select the appropriate case as 
described on page 3-5. Select the Final Report report type and click Word or RTF Editor button. 
After opening the document, select the Final Diagnosis tab and enter the final diagnosis. The 
Canned Message button can be used to add canned messages to the document.  
After saving the section, the Final Diagnosis completion window (Figure 3-31) is displayed.  

 
Figure 3-31. Sample Final Diagnosis Completion Window 

The Screener Evidence Count allows you to specify how many slides are to be captured for 
Screener Evidence Entry. For more information, see Chapter 7.5 – Utility: Screening Evidence.  
NOTE: The Screener Evidence Count field is only available for GYN and MED cases. The 

field is disabled and a value of 0 (zero) displays for Surgical and Autopsy cases. 
The Final Diagnosis Complete check box will display as active, marked, or unmarked based on the 
setting in Options (see Chapter 6.4 – Setup: Options – Result Entry Tab – Final Results (cont) 
Tab). The system will default the gross description as complete, incomplete, or prompt the user for 
confirmation of complete status. 
The only required field in this window is the Done By field. After saving the changes, you can sign 
the case out, enter text in another section, return to the main menu, or return to the case list. 
NOTE: The QA Online window may display after the confirmation of completion of the Final 

Diagnosis. For more information about setting up this option, see Chapter 6.4 – Setup: 
Options – Final Result Entry Tab.   
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Order Stains/Slide Button 
Clicking on the Order Stains/Slides button in the Final Diagnosis completion window 
brings up the Order Stains/Slides tab, as shown in Figure 3-32. This tab is used to order 
additional stains on existing materials. Each line represents material that was ordered and 
processed during initial specimen processing. Gray columns are READ ONLY and white 
columns accept data entry. 

 
Figure 3-32. Order Stains/Slides Window – Order Stains/Slides Tab 

Grid Display and Function 
Spec Displays the specimen designation. 
Source A full text description of the source code. 
Block/Mat/Stains Description of the material, the number of slides initially ordered, 

and the stain code initially ordered. 
Ord Stain A free entry field used to enter a known stain code. You can also use 

the  button to open the Stain Lookup window. 
Sld Method Allows you to choose a slide preparation method: Level, Recut, 

Restain, or Unstained. 
Slides Allows you to enter the number of slides to be stained. 
Special 
Instructions 

A free text entry field that allows you to enter special processing 
instructions. Maximum of 40 alphanumeric characters. 

Ref # Displays the unique number assigned to each line item ordered. 
Status Displays the status of the order. 
Note Displays whether the line item has an associated note. 

Button and Field Function 
Notes Add a note to an order using standard RTF functionality. 
Orders History Check the history of an order. 
Cancel Order Cancel the order, removing all data entered into the editable fields as 

well as all notes attached to the order. 
Add Stain Enter a known stain code with free text in this field or use the  

button to lookup a stain code. Invoking the Add Stain button will add 
an order for that stain to the grid. 

Assign to Assign the order to a specific employee ID. 
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Entering the Final Anatomic Diagnosis (FAD) 
The Final Report type is used to enter the final anatomic diagnosis (FAD) for autopsy cases. If a 
case is completed, but not signed out, you can modify the diagnosis text without creating a revised 
report. After the case has been signed out, you can only make changes by creating a revised report. 
Qualification for this final report depends on your system settings. Autopsy cases may require PAD, 
gross descriptions, and intraoperative consultations (for those requiring IOC before the case is 
established as pending for final anatomic diagnosis). 
To enter a final anatomic diagnosis, access the Result Entry option and select the appropriate case 
as described on page 3-5. Select the Final Report report type and click Word or RTF Editor 
button. After opening the document, select the Final Diagnosis tab and enter the final diagnosis. The 
Canned Message button can be used to add canned messages to the document.  
After saving the section, the Final Anatomic Diagnosis completion window (Figure 3-33) is 
displayed.  

 
Figure 3-33. Final Anatomic Diagnosis (FAD) Completion Window 

The Done By field is the only required field in this window. The prosector imports from specimen 
registration can be changed, if necessary.  
The FAD Complete check box will display as active, marked, or unmarked based on the setting in 
Options (see Chapter 6.4 – Setup: Options – Result Entry Tab – Final Results (cont) Tab). The 
system will default the gross description as complete, incomplete, or prompt the user for 
confirmation of complete status. 
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More Button (FAD/Autopsy Specific) 
Click the More button to display the More Data window. The eight tabs displayed in the 
More Data window are described in the following sections: 
• History tab 
• Autopsy Info tab 
• Calls tab 
• Letters tab 
• Age Info/Body tab 
• Organs/Bones tab 
• Other Case Data tab 
• Adequacy/Problems tab 
• Order Stains/Slides tab  

 

History Tab  
The History tab displays the procedures completed for the case in READ ONLY mode, 
including the death date, autopsy time, provisional date and time, the final diagnosis date and 
time, the gross description date and time, and clinicopathologic correlation date and time. 

 
Figure 3-34. More Data Window – History Tab 
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Autopsy Info Tab 
The Autopsy Info tab allows you to enter autopsy information, including free text 
information describing the cause and location of death, coroner/police agency information, 
etc. 

 
Figure 3-35. More Data Window – Autopsy Info Tab 

Hospital Where Death Occurred 
Enter the name of the hospital where the patient’s death occurred. Click the  
button to display the Clinic Code Lookup window and select an appropriate code 
from the list. 

County Where Death Occurred 
Enter the county where the patient’s death occurred. This is a free-text field. 
Maximum 32 alphanumeric characters. 

County of Incident 
Enter the county where the incident leading to the patient’s death occurred. This is a 
free-text field. Maximum 32 alphanumeric characters. 

Coroner Case Number 
Enter the coroner case number for the death. This is a free-text field. Maximum 15 
alphanumeric characters 

Coroner Name 
Enter the name of the coroner who performed the autopsy. This is a free-text field. 
Maximum 76 alphanumeric characters 

Chart Return Date 
Enter the date that the chart was returned to the Medical Records department. Enter 
the date manually or click the  button to display a calendar to make your selection. 
Maximum 8 numeric characters using the mm/dd/yyyy format. 

Blood Ethanol 
Enter the patient’s blood ethanol value in the free-text box. Click the drop-down list 
button and select (%) percentage for medical or LEGAL for legal blood ethanol. 
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Cause of Death 
Enter the cause of death. This is a free-text field. 

Police Agency 
Enter the name of the police agency investigating the incident. This is a free-text 
field. 

Autopsy Type 
Select a case type code from the drop-down list. The available case types are defined 
in the Simple Codes option. 

Scene 
Select a code describing the scene of death from the drop-down list. The available 
scenes are defined in the Simple Codes option. 

Manner of Death 
Select a code that describes the manner of death from the drop-down list. The 
available codes are defined in the Simple Codes option. 

Other Drugs 
Select other drugs found in the patient’s system from the drop-down list. The 
available drugs are defined in the Simple Codes option. 
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Calls Tab 
The Calls tab allows you to mark a case for a call for final results after the case has been 
signed out. In addition, you can enter the confirmation of the call in this window. 
NOTE: The procedure for adding calls is described in detail in the Specimen 

Registration section of Chapter 1 - Orders. 

 
Figure 3-36. More Data Window - Calls Tab 
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Letters Tab 
The Letters tab is used to order a follow-up letter and to mark a case so that a letter is 
generated a number of days after sign out, on a date, or for a doctor. You can designate the 
code of the letter to be printed from the Print Final, Letters option. 
NOTE: The procedure for adding letters is described in detail in the Specimen 

Registration section of Chapter 1 - Orders. 

 
Figure 3-37. More Data Window - Letters Tab 
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Age Info/ Body Tab 
The Age Info/Body tab allows you to add information regarding age and the body. All 
information entered during result entry is available for modification. 

 
Figure 3-38. More Data window - Age Info/Body tab  

Body Grid 
Enter or edit the body dimensions in the value column. The scrollbar on the right is 
to move through the available items for data entry. 
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Organs/Bones Tab  
The Organs/Bones tab allows you to enter information regarding organs and bones. All 
information entered during result entry is available for modification. 

 
Figure 3-39. More Data Window - Organs/Bones Tab 

Organs 
Enter the organ weights in the value column. Clicking the Units field displays a list 
that allows you to select the unit of measure used for measuring the weight. Use the 
scrollbar on the right to move through the available items. 

Bones 
Manually enter or edit the bone dimensions in the value column. Clicking the Units 
field displays a list that allows you to select the unit of measure used for measuring 
the dimensions. Use the scrollbar on the right to move through the available items. 
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Other Case Data Tab 
The Other Case Data tab allows you to enter miscellaneous information pertaining to the 
case. All data entered during Specimen Registration is imported and available for 
modification. 

 
Figure 3-40. More Data Window - Other Case Data Tab 

Tag Letters 
Select up to three tag letters from the drop-down list. Tag letters are defined during 
file setup using the Simple Codes option. 

Reported To 
Specify up to four physician codes. Each physician will be sent a copy of the Final 
report. Click the  button to display a list of defined codes. 

Case Comment Button 
Click the Case Comment button to enter a case comment for the patient. This is a 
free text field. The box next to this button is marked if a case comment has already 
been entered. 

Clinical Info Button 
Click the Clinical Info button to display the Clinical Info window for entering 
clinical information for the patient. The box next to this button is marked if clinical 
information has already been entered. 

Operation Info Button 
Click the Operation Info button to display the Operation Info window for entering 
preoperative diagnosis information. The box next to this button is marked if 
preoperative diagnosis information has already been entered. 

UDF (User Defined Flags) Button 
Click the UDF button to display the User Defined Flag window. The available flags 
are defined in the User Flags option (Setup > User Flags). 
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Stillbirth 
Select the Stillbirth check box to indicate that the autopsy is being performed on a 
stillborn infant. 

Partial Autopsy 
Select the Partial Autopsy check box to indicate that only a partial autopsy is being 
performed.  

Complete Autopsy 
Select the Complete Autopsy check box to indicate that a complete autopsy is being 
performed. 

Undiagnosed Infection 
Select the Undiagnosed Infection check box to indicate that the patient has an 
undiagnosed infection. 

For ID Only 
Enter the number of gross identifications performed. 

Intraoperative Consultations  
Enter the number of intraoperative consultations performed when no frozen sections 
exist. 
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Adequacy/Problems Tab 
The Adequacy/Problems tab allows for the entry of specimen adequacy codes and 
specimen processing problem codes for the autopsy. All previously entered 
adequacy/processing problem data is displayed for review.  

 
Figure 3-41. More Data Window - Adequacy/Problems Tab 

Specimen Adequacy Info 
If an adequacy code is entered for the individual specimen, this field becomes active, 
allowing you to enter specimen adequacy information. This is a free text field. 
Canned messages can be inserted if they have been defined.  

Order Stains/Slides Tab 
This Order Stains/Slides tab opens the Order Stains/Slides window as described on page 
3-28.  
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Creating Supplemental Reports 
A supplemental report is a separate document that contains the results of additional stains, tests, 
and/or procedures (e.g., flow cytometry, electron microscopy, nerve studies, etc.) that were not 
available when the final report was issued. A supplemental report should only contain additional text 
related to the case that does not affect the final diagnosis. When the final diagnosis is affected, a 
revised report should be used instead.  
Features of Supplemental Reports 

• Supplemental reports are used in addition to the final report, and can be created before, 
during, or after the final report. 

• Multiple supplemental reports can exist concurrently with the final report. 
• The signatures associated with the final report, preliminary report, or other supplemental 

reports can be different. 
• The information entered in the supplemental report is included in the Previous Case listing in 

the Result Query option and in the bridges to the Result Query option from result entry.  
• Information in supplemental reports is not accessible to, or through, the following functions: 

revised reports, the Quality Assurance option, ODBC reports, the Complex Query option, 
the Fast Sign Out option, the Collated Patient History report, the Old Cases option, and the 
Scheduler option.   

• Supplemental reports cannot be reactivated or revised after they are signed out.  
• Supplemental reports can be viewed in the Query option by clicking the hyperlink 

associated with the report.  
To create a supplemental report, access the Result Entry option and select the appropriate case as 
described on page 3-5. Select the Supplemental Report report type and click the Word or RTF 
Editor button. A report matrix window displays allowing you to base the supplemental report on the 
original final report. Alternately, you can create a new report. After opening the document, you can 
click any of the available tabs to enter information for the corresponding section of the report. The 
Canned Message button can also be used to add canned messages to the document. 
After saving the section, the Supplemental Report completion window (Figure 3-42) is displayed.  

 
Figure 3-42. Supplemental Report Completion Window 

The only required field in this window is the Done By field. A report reason/comment can also be 
entered. After saving your changes, you can sign the case out, enter text in another section, return to 
the main menu, or return to the cases list. 
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Creating Revised Reports 
Revised reports are created because of an incorrect or incomplete diagnosis in the final report. After 
you sign out a case, the revised report replaces the original final report in the active database. The 
original final report remains in the database for viewing/printing only. 
Features of Revised Reports 

• Revised reports are not available in the Scheduler option until they have been signed out.  
• Revised reports cannot be reactivated. 
• Revised reports that have been signed out cannot be edited. To make an 

addition/modification to a completed revised report, you must create a new revised report. 
• Only one revised report can be in process (unsigned) at a time.  
• Revised report information is inaccessible in the Old Cases option.  
• Revised diagnosis text is displayed in the Result Query option. 
• The signature associated with the Revised report can be different from the signature 

associated with the final report, supplemental report, and/or preliminary report.  
• Creating a revised report cancels pending rescreen and proreview procedures. Once the 

report is created, the pending rescreen and proreview procedures must be documented in 
Action Entry. If you do not want to enter pending procedures in Action Entry, always 
complete all rescreen and proreview procedures before creating revised reports. 

• Creating a revised report suspends pending retroreview and follow up procedures. After the 
report is created, the pending retroreview and follow up procedures are removed from the 
QA grid during the revision of the diagnosis. Once the revised report is signed out, you can 
complete the QA. The revised diagnosis will be available during the retroreview and follow 
up procedures for QA. 

To create a revised report, access the Result Entry option and select the appropriate case as 
described on page 3-5. Select the Revised Report report type and click the Word or RTF Editor 
button. A report matrix window displays allowing you to base the revised report on the original final 
report. Alternately, you can create a new report. After opening the document, you can click any of 
the available tabs to enter information for the corresponding section of the report. The Canned 
Message button can also be used to add canned messages to the document. 
After saving the section, the Revised Report completion window (Figure 3-43) is displayed.  

 
Figure 3-43. Revised Report Completion Window 

The only required field in this window is the Done By field. A report reason/comment can also be 
entered. After saving the changes, you can sign out the case, enter text in another section, return to 
the main menu, or return to the case list. 
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Signing Out Cases 
After saving a final, supplemental, preliminary, or revised report, the system returns to the MS Word 
or RTF Editor report window. Click the Sign Out tab to display the Sign Out window (Figure 3-44). 
NOTE: If the case qualifies for QA or is selected for random QA, the system displays the QA 

window or qualification message instead. 

 
Figure 3-44. Final Report Sign Out Completion Window 

Release Case 
Select the Release Case check box to force the release of a case directly to “Signed Out” 
status, bypassing the “Hold time after signout” setting in Setup > Option s> Sign Out > 
Sign Out. 

Cancel Sign Out Cases During Hold Release 
To cancel a signed out case, it must be in Hold Release status.   
Select Setup > Options and then select the Sign Out tab.  Click the Edit toolbar button and enter a 
value in minutes, into the Hold time after signout field to indicate how long a case should be held 
after sign out.  Click the Save toolbar button and exit out of the Options window. 
Select Results > Case Results > Result Entry.  Search and select a case with a report you have 
completed.  Sign out the case and return to the Results tab.  The Status column displays as Hold 
Release, and the Cancel Sign Out button becomes active.  Click the Cancel Sign Out button to 
cancel your signed out case.  After canceling the signed out case, the Status column will display as 
Completed. 
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My Results Worklist 

The My Results Worklist option allows you to view and enter results for cases assigned to your user 
ID. This option allows you to quickly retrieve and work with only your cases. 
To access the My Results Worklist option, select Results > Case Results > My Result Worklist from 
the main menu. The Simple Search tab of the Select Report window (Figure 3-45) is displayed.  
NOTE: If the Auto Invoke Final checkbox is marked in the Options window - Result Entry 

tab - My Results Worklist tab, the system automatically performs a search and displays 
the results on the Cases List tab instead of displaying the Simple Search tab. The search 
criteria used are defined in the Options window - Result Entry tab - My Results 
Worklist tab. 

 
Figure 3-45. Select Report Window - Simple Search Tab 

Enter search criteria in the Simple Search, Advanced Result Search, or Advanced QA Search tab 
and click Find. The system displays a list of all cases that match the specified criteria on the Cases 
List tab (Figure 3-46). 
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Figure 3-46. Select Report Window - Cases List Tab 

Highlight the case(s) you want to result and click Mark Selected. Alternately, you can mark the Sel. 
checkbox next to each case that you want to result. When you have marked all the cases you want to 
result, click OK to display the report window. Refer to page 3-9 for information on entering results 
for the case.  
NOTE: The arrow buttons located at the top of the MS Word or RTF Editor report window can 

be used to navigate between the selected cases. When you save the current case, the next 
selected case from the list is displayed.  
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Quality Assurance 

The Quality Assurance options are used to perform quality assurance procedures. These options 
allow you to enter all information required to generate the necessary quality assurance and screening 
evidence reports. You can also enter the results of rescreened cases, reviewed cases, intraoperative 
correlations, and any follow up correlations.  

 
Figure 3-47. Results Menu – Quality Assurance Submenu 

The Quality Assurance menu contains the following sub-options: 
• QA Entry 
• My QA Worklist 
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QA Entry 

The QA Entry option is used to perform quality assurance procedures. This option allows you to 
enter all information required to generate the necessary quality assurance and screening evidence 
reports. You can also enter the results of rescreened cases, reviewed cases, intraoperative 
correlations, and any follow up correlations. 
To access the Quality Assurance option, select Results > Quality Assurance> QA Entry from the 
main menu. The Advanced QA Search tab (Figure 3-48) is displayed.  

 
Figure 3-48. Select Report Window – Advanced QA Tab 

Enter any necessary search criteria and click Find. The system displays a list of all cases that match 
the specified criteria and are pending QA on the Cases tab (Figure 3-49).  
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Figure 3-49. Select Report Window - Cases List Tab 

Select the cases for quality assurance verification and click the Select button. The Results tab 
(Figure 3-50) for the selected case is displayed. The Results tab contains the report status, the QA 
procedure status, and the reason why the case qualifies for QA.  

 
Figure 3-50. Select Report Window – Results Tab 

Highlight the QA procedure to perform from the QA Procedures grid. Click either the Word Editor 
or RTF Editor button at the bottom of the window and the appropriate report will display. Make any 
necessary changes to the report and click Save Data. The system displays the appropriate QA 
completion window. For more information on QA completion windows, refer to page 3-49. For more 
information about the Undergo QA button, see page 3-8. 
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Completion Windows 
After entering QA data, additional information is required to complete the QA procedure in the 
appropriate completion window. The exact completion window displayed depends on the case and 
procedure type. For instance, a completion window displays for rescreening, proreview, retroreview, 
autopsy correlation, and IOC correlation procedures.  

 
Figure 3-51. Sample QA Completion Window 

The only required fields in this window are the Done By and QA Code fields. After all data in the 
completion window is entered, click OK. The system asks you whether the procedure is complete or 
should remain pending. A procedure is complete if all applicable text and data has been entered. If 
you indicate that the procedure is complete, the system changes the case status to Completed in the 
system. You can save the data, sign out the case, return to the cases list, or return to the main menu. 
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Rescreen and Proreview Procedures 
This section details the rescreen and proreview QA procedures.  
Qualification 

A case is pending for rescreen or proreview when the final diagnosis is entered and 
completed and the case is qualified via case comparison setup, random QA setup, or manual 
marking. Also, a case will only qualify for rescreening or proreview if the number of days 
allowed for entering the rescreen or proreview (specified in the Options file) has not been 
exceeded. 

Forced QA 
A rescreen or proreview procedure can be entered for a case when it is not pending for QA., 
which is referred to as Forced QA when the QA procedures are reported. A rescreen or 
proreview procedure can only be entered for a case if results have been entered. If no results 
have been entered for the case, the system does not allow a rescreen or proreview procedure 
to be performed on the case.  
If the results are incomplete, an error message is displayed, but the rescreen or proreview 
procedure can still be performed. The final diagnosis procedure will then be marked as 
completed after saving the rescreen or proreview procedure. If the case is currently marked 
for the random QA drawing, it is removed from the available pool of cases. 

Time Limit 
Rescreen or proreview procedures can only be performed a specified number of days after 
sign out (defined in the Entering Limit for Rescreening in Days after Sign Out and 
Entering Limit for Proreview in Days after Sign Out fields in the Options window - 
Quality Assurance tab - QA Limits tab). Rescreen and proreview procedures are always 
pending prior to the sign out of the case, but a limit for the number of days after sign out 
must be set. When the number of days has been exceeded, the QA procedure becomes 
available in the Action Entry option for documentation. The procedure will have the status 
Not Re-examined. 

Signed vs. Unsigned 
The ability to edit or view a case with a read-only status depends on the sign out status of 
the case. When the case is signed out, the document is displayed in read-only mode. The 
following functions are not available in read-only mode: 

• Canned Messages 
• Lab Results 
• Diagnosis (Dx) Cascade 

If the case has not been signed out and the QA completion window is displayed, all normal 
report window functionality is available. 

Revised Cases 
A rescreen or proreview procedure cannot be performed after a revised report is created for 
the case. After the revised report is created, any rescreen or proreview entries that are 
pending are moved to the Action Entry option for documentation. 

Completed vs. Not Completed Procedures 
The ability to edit an existing QA procedure depends on whether the procedure has been 
marked as completed or not completed. Procedures marked as completed cannot be edited, 
are displayed in read-only mode and is also blocked from result entry once a QA procedure 
has been entered. This is done regardless of the status of the QA procedure. Once a QA 
procedure is entered, it is based on the previous diagnosis. Therefore, the previously 
assigned diagnosis cannot be changed. For the same reason, a completed QA procedure 
cannot be altered. 
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Rescreen and Proreview Completion Window Fields 
Done By  

Enter the ID of the person that performed the QA procedure. The personnel records 
contained in this field’s dynamic list have the Can Rescreen (for rescreen 
procedures) checkbox and Can Review (for proreview procedures) checkbox 
marked in the Personnel setup file. This field is required. 

Screener Evidence Count 
This field displays the number of slides screened by a User ID each day. This value 
can be edited, but to no more than the number of slides in the current case. 

Tag 
Select up to three case tag letters. Available codes are defined in Simple Codes.  

QA Code  
Click the  button to select a QA code to assign to the procedure. Available codes 
are defined in the Quality Assurance Categories option. This field is required. 

Procedure Comment Button 
Click the Procedure Comment button to enter a free text comment using the rich 
text editor. This information is captured with the respective QA procedure.  
The ability to select the type of canned message that will be available for insertion 
when a canned message is used in the QA Comment field is defined in the Canned 
Message Type for Comment field located in the Options window - Quality 
Assurance tab - Common tab.  

Qualifies for Cancer Agency Report 
Mark the Qualifies for Cancer Agency Report check box to flag the case as 
qualifying for the Cancer Agency Report. For more information, consult Chapter 
5.3 – Reports: Cancer Agency Report.  
NOTE: Check box only appears if Cancer Agency Reporting is enabled in 

Options. 
Dx Codes Grid 

Edit, add, or delete diagnosis codes in the QA completion window for unsigned 
cases. The coding system available is based on the case type and the diagnostic 
dictionary selected during system setup. 

Case Comment Button 
Click the Case Comment button to view/edit/delete the case comment. 

Undergo QA Button 
Click the Undergo QA button to manually mark/unmark cases for additional QA 
procedures. 

UDF Button 
Click the UDF button to display the User Defined Flag window. The available flags 
are defined in the User Flags option (Setup > User Flags). 

Dx Cat  
Click the  button to select a diagnosis category for unsigned cases only. The 
available codes are defined in the Diagnosis Categories option. 

GYN Info / Med Info Buttons 
These buttons allow you to view GYN and MED cytology information entered 
throughout the system. These buttons are only available on GYN and Med cases. 
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Random QA 
In this section, the functionality of the random QA drawing feature is explained. 
Random QA Qualification 

The collection of cases for random QA is based on the settings defined in the Options 
window - Quality Assurance tab - Random QA tab and whether the case is negative or 
unknown for the diagnostic coding or category. If any of the diagnostic coding is positive, 
the case will not be selected for random QA. 

Percentage of Cases Selected 
The system determines the random percentage of cases based on these settings: 

• Percent for rescreen (defined in the Personnel file) 
• Percent for review (defined in the Personnel file) 
• Percent for random rescreen (based on the defaults in the Options file) 
• Percent for random proreview (based on the defaults in the Options file) 
• Inclusion of High Risk cases (based on defaults in the Options file) 

The percentage of cases selected for random rescreen and proreview is determined by 
checking the Personnel file for a percentage greater than 0. If a value greater than 0 exists for 
the screener associated with the case, the percentage specified in the screener’s Personnel 
file is used. If the value is set to 0 in the Personnel file, the random percentage is taken from 
the system defaults defined in the Options file. 
The system reads the case comparison setup and random settings only when you save the 
final diagnosis during result entry and only if you click Yes when the system prompts you 
with the message: "Procedure Completed."  This qualification is reassessed by the system 
when a diagnosis is edited. 
The system always checks non-random rules first. If the case meets any non-random 
scenario defined in the Case Comparison Setup option or is manually marked for QA, the 
case is qualified for QA regardless of the random rules. 

Performing the Random QA Drawing 
The random QA drawing can be performed either through the Scheduler option or you can 
start the process manually in the Sign Out by Case, Sign Out by Pathologist, Sign Out by 
Range, or My Signout Worklist options. 
The random drawings are performed as follows: 
The drawing is performed separately for each day, case type, and QA procedure. Each time 
the procedure is performed, the system counts the total number of cases that were marked for 
the random QA drawing for each day. These must be cases that were not selected by a 
previous random QA drawing. 
The system calculates the total number of cases that are to be selected based on the 
percentages specified. 
The system then counts how many of the cases from step 2 were previously selected for the 
day and calculates the difference between the needed number and the number already 
selected for that day. From this calculation, the correct number of cases required to meet the 
current percentage is selected. 
The screener percentages are always selected first. If no value is defined for the screener in 
their Personnel file or if the setting is 0, the global random percentages set in the Options file 
are used instead. 
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All cases that were included in the random QA drawing are then marked by setting the 
Random flag for the case record. The system also notes the procedure performed. This is 
done to prevent the case from being randomly drawn again. However, if a user edits the 
diagnosis of the case, this flag is removed and the case will once again be eligible for the 
random QA drawing. 
All cases that are randomly selected are marked as pending for QA with the reason 
Random. All cases that were not selected are released for sign out. 

Sign Out 
By default, the system does not allow any user to sign out any cases that qualified for either 
the rescreen or proreview random drawing if the drawing has not yet been performed. Users 
with permission to force sign out on QA marked cases can only force the sign out of an 
eligible case after the random QA drawing is completed.  
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Retroreview Procedure 
This section details the retroreview QA procedure. 
Qualification 

A case will be pending for the retroreview procedure when it has been qualified via case 
comparison setup, random QA setup, or if it is marked manually. In addition, the case must 
be signed out, and the number of days allowed for performing the retroreview (specified in 
the Options file) must not be exceeded. 

Forced QA 
You can force QA for the retroreview procedure in the same manner as the rescreen and 
proreview procedures. See page 3-50. 

Time Limit 
The retroreview procedure can only be performed a specified number of days after sign out 
(defined in the Entering Limit for Retroreview in Days after Sign Out field located in the 
Options window - Quality Assurance tab - QA Limits tab). Retroreview procedures are 
always pending after a case is signed out, but a limit for the number of days after sign out 
must be set. When the number of days has been exceeded the QA procedure will be available 
in the Action Entry option for documentation and will have the status of Not Re-examined. 

Signed vs. Unsigned 
The current sign out status of the case affects the retroreview procedure in the same manner 
as the rescreen and proreview procedures. See page 3-50. 

Completion Window 
The completion window for the retroreview procedure is the same as that described for the 
rescreen and proreview procedures on page 3-51. The exception is that only personnel 
records defined as pathologists or residents are available for selection in the dynamic list for 
the Done By field  

Revised Cases 
A retroreview procedure cannot be entered after a revised report has been created for the 
case. After the revised report is created, any pending retroreview entries are removed from 
the QA grid in the Quality Assurance option. After the revised report is signed out, the 
pending retroreview procedure can be performed and the updated diagnosis is displayed so 
the QA review can be completed. 

Completed vs. Not Completed Procedures 
The differences between completed and not completed retroreview procedures are identical 
to those described for the rescreening and proreview procedures on page 3-50.  

Random QA 
The random QA drawing for retroreview procedures is identical to the random QA process 
described for rescreen and proreview procedures. See page 3-52. 
The system collates the percentage of cases selected for random retroreview based on the 
default percentage defined in the Options file.  
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IOC Correlation Procedure 
This section details the intraoperative consultation (IOC) correlation QA procedure. 
Qualification 

A case is pending for the IOC correlation procedure if an intraoperative consultation and 
final diagnosis have been entered and completed. Also, the specified number of days allowed 
for entering the IOC Correlation (as defined in the Options file) must not be exceeded. 

Forced QA 
An IOC correlation cannot be forced. The procedure cannot be performed until the IOC and 
the final diagnosis sections of the report are completed. 

Time Limit 
The IOC correlation procedure can only be performed a number of days after sign out 
(defined in Entering Limit for IOC Correlation in Days after Sign Out field located in 
the Options window - Quality Assurance tab - QA Limits tab). IOC correlation procedures 
are always pending prior to the sign out of the case, but a limit for the number of days after 
sign out must be set. When the number of days has been exceeded the QA procedure 
becomes available in the Action Entry option for documentation. The procedure will have 
the status of Overdue IOC Correlation. 

Signed vs. Unsigned 
The sign out status of the case is not taken into consideration for IOC correlations. The final 
diagnosis cannot be edited during this QA procedure. 

Completion Window 
The completion window for the IOC correlation procedure is the same as that described for 
the rescreen and proreview procedures on page 3-51. The exception is that only personnel 
records defined as pathologists or residents are available for selection in the dynamic list for 
the Done By ID field. 
NOTE: The GYN Info, Med Info, and UDF buttons are not available in the IOC 

correlation completion window. 
Revised Cases 

An IOC correlation cannot be performed after a revised report has been created for the case. 
When a revised report is created, any pending IOC correlation procedures are displayed in 
the Action Entry option for documentation.  

Completed vs. Not Completed Procedures 
The differences between completed and not completed IOC correlation procedures are 
identical to those described for the rescreening and proreview procedures on page 3-50. 
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Autopsy Correlation Procedure 
This section details the autopsy correlation QA procedure. 
Qualification 

A case is pending for the autopsy correlation procedure if the clinicopathologic correlation 
and the final diagnosis have been entered and completed. Also, the specified number of days 
allowed for entering the autopsy correlation (as defined in the Options file) must not be 
exceeded. 

Clinicopathologic Correlation Edited 
A clinicopathologic correlation can only be entered once per case. If a user attempts to enter 
a second correlation entry, the original is shown as edited. 

Forced QA 
An autopsy correlation cannot be forced. The procedure cannot be performed until the 
clinicopathologic correlation and the final diagnosis sections of the report are complete. 

Time Limit 
The autopsy correlation procedure can only be performed a specified number of days after 
sign out (defined in the Entering Limit for Autopsy Correlation in Days after Sign Out 
field located in the Options window - Quality Assurance tab - QA Limits tab). Autopsy 
correlation procedures are always pending after a case is signed out, but a limit for the 
number of days after sign out must be set. When the number of days has been exceeded the 
QA procedure will be available in the Action Entry option for documentation and will have 
the status of Overdue Autopsy Correlation. 

Signed vs. Unsigned 
The sign out status of the case is not taken into consideration for autopsy correlations. The 
final diagnosis cannot be edited during this QA procedure. 

Completion Window 
The completion window for the autopsy correlation procedure is the same as that described 
for the rescreen and proreview procedures on page 3-51. The only exception is that 
personnel records defined as pathologists or residents are available for selection in the 
dynamic list for the Done By field. 
NOTE: The GYN Info, Med Info, and UDF buttons are not available in the IOC 

correlation completion window. 
Revised Cases 

An autopsy correlation cannot be performed after a revised report has been created for the 
case. When a revised report is created, any pending autopsy correlation is moved to the 
Action Entry option for documentation. 

Completed vs. Not Completed Procedures 
The differences between completed and not completed autopsy correlation procedures are 
identical to those described for the rescreening and proreview procedures on page 3-50. 
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Follow Up Correlation Procedure 
This section details the follow up correlation QA procedure. 
Qualification 

A case is pending for follow up correlation if the previous and the current case are signed 
out, the difference between the registration date of the two cases does not exceed five years, 
the criteria defined in the Case Comparison Setup option for follow up procedures is met, 
and the number of days allowed for entering the follow up correlation has not been 
exceeded. 

New Procedure 
After you select the case for follow up correlation and the follow up procedure, the 
following information is displayed on the grid: 

Case Number Displays the case number. 

Ordered Date Displays the ordered date for the case. 

Req. Dr. Displays the requesting doctor for the case. 

Pathologist Displays the pathologist for the case. 

Sign Out Date Displays the date the case was signed out. 

QA Setup This field displays:  
• Yes when the current case and the previous case satisfy a 

scenario defined in the Case Comparison Setup option.  
• No when the current case and the previous case do not meet 

the criteria for any scenario defined in the Case Comparison 
Setup option. 

Status This field displays: 
• No when there is no follow up correlation between the 

previous and current case.  
• Completed when all correlations between the current and 

previous case are completed.  
• Pending when there is at least one pending correlation 

between the current and previous case. 
Abnormal /Normal Displays if the case results were abnormal or normal. 

Dx Category Displays the diagnostic category for the case. 

Source Codes Displays the first three sources associated with the case. If more 
than three source codes are associated with the case, an ellipse 
(…) is displayed at the end of the list. 

Select the case(s) for correlation from the grid and click OK.  
NOTE: If any of the selected cases are not resulted, incomplete, or unsigned, the system 

displays an appropriate message. If you select an unresulted case, the system 
will not allow you to continue the follow up correlation. 

After you click OK, all the selected cases are displayed in a single window. Separate tabs 
are displayed for current cases with the previous cases always displayed in the upper portion 
of the window. All case information is displayed in read-only mode. You can view GYN 
history, user-defined flags, processing history, and edit QA information (using the Undergo 
QA button) for the previous case using the various buttons located on the bottom of the 
window.  
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Forced QA 
A follow up correlation can performed for a case even if the case is not pending for QA. This 
is referred to as Forced QA in QA procedure reports. A follow up correlation can only be 
performed for a case if the case has been resulted. If no results have been entered for the 
case, the system does not allow you to enter a follow up correlation for the case. If the 
results are incomplete or unsigned, an error message displays, but you can still perform the 
follow up correlation. If you continue to perform the follow up correlation, the final 
diagnosis procedure is marked as completed after you save the follow up correlation. Also, 
users will not be able to enter or edit results for the case.  
When forcing a QA procedure, all current cases in the system are displayed for selection. 
This allows you to enter a follow up correlation when the criteria specified in the Case 
Comparison Setup option have not been met, but additional QA is needed.  

Time Limit 
The follow up correlation procedure can only be performed a specified number of days after 
sign out (defined in the Entering Limit for Follow Up in Days after Sign Out field located 
in Options - Quality Assurance tab - QA Limits tab). Follow up correlation procedures are 
always pending after a case is signed out, but a limit for the number of days after sign out 
must be set. When the number of days is exceeded, the QA procedure becomes available in 
the Action Entry option for documentation with the status of Overdue Follow Up. 

Completion Window 
The completion window for the autopsy correlation procedure is the same as that described 
for the rescreen and proreview procedures on page 3-51. The exception is that only 
personnel records defined as pathologists or residents are available for selection in the 
dynamic list for the Done By field. 
NOTE: All correlation cases must contain a QA code on the respective tabs for the case 

representation. If a case does not contain a QA code the system displays an error 
message, but you can still save the data. When you save your data, all cases that 
contain the specified QA code are also saved. All cases that do not contain the 
QA code are not saved. If the procedure was pending, these cases remain 
unchanged. 

Revised Cases 
A follow up correlation cannot be performed after a revised report has been created for a 
case. When a revised report is created, any pending follow up correlation procedures are 
removed from the QA grid in the Quality Assurance option. After the revised report is 
signed out, the pending follow up procedures become available for completion and the 
updated diagnosis is displayed so that the follow up correlation can be completed.  

Completed vs. Not Completed Procedures 
When you save a follow up correlation, the system automatically marks it as completed. This 
is done to prevent the locking of multiple cases. For example, if five cases are correlated 
together and the procedure is left as not completed, all five cases are locked, preventing 
further entries until the procedure is completed. A new procedure would then be required to 
overwrite an erroneous entry in the follow up correlation.  
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My QA Worklist 

The My QA Worklist sub-option is used to collate cases pending QA entry by the user currently 
logged into the system. The system collates cases based on criteria defined in the Options setup file. 
To access this option, select Results > Quality Assurance > My QA Worklist from the main menu. 
The system displays the Cases tab with all pending cases that match the pre-defined search criteria if 
the Invoke Search on Entry checkbox is marked in Options - Sign Out tab - My Sign Out 
Worklist tab.  
If this checkbox is unmarked, the Advanced QA Search tab (Figure 3-52) is displayed. You can 
modify the default search criteria if the Allow Edit of Search checkbox is marked in Options – 
Quality Assurance tab - My QA Worklist tab. Click Find and a list of cases matching the search 
criteria is displayed on the Cases tab (Figure 3-49). 

 
Figure 3-52. Select Report Window – Advanced QA Search Tab 
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Sign Out Entry 

The Sign Out Entry options are used to change a case status to Signed Out. Afterwards, no changes 
can be made to the Final report without first generating a revised report. The sign out ID code, the 
person entering the information, and the date/time of sign out are registered by the system 
automatically.  

 
Figure 3-53. Results Menu – Sign Out Entry Submenu 

The Quality Assurance menu contains the following sub-options: 
• Sign Out By Case 
• My Sign Out Worklist 
• Sign Out by Case Range 
• Fast Sign Out 
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Random QA 
The random QA drawing can be performed from all Sign Out Entry options. All cases that 
qualify for the random drawing are held by the system (i.e., they cannot be signed out) until 
the QA procedure is performed. This process can be set up to run from the Scheduler option 
unless you need to force the drawing to release a specific case. When you need to release a 
specific case, click the Random QA toolbar button prior to performing a search. If the 
search has already been performed, click the Clear button and then click the Random QA 
button. The system displays a confirmation message when the drawing has been completed 
and the cases that were held are made available.  
NOTE: If the case you want to release was marked by the random selection for QA, you 

must have the ability to force sign out on QA marked cases to sign the case out. 
This permission is assigned in the Personnel file. 
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Sign Out by Case 

The Sign Out by Case sub-option can be used to sign out a single case.  
To access this option, select Results > Sign Out Entry > Sign Out by Case from the main menu. The 
Sign Out by Case Search window (Figure 3-54) is displayed. 

 
Figure 3-54. Sign Out by Case Search Window 

Enter any necessary search criteria in the available fields and click Find. A list of cases matching the 
entered criteria is displayed on the Cases tab (Figure 3-57). Refer to Completing the Sign Out 
Process on page 3-69 for information on performing the remainder of the sign out process. 
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My Sign Out Worklist 

The My Sign Out Worklist sub-option can be used to collate cases pending sign out by the user 
currently logged into the system. The system collates cases based on criteria defined in the Options 
setup file.  
To access this option, select Results > Sign Out Entry > My Sign Out Worklist from the main menu. 
A list of cases matching the pre-defined search criteria is displayed on the Cases tab (Figure 3-57) if 
the Invoke Search on Entry checkbox is marked in Options - Sign Out tab - My Sign Out 
Worklist tab.   
If this checkbox is unmarked, the My Sign Out Worklist Search window (Figure 3-55) is 
displayed. You can modify the default search criteria if the Allow Edit of Search checkbox is 
marked in the Options window - Sign Out tab - My Sign Out Worklist tab. Click Find to retrieve 
pending cases that match the current search criteria. 

 
Figure 3-55. My Sign Out Worklist Search Window 

Sign Out ID  
The Sign Out ID field defaults to the currently logged in user ID or a user ID specified in 
Options - Sign Out tab - My Sign Out Worklist tab. When you click Find, the system 
retrieves all cases assigned to the specified sign out ID. 

Only Completed Cases 
Mark the Only Completed Cases check box to only include cases that have met all 
milestones in your search. If this checkbox is unmarked, the system includes all currently 
unsigned cases in the search. 

Enter any other necessary search criteria in the available fields and click Find. A list of cases 
matching the entered criteria is displayed on the Cases tab (Figure 3-57). Refer to Completing the 
Sign Out Process on page 3-69 for information on performing the remainder of the sign out process. 
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Sign Out by Case Range 

The Sign Out by Case Range sub-option can be used to sign out only cases belonging to a specific 
case range or if you want to sign out all cases. This option also allows you to sign out all cases 
within a specified date range.  
To access this option, select Results > Sign Out Entry > Sign Out by Case Range from the main 
menu. The Sign Out by Case Range Search window (Figure 3-56) is displayed. 

 
Figure 3-56. Sign Out by Case Range Search Window 

Ordered From and To 
Enter a range of dates to include only cases ordered within the specified date range in the 
search. Click the  buttons to select a date from the calendar. 

Case Range From and To 
Enter a range of case numbers to include only cases with case numbers that fall within the 
specified range in the search. Click the  buttons from a list of valid case numbers. 

Enter search criteria in any of the other available fields and click Find. A list of cases matching the 
entered criteria is displayed on the Cases tab (Figure 3-57). Refer to Completing the Sign Out 
Process on page 3-69 for information on performing the remainder of the sign out process. 
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Completing the Sign Out Process 

After using Sign out by Case, My Sign Out Worklist, or Sign Out by Case Range to perform a 
search for cases pending sign out, a list of matching cases is displayed on the Cases tab (Figure 
3-57). When a case’s status changes, the Cases tab is automatically refreshed. 
NOTE: If you are using the My Sign Out Worklist option, the system will automatically 

perform the search using default criteria if the Invoke Search on Entry checkbox is 
marked in Options - Sign Out tab - My Sign Out Worklist tab. 

 
Figure 3-57. Select Report Window - Cases Tab 

Select the cases to sign out by marking the corresponding checkboxes and click OK. The report 
window for the case is displayed (Figure 3-58). Cases that appear grayed-out are inaccessible, which 
may be due to any of the following factors: no security permission for the sign out level, random 
draw not yet performed for QA percentiles, or pending QA. 
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Figure 3-58. Sample Report Window For A GYN Case 

NOTE: To switch from the Word document to the Sign Out competition window, click ALT+ 
the down arrow key. 

The fields and buttons that can appear in the completion window are listed below. These may vary 
depending on case type, required QA procedures, etc.  
Sign/Done By 

Enter the ID of the employee performing the QA activity. 
Pathologist 

Enter the ID of the pathologist working the case. 
Screener Evidence Count 

This field displays the number of slides screened by a User ID each day. This value can be 
edited, but to no more than the number of slides in the current case. 

Resident(s) Button 
Click the Resident(s) button to display the Resident(s) window for identifying any residents 
who worked on the case. 

Release Case 
Mark the Release Case check box to force the release of a case directly to “Signed Out” 
status, bypassing the “Hold time after signout” setting in Setup > Option s> Sign Out > 
Sign Out. 

DX Category 

Click the  to display the Diagnosis Category Lookup window for selecting the diagnostic 
category for the case. 

Qualifies for Cancer Agency Report 
Mark the Qualifies for Cancer Agency Report check box to flag the case for the Cancer 
Agency Report. For more information, see Chapter 5.3 – Reports: Cancer Agency Report.  



SoftPath GUI v.4.2.1 User Manual Chapter 3.3 – Results: Sign Out Entry 

PATH4.2-G-U (6th Ed, Rel. 01/31/07)   Page 3-71 

NOTE: This checkbox will only appear if Cancer Agency Reporting is enabled in 
Options. 

Add Code Button 
To add a new diagnosis code to the case, click the Add Code button. Refer to page 3-21 for 
more information on this functionality. 

Delete Code Button 
Highlight the diagnosis code on the grid that you want to delete and click the Delete Code 
button to delete the diagnosis code. 

DX Find Button 
Clicking the Dx Find button prompts SoftPath to read the final diagnosis text and look for 
the appropriate codes. Refer to page 3-22 for more information on this functionality. 

More Button 
Click the More button to display the Final Report window (Figure 3-59) for the current 
case. This window allows you to view or enter new information for the case. The tabs 
located in this window are described below. When you have finished entering data, click OK 
to save the information or click Cancel to return to the report window without saving the 
information. 

 
Figure 3-59. Final Report – More Data Window 

Calls Tab 
The Calls tab is used to add calls to the current case. For a detailed description of 
this tab, refer to Chapter 1 – Order: Specimen Registration – Calls Tab. 

Letters Tab 
The Letters tab is used to add letters to the current case. For a detailed description 
of this tab, refer to Chapter 1 – Order: Specimen Registration – Letters Tab. 

Undergo QA Tab 
The Undergo QA tab allows you to enter information about the QA procedures for 
the current case. For a detailed description of this tab, refer Chapter 1 – Order: 
Specimen Registration – Undergo QA Tab. 
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Adequacy/Problems Tab 
The Adequacy/Problems tab allows you to enter information regarding the 
adequacy or processing problem codes to be assigned at the case or specimen level. 
Up to three codes can be selected for Adequacy and Processing Problems. For a 
detailed description of this tab, refer to Chapter 1 – Order: Specimen Registration 
– Adequacy/Problems Tab. 

Order Stains/Slides Tab 
Refer to page 3-28 for information about the Order Stains/Slides tab. 

Other Case Data Tab 
The Other Case Data tab (Figure 3-61) allows you to enter additional information 
concerning the case, such as the number of service units or the reported to doctor. 

 
Figure 3-60. Final Report – More Data Window – Other Case Data Tab 

Billing Part A and Part B Tabs 
The Billing tabs (Figure 3-61) display the calculated charges captured from the user-
defined transaction table. Only the Change To, Change Type, and Location fields 
can be edited.  

 
Figure 3-61. Final Report – More Data Window - Billing Part A Tab 
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Change To 
You can change a captured value entering a new value in the Change To 
field. Select a value for the Change Type field: 

• Permanent - The system reads the manually entered value and not 
the automatically calculated value. 

• Increment - The system reads the automatically calculated value 
and adds the manually entered value. 

Enter a permanent/increment value in the Change To field. Maximum 2 
numeric characters. The captured value is changed when you click OK.  

Sent Charges 
The Sent Charges field displays the number of charges sent to the 
SoftA/R® module. 

Location 
The Location field is used to enter the location where the test was 
performed for billing purposes. This location is sent, along with the billing 
charges, to the SoftA/R® module. 

Unflag Sent Charges Button 
Click the Unflag Sent Charges button to unflag charges that were 
previously sent to SoftA/R. These charges are no longer flagged as billed. 

Add Button 
Click the Add button to add any charge defined in the Charge Code option 
to the case. If you add a charge, the Change To field defaults to a value of 1 
and the Change Type field defaults to Increment. 

Delete Button 
Select a charge and click the Delete button to delete the charge from the 
case. You can only delete manually entered charges and only before the 
charges are sent to the SoftA/R® module.  
NOTE: Since automatically captured charges cannot be deleted, you can 

use credits to cancel the charges. This function credits both 
automatically captured charges and manually entered charges. 

Reassign Loc Button 
Click the Reassign Loc button to change the location specified in the 
Location field if a default location is specified in the Charge Code option. 

Assign ICD9 to CPT Codes Tab 
The Assign ICD9 to CPT Codes tab is used to associate up to four ICD9 codes with 
any available CPT codes for part B billing purposes.  
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Figure 3-62. Final Report – More Data Window - Assign ICD9 to CPT Codes 
Tab 

ICD 9 
Enter the ICD9 codes you want to associate with the available CPT codes in 
the 1, 2, 3, and 4 fields. 

CPT Code Grid 
The CPT Code grid displays the CPT codes available for the current case. 
Enter a number (1-4) corresponding with the ICD9 codes you entered at the 
top of the window in the ICD9 1, ICD9 2, ICD9 3, and ICD9 4 columns. 
This assigns the specified ICD9 codes to the selected CPT code. 

Billing Information Tab 
Depending on your Options settings (see Chapter 6 – Setup: Options – Utilities 
Tab – Billing Tab), the Billing Part A, Billing Part B, and Assign ICD9 to CPT 
Codes tabs can be consolidated into the Billing Information tab. 

 
Figure 3-63. Final Report – More Data Window – Billing Information Tab 
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Order Stains/Slides Button 
Click the Order Stains/Slides button to display the Final Report – More Data window 
with the Order Stains/Slides tab displayed. Refer to page 3-28 for information about the 
Order Stains/Slides tab. 

Sign Out Button 
Click the Sign Out button to save all your data and sign out the case. The report window 
closes and the system returns you to the list of cases eligible for sign out. 

Cancel Button 
Click the Cancel button to close the completion window and return to the report. Make any 
necessary additions and/or changes to the report and then click Save Data. The appropriate 
completion window displays, allowing you to sign out the case. 

Result Comment Button 
Click the Result Comment button to open a 500-character free text window for entering any 
comments regarding the result. 
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Fast Sign Out 

The Fast Sign Out option is used to sign out cases in a batch mode. The required case status can be 
set in the Options file to determine the cases available in the Fast Sign Out option.  
You cannot change any case information in this option. If the pathologist ID was not entered, it 
defaults from the ID entered in the Done By field during final diagnosis entry (but only when the 
parameter Auto Sign ID is active for the given case type). If you activate the parameter Display 
Sign Out ID Window In Fast Sign Out, the system allows you to select which sign out ID you 
want to use. The system displays all cases assigned to the specified sign out ID. 
To access the Fast Sign Out option, select Results > Sign Out Entry > Fast Sign Out from the main 
menu. The Fast Sign Out search window (Figure 3-64) is displayed. 

 
Figure 3-64. Fast Sign Out Search Window 

There are four possible configurations for this option that are defined in Options - Sign Out tab - 
Sign Out tab. These configurations determine which windows display when you access this option. 
• Both the Display Sign Out ID Window In Fast Sign Out and Ability to S/O Cases Only For 

Logged On Pathologist check boxes are not marked. The Fast Sign Out search window is 
displayed similar to Figure 3-64. Enter search criteria and click OK. A list of cases that can be 
signed out and match the specified criteria is displayed. 

• The Display Sign Out ID Window In Fast Sign Out check box is not marked, but the Ability 
To S/O Cases Only For Logged On Pathologist check box is marked. The user ID for the 
currently logged on user displays in the Sign Out ID field. Enter search criteria and click OK. 
The sign out ID is automatically entered by the system and cannot be changed. After you click 
OK, the system displays a list of cases matching the specified criteria that you can sign out. 

• The Display Sign Out ID Window In Fast Sign Out check box is marked, but the Ability To 
S/O Cases Only For Logged On Pathologist check box is not marked. The Person Can Sign 
Out Lookup window is displayed. Select the person signing out the case and click OK. Cases 
ready to sign out for the selected ID are displayed. 



Chapter 3.3 – Result: Sign Out Entry SoftPath GUI v.4.2.1 User Manual 

Page 3-78  PATH4.2-G-U (6th Ed, Rel. 01/31/07) 

• Both the Display Sign Out ID Window In Fast Sign Out and Ability to S/O Cases Only For 
Logged On Pathologist check boxes are marked. The Fast Sign Out window displays 
immediately with pending cases for the currently logged on user ID. No search window is 
available. 

After entering the search criteria, click OK to display the Fast Sign Out window (Figure 3-65), 
which lists all cases pending sign out that match the specified criteria. 

 
Figure 3-65. Fast Sign Out Window 

Select the cases you want to sign out. To select a case, highlight the case row(s) and click Mark 
Selected. To select all cases, click Mark All. After selecting the cases, click the Sign Out button. 
The selected cases are signed out using the ID that was assigned to the case and the system displays a 
confirmation message. 
Print List 

Click the Print List button to display a printer selection window for printing the list of cases 
qualifying for Fast Sign Out.   

Final Dgn 
Selection of the Final Dgn button will display the Final Diagnosis text for the highlighted 
case.  
NOTE: The Final Diagnosis text is displayed in read-only mode. 
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IntraDepartmental Consultation 

The IntraDepartmental Consultation option is used to enter intradepartmental consultations 
outside of the Result Entry option. 
To access the IntraDepartmental Consultation option, select Results > Intradepartmental 
Consultation from the main menu. The IntraDepartmental Consultation Search window (Figure 
3-66) is displayed.  

 
Figure 3-66. IntraDepartmental Consultation Search Window 

Entered search criteria in any of the available fields and click Find; a list of matching cases is 
displayed on the Cases List tab. Select the desired case by double-clicking it and the 
IntraDepartmental Consultation for Case tab (Figure 3-67) is displayed.  
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Figure 3-67. IntraDepartmental Consultation Search Window – IntraDepartmental 
Consultation for Case Tab 

Any previously entered interdepartmental consultations for the case are displayed on the 
IntraDepartmental Consultation for Case tab (Figure 3-67).  Click the View, Edit, or Delete 
buttons or click the New Consultation button to add a new consultation to an unsigned case; the 
IntraDepartmental Consultation window (Figure 3-68) is displayed. A case must be unsigned to 
change any consultation information. 
NOTE: To add, edit, or delete, users must be defined with a personnel type of pathologist in the 

Personnel Setup File. 

 
Figure 3-68. IntraDepartmental Consultation Window 

The top portion of the IntraDepartmental Consultation window contains read-only patient 
demographic information.  
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Pathologist ID 
Enter the pathologist’s ID.  

Consultation D&T 
Enter the consultation date and time. These fields indicate the date and time the consultation 
was performed. This information can be entered manually or you can click the  button to 
display a calendar to make a selection.  

Comment 
Enter a free-text comment Maximum 200 alphanumeric characters. 

When you have completed entering or editing the consultation, click the Save button on the toolbar. 
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Chapter 4. Query 

The Query menu options provide a number of different methods that can be used to view detailed 
case information.  

 
Figure 4-1. Query Menu 
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SoftPath Query Menu Options 
The SoftPath Query option contains the following features and applications: 

Results Query 
To view detailed information for a single case, select the Results Query option.  
See Chapter 4.1—Query: Results Query. 

Doctor’s Query 
The Doctor’s Query option allows an attending physician to select and view his or her own 
cases.  
See Chapter 4.2—Query: Doctor’s Query. 

Complex Query 
To enter more detailed search criteria and view more information for a search than the other 
two query options, select the Complex Query option.  
See Chapter 4.3—Query: Complex Query. 

Synoptic Query 
To run a detailed query for cases where the synoptic reporting functionality was used during 
results entry, select the Synoptic Query option.  
See Chapter 4.4 – Query: Synoptic Query. 
 

Helpful Keyboard Shortcuts for all Query Screens 

F2 Opens Accession Sequence Lookup 

TAB Moves through the fields in order. 

CTRL+TAB Used to switch between Simple and Advanced search. 

CTRL+F Once all data is entered, use to Find. 

CTRL+K To clear all information from Query screens. 

ENTER To run a search once all information has been entered. 
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Results Query 

The Result Query option allows you to view detailed information for a single case. This option can 
also be used to query a patient instead of a case. The histories for the previous cases (active and 
archived) are available when the case is displayed. 
To access the Result Query option, select Query > Results Query from the main menu. The Result 
Query Search window (Figure 4-2) is displayed.  

 
Figure 4-2. Result Query Search Window 

In the Result Query Search window, select either the Simple Search or Advance Search tab. 
• Simple Search Tab - When performing a search using this tab, you should search by the case 

number or the patient name. Any of the available fields can be used to limit the search. 
• Advanced Search Tab - The Advanced Search tab allows you to enter more specific 

information to narrow the search.  

 
Figure 4-3. Result Query Search Window - Advanced Search Tab 
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After entering the necessary search criteria, click the Find button. Cases or patients that match the 
specified criteria are displayed on the Cases tab. Highlight a patient/case and click the OK button to 
perform a results query for the specified patient/case. The Results Query window (Figure 4-4) is 
displayed.  

 
Figure 4-4. Results Query Window 

The Result Query window displays the patient demographics, stay demographics, and case number 
for the selected case. This window also contains tabs that provide more detailed information about 
the selected case (the format of these tabs depends on the type of case selected).  
NOTE: The Result Query window displays information in READ-ONLY mode. You can only 

edit information in the Letters, Calls, and Undergo QA tabs. 
Case Description Tab 

The Case Description tab displays the processing status of the case and provides hyperlinks 
to other Result Query tabs. You can view the final reports for the cases by clicking the final 
report hyperlinks.  
NOTE: If the case has not been signed out, it is marked in red as an unsigned result. 
NOTE: The ability to view the unsigned final diagnosis and gross description is 

determined in the Security Settings tab of the Personnel file. If you do not want 
users to be able to view the final report or gross description prior to sign out, set 
these permissions accordingly in the users’ personnel records. 

Case Data Tab 
The Case Data tab displays the registration information about the case including case 
number, date and time of death, date and time of registration, date and time of autopsy, 
requesting doctor, pathologist, resident, priority, foreign case number, and HIS number. 
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Specimens Tab 
The Specimens tab allows you to view detailed information regarding the specimens, 
including the following information: specimen ID, source code, description, body site, and 
collection method. The following buttons are available on this tab:. 

Processing  Displays the Specimen Processing window, which allows you to 
review the specimens and blocks submitted for the case. 

Comment  Click this button to view free text comments for the specimen. 

Special Tests  Displays the Special Test window for any ordered special stains. 

Lab Tests  Displays the Laboratory Tests window and all associated lab results. 

Micro Tests Displays the Microbiology Tests window and all associated micro 
results. 

Source Flags  Displays the Source Flags window and any flags or processing 
information. 

UDF Displays user defined flags that have been assigned to a case. 

Patient Tab 
The Patient tab displays patient demographics such as name, age, sex, race, medical record 
number, patient address, etc.  

Billing Tabs (Part A and B) 
The Billing Part A tab and the Billing Part B tab display the billing status of the case. 
Technical (part A) or professional (part B) internal billing codes are counted in the night 
billing by IBC, CPT, Name, Calculated, Change To, Change Type, Sent Changes, and 
Location. 

Patient History Tab 
The Patient History tab displays any previous history for the patient based on the criteria 
specified during system setup. The Patient History tab includes cases from both the active 
and archive databases. The information displayed includes case number, billing number, 
requesting doctor, pathologist, and order date.  
NOTE: Clicking a case number in the Patient History tab bridges you to the Result 

Query window for that case. Red text signifies a case with an abnormal result. 
Undergo QA Tab 

The Undergo QA tab displays the quality assurance (QA) procedures assigned to and/or 
completed for the case. If the rescreen, proreview, or retroreview procedures have been 
performed, you can view the completed date and the ID of the person that performed the 
procedure. The QA results are also displayed. 

Adequacy/Problems Tab 
The Adequacy/Problems tab contains two areas:  
• Adequacy Area - Displays the adequacy codes (up to three) that have been assigned to 

the case or specimen. 
• Processing Problems Area - Displays the processing problem codes (up to three) that 

have been assigned to the case or specimen. 
The Specimen Adequacy Info window displays any free text entered for specimen 
adequacy/processing problems.  
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Other Case Data Tab 
The Other Case Data tab allows you to view any previously entered data, including Tag 
Letters (up to three), Reported To doctor ID’s (up to three), and the number of Service 
Units captured at all levels. 
The autopsy flags include Stillbirth, Partial Autopsy, Complete Autopsy, Undiagnosed 
Infection, ID Only, Intraoperative, and Consultations. 
The buttons available on this tab allow you to perform the following functions: 

Case Comment  Displays the Case Comment window, which contains any text entered 
during specimen registration. 

Clinical Info Displays the Clinical Info window, which contains any clinical 
information entered during specimen registration. 

Operation Info Displays the Operation Info window, which contains any operation 
information entered during specimen registration. 

Processing History Tab 
The Processing History tab displays the processing history for the case, including details for 
every action performed on the case including the date and time of the action, who performed 
the action (done by/typed by), and a description of the procedure/action. The Additional 
Info area displays any additional information related to the procedure/action. For printing 
actions, the system displays the Printer ID or Fax number that the final report was sent to.  

Outgoing Consultation Tab 
The Outgoing Consultation tab displays information regarding the status of any outgoing 
consultation requests for the case. The buttons available on this tab allow you to perform the 
following functions: 

Slide Sel If there are any slides associated with the current case that have been sent to 
the consultation, the checkbox next to the Slide Sel button is marked. 
Clicking Slide Sel displays the Select Slides window. All slides assigned to 
the current case that have not been sent out are displayed on the grid. 

Block Sel If there are any blocks prepared in the laboratory for this case that have not 
been sent to the consultation, the checkbox next to the Block Sel button is 
marked. Clicking this button displays the Select Block window. 

Comment If there is any comment for the case, the checkbox next to the Comment 
button is marked. Clicking this button displays the free text comment 
window. 

Return Mat If any of the materials have been returned, the checkbox next to the 
Returned Materials button is marked. Clicking this button displays the 
Returned Materials window, which contains a list of materials that were 
sent out. Returned materials are also flagged on the grid in the Returned 
Materials window. 

Incoming Consultation Tab 
The Incoming Consultation tab displays information regarding the status of any incoming 
consultation requests for the case. 
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Reports Tab 
The Reports tab allows you to view and/or print reports. The Reports tab contains the 
created date, report type, status, and sign-out date. The default report types displayed on this 
tab are defined in the Query tab of the Options file. The buttons available on this tab allow 
you to perform the following functions: 

Mark/Unmark Selected Click this button to mark/unmark selected reports in the grid. 

Mark/Unmark All Click this button to mark/unmark all of the reports in the grid. 

View Click this button to view the marked reports. 

Print Click this button to print the marked reports. 

Send to HIS If the case has been signed out, click this button to manually 
send the report to the HIS. 

All Reports This button shows all reports if the user has the appropriate 
security clearances. 

NOTE:   To restrict users to the final report only, do not give them access to this tab in 
the SoftSecurity™ module. 

Diagnoses Tab 
The Diagnoses tab displays the diagnosis codes assigned to the case. Information displayed 
includes code, class, description, diagnostic coding system, diagnosis category, and 
diagnosis type. 

Letters Tab 
The Letters tab displays information concerning any letters to be sent for the case. Users 
with security access can also add letters to the case from this tab. The buttons available on 
this tab allow you to perform the following functions: 

Display Letter Displays the attached letter. 

Add New To add a new letter, click the Edit button on the toolbar and then click 
the Add New button. Adding a new letter is described in Chapter 1 – 
Order: Specimen Registration. 

Calls Tab 
The Calls tab displays information about any calls requested for the case. Users with proper 
access can also add calls to the case. The buttons available on this tab allow you to perform 
the following functions: 

Call Comment Click this button to display the Requesting Call Comment window. 

Call Again Click this button if you want to repeat any performed call. 

Add Call To add a call to the case, click the Edit toolbar button and then click 
the Add Call button. 

GYN Info Tab 
The GYN Info tab is only displayed for GYN cytology cases and shows any GYN 
information that was entered during specimen registration. The buttons available on this tab 
allow you to perform the following functions: 

Menop Info Displays the Menopause Information window. 

Comment Displays the GYN Info Comment window. 
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MED Info Tab 
The Med Info tab displays any MED cytology information entered during specimen 
registration or specimen processing. This tab is only displayed for MED cytology cases. 

Autopsy Info Tab 
The Autopsy Info tab displays information about the place, time, and manner of death. This 
tab is only displayed for autopsy cases. 

Age Info/Body Tab 
The Age Info/Body tab displays information pertaining to the age and size of the body that 
was entered during specimen registration. This tab is only displayed for autopsy cases. 

Organs/Bones Tab 
The Organs and Bones tab is only displayed for autopsy cases. There are two tables in this 
tab that contain information about organs and bones determined during the autopsy.  

Risk Factors Tab  
The Risk Factors tab is used to enter, modify, and view risk factors for the current patient. 
The grid on this tab displays the code, name, severity level, assigned date, expiration date, 
and MRN of all risk factors associated with the patient.  
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Doctor Query 

The Doctor Query option allows the attending physician to select and view his or her own cases 
based on the login ID. The system searches the cases in the active database first and then the archive 
database. 
To access the Doctor Query option, select Query > Doctor Query from the main menu. The Doctor 
Query Search window (Figure 4-5) is displayed.  
NOTE:  The Doctor Query window displays information in READ-ONLY mode. Only 

information in the Letters and Calls tab can be edited. 

 
Figure 4-5. Doctor Query Search Window 

NOTE: The login ID must match the Doctor ID that exists in the Doctors setup file. 
In the Doctor Query Search window, select either the Simple Search or Advance Search tab. 
• Simple Search Tab - When performing a simple search, search by the case number or the 

patient name. Any of the fields can be used to limit the search. 
• Advanced Search Tab - The Advanced Search tab (Figure 4-6) allows you to enter more 

specific information to narrow the search. The admitting doctor ID displayed in the Adm Doctor 
field defaults from the user ID of the currently logged in user and cannot be changed. 
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Figure 4-6. Doctor Query Search Window - Advanced Search Tab 

After entering any additional search criteria, click the Find button. Any cases or patients that match 
the specified criteria are displayed on the Patient or Cases tab. 
The results of your search depend on the type of search performed. 
• Results display on the Cases tab if the search was performed using case data. 
• Results display on the Patient tab if the search was performed using patient data. 
Highlight a patient or case and click the Select button to perform a query for the specified 
patient/case. The Doctor Query window displays the patient demographics, stay demographics, and 
case number for the selected case. This window also contains tabs that provide more detailed 
information about the selected case (the format of these tabs depends on the type of case selected). 
The fields and tabs of this window are identical to those contained in the Result Query window. 
Refer to page 4-3 for detailed information about the tabs of the Doctor Query window. 
NOTE: The Doctor Query window and all related tabs are displayed in READ-ONLY mode.  
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Complex Query 

The Complex Query option allows you to enter more detailed search criteria and displays more 
information than the other Query menu options. It allows you to view all cases matching the search 
criteria, one by one, even if they do not concern the same patient. The Complex Query option 
allows you to search both the active and archive database. 
To access the Complex Query option, select Query > Complex Query from the main menu. The 
Complex Query window (Figure 4-7) is displayed.  

 
Figure 4-7. Complex Query Window 

The Complex Query window allows you to search by several different combinations of variables 
and define the sorting criteria. More information results in a narrower and faster search. Some of the 
search criteria fields for the Complex Query option are described below. 
Date Range 

Select Ordered from the drop-down list and enter a range of dates to search for cases 
ordered within the specified date range. Select Signed Out and enter a range of dates to 
search for all cases signed out within the specified date range. The range of dates can be 
entered manually or you can click the  button to select a date from the calendar. The 
default number of days for the date range is defined in the Options file. 
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Status 
Select the processing status of the cases you want to include in the complex search. Use the 
drop-down list to select one of the possible statuses. 

Database 
Select the check boxes corresponding to the database(s) you want to search: Working or 
Archive.  

Case Type 
Select the check boxes corresponding to appropriate case type (e.g., Autopsy, GYN, MED, 
or Surgical). 

Dx Text Search Button 
Click the Dx Text Search button to open the Search Text Criteria window (Figure 4-8).  

 
Figure 4-8. Search Text Criteria Window 

Specify the section of report text you want to search and use the drop-down list to select 
from the following possible choices: 

• Final Diagnosis – Searches the final diagnosis text. 
• Gross Description – Searches for Gross Description text. 
The following selections are only available if the parameter RH_GROSS_SAVE is set to 
“Y”: 
• Clinical History - Searches the Clinical History field. 
• Source Name - Searches the Source field. 

Words 
Enter the words you want to search for based on the text field selected. 
NOTE:   And/Or operators are available to expand your search. 

Req Doctor 
 Select the requesting doctor(s) to limit the search. A maximum of four can be selected. 
Pathologist 
 Select the pathologist(s) to limit the search. A maximum of four can be selected. 
Accession Base 

Select the Accession base to limit the search. A maximum of three can be selected. 
Sex 

Select a gender to limit the search. 
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Last Name and First Name 
Use these fields to search by patient name. 

Tumor Registry 
Select the Tumor Registry status to limit the search. Select from Yes, No, or All. 

Diagnoses 
Click the  button to display the Select Diagnosis Code System window (Figure 4-9). 

 
Figure 4-9. Select Diagnosis Code System Window 

Double-click the diagnosis code system name to display the appropriate lookup window and 
select the required diagnosis code. Up to three diagnosis codes can be entered. 
The selection can be limited by selecting an And/Or logic operator from the drop-down lists 
between the diagnosis codes fields. Choose one of the following:  

And Both codes must be present for the case to qualify for the query.  

Or At least one of the codes must be present for the case to qualify for the query.  

Tag Letter 
Use the Tag Letter drop-down list to limit the query based on the available tag letters. 

Image Status 
Select one of the following choices to search by the image status: 

• Documents With Images 
• Documents Without Images 
• Documents With and Without Images 

NOTE: Searching for documents that do or do not contain images will increase your 
search time. For faster search time, search using the “Documents With and 
Without Images” option. 

Dx Group 
Click the  button to display the Diagnosis Group Lookup window. Select a group by 
double-clicking the appropriate row. Up to three diagnosis groups can be selected. 
The selection can be limited by selecting an And/Or logic operator from the drop-down lists 
between the diagnosis codes fields. Choose one of the following:  

And Both codes must be present for the case to qualify for the query.  

Or At least one of the codes must be present for the case to qualify for the query.  



Chapter 4.3 – Query: Complex Query SoftPath GUI v.4.2.1 User Manual 

Page 4-14   PATH4.2-G-U (6th Ed, Rel. 01/31/07) 

Par X,Y,Z 
The Par X,Y,Z fields allow you to search for cases based on a defined set of parameters. 
The parameters available are drawn from the transaction lines in the Billing setup file. 
Up to three parameter codes can be selected. Click the  button to display the Select 
Workload/Billing Flag window (Figure 4-10) and highlight the appropriate row and double-
click to select it. 

 
Figure 4-10. Select Workload/Billing Flag Window 

Source 
Select a source to limit the search. 

Body Site 
Select a body site to limit the search. 

Test 
Select a special stain/test to limit the search. 
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Condition 
The Condition field is used to define the conditions for the parameters selected in the Par 
X, Y, Z fields. Click the  button to display the Logic Calculator (Figure 4-11). 

 
Figure 4-11. Logic Calculator 

Use the Logic Calculator to set up conditions. A description of possible choices is provided 
below. 

X Parameter X * multiplied by 

Y Parameter Y - minus 

Z Parameter Z + plus 

!X not X > greater than 

!Y not Y < less than  

!Z not Z != not equal 

, separate two conditions = equal to 

/ divided by   

And/Or 
Select the logic operator (and or or) to connect the next line of parameters. A logical 
operator connects each of the three lines of conditions. Select a logic operator from the drop-
down lists between the diagnosis codes fields. Choose one of the following:  

And Both codes must be present for the case to qualify for the query.  

Or At least one of the codes must be present for the case to qualify for the query.  
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Completing the Query 
After entering the necessary search criteria, click Find. A list of cases matching the search criteria 
are displayed on the Cases List tab (Figure 4-12).  

 
Figure 4-12.  Complex Query Window - Sample Cases List Tab 

Print List Button 
Click the Print List button to print the list of cases that match the specified criteria. 

Print Final Reports Button 
Click the Print Final Reports button to print the final reports that have been selected from 
the qualifying list. By default all reports are selected, but it is possible to select and deselect 
reports if desired. 

Highlight a case and click the OK button to perform a query for the specified patient/case. The 
Complex Query window is displayed with the patient demographics, stay demographics, and case 
number for the selected case. This window also contains tabs that provide more detailed information 
about the selected case (the format of these tabs depends on the type of case selected). The fields and 
tabs of this window are identical to those contained in the Result Query window. Refer to page 4-3 
for detailed information about these tabs  
NOTE: The Complex Query window displays information in READ-ONLY mode. You can 

only edit information in the Letters and Calls tab. 
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Synoptic Query 

Synoptic Query provides the ability to run a detailed search for cases where synoptic reporting 
functionality has been used during results entry. Synoptic Query provides both an ad hoc search 
capability as well as the ability to save user-defined searches for later use. 
To access the Synoptic Query option, select Query > Synoptic Query from the main menu. The 
Synoptic Query window (Figure 4-13) is displayed.  

 
Figure 4-13. Synoptic Query Window 

The ad hoc search screen provides the ability to search for three different synoptic data elements. 
Also, three options within those data elements can be selected below the elements to limit the search. 
To include more data elements in the search grid, specify those elements in the Additional Synoptic 
Data Elements section. 
NOTE: The Additional Synoptic Data Elements do not affect the search, but simply appear in 

the search results grid as a way to isolate a specific case or cases. 
Once a search has been specified, it can be saved for future use simply by clicking the Save button at 
the top right of the window. The system will ask you to provide a name for your search. The search 
can then be accessed and run again using the User-Defined Synoptic Search tab in the Synoptic 
Query search window. 
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Figure 4-14. User Defined Synoptic Search Tab 

Once cases that meet the search criteria are found, you can print the list of qualifying cases or bridge 
to the Case Description tab of Results Query for that case. Refer to page 4-3 for more information 
about working within Results Query. 
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Chapter 5. Reports 

The Reports menu options allow you to view or print reports such as results report, quality 
assurance reports, ODBC reports, and various system logs.  You can access any of the Reports 
options from the Reports menu on the SoftPath desktop. 
NOTE:   All examples and listings of report contents assume that you are using the standard 

system settings. If your organization is using any setting other than the standard reports, 
the data contained in the reports may differ from the examples given. 

 
Figure 5-1. Reports Menu 
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SoftPath Report Menu Options 
The SoftPath Report option contains the following features and applications: 

Report Launcher 
The Report Launcher helps you generate reports from the SoftPath database.  
See Chapter 5.1—Reports: Report Launcher. 

Result Reports 
The Result Reports option allows you to print reports, worksheets and letters. 
See Chapter 5.2—Reports: Result Reports. 

Billing Reports 
The Billing Report options allow you to produce a report and/or file for billing purposes. 
See Chapter 5.3—Reports: Billing Reports. 

Cancer Agency Report 
The Cancer Agency Report allows you to create a file that contains all cases flagged as 
qualifying for Cancer Agency Reporting 
See Chapter 5.4—Reports: Cancer Agency Report. 

Case Logs 
The Case Logs options includes the following reports: Autopsy Case Report, Deleted Cases 
Log, Deleted Stays Log, Doctor Cytology Report, Parent Source Log, Resulted Cases Log, 
Revised Cases Log, and the Post Sign Out Modification Log. 
See Chapter 5.5—Reports: Case Logs. 

Patient Management Reports 
The Patient Management Reports option includes the following reports: Collated Patient 
History Report and High Risk Patient Report. 
See Chapter 5.6—Reports: Patient Management Reports. 

Consultation Logs 
The Consultation Logs option includes the following logs: Incoming Consultation Log, 
Outgoing Consultation Log, Temporary Data Log, and Consultation Discrepancy Log. 
See Chapter 5.7—Reports: Consultation Logs. 

Daily Reports 
The Daily Reports option includes the following logs: Case Status Log, Daily Accession 
Log, Daily Case Log, and Daily Result Log. 
See Chapter 5.8—Reports: Daily Reports. 

Processing Logs 
The Processing Logs option includes the following logs: Cytology Slides Log, Daily Blocks 
Log, Histology Slides Log, Processed Blocks Log, Processed Specimen Log, Special Stain 
Log, and Specimen Status Log. 
See Chapter 5.9—Reports: Processing Logs. 

QA Reports 
The QA Reports option allows you to run reports for various QA purposes.  
See Chapter 5.10—Reports: QA Reports. 
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Report Logs 
The Report Logs option includes the following logs: Preliminary Report Log and 
Supplemental Report Log. 
See Chapter 5.11—Reports: Report Logs. 

Worksheets 
The Worksheets option includes the following worksheets: QA Worksheets and Pending 
Stain Worksheet.  
See Chapter 5.12—Reports: Worksheets. 

ODBC Reports 
The ODBC Reports option allows the user to select and print a report from a list of reports 
previously defined using Microsoft Access and Structured Query Language (SQL).  
See Chapter 5.13—Reports: ODBC Reports. 

Action Logs 
The Action Logs option allows you to prepare reports and logs containing cases with an 
Action Entry procedure that was performed. You can also prepare worksheets with cases that 
qualify for this action entry.  
See Chapter 5.14—Reports: Action Logs. 
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Report Launcher 

All SoftPath reports (except Result reports, several management reports, and ODBC reports) are 
accessed using the Report Launcher window. The Report Launcher window is an application that 
helps you generate reports from the SoftPath database.  
From the Report menu, select the report to open and the system bridges you to the Report 
Launcher window where the report criteria fields for the selected report are displayed. Enter the 
appropriate report criteria and click Run to generate the report. Common report criteria fields are 
detailed on page 5-16. 

 
Figure 5-2. Report Launcher Window 
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Launcher Utility: Menus and Tool Buttons 
To help you to navigate through the Launcher utility, each menu command and its corresponding 
tool button, if any, is listed and described below in the order in which it appears on the Launcher 
utility menu bar. 
File Menu 

The File menu in the Launcher utility enables you to close the current window without 
exiting the Launcher utility and exit the Launcher utility without exiting SoftPath. 

 
Figure 5-3. Report Launcher – File Menu 

Close  
Select File > Close to close the current window without exiting the Launcher 
utility. 

Exit 
Select File > Exit to exit the Launcher utility without exiting SoftPath. 

Edit Menu 
The Edit menu enables you to cut, copy or paste information in the Launcher. 

 
Figure 5-4. Report Launcher – Edit Menu 

 
 
 
 
 
 

Cut 

 To cut, select Edit > Cut, click the Cut button, or press CTRL+X. 

Copy 

 To copy, select Edit > Copy, click the Copy button, or press CTRL+C. 

Paste 

 To paste, select Edit > Paste, click the Paste button, or press CTRL+V. 
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View Menu 
The View menu enables you to show or hide the toolbar, status bar, and/or the status 
window. In addition, from this menu you can view the SoftPath Hosparams, view the trace 
file and scheduler log, and switch to the report list, report details. or status window. 

 
Figure 5-5. Report Launcher – View Menu 

Toolbar 
To show the Launcher utility toolbar, select View > Toolbar4. The right-pointing 
arrow to the right of the menu command indicates that there is a submenu with 
additional options: Standard, Report Status and Tools. The check mark (a) to the 
left of the menu option indicates that the toolbar is in view. To hide the toolbar, 
select View > Status Bar to clear the check mark. 

Status Bar 
To show the Launcher utility status bar, select View > Status Bar. The check mark 
(a) to the left of the menu option indicates that the status bar is in view. To hide the 
status bar, select View > Status Bar to clear the check mark. 

Status Window 

 
To show or hide the status window, select View > Status Window, click the Show or 
Hide Status Window button, or press SHIFT+F9. The status window can be 
moved and/or resized within the launcher screen. This area contains a list of reports 
that have been generated recently. The columns display information for each of the 
reports. This area allows you to view, print, or delete existing reports. You can view 
reports in the top portion of the window if you double-click a report row in the 
Report Status area. 

Trace 

 To display the Trace File window, select View > Trace4. The right-pointing arrow 
to the right of the menu command indicates that there is a submenu with additional 
options: Main System and Auxiliary System. This window displays all actions 
performed in the Launcher and Report Viewer. 

Switch to 
To switch to a different view, select View > Switch to 4. The right-pointing arrow 
to the right of the menu command indicates that there is a submenu with additional 
options: Report List (ALT + 1), Report Details (ALT + 2) and Status Window 
(ALT + 3). 
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Status Menu 
The Status menu in the Launcher utility enables you to filter and refresh a report; view, 
print, and delete selected reports; flag and rerun a report; select all reports; and view 
properties. 

 
Figure 5-6. Report Launcher – Status Menu 

Filter 

 
To display the Report Filter Set Up window, select Status > Filter, click the Filter 
button, or press CTRL+SHIFT+F. The Filter button is available when the Status 
window is open. 

 
Figure 5-7. Report Filter Set Up Window 

The Report Filter Set Up window enables you to customize the view of the grid on 
the Reports’ Status System window. Make the desired changes and click OK to 
confirm the settings. If you click Default, the report grid will be created using 
default parameters. Click Cancel to close this window without making changes. 

Reread 

 
The Reread button is available when the Status Window is open.  Click this button 
to refresh the data in the Status Window. 

View 
To view the selected report on your screen, select Status > View. This function is 
only available for reports with a completed status. 
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Rerun 
To rerun a report, select Status > Return. 

Select All 

 
To mark all displayed folders as selected, select Status > Select All, click the Select 
All button, or press CTRL+A. 

Details 

 
To display the detailed information on the selected report in the Detailed Report 
Info window, select Status > Properties or click the Properties button. 

 
Figure 5-8. Detailed Report Info Window 

Print 

 
To print a selected report to a specified printer, select Status > Print or click the 
Print button. The report is displayed on your screen for review. Select File > Print 
from the menu to print the report to a printer. This function is only available for 
reports with a completed status. 

Delete 

 To delete the selected report(s), select Status > Delete or click the Delete button. 
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Tools Menu 
The Tools menu in the Launcher utility enables you to schedule reports, delete selected 
files, run reports, view existing reports, access the printer, change your password, access the 
User to User module, go to UNIX, and view options. 

 
Figure 5-9. Report Launcher – Tools Menu 

Clean Sweep 

 To select files to delete stored on your local PC or on the server, select Tools > 
Clean Sweep, click the Clean Sweep button, or press SHIFT+F7. When you select 
this command, the Select Files To Delete window displays. 

 
Figure 5-10. Select Files To Delete Window 
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Run Report 

 
To load a report, select Tools > Run Report, click the Run Report button, or press 
CTRL+R. When you select this command a window will display all available 
report types. Select the type of report you wish to load and double-click it or 
highlight it and click OK. The Search window for this report type is displayed.  

 
Figure 5-11. Available Reports Window 

View Existing Report 

 To browse the remote directory to view existing reports, select Tools > View 
Existing Report, click the View Existing Reports button, or press SHIFT+F2. 
When you select this command, the Browse Remote Directory window displays. 

 
Figure 5-12. View Existing Reports window. 

Click Find to display a list of reports. To view the report, click the desired report 
and then click the View button or double-click the entry; the system opens the report 
in the Launcher. 
Highlight the report name and click Print to open the Select Printer window, which 
enables you to view, print, or save the report. 
Click Close to return to the View Existing Reports window without opening a 
report. 
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Utilities 

To  check printers, view the  printer status, change your password, access the 
User to User module, or go to UNIX, select Tools > Utilities and select a command 
from the submenu. 

Options 
To view the options, select Tools > Options. When you select this command, the 
Global Launcher’s Options window displays. 

 
Figure 5-13. Global Launcher Options Window 

Window Menu 
The Window menu in the Launcher utility enables you to arrange multiple records and 
document windows on your desktop. 

 
Figure 5-14. Report Launcher – Window Menu 

Cascade 
Cascade places the subwindows in a waterfall configuration, with each subsequent 
screen in front of and slightly lower than the previous. To cascade your open 
windows, select Windows > Cascade. 

Tile 
Tile places the open subwindows top-to-bottom, often changing the size of the 
subwindows so all open windows are visible on the desktop. To tile your open 
windows horizontally, select Windows > Tile. 

Window Indicator 
This section of the SoftPath Launcher utility Window menu lists the open windows. 
A checkmark appears next to the active window (i.e., the window in which you are 
currently working). 
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Help Menu 
The Help menu in the Launcher utility enables you to obtain information regarding the 
SoftPath Launcher utility. 

 
Figure 5-15. Report Launcher – Help Menu 

Help Topics 

 
Select Help > Help Topics or click the Help Topics button to launch the help utility 
and access online help. 

What’s This? 

 
Select Help > What’s This? or click the Help button to launch the context-sensitive 
help.  The cursor changes to an arrow with a question mark ( ). 

About Launcher… 

 
When you select Help > About Launcher or click the About button, a message 
displays the copyright information and creation date for the Launcher utility. 

 
Figure 5-16. About Launcher Window 
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Launcher: Report Status System Window Fields 
Click the Status Window button ( ) to display the Report Status System window. The status 
window contains a list of the reports that have been run, and enables you to view, print, and delete 
existing reports. This window can be docked at the bottom of the Launcher screen or floated. 

 
Figure 5-17. Report Status System Window 

Tag 
This column displays the report ID entered by the user that generated the report. If the user 
did not specify a tag, the system generates one automatically. 

Status 
This column displays the report status (running, empty, completed, or failed). 

Size 
This column displays the size of the report file in KB. 

Started 
This column displays the date and time the report was initiated. 

Finished 
This column displays the date and time the report finished printing. 

Media  
This column displays the type of print job: 

Save If the report has been saved in a chosen file. 

Print If the report has been printed. 

View If the report has been viewed. 
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Remote File Name  
The contents of this column depend on the Media column. If the report was saved to a file, 
the file name is displayed. If the report was printed, this column displays the name of the 
printer where the report was printed. If the report was viewed on screen, the name of the 
view file is displayed. 

Flagged 
This column indicates whether the report was flagged as printed. 

System 
This column displays the name of the system from where the report was run. 
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Report Fields and Buttons 
Many SoftPath reports use similar fields and functions for the entry of report criteria and selection of 
cases. This section describes some of these fields and buttons and how to make use of them to print 
SoftPath reports. 
Acc Group  

Enter the accession group to limit the search. Click the  button to select a valid accession 
group from the Accession Group Lookup window. 

Acc No 
Enter the accession number to limit the search. 

Alternative Criteria 
All available fields in the search window are included when you use an “and” statement. 
Specific fields in the search window can be selected by using an “or” statement. Select at 
least two options from the available search criteria. 

By Clinic  
Mark the By Clinic check box you want the banner pages collated using the clinic ID rather 
than the physician’s ID. This option is only available if you are printing using Batch Restart. 

Case Prefix  
You can enter up to three case prefix codes to include only cases with the selected prefix in 
the report. The information can be entered manually or you can click the  button to select a 
prefix from the Accession Sequences Lookup window. 

Case Type  
Select the case type you want to include in the report from the drop-down list. 

Case Type/Worksheet Print Status Menus 
Select the type of case and print status to include in the report from the drop-down lists. 
Only one selection is allowed for each field. 
Final worksheets for gynecological and medical cytology cases can be printed as soon as 
specimen processing is completed. 
Final worksheets for surgical pathology and autopsy cases are dependent on when the gross 
description was entered. If the gross description was performed at the same time as block 
and slide processing, then the gross description appears on the final worksheet (depending 
on how your template is set up). 
A case is not considered to be pending after the worksheet is printed, after the final report is 
printed, or after the case is signed out. 

Clinic  
Enter up to three clinic codes to include only cases associated with the specified clinic in the 
report. Click the  button to select a clinic code from the Clinic Code Lookup window. 
Leave these fields blank to include cases for all clinics in the report. 

Dx Category 
Enter up to three diagnosis categories to include in the report. Click the  button to select a 
diagnosis category from the Diagnosis Category Lookup window. 

Dx Groups 
Enter up to three diagnosis group codes to include in the report. Leave these fields blank to 
include all diagnosis groups in the report. Click the  button to select a diagnosis group 
from the Diagnosis Code Lookup window. 



SoftPath GUI v.4.2.1 User Manual Chapter 5.1 – Reports: Report Launcher 

PATH4.2-G-U (6th Ed, Rel. 01/31/07)  Page 5-17 

From and To  
Enter a specific date range to include only cases within the specified range in the report. The 
date can be entered manually or you can click the  button to display a calendar to make a 
selection. The date in the To field must be greater than or equal to the date in the From field. 
Leave these fields blank to include all dates. 

FS/Gr.Intr. 
Select one of the following options from the drop-down list: With FS Blocks, Gross Intr, 
All, or FS or Gross Intr. 

IOC Done By 
Enter a personnel ID code to include only cases with IOC performed by that person in the 
report. Click the  button to select a personnel code from the Personnel Lookup window. 

Normal 
Select whether to include normal, abnormal, or all cases in the report. 

Pathologist  
You can enter up to three pathologist ID codes to include only cases associated with the 
specified pathologists in the report. Click the  button to select a pathologist ID code from 
the Pathologist ID Lookup window. Leave these fields blank to include cases for all 
pathologists in the report. 

Patient Type  
Select up to three patient types to include in the report from the drop-down lists. 

Print   
Select the print status of the reports you want to print from the drop-down list. 

Priority 
Select a case priority from the drop-down list to include only cases with the specified 
priority in the report. 

Procedures 
Select a procedure from the drop-down list to include only cases associated with the 
specified procedure in the report. 

Req Doctor  
You can enter up to three requesting doctor codes to include only cases associated with the 
specified doctor in the report. Click the  button to select a doctor code from the Doctor 
Lookup window. Leave these fields blank to include cases for all requesting doctors. 

Rules 
Select a QA rule from the drop-down list to include only cases that meet the specified rule in 
the report. 

Scenario 
Select the scenario for the report from the drop-down list. Scenarios are defined in the Case 
Comparison/Setup option. 

Screened by 
Enter the screener ID to include only cases screened by the specified screener. Click the  
button to select a screener from the Personnel Lookup window. 

Summary Report/Detailed Report 
Select whether you want to print a summary or detailed version of the current report using 
the specified criteria. 

Sort Rules 
Select a case property you want to use to sort the report from the drop-down list. 
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Source and Only Source  
Enter up to three source ID codes to include only cases with the specified sources in the 
report. Click the  button to select a source ID code from the Source Lookup window. 
Leave these fields blank to include all sources in the report. 

Status  
Select the type of print job you want to initiate from the drop-down list. Options include: 

• All for Case - All copies for the case will be printed, including those that 
have been printed and those that are pending. 

• One per Case - One copy will be printed for the selected cases. 
• All Pending - All copies that have not been printed will be selected. 
• Reprint Printed - All copies that have been printed will be selected. 

Type  
Select the type of report you want to print from the drop-down list. 
NOTE: If you select Revised, the system only searches for cases that have not been 

signed out. When a case is signed out, the revised report becomes the final 
report and can be retrieved by selecting the Final report type from the drop-
down list. 
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Printing Reports 
To print a report, enter all applicable report criteria in the available. Next, select one of the following 
option buttons: 

View This option displays the report on your screen when you click Run. 

Save After you select this option, enter a file name in the adjacent field. Click Run to 
generate the report and save the output in the specified electronic file. 

Print To After you select this option, choose a printer from the drop-down list. Click Run to 
generate the report and send it to the specified printer. 
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Result Reports 

The Result Reports option allows you to print reports, worksheets and letters. 
To access the Result Report option, select Reports > Result Reports from the main menu. The 
Printing window (Figure 5-18) is displayed.  

 
Figure 5-18. Printing Window - Result Reports Tab 
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Result Report Tab  
The Result Reports tab is primarily used for batch printing. After you complete this tab, the system 
marks the case for the initial printing of the report. Additional copies can be reprinted if necessary. 
You can search for pending cases by ordered date or sign-out date. Specify a range of dates and enter 
search criteria to select cases for batch printing of final reports, autopsy (FAD and PAD) reports, 
preliminary reports, revised reports and supplemental reports.  
NOTE: If desired, the Req Doctor and Clinic searches can be expanded to include up to 25 codes 

each. To display this expansion, click on the Browse button for each field. This can be 
enabled in Options. If enabled, the Result Report search screen is displayed similar to 
Figure 5-19. See Chapter 6 – Setup: Options – Document Printing tab – Patient 
Reports subtab for more information. 

 
Figure 5-19. Printing Window – Result Reports Tab with Expanded Doctor and Clinic 
Search Enabled 

Click Find. All cases that fall within the date range and match the search criteria are displayed for 
review. 
NOTE: A report for a single case can also be printed from the Result Entry options, Query 

options, or the Sign Out option. 
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Worksheets Tab 
The Worksheets tab allows you to specify a range of dates and enter search criteria to select cases 
for batch printing of worksheets. These worksheets can be used to record the final diagnosis of the 
case, quality assurance information, billing codes, diagnosis coding, and patient history. 
The worksheets contain all the information available at the time they are printed, including all 
previous cases and requested laboratory work (depending on how your template is set up). After the 
worksheet is printed for the first time, you must use the Reprint option to print additional copies 
with the same date and time as the original. 

 
Figure 5-20. Printing Window - Worksheets Tab 

To quicken processing, the report criteria fields default to the dates and selection necessary to list all 
cases that qualify for Final Results entry but have not had a worksheet printed. You can further limit 
the cases included on the worksheet by specifying additional criteria. After entering any report 
criteria, click the Find button to display a list of cases that match the specified criteria. 
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Letters Tab  
The Letters tab allows you to print letters previously requested and associated with specific cases in 
a batch format. The number of letters is limited to the number you define during setup. A different 
format will be used for each specific situation encountered. Variables such as patient name, MRN, 
admitting physician, pathologist, etc., are placed in the letter automatically by the system (depending 
on how your template is set up). 

 
Figure 5-21. Printing Window - Letters Tab 

In the Letter Type field, enter the type of letter you want to print. Click the  button to display the 
Multiple Choice window, which displays all available letter types. Select one or more letter types by 
selecting the appropriate checkboxes. You can select up to six letter types. 
The letters are prepared in MS Word using templates created for each type of letter defined during 
setup in the Define Letters option. The patient information is extracted from the system and inserted 
according to the template. 
NOTE:  Once a letter has been printed, it cannot be deleted from the case. 

 
 

 



SoftPath GUI v.4.2.1 User Manual Chapter 5.3 – Reports: Billing Report 

PATH4.2-G-U (6th Ed, Rel. 01/31/07)  Page 5-25 

Billing Reports 

Billing reports are used to produce a report and/or file for billing purposes. A billing report can also 
use pre-defined parameters and run automatically in the Scheduler option. The report lists charges 
for each case and are represented by final billing codes and not internal billing codes. The format of 
the report or file can be transferred to the SoftLab system, SoftA/R® system, or the HIS.  

 
Figure 5-22. Reports Menu – Billing Reports Submenu 

The Billing Reports menu contains the following sub-options: 
• Billing Report 
• Billing Worksheets 
• Billing Statistics Reports 

 By Requesting Physician 
 By Pathologist 
 By Source 
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Billing Report 

The Billing Report option allows you to run or print a billing report for all charges that qualify for 
billing since the previous billing. Any examination that has been processed or performed and has an 
approved final report is eligible for billing. 
To access the Billing Report option, select Reports > Billing Reports  > Billing Report from the 
main menu. The Billing Report window (Figure 5-23) is displayed.  

 
Figure 5-23. Billing Report Window 

The main criterion for the Billing report is the processing date range. This date range is used 
differently when the billing is completed daily as opposed to when the billing is completed after 
cases are signed out. You must specify at least one report criterion (date or item selection) in order to 
create a report. 
Transmission Rules 

The field allows the user to define if the system checks the status of “Skip in AR Post” flag 
in the Clinics Setup file when cases are collated for the billing report (see Chapter 6 Setup: 
Setup Files – Clinics File). Select one of the following options: 

• No Checking of “Skip in AR Post”: The flag is not read and all qualifying cases, based on 
search criteria, are qualified. This is the default selection. 

• Only Clinics flagged to “Skip in AR Post”: Only cases associated to Clinics with this flag 
set will qualify to the billing report run. 

• Only Clinics Not flagged to “Skip in AR Post”: Only cases associated to Clinics without 
this flag set will qualify to the billing report run. 
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Patient Discharge Status 
Select one of the following Patient Discharge statuses for qualification for the report:  

• Both Active and Discharged Patients: selects all types of patient, both active and 
discharged. 

• Only Active Patients: selects active patients. 
• Only Discharged Patients: selects patients flagged as discharged. 

NOTE:  When the discharge date is after the current date, the patient will qualify as non-discharged. 
Enter any report criteria and click Run to generate the report. The Billing report contains the case 
number, patient demographics, stay demographics, items billed (including the item description and 
code), and the number of times an item was billed. 
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Billing Worksheets 

The Billing Worksheet option allows you to print a hard copy of the billing charges captured for 
manual entry/edit of billing codes. The format of the billing worksheet is user defined in the 
document setup file. 
To access the Billing Worksheets option, select Reports > Billing Reports > Billing Worksheets 
from the main menu. The Billing Worksheets window (Figure 5-23) is displayed.  

 
Figure 5-24. Billing Worksheets Window 

The main criterion for this report is the order date range or sign out date range. 
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Billing Statistics Reports 

 By Requesting Physician 
The Billing Statistics by Requesting Physician Report contains the case number, patient 
demographics, stay demographics, items billed (including the item description and code), and the 
number of times an item was billed. 
To access the Billing Statistics by Requesting Physician option, select Reports > Billing Reports  
> Billing Statistics Reports > By Requesting Physician from the main menu. The Billing Statistics 
by Requesting Physician Report window (Figure 5-25) is displayed.  

 
Figure 5-25. Billing Statistics by Requesting Physician Report Window 

The main criterion for this report is the processing date range. This date range is used differently 
when the billing is completed daily as opposed to when the billing is completed after cases are 
signed out. You must specify at least one report criterion (date or item selection) to create a report. 
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By Pathologist 
The Billing Statistics by Pathologist Report contains the case number, patient demographics, stay 
demographics, items billed (including the item description and code), and the number of times an 
item was billed. 
To access the Billing Statistics by Pathologist option, select Reports > Billing Reports  > Billing 
Statistics Report > By Pathologist from the main menu. The Billing Statistics by Pathologist 
Report window (Figure 5-26) is displayed.  

 
Figure 5-26. Billing Statistics Report by Pathologist Report Window 

The main criterion for this report is the processing date range. This date range is used differently 
when the billing is completed daily as opposed to when the billing is completed after cases are 
signed out. You must specify at least one report criterion (date or item selection) in order to create a 
report. 
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By Source 
The Billing Statistics by Source Report contains the case number, patient demographics, stay 
demographics, items billed (including the item description and code), and the number of times an 
item was billed. 
To access the Billing Statistics by Source option, select Reports > Billing Reports  > Billing 
Statistics Report > By Source from the main menu. The Billing Statistics by Source Report 
window (Figure 5-27) is displayed.  

 
Figure 5-27. Billing Statistics by Source Report Window 

The main criterion for this report is the processing date range. This date range is used differently 
when the billing is completed daily as opposed to when the billing is completed after cases are 
signed out. You must specify at least one report criterion (date or item selection) in order to create a 
report. 
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Cancer Agency Report 

The Cancer Agency Report allows you to create a file that contains all cases flagged as qualifying 
for Cancer Agency Reporting (For more information on flagging files, depending on their status in 
your workflow, refer to Chapter 3.3 – Results: Quality Assurance and to Chapter 3.4 – Results: 
Sign Out Entry). This file is available for uploading to the appropriate governmental agency through 
the Internet. If desired, a hard copy of all the contents of this file may be generated. 
NOTE: Cancer Agency reporting can only be used if it has been made available in Options. See 

Chapter 6.4 – Setup: Options for more information. 
To access the Cancer Agency Report option, select Reports > Cancer Agency Report from the main 
menu. The Cancer Agency Report window (Figure 5-28) is displayed.  

 
Figure 5-28. Cancer Agency Report Window 

Cancer Agency reports can only be created manually through the search window. Once the search 
window is completed, the Data List tab (Figure 5-29) is displayed. This window allows you to view a 
list of the cases qualifying for this report in addition to allowing you to enter information about 
where on your system you would like the report file saved and whether you would like to view or 
print the report.   
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Figure 5-29. Cancer Agency Report Window – Data List Tab 

These reports, once created, can also be sent electronically through the Internet to a Cancer Agency. 
When the report is run, the results are an ASCII-based report showing all cases flagged to be 
transmitted. After this file is created, the system will prompt you to send the report to the appropriate 
agency via that agency’s website. If, for some reason, the report cannot be sent, it will be destroyed 
(but the report can be run again at a later time). If the report is sent, the temporary file that contains 
the qualifying reports is moved to the directory specified in the hosparam 
rh_CANCER_REP_PATH. Those cases are then flagged as successfully sent to the Cancer Agency 
and will not appear again when future Cancer Agency reports are run.   
NOTE: Your lab’s CLIA number may be required to send this report to the appropriate agency. 

To define this number, please complete the field found in Chapter 6.4 – Setup: Options 
– System Settings. 
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Case Logs 

Figure 5-30. Reports Menu – Case Logs Submenu 

The Case Logs menu contains the following report options: 
• Autopsy Case Report 
• Deleted Cases Log 
• Deleted Stays Log 
• Doctor Cytology Report 
• Parent Source Log 
• Resulted Cases Log 
• Revised Cases Log 
• Post Sign Out Modification Log 
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Autopsy Case Report 
The Autopsy Case Report lists all of the autopsy procedures within a specific date range. The report 
contains the autopsy case number, patient last name, age, sex, date of death, date of autopsy, clinic, 
pathologist ID, deiner ID, resident ID, gross description date and status, PAD date and status, PAD 
sign out date, clinicopathological correlation date and status, FAD date and status, and the FAD sign 
out date. 
To access the Autopsy Case Report option, select Reports > Case Logs > Autopsy Case Report 
from the main menu. The Search Criteria for Autopsy Case Report window (Figure 5-31) is 
displayed.  

 
Figure 5-31. Search Criteria for Autopsy Case Report Window 

The primary criterion for the Autopsy Case report is the ordered date range. You must specify at 
least one report criterion (date or item selection) in order to create a report. 

Deleted Cases Log 
The Deleted Cases Log provides a record of all cases that were deleted in the system with accession 
numbers that are not being re-used. The reason the case was deleted, if entered, is also provided. 
To access the Deleted Cases Log option, select Reports > Case Logs > Deleted Cases Log from the 
main menu. The Deleted Cases Log window (Figure 5-32) is displayed.  

 
Figure 5-32. Deleted Cases Log Window 
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Deleted Stays Log 
The Deleted Stays Log provides a listing of stays that have been deleted, as well as the user ID of 
the person who deleted the stay and the date and time that the deletion occurred. The report also 
provides the comment given during the deletion of the stay, if available. 
To access the Deleted Stays Log, select Reports > Case Logs > Deleted Stays Log from the main 
menu. The Deleted Stays Log window (Figure 5-33) is displayed. 

 
Figure 5-33. Deleted Stays Log Window 

Doctor Cytology Report 
The Doctor Cytology Report provides a listing of cases submitted for examination for each 
requesting physician by diagnosis category. This report includes the case number, patient name, date 
of service, date of birth, and age, sorted under each Diagnosis Category. 
To access the Doctor Cytology Report option, select Reports > Case Logs > Doctor Cytology 
Report from the main menu. The Doctor Cytology Report window (Figure 5-34) is displayed.  

 
Figure 5-34. Doctor Cytology Report Window 



Chapter 5.5 – Reports: Case Logs SoftPath GUI v.4.2.1 User Manual  

Page 5-38  PATH4.2-G-U (6th Ed, Rel. 01/31/07) 

Parent Source Log 
The Parent Source Log prints a lists all cases with a specific “parent” source and all “children” of 
the specified parent source. The report only looks down the source tree, and not up. The report is 
sorted by the parent source code. The information listed for each case includes the accession number, 
received date, reported date, the pathologist who dictated the final diagnosis, the patient type 
(inpatient, outpatient, etc.), and the total number of cases for each source. 
To access the Parent Source Log option, select Reports > Case Logs  > Parent Source Log from 
the main menu. The Parent Source Log window (Figure 5-35) is displayed.  

 
Figure 5-35. Parent Source Log Window 
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Resulted Cases Log 
The Resulted Cases Log lists all of the cases that were signed out in a specific date range. The 
report lists the case number, patient name, sign out date and time, pathologist ID who signed final 
report, screener ID, ordered date and time, and technologist ID who entered the order into the 
system. 
To access the Resulted Cases Log option, select Reports > Case Logs  > Resulted Cases Log from 
the main menu. The Resulted Cases Log window (Figure 5-36) is displayed. 

 
Figure 5-36. Resulted Cases Log Window 
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Revised Cases Log 
The Revised Cases Log prints a report that lists all cases with a revised report created for a specific 
date range and/or case type. The reason for the revision is included on the report if one was entered. 
The report also provides the case accession number, specimen received date, report date(s) (original 
and revised), and the pathologist ID who dictated the report. 
To access the Revised Cases Log option, select Reports > Case Logs  > Revised Cases Log from the 
main menu. The Revised Cases Log window (Figure 5-37) is displayed. 

 
Figure 5-37. Revised Cases Log Window 

o  
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Post Sign Out Modification Log 
The Post Sign Out Modification Log lists all cases that were edited during the hold release time 
after sign out. 
To access the Post Sign Out Modification Log option, select Reports > Case Logs  > Post Sign Out 
Modification Log from the main menu. The Post Sign Out Modification Log window (Figure 5-37) 
is displayed.  

 
Figure 5-38. Post Sign Out Modification Log Window 
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Patient Management Reports 

 
Figure 5-39. Reports Menu – Patient Management Report Submenu 

The Patient Management Report menu contains the following report options: 
• Collated Patient History Report 
• High Risk Patient Report 
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Collated Patient History Report 
The Collated Patient History Report allows you to search for, print, view, or save the collated 
history report for one or more specified patients. 
To access the Collated Patient History Report option, select Reports > Patient Management 
Reports  > Collated Patient History Report from the main menu. The Search Criteria window 
(Figure 5-40) is displayed. 

 
Figure 5-40. Search Criteria Window (Collated Patient History Report) 

Search for patients/cases to include in the report using the fields provided. You can search by MRN 
or patient name by clicking the corresponding option button, which activates the search criteria 
fields. Click Find to display a list of patients that match the specified criteria. The search results will 
display in a table at the bottom of the window. 
Select the patients or cases you want to include by highlighting the appropriate row and clicking the 
Mark Sel button. Click Mark All to select all displayed cases/patients for the report. 
Next, select the type of report you want to create: 
• Collated - Produces a report containing case demographics and diagnoses for each case 

associated with the specified patient. 
• History - Produces a list of case numbers for the specified patient. 
Click the View button to preview the report on your screen or click Print to send the report to a 
printer. 
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High Risk Patient Report 
The High Risk Patient Report provides a list of cases with high-risk patients. This report contains 
the patient risk factors, case number, diagnosis code, patient name, requesting doctor ID, technician 
ID, pathologist ID, resident ID, diagnosis category, source code, and sign out date. 
To access the High Risk Patient Report option, select Reports > Patient Management Report > 
High Risk Patient Report from the main men. The Criteria for High Risk Patient Report window 
(Figure 5-41) is displayed. 

 
Figure 5-41. The Criteria for High Risk Patient Report Window 
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Consultation Logs 

 
Figure 5-42. Reports Menu – Consultation Logs Submenu 

The Consultation Logs menu contains the following report options: 
• Incoming Consultation Log 
• Outgoing Consultation Log 
• Temporary Data Log 
• Consultation Discrepancy Log 
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Incoming Consultation Log 
The Incoming Consultation Log provides a list of incoming consultations for a specified date 
range. 
To access the Incoming Consultation Log option, select Reports > Consultation Logs  > Incoming 
Consultation Log from the main menu. The Incoming Consultation Log window (Figure 5-43) is 
displayed.  

 
Figure 5-43. Incoming Consultation Log Window 

Select whether you want to run the report by the ordered date or the returned date by selecting either 
Ordered or Returned from the data range drop-down list. Enter the date range and select the 
consultation type you want to include in the report from the Consultation Type drop-down list.  
The Consultation Type drop-down list contains the following selections: 
• Case Requested Letter Not Sent - This option collates all ordered incoming consultations with 

no received materials and no specified Request Letter date. 
• Letter Sent Material Not Received - This option collates all ordered incoming consultations 

with materials that have not been received and printed request letters. 
• Material Received Case in Process - This option collates all ordered incoming consultations 

with received materials that have not been returned. 
• Cases with Slides to be Returned - This option collates all ordered incoming consultations with 

slides in the Material Received window and materials that have not been returned. In addition, 
the consultation discrepancy information must be completed 

• Completed Incoming Consultation - This option collates all ordered incoming consultations 
with received and returned materials, a Consultation Report date, Request Letter date, a printed 
Request Letter, and complete Consultation Discrepancy Entry.  

Enter any additional report criteria and then click Run. The report lists the case number, referring 
physician or pathologist, the request date, and the total number of cases. 
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Outgoing Consultation Log 
The Outgoing Consultation Log lists outgoing consultations that have or have not been returned. 
This report lists the patient name, case number, materials (blocks and slides sent), date sent, 
pathologist, and destination (consultant). 
To access the Incoming Consultation Log, select Reports > Consultation Logs > Outgoing 
Consultation Log from the main menu. The Outgoing Consultation Log window (Figure 5-44) is 
displayed.  

 
Figure 5-44. Outgoing Consultation Log Window 
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Temporary Data Log 
The Temporary Data Log provides a list of all incoming consultation requests (without materials 
received) within the specified date range that are stored as temporary. This report lists the MRN, 
patient name, consultant, person that requested the consultation, and date requested. 
To access the Temporary Data Log option, select Reports > Consultation Logs  > Temporary Data 
Log from the main menu. The Temporary Data Log window (Figure 5-45) is displayed.  

 
Figure 5-45. Temporary Data Log Window 
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Consultation Discrepancy Log 
The Consultation Discrepancy Log provides a list of consultation cases that have had a 
consultation discrepancy entry completed. This report lists the case number, date requested, source 
(ID and name), and the discrepancy category. 
To access the Consultation Discrepancy Log option, select Reports > Consultation Logs  > 
Consultation Discrepancy Log from the main menu. The Consultation Discrepancy Log window 
(Figure 5-46) is displayed. 

 
Figure 5-46. Consultation Discrepancy Log Window 
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Daily Reports 

 
Figure 5-47. Reports Menu – Daily Reports Submenu  

The Daily Reports menu contains the following report options: 
• Case Status Log 
• Daily Accession Log 
• Daily Case Log 
• Daily Result Log 
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Case Status Log 
The Case Status Log allows you to view the processing status of any case. This is useful when 
trying to keep track of a specific case specimen. This report prints the case accession number, date 
ordered, priority, and current processing status. 
To access the Case Status Log option, select Reports > Daily Reports  > Case Status Log from the 
main menu. The Case Status Log window (Figure 5-48) is displayed.  

 
Figure 5-48. Case Status Log Window 

This report uses the following abbreviations: 

SP Specimen Processing FD Final Diagnosis 

BE Blocks Embedding FR Final Report Printed 

BP Blocks Processing SO Sign Out 

SS Slides Stained SOR Sign Out Report Printed 

SL Slides Labeled QA Quality Assurance performed 

GE Gross Description Entry FS Frozen Section 

WS Worksheet Printed GIC Gross Intraoperative Consultation 
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Daily Accession Log 
The Daily Accession Log lists all cases registered in the Specimen Registration option. 
To access the Daily Accession Log option, select Reports > Daily Reports > Daily Accession Log 
from the main menu. The Daily Accession Log window (Figure 5-49) is displayed.  

 
Figure 5-49. Daily Accession Log Window 

Each format of the Daily Accession Log provides the following information: 
NOTE: The selection of these formats is done with a parameter setting. Please contact your 

Client Service Representative to change the format parameter. 
Format 1 

A Case number, specimen ID, ordered date, patient last and first name, MRN, client 
ID, and source. 

E Case number, priority, specimen ID, body site, and source code and name.  
G Case number, specimen ID, ordered date, patient last and first name, requesting 

doctor name, Resident ID, Pathologist ID, and source name. 
H Case number, priority, specimen ID, and source ID and name. 
K Case number, patient last and first name, billing number, source ID, ordered doctor 

ID, patient type, and priority. 
M, N Case number, specimen ID, ordered date, patient last and first name, MRN, source 

ID and name. 
S Case number, specimen ID, ordered date, patient last and first name, Pathologist 

ID, and Source ID. 
Format 2 

A, E, G, 
H, K, M 

Case number, patient last and first name, MRN, and source name. 

N Case number, specimen number, ordered date, patient last and first name, 
MRN, and source code. 
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Daily Case Log 
The Daily Case Log provides a list of cases ordered during a specified date range. 
To access the Daily Case Log option, select Reports > Daily Reports > Daily Case Log from the 
main menu. The Daily Case Log window (Figure 5-50) is displayed.  

 
Figure 5-50. Daily Case Log Window 

Each format of the Daily Case Log provides the following information: 

Format 1 Case number, priority, specimen ID, source ID, source name, technologist ID, and order 
date/time. 

Format 2 Case number, patient last and first name, MRN, clinic ID, source name, technologist 
ID, and order date/time. 
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Daily Result Log 
The Daily Result Log should be used on a daily basis to provide a list of cases for a given 
technologist or pathologist during a specified date range, including the diagnosis codes entered by 
that technologist or pathologist. This report prints the case number, last name, first name, diagnosis 
codes, technologist ID, pathologist ID, requesting doctor, and source code. 
To access the Daily Result Log option, select Reports > Daily Reports > Daily Result Log from the 
main menu. The Daily Result Log window (Figure 5-50) is displayed.  

 
Figure 5-51. Daily Result Log Window 
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Processing Logs 

 
Figure 5-52. Reports Menu – Processing Logs Submenu  

The Processing Logs menu contains the following report options: 
• Cytology Slides Log 
• Daily Blocks Log 
• Histology Slides Log 
• Processed Blocks Log 
• Processed Specimen Log 
• Special Stain Log 
• Specimen Status Log 
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Cytology Slides Log 
The Cytology Slides Log lists all of the cases with cytology slides registered within a given date 
range. This report prints the case number, priority, specimen ID, block/slide number, number of 
slides the standard stain was applied to, special stains, number of restains, done by person, 
technologist ID, and the date/time the order was placed. 
To access the Cytology Slides Log option, select Reports > Processing Logs > Cytology Slides Log 
from the main menu. The Cytology Slides Log window (Figure 5-53) is displayed.  

 
Figure 5-53. Cytology Slides Log Window 
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Daily Blocks Log 
The Daily Blocks Log lists the cases with blocks processed within a given date range. This report 
prints the case number, priority, specimen number, source, blocks processed, and slides cut per 
block. 
To access the Daily Blocks Log option, select Reports > Processing Logs > Daily Blocks Log from 
the main menu. The Daily Blocks Log window (Figure 5-54) is displayed.  

 
Figure 5-54. Daily Blocks Log Window 
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Deleted Specimen Log 
The Deleted Specimen Log lists the cases with specimens that have been deleted. This report prints 
the accession number, patient name, date/time the specimen was deleted, the ID of the user that 
deleted the specimen, and the reason the specimen was deleted. 
To access the Deleted Specimen Log option, select Reports > Processing Reports > Deleted 
Specimen Log from the main menu. The Deleted Specimen Log window (Figure 5-55) is displayed.  

 
Figure 5-55. Deleted Specimens Log Window 
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Embedded Blocks Log 
The Embedded Blocks Log lists all of the blocks that were embedded within a specified date range. 
This report contains the case number, priority, specimen ID, source codes, and a list of embedded 
blocks. 
To access the Embedded Blocks Log option, select Reports > Processing Logs > Embedded Blocks 
Log from the main menu. The Embedded Blocks Log window (Figure 5-56) is displayed. 

 
Figure 5-56. Embedded Blocks Log Window 
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Histology Slides Log 
The Histology Slides Log lists all of the cases with histology slides registered within a given date 
range. This report prints the case number, priority, specimen ID, number of slides stained with the 
standard stain, special stains, number of restains, number of slides per case, done by ID, ordering 
technologist ID, and date/time ordered. 
To access the Histology Slides Log option, select Reports > Processing Logs > Histology Slides 
Log from the main menu. The Histology Slides Log window (Figure 5-57) is displayed.  

 
Figure 5-57. Histology Slides Log Window 
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Processed Blocks Log 
The Processed Blocks Log lists all of the processed blocks (cut sections/levels) in a specified date 
range. This report prints the case number, priority, specimen ID, source code, a list of processed 
blocks, total number of cases, and total number of processed blocks. 
To access the Processed Blocks Log option, select Reports > Processing Logs  > Processed Blocks 
Logs from the main menu. The Processed Blocks Log window (Figure 5-58) is displayed.  

 
Figure 5-58. Processed Blocks Log Window 
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Processed Specimen Log 
The Processed Specimens Log lists all of the specimens processed in the Fast Processing, One 
Case Processing, Specimen Processing Worklist, or Specimen Registration options. This report 
prints the case number, priority, specimen ID, source code, block designation/number of pieces in 
the block, number of additional and regross blocks, number of frozen section blocks, number of cell 
blocks, number of smear slides, number of cytocentrifuge slides, number of membrane filter slides, 
number of monolayers, and number of touch preps. 
To access the Processed Specimen Log option, select Reports > Processing Logs > Processed 
Specimen Log from the main menu. The Processed Specimen Log window (Figure 5-59) is 
displayed.  

 
Figure 5-59. Processed Specimen Log Window 
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Special Stain Log 
The Special Stain Log lists all of the cases with special stains/tests processed within a specific date 
range. This report prints the case accession number, priority, specimen ID, blocks and levels with the 
corresponding special stains, and the number of restains. 
NOTE:   The standard stains are not displayed. 
To access the Special Stain Log option, select Reports > Processing Logs > Special Stain Log from 
the main menu. The Special Stain Log window (Figure 5-60) is displayed. 

 
Figure 5-60. Special Stain Log Window 

The Print Stains drop-down list contains the following selections: 
• All: displays both completed and pending stains 
• Completed: displays completed stains 
• Pending: displays stains not flagged as complete 
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Specimen Status Log 
The Specimen Status Log lists all specimens processed within a specified date range. This report 
prints the case number, priority, number of specimens, number of blocks, number of additional 
blocks, number of FS blocks, number of FS specimens, number of smears, number of cell blocks, 
number of cytocentrifuge slides, number of membrane filters, number of monolayer slides, number 
of touch prep slides, ordering tech ID, ordering date and time. 
To access the Specimen Status Log option, select Reports > Processing Logs > Specimen Status 
Log from the main menu. The Specimen Status Log window (Figure 5-61) is displayed.  

 
Figure 5-61. Specimen Status Log Window 
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QA Reports 

 
Figure 5-62. Reports Menu – QA Reports Submenu  

The QA Reports menu contains the following report options: 

• Cytology-Histology Comparison Report • Specimen Adequacy Report 

• Autopsy Correlation Report • IOC Correlation Report 

• Case Review Reports • Turnaround Time Report 

• Tissue Committee Report • QA Statistical Report 

• IOC Correlation Statistic Report • QA Correlation Report 

• Outside Consultation Correlation • QA Summary Report 

• Screening Evidence Report • Follow Up Correlation Report 

• Screening Evidence Trend • Bethesda Final Diagnosis Comparison 
Report 

• Slides Rescreen Report • Bethesda Adequacy Comparison Report 
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Cytology-Histology Comparison Report 
The Cytology-Histology Comparison Report provides a report that lists cytology cases (both GYN 
and MED) that have or have not had a subsequent surgical case containing a source that is flagged as 
qualifying for biopsy in the source setup file. 
This report prints the case number, MRN, requesting doctor, source, diagnosis code, diagnosis group 
and name, as well as the Pathologist’s ID.  
To access the Cytology-Histology Comparison Report option, select Reports > QA Reports > 
Cytology-Histology Comparison Report from the main menu. The Cytology-Histology Comparison 
Report window (Figure 5-63) is displayed.  

 
Figure 5-63. Cytology-Histology Comparison Report Window 
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Autopsy Correlation Report 
The Autopsy Correlation Report is printed for completed Autopsy Correlations and includes the 
patient name, case number, death date/time, final diagnosis, done by ID, final diagnosis, procedure 
date/time, clinicopathologic correlation done by ID, clinicopathologic correlation procedure 
date/time, autopsy correlation done by ID, autopsy correlation procedure comment, autopsy 
correlation QA code. 
To access the Autopsy Correlation Report option, select Reports > QA Reports > Autopsy 
Correlation Report from the main menu. The Search Criteria for Autopsy Correlation Report 
window (Figure 5-64) is displayed.  

 
Figure 5-64. Autopsy Correlation Report Search Window 

Enter search criteria in the provided fields and click Find; cases matching the specified criteria are 
displayed. Select the cases you want to include in the report by highlighting the row and clicking 
Mark Sel. Click Mark All to include all displayed cases in the report. After selecting cases, click 
Print to print the report to a specified printer or View to preview the report on your screen.  
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Case Review Reports 
The Case Review Report option allows you to review rescreening diagnosis information, 
rescreening diagnosis descriptions, specimen adequacy, diagnosis codes, and the results of the 
procedures performed. It provides seven different QA management reports. All pending QA must be 
performed on the case before it will qualify for these reports. 
To access the Case Review Reports option, select Reports > QA Reports > Case Review Reports 
from the main menu. The Case Review Reports window (Figure 5-65) is displayed. 

 
Figure 5-65. Case Review Reports window. 

Review Tab - QA Case Review Report 
The Review tab allows you to print the QA Case Review Report, which is a cumulative 
diagnostic review that provides a list of cases with QA that has been performed. All pending 
QA must be completed before a case qualifies for this report. 
NOTE: When the results QA code reflects that no change was made to the final 

diagnosis at the time of rescreening, the final diagnosis defaults to the original 
final diagnosis and prints this way on the report. If the diagnosis has been 
changed, then both are printed on the report. 

Internal Tab - Internal Review Correlation Report 
The Internal tab allows you to print the Internal Review Correlation Report,  a statistical 
management report for the internal correlation/review of cases with a proreview QA 
procedure that has been performed. The report lists the cases, includes any changes in the 
final diagnosis, and provides a summary of the total number of cases and percentages of 
cases that agree and disagree. Case comparison setup for proreview must be defined to use 
this report. In addition, all pending QA must be completed for the case to qualify for this 
report. 
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Daily Tab - Daily Cytotechnologist Correlation Report 
The Daily tab allows you to print the Daily Cytotechnologist Correlation Report, a 
cumulative diagnostic review report that provides a list of cases based with QA that has been 
performed. All pending QA must be completed for a case to qualify for these reports. 

Monthly Tab - Monthly Cytotechnologist Correlation Report 
The Monthly tab allows you to print the Monthly Cytotechnologist Correlation Report. 
This report provides a list of current and previous cases with a retro-review QA procedure 
that has been performed. All pending QA must be completed for both cases to qualify for 
these reports. 

Comparison Tab - Comparison Report 
The Comparison tab allows you to print the Comparison Report,  a management report 
that is used to compare the current case to a previous case based on case type and diagnosis 
category. Case comparison setup for proreview and QA reports must be defined in order to 
use this report. 
When you select this tab, the Select Comparison Type window (Figure 5-66) is displayed. 
Select the comparison type by double-clicking the corresponding row. 

 
Figure 5-66. Select Comparison Type window. 

Depending on the comparison type chosen, the appropriate report criteria window displays. 
Enter any search criteria and click Run to generate the report. 

Non Gyn Tab - Non-Gynecological Cytotechnologist Correlation Report 
The Non-Gyn tab allows you to print the Non-Gynecological Cytotechnologist 
Correlation Report, a management report of cases that are correlated together because of 
the related significance established in the Case Comparison Setup for the Retroreview and 
QA Report options. 
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Tissue Committee Report 
The Tissue Committee Report allows you to compare pre-operative and post-operative diagnoses. 
The report can be printed on demand based on the defined search criteria. 
To access the Tissue Committee Report option, select Reports > QA Reports > Tissue Committee 
Report from the main menu. The Tissue Committee Report window (Figure 5-67) is displayed.  

 
Figure 5-67. Tissue Committee Report Window 
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IOC Correlation Statistic Report 
The IOC Correlation Statistic Report contains statistical information regarding performed IOC 
correlations. Checkboxes in the search window allow you to narrow the report to cases with frozen 
section blocks or without frozen section blocks. The report prints information about number of 
performed IOC correlations, number of cases with discovered discrepancies between IOC and the 
Final Report. The report also contains the total cases with IOC correlation performed, total FS cases, 
total FS blocks, percentage of cases that agree, percentage of cases that disagree, patient name, case 
number, and discrepancy category. 
To access the IOC Correlation Statistic Report option, select Reports > QA Reports > IOC 
Correlation Statistic Report from the main menu. The IOC Correlation Statistic Report window 
(Figure 5-68) is displayed.  

 
Figure 5-68. IOC Correlation Statistic Report Window 
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Outside Consultation Correlation 
The Outside Consultation Correlation Report provides a listing of all of the cases with an 
outgoing consultation registered, the overall percentage of the agree/disagree choices, and a 
summary of discrepant cases during a given period of time. The report prints the total outgoing 
consultations, total number of cases that disagree, percentage of cases that agree, percentage of cases 
that disagree, patient name, case number, and discrepancy category. 
To access the Outside Consultation Correlation option, select Reports > QA Reports > Outside 
Consultation Correlation from the main menu. The Outside Consultation Correlation window 
(Figure 5-69) is displayed.  

 
Figure 5-69. Outside Consultation Correlation Window 
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Screening Evidence Report 
The Screening Evidence Report lists the number of slides examined by selected screeners during a 
specific period of time. This report provides evidence of having an adequate number of technologists 
on staff to handle the annual volume of cytology slides. Under the CLIA ’88 Regulations, no one 
person can screen more than 100 previously unscreened cytology slides per day. In addition, the 
maximum 100 slides cannot be examined in less than eight hours. The CLIA ’88 Regulations do not 
restrict the laboratory, only the screeners. 
This report prints the screener name, screener ID, screening limit, hours worked in lab, slides 
screened in lab, hours worked outside of lab, slides screened outside of lab, total hours worked, and 
the total slides screened. 
To access the Screen Evidence Report option, select Reports > QA Reports > Screening Evidence 
Report from the main menu. The Screening Evidence Report window (Figure 5-70) is displayed.  

 
Figure 5-70. Screening Evidence Report Window 

Summary Report 
Select the Summary option button to run the summary version of the Screening Evidence 
Report. This report can be generated for any time period. It displays all data for the time 
period within a single table and contains totals for the specified time period. 

Detailed Report 
Select the Detailed option button to run the detailed version of the Screening Evidence 
Report. This report can be generated for any time period greater than one day and displays 
the data in individual tables based on the screener ID and the specified time period.  



Chapter 5.10 – Reports: QA Reports SoftPath GUI v.4.2.1 User Manual 

Page 5-78  PATH4.2-G-U (6th Ed, Rel. 01/31/07) 

Screening Evidence Trend 
The Screening Evidence Trend Report is used to compare the volume of a screener’s work over a 
period of time. This information is especially useful when the volume of work to be performed 
exceeds the correct staffing ratio. This report can also be used as a quality assurance tool to 
determine which screeners exceed the expected number of slides screened during a specified time 
period. 
This report prints the screener name, screener ID, hours worked, screening limit, time frame of the 
report, total number of hours worked, and the total number of slides screened. 
To access the Screening Evidence Trend option, select Reports > QA Reports > Screening 
Evidence Trend from the main menu. The Screening Evidence Trend Report window (Figure 
5-71) is displayed.  

 
Figure 5-71. Screening Evidence Trend Report Window 
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Slides Rescreen Report 
The Slides Rescreen Report provides information about all cases where a rescreening QA 
procedure was performed. This report prints the case number, date received, body site, source name, 
primary screener ID with date and time of primary screening, rescreener ID with date and time of 
rescreening, QA category, diagnosis codes, and diagnosis groups. 
To access the Slides Rescreen Report option, select Reports > QA Reports > Slide Rescreen Report 
from the main menu. The Slide Rescreen Report window (Figure 5-72) is displayed. 

 
Figure 5-72. Slides Rescreen Report Window 
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Specimen Adequacy Report 
The Specimen Adequacy Report provides statistics for specimens with specimen adequacy 
problems. The purpose of specimen adequacy recording is to monitor the proper fixation and 
identification of specimens submitted to the pathology laboratory and to ensure that all safety 
requirements are met. Specimen processing problems and quality assurance codes can be used as 
criteria to generate this report.  
This report prints the processing problem, case number, patient name, procedure date, location, 
physician name, specimen adequacy problem code, and source code. 
To access the Specimen Adequacy Report option, select Reports > QA Reports > Specimen 
Adequacy Report from the main menu. The Specimen Adequacy Problem Report window (Figure 
5-73) is displayed. 

 
Figure 5-73. Specimen Adequacy Problem Report Window 
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IOC Correlation Report 
The IOC Correlation Report option allows you to prepare reports and logs with a list of cases with 
an IOC correlation procedure that has been performed. You can also prepare a worklist of cases that 
qualify for IOC correlation.  
To access the IOC Correlation Report option, select Reports > QA Reports > IOC Correlation 
Report from the main menu. The IOC Correlation Report window (Figure 5-74) is displayed.  

 
Figure 5-74. IOC Correlation Report Window 

Enter any search criteria for the report. Select the Report option button to print a report or select the 
Log option button to print a log. Click Run to display the List of Found Cases window. Mark the 
checkboxes corresponding to the cases you want to include in the log or report.  
If you mark the Worklist checkbox, the window includes only cases that require an IOC correlation 
QA procedure. If you leave this checkbox unmarked, the window includes only cases with the IOC 
correlation procedure performed. 
After you select the case you want to include in the report/log/worklist, click the OK button to 
generate report. 
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Turnaround Time Report 
The Turnaround Time (TAT) Report calculates and prints the workflow for almost any situation 
in the pathology department. Two categories can be evaluated for every workstation: Response 
Time and Processing Time. 
• Response time measures the time between case registration (receiving the specimens) and the 

time the final report is sent out. This calculation is especially important for patient quality 
assurance. The FS TAT calculation is also available from this report. 

• Processing time measures the time the case is processed at different workstations. This 
calculation is especially important to identify delays in processing where more resources may be 
needed. 

NOTE: Use the Holiday Schedule selection in Options setup to define holidays that should not 
be included when calculating TAT. 

To access the Turnaround Time Report option, select Reports > QA Reports > Turnaround Time 
Report from the main menu. The Turnaround Time Report window (Figure 5-75) is displayed.  

 
Figure 5-75. Turnaround Time Report Window 
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QA Statistical Reports  
The summary version of the QA Statistical Report prints a statistical analysis for the screener 
compared with the lab. The statistical data includes the total QA procedures, total abnormal QA 
procedures, and total normal QA procedures with the percentage that agreed and disagreed and the 
qualification statistics. The report displays this information for both the screener and the lab.  
The detailed version of the QA Statistical Report prints the statistical data contained in the 
summary version in addition to the ordered from/to date and time, QA procedure, QA done by ID, 
screener ID, pathologist, diagnosis group, diagnosis category, and source code for cases within a 
specified date range.  
To access the QA Statistical Reports option, select Reports > QA Reports > QA Statistical Reports 
from the main menu. The QA Statistical Report window (Figure 5-76) is displayed.  

 
Figure 5-76. QA Statistical Report Window 
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QA Correlation Report  
The detailed version of the QA Correlation Report prints the patient name, MRN, requesting 
doctor, pathologist, diagnosis category, source, ordered date/time, signed out date/time, diagnosis 
codes, collection method, QA code, and diagnosis text. All QA procedures (proreview, retroreview, 
follow up, and rescreen) performed within the specified range are displayed based on the scenario 
selected. The scenarios available are based on the currently active scenarios defined in the Case 
Comparison Setup option for QA. The procedure selected in this option affects the scenarios 
available for selection. The summary version of this report displays all of the data except for the 
diagnosis text.  
To access the QA Correlation Report option, select Reports > QA Reports > QA Correlation 
Report from the main menu. The QA Correlation Report window (Figure 5-77) is displayed.  

 
Figure 5-77. QA Correlation Report Window 
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QA Summary Report 
The QA Summary Report contains information concerning QA procedures such as rescreen, 
proreview, and retroreview.  
The QA Summary Report prints the case number, requesting doctor, ordered date/time, sign out 
date/time, pathologist, procedures, diagnosis, prior procedures performed outside the specified date 
range (marked with an asterisk *), done by ID for each procedure, date/time for each QA procedure, 
QA codes, procedure comments, diagnosis codes, diagnosis category, and completion status. 
The QA Summary Log displays a list of procedures that match the report criteria. Other information 
includes the case number, procedure date/time, who performed the procedure, procedure name, 
result, requesting doctor, pathologist, and completion status. 
NOTE: When performing a simple search using the Simple Search tab, all three QA procedures 

(retroreview, proreview and rescreen) are included in the search by default. 
To access the QA Summary Report option, select Reports > QA Reports > QA Summary Report 
from the main menu. The QA Summary Report window (Figure 5-78) is displayed.  

 
Figure 5-78. QA Summary Report Window 
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Follow Up Correlation Report 
The Follow Up Correlation Report option allows you to generate reports and logs for cases with 
follow up procedure that were performed (report/log) and cases that qualify for follow up procedures 
(for worklists). 
To access the Follow Up Correlation Report option. select Reports > QA Reports > Follow Up 
Correlation Report from the main menu. The Follow Up Correlation Report window (Figure 5-79) 
is displayed.  

 
Figure 5-79. Follow Up Correlation Report Window 

Enter any report criteria and indicate whether you want to prepare a log or a report. Click Run. A list 
of cases that match specified criteria displays in the List of Found Cases window. Select the cases 
you want to include in the report by highlighting the case row and clicking Mark Sel. Click OK 
after you selected all the cases you want to include in the report. 
NOTE: If you mark the Worklist checkbox, the system will display a list of previous cases that 

qualify for the Follow Up Procedure for selection. If you don’t select the Worklist 
checkbox flag, the system displays the list of cases for which the Follow Up procedure 
was done.  
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Bethesda Final Diagnosis Comparison Report 
The Bethesda Final Diagnosis Comparison Report provides statistics about screeners in regards to 
the Bethesda Final Diagnosis codes assigned to cases. It gives percentage figures for an individual 
screener’s usage of the codes and a comparison to the lab’s usage. 
To access the Bethesda Final Diagnosis Comparison Report option, select Reports > QA Reports 
> Bethesda Final Diagnosis Comparison Report from the main menu. The Bethesda Final 
Diagnosis Comparison Report window (Figure 5-80) is displayed.  

 
Figure 5-80. Bethesda Final Diagnosis Comparison Report Window 
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Bethesda Adequacy Comparison Report 
The Bethesda Adequacy Comparison Report provides statistics about screeners in regards to the 
Bethesda adequacy codes assigned to cases. It gives percentage figures for the individual screener’s 
usage as well as a comparison to the lab’s overall usage. 
To access the Bethesda Adequacy Comparison Report option, select Reports > QA Reports > 
Bethesda Adequacy Comparison Report from the main menu. The Bethesda Adequacy 
Comparison Report window (Figure 5-81) is displayed. 

 
Figure 5-81. Bethesda Adequacy Comparison Report Window 
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Report Logs 

 

Figure 5-82. Reports Menu –Report Logs Submenu 

The Report Logs menu contains the following report options: 
• Preliminary Report Log 
• Supplemental Report Log 
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Preliminary Report Log 
The Preliminary Report Log provides a record of all of the cases that have had a Preliminary 
Report created for a specific date range and/or case range. The Preliminary Report displays when 
you create a report. 
To access the Preliminary Report Log option. select Reports > Report Logs > Preliminary Report 
Log from the main menu. The Preliminary Report Log window (Figure 5-83) is displayed. 

 
Figure 5-83. Preliminary Report Log Window 
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Supplemental Report Log 
The Supplemental Report Log provides a record of all of the cases that have a supplemental report 
created for a specific date range and/or case type.  
To access the Supplemental Report Log option, select Reports > Report Logs > Supplemental 
Report Log from the main menu. The Supplemental Report Log window (Figure 5-84) is 
displayed.  

 
Figure 5-84. Supplemental Report Log Window 
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Worksheets 

 

Figure 5-85. Reports Menu –Worksheets Submenu 

The Worksheets menu contains the following report options: 
• QA Worksheets 

 Rescreen Worksheet 
 Proreview Worksheet 
 Retroreview Worksheet 

• Pending Stain Worksheet 
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QA Worksheets 

Rescreen Worksheet 
The Rescreen Worksheet option allows you to prepare worksheets for cases that qualify for the 
rescreen procedure. 
To access the Rescreen Worksheet option, select Reports > Worksheets > QA Worksheets > 
Rescreen Worksheet from the main menu. The Rescreen Worksheet window (Figure 5-86) is 
displayed.  

 
Figure 5-86. Rescreen Worksheet Window 
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Proreview Worksheet 
The Proreview Worksheet option allows you to prepare worksheets for cases that qualify for the 
proreview procedure. 
To access the Proreview Worksheet option, select Reports > Worksheets > QA Worksheets > 
Proreview Worksheet from the main menu. The Rescreen Worksheet window (Figure 5-87) is 
displayed.  

 
Figure 5-87. Proreview Worksheet Window 
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Retroreview Worksheet 
The Retroreview Worksheet option allows you to prepare worksheets for cases that qualify for the 
retroreview procedure. 
To access the Retroreview Worksheet option, select Reports > Worksheets > QA Worksheets > 
Retroreview Worksheet from the main menu. The Retroreview Worksheet window (Figure 5-88) is 
displayed.  

 
Figure 5-88. Retroreview Worksheet Window 
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Pending Stain Worksheet 
The Pending Stain Worksheet allows you to produce a report about pending stains in the lab based 
on factors, which include the ordered date and time, the pathologist, and the type of case. 
NOTE:  Stains not flagged as completed will be included on the worksheet even if the case is signed 

out. 
To access the Pending Stain Worksheet option, select Reports > Worksheets > Pending Stain 
Worksheet from the main menu. The Pending Stain Worksheet window (Figure 5-89) is displayed. 

 
Figure 5-89. Pending Stain Worksheet Window 
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ODBC Reports 

The ODBC Reports option allows the user to select and print a report from a list of reports 
previously defined using Microsoft Access and Structured Query Language (SQL).  
NOTE: To use SQL reports rather than ODBC, SQL reporting must be enabled during 

installation of SoftPath. 
To access the ODBC Reports option, select Report > ODBC Reports from the main menu, which 
opens Microsoft Access with the Main Switchboard window (Figure 5-90) displayed. Click the  
buttons to select the ODBC report you want to print and to navigate through the different categories 
of reports. 
NOTE:  If you have SoftReports capabilies, the menu will displays in SoftReports format. 

 
Figure 5-90. Main Switchboard Window 

The ODBC Main Switchboard windows contains the following report categories: 
• Autopsy Reports 
• Cytology Reports 
• GYN Cyto Reports 
• Med Cyto Reports 
• Surgical Reports 
• Miscellaneous Reports 
• Multisite Reports 
• Utilities 
• Custom Reports – If your site has custom reports generated by SCC, use this option to 

access the reports.  
After you locate and select the report you want to print, a report parameters window is displayed 
(Figure 5-91) allowing you to enter search criteria for the report.  
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Figure 5-91. Sample Report Parameters Window 

NOTE: All types of User Defined Flags can be captured in ODBC reports. 
Enter any report criteria and then click Print Report to print the report to a specified printer. Click 
View Report to preview the report on your screen. 
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Autopsy Reports 
A brief explanation of each Autopsy report will be listed in this section. To create a new ODBC 
report, use the Define ODBC Reports option located under Utility on the Main Menu. 

 
Figure 5-92. Autopsy Reports Window 

Autopsy Marked for Conference Log 
The Autopsy Marked for Conference Log lists all of the autopsy cases within a specific 
date range that were marked for a conference. The log can be printed for all conference dates 
or can only list cases for one conference date, when entered. The log contains the date of the 
sequence number on the log, patient name, MRN, ward, patient age and sex, date and time of 
death, date when the body was received, date when the history was sent to Medical Records 
(signed out), flag if the autopsy was performed, autopsy case accession number, date and 
time of autopsy, prosector code or name, date when the PAD was printed, and the date when 
the FAD was printed. 

Autopsy Log 
The Autopsy Log lists all autopsy procedures within a specific date range. The log contains 
the date of the sequence number on the log, patient name, MRN, ward, patient age and sex, 
date and time of death, date when body was received, date when the history was sent to 
Medical Records (signed out), flag if the autopsy was performed, autopsy case accession 
number, date and time of autopsy, prosector code or name, date when the PAD was printed, 
and the date when the FAD was printed. 

Death Log 
The Death Log lists all of the deaths with an autopsy case registered during a specific date 
range. The log contains the date of the sequence number on the log, patient name, MRN, 
ward, patient age and sex, date and time of death, date when the body was received, date 
when the history was sent to Medical Records (signed out), flag if the autopsy was 
performed, autopsy case accession number, date and time of autopsy, prosector code or 
name, date when the PAD was printed, and date when the FAD was printed. 
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Patient Death Log 
The Patient Death Log lists all of the deaths registered in the system with or without an 
autopsy case registered. The log contains patient name, MRN, age, sex and the date and time 
of death. 

Main Switchboard 
Click the Main Switchboard button to exit to the first screen on the switchboard. 
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Cytology Reports 
A brief explanation of each Cytology report will be listed in this section. To create a new ODBC 
report, use the Define ODBC Reports option located under Utilities on the Main Menu. 

 
Figure 5-93. Cytology Reports Window 

Cytotechnologist Productivity Log  
The Cytotechnologist Productivity Log is a listing of the case numbers in which the 
primary screening was performed by a given cytotechnologist. The list is generated based on 
an order date range for a specific cytotechnologist. The log consists of the case number, 
number of slides associated with the case, patient name, primary screener final diagnosis, 
date and time, and the Dx CAT assigned to the case at the time of sign out. 

Cytotechnologist Screen Case Log 
The Cytotechnologist Screen Case Log provides a listing of the number of cases and QA 
cases screened by a given cytotechnologist. The log consists of the date ordered, count of 
GYN cases per date, count of Non-GYN cases per date, count of QA cases per date and the 
total cases per date. 

Cytotechnologist Screen Slide Log 
The Cytotechnologist Screen Slide Log provides a listing of the number of slides and QA 
slides screened by a given cytotechnologist. The log consists of the date ordered, count of 
GYN slides per date, count of Non-GYN slides per date, count of QA slides per date and the 
total slides per date. 

Cytotechnologist Primary Screen Log 
The Cytotechnologist Primary Screen Log provides a listing of the number slides (GYN, 
Non-GYN, and total) screened for a given technologist. 

Abnormal Cytology Summary 
The Abnormal Cytology Summary Report is a monthly summary report of abnormal 
cytology results lists the patient names, physician, procedure date, accession number, and 
diagnosis category. 
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Cytology by Clinic Log 
The Cytology by Clinic Log reports a list of cases for a given date range and clinic code. 
The log includes the case number, MRN, procedure date, diagnosis, and pathologist code. 

Cytology by Doctor Log 
The Cytology by Doctor Log lists all gynecological and medical cytology cases for a 
specified date range by requesting doctor’s ID. The report lists the requesting doctor ID, case 
number, MRN, patient name, procedure date, Pathologist’s ID, and the total number of cases 
fir each requesting doctor ID. 

Cytology by Source Log 
The Cytology by Source Log lists all cytology cases for a specified date range. Cases are 
sorted alphabetically by specimen source name and case type (i.e. MED and GYN). The 
fields include case number, source code, and name. 

Cytology Consultation Log 
The Cytology Consultation Log lists all cases with staff consultations listed monthly and 
sorted by case accession number. The case is matched by the Consultation field, where the 
consulting pathologist code is stored. The log consists of the procedure date, case number, 
patient name, diagnosis code, primary pathologist code, the consulting pathologist code, and 
the consultation comments. 

Cytology Summary Log 
The Cytology Summary Log is a concise report of all the totals summarized from the first 
eleven (11) cytology reports described in this section. 

Cytology Tagged Cases Log 
The Cytology Tagged Cases Log is a listing of all of the cases within a specified date range 
that were marked in the tag letter field (flag) with a particular letter. The log contains the 
case number, patient MRN, requesting doctor ID, ward code, and the source name. 

Cytology Turnaround Time Log 
The Cytology Turnaround Time Log lists all cytology cases for the month. GYN cases are 
listed separately for inpatients and outpatients. Fields include the case number, received date, 
reported date, patient ward, patient type, and turnaround time in days (the difference 
between the received and reported dates). 

Cytology Work Log 
The Cytology Work Log prints for a given date range listing the cases by patient type and 
case number. The totals are listed for each patient type. The following information is listed 
for each case: case number, specimen source name, patient type, number of slides, number 
of smear slides, number of cytocentrifuges, and number of cell blocks. The default for the 
date range is the beginning and the end of the current day. 

Cytology Diagnosis Category Comparison Log 
The Cytology Diagnosis Category Comparison Log displays the totals of all GYN and 
MED cases for each assigned diagnosis category within the date range entered. The report 
includes the laboratory totals, individual screener totals, and a percentage comparison 
between the two values. 

Technologist Discrepancy Trend Report 
The Technologist Discrepancy Trend report displays a list of discrepancy codes assigned 
to a technologist’s ID. The report includes the Tech ID, Discrepancy code, case number, 
rescreened by, reviewed by, the number of cases for the QA code, and the number of cases 
for the Tech ID. 

Main Switchboard 
Click the Main Switchboard button to exit to the first screen on the switchboard. 
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GYN Cyto Reports 
A brief explanation of each Gyn Cyto report will be listed in this section. To create a new ODBC 
report, use the Define ODBC Reports option located under Utilities on the Main Menu. 

 
Figure 5-94. GYN Cyto Reports Window 

Abnormal Gyn Cyto Log 
The Abnormal Gynecology Log lists cases flagged as abnormal for the criteria entered. 

GYN Cyto Results Log 
The GYN Cyto Results Log provides a listing of GYN results on a case-by-case basis, 
defined by the criteria entered. 

GYN Cyto TAT by Patient Log 
The GYN Cyto TAT by Patient Type Log provides a listing of the turn around time values 
by patient type. The system displays the number of days elapsed between the received date 
and the sign out date. 

GYN Cyto Unsatisfactory Log 
The GYN Cyto Unsatisfactory Log lists cases with a diagnosis cost deemed unsatisfactory 
assigned. 

Main Switchboard 
Click the Main Switchboard button to exit to the first screen on the switchboard. 
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Med Cyto Reports 
A brief explanation of each Med Cyto report will be listed in this section. To create a new ODBC 
report, use the Define ODBC Reports option located under Utilities on the Main Menu. 

 
Figure 5-95. Med Cyto Reports Window 

Abnormal Med Cyto Log 
The Abnormal Med Cyto Log lists cases flagged as abnormal for the criteria entered. 

Med Cyto TAT by Patient Type Log 
The Med Cyto TAT by Patient Type Log provides a listing of the turn around time values 
by patient type. The system displays the number of days elapsed between the received date 
and the sign out date. 

Med Cyto Unsatisfactory Log 
The Med Cyto Unsatisfactory Log lists cases with a diagnosis cost deemed unsatisfactory 
assigned. 

Main Switchboard 
Click the Main Switchboard button to exit to the first screen on the switchboard. 
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Surgical Reports 
A brief explanation of each Surgical report will be listed in this section. To create a new ODBC 
report, use the Define ODBC Reports option located under Utilities on the Main Menu. 

 
Figure 5-96. Surgical Pathology Reports Window 

Surgical Accession Log 
The Surgical Accession Log lists all surgical cases examined in the lab during the month 
and can be sorted and listed by case number, received and reported date, the pathologist 
code, and patient type. 

Surgical Consultation Log 
The Surgical Consultation Log lists all cases with staff consultations listed monthly and 
sorted by case accession number. The case is matched by the Consultation field, where the 
consulting pathologist code is stored. The report consists of the procedure date, case number, 
primary pathologist code, the consulting pathologist code, and the consultation comments. 

Surgical Diagnosis by Source 
The Surgical Diagnosis by Source lists all cases for a given source type and date range with 
the final diagnosis. The report is sorted by case number. 

Surgical GIC Log 
The Surgical GIC Log lists all surgical cases with GIC performed. Cases qualify for the log 
if at least one Gross IOC is recorded. 

Surgical Pending Cases Log 
The Surgical Pending Cases Log lists all pending cases, sorted by case number, with 
surgical pathology specimens. The case is pending for that report if it is registered, but not 
signed out. The report is created weekly and contains the case number, received date, patient 
name, ward code, specimen source, surgeon name, and flags. 

Surgical Incoming Consult Slide Log 
The Surgical Incoming Consult Log produces a list of incoming consultations for a 
specified date range; it lists the case number, referring physician or pathologist, request date 
and total number of slides. 
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Surgical Pathology Frozen Section Log 
The Surgical Pathology Frozen Section Log is a listing of all cases with frozen section 
blocks created based on the flag in the case record. The following fields are included: case 
number, patient ward, patient type, number of FS blocks, and some flags (B for source of 
breast, CL if source was corpus luteum, etc. as defined in your Source file setup). The cases 
are sorted and totaled by the patient type and case number. The total number of cases and 
number of frozen section blocks are listed. 

Surgical Pathology with Special Tests 
The Surgical Pathology with Special Tests Report lists all surgical cases that have had 
special stains (tests performed within a specific date range). 

Surgical Summary Log 
The Surgical Summary Log is a concise report of all totals summarizing the surgical 
pathology reports defined above. 

Surgical Tagged Cases Log 
The Surgical Tagged Cases Log lists cases within a specific date range that were marked in 
the Tag Letter field with a particular letter. The log contains the case number, MRN, 
requesting doctor ID, ward code, and the source name. 

Surgical TAT by Pathologist Log 
The Surgical TAT by Pathologist Log provides a listing of the turn around time values by 
pathologist. The system displays the number of days elapsed between the received date and 
the sign out date. 

Surgical TAT by Patient Type Log 
The Surgical TAT by Patient Type Log provides a listing of the turn around time values by 
patient type. The system displays the number of days elapsed between the received date and 
the sign out date. 

Abnormal Surgical Log 
The Abnormal Surgical Log lists abnormal surgical cases per month. An abnormal case is 
recognized by the abnormal flag that can be set in Result Entry by the user or is set 
automatically from the Diagnosis Group field. The report contains the case number, MRN, 
patient name, specimen source code, diagnosis code, and pathologist code. 

Surgical Case Log by Clinic 
The Surgical Case Log by Clinic Log lists the cases for a given date range and clinic code. 
It includes the case number, MRN, procedure date, and pathologist code. 

Surgical Specimen with Photo 
The Surgical Specimens with Photos Report lists all cases that have had a gross 
photograph performed. The cases are matched by the specimen or case flag. The report 
includes the case number, surgeon name, patient ward, and patient type. The report can be 
listed monthly and is sorted by the patient type. The total number of specimens with a gross 
photograph performed is listed. 

Main Switchboard 
Click the Main Switchboard button to exit to the first screen on the switchboard. 
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Miscellaneous Reports 
A brief explanation of each Miscellaneous report will be listed in this section. To create a new 
ODBC report, use the Define ODBC Reports option located under Utilities on the Main Menu. 

 

 
Figure 5-97. Miscellaneous Reports Window 
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Block Tag Letter Log 
The Block Tag Letter Log lists all cases for designated tag letters within a specific date 
range. The log can be printed for all block tag letters or only for a specific tag letter. The 
report contains case accession number, sign out date, tag letter, and comment. 

Calculus Monthly Log 
The Calculus Monthly Log lists all the cases that contain a source with the pattern of 
“CALC” for a specified date range. For each case on the log, the accession number, patient 
ward, patient type, and source name is listed. The cases are sorted by the patient type first 
and the case number second with the totals for both inpatients and outpatients being listed. 
The calculus is recognized by the source type with the main source type that represents the 
calculus defined in the Hosparam during installation. The different locations where the 
calculus comes from can be represented by the source types with the owner source for 
calculus defined in the Hospital Parameters file. 

Card Log 
The Card Log can list all cases for a specific date range by patient’s last name and first 
name, MRN, case accession number, and patient’s date of birth. 

Control Reference Block Cases Log 
The Control Reference Block Cases Log finds cases with a block marked for use as a 
control reference. It also lists case numbers, order dates, stains, specimen ID, and block. 

Case Summary Log  
The Case Summary Log produces a total list of cases for a specified month. The log lists 
case numbers, patient types, and dates ordered. 

Case Tag Letter Log 
The Case Tag Letter Log lists all cases for designated tag letters within a specific date 
range. The log can be printed for all case tag letters or only for a specific tag letter. The 
report contains case accession number, sign out date, tag letter, and case comment. 

CPT Log – Summary  
For each code in a specified time period, the CPT Log - Summary lists the CPT codes, IBC 
codes, associated description, and the number of occurrences. Sorts by ascending CPT 
codes. 

CPT Log – Detailed 
For each code in a specified time period, the CPT Log – Detailed lists the CPT codes, IBC 
codes, case number, specimen code, the number of occurrences, the total number of CPT 
codes per IBC codes, and the total number of CPT codes. Sorts by ascending CPT codes. 

Doctor ID Log 
The Doctor ID Log lists doctors by their ID codes, last names, first names, second IDs, and 
third IDs. 

Diagnosis Category Log 
The Diagnosis Category Log breaks down cases by each diagnosis category in the system. 

FIO Log 
The FIO (For Identification Only) Log lists all cases that are matched based on the flag in 
the case record “Gross ID Only”. The report is sorted by the patient type and is totaled, 
presenting you with the case number, patient ward, and type. 

Incoming Consultation Log 
The Incoming Consultations Log produces a list of incoming consultations for a specified 
date range; it lists the case number, referring physician or pathologist, request date, and total 
number of cases. 
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Open Cases Log 
The Open Cases Log lists all cases that are NOT signed out or open for a specific date 
range. The log lists the patient’s last and first name, case accession number, source name, 
and date received. 

Outgoing Consultation Log 
The Outgoing Consultation Log lists outgoing consultations that have or have not (or both) 
been returned. It lists patient name, case number, materials (blocks and slides), date sent, 
pathologist, and destination (consultant). 

Revised Cases Report 
The Revised Cases Report retrieves revised surgical cases for the months specified. It lists 
the case number, received date, revised date, pathologist, and the reason for revision. 

Unsigned Cases Over 48 Hours Log 
The Unsigned Cases Over 48 Hours Log lists all unsigned cases 48 hours after registration 
and cases 48 hours after registration. The log lists the case accession number, the 
pathologist, and date ordered. This is to allow the monitoring of cases that have been 
resulted over 48 hours, but are still not signed out. 
NOTE: Cases with Supplemental reports will not qualify for this log. 

Accessioned without Clinic Log 
The Accessioned without Clinic Log shows all cases accessioned without a clinic on 
record. 

Final Billing Charges Log 
The Final Billing Charges Log lists the Final Billing Charges assigned during a defined 
date range and the total number of occurrences of these charges. 

Source Log 
The Source Log lists all sources processed within the defined date range and the total 
number of occurrences for each source. 

Source Statistics 
The Source Statistics lists all sources processed within the defined date range and the 
materials submitted for each source. 

Gross Description Log 
The Gross Description Log lists all cases that have had a Gross Description completed. The 
log includes the case number, specimen ID, source description, Done By ID, and the date 
and time the gross description was completed. 

Interdepartmental Consultation Log 
The Interdepartmental Consultation Log lists the case number, sign out ID, internal 
consultant ID, and the internal consultant comment. 

Turnaround Time by Accession Sequence 
The Turnaround Time by Accession Sequence displays the TAT calculated between 
Received D&T and Sign Out D&T for each case.  The search screen allows the user to 
define when the TAT values will be calculated on a 5-day, 6-day, or 7-day work week. 

Main Switchboard 
Click the Main Switchboard button to exit to the first screen on the switchboard. 
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Multisite Reports 
A brief explanation of each Multisite report will be listed in this section (Figure 5-99). To create a 
new ODBC report, use the Define ODBC Reports option located under Utilities on the Main Menu 

 
Figure 5-98.  Multisite Reports Window 

CPT Log- Summary 
The CPT Log – Summary will produce a report of procedures performed by each accession 
group organized by CPT code. 

CPT LOG- Detailed 
The CPT Log – Detailed produce a report of each accession group broken down by showing 
the total CPT procedures for each IBC code. 

Summary of Abnormal Cytology 
The Summary of Abnormal Cytology shows each abnormal cytology case organized by 
accession group.      

Cytology by Source Log 
The Cytology by Source Log gives a breakdown of all cytology cases based on source.  
You can select between MED and GYN cases in the search screen. 

Surgical Frozen Section Log 
The Surgical Frozen Section Log shows the number of blocks with a frozen section 
categorized by accession group. 

Abnormal Gyn Cyto Log 
The Abnormal Gyn Cyto Log displays the cases with abnormal diagnosis codes 
categorized by accession group. 

Gynecological Results Log 
The Gynecological Results Log shows diagnosis codes and working personnel for cases 
within an accession group. 
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Abnormal MED Cytology Log 
The Abnormal MED Cytology Log gives the abnormal MED cases for any or all accession 
groups. 

Surgical Pathology Accession Log 
The Surgical Pathology Accession Log shows every surgical case for any or all accession 
groups. 

Surgical Pathology Pending Cases Log 
The Surgical Pathology Pending Cases Log displays all pending cases for any or all 
accession groups. 

Surgical Pathology with Special Tests 
The Surgical Pathology with Special Tests report shows all cases that required a test 
classified as “special” for any or all accession groups. 

Abnormal Surgical Pathology Log 
The Abnormal Surgical Pathology Log gives the abnormal surgical cases for any or all 
accession groups. 

Main Switchboard 
Click the Main Switchboard button to exit to the first screen on the switchboard. 
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Utilities 
A brief explanation of each Utility option will be listed in this section.  

 
Figure 5-99. Utility Window 

Relink Tables 
This Relink Tables utility will relink the tables in the Access database to the tables on the 
server. The ODBC data source name that was previously setup in the control panel must be 
entered for the tables to be linked. 

Add Custom Report 
Add Custom Report is used to list your custom made reports on the Custom section of the 
switchboard so you can easily access them.   

Delete Custom Report 
Delete Custom Report is used to delete custom reports from the switchboard. 

Edit Database Objects 
Edit Database Objects  allows a user with full access permissions to edit the objects in the 
Access database. 

Distribute Database 
Distribute Database will allow you to set the database as a reference for other users. 

DB Version 
DB Version will list the version of the software. 

Main Switchboard 
Click the Main Switchboard button to exit to the first screen on the switchboard. 
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Action Logs 

The Action Logs option allows you to prepare reports and logs containing cases with an Action 
Entry procedure that was performed. You can also prepare worksheets with cases that qualify for this 
action entry.  
To access the Action Log option, select Reports > Action Logs from the main menu. The Log tab of 
the Action Entry Logs window (Figure 5-100) is displayed, allowing you to prepare a log 
containing cases for which an Action Entry procedure was performed. Enter search criteria to limit 
the log to specific cases and then click Run to generate the log.  

 
Figure 5-100. Action Entry Logs Window 

NOTE:  In the Action Entry Log, you can search for cancelled Preliminary and/or Supplemental 
reports. 
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Worksheet Tab 
The Worksheet tab (Figure 5-101) allows you to prepare worksheets with a list of cases that qualify 
for the Action Entry procedure. Enter search criteria to limit the worksheet to specific cases and then 
click Run to generate the worksheet. 

 
Figure 5-101. Action Worksheet Window 
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Report Tab 
The Report tab (Figure 5-102) allows you to prepare a report with a list of cases for which the 
Action Entry procedure was performed. Enter search criteria to limit the report to specific cases and 
then click Run to generate the report. 

 
Figure 5-102. Action Report Window 
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Chapter 6. Setup 

The Setup menu options are used to establish system-wide rules, defaults, and settings. From this 
menu, you can create and modify setup files, define the billing setup, set system options and defaults, 
create and modify simple codes and user flags, and other essential setup functions. Most users will 
not need to access these options on a day-to-day basis. Most setup files, billing setup, options, etc. 
will be defined during implementation. 

 
Figure 6-1. Setup Menu 
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SoftPath Setup Menu Options 
The SoftPath Setup option contains the following features and applications: 

Setup Files 
The Setup Files contain records and data used to complete many important SoftPath 
functions.  
See Chapter 6.1—Setup: Setup Files. 

Billing Setup 
Billing Setup contains options that allow you to enter and edit information regarding billing 
codes and procedures for your facility.  
See Chapter 6.2—Setup: Billing Setup. 

Case Comparison Setup 
To establish the criteria that the system will use to automatically select cases to flag for QA 
rescreening and review, select the Case Comparison Setup option.  
See Chapter 6.3—Setup: Case Comparison Setup. 

Options 
The Options file allows the system administrator to establish a limited number of user-
defined system parameters that supersede the Hosparam file values that were initially 
established by SCC personnel.  
See Chapter 6.4—Setup: Options. 

Scheduler 
To establish days, times, and other parameters for certain programs and reports so they can 
run automatically without operator intervention, select the Scheduler option.  
See Chapter 6.5—Setup: Scheduler. 

Dx Coding Setup 
To establish parameters regarding diagnosis coding for your facility, select the Dx Coding 
Setup option.  
See Chapter 6.6—Setup: Dx Coding Setup. 

Simple Codes 
The Simple Codes option allows you to define simple codes to be used within the system for 
certain informational fields.  
See Chapter 6.7—Setup: Simple Codes. 

User Flags 
To define new flags to be used within SoftPath, select the User Flags option.  
See Chapter 6.8—Setup: User Flags. 

Document Files 
Document Files allows you to prepare the layout and define other options regarding 
documents in your facility, including all reports.  
See Chapter 6.9—Setup: Document Files. 
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Auto Assignment 
To establish parameters for the automatic assignment of cases to personnel, select the Auto 
Assignment option.  
See Chapter 6.10—Setup: Auto Assignment. 

Custom Registration Setup 
Custom Registration Setup allows you to define your own templates for registration 
screens within the system.  
See Chapter 6.11—Setup: Custom Registration Setup. 
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Setup Files 

Setup files contain records and data used to complete many important SoftPath functions. You can 
use these files to set parameters and defaults and the contents of these files populate dynamic lists for 
many SoftPath fields. You will create the majority of your setup files during implementation/setup, 
but periodically you may need to add new records to these files. 

 
Figure 6-2. Setup Menu - Setup Files Submenu 

The Setup Files submenu contains the following options: 

• Personnel • Storage File 
• Collection Method • Insurances 
• Source • Consultants File 
• Body Site • Canned Messages 
• Special Stains/Tests • Dictionaries 

• Stain Panels • Organ File 
• Accessions File • Client Profile 
• Quality Codes • Location 
• Dx Category Severity • Risk Factor 
• Define Letters • Priority 
• Clinics File • Placeholder Setup 
• Doctors File  
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Adding a New Record  
When you access most Setup menu options, a lookup window displays, allowing you to 
select an existing record for review or modification. If you want to add a new record to the 
file, click the Add Record button. A window displays, allowing you to enter data for the 
new record. Complete the fields and click Save to add the new record to the database. 
NOTE: Use caution when creating new codes. Certain fields, such as the Code or Case 

Type fields cannot be modified after the record is initially created.  

Editing an Existing Record 
After you access the appropriate setup file option, enter search criteria in the lookup window 
to locate the record you want to edit. Click Find. Locate the record you want to edit and 
click the appropriate row to highlight it. Click OK.  
The setup window for the record displays. Click Edit from the toolbar to modify the 
information contained in the fields. Certain fields, such as the Code or Case Type fields 
cannot be modified after the record is initially created. When you have completed all your 
modifications, click Save. 
NOTE: If you unmark the Active check box when editing a record, the record is 

deactivated and will no longer be used by the system except for archive 
purposes. For example, if you deactivate a source code record, that source code 
will no longer be valid during specimen registration and will not display on any 
of the Source field dynamic lists. 

Deleting an Existing Record 
After you access the appropriate setup file option, enter search criteria in the lookup window 
to locate the record you want to delete. Click Find. Locate the record you want to delete and 
click the appropriate row to highlight it. Click OK. The setup window for the record 
displays. Click Del from the toolbar. The following message displays: “Do you really want 
to delete this record?” 
Click Yes to delete the record or No to cancel the action. If you click Yes, the record is 
deleted from the database. 
NOTE:  Use caution when deleting records from the setup file databases. Generally, you 

should deactivate a record instead of deleting it. To deactivate a record, edit the 
record and clear the Active check box.  
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Personnel File 

The Personnel File stores information about the laboratory employees that are given access to 
SoftPath. All personnel that will be interacting directly or indirectly with SoftPath should be 
registered and assigned to one of the categories based on a job type, (e.g. pathologist, technologist, 
etc.).  
NOTE: Personnel must first be defined in the SoftSecurity™ User file if they will have direct 

interaction with the system. Personnel that are needed for data entry by others but who 
will not be entering information directly to the system do not need to be defined in 
SoftSecurity.  

To access the Personnel file, select Setup > Setup Files > Personnel from the main menu. The 
Personnel Lookup window will display. To add a new personnel record, click the Add Record 
button and the Personnel Setup window (Figure 6-3) is displayed.  

 
Figure 6-3. Personnel Setup Window 

The Personnel Setup window contains standard data that is used for the employee throughout the 
system. If the user that is being added is defined in the SoftSecurity module, it is best to go to the 
Security Info tab and select the user’s SoftSecurity ID using the browser. When you attempt to enter 
a security ID, the system will prompt you to use the default values from SoftSecurity. If you decide 
to accept the defaults, the employee’s title, last name, first name, middle name and any other data 
defined within SoftSecurity is imported into the personnel record. 
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Personnel Setup Field Descriptions – Personnel Data 

 
Figure 6-4. Personnel Setup Window – Personnel Data 

Employee ID 
Enter a unique code to identify the employee.  Maximum 5 alphanumeric characters. 

Employee Type 
Select an employee type. This field, for example, is used with Manager’s Dashboard to 
organize employees by type for work distribution.  

Active 
A check is displayed in the box to indicate an active employee.  To inactivate an employee 
record, select the check box. 

Doctor ID 

Enter a doctor ID to identify the employee as a physician. Click  to open the Doctor 
Lookup Window for selecting a doctor ID.  

Title 
Enter a title for the employee. 

Last Name 
Enter the employee’s last name. 

First Name 
Enter the employee’s first name. 

Middle Name 
Enter the employee’s middle initial. 

SSN 
Enter the employee’s Social Security number. 

Sign Out Level 
Select the level of sign out permission available for the login ID. This level determines the 
user’s permission to sign out cases with the Diagnosis Codes corresponding to the defined 
level or lower. The required sign out level may be defined for each Diagnosis Code in the 
Diagnosis Code setup files. For example, a login ID with a sign out Level II can sign out 
cases with an associated Diagnosis Code of Level I or II but is prohibited from signing out a 
case with a Level III Diagnosis Code. Refer to page 6-78 for a description of the Diagnosis 
Code setup.  
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Personnel Setup Field Descriptions – Address Tab 
The Address tab is used to enter the employee’s address information. 

 
Figure 6-5. Personnel Setup Window – Address Tab 
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Personnel Setup Field Descriptions – QA Info Tab 
The QA Info tab is used to establish QA-related settings for the employee. 

 
Figure 6-6. Personnel Setup Window – QA Info Tab 

Daily Slide Screen Limit Field 
Enter the number of slides this employee is allowed to screen in one day during a regular 
shift. The value entered in this field is used by the system in the Screener Evidence Entry 
option to determine when the screener has exceeded the maximum number of slides. 
Maximum numeric value of 100. 

Hours in the Shift  
Enter the number of hours in one full shift. Maximum 2 numeric characters. 

Date of Last Exam  
Enter the date of this employee’s last proficiency examination or click the  button to select 
a date from the calendar. MM/DD/YYYY format. 

Failure # After Last Passed  
Enter the number of failed exams after the last passed exam. Maximum 2 numeric 
characters. 

Last Exam Agreement (%)  
Enter the percentage of the last examination agreement. Maximum 2 numeric characters. 

Random Case Rescreen 
The number you enter in this field indicates the percentage of cases screened by this user 
that will be selected for random rescreening. 

Random Case Review 
The number you enter in this field indicates the percentage of cases screened by this user 
that will be selected for random QA review. 

Screening Evidence 
Select the Screening Evidence check box to record screening evidence information for the 
user. 
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Personnel Setup Field Descriptions –Security Info Tab 
The Security Info tab displays all security and permission information. This option allows you to 
define the level of SoftPath access granted to the employee.  

 
Figure 6-7. Personnel Setup Window - Security Info Tab 

Security ID 
Enter the initials defined in SoftSecurity for the user. This information can be entered 
manually, or you can click the  button to display a list of ID codes present in the 
SoftSecurity database. 

Can see Final Diagnosis before Sign-Out 
Select this check box so the user can view the diagnosis prior to sign-out in the various 
Query options. 

Can see Gross Description before Sign-Out 
Select this check box if the user can view the gross description prior to sign-out in the 
various Query options. 

Can Dictate Gross Description 
Select this check box so the user can dictate gross descriptions and will be displayed in the 
dynamic list for the Done By field during gross description entry. 

Can Dictate Final Diagnosis 
Select this check box so the user can dictate final diagnoses and will be displayed in the 
dynamic list for the Done By field during final diagnosis entry. 

Can Dictate Intraoperative Consultation 
Select this check box so the user can dictate intraoperative consultations and will be 
displayed in the dynamic list for the Done By field during IOC entry. 

Can Dictate Revised 
Select this check box so the user can dictate revised reports and will be displayed in the 
dynamic list for the Done By field during revised report entry. 

Can Perform Result Entry using Standard Dx 
Select this check box so the user can perform result entry using Standard Dx. 
NOTE: The “Can Dictate Final Diagnosis” check box must be marked for this 

functionality to be available for the user. 
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Can Perform Sign-Out 
Select the corresponding case type check box(es)so the user can perform sign-out on selected 
authorized case types and will be displayed in the dynamic list for the Sign Out By field in 
the various sign out areas within the system. 

Can Rescreen 
Select this check box if the user will be displayed in the dynamic list for the Done By field 
during Rescreen entry. This setting also determines whether the user can be assigned to a 
rescreen procedure. 

Can Review 
Select this check box if the user will be displayed in the dynamic list for the Done By field 
during proreview entry. This setting also determines whether the user can be assigned to a 
proreview procedure. 

Can Edit the Result of QA Marked Cases 
Select this check box to give the user the ability to edit the results of a QA marked case from 
within a QA activity (Rescreen, Retro, Proreview). If this box is not marked, the user will be 
able to complete the fields within the QA completion window and save the QA procedure, 
but they will not be able to edit the document. 

Can Force Sign Out on QA Marked Cases 
Select this check box to give the user the ability to sign out QA cases. This setting will be 
recognized for cases with pending and completed QA procedures but does not affect cases 
that are in the random pool before the drawing is completed. Cases in the random pool 
cannot be signed out regardless of this setting. 

Can Release Body 
Select this check box to give the user the ability to edit the information displayed on the 
Body Release tab in the Autopsy Specimen Registration option. 

Deiner 
Select this check box if the user will be displayed in the dynamic list for the Deiner field for 
autopsy cases. 

High Risk Flag/Unflag 
Select this check box to give the user the ability to modify the High Risk flag in Patient 
Maintenance. 

Can view all reports 
Select this check box to give the user the ability to view all reports in the Results Query 
option. This will give the user access to the “All Reports” button on the Query – Reports tab. 

Can Perform Result Entry Using Pre-Defined Dx 
Select this check box so the user can perform result entry using the Pre-Defined Dx 
functionality. 
NOTE: The “Can Dictate Final Diagnosis” check box must be marked for this 

functionality to be available for the user. 
Can Perform Result Entry 

Select this check box to allow the user to enter reports in Final Result Entry. 
Select the corresponding case type check box(es)so the user can perform result entry on 
selected authorized case types. 
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Collection Method 

The Collection Method file, in conjunction with the Source file, is used to describe the specimen 
during specimen registration. The collection method describes how the specimen was obtained and 
includes other information regarding specimen handling. Both the Collection Method and the 
Source fields must be completed before you can successfully register a specimen. If a collection 
method is not entered during specimen registration, the default code from the Options file is 
automatically entered for each source.  
To access the Collection Method file, select Setup > Setup Files > Collection Method from the 
main menu. The Collection Method Lookup window displays, containing the codes and names of 
the records previously defined. To add a new collection method record, click the drop-down list 
button to select the desired case type and click the Add Record button. The Collection Method 
Setup window (Figure 6-8) is displayed.  

 
Figure 6-8. Collection Method Setup Window 

Code 
Enter a unique acronym to identify the collection method. Maximum 2 alphanumeric 
characters. 

Active 
A checkmark is displayed in the box to indicate an active collection method.  To inactivate a 
collection method record, select the check box. 

Name 
Enter a name/short description for the collection method. Maximum 49 alphanumeric 
characters. 

Half Slides for Screener Evid 
Select the Half Slides for Screener Evid check box if a half slide should be counted for this 
collection method during screener evidence entry. 
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Source 

The Source file contains source codes used to describe specimens/tissues. Processing protocol 
defaults are optional and can be designed to expedite specimen processing. You can override these 
default values during specimen processing.  
To access the Source file, select Setup > Setup Files > Source from the main menu. The Source 
Lookup window displays containing the codes and descriptions for existing records. To add a new 
source record, click Add Record and the Source Setup window (Figure 6-9) is displayed.  

 
Figure 6-9. Source Setup Window  

Code 
Enter a unique acronym to identify the source. This code will be used during specimen 
registration to complete the Source field. Each source code must be unique. Maximum 5 
alphanumeric characters. 

Active 
A checkmark is displayed in the box to indicate an active source.  To inactivate a source 
record, select the check box. 

Name 
Enter the full name/description of the source. Maximum 50 alphanumeric characters. 
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Parent Code 
Enter a parent source for this source code or click the  button to select from a list of 
existing source codes. Source records have a tree-like structure in the database. One source 
code can be assigned as a parent source code for other related source types. A multi-level 
structure of source types can be created (with a maximum of nine levels).  
Parent codes are useful when used during QA setup and when collating data throughout the 
system. By building the sources as parents and children, you can collate QA and reporting 
based on the parent source, which allows one setup to qualify cases for QA collation or 
reporting by capturing all of the children attached to the same parent source. 

Synoptic Protocol 
Enter the synoptic protocol that is to be imported into the Word template for cases with this 
specimen registered. Click the  button to select from a list of active synoptic protocols. 

Collection Method 
Enter the default collection method code you want to associate with this source code. Click 
the  button to select from a list of active collection method codes for the current source’s 
case type.  

Specimen Storage 
Enter a specimen storage location to associate with this source code or click the  button to 
select from a list of active specimen storage codes.  

Period (Days) 
Enter the default number of days that the source will be active within the lab prior to 
permanent storage. The information entered directly affects inventory management and the 
pending status of specimens for storage. Maximum 2 numeric characters. 

Block # 
Enter the default number of primary blocks per specimen/case for this source. Maximum 2 
numeric characters. 

Smear Slides 
Enter the default number of smear slides for this source. Maximum 2 numeric characters. 

Block Default Slides 
Enter the block default level for slide preparation for this source. Maximum 2 numeric 
characters. 

Membrane Filters 
Enter the default number of membrane filters for this source. Maximum 2 numeric 
characters. 

Monolayers 
Enter the default number of monolayers for this source. Maximum 2 numeric characters. 

Cell Blocks 
Enter the default number of cell blocks for this source. Maximum 2 numeric characters. 

Cytocentrifuges 
Click the arrow buttons to select the default number of cytocentrifuges for this source. 
Maximum 2 numeric characters. 

Stains/Tests 
Enter up to six special stains or tests that should be performed when this source type is 
registered. Click the  button to select from a list of valid special stain or test codes.  
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Lab Tests 
Enter up to six individual or group laboratory test codes or click the  button to select from 
a list of valid codes. These codes are defined in the SoftLab system. When the pathologist’s 
worksheet is printed, these codes will reflect pertinent information on the physiology of the 
source organ. The specified tests can be printed automatically on the final worksheet to 
provide more information to aid the pathologist with the final diagnosis.  

Billing Level 
Select the appropriate billing level (as defined in the CPT coding book) for this source from 
the drop-down list. The billing levels, when defined in the billing transaction table and the 
source file, can automatically capture the appropriate billing level based on the source code 
entered during specimen registration. Select one of the following: 

Level I 88300 Level V 88307 

Level II 88302 Level VI 88309 

Level III 88304 Level VII 88160 

Level IV 88305   

Source Priority 
Select the priority for the source from the drop-down list.  

GYN Biopsy Flag 
Select the GYN Biopsy Flag to select this source as qualifying as a biopsy for GYN cases. 
This flag is used when generating the Cytology-Histology Comparison Report. This flag will 
allow you to print a report containing those GYN Cytology cases that did not have a 
following surgical case containing a source with this flag marked.  

MED Biopsy Flag 
Select the MED Biopsy Flag to select this source as qualifying as a biopsy for MED cases. 
This flag is used when generating the Cytology-Histology Comparison Report. This flag will 
allow you to print a report containing those MED Cytology cases that did not have a 
following surgical case containing a source with this flag marked. 
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Body Site 

The Body Site file contains body sites to be used in accordance with the source codes to further 
identify the source during specimen registration.  
To access the Body Site file, select Setup > Setup Files > Body Site from the main menu. The Body 
Site Lookup window is displayed containing the codes and descriptions for existing records. To add 
a new body site record, click Add Record. The Body Site Setup window (Figure 6-10) is displayed.  

 
Figure 6-10. Body Site Setup Window 

Code 
Enter a unique acronym to identify the body site. This code should be entered during 
specimen registration in the Body Site field. Maximum 5 alphanumeric characters. 

Active 
A checkmark is displayed in the box to indicate an active body site.  To inactivate a body 
site record, select the check box. 

Name 
Enter the full name or short description of the body site code. This name is used in reports. 

Parent Code 
Enter a parent source code or click the  button to select from a list of valid body site codes. 
One body site code can be assigned as a parent code for other related body sites. This action 
can be repeated to produce a multi-level body site structure (with a maximum of nine levels).  

Allowed Case Types 
Select the appropriate check boxes to indicate the types of cases allowed to use this body site 
code. A maximum of four case type(s) may be selected. 
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Special Stains/Tests 

The Special Stains/Tests file contains special stains or test procedures that can be performed for 
certain cases. This also includes information about the test, such as the number of slides required and 
the text for the labels. 
To access the Special Stains/Tests file, select Setup > Setup Files > Special Stains/Tests from the 
main menu. The Special Stains/Tests Lookup window displays containing the codes and 
descriptions for existing records. Click Add Record to add a new special stain/test record in the 
Special Stains/Tests Setup New Record window (Figure 6-10). 

 
Figure 6-11. Special Stains/Tests Setup New Record Window 

Procedure ID 
Enter a unique acronym to identify the special stain/test. Maximum 5 alphanumeric 
characters. 

Name 
Enter the full name of the special stain/test. This name will be displayed on reports. 
Maximum 25 alphanumeric characters. 

Location 
Enter the code of the laboratory where the specimen is to be sent as defined in the 
Consultants Setup file. Click the  button to select from a list of valid consultant codes. This 
is NOT a required field. 

Send Out 
Select this check box if an outside laboratory will perform the testing. 
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Allowed Case Types 
Select the appropriate check boxes to indicate the case types allowed to use this special 
stain/test. A maximum of four case type(s) may be selected. 

Technical Billing Group 
From the drop-down list, select the technical billing group to associate with the test (I 
through IX). 

Professional Billing Group 
From the drop-down list, select the professional billing group to associate with the test (I 
through IX).  

Patient Slides Area 
In the Patient Slides area, complete the following fields: 
Number 

Enter the number of patient slide labels required per case for this procedure. 
Maximum 2 numeric characters. 

Label Text 
Enter the text you want to print on the patient slide labels. Maximum 12 
alphanumeric characters. 

Control Labels Area 
In the Control Labels area, complete the following fields: 
Number 

Enter the number of control labels required for this procedure per case. Maximum 2 
numeric characters. 

Label Text 
Enter the text that you want to print on the control slide labels. Maximum 12 
alphanumeric characters. 

Active 
A check is displayed in the box to indicate an active special stain/test.  To inactivate a 
special stain/test record, select the check box. 
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Stain Panel Setup 

The Stain Panel file allows you to define special stains or test procedures to be performed as a group 
for selected cases. This setup file also allows you to define the number of slides required for the 
selected test and technical/professional billing definitions for the group.  
To access the Stain Panel file, select Setup > Setup Files > Stain Panel Setup from the main menu. 
The Stain Panel Lookup window displays containing the codes and descriptions for existing 
records. Click Add Record to display the Stain window (Figure 6-12) to add a new stain/test record.  

 
Figure 6-12. Stain Window 

Procedure ID 
Enter a unique ID code for the stain panel. Maximum 5 alphanumeric characters. 

Name 
Enter the name of the stain panel. Maximum 22 alphanumeric characters. 

Technical Billing Group 
From the drop-down list, select the technical billing group to associate with the stain panel (I 
through IX). 

Professional Billing Group 
From the drop-down list, select the professional billing group to associate with the stain 
panel (I through IX).  
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Allowed Case Types 
Select the appropriate check boxes to indicate the case types allowed to use this stain panel. 
A maximum of four case type(s) may be selected. 

Special Stain/Test Grid 
When the grid is active, clicking the Code column allows you to select a special stain/test. 
Enter the required number of slides for this special stain/test in Number of Patient Slides 
and Number of Control Labels fields. The system inserts the default values taken from the 
corresponding stain file for each item, but this information can be modified.  
The stains entered in the grid will be applied in the various processing options in the order in 
which there are entered. 

Add Test Button 
Click Add Test to add a test to the stain panel. The Special Stains/Test grid becomes 
available for data entry. 

Delete Test Button 
Highlight the test you want to delete and click Delete Test. The test is removed from the 
grid. 

Active 
A checkmark is displayed in the box to indicate an active stain panel.  To inactivate a stain 
panel record, select the check box. 
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Accessions File 

The Accessions File allows you to define the structure of the accession sequence numbers used for 
each case type and define distinct group codes for each location and the structure of the accession 
sequence numbers used for each case type. 

 
Figure 6-13. Setup Menu - Setup Files Submenu – Accessions File 

The Accessions Files contains the following options: 
• Accession Sequences 
• Accession Groups 
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Accession Sequences 
The Accession Sequences option defines the structure of the accession sequence numbers used for 
each case type. This includes whether the case is for processing only, or if the case needs a complete 
work-up that issues a patient report. 
To access the Accession Group file, select Setup > Setup Files > Accessions File > Accession 
Sequences from the main menu. The Accession Sequences Lookup window is displayed. Click Add 
Record to add a new accession sequence record and the Accession Sequences Setup window 
(Figure 6-14) is displayed.  

 
Figure 6-14. Accession Sequence Setup Window 

Accession Base 
Enter a unique accession base code (Maximum 3 alpha characters, the number of available 
characters for your system is determined in pre-live setup) and a brief description 
(Maximum 28 alphanumeric characters) of the accession base. 

Parent Base 
Enter the code of the parent accession base if sequentially incrementing accession numbers 
are to be used between two case types. Click the  button to select from a list of valid 
accession bases.  

Accession Group 
Enter the group code of the accession sequence that will be used. Each sequence must have 
an accession group associated with it and the code must be defined in the Accession Group 
file. Click the  button to display a list of valid accession groups. 

Number 
Enter the starting sequence number. If you entered a parent code in the Parent Base field, 
the number must be 0. Maximum 5 numeric characters. 
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Processing Only 
Select this check box if the accession sequence is to be used for “processing only” cases. The 
accession sequences designated for processing only will not be pending for transcription 
entry, but will be pending for specimen and block processing. The case must be 
electronically signed out of the SoftPath module. You can sign out cases in the Fast Sign 
Out option using the accession sequence for the case selection or by marking the Processing 
Only check box in the Fast Sign Out window. 

Type 
Select one of the following options for this accession sequence: 

New The accession sequence will be used for new cases only. 

Old The accession sequence will be used for cases previously registered in another 
system (e.g., computer, microfiche, manual cards). 

Allowed Case Types 
Select the case type(s) in which the accession sequence may be used. Accession sequences 
defined for the Autopsy case type will remain exclusive to just autopsies. 

Default Technical and Professional Billing Location 
Enter the default technical and/or professional billing location for the accession sequence or 
click the  button to select from a list of active billing locations. If you enter a billing 
location, the specified location becomes the default billing location on the Accounting tab in 
the Specimen Registration options if no billing locations are associated with the clinic. 
However, if a billing location exists for the clinic associated with the case, that clinic’s 
location is used instead.  

Active 
A checkmark is displayed in the box to indicate an active accession sequence.  To inactivate 
an accession sequence, select the check box. 
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Accession Groups 
The Accession Groups option allows you to define distinct group codes for each location and the 
structure of the accession sequence numbers used for each case type. The accession group code is 
entered in the Accession Sequence file to define the location used. 
NOTE: This file MUST be established before the Accession Sequence file is set up. 
To access the Accession Groups file, select Setup > Setup Files > Accessions File > Accession 
Groups from the main menu. The Accession Group Lookup window will display. To add a new 
accession group record, click Add Record and the Accession Groups Setup window (Figure 6-15) 
is displayed.  

 
Figure 6-15. Accession Group Setup Window 

Accession Group ID 
Enter a unique accession group code. Maximum 2 alphanumeric characters. 

Active 
A checkmark is displayed in the box to indicate an active accession group.  To inactivate an 
accession group, select the check box. 

Accession Group Name 
Enter a unique group name. Maximum 30 alphanumeric characters. 

Location/Address 
Enter a maximum of five lines of text to indicate the facility’s address. 

Phone 
Enter the phone number of the last contact at the facility.  Maximum 12 numeric 
characters. 

Ext 
Enter the telephone extension of the last contact at the facility. Maximum 5 alphanumeric 
characters. 

Fax 
Enter the fax number of the last contact at the facility. Maximum 12 numeric characters. 

Last Contact 
Enter the name of the person to contact at the facility. Maximum 19 alphanumeric 
characters. 
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Quality Codes 

The Quality Codes option allows you to monitor the proper fixation, identification, and safety 
requirements of a specimen submitted to the pathology laboratory. These options aid in categorizing 
technical and organizational problems that occur during processing, describe the diagnosis 
discrepancies between two examiners, and differentiate between the abnormal and normal cases for 
one or more case types.  
To access the Quality Codes option, select Setup > Setup Files > Quality Codes from the main 
menu. The Quality Codes Lookup window (Figure 6-16) is displayed; select the proper adequacy 
option from the Option drop-down list. Click Find to display existing records or Add Record to 
create a new adequacy code of the specified type. 

 
Figure 6-16. Quality Codes Lookup Window 

Quality Codes options include: 
• Diagnosis Categories File 
• Processing Problems 
• Quality Assurance Categories 
• Specimen Adequacy Codes 
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Diagnosis Categories File  
The Diagnosis Categories File option allows you to define extensive diagnosis codes that can be 
used to classify results and categorize them as normal or abnormal. 
To access this option, select Diagnosis Categories File from the Options drop-down list and then 
select a case type. Click Add Record to display the Adequacy File Setup window (Figure 6-17). 

 
Figure 6-17. Adequacy File Setup New Record Window – Diagnosis Categories 

Code 
Enter a unique acronym to identify the diagnosis category. Maximum 3 alphanumeric 
characters. 

Active 
Mark this check box if the diagnosis category should be available for use in the system. 

Name 
Enter the full name of the diagnosis. Maximum 31 alphanumeric characters. 

Description 
Enter a brief diagnosis category description as it should appear on reports. Maximum 59 
alphanumeric characters. 

Abnormal 
Select this check box to mark the code as an Abnormal result and flag the diagnosis for the 
case as abnormal. 

High Risk 
Select this check box to flag the diagnosis category as high risk.  If this is done and the 
diagnosis category is applied to a case, the patient is flagged as high risk. 
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Processing Problems 
The Processing Problems option allows you to define different technical and organizational 
problems that may occur during processing. It determines if processing should continue when each 
type of problem has been detected. 
To access this option, select Processing Problems from the Options drop-down list and then select 
a case type. Click Add Record to display the Adequacy File Setup window similar to Figure 6-18. 

 
Figure 6-18. Adequacy File Setup Window – Processing Problems  

Code  
Enter a unique acronym to identify the processing problem. Maximum 3 alphanumeric 
characters. 

Name  
Enter the full name of the processing problem. Maximum 31 alphanumeric characters. 

Description  
Enter a brief processing problem description as it should appear on reports. Maximum 59 
alphanumeric characters. 

Specimen Rejection  
Select this check box to indicate that the specimen with this processing problem has been 
rejected and no further processing is to proceed. Leave this check box blank to allow the user 
to note the specimen problem and to continue processing. 
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Quality Assurance Categories  
Quality Assurance Categories are set up to define the differences in diagnoses that may occur 
between two examiners. The discrepancies are detected when a cytologist, pathologist, or another 
consultant and pathologist review the case.  
To access this option, select Quality Assurance Categories from the Options drop-down list and 
then select a case type. Click Add Record to display the Adequacy File Setup window (Figure 
6-19). 

 
Figure 6-19. Adequacy File Setup Window – Quality Assurance Categories 

Code  
Enter a unique acronym to identify the QA category. Maximum 3 alphanumeric 
characters. 

Name  
Enter the full name of the QA category. Maximum 31 alphanumeric characters. 

Description  
Enter a brief QA category description that should be printed on reports. Maximum 59 
alphanumeric characters. 

Discrepancy  
Mark this check box if the QA category indicates a discrepancy between the two examiners. 
This flag is used by the system to locate cases in the Action Entry option that will require 
documentation of the discrepancy. 
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Specimen Adequacy Codes 
Specimen adequacy Codes define the different deficiencies a received specimen may have and will 
determine if processing can continue when each type of deficiency is detected. 
To access this option, select Specimen Adequacy Codes from the Options drop-down list and then 
select a case type. Click Add Record to display the Adequacy File Setup window (Figure 6-20). 

 
Figure 6-20. Adequacy File Setup Window – Specimen Adequacy Codes 

Code  
Enter a unique acronym to identify the specimen adequacy. Maximum 3 alphanumeric 
characters. 

Name  
Enter the full name of the specimen adequacy code. Maximum 31 alphanumeric 
characters. 

Description  
Enter a brief description of the specimen adequacy code that will be printed on reports. 
Maximum 59 alphanumeric characters. 

Specimen Rejection  
Mark this box to indicate that specimens with this code should be rejected and processing 
should be stopped. Leave the field blank to note a specimen problem and continue 
processing. 
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Dx Category Severity 

The Dx Category Severity option allows you to define the order of importance of the Dx Categories 
for each case type.  Based on the severity, when the Auto Assign Dx Cat is activated, the system will 
assign the most severe Dx Category to the case if multiple categories qualify based on the Dx Codes 
selected for the case. 
To access the Dx Category Severity option, select Setup > Setup Files > Dx Category Severity from 
the main menu. The Dx Category Severity window (Figure 6-21) is displayed.  

 
Figure 6-21. Dx Category Severity Window 

To edit Dx category severity, select a case type from the Case Type drop-down list. A list of all the 
Dx Categories defined for the selected case type will display in read-only mode. A list of Dx 
categories is displayed in a list at the bottom of the window. Highlight a Dx Category and use the up 
and down arrow buttons to arrange the categories with the top of the list being the most severe 
categories and the bottom of the list being the lease severe categories. 
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Define Letters 

The Define Letters option allows you to create form letters. The basic contents of the letter can be 
predefined (e.g., patient, test, and result information) and assigned a code name and a letter type.  
To access the Define Letters option, select Setup > Setup Files > Define Letters from the main 
menu. The Letter Lookup window is displayed. To create a new form letter, select the letter type 
you want to create in the Letter Type drop-down list:  

Follow-up Letter Used to send a letter to a physician/patient following the sign out of a case or 
on a specific date. It can also be used to remind patients of appointments. 

Incoming Form Used to request material for consultation from another facility. 

Insurance Form Printed, if needed, for an outgoing consultation. 

Outgoing Form Accompanies all materials sent for an outside consultation. 

Incoming Form 
Return Material 

Accompanies material being returned to a facility that has requested a 
consultation. 

Fax Cover Page Allows the definition of how the fax coversheet should read. (This applies to 
only those that have faxing capabilities for MS Word documents.) 

After you select a letter type, click Add Record to create a new form letter. The Define Letters 
Setup window (Figure 6-22) is displayed.  

 
Figure 6-22. Define Letters Window 

Code  
Enter a unique code to identify the letter. Maximum 5 alphanumeric characters. 

Title   
Enter the title of the letter. Maximum 35 alphanumeric characters. 
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Document Button 
After entering the required data in the Define Letters Setup window (Figure 6-22), click the 
Document button to access Microsoft Word to display the Letter Setup window (Figure 6-23). 

 
Figure 6-23. Letter Setup Window 

Insert Common Data Code Button 
Select a common data code from the drop-down list and click Insert Common Data Code 
to insert the code into the document at the current cursor location. These common data codes 
allow you to automatically insert information from SoftPath records into the letter when it is 
printed. For example, if you insert the Clinic Name data code, the appropriate clinic name 
will print on the letter when you generate it. 

Insert Letter Data Code Button 
Select a letter data code from the drop-down list and click Insert Letter Data Code to insert 
the code into the document at the current cursor location. These common data codes allow 
you to automatically insert information from SoftPath records into the letter when it is 
printed. For example, if you insert the Consultant Address Line 1 data code, the first line of 
the consultant’s address will print on the letter when you generate the letter. 



SoftPath GUI v.4.2.1 User Manual Chapter 6.1 – Setup: Setup Files 

PATH4.2-G-U (6th Ed, Rel. 01/31/07)   Page 6-39 

Clinics File 

The Clinics file stores information regarding the patients, including inpatient clinics and outpatient 
facilities. The data entered contains patient type, billing information, and clinic price schedules. All 
SCC modules commonly share this setup file. 
To access the Clinics file, select Setup > Setup Files > Clinics File from the main menu. The system 
bridges you to the SoftLab system and displays the (SoftLab) Wards/Clinics window. 
NOTE: Accessing the Clinics file bridges you to the SoftLab GUI or SoftLab ASCII application, 

depending on environmental variables. For further details, refer to the appropriate 
SoftLab User Manual. 

• SoftLab GUI is called when the HAS_GLAB hosparam equals Y. 
• SoftLab ASCII is call when the HAS_GLAB hosparam equals N 

With the Wards/Clinics screen displayed, enter data in each applicable field.  Fields are described 
below in the order they appear on screen.    
Ward ID 

Enter a unique code to identify the clinic.  The code will print on Cumulative reports.  Click 
the dynamic list button or press F2 to display a list of all previously defined codes in the 
Search Results window (Figure 6-24).  To select a code, either double-click the entry or click 
once to highlight and click OK.  You can also arrow down to the selection and press 
ENTER to select.  Maximum 5 alphanumeric characters. 

 
Figure 6-24.  Ward ID Dynamic List 

Salesman ID 
Defines the sales representative for the clinic/client (used for independent labs).  Click the 
dynamic list button or press F2 to display a dynamic list of all previously defined codes.  To 
select a code, either double-click the entry or click once to highlight and click OK. 
This is an optional field.  Maximum 15 alphanumeric characters. 
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Area 
Enter a unique code to identify the area in which this clinic is located.  Click the down arrow 
in the right side of field or press F2 to display a dynamic list of all previously defined codes.  
To select a code, either double-click the entry or click once to highlight and click OK.  
Maximum 5 alphanumeric characters. 

• This code can be used to group clinics for batching and prioritizing of reports.  This 
field is equivalent to the Courier Route field in the Doctor setup files. 

• Both fields, Ward/Area and Doctor/Courier Route correspond to the Area field in 
screens for generating print jobs. 

• This field can be used for grouping clinics that use identical age specific reference 
ranges. 

House doc (Optional field used by Independent Labs) 
Enter the Doctor ID code if the Ward/Clinic has a designated physician assigned as the 
house doctor.  This code can automatically default in Order Entry in the Requesting Doctor 
field, if the requesting doctor field is blank.  Consult with SCC if you wish to use this field. 

Active 
Click the check box to indicate whether or not this ward is active (currently in use). 

Name 
Enter the full name of this clinic as you want it to appear on the Single-Sheet (RR format) 
reports.  This name does NOT print on Cumulative (CR format) reports.  Maximum 43 
alphanumeric characters. 
NOTE: If you exceed 30 characters, notify SCC to adjust the report layout (this applies 

to Single-Sheet reports only). 
Type 

Enter a code to identify the type of patient residing within this clinic; click the down arrow 
in the right side of field to display a drop-down list of the following options: 

• Emergency Room • Inpatient • Outpatient 

• Home care • Nursing Home • Veterinary 

To select an option, click on the entry once.  This patient type is used in various report 
options, including Billing. 

Pre-ops 
Select check box to indicate a pre-op clinic.  All abnormal results for patients in this clinic 
are automatically placed on the Call List. Leave blank if this is not a pre-op clinic.  Results 
then qualify for the Call List based on the following: 

• Order Entry Call field (denotes a marked order). 
• Any applicable rules in the RBS Setup file. 
• Call List Hosparam file settings. 
• Service type and license number 

Serv Type 
Enter free text to describe the type of service this clinic provides.  This field is optional and 
for informational use only.  Maximum 15 alphanumeric characters. 

License #  
Enter the proper license number for this clinic if this clinic is required to operate under a 
license (e.g., a free-standing physician clinic).  Maximum 11 alphanumeric characters. 
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Facility 
Enter a hospital code for this clinic.  This field can be used for grouping clinics that use 
identical age-specific reference ranges. 
For Multisite clients using multisite billing, this code must be entered into the Hosp field in 
the Test Setup Table found under Multisite setup.  The field is also used in MultiSecurity.  
Maximum 7 characters. 

Group 
Enter a unique code to identify the group.  This field can be used for grouping clinics that 
use identical age specific reference ranges.  This field is also used in MultiSecurity.  
Maximum 7 characters. 

Depot (For multisite clients) 
Enter a unique code to identify the depot.  This field can be used for grouping clinics that use 
identical age specific reference ranges.  Maximum 2 characters. 
NOTE: The user can group clinics using identical age specific reference  ranges by 

one of the following fields: Area, Facility, Group, or Depot.  The field used for 
grouping purposes is controlled by Hosparam Ranges_by_group by entering 
A=Area, F=Facility, G=Group, or D=Depot.  In the Clinic field, in F5-Ranges, 
in Individual Test Setup, the user can enter a clinic ID or the entry from the field 
used to group the clinics. 

Collector 
Enter the collection/billing company identification code.  Used in conjunction with SoftA/R. 

Ins. ID 
Enter up to four insurance company names associated with this clinic.  This field is required 
for the SoftA/R module.  Four fields, maximum 5 alphanumeric characters each. 

Provider# 
Enter a provider number for each insurance company in the Insurance field.  This field is 
required for the SoftA/R module.  Four fields, maximum 11 alphanumeric characters 
each. 

Additional information 
Enter optional free text for any insurance company entered in the corresponding Insurance 
field.  This is for informational use only.  Four fields, maximum 19 alphanumeric 
characters each. 

# of Report Copies 
Enter the number of copies to be generated for the Ward/Clinic from Collated batch 
reporting. 
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Auto report 
Click check box to indicate that this Ward/Clinic will use Autoreporting for SoftLab results 
or leave blank if you do not want to use Autoreporting. 
If checked, all lab results reports (single-sheet reports) for patients assigned to this clinic will 
print automatically to a designated printer.  If blank, the Order Entry printer, the priority rule 
in the Hosparam file, or Individual Flag setup for a test in the order determines if an order 
for this clinic automatically prints upon result. 
The System selects the appropriate level (1-5) and the printer as follows: 
Individual Test Level 
1. Individual Test - Flag #14:  This level is used to autoreport test level (not order, 

clinic, or priority).  The printer is selected first by clinic, then by the autoreporting 
default printer. 
NOTE: A single test within an order qualifies the entire order when the test is 

resulted and verified. 
Clinic or Doctor Level 
2. Ward/Clinic is the third level.  A specific printer for this clinic can be defined on 

either of the Ward profile fields as follows: 
!PR XXX, where: 
a) XXX denotes the first three characters of the printer’s name.  Each time an 

order that qualifies for autoreporting is verified, a Single-Sheet Report is 
generated to this printer. 

b) The Ward/Clinic printer overrides the default printer from the Hosparam, but 
is superseded by the printer defined in the Order Entry screen     (Level 1). 

3. The system defaults to the Doctor level, if defined, and the patient Stay-Clinic is not 
defined at the Ward/Clinic level.  The printer must be defined as on the Clinic file in 
either of the profile fields (prof) in the Doctor’s file as follows: 

!PR XXX, where: 
a) XXX denotes the first three characters of the printer name or FAX ID. 
b) The report prints on the requesting doctor’s printer if no printer is defined for 

the order or for the Ward/Clinic. 
Priority Level 
4. The final level is the Hosparam priority definition e.g., autoreport Stats only.  First, 

this level looks to the Clinic printer, then to the Doctor’s printer, and third, to the 
default printer to select the printing destination. 

Default Printer 
5. If the printer is not selected in Order Entry and there is NO Clinic or Doctor printer 

defined, then the orders for this Clinic that qualify for autoreporting will print to the 
default printer. 

a) Notify SCC of the name of the default printer to be defined in the Hosparam. 
b) This default situation for autoreporting is superseded by any printers as 

described in Level 1, 2, and 3. 



SoftPath GUI v.4.2.1 User Manual Chapter 6.1 – Setup: Setup Files 

PATH4.2-G-U (6th Ed, Rel. 01/31/07)   Page 6-43 

Label at OE  
Click check box to automatically print labels at Order Entry or leave blank if you do not 
need to print labels at Order Entry. 
After confirming your Hosparam controls, use this flag to generate automatic labels from 
Order Entry on Inpatient wards (and other non-outpatient wards). 
NOTE: Stat and Outpatient labels do NOT require this flag, as they print based on 

Hosparam controls (see SCC personnel). 
Auto rep. mic 

Click check box, if this clinic's microbiology result reports should print automatically.  This 
field applies only to the Autoreporting Micro option in the Interfaces Setup file.  The reports 
are generated based on specified priorities. Leave blank if this clinic's microbiology results 
reports should not automatically print. 

Generate MRN 
Click check box to automatically generate a unique Medical Record Number when a patient 
without an MRN is added to the database.  LIS will create an MRN when the record is saved 
to the database, using X as a prefix (e.g., X1234567). Leave blank if you do not want to 
automatically generate MRNs, even when none is given with patient information. 
NOTE: This flag also generates a billing number when a patient without a billing 

number is added to the database.  This requires Hosparam settings. 
Single rep final 

Click check box to prevent orders for LAB SINGLE-SHEET REPORTS (RR format) from 
printing until ALL tests included in chapters have been verified. Leave blank to print 
SoftLab Single-Sheet reports before all tests have been verified. 
NOTE: This flag affects the Lab Single-Sheet Result Reports and Outpatient reports 

through manual batch reporting and the Print Scheduler.  Setting overrides 
Autoreporting, if the two are different e.g., if autoreporting is set to print 
complete chapters and a ward has this flag set to checked, then the Ward 
receives its reports upon entire order completion. 

Single Rep complete Chapters 
Chart avail. for duplicate copy 

Used in conjunction with !DUPPT in the Doctor Setup file.  When this flag is checked and 
the !DUPPT tag is entered in the Profile line in the Doctor Setup file, a copy of a Single 
Sheet Final Report will print for the Requesting Physician and a copy of the Discharge 
Report will print for the Attending Physician. 

Skip in AR post 
Click check box to skip this Ward/Clinic when posting to SoftA/R.  Patients assigned to this 
ward or clinic will be skipped by SoftA/R and posted to the HIS via the regular billing 
program. Leave blank to include this Ward/Clinic when posting to SoftA/R. 

Skip bill 
Click check box if this Ward/Clinic will be EXCLUDED from the LIS billing report. Leave 
blank to include the Ward in the LIS report. 

Skip drawing (bill)  
Click check box if you do NOT want to bill for drawing blood.  This clinic will be 
EXCLUDED from the Phlebotomy Drawing charges (see Chapter 1.15) that may be 
defined in the Hosparam file (consult with SCC personnel). Leave blank if you DO want to 
bill for drawing blood. 
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DX req.atOE: 
Click check box to require a diagnosis at the time of the Mini Order Entry. Leave blank to 
allow Order Entry without a diagnosis. 
NOTE: THIS APPLIES TO MINI ORDER ENTRY ONLY. 

Skip call 
Click check box to exclude this ward or clinic from the call list. Leave blank to include this 
ward or clinic on the call list. 

Discount__% 
Enter the percentage discount in whole numbers that is applied to the billing for this clinic 
(e.g., 10 = 10 percent off the price).  This is an OPTIONAL field for the SoftA/R module 
(where clinic = client and the default price schedule for a client is CLIN).  Maximum 3 
numeric characters. 
NOTE: In SoftLab, this field can be used with the Billing Report. Consult SCC 

personnel, as this is not a standard feature. 
 

Price Redirection to 
This field allows you to redirect a test price for this client to any defined price schedule.  
This eliminates the need to enter the same fee schedule repeatedly under Individual or Group 
Tests setup.  Maximum 5 alphanumeric characters. 
EXAMPLE: 

Enter PRINS to redirect the test price to the Private Insurance Fee Schedule.  Once 
you have defined the PRINS carrier in the Individual and Group Tests setup 
sections, you can link this schedule/price to other carriers by entering PRINS in this 
Price redirection field.  Examples of other entries include MCR, MAID, or PRIV. 
NOTE: This option is used only with SoftA/R. Consult with SCC SoftA/R 

personnel for further details. 
Billing # 

Enter a unique billing number if this Ward/Clinic is to be billed directly as a separate 
account. 
It is necessary to consult with SCC if you wish to use this field as a Hosparam setting. 

Price Schedule 
Enter the price schedule used to bill the clinic as the default.  This definition is used in the 
Individual and Group Tests setup; more than one clinic may use the same code.  Maximum 
2 alphanumeric characters. 
Schedules allow you to create different billing prices for the same patient type. 
EXAMPLE: 

Inpatients default to the price set in the Individual Tests setup.  Therefore, rather 
than using the default price linked to the billing code, the ICU ward uses the 
Schedule 1 price (as defined in Individual Tests setup, Prices tab). 
It is necessary to consult with SCC if you wish to use this field as a Hosparam 
setting. 

Balance 
This READ-ONLY field shows the current balance due from this clinic as recorded 
in SoftA/R. 
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Starting Date 
Enter the exact date when this clinic becomes operational.  Maximum 8 numeric 
characters using the mm/dd/yyyy format. 

 
Total payments  

This READ-ONLY field shows the total payments received from this clinic (if available) as 
recorded in SoftA/R. 

Profile  
Enter command-specific tags OR free-text information about the ward or clinic (e.g., office 
hours).  Two fields, maximum 47 alphanumeric characters each. 
The Command-Specific Tags include: 

• The printer where autoreporting of this clinic's patient results will occur (if no 
printer is specified in Order Entry).  Use the format !PR XXX (where XXX is the 
first three characters of printer name). 

• The printer where Collated-Batch reports will print (if no printer is defined for the 
Collated-Batch job in the Print Scheduler).  Use the format !CHPR XXX (where 
XXX is the first three characters of the printer name). 

• The printer designation for an Advanced Beneficiary Notice form.  Use the format 
!PRC XXX (where XXX is the first three characters of the printer name). 

• Single-Sheet FORMAT used by the clinic, using the format !RC XXX (e.g., !RC 
RR2).  See SCC personnel, as this tag is activated by a Hosparam setting. It 
supersedes hard-coded defaults, generic Hosparam settings, and Print Scheduler 
definitions. 

• Single-Sheet LAYOUT used by the ward, using the format !RR XXX (e.g., !RR 
RL2).  See SCC personnel, as this tag is activated by a Hosparam setting. It 
supersedes hard-coded defaults, generic Hosparam settings, and Print Scheduler 
definitions. 
NOTE: To use the Single-Sheet format and layout tags together, join them with 

a semicolon (;) (e.g., !RC RR2;!RR RL2).  Single-Sheet batch jobs 
must be sorted by Clinic first (as the first-level criteria). 

• Call List Schedule, enter !CSCH xxxx-xxxx tag to indicate the hours the clinic can 
be called with results.  Calls outside the time parameters are skipped. 
EXAMPLE: 

!CSCH 0800-1200, 1500-1700 means that results to be called to this clinic 
will only appear on the call list between 8 a.m.-12 Noon and 1p.m.-5 p.m. 
!CSCH MON-FRI: 0900-1230, MON-FRI: 1500-1700, SAT: 0900-1200 
means results to be called to this clinic will only appear on the call list 
Monday-Friday: 9 a.m.-12:30 p.m., 1p.m.-5 p.m., and Saturday from 9 a.m.-
12 Noon. 

• !DEPOT XX, where XX is a multisite depot.  Tests ordered for patients in this ward 
will always be assigned to the workstations, to which orders from the depot are sent, 
regardless of the ordering region/depot. 

• Collated Printing Schedule: Enter !PSCH xxxx-xxxx-xxxx where xxxx denotes 
hours (in military time) or the selection pattern.  This indicates the schedule when 
the client/clinic will be eligible to have results reported.  A clinic which does not 
match the scheduled parameter will be skipped from the collated run. 
EXAMPLE: 
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!PSCH 0700-1500-1700 means that results will print for a run for any clinic 
with this tag/parameter at 0700, 1500, and at 1700 from the collated 
scheduler.  This occurs daily since no days were specified. 
!PSCH MON-FRI:0800-1600-1800,SAT:1600 means that the client/clinic 
results will print Monday through Friday at 0800,1600, and 1800, on 
Saturday only at 1600, and no results will  print on Sunday. 

• !CAT XXXXX is the tag that links the Ward/Client to a specific billing rule.  The 
Billing Rules are maintained in the SoftA/R main menu, selection 5-Setup, Billing 
Rules.  These rules are explained in Chapter Five of the SoftA/R User Manual.  
Each Ward/Clinic-CLIENT that will be billed through SoftA/R must have a tag on 
the Ward Profile line. 

If a patient is admitted without a medical record number (MRN) and/or a billing number, 
you can automatically generate them by entering !NOMRN in this field.  THIS TAG HAS 
THE SAME RESULT AS ENTERING Y IN THE Generate MRN FIELD.  This may occur 
with a specific clinic which does not follow the normal admission process or when the HIS 
ADT is down for a period.  The system will provide a sequential number in the MRN field 
and/or the billing number field if required.  When the correct MRN is available, you can 
merge the two records using the Patient Maintenance file option.  Requires Hosparam 
setting. 

Codes Button 
The Codes button enables you to add or modify codes.  Click the Codes button to add or 
modify codes.  This is used for bar coding a label and is defined on the last line only (shifts 
barcode from left to right on label). 

Contact Information 
After entering information into the fields of the Ward tab, click the Address and communication 
parameters tab.  The Contact Information screen will display similar to Figure 6-25. 

 
Figure 6-25.  Address and Communication Parameters 

 



SoftPath GUI v.4.2.1 User Manual Chapter 6.1 – Setup: Setup Files 

PATH4.2-G-U (6th Ed, Rel. 01/31/07)   Page 6-47 

Accessing Ranges 
To access the Ranges window click on the Ranges tab.  The Ranges window (under the Edit option) 
displays similar to Figure 6-26.  This is the same Ranges window that appears when you select the 
Ranges option in the Individual Tests Setup file.  The window allows you to edit established numeric 
test ranges for this clinic without leaving the Wards/Clinics setup.  The modifications made from the 
Wards/Clinics file are applied to the specific test performed on a specific workstation as specified in 
the Individual Tests file. 

 
Figure 6-26.  Ranges Window 

NOTE: To access the Ranges option while in Wards/Clinics, you MUST be in Edit mode with a 
record selected.  Click on the Ranges tab to open the Test/Workstation window. 

ID  
Enter the ward ID. This field displays as read only unless you are adding a new record. 

Name  
Enter the name of the ward. This field displays as read only unless you are adding a new 
record. 

Test 
Enter the test ID as defined in the Individual Tests Setup file, or click on the dynamic list 
button to display a list of valid test IDs and select one to insert in this field. 

Workstation 
Enter the workstation as defined in the Individual Tests Setup file, or click the dynamic list 
button to display a list of workstations and select one to insert in this field. 
NOTE: Be sure the entry is appropriate for the Test ID entered in the preceding field and 

that Individual Test. 
Once the test ranges are displayed, you can edit the clinic-specific lines only. 
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Tips for Wards/Clinics 
Auto report 

The System selects the appropriate level (1-5) and the printer as follows: 
Individual Test Level 
1. Individual Test - This level is used to autoreport at test level (not marked order, 

clinic or priority).  The printer is selected first by clinic then by the autoreporting 
default printer. 
NOTE: A single test within an order qualifies the entire order when the test is 

resulted and verified. 
Clinic or Doctor Level 
2. Ward/Clinic is the third level.  A specific printer for this clinic can be defined on 

either of the Ward profile fields as follows: 
!PR XXX, where 
a) XXX denotes the first three characters of the printer's name. Each time an 

order that qualifies for autoreporting is resulted/verified, a single-sheet report 
is generated to this printer. 

b) The Ward/Clinic printer overrides the default printer from the Hosparam, but 
is superseded itself by the printer defined in the Order Entry screen (Level 1). 

3. The system defaults to the Doctor level, if defined and the patient Stay-Clinic is not 
defined at the Ward/Clinic level.  The printer must be defined, as on the Clinic file, 
on either of the profile fields (prof) in the Doctor's file as follows: 
!PR XXX, where 
a) XXX denotes the first three characters of the printer name or FAX ID. 
b) The report prints on the requesting doctor's printer if no printer is defined for 

the order or for the Ward/Clinic. 
Priority Level 
4. The final level is the Hosparam priority definition e.g., autoreport Stats only.  

First, this level looks to the Clinic printer, then to the Doctor's printer and third, to 
the default printer to select the printing destination. 

Default Printer 
5. If the printer is not selected in Order Entry and there is NO Clinic or Doctor printer 

defined, then the orders for this Clinic that qualify for autoreporting will print to the 
default printer. 
a) Notify SCC of the name of the default printer to be defined in Hosparam. 
b) This default situation for autoreporting is superseded by any printers as 

described in Levels 1, 2, and 3.. 
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Doctors File 

The Doctors File stores the demographic information regarding the orders placed by physicians to 
the laboratory. Doctors who do not order tests on a regular basis do not require a definition. They are 
referred to as Auxiliary Physicians and their demographic information can be entered during 
specimen registration.  
To access the Doctors File, select Setup > Setup Files > Doctors File from the main menu. The 
system bridges you to the SoftLab system and displays the (SoftLab) Doctors window. 
NOTE: Accessing the Doctors file bridges you to the SoftLab GUI or SoftLab ASCII 

application, depending on environmental variables. For further details, refer to the 
appropriate SoftLab Setup Manual. 
• SoftLab GUI is called when the HAS_GLAB hosparam equals Y. 
• SoftLab ASCII is call when the HAS_GLAB hosparam equals N. 

With the Doctors screen displayed, enter data in each applicable field.  All other fields are described 
below in the order they appear on screen. 

General Tab 
Doctor 

ID 
Enter alphanumeric characters for physician’s ID code.  Click the button to the right 
side of the First ID field to display a dynamic list of previously defined codes.  
Select a code (by clicking it once) and click OK or highlight the code and press 
ALT+O.  The First ID may be used to SORT reports.  

Second ID  
Enter another identification code used to identify this doctor.  This cross-reference 
number may be one that is used on another computer system (e.g., HIS).  This field 
may be optional per HIS specifications.  Maximum 15 alphanumeric characters. 

Third ID  
Enter another identification number used to identify this doctor.  This cross-
reference number may be one that is used on another computer system.  This field 
may be optional per HIS specifications.  Maximum 15 alphanumeric characters. 
NOTE: Please consult SCC and your HIS specialist before choosing to use 

the second and third ID for cross-referencing.   
Last  

Enter the physician’s last name in this field.  Maximum 19 characters. 
First  

Enter the physician’s first name in this field.  Maximum 15 characters. 
Middle  

Enter the physician’s middle initial in this field.  One alpha character. 
Active 

Select Active or Not Active by using the list box to the right of the field. 
License # 

Enter the physician’s medical license number in this field. Maximum 10 
alphanumeric characters. 
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Title 
Enter the physician’s title in this field.  This is an optional field.  Maximum 14 
characters. 

Type  
Enter the user-defined code to describe the specialty of the doctor.  This is an 
optional field.  Maximum 3 alphanumeric characters.   

Service type  
Enter an HIS code for SoftBank transfusion reports, or enter a user-defined type of 
service provided by the doctor (optional).  Maximum 15 characters. 

Main Ward ID 
Enter the ID code of the main clinic, which serves as the primary location for the 
doctor.  Maximum 5 alphanumeric characters.  This code is used in one of the 
following two ways: 
1. Sorting Batch report job by Clinic: (If the doctor has a Main Ward ID 

filled in , the Main Ward address (from clinic file) will be printed on 
doctor's banner page). 
a) The main copy looks to the clinic field for a printer destination, not 
to the requesting doctor field. 
b) The requesting doctor has more than one location or office and you 

want duplicate copies for patient type(s) to print with the Main 
Clinic address. 
• The clinic code must be defined under the ward/clinic setup 

with the appropriate address. 
• The DUPPT tag can be used to print an additional copy to 

requesting doctor.   
• The Main Ward ID and DUPPT are used by collated reports. 

 
• A duplicate copy of Final/Single-sheet Collated reports can be 

generated with the Main Clinic address on the report rather than 
the doctor address for specified patient type(s).  (see Profile 
field Help). 

2. When using the collated/merge report program, if a Doctor is defined with a 
Main Clinic ID, and the Doctor is listed in Order Entry as a Report-to doctor, 
then the address/printing destination for the doctor comes from the main clinic 
in Ward/Clinic file setup, not from the Doctor file. 

Name 
Once the Clinic ID field has been defined, the Name field will display the name of 
the clinic.  This name will appear on single sheet (RR format) reports.  The name 
however, does not print on cumulative (CR format) reports. 

Area 
Once the Clinic ID field has been defined, the Area field will display the unique 
code used to identify the location of the clinic and where reports will be printed. 
 

Insurance ID 
Enter up to four insurance company names associated with this doctor.  Four fields, 
maximum 5 alphanumeric characters each. 
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Provider # 
Enter a doctor provider number for each insurance company entered in the corresponding 
Ins. Field.  Four fields, maximum 11 alphanumeric characters each. 

Additional Information 
Enter optional free text about each insurance company entered in the corresponding Ins. 
field.  This is for informational use only.  Four fields, maximum 19 alphanumeric 
characters each. 

Number of Report Copies 
Enter the number of copies of each report normally required by the doctor (0-9).  This does 
NOT apply to the Instant Report option using the accent (`) keystroke from Order Entry, 
Query, etc.  Maximum 2 numeric characters. 

Courier route  
Enter the route identification number used for specimen pickup.  This field is also used as a 
filtering criterion for collated reports.  Maximum 5 characters. 
NOTE: Q requesting Dr., -j attending doctor (used like area in clinic) restricts run to 

only doctors in the selected route. 
Doctor's schedule 

Enter the doctor's schedule, office hours, and/or regularly scheduled office hours, using days 
and hours (e.g., MON 0900-1400).  Optional field for INTERNAL information only.  
Maximum 47 characters. 

Pickup schedule  
Enter the specimen pickup schedule and/or special instructions for this doctor.  Optional 
field for INTERNAL information only.  Maximum 47 characters. 

Profile 
Enter any additional internal information not defined in previous fields.  Two lines, 
maximum 70 alphanumeric characters per line. 

Codes 
To access the Codes window, click on Codes or press ALT+C.  The Codes window 
displays similar to Figure 6-27.  To use the Codes window, hit the dynamic arrow or press 
the UP/DOWN ARROW keys to bring forth the code. 

 
Figure 6-27.  Codes window 
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Name 
Select the code from the Name list box to the right of the field.  You can use the 
mouse or arrow down to the name you want. 

Value 
Enter the value you would like to associate with the code.Your selection will appear 
in the box.  Click OK or ALT+O to return to the Doctor Setup window. 

EXAMPLE: 
Order Entry Keypad:  Enter !OK OEXXX to generate a keypad in Order-Entry, 
when this Doctor is the Requesting Doctor. The keypad must be defined in Keypad 
Setup as OEXXX, where XXX are three characters specific to this doctor/keypad.  

Advanced Beneficiary Notice (ABN) Print Destination 
PRC XXX (PRC-is the code and XXX is the value).  To specify the printer to which 
an ABN should print, where XXX represents the first three characters of the printer 
name. 

Autoreporting Print Destination 
PRXXX (PR is the code XXXis the value).  To specify the printer to which 
autoreporting will send reports, where XXX represents the first three characters of 
the printer name. 
To use autoreporting for doctors, set the Print copies for additional doctor Flag to 
Y in the autoreporting Interface Setup (see the SoftLab User Manual). 
NOTE: If the Report to field in Order Entry (see Order Entry in the SoftLab 

User Manual) contains any doctor codes, and if any of these doctors 
have the !PR tag defined in their setup records,  the Autoreporting 
program will generate copies to both the ward printer and the doctor 
printer (if no printer is defined for either the doctor or ward, the 
reports print to the default printer). 

Call List Instruction Message 
CALLMxxxxx(CALLM is the code and xxxxx is the value) where xxxxx represents 
a canned Message ID known as a call instruction.  The comment appears on the Call 
window in the call list when you press the instruction button. 

Call List Instruction Schedule 
CSCH xxxx(where CSCH is the code and xxxxx I the value).  Enter a tag using the 
!CSCH xxxxx... format to indicate the hours that the doctor can be called with the 
results.  Calls outside the time parameters are skipped. 
EXAMPLE: 

!CSCH 8-1300, 1430-1730 means that the doctor can be called 
between 8:00 a.m.- 1:00 p.m. and from 2:30 p.m. - 5:30 p.m. 

NOTE: Any result that is verified outside the schedule (for doctor or clinic) 
will be held until the schedule reopens the doctor or clinic selection 
option.  Reopens means the schedule begins again (e.g., the next 
day).  In other categories of call list (e.g., inpatient), verified results 
can still be located during the hours excluded by the schedule 
category. 
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Collated Reports 
CHPR xxx (where CHPR is the code and xxx is the value).  To define the printer for 
collated reports, where xxx represents the first three characters of the printer name. 
NOTE: Primary sorting criteria MUST be by doctor to link to this comment-

tag. 

Duplicate Copy of Single-Sheet/Finalized Discharge Reports 
DUPPT xxx(where DUPPT is code and xxx is the value).  To define the patient 
types that will generate duplicate report copies to be sent to the requesting doctor's 
main clinic, enter a code, where each x represents a separate patient type (e.g., 
DUPPT O or DUPPT IOE). 
NOTE: This option applies to Single and/or Cumulative Discharge reports, 

collated or non-collated. 
The Main Clinic ID field must be completed to tell SoftLab which clinic is to 
receive these duplicate reports. 
In the Wards/Clinics Setup file, you MUST define the main clinic, and the record 
must include the tag !PR (which tells SoftLab which printer to select when 
generating these duplicate reports). 

Order Entry Keypad 
OK OExxx (where OK is the code and Oexxx is the value.)  If this doctor is the 
requesting doctor with a special profile or ordering scheme, you can create and 
attach a keypad with specific tests for Order Entry purposes. (Format where xxx 
represents the keypad code.) 

Report Format/Layout (RC and RR where Rc and RR are the codes and xxx is 
the report format/layout) 

The report format/layout should be complete before entering these codes.  You must 
define the tags and format.  You can select a specific format and/or layout specific to 
the doctor.  You must sort by Doctor first within a batch report job (e.g., DCN 
(Doctor-Clinic-Patient name)) to use these: 

a) Enter !RC followed by the report format (e.g., !RC RR2) 
b) Enter !RR layout (e.g., !RR RL2) where RR2 and RL2 are NOT 

default format/layout.  If both tags are used, then you MUST 
separate them by a semicolon (;).  This doctor-tag is superseded by 
the same tag linked on a clinic basis ONLY when using 
autoreporting. 

If additional tests are to appear on the doctor's request sheet, you can list the test 
codes. 
NOTE: Use of these tags is required when using autoreporting in a Multisite 

system. Each layout is hard-coded with the correct layout address 
per the reporting facility.Code NLB – For Clients with a Libra data 
file installed 

If the flag “DoctorIsNotQualifiedToBeSeenInLibraDataFile” is checked: enter NLB 
X where X is any symbol.  If order will be reported for LIBRA processing but 
doctor will have this tag set, then such doctor will be excluded from the Libra data 
file.  
NOTE: If more than one tag is defined on the profile line, the tags must be 

separated by a comma (;). 
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Contact Information Tab 
You may enter further information per doctor such as a fax number, pager number, or E-mail 
address.  Click the Contact Information tab or you may tab to display a screen similar to 
Figure 6-28. 

 
Figure 6-28.  Contact Information tab 

All fields are described in the order that they appear as information pertaining specifically to 
the doctor. 
Street 

Enter the complete street address.  Maximum 23 alphanumeric characters. 
City 

Enter the city as part of the address.  Maximum 15 alphanumeric characters. 
State 

Enter the appropriate state abbreviation as a part of the address.  Maximum 2 alpha 
characters. 

Country 
Enter the country as part of the address.  Maximum 35 alphanumeric characters. 

Zip 
Enter the zip code as part of the address.  Maximum 9 numeric characters. 

Contact 
Enter the Contact person’s name.  Maximum 47 alphanumeric characters.  

E-mail 
Enter the e-mail address.  This is for Internal use only. 

Phone 
Enter the phone number, including the area code.  Maximum 10 numeric 
characters. 
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Ext 
Enter the extension number.  Maximum 12 alphanumeric characters. 

Fax 
Enter the full fax number, including the area code.  This fax number will appear in 
the call list.  Maximum 10 numeric characters using the (xxx) xxx-xxxx format. 

Alt. Phone 
Enter an alternate phone number, including the area code.  Maximum 10 numeric 
characters. 

Ext. 
Enter the extension number for the alternate phone number.  Maximum 12 
alphanumeric characters. 

Modem 
Enter the full telephone number for the doctor's modem (including the area code).  
Maximum 10 numeric characters using the (xxx) xxx-xxxx format. 
NOTE: This is strictly internal documentation.  SoftLab does not look to 

this modem definition for reporting. 
Auto Printer 

To select an auto printer, use the dynamic list button . 
Batch Printer 

To select a batch printer, use the dynamic list button . 
Pager 

Enter the full pager number, including the area code.  Maximum 10 numeric 
characters using the (xxx) xxx-xxxx format.  This is for internal use only. 

Duplicate Copies to Requesting Dr. 
The DUPPT tag can be used to print an additional copy to requesting doctor.  To get an 
extra copy to requesting doctor: 
1. Add DUPPT <patient_types> .   

a. Patient's clinic type must match one of DUPPT patient types.   
b. Patient's clinic must have "chart available for duplicate copy" set to Y.   
c. Only final reports get duplicates.   
d. Duplicates are sent to CHPR printers  (not to clinics).   
e. Requesting dr flag -ENYNNNN controls DUPPT duplicates. 

EXAMPLE: 
Order# A0000001 req.by D0001 ward C0001 status FINAL 
D0001 doctor profile: !CHPR D01; !DUPPT O; 
C0001 clinic type O profile: !CHPR C01; 
Collated report flag: -ENYNNNN sort by C 
Expected result: 

Order A0000001 prints two copies. First copy is sent to printer C01 and has clinic's C0001 banner.  
Second copy is sent to printer D01 and has doctor's D0001 banner. 
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Storage File 

The Storage File option allows you to define where the specimens, blocks, and slides are to be 
stored. This also allows you to determine the details of the Storage file setup. You can have either a 
separate storage record for each storage area or a separate record for each shelf or box in each 
storage area. 
To access the Storage file, select Setup > Setup Files > Storage File from the main menu. The 
Storage Lookup window will display. To add a new storage location, click Add Record and the 
Storage File Setup window (Figure 6-29) is displayed.  

 
Figure 6-29. Storage File Setup Window 

Code  
Enter a unique acronym to identify the storage location. Maximum 5 alphanumeric 
characters. 

Active 
A checkmark is displayed in the box to indicate an active storage file.  To inactivate a 
storage file record, select the check box. 

Name  
Enter the full name of the storage location. Maximum 35 alphanumeric characters. 

Type of Material 
Select the type of material you want to store in this storage area. Mark the Block Storage, 
Specimen Storage, or Slide Storage check box. The available selections are defined in the 
Setup > Simple Codes > Storage Location Type option. 

Description 
Enter a description of the storage area. This is a free text field. 
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Insurances  

The Insurances option allows you to define specific information regarding each insurance carrier 
that has transactions with the laboratory. This information is used to establish and maintain billing 
records for the laboratory. 
Access the Insurances file by selecting Setup > Setup Files > Insurances from the main menu. The 
system bridges you to the SoftLab system and displays the (SoftLab) Insurances Setup window. 
NOTE: Accessing the Insurances file bridges you to the SoftLab GUI or SoftLab ASCII 

application, depending on environmental variables: 
• SoftLab GUI is called when the HAS_GLAB equals Y. 
• SoftLab ASCII is called when HAS_GLAB equals N. 

With the Insurances window displayed, enter data in each applicable field.  Fields are described 
below in the order they appear on the window. 
ID 

Enter a unique code to identify the insurance company.  Click the arrow button to display a 
dynamic list of all previously defined codes (e.g., BCBS, EQC, METL, PRUD) or press F2, 
use the UP/DOWN arrow keys and then press ENTER.  Maximum 5 alphanumeric 
characters. 

Name 
Enter all information required for this insurance type.  Maximum 30 alphanumeric 
characters. 

Active 
Click the drop-down list button or use the UP/DOWN arrow keys to select Active to 
activate or select Inactive to deactivate the insurance company in the system.   
You may also select All to include both active and inactive records. 

Address 
Enter the mailing address of the insurance company.  2 lines, 22 characters each line. 

City 
Enter the city in which the insurance company is located. 

State 
Enter the state in which the insurance company is located. 

ZIP 
Enter the zip code of the insurance company location. 

Phone 
Enter the phone number of the insurance company. 

Second Phone 
Enter the secondary phone number of the contact or the insurance company. 

A/R Only 
For A/R use only.  Not used for A/R GUI. 
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Price schedule   
Enter the price schedule for this specific carrier.  This is a NUMERIC category code.  
Maximum 2 characters. 
The price schedule code must also appear in the Individual/Group Test file setup: 

• Click on the Prices tab. 
• Go to appropriate Carrier code (Party). 
• Go to Sch field, and enter the schedule code for this carrier, as defined in 

Insurance File setup.  Default is set to 0. 
Default category code is 0.  We do not recommend multiple price schedules, since you can 
use Price Redirection.  However, multiple price  schedules can be accommodated 

Contact 
Enter the name of the person who is the primary contact for the Insurance carrier. This is a 
free-text entry field.  Maximum 40 alphanumeric characters.  

Provider number  (For SoftA/R only – not used for GUI A/R) 
Enter the designated provider number for this Insurance carrier.  Maximum 11 
alphanumeric characters. 

InsNo format 
Enter the insurance number format to indicate the syntax that a carrier requires for ID 
numbers in the Patient Maintenance file. Medicare, for example, requires that a person’s 
Social Security Number be used with an A, B, C, or D suffix, e.g. 111223333A.  If incorrect 
data is entered, the message “Wrong Syntax for this Insurance” will display. 

Payor ID (Not used for GUI A/R) 
This field is required for SoftA/R only.  Enter another Insurance code that will appear on the 
insurance claim form.  Maximum 9 alphanumeric characters.  Usually required for NEIC 
only. 

Office ID  (Not used for GUI A/R) 
This field is required for SoftA/R or Electronic Billing only.  Used for NEIC electronic 
claim filing.  Office ID is the payer office.  Maximum 9 alphanumeric characters. 

ECS format  (Not used for GUI A/R) 
Electronic Claim Status.  This field is required for SoftA/R when the Electronic claims ‘flag’ 
is checked.  Click the dynamic list button to display a dynamic list of all previously defined 
codes.  To enter a code, double-click an entry or click once and click enter. 

Biller 
Click the drop-down list button to select a biller/collector to be assigned to the carrier.  Used 
in conjunction with the Ward/Clinic Collector field- 
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Flags 
Click the Flags button to display the Insurances Flags window or tab to the field, then press 
the SPACEBAR.  An example of the window is shown in Figure 6-30. 

 
Figure 6-30.  Insurance Record Flag Window    

Set all applicable flags as follows: 
NOTE: Fields that state they are needed “For SoftA/R only” are ONLY used for the 

ASCII based A/R system, not the New GUI A/R.  
 

Electronic claims  (For SoftA/R only) 
Click the check box to file this carrier's claims electronically.  This field can be chosen even 
if the Paper claims field is also selected. 

Paper claims  (For SoftA/R only) 
Click the check box in order to print claims on paper when billing this carrier.  This field can 
be chosen even if the Electronic claims field is also selected. 

Other in aging  (For SoftA/R only) 
When printing the aging report, this carrier can be reported in the same category as all other 
carriers (PRINS) or in a separate category.  Click the check box if you want it reported in a 
separate category. 

Remittance  (For SoftA/R only) 
Click the check box to receive payment (remittance) electronically from this carrier. 

Client billing  (For SoftA/R only) 
Click the check box to send monthly statements to this carrier.  Enter T if you want special 
billing statements with totals by procedure instead of detail by invoice.  Can only select or 
not select with check box. 

Redirect to PRINS  (For SoftA/R only) 
Click the check box to redirect all CPT codes and prices to the PRINS (Private Insurance) 
price schedule for billing. 

Automatic write off   
Not currently in use.  
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Co-payment required  (For SoftA/R only) 
Click the check box if this carrier requires a co-payment. 

Value 
If the Co-payment required flag is selected, enter the amount of the co-payment (e.g., 
$5.00, $10.00, etc.) in this field. 

MEDIGAP accepted  (For SoftA/R only) 
Click the check box if this carrier participates in the MEDIGAP insurance plan. 

MG# 
If the MEDIGAP accepted flag is selected, enter the MEDIGAP policy number in this field. 

Collect money at Order Entry 
Click the check box if the patient's account has gone to a collection agency.  At Order Entry, 
a message automatically displays to advise you to contact the business office or collect 
money.  This message is user-definable, but is programmed by SCC. 

Skip insurance from HIS bill (dep) 
Click the check box to indicate that certain departments will be skipped from HIS billing.  
(Contact SCC personnel as a Hosparam setting is involved.)  Leaving this flag unchecked 
indicates that all departments are to be included in HIS billing.  Refer to Labparam 
(BILL_skip_dep_insurance). 

Skip insurance from HIS bill (tot) 
Click the check box to indicate that this insurance will be skipped from HIS billing.  Leaving 
this flag unchecked indicates that this insurance will be included on all HIS billing. 

Print ABN form 
Click the check box to indicate that an ABN form should be printed when Medical Necessity 
Checking criteria is not met.  Leave blank if an ABN form is not required. 

Accept assignment  (For SoftA/R only) 
Click the check box to indicate that the client accepts assignment by carrier. 

Diagnosis mandatory 
Click the check box to prohibit saving an order in which the diagnosis has not been entered. 
Works in conjunction with the Hosparam OE_ptype_reqdiag and the Diagnosis Required 
at Order Entry Flag in Individual and Group Test setup.  Leaving this flag unchecked 
indicates that the order can be saved without a diagnosis. 

Check for Medical Necessity 
Click the check box to perform Medical Necessity Checking, as defined in Hosparams 
OE_ptype_reqdiag and OE_ptype_mednec, the Diagnosis Required at Order Entry Flag, 
and Allowed/Not Allowed diagnosis setup in Individual and Group test setup.  Leaving this 
field unchecked indicates that Medical Necessity Checking is not required. 

Can charge venipuncture  (For SoftA/R only) 
Click the check box to bill this Insurance carrier for a venipuncture. 

Insurance tax flag (For SoftA/R only) 
Click the check box to add a tax amount to a test price.  When checked, the group box 
containing expiration date and tax fields will alter to accept entry. 
Leaving this flag unchecked indicates no tax amount should be added to the test price and 
the expiration date and tax fields will not be accessible. 

Exp. Date and Tax 
If the Insurance tax flag is selected, enter the expiration date(s) in the Exp. Date field(s) 
and the tax amount(s) in the Tax field(s). 
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Venipuncture default  (For SoftA/R only) 
Charge Venipuncture 

Click the check box following Charge Venipuncture.  You should ALWAYS charge 
for venipuncture for this carrier. 

Charge Travel 
Click on the check box to insert a check mark in this field if the carrier will be 
charged for travel, or leave unchecked if the carrier will not be charged for travel.  

Diagnosis required at Order Entry 
These flags determine the level at which a diagnosis is required.  Click the appropriate check 
box if a diagnosis is required at the Order level or the Test level.  If a diagnosis is required at 
both the Order and Test levels, click both check boxes.  If a diagnosis is not required, leave 
both flags unchecked. 
When a diagnosis is not entered at the appropriate level, a warning will be generated, 
however, the order will be saved. 
The Diagnosis Required at Order Entry Flag works in conjunction with the Diagnosis 
Required at Order Entry Flag in Individual and Group Test setup. 

Once you are finished setting the appropriate flags, click or tab to the OK button to return to the 
Insurances window. 
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Consultants File 

The Consultants File option allows you to define the consultants, consultant firms, and facilities that 
regularly send or receive specimens, blocks, and slides to or from the laboratory. Each facility should 
be defined as a separate Consultants file record for all materials received from or sent out to an 
outside facility. 
To access the Consultants File option, select Setup > Setup Files > Consultants File from the main 
menu. The Consultants File Lookup window will display. Click Add Record to add a new 
consultant record and the Consultants File Setup window (Figure 6-31) is displayed.  

 
Figure 6-31. Consultant File Setup Window 

Code 
Enter a unique acronym to identify this consultant. Maximum 5 alphanumeric characters. 

Name 
Enter the full name of the consultant as you want it to appear in lookup windows and 
management reports. Maximum 35 alphanumeric characters. 

Out 
Mark this check box if the materials are normally sent from the laboratory to the outside 
consultant. 

Letter Code (Out) 
Click the  button to display the Letter Lookup by Type window. Select the desired 
default letter from the list. The letter entered in this field is used by the system to select the 
default letter when this consultant is used in the Outgoing Consultations option. 

In 
Mark this check box if the materials are normally received from this outside consultant for 
processing in the laboratory. 
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Insurance Form 
Mark this check box to print an insurance form to accompany this consultant’s request. 
NOTE:  Insurance forms that must accompany the request can be created in the Define 

Letters option. 
Letter Code (In) 

Click the  button to display the Letter Lookup By Type window. Select the desired 
default letter from the list. The letter entered in this field is used by the system to select the 
default letter when this consultant is used in the Incoming Consultations option. 

Location 
Enter the consultant’s mailing address as you want it to appear on envelopes and 
correspondence. Maximum 5 lines. 

Phone 
Enter the consultant’s phone number using the format (xxx) xxx-xxxx. Maximum 10 
numeric characters. 

Ext 
Enter the consultant’s telephone extension.  

Fax 
Enter the consultant’s fax number using the format (xxx) xxx-xxxx. Maximum 10 numeric 
characters. 

Letter Code (Ins) 
Click the  button to display the Letter Lookup By Type window. Select the default 
insurance form from the list. 

Comment 
Enter any fees, consultants, specialties, or any other comments that may pertain to this 
consultant. Maximum 68 alphanumeric characters. 

Active 
A checkmark is displayed in the box to indicate an active consultants file.  To inactivate a 
consultants file record, select the check box. 
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Canned Messages 

The Canned Messages option allows you to define standard text inserts. The canned messages can 
be defined for use in many areas to expedite the entry of text into the system. 
To access the Canned Messages option, select Setup > Setup Files > Canned Messages from the 
main menu. The Canned Message Lookup window will display. To create a new canned message, 
select the case type that you want and then select the type of message you want to create from the 
Message drop-down list. Click Add Record to create a new canned message. You may also define 
which document section to associate the new canned message with using the same Message drop-
down list. Document Sections are defined in Chapter 6.9 – Setup: Document Files. The Canned 
Messages Setup window (Figure 6-32) for the selected case type and functional class is displayed. 
The selected case type and functional class displays at the top of the window. Message type varies 
with case type selection. 

 
Figure 6-32. Sample Canned Message Setup Window  

The default format for canned messages is Rich Text. Rich text canned messages are created for all 
text that will be inserted in data entry fields  (e.g., comments and information fields). Complete the 
following fields in the Canned Messages Setup window: 
ID 

Enter a unique acronym to identify this canned message. 
Title 

Enter the title of the message. 
Text 

Enter the text of the message in the displayed box. Use the displayed formatting buttons to 
format the body of the text, as needed. Stop characters, a defined character that causes the 
cursor to stop, can be inserted into the text of a canned message. The system uses the vertical 
bar character ( | ) to mark stop points in the canned message; press Tab to move between 
stops. The stop characters ( | ) are removed when the message is imported into the document. 
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MS Word Format Button 
Canned messages in MS Word format can be created for all text such as a final diagnosis, gross 
description or IOC that will be inserted into a MS Word document in SoftPath. 
After entering the canned message ID and title, click the MS Word Format button to access 
Microsoft Word. The system will prompt you to save the record.  
The top of the window displays basic information (such as code, title, case type and message) for the 
canned message. Enter any text, add graphics, and apply any other formatting that is required. Full 
MS Word functionality is available. 
When all of the text entry is complete, click Save on the MS Word toolbar. Return to the Canned 
Message Setup window by closing the window. The system marks the check box next to the MS 
Word Format button, indicating that the text has been entered in Word format. 
NOTE: A canned message can be entered in either rich text or MS Word format, but not as both. 

Once a canned message has been created, you cannot change the format unless you 
delete and re-create the message in the new format. 
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Dictionaries 

 
Figure 6-33. Setup Menu - Setup Files Submenu – Dictionaries 

The Dictionaries contain the following options: 
• DRG Codes 
• ICD9 Codes 
• SNOMED Codes 
• Bethesda Codes 
• Canned Dx Codes 
• Diagnosis Groups 
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DRG Codes 
The DRG Codes option allows you to maintain a dictionary file of standard DRG codes. The 
diagnoses of the different case types can be coded within this system. 
To access the DRG Codes option, select Setup > Setup Files > Dictionaries > DRG Codes from the 
main menu. The DRG Lookup window is displayed. To add a new DRG code to the database, click 
Add Record. The DRG Codes Setup window (Figure 6-34) is displayed.  

 
Figure 6-34. DRG Codes Setup Window 

Code  
Enter a unique acronym to identify the diagnosis. Maximum 8 alphanumeric characters. 

Group  
Enter the diagnosis group associated with this DRG code. Click the  button to select from a 
list of valid diagnosis group codes. See page 6-80. 

Qualify as Adequacy Code 
Mark this check box to define the code as an Adequacy code, for QA reporting purposes 

Qualify as Final Dx Code 
Mark this check box to define the code for Final diagnosis. 
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Default Dx Category Grid 
Define a default Dx Category for each case type for the code.  

• Case Type – displays the available case types (Autopsy, GYN Cytology, MED 
Cytology, and Surgical). 

• Dx Category – enter a Dx Category code or click the browser button to select from 
a list of available Dx Category codes. 

• Description – displays the description of the selected Dx Category code.  
Signout Level 

In the Signout Level drop-down list, select the Signout Level to be used when this diagnosis 
is associated with a case. The Signout Level is extremely important since it limits the 
personnel types allowed to sign out the case. 

Text 
Enter the text of the diagnosis. 

Active 
A checkmark is displayed in the box to indicate an active code.  To inactivate a code, select 
the check box. 
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ICD9 Codes 
The ICD9 Codes option allows you to maintain a dictionary file of standard ICD9 codes. The 
Insurance codes for a diagnosis can be coded for different case types in the system.  
To access the ICD9 Codes option, select Setup > Setup Files > Dictionaries > ICD9 Codes from the 
main menu. The ICD9 Lookup window is displayed. To add a new ICD9 code to the database, click 
Add Record. The ICD9 Codes Setup window (Figure 6-35) is displayed.  

 
Figure 6-35. ICD9 Codes Setup Window 

Code 
Enter a unique acronym to identify this diagnosis. Maximum 5 alphanumeric characters. 

Group 
Enter the diagnosis group associated with this ICD9 code. Click the  button to select from 
a list of valid diagnosis group codes. See page 6-80. 

Qualify as Adequacy Code 
Mark this check box to define the code as an Adequacy code, for QA reporting purposes 

Qualify as Final Dx Code 
Mark this check box to define the code for Final diagnosis. 
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Default Dx Category Grid 
Define a default Dx Category for each case type for the code.  

• Case Type – displays the available case types (Autopsy, GYN Cytology, MED 
Cytology, and Surgical). 

• Dx Category – enter a Dx Category code or click the browser button to select from 
a list of available Dx Category codes. 

• Description – displays the description of the selected Dx Category code. 
Signout Level 

In the Signout Level drop-down list, select the signout level to be used when this diagnosis 
is associated with a case. The signout level is extremely important since it limits the 
personnel types allowed to sign out the case. 

Text   
Enter the text of the diagnosis. 

Active 
A checkmark is displayed in the box to indicate an active code.  To inactivate a code, select 
the check box. 
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SNOMED Codes 
The SNOMED Codes option allows you to maintain a dictionary file of standard SNOMED CT 
codes. The diagnoses of different cases can be coded using this system. 
To access the SNOMED Codes option, select Setup > Setup Files > Dictionaries > SNOMED 
Codes from the main menu. The SNOMED Lookup window is displayed. Click Add Record and 
the SNOMED Codes Setup window (Figure 6-36) is displayed for adding a new code.  

 
Figure 6-36. SNOMED Codes Setup Window 

Code  
Enter a unique acronym to identify the diagnosis. Maximum 9 alphanumeric characters. 

Active 
A checkmark is displayed in the box to indicate an active code.  To inactivate a code, select 
the check box. 

Group  
Enter the diagnosis group associated with this SNOMED code. Click the  button to select 
from a list of valid diagnosis group codes. See page 6-80. 

Class  
Enter the code for the English term classification: 
• A primary or preferred term. 
• A synonym of the primary term. 
• A term related to, but not synonymous with the primary term. 
• The adjectival form of the term such as hepatic for liver. This allows for the use of 

automated language analysis. 



SoftPath GUI v.4.2.1 User Manual Chapter 6.1 – Setup: Setup Files 

PATH4.2-G-U (6th Ed, Rel. 01/31/07)   Page 6-75 

Modifier  
Enter a code that identifies the modifier. This applies to records imported from the standard 
SNOMED glossary. 

Default Dx Category Grid 
Define a default Dx Category for each case type for the code.  

• Case Type – displays the available case types (Autopsy, GYN Cytology, MED 
Cytology, and Surgical). 

• Dx Category – enter a Dx Category code or click the browser button to select from 
a list of available Dx Category codes. 

• Description – displays the description of the selected Dx Category code. 
Signout Level 

In the Signout Level drop-down list, select the signout level to be used when this diagnosis 
is associated with a case. The signout level is extremely important as it limits the personnel 
types allowed to sign out the case. 

Text 
Enter the text of the diagnosis. This will display in the report. 
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Bethesda Codes 
The Bethesda Codes option allows you to maintain a dictionary file of the standard Bethesda codes. 
The diagnoses of different cytology case types can be coded with this system.  
To access the Bethesda Codes option, select Setup > Setup Files > Dictionaries > Bethesda Codes 
from the main menu. The Bethesda Lookup window is displayed. Click Add Record and the 
Bethesda Codes Setup window (Figure 6-37) is displayed for addition of a new code.. 

 
Figure 6-37. Bethesda Codes Setup Window 

Code  
Enter a unique acronym to identify the diagnosis. Maximum 9 alphanumeric characters. 

Group  
Enter the diagnosis group associated with this Bethesda code. Click the  button to select 
from a list of valid diagnosis group codes. See page 6-80. 

Qualify as Adequacy Code 
Select this check box to define the code for QA reporting purposes as an Adequacy code. If 
selected, the code will qualify for the Bethesda Adequacy Comparison Report. 

Qualify as Final Dx Code 
Select this check box to define the code for QA reporting purposes as a Final Diagnosis 
code. If selected, the code will qualify for the Bethesda Final Diagnosis Comparison Report. 
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Default Dx Category Grid 
Define a default Dx Category for each case type for the code.  

• Case Type – displays the available case types (Autopsy, GYN Cytology, MED 
Cytology, and Surgical). 

• Dx Category – enter a Dx Category code or click the browser button to select from 
a list of available Dx Category codes. 

• Description – displays the description of the selected Dx Category code. 
Signout Level 

In the Signout Level drop-down list, select the signout level to be used when this diagnosis 
is associated with a case. The signout level is extremely important as it limits the personnel 
types allowed to sign out the case. 

Text 
Enter the text of the diagnosis. This text will display in the final report. 

Dx Setup Descriptor 
The Dx Setup Descriptor allows the user to enter a description for the code that will display 
in the browser and is different than the text of the code. 

Active 
A checkmark is displayed in the box to indicate an active code.  To inactivate a code, select 
the check box. 
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Canned Dx Codes 
The Canned Diagnosis Codes dictionary is user-defined. It has a tree-like structure where any code 
can be a parent for other codes. Canned Diagnosis Codes can be defined separately for each case 
type.  
To access the Canned Diagnosis Codes dictionary, select Setup > Setup Files > Dictionaries > 
Canned Dx Codes from the main menu. The Canned Diagnosis Lookup window will display. To 
add a new canned diagnosis code, select the case type from the Case Type drop-down list and click 
Add Record. The Canned Dx Codes Setup window (Figure 6-38) is displayed.  

 
Figure 6-38. Canned Dx Codes Setup Window 

Code 
Enter a unique acronym to identify the diagnosis. Maximum 5 alphanumeric characters. 

Parent 
If applicable, enter the parent diagnosis code. This code MUST be defined in the Canned 
Diagnosis Codes dictionary. Click the  button to select from a list of valid canned 
diagnosis codes.  

Group 
Enter the diagnosis group associated with this canned diagnosis code. Click the  button to 
select from a list of valid diagnosis group codes. See page 6-80. 

Default DX Category 
Enter the default Dx Category code or use the browser button to select from a list of 
available codes.   
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Sign out Level 
In the Signout Level drop-down list, select the sign out level to be used when this diagnosis 
is associated with a case. The signout level is extremely important as it limits the personnel 
types allowed to sign out the case. 

Text  
Enter the text of the diagnosis. 

Dx Setup Descriptor 
The Dx Setup Descriptor allows the user to enter a description for the code that will display 
in the browser and is different than the text of the code. 

Active 
A checkmark is displayed in the box to indicate an active code.  To inactivate a code, select 
the check box. 
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Diagnosis Groups 
Diagnosis groups are not specific for any case type or coding system. Each diagnosis code from the 
different selected coding systems should have a diagnosis group code assigned to it for reporting 
reasons. SoftPath uses the diagnosis group or diagnosis category to determine whether the final 
diagnosis represents normal or abnormal findings. 
To access the Diagnosis Groups option, select Setup > Setup Files > Dictionaries > Diagnosis 
Groups from the main menu. The Diagnosis Group Lookup window will display. To add a new 
diagnosis group to the database, click Add Record. The Diagnosis Groups Setup window (Figure 
6-39) is displayed.  

 
Figure 6-39. Diagnosis Groups Setup Window 

Code  
Enter a unique acronym to identify the diagnosis group. This code will be entered in the 
diagnosis code record. Maximum 5 alphanumeric characters. 

Description 
Enter a description of the diagnosis group. Maximum 60 alphanumeric characters. 

Abnormal 
Mark this check box if the diagnosis group result represents an abnormal result. Unmark this 
check box if the result represents normal findings. 

Signout Level 
The signout level associated with the diagnosis group is used by the system unless a signout 
level is associated with a diagnosis code that is included in the group. This allows for 
permissions to be set up at the group level while still allowing special circumstances and 
signout conditions for individual diagnosis codes. 

Active 
A checkmark is displayed in the box to indicate an active diagnosis group.  To inactivate a 
diagnosis group, select the check box. 
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Organs File 

The Organs File option allows you to define which organs, bones, and body weight fields are to be 
used in the SoftPath autopsy functions. 
To access the Organs File option, select Setup > Setup Files > Organs File from the main menu. 
The Organs File Setup window (Figure 6-40) is displayed.  

 
Figure 6-40. Organs File Setup Window 

Select the option (organs, body weight, or bones) you want to define from the Option drop-down 
list. Click New on the SoftPath toolbar to enter new Organs file information. 
Code 

Enter the element code. Maximum 2 alphanumeric characters. 
Description 

Enter the description that you want to appear in lookup windows and reports. Maximum 50 
alphanumeric characters. 

Measure 
Select a unit of measurement from the drop-down list. Choices are centimeter, gram, 
kilogram, millimeter, milligram, and meter. 

Def Curves Area 
These fields are used to define the normal values for an age group. Enter the gestational age 
(in weeks) and the weight/size of the item being defined with the limits for variation.  
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Client Profile 

The Client Profile option allows you to link additional relevant information to the Clinics file. You 
can only have one clinic per client profile code. 
To access the Client Profile option, select Setup > Setup Files > Client Profile from the main menu. 
The Client Profile Lookup window will display. To add a new client profile, click Add Record and 
the Location Defaults window (Figure 6-41) is displayed.  

 
Figure 6-41. Client Profile Setup Window – Location Defaults Tab 

Client  
Click the  button to select a valid clinic code to associate with this client profile. 

Default Technical and Professional Performing Location(s) 
When the default billing location(s) for professional and technical billing have been defined 
in the Clinics file, a Client Profile is automatically created for the clinic. This information is 
then displayed in the client profile. These defaults can be changed when editing the record, if 
necessary. 
Click the  button to select a valid Default Technical or Default Performing location. 
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Client Profile Defaults Tab 
The Client Profile Defaults tab (Figure 6-42) is used to establish defaults for the current client 
profile.  

 
Figure 6-42.  Client Profile Setup Window – Client Profile Defaults Tab 

Client Group 
Select a client group code for this client profile from the drop-down list. These options are 
defined in the Setup > Simple Codes > Client Group ID option. 

Route ID 
Enter the route ID. Maximum 10 characters free-text field used for printing routing 
information. 

Destination 
Enter the destination address that corresponds to the HIS reporting address  
(e.g., T: 2345, G67). Maximum 10 alphanumeric characters. 

Compile 
Specify the compile type that tells the HIS which format to use when preparing material 
received from SCC (e.g., LQ850 is an Epson). Maximum 10 characters. 

Paper Type 
Enter the information to be passed to the HIS to determine the type of paper the printer will 
use for the report. Maximum five characters. 

Client Profile Grid 
In the Field Name, column, click the  button and select a valid field name from the list. 
The field is added to the grid. The available fields are defined during initial system setup in 
the Simple Codes setup option (Client Fields group). 
Mark the Required check box to indicate that this field is required. Unmark this check box 
to indicate that the field is optional. Fields added into the grid can be marked as required or 
optional. Any field that is marked required must have an appropriate value entered before 
the case can be saved and/or accessioned. If these fields are not completed, the system 
displays the required fields for data entry when a user attempts to save the record. 
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Case Specific Defaults Tab 
This tab is used to enter client-specified case defaults. 

 
Figure 6-43. Client Profile Setup Window - Case Specific Defaults Tab 

Pathologists Area 
Enter a pathologist ID in the Surgical, Medical, GYN, and Autopsy fields or click the  
button to select from a list of valid pathologist ID’s. Cases of the corresponding type will 
automatically be assigned to the specified pathologist in specimen registration (based on the 
patient’s associated clinic).  

Accession Number Labels Format Area 
Enter the format that should be used to print accession sequences on slide labels. This does 
not change the accession number format set in the Options file. Enter the accession number 
format for each case type in the corresponding Surgical, Medical, GYN, and Autopsy 
fields. Maximum 32 alphanumeric characters. 
Data entered in this field should follow the standard nomenclature used in the standard setup 
of B (base), Y (year), and N (number). For example, if the case number is SUR-02-00000, 
the format should be BBB-YY-NNNNN.   

Label Tag Area 
Enter the label tag for the specimen code to be printed on the slide labels. This does not 
change the numbering format set in the Options file or the display in the various Processing 
options. Select a label tag for specimens, blocks, FS block, or slides in the corresponding 
Specimen, Block, FS Block, and Slide drop-down lists.  

Client Profile Button 
Click this button to display the Free Text window. Enter up to 30 lines of free text 
information about the client. Free text information only displays in the Client profile area.  



Chapter 6.1- Setup: Setup Files SoftPath GUI v.4.2.1 User Manual 

Page 6-86  PATH4.2-G-U (6th Ed, Rel. 01/31/07) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 



SoftPath GUI v.4.2.1 User Manual Chapter 6.1 – Setup: Setup Files 

PATH4.2-G-U (6th Ed, Rel. 01/31/07)   Page 6-87 

Locations 

The Locations option is used to create/define new billing locations in SoftPath. 
To access the Locations option, select Setup > Setup Files > Locations from the main menu. The 
Location Lookup window is displayed. To add a new location to the database, click Add Record. 
The Location Setup window (Figure 6-44) is displayed.  

 
Figure 6-44. Location Setup Window 

Code 
Enter the element code. Maximum 5 alphanumeric characters. 

Active 
A checkmark is displayed in the box to indicate an active location.  To inactivate a location 
record, select the check box. 

Name  
Enter the name/description for the location. Maximum 50 alphanumeric characters. 

Independent Flag 
Mark this check box if the location will use unique billing for charges associated with the 
location in the Technical Charge Codes option. The location will override the default 
technical billing location defined in Billing setup. 

Address 
Enter the address of the location. Maximum 5 lines of text. 
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Risk Factors 

The Risk Factors option allows you to define patient risk factors.  
To access the Risk Factors setup file, select Setup > Setup Files > Risk Factors from the main menu. 
The Risk Factors Lookup window is displayed. To add a new risk factor to the database, click Add 
Record and the Risk Factors Setup window (Figure 6-45) is displayed.  

 
Figure 6-45. Risk Factors Setup Window 

Code   
Enter a unique acronym to identify the risk factor. Maximum 5 alphanumeric characters. 

Active 
A checkmark is displayed in the box to indicate an active risk factor.  To inactivate a risk 
factor record, select the check box. 

Name  
Enter the name/short description for the risk factor. Maximum 50 alphanumeric 
characters. 

Expiration Period 
Enter the number of months (maximum 999 months) this risk factor should remain active 
after it is associated with a patient. Enter 0 or leave this field blank if you do not want the 
risk factor to expire. This value is used to determine the default expiration date when a new 
risk factor code is associated with a patient. 

High Risk 
Select this check box to indicate that the risk factor is high risk. The High Risk flag will be 
marked for patients with this risk factor. 
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Priority 

The Priority setup file provides the ability to define Priority codes and rank them in order of 
importance.  
To access the Priority setup file, select Setup > Setup Files > Priority from the main menu. The 
Priority Setup window (Figure 6-46) is displayed.  

 
Figure 6-46. Priority Setup Window 

To add a new Priority code, click the Insert button. The system will ask you to provide information 
both for the Code column and the Name column of the table.  
NOTE: The Code column only accepts one (1) alphabetic character. 
To change the priority of the codes in the table, select the code you would like to change and click 
either the Up or Down buttons to move the code accordingly in the table. To delete a code, click the 
Delete button. 
NOTE: The standard codes that come installed with the system may not be deleted from the file. 
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Placeholder Setup 

 
The Placeholder setup file allows you to define Placeholder codes, which will be available for 
association with the document sections and subsections for inserting images. 
To access the Placeholder setup file, select Setup > Setup Files > Placeholder Setup from the main 
menu. The Placeholder Lookup window is displayed; select a current placeholder or click the Add 
Record button. The Placeholder Setup window (Figure 6-47) is displayed. 

 
Figure 6-47. Placeholder Setup Window 

Code 
Enter a unique code with a maximum of 5 alphanumeric characters to define the placeholder.  

Name 
Enter a name to describe the image placeholder. 

Active 
Activate and inactivate the placeholder by selecting and deselecting this check box. 
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Billing Setup 

 
Figure 6-48. Setup Menu – Billing Setup Submenu  

The Billing Setup submenu contains the following options: 
• Technical Charge Codes 
• Professional Charge Codes 
• Charge Transaction Part A 
• Charge Transaction Part B 
• Billing Routine Activity 
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Technical Charge Codes 
The Technical Charge Codes option allows you to define the relationship between the internal 
billing code (IBC) and the final billing code (FBC) and CPT codes for the technical component of 
the pathology billing (Part A).  
To access the Technical Charge Codes option, select Setup > Billing Setup > Technical Charge 
Codes from the main menu. The Technical Charge Lookup window will display. To add a new 
technical charge code, click Add Record. The Technical Charge window (Figure 6-49) is 
displayed.  

 
Figure 6-49. Technical Charge Code Window 

Internal Code ID 
Enter a unique acronym to identify the billing transaction. Maximum 5 alphanumeric 
characters.  

Name 
Enter the transaction name that you want to appear on billing reports (part A and B). 
Maximum 22 alphanumeric characters. 

Active 
A checkmark is displayed in the box to indicate an active technical charge code.  To 
inactivate a technical charge code record, select the check box. 
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CPT code 
Enter the applicable CPT code associated with the IBC and FBC code. Maximum 5 
alphanumeric characters. 

Allowed Functional Classes 
Select the required functional class (case type) for this technical charge by marking the 
appropriate check box(es).  

Billing Class/Final Billing Code 
Enter the final billing code (FBC) for each billing class. This code will be sent to the HIS or 
a private billing agency. In some cases, the FBC cannot be defined, so the patient will not be 
billed even if an IBC were assigned to the transaction record.  

Default Performing Location 
Enter the default performing location for the billing transaction. The locations available are 
defined in the Locations setup file. 

Prices Grid: 
Complete the following fields in the Prices grid: 

Party Enter the billing party. 

Schedule Enter the billing schedule. 

Billing # Enter the bill code number. 

Billing Price Enter the basic billing price. 

Expiration Date Enter the expiration date. 

Alternative Price Enter the alternative billing price. 
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Professional Charge Codes 
The Professional Charge Codes option defines the relationship between the internal billing code 
(IBC) and the final billing code (FBC) and CPT codes for the professional components of pathology 
billing.  
To access the Technical Charge Codes option, select Setup > Billing Setup > Professional Charge 
Codes from the main menu. The Professional Charge Lookup window is displayed. To add a new 
professional charge code, click Add Record. The Professional Charge window (Figure 6-50) is 
displayed.  

 
Figure 6-50. Professional Charge Window 

The window for the Professional Charge Codes option is identical to window for the Technical 
Charge Codes option. All data fields and buttons are described in the Technical Charge Code 
section on page 6-96.  
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Charge Transaction Part A and Part B 
The Charge Transaction Part A and Charge Transaction Part B options are used to define the 
charge transaction part A and part B tables. Prior to defining the transaction tables, all of the system 
files used (such as the Source, Special Stains/Tests, Diagnosis Code, and Insurances files) must be 
completed because they are used to group tests together in the transaction definitions. The billing 
transactions are defined in tables.  
To access the Charge Transaction Part A option, select Setup > Billing Setup > Charge 
Transaction Part A from the main menu. The Charge Transaction Part A window (Figure 6-51) is 
displayed.  
NOTE:  The procedure for accessing and using the Charge Transaction Part B option is 

identical to the procedure for accessing and using the Charge Transaction Part A 
option. 

 
Figure 6-51. Charge Transaction Part A window 

IBC Column 
Click the  button to select a valid internal billing code for this transaction. Each transaction 
must have one IBC assigned. 
NOTE: The IBC must be defined in the Professional Charge Codes and Technical 

Charge Codes options before it is entered in the transaction records. 
Case Type Column 

The case type you specify in this column is connected with the IBC. After selecting the IBC 
in the first column, click the  button in the Case Type column to select from a list of valid 
case types.  
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Par X, Par Y, and Par Z Columns 
Enter the parameters X, Y, and Z, respectively. Click the  buttons in each column to select 
a valid parameter code from the Select Workload/Billing Flag window. 

 
Figure 6-52. Select Workload/Billing Flag Window 

Condition Column 
Define the conditions for the transaction to be applied. Click the  button to display the 
Logic Calculator window (Figure 6-53). Use the calculator to define the conditions. 

 
Figure 6-53. Logic Calculator 

The following calculator commands are available: 
X Parameter X / Divided by 
Y Parameter Y * Multiplied by 
Z Parameter Z - Minus 
!X Not X + Plus 
!Y Not Y > Greater than 
!Z Not Z < Less than 

<integer> Numeric value != Not equal 
, Separate two conditions (both must be true) = Equal 

EXAMPLE: Enter <5,Y>X. The charges will be applied if the value of the variable X is 
less than 5 and the value of the variable Y is greater than the value of X. 
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Source Column 
Enter the source type code to which this transaction applies. The source must be defined in 
the Source file. Click the  button to select from a list of valid source codes. If you enter a 
source code into this field, the charges will only be applied if the specimen is associated with 
the specified source type or one of the source members in the source type tree-like structure. 

Test ID Column 
Enter the special stain/test code to which this transaction applies. The code must be defined 
in the Special Stains/Tests file. Click the  button to select from a list of valid special 
stains/tests. If you enter a special stain/test code, the charges will be applied only when the 
specified special stain/test has been performed for the case. 

Dx Code Column 
Enter the diagnosis code to which this transaction applies. The code must be defined in the 
Dictionaries file. Click the  button to select the diagnosis coding system appropriate for the 
transaction case type.  
If you enter diagnosis code in this field, the charges specified in the transaction record are 
applied only when this diagnosis code is assigned to the case result. 

# of IBC Column 
Click the  button to display the Logic Calculator window (Figure 6-53) where you can 
calculate the number of internal billing codes to be applied. See the description of the 
Condition column for more information. 

Exclude Code Column 
Enter the exclude code to further define the calculation. Click the  button to display the 
Exclude Choice window. Select one of the following:  

A (Additive) Add the charge from the transaction to the charges from other 
transactions with the exclude code A. 

E (Exclude additive) If one or more transactions have exclude additive flags, only 
transactions with the exclude code E are applied to the case. 

X (Exclude all) If one transaction with exclude all flags is encountered, only the 
charge from this transaction is applied. Only one transaction with 
the exclude code X (the first that qualifies and is encountered) will 
be used. 

Active Column 
A checkmark is displayed in the box to indicate an active transaction.  To inactivate a 
transaction record, select the check box. 

Description Column 
Enter a brief description of the transaction. 
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Billing Routine Activity 
The Billing Routine Activity option allows you to define whether or not to display a particular code 
in the selection list for Charge Transaction Part A and Charge Transaction Part B tables.  
To access the Billing Routine Activity option, select Setup > Billing Setup > Billing Routine 
Activity from the main menu. The Billing Routine Activity Setup window (Figure 6-54) is 
displayed. Click Edit from the toolbar. Select the codes by marking the appropriate check boxes in 
the Display column. 
NOTE: You cannot make changes to the Code, Type, Description, or Level fields. 

 
Figure 6-54. Billing Routine Activity Window 
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Case Comparison Setup 

The Case Comparison Setup option allows you to establish the criteria that the system uses to 
automatically select cases to flag for QA rescreening and review. 
To access the Case Comparison Setup option, select Setup > Case Comparison Setup from the 
main menu. The Case Comparison Setup window (Figure 6-55) is displayed. To add a new case 
comparison row, click New on the SoftPath toolbar. 

 
Figure 6-55. Case Comparison Setup Window 

Comparison Types  
Select the appropriate comparison type from the drop-down list: 

QA Reports Create and maintain a series of case criteria used to automatically flag qualifying 
cases for the corresponding Case Review report. 

Follow Up Create and maintain a series of case criteria used to automatically flag qualifying 
cases for follow up. 

Proreview Create and maintain a series of case criteria used to automatically flag qualifying 
cases for proreview. 

Rescreen Create and maintain a series of case criteria used to automatically flag qualifying 
cases for rescreening. 

Retroreview Create and maintain a series of case criteria used to automatically flag qualifying 
cases for retroreview. 
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Case Comparison Grid 
The grid present in the Case Comparison Setup window is divided into two areas, Current Case 
and Previous Case. The parameters for the current case are entered in the Current Case area and 
the parameters for the previous case for the same patient are entered in the Previous Case area. 
Case Type  

Click the  button to select from a list of valid case types for this comparison.  
A/N  

Click the  button and select Abnormal, Normal, or Unknown. 
Dx Cat  

Click the  button to select a valid diagnosis category code for this case comparison. 
Dx Group  

Click the  button to select a valid diagnosis group code for this case comparison. 
Dx Code  

Click the  button to select a valid diagnosis code for this case comparison. 
Source Family  

If you want to specify a source code as qualifying criteria, click the  button to select from a 
list of valid source codes.  

Employee Type 
Click the  button to select from a list of valid employee types for this comparison. 

Qualify By Column 
To select the method of qualifying cases for QA, click the  button and select one of the 
available criteria: 

0 NULL No value. 
1 The same Dx 

code 
The current case will be flagged for review if the diagnosis codes 
for the current and previous cases are the same. 

2 The same Dx 
category 

The current case will be flagged for review if both the current and 
previous cases have the same diagnosis category. The cases must 
have Dx categories assigned. 

3 The same Dx 
group 

The current case will be flagged for review if the Dx groups for the 
current and previous cases are the same. This is possible only when 
the Dx codes are assigned and Dx groups are associated to the Dx 
codes. 

4 IOC Done By Comparison is based on the employee type defined for this report 
type in the Current Case area. 

5 Gross Done by Comparison is based on the employee type defined for this report 
type in the Current Case area. 

6 Final Done by Comparison is based on the employee type defined for this report 
type in the Current Case area. 

7 Clinicopathology 
Done by 

Comparison is based on the employee type defined for this report 
type in the Current Case area. 

High Risk Column 
Mark check box to qualify cases for QA based on the High Risk flag associated with patient 
record. 
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Options 

The Options file allows the system administrator to establish a limited number of user-defined 
system parameters that supersede the Hosparam file values that were initially established by SCC 
personnel. Any parameters not defined by this option will be taken from the Hosparam file. 
To access the Options file, select Setup > Options from the main menu and the Options window 
(Figure 6-56) is displayed. You can also access the Options file by clicking the Options button on 
the SoftPath toolbar.  

 
Figure 6-56. Options Window 

The Options window contains the following tabs: 

• Specimen Registration Tab • Document Printing Tab 

• Specimen Processing Tab • Utilities Tab 

• Result Entry Tab • Miscellaneous Tab 

• Quality Assurance Tab • Voice Recognition Tab 

• Sign Out Tab • System Settings Tab 

• Query Tab • Workspace Tab 
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Setting Type 
The settings in the Options file must be determined for each individual user ID. For example, 
to set a default accession base for a specific site, the system administrator must set the 
default for each user at that site, based on their logon ID. You can change the setting type by 
clicking the  and  buttons located on the SoftPath toolbar.  
NOTE: Some parameters can be defined as generic settings ONLY and are not accessible 

when defining options for a specific user. 
• Generic Settings - Used to determine the global default settings for all users. This 

option must be selected when you first access the Options window if you want to use 
generic settings. The default setting type is User Settings, since the system user is not 
generally given permission to edit the default settings for the lab. 

• User Settings - Used to determine specific default settings for individual users. This is 
the default setting type. 

Parameter Group List 
This list contains all the available Parameter Groups. The group list can be used to move 
from tab to tab by using the mouse and clicking the desired area. 
Each tab contains the parameter variables specific to the functional group. Within each tab, 
there are several additional tabs containing function-specific parameter variables. 
Click Edit on the toolbar to make changes to any of the settings in the Parameter Group tabs. 
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Specimen Registration Tab 

To access the Specimen Registration tab, select Setup > Options from the main menu and then 
select Specimen Registration from the Parameter Group list. The Specimen Registration tab 
(Figure 6-57) is displayed. Click Edit on the toolbar to make changes to any of the parameters. 

 
Figure 6-57. Options Window – Specimen Registration Tab 

The Specimen Registration tab contains the following tabs: 
 Standard Settings 
 Standard Settings cont. 
 Case Deletion 
 Flags 
 Navigation 
 Tab Selection 
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Standard Settings Tab 
The Standard Settings tab displays similar to Figure 6-58. 

 
Figure 6-58. Options Window - Specimen Registration Tab - Standard Settings Tab 

Default Accession Sequence 
Enter the default accession sequence for the Surgical, MED, GYN, Autopsy and Old Case 
types. Click the  button to display the Accession Sequences Lookup window from which 
the desired code can be selected.  
The specified default accession sequence will only be used in the appropriate Specimen 
Registration option for the case type. If you use the All Cases specimen registration option, 
you will have to select the correct accession sequence. Once you select an accession 
sequence, the system automatically determines the case type and displays the appropriate 
Specimen Registration window for the case type.  
User settings are available for surgical, MED cytology, GYN cytology, and autopsy case 
types. Generic settings are available for all case types. 

Default Collection Method for Surgical, MED, GYN and Autopsy Cases 
Enter a default collection method for specimen registration. Click the  button to select 
from a list of valid collection method codes. The specified collection method will only be 
used when a collection method has not been associated with a source and the system 
parameters are set to use the source defaults. If the system is not set to use the source 
defaults the collection method entered will always be used regardless of the settings in the 
source file. 
This option can be defined both at the user-specific level and the global (generic) level. 
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Setting Procedure Date 
Select a default procedure date setting from the drop-down list. The procedure date can be 
set as the current system date or it may not be set.  
NOTE: If set to “Procedure date is not set” the system will consider this a mandatory 

field and require the user to enter a date in the mm/dd/yyyy date format.  
This option can be defined both at the user-specific level and the global (generic) level. 

Setting Procedure Time 
Select the default procedure time setting from the drop-down list. The procedure time can be 
defined as the current system time or it can be left blank.  
NOTE: The procedure time is not required during specimen registration. If this field is 

left blank in specimen registration, all turnaround time reports based on the 
procedure date will be based on the time of 12:00 A.M. for the specified date. 
This can skew the actual turnaround times of the reported cases. 

This option can be defined both at the user-specific level and the global (generic) level. 
Set Procedure Date (years) 

Select the period of time in years, prior to the current date, that the system accepts as a valid 
date in the procedure date field. If the date entered is greater than the defined value, a 
message ("Invalid procedure date entered") will display and prevent the user from leaving 
the field until a valid date is entered. The default value shall be set to 1 year. 
This option can only be defined on the global (generic) level. 

Setting Source Code 
Select the source code setting that will be used when adding a specimen in the system from 
the drop-down list. You can choose to add all subsequent specimens using the first specimen 
entered for the case or by using the last specimen added to the case. The setting source code 
is only used when adding a specimen to a case that already has at least one specimen 
entered. If no specimens have been entered the new entry will always be blank. 
This option can only be defined on the global (generic) level. 

Default Cursor Position in Browser 
Select the field that the cursor will be positioned on the Simple Search and Advanced 
Search tabs when the Specimen Registration option is accessed. 
This option can be defined both at the user-specific level and the global (generic) level. 

Default Patient Type 
Select the default patient type for new patients from the drop-down list. The available patient 
types are defined in the Simple Codes option. The default patient type will only be used for 
patients that are entered in conjunction with a clinic that does not have a specified default 
patient type. The default patient type specified in the Clinics file (if any) always takes 
priority over this default patient type you enter in this field.  
This option can only be defined on the global (generic) level. 



Chapter 6.4- Setup: Options SoftPath GUI v.4.2.1 User Manual 

Page 6-110  PATH4.2-G-U (6th Ed, Rel. 01/31/07) 

Standard Settings cont. Tab 
The Standard Settings Cont tab displays similar to Figure 6-59. 

 
Figure 6-59. Options Window - Specimen Registration Tab - Standard Settings cont. Tab 

Allowed Duplication of Special Tests 
Select Yes to allow users to enter duplicate test codes during specimen processing and 
registration. Select No if you do not want to allow duplicates. The system will prompt the 
user if a duplicate is entered and will inform them that the duplicate must be deleted. 
This option can only be defined on the global (generic) level. 

Default Mode for Pending Cases in Specimen Registration 
Select either Read mode (READ ONLY) or Edit mode as the default mode for pending 
cases in the Specimen Registration option. A pending case for Specimen Registration is a 
case that has not been signed out in the system. Cases that have been signed out are always 
opened in read-only mode regardless of the mode selected in this field and cannot be edited. 
This option can be defined both at the user-specific level and the global (generic) level. 

Copies to Dr. Required? 
Select Yes to require users to always specify a minimum of one copy to the doctor during 
specimen registration. If the Copies To field is left empty and the user attempts to save the 
registration record, the system prompts them to complete the field. Select No if you do not 
want users to be required to send copies. Copies can still be sent to doctors on a case-by-case 
basis as needed. 
This option can only be defined on the global (generic) level. 

Minimum Time (minutes) to Reactivate Case 
Enter the minimum number of minutes permitted to reactivate a case number.  Allowed 
value: up to 3 digits.   
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This option can only be defined on the global (generic) level and by default is set to 960 
minutes by default. 

Number of Days System will Prompt for Registration in Previous Year 
Enter the number of days in which to prompt the user after the beginning of the new year for 
registration of the case in the previous year.  Allowed value: up to 365 days. 
This option can only be defined on the global (generic) level. 

Use tree grid display 
If you mark this check box, a tree grid display will be presented in the following search 
screens:  Patient Maintenance, Query and Specimen Registration. 
This option can only be defined on the global (generic) level. 

Display lab’s tag data in Spec. Registration 
If you mark this check box, the Display Lab Tag button displays on the Other Case Data 
tab of the Specimen Registration window. This button allows users to view any tag data 
associated with an imported lab patient. If this check box is not marked, the Display Lab 
Tab button is not displayed. 
This option can only be defined on the global (generic) level. 

Default Clinic ID from Admitting Dr ID 
This check box allows the main Ward ID (as defined in the setup file) to be imported as the 
Admitting Dr ID when a new stay is created for a patient in Patient Maintenance. 
This option can only be defined at the global (generic) level. 

Downgrade Case Status with Spec. Registration Edit 
Mark this check box if a case status of Final Diagnosis complete should be downgraded 
when the case is edited in Specimen Registration.  
This option can only be defined at the global (generic) level. 

Create New Case for the Same Patient 
Mark the check boxes corresponding to the case types that will be prompted with the 
message: create a new case for the same patient? when specimen registration is completed 
and the user clicks the Add button. The user can then click Yes to use the same patient and 
stay for a second case, or they can click No to specify a new patient.  
If you do not mark any case types, the system displays a search window that allows the user 
to specify a new patient when a new case is added. 
This option can only be defined on the global (generic) level. 
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Case Deletion Tab 
The Case Deletion tab (Figure 6-60) is used to define the case deletion limits. 
NOTE: The options defined on this tab affect unsigned cases only. Signed out cases cannot be 

deleted. 

 
Figure 6-60. Options Window - Specimen Registration Tab - Case Deletion Tab 

Limitation for Reusing Case Number 
Enter the maximum number of days for reusing the case number after the case is deleted. For 
example, if you enter 5, users have five days to reuse the case number before it is deleted. 
If you enter a value greater than 0 in this field, the system asks users that delete a case 
whether they want to reuse the case number. If the user opts not to allow the case number to 
be reused, the case number cannot be reused, regardless of the value entered in this field.  
If you enter 0 in this field, case numbers will not be available for reuse within the system. 
This option can only be defined on the global (generic) level. 

Limitation for Deleting Case 
Enter the maximum number of days after the registration date of the case that users will be 
allowed to delete the case. For example, if you enter 10, users will have ten days from the 
date of registration to delete the case. They cannot delete the case in the Specimen 
Registration window after this time has passed.  
If you enter 0 in this field, users cannot delete cases in the Specimen Registration window. 
This option can only be defined on the global (generic) level. 

Only the Ordered Tech. Can Delete Case 
Mark this check box so only the ordering technologist can delete the case. If you mark this 
check box, only the ordering technologist will be able to use the Delete button to delete 
cases in the Specimen Registration window. This button will be inactive for other users and 
they will not be able to delete cases during specimen registration.  
This option can only be defined on the global (generic) level. 
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Flags Tab 
The Flags tab (Figure 6-61) allows you to define the available case flags and source flags in 
specimen registration for specific case types.  

 
Figure 6-61. Options Window - Specimen Registration Tab - Flags Tab 

Case Flags in Specimen Registration 
Select a case type from the drop-down list. For each case type, mark the Case Flags check 
boxes to indicate which source flags you want to display on the Other Case Data tab of the 
Specimen Registration window for the selected case type.  
This option can only be defined on the global (generic) level. 

Source Flags 
Select a case type from the drop-down list. For each case type, mark the Source Flags check 
boxes to indicate which source flags you want to display in the Source Flags window for the 
select case type. Users access the Source Flags window by pressing the Source Flags button 
in the Specimen Registration window.  
This option can only be defined on the global (generic) level. 
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Navigation Tab 
The Navigation tab displays similar to Figure 6-62. 

 
Figure 6-62. Options Window - Specimen Registration Tab - Navigation Tab 

Bridge to Query by: 
Select the method you want to use to bridge users from the Specimen Registration option to 
the Results Query option when a user presses the Query button on the SoftPath toolbar. 
This option can be defined both at the user-specific level and the global (generic) level. 
 Bridge by MRN to Results Query – If you select this option, the Result Query Search 

window displays when the user clicks the Query toolbar button in the Specimen 
Registration option. The system inserts the current patient’s MRN into the MRN field 
and displays a list of all cases that match the MRN. If only one case exists, the system 
displays the case data in the Result Query window. 

 Bridge by MRN to Results Query by Search Screen – If you select this option, the 
Result Query Search window displays when the user clicks the Query toolbar button in 
the Specimen Registration option. The system inserts the current patient’s MRN into 
the MRN field. The user can then enter additional search criteria. After entering search 
criteria, the user must click Find to initiate the search. The system displays a list of cases 
that match the specified search criteria. 

 Fast Bridge by case to Results Query – If you select this option, the system displays 
data for the current case in the Results Query window when the user clicks the Query 
toolbar button in the Specimen Registration option. This option bypasses the Results 
Query Search window entirely. 

 Bridge by Case to Results Query by Search Screen – If you select this option, the 
Result Query Search window displays when the user clicks the Query toolbar button in 
the Specimen Registration option. The system inserts the current case number into the 
Case field. The user can then enter additional search criteria. After entering search 
criteria, the user must click Find to initiate the search. The system displays a list of cases 
that match the specified search criteria. This option can be defined both at the user-
specific level and the global (generic) level. 
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Tab Selection Tab  
The Tab Selection tab displays similar to Figure 6-63. 

 
Figure 6-63.  Options Window - Specimen Registration Tab – Tab Selection Tab 

Tab Selection 
Select the check boxes corresponding to the tabs to display in specimen registration.  By 
default, the Case Data and Specimens tab will always display. 
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Specimen Processing Tab 

To access the Specimen Processing tab, select Setup > Options from the main menu and then select 
Specimen Processing from the Parameter Group list. The Specimen Processing tab (Figure 6-64) 
is displayed. Click Edit on the toolbar to make changes to any of the parameters. 

 
Figure 6-64. Options Window – Specimen Processing Tab 

The Specimen Registration tab contains the following tabs: 
 Universal Settings 
 One Case  
 Worklists 
 Fast Processing 
 Labels 
 Flags 
 Navigation 
 Stain Evaluation 
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Universal Settings Tab 
The Universal Settings tab displays similar to Figure 6-65. 

 
Figure 6-65. Options Window - Specimen Processing Tab - Universal Settings Tab 

Default Slide Location 
Enter the default location for slide storage or click the  button to select from a list of valid 
storage codes that can be used to store slides. The default location specified here is used in 
the Inventory window during specimen processing. 
This option can be defined both at the user-specific level and the global (generic) level. 

Default Block Location 
Enter the default location for block storage or click the  button to select from a list of 
storage locations that are eligible to serve as block storage locations. The location you 
specify will be used in the Inventory window during specimen processing. 
This option can be defined both at the user-specific level and the global (generic) level. 

Default Specimen Location for Source Setup 
Enter the default location for specimen storage or click the  button to select from a list of 
storage locations that are eligible to serve as specimen storage locations. The location you 
specify will be used as the default storage location when you add a new record to the Source 
setup file. 
This option can only be defined on the global (generic) level. 

Standard Method of Staining for Surgical 
Enter the standard stain to be used for histology slides or click the  button to select from a 
list of valid stains. 
This option can only be defined on the global (generic) level. 
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Standard Method of Staining for Cytology 
Enter the standard stain to be used for cytology slides or click the  button to select from a 
list of valid stains. 
This option can only be defined on the global (generic) level. 

Standard Method of Staining for Touch Preps 
Enter the standard stain to be used for touch prep slides or click the  button to select from a 
list of valid stains. The default will apply for Surgical, MED Cytology and Autopsy case 
types. 
This option can only be defined on the global (generic) level. 

Default Level 
Select the default level for blocks. This level will only be used if source defaults are not 
being used or if there is no default level associated with the source and the defaults from the 
source file are being used.   
This option can only be defined on the global (generic) level. 

Default Storage Period for Source Setup 
Enter the default time frame from the received date of the specimen until the specimen 
should be pending for storage. The time period you specify will be used as the default 
storage location when you add a new record to the Source setup file. 
This option can only be defined on the global (generic) level. 

Default FS Block Level 
Enter the default number of slides applied to FS blocks. 
This option can only be defined on the global (generic) level. 

Activate Cassette Labeler 
Mark this check box to activate the cassette labeling functionality of the system. This is also 
where to define the default printer to display in the Fast Processing search screen. See 
Chapter 2.5 – Processing: Print Cassettes for more information about this functionality. 

Autoprint Cassettes from One Case Processing 
Mark this check box to print cassettes to the selected default printer from the One Case 
Processing option.  This is dependent on the “Activate Cassette Labeler" check box. 
This option can only be defined on the global (generic) level. 

Use Processing Defaults from Source Setup 
Mark this check box to always use processing defaults from the Source setup file during 
specimen processing. 
This option can only be defined on the global (generic) level. 

Look for Defaults in Parent Sources 
Mark this check box to use the defaults defined in the parent source codes during specimen 
processing when the child source does not have any default values defined.  
For example, if the default value is equal to 0 in the child, but the value is greater than 0 for 
the parent, the system uses the default from the parent source. If the child source default is 1, 
then the value 1 would be the default used for the primary blocks. The parent source defaults 
are only used for items that are left undefined in the source setup file and pertain only to the 
material defaults. 
This option can only be defined on the global (generic) level. 

Display Incoming Consultation Number 
Mark this check box to display the Outside Case Number entered in the Materials Received 
window of Incoming Consultation beside the specimen code in One Case Processing 
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Case Types Requiring Processing Before Results Entered/Completed 
These fields allow you to select case types that require processing before results are entered 
or completed. These case types would be flagged before qualifying as pending for Final 
Result Entry or before the final results are flagged as completed. By default, these check 
boxes are cleared. 
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One Case Tab 
The One Case tab displays similar to Figure 6-66. 

 
Figure 6-66. Options Window - Specimen Processing Tab - One Case Tab 

Default Cursor Position in Browser 
Select the field that the cursor should be positioned in each time you access the search 
window for the One Case Processing option. This setting is used for both the Simple 
Search and Advanced Search tabs. 
This option can be defined both at the user-specific level and the global (generic) level. 

Default Case Type for Pending Specimens 
Select the default case type to display first on the Pending Cases tab. 
This option can be defined both at the user-specific level and the global (generic) level. 

Default Date Range for Pending Specimens 
Enter the default time in days to look back on the Pending Cases tab. 
This option can be defined both at the user-specific level and the global (generic) level. 

No Questions About Defaults in One Case Processing 
Marking this check box causes the system to automatically apply processing defaults in the 
One Case Processing option. If the Use Processing Defaults from Source Setup check 
box (Universal Settings tab) is also marked, the defaults are automatically applied without 
any additional action from the user; if the Use Processing Defaults from Source Setup 
check box is not marked, defaults for the various processing items (such as default level, 
default stain, etc.) are automatically applied without any additional action from the user.  
Leave this check box unmarked to always prompt the user prior to applying any processing 
defaults to the case. 
This option can only be defined on the global (generic) level. 

Case Flags in Specimen Processing 
Select a case type from the drop-down list and mark the check boxes to indicate which flags 
should be available for data entry during specimen processing.  
This option can only be defined on the global (generic) level. 
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Worklists Tab 
The Worklists tab displays similar to Figure 6-67. 

 
Figure 6-67. Options Window - Specimen Processing Tab - Worklists Tab 

Sort Rules for Specimen Worklist 
Select the default sort rules for the specimen processing worklist. You can select up to three 
sort rules that will be used in the worklist search window.  
This option can be defined both at the user-specific level and the global (generic) level. 

Default Settings for Worklists 
This function allows you to determine whether the system should ask the user to accept the 
processing defaults defined in the Source/Options file each time a worklist is accessed. Mark 
the check boxes next to the appropriate options. 
This option can be defined both at the user-specific level and the global (generic) level. 

Stains Worklist  - Display All Slides 
Mark this check box to display all unsigned cases with the applied stains in the stains 
worklist in addition to the unstained slides. 
This option can only be defined on the global (generic) level. 

Default Ordered Date Range 
Enter the default date range that specifies the number of days to look back for pending cases 
in the Worklist Search Screen window. 
This option can be defined both at the user-specific level and the global (generic) level. 

Default Worklist 
From the drop-down list, select the default worklist.  



SoftPath GUI v.4.2.1 User Manual Chapter 6.4 – Setup: Options 

PATH4.2-G-U (6th Ed, Rel. 01/31/07)   Page 6-123 

Fast Processing Tab 
The Fast Processing tab (Figure 6-68) is used to define defaults for the Fast Processing option 
(Processing > Fast Processing).  

 
Figure 6-68. Options Window - Specimen Processing Tab - Fast Processing Tab 

Default Actions in Fast Processing 
Mark the check boxes to indicate which actions should be used as defaults in the Fast 
Processing Search Screen window. 
This option can be defined both at the user-specific level and the global (generic) level. 

Default Case Types 
Mark the check boxes to indicate the case types that should be used as defaults in the Fast 
Processing Search Screen window. 
This option can be defined both at the user-specific level and the global (generic) level. 

Default Ordered Date Range 
Enter the default date range that specifies the number of days to look back for pending cases 
in the Fast Processing Search Screen window. 
This option can be defined both at the user-specific level and the global (generic) level. 

Standard Stain for First Slide in Fast Processing 
Mark this check box to indicate that a standard stain should be applied to the first slide in the 
Fast Processing option. 
This option can only be defined on the global (generic) level. 

Default Printer for Slide Labels 
Select the printer to display as the default slide label printer, as displayed in the Fast 
Processing search screen. 
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Labels Tab  
The Labels tab (Figure 6-69) is used to define defaults for the Labels option (Processing > Labels).  

 
Figure 6-69. Options Window - Specimen Processing Tab - Labels Tab 

Default Sort Rules for Label Entry 
Select up to three default sort rules for the Slide Labels Search Screen window.  
This option can be defined both at the user-specific level and the global (generic) level. 

Default Case Types 
Mark the check boxes that correspond to the case types to use as the default selections in the 
Slide Labels Search Screen window.  
This option can be defined both at the user-specific level and the global (generic) level. 

WORD Labels 
Mark this check box to define whether labels will be printed using the Microsoft Word 
functionality. 

Clear block ID when there is a single block per specimen 
Mark this check box to omit the block ID on the label when only one specimen exists. Leave 
this check box unmarked to always include the block ID on the label. 
This option can only be defined on the global (generic) level. 

Clear slide ID when there is a single slide per block or specimen 
Mark this check box to omit the slide ID on the label when only one specimen exists. Leave 
this check box unmarked to always include the slide ID on the label. 
This option can only be defined on the global (generic) level. 

Clear Specimen ID when there is a single specimen on the case  
Mark this check box to omit the specimen ID on the label when only one specimen exists. 
Leave this check box unmarked to always include the specimen ID on the label. 
This option can only be defined on the global (generic) level. 
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Print Standard Stain on Labels 
Mark this check box to print the standard stain text on slide labels. 
This option can only be defined on the global (generic) level. 

Label Printing Required  
Mark this check box to require label printing as a milestone within the system. If this check 
box is marked, cases will not be pending for results until the labels have been printed for the 
slides. If this check box is not marked, cases will be pending for results even if no labels 
have been printed.  
NOTE: Other restrictions for pending status may be applied. 
This option can only be defined on the global (generic) level. 

Consult Label Formats Case Type Sensitive   
Mark the check box to print the label formats for consultations using the standard histology 
and cytology label formats based on the slide type and the accession base associated with the 
case. Leave the check box unmarked to print one format for all consultation labels regardless 
of slide type and accession sequence. 
This option can only be defined on the global (generic) level. 

Default Label Status 
Select the default printing status in the Labels Search Screen window for cases to be 
included in the pending list. 
This option can be defined both at the user-specific level and the global (generic) level. 

Default Number of Labels in One Row 
Enter the number of slide labels per row for the slide label stock being used.  
This option can be defined both at the user-specific level and the global (generic) level. 

Default Label Range 
Enter the default number of days to look back for pending cases in the Slide Labels Search 
Screen window.  
This option can be defined both at the user-specific level and the global (generic) level. 

Number of Label Copies 
Enter the default number of specimen labels you want to print for each specimen.  
This option can only be defined on the global (generic) level. 

Space in Between Labels   
Enter the number of lines that will be used for label spacing when MS Word does not 
generate the labels. The spacing of MS Word labels depends how you set up the label. 
This option can only be defined on the global (generic) level. 

Autoprint Specimen Labels 
Mark this check box to have specimen labels print automatically when a new case 
registration is completed. The system may be configured to print to different printers based 
on the accession sequence or the case type. Once activated, the printer setup grid allows you 
to define the printer and number of labels to be used for each accession sequence/case type.  
This option can be defined both at the user-specific level and the global (generic) level. 

Autoprint Case Labels 
Mark this check box to have case labels print automatically when a new case registration is 
completed. The system may be configured to print to different printers based on the 
accession sequence or the case type. Once activated, the printer setup grid allows you to 
define the printer and number of labels to be used for each accession sequence/case type.  
This option can be defined both at the user-specific level and the global (generic) level. 
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Number of Case Labels 
Enter the default number of case labels you want to print for each specimen.  
This option can only be defined on the global (generic) level. 

Label Length   
Enter the number of lines that will be contained in the label length for labels that are not 
being generated from MS Word. The label length for MS Word labels depends on how you 
set up the label. 
This option can be defined both at the user-specific level and the global (generic) level. 

Label Width 
Enter the number of columns that will be contained in the label width for labels that are not 
being generated from MS Word. The label width for MS Word labels depends on how you 
set up the label. 
This option can be defined both at the user-specific level and the global (generic) level. 
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Flags Tab 
The Flags tab displays similar to Figure 6-70. 

 
Figure 6-70. Options Window - Specimen Processing Tab - Flags Tab 

Check Status, Block Holding, and Allow Deactivation 
Mark this check box if you want the system to automatically check for processing flags, such 
as a block hold. The system suspends these cases from the pending lists for processing and 
does not allow further processing until the block hold is removed. This setting is used in 
conjunction with the Reset Block Hold Flag check box. 
This option can only be defined on the global (generic) level. 

Reset Block Hold Flag 
Mark this check box if you want the system to reset the block hold flag on a nightly basis. 
This setting will only work if the Check Status, Block Holding, and Allow Deactivation 
check box are marked. Marking this check box without marking the Check Status, Block 
Holding, and Allow Deactivation check box will not reset the Block Hold flag. 
This option can only be defined on the global (generic) level. 



Chapter 6.4- Setup: Options SoftPath GUI v.4.2.1 User Manual 

Page 6-128  PATH4.2-G-U (6th Ed, Rel. 01/31/07) 

Navigation Tab 
The Navigation tab displays similar to Figure 6-71. 

 
Figure 6-71. Options Window - Specimen Processing Tab - Navigation Tab 

Opening Gross Description Window 
Select one of the following options: 
 Open automatically - SoftPath will open the Gross Description window (for medical 

cytology, gynecology, and autopsy cases) automatically when the cursor is advanced to 
the field. 

 Open normally - The user must press Enter when the cursor is positioned in the field 
(for medical cytology, gynecology, and autopsy cases) to open the Gross Description 
window. 

NOTE: If the user clicks the Gross Description button, the Gross Description window 
will be opened regardless of the option selected in this field. 

This option can only be defined on the global (generic) level. 



SoftPath GUI v.4.2.1 User Manual Chapter 6.4 – Setup: Options 

PATH4.2-G-U (6th Ed, Rel. 01/31/07)   Page 6-129 

Stain Evaluation Tab 
The Stain Evaluation tab displays similar to Figure 6-72. 

 
Figure 6-72. Options Window - Specimen Processing Tab - Stain Evaluation Tab 

Created Date Range 
Enter the default number of days to the batch creation date range. This default will be used 
in all search screens for the Stain Evaluation option. 
This option can only be defined on the global (generic) level. 

Availability Date Range 
Enter the default number of days for the available date range for newly created stain batches 
in the system. 
This option can only be defined on the global (generic) level. 

Number of Control Labels 
Enter the default number of copies of control labels that should be printed when the batch is 
created. This number is only a default and can be changed once the record is created. 
This option can be defined both at the user-specific level and the global (generic) level. 

Number of Characters in Batch Number 
Enter the maximum number of characters you want to use for batch number assignment. 
This option can only be defined on the global (generic) level. 

Default printer 
Select the default printer from the drop-down list. This selection works in conjunction with 
the Auto Print Labels check box. If you select a default printer in this field, but the system 
administrator has not marked the Auto Print Labels check box for your facility, labels will 
not automatically print to the specified default printer. The Auto Printing Labels feature is 
available as a global setting within the institution depending on whether the control labels 
will be generated based on the case or the stain batch.  
This option can be defined both at the user-specific level and the global (generic) level. 
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Auto Print Labels 
Mark this check box to print labels automatically. This check box is used in conjunction with 
the Default Printer drop-down list. 
This option can only be defined on the global (generic) level. 

Tech ID same as Logon ID 
Mark this check box to use the currently logged in user of the system as the default 
technologist when a new batch is created. This is only a default and can be changed once the 
record is created during Stain QC batch assignment. 
This option can be defined both at the user-specific level and the global (generic) level. 
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Result Entry Tab 

To access the Result Entry tab, select Setup > Options from the main menu and then select Result 
Entry from the Parameter Group list. The Result Entry tab (Figure 6-73) is displayed. Click Edit 
on the toolbar to make changes to any of the parameters. 

 
Figure 6-73. Options Window – Result Entry Tab 

The Result Entry tab contains the following tabs: 
 Intraoperative Consultation 
 Gross Description 
 Final Result Entry 
 Final Results (cont) 
 Dx Coding 
 Letters 
 My Result Worklist 
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Intraoperative Consultation Tab 
The Intraoperative Consultations tab displays similar to Figure 6-74. 

 
Figure 6-74. Options Window - Result Entry Tab - Intraoperative Consultation Tab 

Default Section in Word & RTF for Surgical, MED Cytology, GYN Cytology, and Autopsy 
From the drop-down list, select the default position of the cursor in MS Word and RTF 
documents for each case type. The cursor positions available are based on the sections you 
create in the Simple Codes setup option. This setting is used by the system for cursor 
placement during IOC entry when the user utilizes the Advanced Result Search tab in the 
My Results Worklist option or Results Entry option and selects the IOC option button in 
the Find For: area.    
This option can be defined both at the user-specific level and the global (generic) level. 

Case Types Available for IOC 
Mark the check boxes to indicate that the corresponding case types should be included in the 
list of cases when the user utilizes the Advanced Result Search tab in the My Results 
Worklist option or Results Entry option and selects the IOC option button in the Find For: 
area. If a frozen section block is added or the IOC field is set to a value greater than 0 for a 
case type that you have not marked on this tab, the case will not be included in the pending 
list during result entry.  
This option can only be defined on the global (generic) level. 

Set Display to Top of Document 
This option, when checked, allows the display to open at the top of the report when the MS 
Word template is opened. 
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Gross Description Tab 
The Gross Description tab displays similar to Figure 6-75. 

 
Figure 6-75. Options Window - Result Entry Tab - Gross Description Tab 

Case Types Requiring Gross Description when Resulting 
Mark the check boxes to indicate which case types require gross description prior to final 
result entry. When you enter final results for one of the selected case types, the system will 
inform you that the gross description is required before you can enter and save the final 
diagnosis for the case. 
This option can only be defined on the global (generic) level. 

Default Section in Word & RTF for Surgical, MED Cytology, GYN Cytology, and Autopsy 
Select the default position of the cursor in MS Word and RTF documents for each case type 
from the drop-down list. The available cursor positions are based on the sections you created 
in the Simple Codes setup file. These defaults are used by the system to determine where to 
position the cursor during gross description entry when you utilize the Advanced Result 
Search tab in the My Results Worklist option or Results Entry option and select the Gross 
Description option button in the Find For: area. 
This option can be defined both at the user-specific level and the global (generic) level. 
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Prompt to Flag Gross Description as Completed 
Select one of the following rules for determining the method of marking the Gross 
Description as completed: 

• Prompt for Gross Description Complete: When selected, the user is prompted for 
the completion status of the Gross Description and the Gross Completed checkbox 
in the Gross Description save window is masked.  

• Default Completed Checkbox to Marked: When selected, the Gross Completed 
checkbox is displayed in the Gross Description save window as marked, the user is 
not prompted for the completion status, and the case is flagged as Gross Description 
complete when saved. 

• Default Completed Checkbox to Unmarked: When selected, the Gross Completed 
checkbox is displayed in the Gross Description save window as unmarked, the user 
is not prompted for the completion status, and the case is not flagged as Gross 
Description complete when saved.  

This option can be defined both at the user-specific level and the global (generic) level. 
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Final Result Entry Tab 
The Final Result Entry tab displays similar to Figure 6-76. 

 
Figure 6-76. Options Window - Result Entry Tab - Final Result Entry Tab 

Default Section in Word and RTF for Surgical, MED Cytology, GYN Cytology, FAD, and PAD 
Select the default position of the cursor in MS Word documents for each case type from the 
drop-down list. The available cursor positions are based on the sections you created in the 
Simple Codes setup file. These defaults are used by the system to determine where to 
position the cursor during final results entry when you use the Advanced Result Search tab 
in the My Results Worklist option or Results Entry option and select either the Final 
Entry, PAD, or FAD option buttons in the Find For: area. 
This option can be defined both at the user-specific level and the global (generic) level. 

Person Name Format  
Select one of the following formats for the names of personnel. This format is used for 
reporting purposes and displays on patient reports. The following formats are available: 

 Format I (First Last, Title) 
 Format II (First Last) 
 Format III (Last, First) 
 Format IV (Last, First, Title) 
 Format V (First MI, Last, Title) 
 Format VI (Last, First MI., Title) 

This option can only be defined on the global (generic) level. 
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Default Date Range to Search Final Dgn Entry 
Enter the number of days to look back for pending cases during final diagnosis entry. This 
default is applied when you use the Advanced Result Search tab in both the Result Entry 
and My Results Worklist options. 
This option can be defined both at the user-specific level and the global (generic) level. 

Default Number of Days to Pull Lab Result 
Enter the number of days to search back in the SoftLab database for associated patient 
laboratory results to import into the worksheet or report. 
This option can only be defined on the global (generic) level. 

Autoprint Unsigned Report 
Mark this check box to autogenerate unsigned final reports after completing the final 
diagnosis save routine. Additionally, use the grid to define the case type or accession 
sequence and the printer to be used for printing the associated reports.   
This option can only be defined on the global (generic) level. 

Activate Refresh after Completion of Save Routine 
This option allows you to define if the case information will be automatically updated in the 
displayed document each time a save routine is completed. If left unmarked, the system will 
only refresh the case information and update the info in the report after the document is 
saved and closed. 
NOTE: This option is provided as a tool to minimize the amount of time the system 

requires to move from case to case. 
Automatically Drop Logon ID into “Done By” Field 

Mark this check box to have the system automatically insert the user ID of the currently 
logged in user into the Done By field during final result, IOC entry, and QA entry. 
This option can be defined both at the user-specific level and the global (generic) level. 

Tumor Registry 
Mark this box to activate the ability to flag a case for the Tumor Registry report. A case will 

qualify for the Tumor Registry flag if the source has been marked as a biopsy in 
the source setup file. Cases may be flagged from Result Entry, QA Entry, and 
Sign Out Entry completion windows. 

Is PAD required before FAD 
Mark this check box if the provisional anatomic diagnosis (PAD) must be performed prior to 
the final anatomic diagnosis (FAD). 
This option can only be defined on the global (generic) level. 

Require Reason/Comment 
Mark this check box to have the system prompt the user to enter a Report Reason or 
Comment during completion of a Revised report. 

QA on-line in Result Entry 
If marked, the QA Online window will display after the confirmation of completion of Final 
Diagnosis in the Result Entry option.   
This option can be defined on both the global (generic) and User levels. 

Dx Coding Required for Case Types (Autopsy, GYN Cytology, MED Cytology, Surgical) 
Mark the case types for which diagnosis codes are a required field. 
This option can only be defined on the global (generic) level. 

Diagnosis without a Pathologist ID 
Mark this check box to indicate that a diagnosis may be entered without a Pathologist ID. 
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This option can only be defined on the global (generic) level. 
Use Tree Grid Display for Cascade Windows 

Mark this check box if you want to enable the tree grid display for cascade windows. 
This option can be defined on both the user and global (generic) level. 

Activate Cancer Agency Report 
Mark this check box to enable the display of the “Qualifies for Cancer Agency Report” 
check boxes within the final diagnosis, QA entry, and Sign Out entry completion windows. 
If flagged, that case will then be displayed in the Cancer Agency Report. See Chapter 5.3 – 
Reports: Cancer Agency Report. 
This setting may be defined at both the global (generic) and the user levels. 

Enable Multiple Window Display 
Mark this check box for the ability to display and enter data in multiple windows 
simultaneously in the system. With this check box marked, users are able to open two 
options on the screen simultaneously, perform data entry in each option, and switch between 
options. This functionality is limited to Case Results (either MS Word or RTF Editor), 
Specimen Registration, One Case Processing, and Patient Maintenance options. 
This setting may be defined at both the global (generic) and the user levels.  

Billing Worksheet Autogenerate to Printer 
Select the printer you want to use to print automatically generated billing worksheets.  If no 
printer is defined, billing worksheets will not print. 
This option can only be defined on the global (generic) level. 

Default Tab in Result Entry  
Select either the Advanced Result Search or Simple Search tab as the default tab in the 
Result Entry Search window. 
This option can be defined both at the user-specific level and the global (generic) level. 

Autogenerate to Print After IOC  
Define a printer to print an unsigned report after the completion of the IOC activity to 
activate this functionality.  If no printer is defined, the system will not print the report 
automatically. 
This option can only be defined on the global (generic) level. 

Import Preliminary Text to Final Report 
If selected, the system will automatically import the entire text of the most current 
preliminary report into the final report. 
This option can only be defined on the global (generic) level. 

Prompt User to Import Preliminary Text to Final 
If selected, the system will prompt the user to import the preliminary text into the final 
report.  This check box is only enabled if automatic import is not marked. 

Import Preliminary Sections into Final Sections 
If selected, the system will automatically import the individual documents sections from 
preliminary sections into the corresponding sections in the final report.  
This option can only be defined on the global (generic) level. 
NOTE: This option is only available if the Import Preliminary text to Final check box is 
unmarked. 

Display DX Cat Message 
Mark this check box to have the system prompt the user to accept the current Dx category 
each time the final diagnosis is changed. 



Chapter 6.4- Setup: Options SoftPath GUI v.4.2.1 User Manual 

Page 6-138  PATH4.2-G-U (6th Ed, Rel. 01/31/07) 

This option can be defined on both the global (generic) and User levels. 
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Final Results (cont) Tab 
The Final Results (cont) tab displays similar to Figure 6-77. 

 
Figure 6-77. Options Window - Result Entry Tab – Final Results (cont) Tab 

Prompt to Flag Final Diagnosis as Completed 
Select one of the following rules to determine the method of marking the Final Diagnosis as 
completed:     
• Prompt for Final Diagnosis Complete - Prompts the user for the completion status of 

the Final Diagnosis and the Final Diagnosis Completed checkbox is masked in the Final 
Diagnosis save window.   

• Default Completed Checkbox to Marked - the Final Diagnosis checkbox in the Final 
Diagnosis save window is marked and the case is flagged as Final Diagnosis complete 
when saved. 

• Default Completed Checkbox to Unmarked - the Final Diagnosis checkbox in the 
Final Diagnosis save window is unmarked and the case is flagged as Final Diagnosis 
incomplete when saved. 

 This option can be defined on both the global (generic) and User levels. 
Display Prompt to Update Screener Evidence Count 

Mark this check box to display a prompt to "Update Screener Evidence Count" in Result 
Entry and QA Entry.   
This option can be defined on both the global (generic) and User levels. 

Permission to Over-ride Maximum Slide Limit Message 
Mark this check box if when the system prompts "Maximum slide limit will be exceeded,” if 
the user has the ability to over-ride the message. This option is dependent on the activation 
of the Screening Evidence setting and the value defined as the Daily Slides Screen Limit 
field in the Personnel File.  
This option can be defined on both the global (generic) and User levels. 
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Auto Assign Dx Cat Based on Dx Code 
Mark each case corresponding check box to define if Dx Categories will automatically be 
assigned to that case type based on the diagnosis codes selected.  
This option can be defined on both the global (generic) and User levels. 
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Dx Coding Tab 
The Dx Coding tab displays similar to Figure 6-78. 

 
Figure 6-78. Options Window - Result Entry Tab - Dx Coding Tab 

Case Types Having Automatic Insertion of Dx Codes 
Mark the check boxes to indicate which case types will have diagnosis codes inserted 
automatically by SoftPath based on the text entered in the Final Diagnosis section. 
This option can only be defined on the global (generic) level. 
NOTE: Do not select GYN Cytology if the resulting workflow has been configured for 

cascade window use. Dx Cods for cascade windows are imported from the code 
selected, not the diagnosis text. 

Source will be Scanned when Dx Coding 
Mark this check box if you want the system to include the source in the diagnostic coding of 
the case. 
This option can only be defined on the global (generic) level. 

Auto Insertion of Dx Codes  
Mark this check box if you want the system to automatically insert the diagnosis codes into 
the report completion window based on the system selection of diagnosis codes. This option 
applies only to case types selected in the Case Types Having Automatic Insertion of Dx 
Codes area. If the case type is unmarked in the Case Types Having Automatic Insertion of 
Dx Codes area but is marked in the Automatic Insertion of Dx Codes area, the system will 
display the codes collated by the system for confirmation by the user prior to inserting them. 
This allows the user to add or remove codes from those selected by the system within the 
same processing step. 
This option can only be defined on the global (generic) level. 
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Percentage Usage of DxCode Pattern 
This field allows you to define what percentage of SNOMED code text must be matched 
during a search. The higher the percentage, the more rigid the search and fewer search 
results will be generated. 

Method of Dx Searching 
This drop-down list allows you to select a predetermined search method of SNOMED codes, 
according to how thorough you would like code searching to be. The three options contained 
in the list are Precise, Normal, and Fast. 

GYN Cytology, MED Cytology, Surgical, and Autopsy DX Coding System 
Select the diagnostic coding system from the drop-down list for each of the four case types, 
Bethesda Codes, DRG Codes, ICD9 Codes, SNOMED Codes, and Canned Diagnosis Codes. 
This option can only be defined on the global (generic) level. 

Code Filtering 
Select up to 10 SNOMED Prefixes, which can be defined in the Simple Codes Setup file, to 
limit the search. The grid displays the code prefix and the code description. By default, no 
filtering is defined. 
NOTE: Functionality is available in SoftPath versions 4.2.1.6 and higher. 
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Letters Tab 
The Letters tab (Figure 6-79) allows you to designate which letter types will be available within the 
various system menu options.  

 
Figure 6-79. Options Window - Result Entry Tab - Letters Tab 

Select the form type from the drop-down list and then mark the check boxes for the letters that you 
want to be available for the selected form type.  
The following letters can be associated with the selected form type: 

Outgoing Form 
The selected form type will be displayed for the user to select wherever an outgoing 
consultation letter is available for selection. 

Incoming Form 
The selected form type will be displayed for the user to select wherever an incoming request 
letter is available for selection. 

Incoming Form Return Form 
The selected form type will be displayed for the user to select wherever an incoming return 
letter is available for selection. 

Insurance 
The selected form type will be displayed for the user to select wherever an insurance letter is 
available for selection. 

Follow Up Letter 
The selected form type will be displayed when a follow-up letter is available for selection. 

Fax Cover Page 
The selected form type will be displayed when a fax cover page is available for selection. 

This option can only be defined on the global (generic) level. 
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My Result Worklist 
The My Result Worklist option allows you to create a pending list for resulting based on the criteria 
set within the search window. This option also allows you to auto-invoke the final report, minimizing 
the keystrokes required for report selection during result entry when working with a list of pending 
cases. The My Result Worklist tab will display similar to Figure 6-80.   

 
Figure 6-80. Options Window - Result Entry Tab - My Result Worklist Tab 

Path ID 
Enter a pathologist ID to use when collating cases for result entry or click the  button to 
select from a list of active pathologist ID codes. You can enter a maximum of three 
pathologist ID codes.  
This option can be defined both at the user-specific level and the global (generic) level. 

Resident ID 
Enter a resident ID to use when collating cases for the My Results Worklist option or click 
the  button to select from a list of active resident ID codes. You can enter a maximum of 
three resident ID codes.  
This option can be defined both at the user-specific level and the global (generic) level. 

Deiner ID 
Enter a deiner ID to use to collate cases for the My Results Worklist option or click the  
button to select from a list of active deiner ID codes. 
This option can be defined both at the user-specific level and the global (generic) level. 

Acc Group 
Enter an accession group to use to collate cases for the My Results Worklist option or click 
the  button to select from a list of active accession group codes. 
This option can be defined both at the user-specific level and the global (generic) level. 
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Auto Invoke Final 
Mark this check box to always display the final report for the first qualifying case 
automatically in the My Results Worklist tab. After the report displays in MS Word format, 
the user can click the Next and Previous buttons to move between reports for all selected 
cases.  
If this check box is left unmarked, the user will always have to make the report selection for 
the first case. 
NOTE: This setting also affects the auto-invoke capability of the My Workspace 

option. 
This option can be defined both at the user-specific level and the global (generic) level. 

Hide Search Tabs 
Mark this check box to hide the search tabs when the user accesses the My Results 
Worklist option. This allows you to restrict displayed results to only cases that match the 
default search criteria and denies users the ability to access other cases by using the search 
tabs.  
If this check box is left blank, the search tabs will be available for use in the My Results 
Worklist option, allowing users to select any case currently in the system. 
This option can be defined both at the user-specific level and the global (generic) level. 

Case Type Area and Pending For Area 
Select a case type from the drop-down list and select the corresponding materials desired for 
the selected case type. Repeat this process for each case type you want users to process using 
the My Results Worklist option.  
Next, select the pending procedures for the cases in the Pending For: area. These settings 
are used in conjunction with the case type and the materials selected to produce the pending 
list of cases. 
This option can be defined both at the user-specific level and the global (generic) level. 

Default Text Editor for Result Entry 
Select the default text editor for Result Entry from the drop-down list.  Choose from RTF 
format and Microsoft Word as the default text editor. 
This option can be defined at both the user-specific and the global (generic) level. 

Default Text Editor for QA Entry  
Select the default text editor for QA Entry from the drop-down list.  Choose from RTF 
format and Microsoft Word as the default text editor. 
This option can be defined at both the user-specific and the global (generic) level. 
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Quality Assurance Tab 

To access the Quality Assurance tab, select Setup > Options from the main menu and then select 
Quality Assurance from the Parameter Group list. The Quality Assurance tab (Figure 6-81) is 
displayed. Click Edit on the toolbar to make changes to any of the parameters. 

 
Figure 6-81. Options Window – Quality Assurance Tab 

The Quality Assurance tab contains the following tabs: 
 Common  
 QA Limits 
 Random 
 My QA Worklist 
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Common Tab 
The Common tab displays similar to Figure 6-82. 

 
Figure 6-82. Options Window - Quality Assurance tab - Common Tab 

Canned Message Type for Comment 
Select the canned message type you want to display by default when users select the Canned 
Message option when entering QA comments.  
This option can only be defined on the global (generic) level. 

Default Qualification for Advanced QA Search 
Select the qualification status you want to use as the default for the Advanced QA Search 
tab.  
This option can be defined both at the user-specific level and the global (generic) level. 

Default Search Rules for Worksheet 
Select the qualification status you want to use as the default for the Worksheet Search tab. 
This option can be defined both at the user-specific level and the global (generic) level. 

Default Procedure Status for Worksheet 
Select a default procedure status for the Worksheet Search tab. 
This option can be defined both at the user-specific level and the global (generic) level. 

Default Procedure Status for Log/Report 
Select a default procedure status for QA logs or reports. 
This option can be defined both at the user-specific level and the global (generic) level. 

Default FS/Gross Intraoperative for Pending 
Select the default value for the FS/Gross IOC field of the Worksheet Search tab. 
This option can be defined both at the user-specific level and the global (generic) level. 

Default Normal/Abnormal for Worksheet 
Select the default value for the Normal/Abnormal field of the Worksheet Search tab. 
This option can be defined both at the user-specific level and the global (generic) level. 
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Default Procedure Status for IOC Report/Log Worksheet 
Select the default status of procedures to be included in the IOC report/log worksheet. 
This option can be defined at both the user-specific and global (generic) levels. 

Display QA Qualification Message 
Mark this check box to display a reminder message when saving if the case has qualified for 
QA based on the Case Comparison setup. 
This option can be defined at both the user-specific and global (generic) levels. 

Display Random QA Qualification Message 
Mark this check box to display a reminder message when saving if a case has qualified for 
Random QA.   
This option can be defined at both the user-specific and global (generic) levels. 

QA Online Default Assigned To ID 
This field allows you to enter the User ID that you would like to be the default Assigned To 
ID in the QA On-line screen. The ID entered will be defaulted into the Assigned To field of 
that screen. 
This option can be defined both at the user-specific level and the global (generic) level. 

Default Search Range for Entry/Worksheet 
Enter the default number of days to look back for cases that require QA results entry or that 
belong on the Worksheet. 
This option can be defined both at the user-specific level and the global (generic) level. 

Default Search Range for Entry/Worksheet 
Enter the default number of days to look back for cases that require QA Results Entry or that 
belong on the worksheet.  
This option can be defined both at the user-specific level and the global (generic) level. 

Default Search Range for Log/Report 
Enter the default number of days to look back for cases to include in QA logs or reports.  
This option can be defined both at the user-specific level and the global (generic) level. 

Follow Up Entry Date Range 
Enter the default number of days for the Advanced QA Search tab that will be used when 
the Follow Up option button is selected. 
This option can be defined both at the user-specific level and the global (generic) level. 

Default Sort Rules for Log/Report 
Select the default sort rules for QA logs and reports.  
This option can be defined both at the user-specific level and the global (generic) level. 

Default Sort Rules for Worksheet 
Select the default sort rules for the QA worksheet.  
This option can be defined both at the user-specific level and the global (generic) level. 

Default Sort Rules for QA Summary 
Select the default sort rules for the QA Summary report/log. 
This option can be defined at both the user-specific and global (generic) levels. 

Default QA Codes for Surgical, Med Cytology, GYN Cytology, and Autopsy Cases 
Select the default QA codes to be displayed in the QA Code field of QA Entry.  
This option can be defined at both the user-specific and global (generic) levels. 
 
 



SoftPath GUI v.4.2.1 User Manual Chapter 6.4 – Setup: Options 

PATH4.2-G-U (6th Ed, Rel. 01/31/07)   Page 6-149 

QA Limits Tab 
The QA Limits tab displays similar to Figure 6-83. 

 
Figure 6-83. Options Window - Quality Assurance tab - QA Limits Tab 

Entering Limit for Rescreening, Proreview, Retroreview, IOC Correlation, Follow Up 
Correlation, and Autopsy Correlation in Days after Sign Out 

Enter the maximum number of days after sign out that the corresponding QA procedure can 
still be performed. Once the time entered has expired, the QA procedure will be available for 
documentation within the Action Entry option.  
These options can only be defined on the global (generic) level. 
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Random Tab 
The Random tab (Figure 6-84) allows you to define quality assurance settings. Using this tab, you 
can enter the percentage of cases of a given case type that will be selected for random retroreview, 
proreview, and/or rescreen. 

 
Figure 6-84. Options Window - Quality Assurance tab - Random Tab 

Percent for Random Rescreening – Negative Cases with/without High Risk 
Enter the separated percentages of High Risk and non-High Risk cases that that you want 
selected for random rescreening. The percentages entered will be used as the global random 
percentage and the percentage when the screener random percentage set in personnel is equal 
to "0.”  
This option can only be defined on the global (generic) level. 

Percent for Random Retroreview and Proreview 
Enter the percentage of cases that you want selected for random retroreview or proreview. 
The percentages entered in these fields are used in conjunction with the case types you select 
for each QA procedure in the bottom half of the window to determine what percentage of 
each case type will be selected for random QA. All cases that have a normal diagnosis will 
be included in the random QA selection process based on the diagnosis codes and/or 
diagnosis category associated with the case. No cases containing an abnormal diagnosis will 
be selected for random QA. The Case Comparison Setup option should be used to set up all 
scenarios required for the QA of abnormal cases. 
This option can only be defined on the global (generic) level. 

Include High Risk Cases in Random Rescreen 
Mark this check box to include all negative cases for High Risk patients in the Random 
Rescreen draw. 

Rescreen, Proreview, Retroreview Check boxes 
Select the random QA procedures you want to perform for each of the four case types. 
This option can only be defined on the global (generic) level. 
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My QA Worklist Tab 
The My QA Worklist option allows you to create a pending list for resulting based on the criteria 
set within the search window. This option also allows you to auto-invoke the final report, minimizing 
the keystrokes required for report selection during result entry when working with a list of pending 
cases for QA. The My QA Worklist tab displays similar to Figure 6-85. 

 
Figure 6-85. Options Window - Quality Assurance tab – My QA Worklist Tab 

Acc Group 
Enter an accession group to use to collate cases for the My QA Worklist option or click the 

 button to select from a list of active accession group codes. 
This option can be defined both at the user-specific level and the global (generic) level. 

Path ID 
Enter a Pathologist ID or click the  button to select from a list of active pathologist ID 
codes. You can enter a maximum of three pathologist ID codes.  
This option can be defined both at the user-specific level and the global (generic) level. 

Resident ID 
Enter a resident ID or click the  button to select from a list of active resident ID codes. 
You can enter a maximum of three resident ID codes.  
This option can be defined both at the user-specific level and the global (generic) level. 

Screener ID 
Enter a Screener ID or click the  button to select from a list of active screeners. You can 
enter a maximum of three Screener ID codes. 
This option can be defined both at the user-specific level and the global (generic) level. 
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Case Type Area and Pending For Area 
Select a case type from the drop-down list and select the corresponding materials desired for 
the selected case type. Repeat this process for each case type you want users to process using 
the My QA Worklist option.  
Next, select the pending procedures for the cases in the Pending For: area. These settings 
are used in conjunction with the case type and the materials selected to produce the pending 
list of cases. 
This option can be defined both at the user-specific level and the global (generic) level. 

Auto Invoke Final 
Mark this check box to always display the final report for the first qualifying case 
automatically in the My QA Worklist tab. The report opens using the default text editor 
(Word or RTF). After the report displays, the user can click the Next and Previous buttons 
to move between reports for all selected cases.  
If this check box is left unmarked, the user will always have to make the report selection for 
the first case. 
NOTE: This setting also affects the auto-invoke capability of the My Workspace option. 
This option can be defined both at the user-specific level and the global (generic) level. 

Hide Search Tabs 
Mark this check box to hide the search tabs when the user accesses the My QA Worklist 
option. This allows you to restrict displayed results to only cases that match the default 
search criteria and denies users the ability to access other cases by using the search tabs.  
If this check box is left blank, the search tabs will be available for use in the My QA 
Worklist option, allowing users to select any case currently in the system. 
This option can be defined both at the user-specific level and the global (generic) level. 
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Sign Out Tab 

To access the Sign Out tab, select Setup > Options from the main menu and then select Sign Out 
from the Parameter Group list. The Sign Out tab (Figure 6-81) is displayed. Click Edit on the 
toolbar to make changes to any of the parameters. 

 
Figure 6-86. Options Window – Sign Out Tab 

The Sign Out tab contains the following tabs: 
 Sign Out 
 My Sign Out Worklist 
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Sign Out Tab 
This Sign Out tab (Figure 6-87) allows you to establish sign out defaults.  

 
Figure 6-87. Options Window - Sign Out tab  

Sign Out Flags 
Display Sign Out ID Window in Fast Sign Out 

If you mark this check box, a window containing available sign out ID is displayed 
for the user to select an appropriate sign out ID when the user accesses the Fast Sign 
Out option.  
If this check box is left unmarked, a small search window is displayed when a user 
accesses any Sign Out Entry option, allowing the user to specify additional search 
criteria.  
This option can only be defined on the global (generic) level. 

No Warning about Service Units 
Mark this check box if you do not want the system to prompt users (during the sign 
out process) to add service units when they are missing from a surgical case. 
This option can only be defined on the global (generic) level. 

Ability to S/O Only for Logged on Pathologist 
If you mark this check box, the user will only be able to sign out a case using the 
current login ID in any Sign Out Entry option. The current login ID is 
automatically inserted into the Sign Out ID field and cannot be edited.  
If this check box is marked and the Display Sign Out ID Window in Fast Sign Out 
check box is also marked, a window will not be displayed for sign out ID selection 
when any Sign Out Entry option is accessed. The system will automatically use the 
login ID to collate the listing of cases, restricting the current user to only their cases 
with no ability to change the search criteria.  
This option can only be defined on the global (generic) level. 
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QA On-Line in Sign Out Entry 
Mark this check box to display the QA On-Line window during sign out entry. This 
setting does not affect the Fast Sign Out option. 
This option can only be defined on the global (generic) level. 

Auto Sign Out ID 
Check the appropriate boxes to indicate which case types you want the system to default the 
current login ID into the Sign Out ID field. This setting affects all sign out options where 
the Sign Out ID field is an editable entry. 
This option can only be defined on the global (generic) level. 

Required Case Status for Fast Sign Out 
Define the required processing status the cases must have to qualify for the Fast Sign Out 
option. Click the drop-down list button to display available options. 
This option can only be defined on the global (generic) level. 

Cursor Position in Sign Out 
Define the default cursor position for the search window when a user accesses any Sign Out 
Entry option. Click the drop-down list button to display the available options. 
This option can be defined both at the user-specific level and the global (generic) level. 

Mask Screener ID if the Same as Sign Out ID 
Mark this check box to define if the Screener ID will be masked on the final report if it is the 
same as the Sign Out ID for the report.  
This option can only be defined on the global (generic) level. 

Display Sign Out Confirmation Message 
Mark this check box to have the system display a message to confirm the sign out of any 
case. 
This option can be defined both at the user-specific level and the global (generic) level. 

Default Date Range in Sign Out by Case Range 
Define the default date range by clicking the arrows to select the desired number. 
This option can only be defined on the global (generic) level. 

Hold Time After Sign Out 
Enter a number to indicate how long a case should be held after sign out. If defined, the 
case(s) shall not be sent to the Print Server, HIS, or Query until the time has elapsed. 
This option can be defined both at the user-specific level and the global (generic) level. 

Units to Measure Hold Time 
Select the unit in time that will be used in conjunction with the value entered in the Hold 
Time After Sign Out field to determine the hold time. 
This option can be defined both at the user-specific level and the global (generic) level. 
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My Sign Out Worklist Tab 
The My Sign Out Worklist tab (Figure 6-88) allows you to establish sign out defaults for the option 
My Sign Out Worklist.  

 
Figure 6-88. Options Window - Sign Out tab - My Sign Out Worklist Tab 

Login ID or Sign Out ID 
Select the Login ID option button to use the current login ID as the default search criteria for 
the My Sign Out Worklist option.  
Select the Sign Out ID option button and enter an ID or click the  button to select from the 
list of active personnel with permission to sign out cases. This option allows you to use a 
different ID as the default search criteria for the My Sign Out Worklist option.  
NOTE: If the Ability to S/O Cases only for Logged on Pathologist check box in the 

Sign Out tab is marked this setting shall be disregarded and the login ID will 
always be used. 

This option can be defined both at the user-specific level and the global (generic) level. 
Case Type 

Select up to a maximum of four case types as the default search criteria in the My Sign Out 
Worklist option. 
This option can be defined both at the user-specific level and the global (generic) level. 

Acc Group 
Enter an accession group as the default search criteria in My Sign Out Worklist. You can 
click the  button to select from a list of valid accession group codes. 
This option can be defined both at the user-specific level and the global (generic) level. 

Only Completed Cases 
Mark this check box if you want only completed cases to be included in the default search 
for the My Sign Out Worklist option. 
This option can be defined both at the user-specific level and the global (generic) level. 
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Allow Edit of Search 
Mark this check box to allow the user to edit the search criteria in the My Sign Out 
Worklist option. Leave this check box unmarked to limit the user to the default criteria 
specified on this tab.  
This option can be defined both at the user-specific level and the global (generic) level. 

Invoke Search on Entry 
Mark this check box to automatically begin a search based on the default criteria when a user 
accesses the My Sign Out Worklist option. Unmark this check box to display the search 
window with the default criteria when the user accesses the My Sign Out Worklist option. 
This option can be defined both at the user-specific level and the global (generic) level. 
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Query Tab 

To access the Query tab, select Setup > Options from the main menu and then select Query from 
the Parameter Group list. The Query tab (Figure 6-89) is displayed. Click Edit on the toolbar to 
make changes to any of the parameters. 

 
Figure 6-89. Options Window - Query Tab 

Reports Displayed in Query 
Mark the check boxes next to the reports you want to display in the Reports tab of the 
Query options. 
This option can only be defined on the global (generic) level. 

Default Cursor position in Case Query 
Select the field you want the cursor positioned in when a user first accesses a Query option.  
This option can be defined both at the user-specific level and the global (generic) level. 

Date Range for Complex Query 
Enter the default number of days back to look for qualifying cases in the Complex Query 
option. 
This option can be defined both at the user-specific level and the global (generic) level. 
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Document Printing Tab 

To access the Document Printing tab, select Setup > Options from the main menu and then select 
Document Printing from the Parameter Group list. The Document Printing tab (Figure 6-90) is 
displayed. Click Edit on the toolbar to make changes to any of the parameters. 

 
Figure 6-90. Options Window – Document Printing Tab 

The Document Printing tab contains the following tabs: 
 Patient Reports 
 Worksheets 
 Letters 
 Logs 
 Management Reports 
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Patient Reports Tab 
The Patient Reports tab displays similar to Figure 6-91. 

 
Figure 6-91. Options Window - Document Printing Tab - Patient Reports Tab 

Default Case Type 
Select the default case type to use for searches. 
This option can be defined both at the user-specific level and the global (generic) level. 

Default Type 
Select the default report type to use for searches.  
This option can be defined both at the user-specific level and the global (generic) level. 

Default Print 
Select the default print job case status to display when users access the search window.  
This option can be defined both at the user-specific level and the global (generic) level. 

Default Status 
Select the default print status to use for searches.  
This option can be defined both at the user-specific level and the global (generic) level. 

Batch Restart # of Copies Based on MRN for SUR, MED, GYN, AUT 
Enter the default number of copies to print for each of the case types when batch printing is 
used. 
This option can only be defined on the global (generic) level. 

Patient Types Pulling Ward of DIS when Discharged 
Mark the check boxes to indicate which patient types should have the word DISCHARGED 
printed on their patient reports when the discharge macro is included in the report format. 
This option can only be defined on the global (generic) level. 
NOTE:  The word DISCHARGED only prints on the final report when the patient is 

discharged prior to the sign out date. Once the case has been signed out the 
report becomes static and cannot be modified unless it is revised. 
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Final Report Collation Display 
Mark this check box if you want to display the selection “All-Collated” in the Type field 
drop-down menu of the Results Report Option. This option has the system find every report 
available for a case, rather than just the report type you specified. From there, the Final 
Report Collation can be printed in its entirety.  
This option can be defined both at the user-specific level and the global (generic) level. 

Hide empty report sections 
Mark this check box if you want to hide empty report sections in the printed copy of the final 
report. 
This option can only be defined on the global (generic) level. 

Batch Restart - Print Copy for Admitting 
Mark this check box if you want to print copies of the reports with the banner pages for 
admitting doctors when batch printing is used. 
This option can only be defined on the global (generic) level. 

Batch Restart - Print Copy for Attending 
Mark this check box if you want to print copies of the reports with the banner pages for 
attending doctors when batch printing is used. 
This option can only be defined on the global (generic) level. 

Batch Restart - Print Copy for Requesting Doctor 
Mark this check box if you want to print copies of reports with the banner pages for 
requesting doctors when batch printing is used. 
This option can only be defined on the global (generic) level. 

Batch Restart - Print Copy for Doctors and Associated Clinics 
Mark this check box if when a batch job is generated, you want to print the total number of 
copies designated in the Doctors setup file plus the copies designated in the Clinics setup 
file. 
This option can only be defined on the global (generic) level. 

Batch Restart - Print Copy for Billing purposes 
Mark this check box if you want to print copies of reports for billing purposes with the 
pending reports when using the Print Scheduler.  
This option can only be defined on the global (generic) level. 

Batch Restart - Print Copy to Chart 
Mark this check box if you want to print copies of reports for medical records with the 
pending reports when using the Print Scheduler. 
This option can only be defined on the global (generic) level. 

Display Sign Out ID and Name fields before Sign Out 
Mark this check box if you want the sign out ID & name (from the signature template setup) 
to display on the unsigned report. 
NOTE: The signature graphic will not display on the document. 

Expanded Clinic and Requesting Doctor Search 
Mark this check box if you would like to expand searching in Result Reports to 25 Req 
Doctor and Clinic codes each. 

Default Display of Flag Check box 
Mark this check box to display the “Flag” check box in the Results Report search screen, as 
marked by default. 
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Number of Final Report Copies for Surgical, MED, GYN, and Autopsy 
Enter the default number of copies to print for each case type when batch printing is not used 
to print signed out reports.  
This option can only be defined on the global (generic) level. 

Default Date Range for Document Printing 
Enter the default number of days to use as the date range of patient reports. 
This option can be defined both at the user-specific level and the global (generic) level. 

Number of Final Report Copies Regardless of Type 
Enter the default number of copies to print of signed out reports regardless of type when 
batch printing is not used.  
This option can only be defined on the global (generic) level. 

Number of Final Report Copies for Billing purposes 
Enter the default number of copies to print for billing purposes.   
This option can only be defined on the global (generic) level. 

Number of Final Report Copies for chart purposes 
Enter the default number of copies to print to be sent to Medical Records.   
This option can only be defined on the global (generic) level. 
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Worksheets Tab 
The Worksheets tab displays similar to Figure 6-92. 

 
Figure 6-92. Options Window - Document Printing Tab - Worksheets Tab 

Default Case Type 
Select the default case type to use in the worksheet Search window.  
This option can be defined both at the user-specific level and the global (generic) level. 

Default Status 
Select the default print status for the worksheets in the worksheet Search window. 
This option can be defined both at the user-specific level and the global (generic) level. 

Case Types Requiring Gross to Print Worksheets 
Select the case types that require a completed gross description before they qualify for the 
pending list for worksheet printing.  
This option can only be defined on the global (generic) level. 

Case Types Requiring Worksheets for Results 
Select the case types that requiring that the worksheet be printed before qualifying for the 
pending results list(s).  
This option can only be defined on the global (generic) level. 

Qualify Incomplete Stains to Pending Stains Worksheet Regardless of Sign Out Status 
Mark this check box if stains that are still in the incomplete status qualify for the Pending 
Stain Worksheet. 
This option can only be defined on the global (generic) level. 
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Letters Tab 
The Letters tab (Figure 6-93) allows you to define default search criteria to be used when printing 
letters. 

 
Figure 6-93. Options Window - Document Printing Tab - Letters Tab 

Letter Type 
Mark the appropriate check boxes to use the selected letter types as defaults in the search 
window. 
This option can be defined both at the user-specific level and the global (generic) level. 

Case Type 
Mark the check boxes next to the case types that will default in the search window. 
This option can be defined both at the user-specific level and the global (generic) level. 

Status 
Select the default print status for the search window. 
This option can be defined both at the user-specific level and the global (generic) level. 
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Logs Tab 
The Logs tab displays similar to Figure 6-94. 

 
Figure 6-94. Options Window - Document Printing Tab - Logs Tab 

Daily Result Log Date Range 
Enter the default number of days to look back for cases in the Daily Result Log search 
window.  
This option can be defined both at the user-specific level and the global (generic) level. 

Stain Log Order Range 
Enter the default number of days to look back for cases to be included in the search window 
for the Special Stains Log.  
This option can be defined both at the user-specific level and the global (generic) level. 

Block Log Order Range 
Enter the default number of days to look back for cases in the Daily Block Log search 
window.  
This option can be defined both at the user-specific level and the global (generic) level. 

Embedding Log Order Range 
Enter the default number of days to look back for cases in the Embedded Blocks Log search 
window.  
This option can be defined both at the user-specific level and the global (generic) level. 

Specimen Log Order Range 
Enter the default number of days to look back for cases in the Specimen Status Log search 
window. 
This option can be defined both at the user-specific level and the global (generic) level. 
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Daily Log Order Range 
Enter the default number of days to look back for cases in the Daily Accession Log search 
window. 
This option can be defined both at the user-specific level and the global (generic) level. 

Daily Log - Format Report 
Select either format 1 or 2 (long or short) as the default report format for the Daily 
Accession Log search window. 
This option can be defined both at the user-specific level and the global (generic) level. 

Autopsy Case Report Date Range 
Enter the default number of days to look back for cases in the Autopsy Case Report search 
window 
This option can be defined both at the user-specific level and the global (generic) level. 

Default Date Range for Logs   
Enter the default number of days to look back for cases to be included in the search window 
for the following logs: Cytology Slides Log, Deleted Cases Log, Resulted Cases Log, 
Revised Cases Log, Daily Cases Log, Daily Blocks Log, Deleted Specimen Log, Histology 
Slides Log, and Specimen Status Log. 
This option can be defined both at the user-specific level and the global (generic) level. 

Default Search Range for Log/Report  
Enter the default number of days to look back for cases in the Action Logs search window. 
This setting is used for the Log and Report tabs in the Action Log option. 
This option can be defined both at the user-specific level and the global (generic) level. 

Default Action Status for Action Log 
Select either All, Completed, or Not Completed as the default action status for the Action 
Log search window. This default is used for all tabs in the Action Logs option. 
This option can be defined both at the user-specific level and the global (generic) level. 

Block Description 
Select the block descriptions for each available log type from the drop-down list at the top of 
the window. After you select the log type, mark the appropriate check boxes to indicate 
which block descriptions you want to appear on the selected log. Repeat the selection 
process for each available log type. 
This option can be defined both at the user-specific level and the global (generic) level. 

Sort Rules 
Select the default sort rules for each of the available log types from the drop-down lists. You 
can select up to three sort rules for the selected log type. Repeat the selection process for 
each available log type. 
This option can be defined both at the user-specific level and the global (generic) level. 

Default Sort Rules for Log/Report 
Select the default sort rules for the Action Log and Action Report search windows. The 
selected default sort rules are used in the search screens for the Log and the Report tabs in 
the Action Logs option. 
This option can be defined both at the user-specific level and the global (generic) level. 
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Management Reports Tab 
The Management Reports tab displays similar to Figure 6-95. 

 
Figure 6-95. Options Window - Document Printing Tab - Management Reports Tab 

Specimen Adequacy Report Date Range 
Enter the default number of days to look back for cases in the Specimen Adequacy Report 
search window. 
This option can be defined both at the user-specific level and the global (generic) level. 

Case Status Log Date Range 
Enter the default number of days to look back for cases in the Case Status Log search 
window. 
This option can be defined both at the user-specific level and the global (generic) level.  

Incoming Consultation Log Date Range 
Enter the default number of days to look back for cases in the Incoming Consultation Log 
search window.  
This option can be defined both at the user-specific level and the global (generic) level. 

Outgoing Consultation Date Range 
Enter the default number of days to look back for cases in the Outgoing Consultation Log 
search window.  
This option can be defined both at the user-specific level and the global (generic) level. 

Consultation Discrepancy Report Date Range 
Enter the default number of days to look back for cases in the Consultation Discrepancy 
Report search window.  
This option can be defined both at the user-specific level and the global (generic) level. 
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Cytology-Histology Comparison Report Date Range 
Enter the default number of days to look back for cases in the Cytology-Histology 
Comparison Report search window.  
This option can be defined both at the user-specific level and the global (generic) level. 

TAT Date Range 
Enter the default number of days to look back for cases in the Turnaround Time Report 
search window.  
This option can be defined both at the user-specific level and the global (generic) level. 

TAT Exclude Free Days 
Mark this check box to exclude non-working days from the turnaround time calculation. 
Holidays can be added and edited in the Holiday Schedule tab.  
This option can only be defined on the global (generic) level. 
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Utilities Tab 

To access the Utilities tab, select Setup > Options from the main menu and then select Utilities from 
the Parameter Group list. The Utilities tab (Figure 6-96) is displayed. Click Edit on the toolbar to 
make changes to any of the parameters. 

 
Figure 6-96. Options Window – Utilities Tab 

The Utilities tab contains the following tabs: 
 Screener Evidence 
 Billing 
 Billing, Cont. 
 Action Entry 
 Call Requests 
 Maintenance 
 Archive Utility 
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Screener Evidence Tab 
The Screener Evidence tab displays similar to Figure 6-97. 

 
Figure 6-97. Options Window - Utilities Tab - Screener Evidence Tab 

Default Hours in the Shift 
Enter the default number of hours in a normal shift. The number of hours you enter is used 
as the default for all new records added to the Personnel file. 
This option can only be defined on the global (generic) level. 

Daily Slide Screening Limit 
Enter the maximum number of slides that personnel are permitted to screen in a single shift. 
The limit you enter is used as the default for all new records added to the Personnel file.  
This option can only be defined on the global (generic) level. 
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Billing Tab 
The Billing tab displays similar to Figure 6-98. 

 
Figure 6-98. Options Window - Utilities tab - Billing Tab 

Date Range for Billing Statistics Report 
Enter the default number of days to look back for cases in the Billing Statistics Report 
search window 
This option can only be defined on the global (generic) level. 

Number of Days to Start Billing Reports 
Enter the default number of days to start billing reports in the Billing Report search 
window(s). 
This option can only be defined on the global (generic) level. 

Technical Billing A Online or after Signout 
Select the default of either On Line or Sign Out for technical billing part A from the drop-
down list. This default is used for the Billing Report search window(s). 
This option can only be defined on the global (generic) level. 

Professional Billing B Online or after Signout 
Select the default of either On Line or Sign Out for technical billing part B from the drop-
down list. This default is used for the Billing Report search window(s). 
This option can only be defined on the global (generic) level. 

Count Billing Automatically 
Mark this check box to allow the system to count billing automatically. If you leave this 
check box unmarked, the count must be done manually by running the Billing Report. 
This option can only be defined on the global (generic) level. 
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Assign ICD9 to Technical Billing 
Mark this check box to assign ICD9 to technical billing. A window that allows the user to 
assign ICD9 codes will be displayed at sign out. 
This option can only be defined on the global (generic) level. 

Assign ICD9 to Professional Billing 
Mark this check box to assign ICD9 to professional billing. A window that allows the user to 
assign ICD9 codes will be displayed at sign out. 
This option can only be defined on the global (generic) level. 

Assign ICD9 to Professional Billing after Sign Out 
Mark this check box if you want the system to display a window that allows users to assign 
ICD9 codes to professional billing when the case is signed out. 
This option can only be defined on the global (generic) level. 

Record Work on a Deleted Case or Specimen 
Mark this check box to record work on a deleted case or specimen. 
This option can only be defined on the global (generic) level. 

Edit Billing During Sign Out 
If you mark this check box, the system will display the billing Part A and Part B tabs during 
the Sign Out routine. 
This option can only be defined on the global (generic) level. 

Daily Recording of Unsigned Billing Part A - Technical Billing 
Mark this check box to record daily unsigned billing part A- Technical billing. 
This option can only be defined on the global (generic) level. 

Daily Recording of Unsigned Billing Part B - Professional Billing 
Mark this check box to record daily unsigned billing part B- Professional billing. 
This option can only be defined on the global (generic) level.  

Default Ordering Diagnosis to Billing ICD9  
Mark this check box to use the default ordering ICD9 codes as the final billing ICD9 codes 
during ICD9 assignment. 
This option can be defined both at the user-specific level and the global (generic) level. 

Default Manual Final ICD9 Codes to Unassigned CPT Codes 
Mark this check box to define if CPT codes without an assigned ICD-9 code will be 
automatically assigned the first manually entered ICD-9 code for the case. This auto 
assignment will occur when the Billing Report is created. This function is dependent on the 
Options settings Assign ICD9 to Technical Billing and Assign ICD9 to Professional 
Billing.  
This option can only be defined on the global (generic) level. 

Assign Ordering ICD9 to Final Billing ICD9 – Billing Report 
Mark this check box to define if the Ordering Diagnosis ICD-9 codes are applied to captured 
billing charges at the time of the collation of the Billing Report if no manual Final Diagnosis 
ICD-9 codes are assigned. By default, this option is be marked. At the time of creating a 
billing report, the system checks for cases with Ordering ICD-9 codes but no Final ICD-9 
assignment and then defaults the Ordering ICD-9 code (s) to each CPT as the Final ICD-9 
assignment.  The ICD-9 assignment is then saved to the charge record in the database for 
qualifying charges for the Billing Report run, which is dependant on the Assign ICD9 to 
technical billing and Assign ICD9 to professional billing fields. 
This option can only be defined on the global (generic) level. 
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Use Single Grid Style Billing Entry 
Mark this check box to use a single grid type of display for the Billing Entry functionality 
(Part A, Part B & Assign ICD9 to CPT Codes) used in Results Entry, QA Entry, Sign Out 
Entry and Billing Entry.   
This option can be defined both at the user-specific level and the global (generic) level. 

Patient Type to Qualify for Billing Class 
This area is used to define patient types that qualify for each billing class.  Select a billing 
class from the drop-down list and mark the check boxes next to all patient types that qualify 
for it. Repeat the selection process for each available billing class in the list. 
This option can only be defined on the global (generic) level. 

Default Billing Entry Tab 
If you select the Part A or Part B option buttons, the Billing Part A and Billing Part B tabs 
display when users save a case during the sign out process, allowing the users to enter billing 
information. If you select the Assign ICD9 to CPT Codes option button, the system 
displays the Assign ICD9 to CPT Codes tab when users save a case during the sign out 
process, allowing the users to associate ICD9 codes with CPT codes for the case.  
This option can only be defined on the global (generic) level. 

Enable Billing Report Qualifier “after Sign Out of all cases for patient” 
Mark this check box to enable the display of the Billing qualifier “after Sign Out of all cases 
for patient” in the Part A and Part B Qualification field of the Billing Report and Scheduler 
search screens. 
When selected in the Billing Report Search screen (and in Scheduler), cases will not qualify 
for the Billing report until all cases for the patient have been signed out.  
This option can only be defined on the global (generic) level. 
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Billing, Cont. Tab 
The Billing Cont. tab (Figure 6-99) allows you to define the information to be displayed in the 
Billing report. It also provides the ability to define a user-determined multi-site ID that will be used 
in the Billing transmission.  

 
Figure 6-99. Options Window – Utilities tab – Billing Cont Tab 

Case and Charge Sections 
These fields allow you to select the data that you would like to appear in the case and charge 
sections of your billing reports. The up and down function buttons located to the right of the 
selection windows allow you to establish your own order in which these fields will appear in 
the report. 

Multi-Site ID 
This window enables you to define a multi-site ID for each accession group active in your 
SoftPath system. The Accession Group column will display all accession groups defined in 
the Accession Group setup file. The Multi-Site ID column accepts free text entry.  

Copy Insurances from Patient Records 
From the drop-down list, select between 0 (zero) and 3 (three) insurances to import from the 
patient record to the case record.  
This option can only be defined on the global (generic) level. 
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Action Entry Tab 
The Action Entry tab displays similar to Figure 6-100. 

 
Figure 6-100. Options Window - Utilities Tab - Action Entry Tab 

Default Actions to Process 
Mark the check boxes next to the actions that you want the system to mark by default in the 
Action Log search window. 
This option can be defined both at the user-specific level and the global (generic) level. 

Limit to Edit Action 
Enter the maximum number of days after the action has been completed that a user is 
permitted to edit the action. 
This option can only be defined on the global (generic) level. 

Default Search Range for Action Entry 
Enter the default number of days to look back for cases in the Action Entry search window. 
This option can be defined both at the user-specific level and the global (generic) level. 

Default Action Status for Action Entry 
Select the default action status for cases in the Action Entry search window.  
This option can be defined both at the user-specific level and the global (generic) level. 

How to Bridge to Query from Action Entry 
Select the default method for bridging from the Action Entry to the Results Query option. 
Refer to the options and their descriptions in the Options - Specimen Registration Tab - 
Navigation Tab in this chapter. 
This option can be defined both at the user-specific level and the global (generic) level. 
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Search by Case - Cursor Position 
Select the field where the cursor will be positioned in the search window when a user 
accesses the Action Log option and selects the Search by Case tab. 
This option can be defined both at the user-specific level and the global (generic) level. 

Canned Message Type for Comment 
Select the default canned message type that you want to use when a user inserts canned 
messages into an action. 
This option can only be defined on the global (generic) level. 
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Call Requests Tab 
The Call Requests Tab displays similar to Figure 6-101. 

 
Figure 6-101. Options Window - Utilities Tab - Call Requests Tab 

Default Range for Call List Requests 
Enter the default number of days to look back for cases in the Call List search window.  
This option can be defined both at the user-specific level and the global (generic) level. 

Patient Types for Clinic Calls 
Mark the check boxes next to the patient types that will receive calls based on the clinic 
associated with the case in the Clinic field. The patient types that are left unmarked will 
receive calls based on the requesting doctor associated with the case in the Req Dr field.  
New calls for the patient types will default to the selections made on this tab. Users cannot 
enter a doctor call for a patient type marked for clinic calls and vice-versa.  
This option can only be defined on the global (generic) level. 
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Maintenance Tab 
The Maintenance tab displays similar to Figure 6-102. 

 
Figure 6-102. Options Window - Utilities Tab - Maintenance Tab 

Range to Check Order Optional Key 
Enter the number of days to look back for case statuses (e.g., processed, signed out, etc.) that 
do not match the data that is stored in the database.  
This option can only be defined on the global (generic) level. 

How Long to Keep Trace Files 
Enter the number of days to maintain the trace files that captures a log of any correction 
made to the database.  
This option can only be defined on the global (generic) level. 

Check Order Keys   
Marking this check box initiates a system self-repair process for the software. This process 
looks for statuses that are incorrect when compared to stored data and corrects them. The 
range specified in the Range to Check Order Optional Key field determines how far back 
the process looks back to compare data. 
This option can only be defined on the global (generic) level. 
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Archive Utility Tab 
The Archive tab displays similar to Figure 6-103. 

 
Figure 6-103. Options Window - Utilities tab - Archive Utility Tab 

Number of Days after Sign Out 
Enter the number of days after sign out that a case will qualify for archival.  
This option can only be defined on the global (generic) level. 

Number of Days after Consultation 
Enter the number days after the return of an outgoing consultation that a case will qualify for 
archival.  
This option can only be defined on the global (generic) level. 

Number of Days after Rejection 
Enter the number of days after a case is rejected that it will qualify for archival.  
This option can only be defined on the global (generic) level. 

Number of Days after Registration 
Enter the number of days after a case is registered that it will qualify for archival.  
This option can only be defined on the global (generic) level. 
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Miscellaneous Tab 

To access the Miscellaneous tab, select Setup > Options from the main menu and then select 
Miscellaneous from the Parameter Group list. The Miscellaneous tab (Figure 6-104) is displayed. 
Click Edit on the toolbar to make changes to any of the parameters. 

 
Figure 6-104. Options Window – Miscellaneous Tab 

The Miscellaneous tab contains the following tabs: 
 Image Management 
 Holiday Schedule  
 Lookups 
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Image Management Tab 
The Image Management tab (Figure 6-105) allows you to control the SoftPath specific SoftMedia 
options from SoftPath. 
NOTE: All links to images in Supplemental and Preliminary reports will be removed when they 

are based on the Final or Revised Report. 

 
Figure 6-105. Options Window – Miscellaneous Tab – Image Management Tab 

Activate Image Repository Functionality 
Select this check box to allows users access SoftMedia from SoftPath. 
This option can be defined on the global (generic) level. 

Allow Sign Out Without Images 
Select this check box to allow users to sign-out a document that has image placeholders 
without any images. 
This option can be defined on the global (generic) level. 

Default Twain Source 
Select the TWAIN device that will be used with the One Touch Image Acquire 
functionality. The TWAIN sources available for selection will be dependant upon the 
TWAIN devices installed on the user’s PC.  
This option can be defined at both the user specific and global (generic) levels. 

Revised Reports with Images 
To define how to import images into a Revised Report when it is based on the previous final 
report, select one of the following options: 
• Report Linked to Placeholder –links to the category and displays images associated 

to the category when the revised report is created. 
• Report Linked to Actual Image – links to the image included in the previous report, 

regardless if it is assigned to the same category, when the revised report is created. 
This is the default setting. 

This option can be defined on the global (generic) level. 
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Holiday Schedule Tab 
The Holiday Schedule tab (Figure 6-106) allows you to define the current and previous year’s 
holidays. When the holiday schedule is defined, SoftPath automatically removes those days from the 
turn-around-time calculations.  
You can enter the dates of all the established U.S. holidays and up to three additional holidays. These 
fields accept four numeric characters in mm/dd format.  
This option can only be defined on the global (generic) level. 

 
Figure 6-106. Options Window - Miscellaneous Tab - Holiday Schedule Tab 
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Lookups Tab 
The Lookups tab (Figure 6-107) allows you to define default settings for the Body Site Lookup and 
Source Lookup windows. 

 
Figure 6-107. Options Window - Miscellaneous tab - Lookups Tab 

Default Cursor Position in Body Site Search Screen 
Select the field where the cursor will be positioned when a user accesses the Body Site 
Lookup window.  
This option can be defined both at the user-specific and the global (generic) levels. 

Default Cursor Position in Source Search Screen 
Select the field where the cursor will be positioned when a user accesses the Source Lookup 
window.  
This option can be defined both at the user-specific and the global (generic) levels. 

Default Cursor Position in Doctor Search Screen Browser 
Select the field where the cursor will be positioned when a user accesses the Doctor Lookup 
window. 
This option can be defined both at the user-specific and the global (generic) levels. 

Default Current Year in Case Number Search Fields 
Check this box to have the current year appear as the default in any case number search 
fields. 
This option can be defined both at the user-specific and the global (generic) levels. 
NOTE: If you wish to use a bar code scanner in your facility, this box must remain 

unchecked. 
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Voice Recognition Tab 

The Voice Recognition tab (Figure 6-108) allows you to determine settings for using voice 
recognition. Leave this field blank if you do not want to use the voice recognition feature.  
This option can be defined both at the user-specific level and the global (generic) level. 

 
Figure 6-108. Options Window - Voice Recognition Tab 

Using Voice Recognition 
Select the dictation system to use for voice dictation from the drop-down menu. 
This option can be defined both at the user-specific and the global (generic) levels. 

Voice Dictation in MSWord 
Mark this check box to enable the ability to dictate directly into the MS Word document. 
When unmarked, the dictation shall be done using a text editor box. 
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System Settings Tab 

The settings on this tab are editable only by SCC and will be set with the implementation specialist 
prior to the system live. Once these have been set and the system is live, SCC recommends that these 
settings not be changed. 

 
Figure 6-109. Options Window – System Settings Tab 

The System Settings tab contains the following tabs: 
 Patient History 
 Common Settings 
 Watermarks 
 Conversion Cases 
 SoftWeb 
 Synoptic Reporting 
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Patient History Tab 
The System Settings tab displays similar to Figure 6-110. 

 
Figure 6-110. Options Window - System Settings Tab - Patient History Tab 

Patient Hx Search Criteria for Active Database 
Select the data elements that will be used to collate the patients in the active database. Use 
the check boxes to make selections from the available data elements. You can also enter a 
number of characters to search for in the patient name in the fields adjacent to the First 
Name, Last Name, and Middle Name fields.  
If you mark the Medical Record Number check box, all other entries are irrelevant since 
only the MRN will be searched by the system. Since the MRN is a unique number, there is 
no need to match any other data elements. The same is true for using MPI collation, however 
MPI is an additional add-on SoftPath feature and can only be used if purchased separately.  
This option can only be defined on the global (generic) level and is defined by SCC 
personnel. 

Patient Hx Search Criteria for Archive Database 
Select the data elements that will be used to collate the patients in the archive database (old 
cases) with the patients in the active database. Be aware of the data integrity within the 
archive database when making these selections. If, in the past, the date of birth was not a 
required data element for data entry, SCC suggests this selection not be used to collate data 
for the archive database because it will not find any matches.  
This option can only be defined on the global (generic) level and is defined by SCC 
personnel. 
NOTE: The MPI number cannot be used by or created for this database at this time.  

MPI Collation for Active Database 
If you mark the MPI collation check box, the system will match patient history based on the 
MPI number.  If selected, all other match criteria will be disabled. 
This option can only be defined on the global (generic) level. 
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MPI Collation for Archive Database 

UNDER DEVELOPMENT 

 

The MPI Collation for Archive Database option is currently under 
development. 
We apologize for the inconvenience. 

Lookback Period of Time 
Enter the number of years you want the system to look back for patient history information. 
This option can only be defined on the global (generic) level. 

Import Lab Results via MRN 
Mark the check box to import lab results via MRN. If this box is not selected, lab results will 
be collated by MPI number. 
This option can only be defined on the global (generic) level. 
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Common Settings Tab 
The Common Settings tab displays similar to Figure 6-111. 

 
Figure 6-111. Options Window - System Settings Tab - Common Settings Tab 

HIN Number Validation for French Clients 
Mark this check box to enable HIN number validation for organizations based in Quebec. 
NOTE: This option is only available in the French version of SoftPath. 
This option can only be defined on the global (generic) level and is defined by SCC 
personnel. 

Print Worksheet in Batch 
Mark this check box if you want to give users the ability to batch print worksheets. 
This option can only be defined on the global (generic) level and is defined by SCC 
personnel. 

Print Letter in Batch 
Mark this check box if you want to give users the ability to batch print letters. 
This option can only be defined on the global (generic) level and is defined by SCC 
personnel. 

Single Charge in Billing Part A 
Mark this check box if you want to allow users to associate a single charge with a single IBC 
code during part A billing. Leave this check box unmarked to allow users to associate many 
charges with a single IBC code during part A billing. 
This option can only be defined on the global (generic) level and is defined by SCC 
personnel. 
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Single Charge in Billing Part B 
Mark this check box if you want to allow users to associate a single charge with a single IBC 
code during billing. In addition, users can only associate a single diagnosis code with each 
IBC code.  
Leave this check box unmarked to allow users to associate many charges with a single IBC 
code during billing. If this check box is unmarked, users can associate up to two diagnosis 
codes with each IBC code. 
This option can only be defined on the global (generic) level and is defined by SCC 
personnel. 

Server Busy Message 
Mark this check box if you want the system to display a message when the server is busy. 
This option can only be defined on the global (generic) level and is defined by SCC 
personnel. 

Server Busy Message Timeout 
Enter the number of seconds you want to set as the default timeout for Server Busy 
Messages.  
This option can only be defined on the global (generic) level and is defined by SCC 
personnel. 

Auto Assignment 
Mark this check box if you want to enable Auto Assignment functionality. Refer to Chapter 
6.10—Setup: Auto Assignment. 
This option can only be defined on the global (generic) level. 

Copy PDF Reports to External Directory 
Mark this check box if you want to copy reports in PDF format to an external directory. 
This option can only be defined on the global (generic) level. 

Activate CCOW Functionality 
Mark this check box if you want to enable CCOW functionality. This will allow the use of 
Context Manager to maintain patient ID information when moving from SoftPath to 
another SCC product. 
This option can only be defined on the global (generic) level. 

Enable PDF Conversion 
Mark this check box if you want all reports to be converted to PDF format at Sign Out. 

Re-post Results to HIS if Dx Cat added via RetroReview 
Mark this check box if results should be re-posted to the HIS when the Retroreview 
procedure is marked as completed after sign out.  By default this checkbox is marked. 
This option can only be defined on the global (generic) level. 

Compress Report Files 
Define a value (in kilobytes) where if a report file reaches this size, it will be automatically 
compressed by the system. 
This option can only be defined on the global (generic) level. 

Default Cover Sheets 
This functionality allows you to define the default cover sheets to be used in Autofaxing and 
Auto E-mailing. 
This option can only be defined on the global (generic) level. 



SoftPath GUI v.4.2.1 User Manual Chapter 6.4 – Setup: Options 

PATH4.2-G-U (6th Ed, Rel. 01/31/07)   Page 6-195 

Laboratory CLIA Number 
This field allows you to define your lab’s CLIA number that will be used for Cancer Agency 
reporting. 
This option can only be defined on the global (generic) level. 

ABN Form Generation 
Mark this check box to allow ABN forms to be printed from Specimen Registration. The 
drop-down box below this option allows you to select the appropriate printer. 
This option can only be defined on the global (generic) level. 

Generic ABN Form 
Mark this check box to use a generic ABN form when printing from Specimen Registration. 
This option can only be defined on the global (generic) level. 

Mapping of Attending Physician ID for Patients Imported from Lab 
These fields allow you to define the mapping of the Attending Dr ID to either the Att Dr or 
Adm Dr field within Patient Maintenance when a patient is imported from the Lab 
database.   
This option can only be defined on the global (generic) level. 
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Watermarks Tab 
The Watermarks tab displays similar to Figure 6-112. 

 
Figure 6-112.  Options Window –System Settings Tab – Watermarks Tab 

Watermark Text for Unsigned, Cancelled, and Hold Release Reports 
Enter the text of the watermark you want to print for cancelled, unsigned and Hold Release 
reports. This field cannot be left empty and the default text is Cancelled Report for a 
cancelled report, Unsigned Copy for an unsigned report and Hold Release for a Hold 
Release Report. 
This option can only be defined on the global (generic) level. 
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Conversion Cases Tab 
The Conversion Cases tab displays similar to Figure 6-113. 

 
Figure 6-113. Options Window – System Settings Tab – Conversion Cases Tab 

The Conversion Cases grid displays the available database conversion sections and a row of 
corresponding case types. This grid allows you to define which section(s) will be displayed for 
which case type when using the Previous Cases List macro. The Final Diagnosis section will be 
marked for each case type by default. 
This functionality can only be defined at the generic (global) level. 
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SoftWeb Tab 
The SoftWeb tab displays similar to Figure 6-114. 

 
Figure 6-114. Options Window – System Settings Tab – SoftWeb Tab 

Display Signed Preliminary 
Select this check box to define whether signed preliminary reports should be available to 
view in the SoftWeb system. 

Display Signed Supplemental 
Select this check box to define whether signed supplemental reports should be available to 
view in the SoftWeb system. 

Suppress Final w/ Unsigned Revision 
Select this check box to define whether final reports with unsigned revisions should be 
available to view in the SoftWeb system. 
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Synoptic Reporting Tab 
The Synoptic Reporting tab displays similar to Figure 6-115. 

 
Figure 6-115. Options Window – System Settings Tab - Synoptic Reporting Tab 

Case Types Available for Synoptic Reporting 
These check boxes allow you to define for which case types synoptic reporting functionality 
will be made available. 

Case Types to Auto-Insert SNOMED Codes from Synoptic Setup 
These check boxes allow you to define for which case types SNOMED codes will 
automatically be captured from the Synoptic Fragment setup based on the fragments selected 
in the report. 
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Workspace Tab 

To access the Workspace tab, select Setup > Options from the main menu and then select 
Workspace from the Parameter Group list. The Workspace tab (Figure 6-116) is displayed. Click 
Edit on the toolbar to make changes to any of the parameters. 

 

Figure 6-116. Options Window – Workspace Tab 

The Workspace tab contains the following tabs: 
 Manager’s Dashboard  
 My Workspace 
 Permissions 
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Manager’s Dashboard Tab 
The Manager’s Dashboard tab is displayed similar to Figure 6-117. 

 
Figure 6-117.  Options Window – Workspace Tab – Manager’s Dashboard Tab 

Assigned Case Limit 
This option controls the display of the Workload Indicator Icon in the Manager’s Dashboard.  
The Workload Indicator Icon displays in three colors: green for low workload, yellow for 
medium workload, and red for high workload.  Enter a number that represents the maximum 
number of cases to be assigned to an employee. 
This option can only be defined on the global (generic) level. 

Medium Overload of Assigned Cases 
Enter the percentage of overload of assigned cases. This percent ratio indicates the point at 
which the Workload Indicator Icon transitions from green (low workload) to yellow 
(medium workload). 
This option can be defined both at the user-specific level and the global (generic) level. 

High Overload of Assigned Cases 
Enter the percentage of overload of assigned cases.  This percent ratio indicates the point at 
which the Workload Indicator Icon transitions from yellow (medium workload) to red (high 
workload). 
This option can be defined both at the user-specific level and the global (generic) level. 

Show number of Cases Assigned 
Mark this check box if you want the system to display the number of cases assigned to each 
employee in the Employee’s display of the Manager’s Dashboard. 
This option can be defined both at the user-specific level and the global (generic) level. 
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My Workspace Tab 
The My Workspace tab displays similar to Figure 6-118. 

 
Figure 6-118.  Options Window – Workspace Tab – My Workspace Tab 

Auto Invoke My Workspace 
Mark the check box to automatically display your workspace at logon to the system. 
This option can be defined both at the user-specific level and the global (generic) level. 

Notifications Time Limit 
Enter the number of hours notification will be held for review in the Notification Panel. 
This option can be defined both at the user-specific level and the global (generic) level. 

Flash Repetition Limit 
Indicate the number of times the Hold button (or Notification Icon) flashes when a new 
notification is presented on the Notification Panel. 
This option can be defined both at the user-specific level and the global (generic) level. 

Notifications Audio Signal 
Select a sound from the Notifications Audio Signal drop-down list box.  The sound you 
select will be the signal you will hear when a new notification is presented on the 
Notification Panel. 
This option can be defined both at the user-specific level and the global (generic) level. 

Confirmation of Notifications Receipt 
Mark the check box to activate confirmation of receipt of a notification by the receiver to the 
sender. 
This option can be defined both at the user-specific level and the global (generic) level. 
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Display Cases in Other Employee Queues 
Mark this check box so that cases assigned to other employees in the Other Employee queue 
are displayed within My Workspace.  
This option can be defined both at the user-specific level and the global (generic) level. 

Show Number of Cases Assigned to Other Employee 
Mark this check box to display the number of cases and slides assigned to an employee ID in 
the My Worklist option.  
This option can be defined both at the user-specific level and the global (generic) level. 

Auto Invoke Final 
Mark this check box to auto invoke the final document when selecting the next pending 
activity for a single case in the My Workspace option. When this is marked, the Results tab 
is skipped and the case is opened in the Final Report.  

TAT Delays in days – Surgical, MED Cytology, GYN Cytology, Autopsy 
This area is used to define the display color of the Turn Around Time Indicator Icon in the 
Work Assignment sections of the system (Manager’s Dashboard, My Workspace).  The TAT 
Indicator Icon displays in three colors.  Green indicates the case is well within specified 
TAT, yellow indicates the case is approaching the TAT deadline, and red indicates that TAT 
has been missed. 
Enter the number of days in the Medium Delay column to indicate the pint at which the TAT 
indicator Icon transitions from green to yellow. 
Enter the number of days in the High Delay column to indicate the point at which the TAT 
Indicator Icon transitions from yellow to red. 
This option can only be defined on the global (generic) level. 
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Permissions Tab 
The Permissions tab displays similar to Figure 6-119. 

 
Figure 6-119.  Options Window – Workspace Tab – Permissions Tab 

Employee Type 
Each employee type can be authorized to Return Cases or Change Assignments based on the 
permissions granted. 

Return to Unassigned 
Enter a checkmark in this field if the employee type is authorized to move cases from the My 
Cases queue to the Unassigned Cases queue.  

Move To Other Employee 
Enter a checkmark in this field if the employee type is authorized to move cases from the My 
Cases queue to the queue of a user ID of the same employee type.  

Move From Other Employee 
Enter a checkmark in this field if the employee type is authorized to move cases to their My 
Cases queue from the queue of an employee of the same employee type.  
This option can be defined both at the user-specific level and the global (generic) level. 
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Scheduler 

The Scheduler option allows you to establish days, times, and other parameters for certain programs 
and reports so they can run automatically without operator intervention.  
To access the Scheduler option, select Setup > Scheduler from the main menu. The Scheduler 
window (Figure 6-120) is displayed.  

 
Figure 6-120. Scheduler Window – Billing Report Tab 

After the Scheduler window displays, click Add on the toolbar. The Add Group window (Figure 
6-121) is displayed with a list of all available groups. Select the desired group from the list by 
highlighting it and clicking OK. A tab for the selected group is added with Scheduler window 
displayed in edit mode. You can then complete the fields and establish settings for the new group. 

 
Figure 6-121. Add Group window 
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Time Area 
The Time area is used to define the timing of the scheduled print job. Select the days, hours, 
and minutes when the chosen programs and reports should automatically run.  

 
Figure 6-122. Time Area 

Double-click one of the fields next to the days of the week to display the Hours and 
Minutes window (Figure 6-122). 

 

Select the time to run the report in hours and minutes 
by highlighting the correct values. The Select All 
button selects all of the possibilities in the field. To 
confirm the selections and close the Hours and 
Minutes window, click OK.  
NOTE:  If you select more than one hour, the minute 

value you select will be used for each hour 
selection. If multiple hour and minute 
values are selected, the system will use all 
possible hour and minute combinations 
when determining when to run the report. 
For example, if you select 13 and 14 in the 
hours column and select 15 and 30 in the 
minutes column, the report will be run four 
times during the specified days: once at 
1:15 PM, again at 1:30 PM, at 2:15 PM, 
and again at 2:30 PM. 

Figure 6-123. Hours and Minutes Window 

NOTE:  As a standard part of the AIX Base Operating system (BOS) Runtime, the 
servers automatically adjust to the correct time for yearly time changes and PCs 
may prompt users to accept the time change.  
Because the scheduler runs from cron during the time change, there could be a 
few concerns.  In the Spring the system time advances one hour, so any 
scheduled jobs from 02:00 to 02:59 will have to be run manually; likewise, in 
the Fall the system time will fall back from 01:59 to 01:00.  The same jobs will 
kick off again, but reports that are complete should be flagged and will not print 
again. Only a run that starts and does not finish (or flag as reported) within that 
hour will repeat.  Backup will continue to run if still running or repeat if already 
done.   
Some issues with collection and verification times cannot be avoided.  
Timestamps are generated with the current system time.  A comment can always 
be attached to those orders collected or verified around the time change to avoid 
later confusion. 
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 System Area 
The System area is used to define which system is used to run the reports.  

 
Figure 6-124.  System Area 

Main The main system runs the reports. 

Aux The auxiliary system that can be used when the main system is overloaded. SCC 
recommends that you run all large reports from the auxiliary system, especially when 
you generate the reports during peak times of activity (i.e., during normal business 
hours). This allows the system to run the report without affecting the resources on the 
main working system. 

NOTE: To rename a particular scheduled event, right-click anywhere in the System 
Area and select Sched Job Name. 

Parameter Group Area 
All previously scheduled reports are displayed in this area. The Active check boxes indicate 
the current status of the parameter groups. If the check box is marked, the report is active. 
Unmark the Active check box to set the status of the report to inactive. This check box is 
marked by default for all new records. 

 
Figure 6-125. Parameter Group Area 

Scheduler Job Name Customization 
The system allows the user to customize the name of the scheduled job. Right click on the 
tab and select the Sched job name option to enter the user-defined name for the job. 

Tab Fields 
The system creates a new line in the grid for each new parameter group that you add. The 
contents (i.e., parameter fields) of the individual tabs are determined by the group that you 
select. The system will display the currently selected parameter group for editing.  
NOTE: For detailed descriptions of the parameter groups and parameters, see the 

appropriate sections for the corresponding reports in the SoftPath User Manual. 
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Available Scheduler Parameter Groups 
Deactivation Program 

This group provides the opportunity to define the parameters for the automatic deactivation 
of cases, specimens, slides, blocks, and labels. 

Billing Report 
This group provides the opportunity to automatically print the Billing Report. 

Daily Accession Log 
This group provides the opportunity to automatically print the Daily Accession Log. 

Processed Specimens Log 
This group provides the opportunity to automatically print the Processed Specimens Log. 

Embedded Blocks Log 
This group provides the opportunity to automatically print the Embedded Blocks Log. 

Processed Blocks Log 
This group provides the opportunity to automatically print the Processed Blocks Log. 

Special Stain Log 
This group provides the opportunity to automatically print the Special Stain Log. 

Daily Result Log 
This group provides the opportunity to automatically print the Daily Result Log. 

SQL – Autopsy Log 
This group provides the opportunity to automatically print the Autopsy Log. 

SQL – Autopsy Marked for Conference Log 
This group provides the opportunity to automatically print the Autopsy Marked for 
Conference Log. 

SQL – Block Tag Letter Log 
This group provides the opportunity to automatically print the Block Tag Letter Log. 

SQL – Card Log 
This group provides the opportunity to automatically print the Card Log. 

SQL – Cases with Control Reference Block 
This group provides the opportunity to automatically print the Cases with Control Reference 
Block. 

SQL – Open Cases Log 
This group provides the opportunity to automatically print the Open Case Log. 

SQL – Cases Unsigned over 48 Hours 
This group provides the opportunity to automatically print the Cases Unsigned over 48 
Hours Log. 

Tumor Registry 
This group provides the opportunity to automatically print final reports that have been 
flagged in Results Entry for the Tumor Registry. See page 6-136 for more information.  

QA Screener Evidence Counting 
No parameters are available for definition in this group.  

QA Screener Evidence Report 
This group provides the opportunity to automatically print the Screener Evidence Report. 
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QA Screener Evidence Trend 
This group provides the opportunity to automatically print the Screener Evidence Trend. 

QA Rescreen Worksheet 
This group provides the opportunity to automatically print the Rescreen Worksheet. 

QA Proreview Worksheet 
This group provides the opportunity to automatically print the Proreview Worksheet. 

QA Retroreview Worksheet 
This group provides the opportunity to automatically print the Retroreview Worksheet. 

Pending Stain Worksheet 
This group provides the opportunity to automatically print the Pending Stain Worksheet. 

QA Action Worksheet 
This group provides the opportunity to automatically print the Action Worksheet. 

QA Action Log 
This group provides the opportunity to automatically print the Action Log. 

QA Action Report 
This group provides the opportunity to automatically print the Action Report. 

QA Specimen Adequacy/Problem Log 
This group provides the opportunity to automatically print the Specimen Adequacy/Problem 
Report. 

QA Random 
No parameters are available for definition in this group. 

Result Report 
This group provides the opportunity to automatically print the Result Report. 

Result Worksheets 
This group provides the opportunity to automatically print the Result Worksheets. 

Result Letters 
This group provides the opportunity to automatically print the Result Letters. 

QA Follow up Correlation 
This group provides the opportunity to automatically print the Follow up Correlation report. 

QA IOC Correlation 
This group provides the opportunity to automatically print the IOC Correlation report. 

QA Summary 
This group provides the opportunity to automatically print the QA Summary Report. 

WP (WordPerfect) Convert 
This group allows for automatic conversion of batches of reports from WordPerfect to Word 
format for use in Results Entry. See: Appendix A – SoftPath Conversion on Demand 
Utility. 

Word to PDF Conversion 
This group allows for batch conversion of all signed out Word reports to the Adobe PDF 
format. This allows for faster access to these documents, since the system will not have to 
convert the report when it is viewed or printed. 

HIS Post Hold Release 
This parameter group sends cases to the HIS for reports when the Hold Release status has 
expired. This group is necessary for systems that use the Hold Release functionality. 
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Dx Coding Setup 

 
Figure 6-126. Setup Menu – Dx Coding Setup Submenu 

The Dx Coding Setup submenu contains the following options: 
 Edit Window 
 Delimiter Order 
 Test 
 Print Cascade 
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Edit Window  
The Edit Window option allows you to design and set up the cascade diagnosis windows for all case 
types and dictionaries. This option allows you to edit the parameters of existing windows, delete an 
existing window, or create a new cascade diagnosis window.  
To access the Edit Window option, select Setup > Dx Coding Setup > Edit Window from the main 
menu. The Define Window (Figure 6-127) is displayed.  

 
Figure 6-127. Define Window 

The Select list, on the left side of the Define window (Figure 6-127), displays in case types and 
diagnosis code types in a tree-like structure. Clicking the plus sign (+) next to the case types expands 
the tree to reveal the diagnosis code types. Clicking the minus (-) sign collapses the levels.  
Determine which case type you want to work with and expand the list. Then select a diagnosis code 
type. A list of defined windows for the specified diagnosis code type displays in the Window List 
area. 

Defining New Windows 
To create a new window, select the required case type and coding system from the Select list 
and click New Window. A blank row appears in the Items List with the next available 
window code number assigned in the Window Code field. Enter a title or description of the 
window. Define the parameters for the window by completing all the data entry fields in the 
Items List. 
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Test Button 
Click the Test button to test the currently selected diagnosis window. If the selected 
window is a root window, the cascade will start with the selected window. If the 
selected window is not a root window, the cascade will start from the first root 
window. The selected diagnosis window (Figure 6-129) will display. While in this 
test mode, you can preview how the window will appear to SoftPath users and 
ensure that it functions properly. 

 
Figure 6-128. Test for Diagnosis Window - Cascade 

 
Figure 6-129. Test for Diagnosis Window – Tree Grid 

Pre-Defined Dx Button 
Click the Pre-Defined Dx button to define a Standard Diagnosis and an unlimited 
number of pre-defined diagnoses to use in Result Entry. Additionally, this window 
can be used to assign up to 10 (ten) diagnoses to the Pre-defined Dx keys in Result 
Entry. Once the button is clicked, the Pre-Defined DX window (Figure 6-130) is 
displayed.  For more information on defining the pre-defined diagnoses, see Pre-
defined Dx. 
NOTE: When Predefined-Dx setup has been done, the corresponding check box 

is marked. 
Window Code 

When you create a new window, the system automatically generates the next 
sequential window code. If necessary, you can manually enter a new code for the 
window. The code must start with WN (e.g., WNO2). This code displays in the 
Window List area in the Code column. 

Description 
Enter the title of the window. This description is displayed in the Window List area. 
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Item List 

Code Click the  button to select from a list of valid diagnosis codes from the 
appropriate diagnosis code type. 
NOTE: In addition to the diagnosis code, the following characters 

can be entered in this field: 
 %T - free text 
 % M - maturation index 

Description The system displays the description of the code, which defaults from the 
Diagnosis Codes setup file. The text is for informational purposes only 
and does not print on reports. 

Select the action performed when this code is selected. The available 
actions are:  

Sel Defines the window as a selectable item for display in the 
diagnosis cascade. 

Fld Inserts the maturation index for data entry in the diagnosis 
cascade. 

Ftx Inserts the free text editor for data entry in the diagnostic 
cascade. 

Win Provides a mechanism to open another window when a selection 
is made. 

Ext Exits from the window, saves the data entered, and proceeds to 
the next root window. 

Action 

Qut Quits the diagnostic cascade from the window and saves the data 
entered. 

Param Enter a window code (e.g., WNO2). This code identifies which cascade 
window you want to open from the current window. The window code 
must be defined before you can enter it into the field. If the window is 
not yet defined, this field can be edited at a later time. If you do not want 
any windows to cascade from the current window, enter 0 in this field. 

Enter a code to determine the type of action to be taken when the user 
selects a code and clicks OK. 
E Exit the current window and go to the next root window. The item 

is marked and stored. 
P Physically mark this code with an asterisk (*) and save it when 

exiting from the window. 

Select 

Q Quit and return to the calling program. Stops all further window 
selections. 

New Item Button 
Click New Item to insert a new line in the Items List. 
NOTE: A new item can also be added by clicking a blank row below the last 

defined row in the table or by pressing the Insert key on the keyboard. 
Delete Item 

Click the Delete Item button to delete the selected window from the Items List. 
Delimiter 

Mark the Delimiter check box if the window is to be used as the title on the report 
and any selected items associated with this window are to be placed under this title. 
If the Include Title check box is marked first, the default delimiter code will be 
inserted automatically but can be edited at any time. 
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Include Title 
Mark the Include Title check box to include the title when this window is selected. 

Root 
Mark this check box if the window should always displays in the diagnosis data 
entry sequence and this window, not a sub-window. 

X, Y 
Enter coordinates to indicate where the window should appear on the user’s screen. 
The coordinates are measured in pixels. X is the horizontal axis and Y is the vertical 
axis. 
EXAMPLE: For coordinates X=0, Y=0, the window will be located in the upper 

left of the screen. If a value greater than X=20, Y=20 is entered, the 
window may not display due to the length of the text in the window. 
SoftPath will automatically enter the default values for X, Y for a 
new window. 

Pre-Defined Dx Setup 
Click the Pre-Defined Dx button to define a Standard Diagnosis and an unlimited number of 
pre-defined diagnoses to use in Result Entry. Additionally, this window can be used to 
assign up to 10 (ten) diagnoses to the Pre-defined Dx keys in Result Entry. Once the button 
is clicked, the Pre-Defined DX window (Figure 6-130) is displayed.   
NOTE: When Predefined-Dx setup has been done, the corresponding check box is 

marked. 

 
Figure 6-130. Pre-Defined Dx Window 

The grid at the top of the Pre-Defined Dx window displays existing pre-defined diagnoses 
and other information including the predefined diagnosis code, name, and the assigned 
shortcut button (if defined).  Highlight a pre-defined diagnosis and a preview is displayed in 
the Preview Pane. To change the selected diagnosis, click the Edit button or click the Delete 
button to delete it. 
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Click the Add New button to add a new pre-defined diagnosis. The Add New window 
(Figure 6-131) is displayed. Enter all needed information and click the OK button. 

 
Figure 6-131. Pre-Defined Dx Window – Add New  

Code Enter a code for the diagnosis. 

Name Enter a name for the diagnosis. 

Button 
Assignment 

If desired, select a Result Entry shortcut button for the diagnosis. There are 
10 (ten) available buttons, but only unassigned buttons will display in this 
list. 

Define 
Diagnosis 

Click the Define Diagnosis button to use either the Cascade or Tree Grid 
(dependant on your system settings) to define the diagnosis.  
If you are using cascade diagnoses, Two sets of windows will open after 
clicking this button. First, you will need to choose your diagnosis text from 
the selection window(s): 

 
Figure 6-132. Sample Selection Window 

To select your text, mark each corresponding checkbox, as needed. Use the 
Prev Root and Next Root buttons to move between selection windows. 
When selections are complete, scroll to the end of the window and select the 
Quit check box and then click the OK button. 
The Diagnosis (Cascade) Window is displayed with the selected diagnosis 
codes in the Codes grid and the text in the Diagnosis area of the window. 
Enter a Dx Category code or use the corresponding browser button to select 
from the list of available codes. Click the OK button to complete the define 
diagnosis function. 
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Figure 6-133. Diagnosis (Cascade) Window 

If you are using tree grid diagnoses, a single Define Diagnosis window will 
open after clicking this button. First, you will need to choose your diagnosis 
text from the tree grid. When selections are complete, enter a Dx Category 
code or use the corresponding browser button to select from the list of 
available codes. If you need to clear all of your selections and re-enter your 
diagnosis, click the Clear button. Click the OK button to complete the 
define diagnosis function. 

 
Figure 6-134. Define Diagnosis Window (Tree Grid) 
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Delimiter Order 
The Delimiter Order option allows you to define the order in which the root windows will cascade 
(open) for entering diagnoses and the order in which they will appear on the report. After creating a 
window, a unique delimiter code must be assigned to include the window in the sequence. This 
option also allow you to define the column positions that the delimiter will display in Tree Style 
Cascade.  
To access the Delimiter Order option, select Setup > Dx Coding Setup > Delimiter Order from the 
main menu. The Delimiter Order window (Figure 6-135) is displayed. 

 
Figure 6-135. Delimiter Order Window 

In the Select list, click the plus sign (+) next to the appropriate case and select a diagnosis type. 
Information for the selected diagnosis type displays in the Delimiter Order area. In the Delimiter 
Order area, you can establish the order in which the windows display.  
NOTE: Begin setting up the delimiter order from the bottom of the list and move up. 
Delimiter Description 

This field displays the title (description) assigned to the window. This title prints on reports 
(if designated). Changes cannot be made to the title from this window. Use the Edit 
Window option to modify window properties. 

ID 
This field displays the unique delimiter code assigned to the window. It is used to mark the 
record in the database for a report title. Changes cannot be made to the title from this 
window. Use the Edit Window option to modify window properties. 

R 
This field displays the root flag assigned to the window. 

NUM 
This field displays the order in which the windows display when entering the diagnosis (i.e., 
the cascading order). Click this field and enter the delimiter’s position/order in the cascade.  

COL 
Select the column assignment of codes for use with the Tree Grid display for Cascaded Dx. 
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Test  
The Test option allows you to test the cascade order of the root windows and the selection within 
each window. This option is used to verify the actions that need to be used during the setup 
procedure, such as physical marks, opening sub-windows, free text, maturation index (if applicable), 
and exiting the windows. If the windows do not cascade in the correct order, return to the Edit 
Window or Delimiter Order options to make the necessary adjustments. 
To access the Test option, select Setup > Dx Coding Setup > Test from the main menu. The Select 
window is displayed with a list of case types and diagnosis codes. 

 
Figure 6-136. Select Dictionary Window 

Click the plus sign (+) next to the appropriate case and select a diagnosis type. The first root window 
of the cascade displays. Select a code by highlighting it and clicking Select. The next window in the 
cascade displays. Continue with selecting codes until the cascade is completed. 
Next Root Button  

Click this button to display the next root, according to the delimiter order. After the last root 
displays, a message displays indicating that all root windows are opened. 
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Print Cascade 
The Print Cascade option allows you to print the diagnosis cascade as a MS Word document. The 
diagnosis coding setup is shown in the form of bar codes.  
Access the Print Cascade option by selecting Setup > Dx Coding Setup > Print Cascade from the 
main menu. The Cascade, Template For: window displays similar to Figure 6-137. 

 
Figure 6-137. Cascade, Template For: Window 

Cascade Type 
Select the required case type and diagnosis code type from the drop-down lists. 

Edit Template Button  
Select the required case type and diagnosis code type from the drop-down lists. The selected 
diagnosis code type displays in MS Word format. You have full access to MS Word toolbars 
and functionalities.  

 
Figure 6-138. Cascade, Template For: window 

Insert Cascade Control Button 
Click this button after selecting the appropriate control key from the drop-down list 
to insert the cascade function keys in the template.  
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Insert Cascade Setup Button  
Click this button to insert cascade setup labels and barcodes into the template. The 
barcodes inserted when using this button are determined by the window setup. If the 
window setup changes, the system will not automatically update the bar-coded sheet. 
After you insert the text and barcodes, they can be formatted as desired.  
NOTE:   The font size you use must not cause the lines within the barcode to 

merge. If this happens, the barcodes will not be readable. 
Bar Code Setup Button 

Mark the Insert Bar Code check box if you want the label to include a bar code in 
the label template. If you choose to include a bar code on the label, click the Bar 
Code Setup button. The Bar Code Setup window (Figure 6-139) is displayed. This 
window is used to define the bar code used on the label. After you have finished 
entering the bar code information, click Save and then Close to return to the Label 
Sheet Setup Case Label window. 

 
Figure 6-139. Bar Code Setup Window 

Bar Code Width and Bar Code Height 
Enter the width and height of the bar code in inches. 

Font Size 
Enter the font size (in points) for the bar code characters. 

Coding Type 
Select a bar coding system to use to generate the bar code from the drop-
down list. Available coding types include Code 128, Code 39, and Code 39 
Full ASCII. 

Insert Text for Bar Code 
Mark this check box to include text in the bar code.  

Set as Default 
Mark this check box to make the bar code settings you entered on this tab 
the default settings for bar codes. You can load the default settings you 
define by clicking the Load Defaults button. 

Load Defaults Button 
Click this button to use the default bar code settings. 
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Simple Codes 

The Simple Codes option allows you to define simple codes to be used within the system for certain 
informational fields. 
To access the Simple Codes option, select Setup > Simple Codes from the main menu. The Simple 
Codes window (Figure 6-140) is displayed.  

 
Figure 6-140. Simple Code Window 

Group List 
This area contains a list of groups with previously defined codes. This information is 
displayed in READ ONLY mode. Select a group to view information on the group in the 
Group Items grid. 

Group Items Grid 
After selecting a group from the Group list, a list of codes defined for the specified group 
displays in this grid. To edit information on this grid, click the Edit button on the toolbar.  

Code This field displays a unique alphanumeric code assigned to this field. This 
field cannot be modified. 

Description This field displays a description of the code. 

Active This field indicates whether the group items are active codes. 
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Adding a Simple Code 
To add a simple code, click New on the toolbar; the Add Simple Code window (Figure 6-141) is 
displayed. 

 
Figure 6-141. Add Simple Code Window 

Code 
Enter a unique acronym to identify this simple code. This is a required field. Maximum 3 
alphanumeric characters. 

Description 
Enter a brief description of the simple code. Maximum 13 alphanumeric characters. 
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Simple Codes Groups 
Each group displayed in the Group list is described below in the order it appears on the list: 
Interface Sequence Tests 

Allows you to define codes that will be available for use when testing interface sequences. 
Interface Tests 

Allows you to define codes that will be available for use when testing the system interfaces. 
Defined Fields 

Allows you to define additional fields that will be available for use in the Client Profile 
setup option.  The codes associated with a clinic in the Client Profile option can be printed 
on patient reports. 

Client Group ID 
Allows you to define an ID that links to the Client Profile. This is an interface field that deals 
with transmission of a group data, which is defined on the HIS. 

Stain QC Result 
Allows you to define the QA coding available for use when performing stain QC. 

Time Units 
Allows you to define codes that represent units of time (hours, minutes, seconds, etc.) 

Case Tag Letter 
Allows you to define case tags that can be applied to a case (e.g., D = dialysis study). These 
are retrievable through ODBC reports and can also be printed on patient reports. 

Block Tag Letter 
Allows you to define block tags that can be used at the block level for specific purposes 
(e.g., teaching). These tag letters can be retrieved by using ODBC reports. 

Fixative List 
Allows you to define a list of fixatives used in a specific institution that can be applied to the 
cassette, (e.g., formalin, saline, B5). 

History Procedures Description 
Only the descriptions of the history procedures available can be edited in the Simple Codes 
option. The procedures available are hard-coded capture points within the system that are 
displayed in the Processing History tab located in various options throughout the system. 
The wording of the display can be changed according to your organization’s specific needs, 
but the capture points for these values cannot be modified. 

QA Rules 
Displays the QA reasons that may be used to search for cases pending QA. 

QA Follow Up 
Displays the case Follow Up status that may be used to search for cases pending Follow Up. 

QA Rules for Sign Out entry 
Displays the search rules that may be used to find cases that are pending sign out. 

Consistency - Gross Description 
Allows you to define additional selections for the Consistency field that display in the MED 
cytology gross description window. 

Color - Gross Description 
Allows you to define additional selections for the Color field that display in the MED 
cytology gross description window. 
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Allowed Program Codes 
Displays the system programs available for use in the definition of Tag Letters. 

Measures 
Displays the measurements for review. The measurement codes cannot be edited in the 
Simple Codes option. 

Storage/Location Type 
Allows you to define additional selections for the Storage file. 

Patient Type 
Displays the system defined patient types provided with the application. Only the patient 
type description can be edited. Select New from the toolbar to add a new patient type for use 
in the system. 

Billing Qualification 
Displays the rules that are available for the setup of billing options. 

Workload Unit Group 
Displays selections for use during configuration procedure of using SoftPath with 
SoftWorkload 

Other Drugs 
Allows you to define additional selections for the Other Drugs field located in the Autopsy 
FOR, Forensic Information window for specimen registration and result entry for FAD. 

Scene 
Allows you to define additional selections for the Scene of Death field located in the 
Autopsy FOR, Forensic Information window for specimen registration and result entry for 
FAD. 

Manner of Death 
Allows you to define additional selections for the Manner of Death field located in the 
Autopsy FOR, Forensic Information window for specimen registration and result entry for 
FAD. 

Case Type 
Allows you to define additional selections for the Case Type field located in the Autopsy 
FOR, Forensic Information window for specimen registration and result entry for FAD. 

Patient Race 
Allows you to define additional selections for the patient Race field in specimen registration 
and patient maintenance. 
NOTE:   The values available for Race field should always be the same in all SCC 

products to allow you to import and export between systems. 
Normal/Abnormal 

These values appear in the body of the QA Statistical report. 
Report Type 

Displays the options that are available for selection in the report printing search screens.  
Default FS/Gross Intr for Worksheets 

Allows you to define the FS search criteria available in the QA Reports search screens. 
Scale of Measure 

Allows you to assign codes to the various scales of measure used in autopsy case 
registration. 
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Medical Gross 
Displays the selection available in the MED Gross Description window. 

Case Status 
Displays the various case statuses that can be used to search for cases. 

QA Procedure Reason 
Displays the various qualifiers that are available for selection in Case Comparison Setup. 

QA Assign 
Displays the available assign. 

Diagnosis Type 
Only the descriptions of the diagnosis types may be edited in the Simple Codes option. The 
codes displayed are hard-coded values within the system that allow the system to display 
patient history as normal or abnormal. 

Abnormal Diagnosis Strings 
These entries are used for macro customization purposes when lab results are inserted into 
Results Entry. 

Archive Case Section Names 
Archive Case Section Names allows you to define the section names to be used when 
defining the sections to be displayed for converted cases: 

Code Enter a unique code for the document section. 

Description Enter the description for the document section. 

Active Click the check box to mark the document section as Active or Inactive. 

Report Title 
This group displays the report title names to be used by the Report Title merge field in the 
Document setup file. 

SNOMED Prefixes 
Define the SNOMED Prefixes used by the Dx Coding Filter. Maximum 2 alphanumeric 
characters.   
By default, the following prefixes are available as READ ONLY: 
M Morphology 
T Topography 
P Procedure 
DF Disease 

NOTE: Functionality is available in SoftPath versions 4.2.1.6 and higher. 
The following 37 SNOMED code prefixes were derived from a cursory review of the 
SNOMED dictionary contents. This is NOT an official list but has been compiled for your 
convenience. 

Prefix Description 
A Physical Force, Physical Object, Qualifier Value 
C Product, Substance 
D0 Disorder – Skin 
D1 Disorder – Bone & Joint 
D2 Disorder – Nose, Throat, Chest 
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Prefix Description 
D3 Disorder – Cardiac 
D4 Disorder – Congenital 
D5 Disorder – Neoplasm 
D6 Disorder – Metabolic 
D7 Disorder – Genitopelvic & Breast 
D8 Disorder – Pregnancy 
D9 Disorder – Drug Dependency, Psychotic Behavior, Sleep, Developmental 

(Findings) 
DA Disorder – Head, Eyes, Ears, Nose, CNS, Brain, Face 
DB Disorder – Endocrine 
DC Disorder – Blood, Cellular, Immune 
DD Disorder – Trauma 
DE Disorder – Infection & Bacteria 
DF Disorder – Disease (Findings) 
F Substance  - Observable Entity, Disorder, Findings, (Navigational Concept) 
G Specimen – Observable Entity, Qualifier Value, Findings, Scoring and Grading 
J Occupation 
L Organisms, Substance 
M Morphology Abnormality 
P Procedure 
P0 Procedure 
P1 Procedure 
P2 Procedure, Regimen, Therapy 
P3 Procedure 
P5 Procedure 
P7 Procedure, Regimen, Therapy 
P8 Procedure – Dental 
P9 Procedure - Psychiatric 
PA Procedure – Patient, Nursing 
PF Procedure - Spiritual 
R Disorder (Special Concept) 
S Ethnic Group – Environment, Findings 
T Body Structure - Substance 
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User Flags 

The User Flags option allows you to define new flags to be used within SoftPath.  
To access the User Flags option, select Setup > User Flags from the main menu. The User Flags 
window (Figure 6-142) is displayed. Click New on the SoftPath toolbar to insert a blank row at the 
bottom of the table for adding a new user-defined flag. 

 
Figure 6-142. User Flags Window 

Code 
Enter a unique alphanumeric code for the flag. Maximum 4 alphanumeric characters. 

Description 
Enter a description of the flag that will be used to define the code. Maximum 25 
alphanumeric characters. This field is mandatory. 

Record 
Select the record that this flag will be applied to. Select from case or specimen. 

Type 
Select the type of input this flag will receive. 

Field Len 
The field length of the flag defaults to a numeric value determined by the type of flag 
chosen. This value cannot be modified. 

Mark 
Enter the character that is accepted in the field. The default sign is an asterisk (*).  
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Case  
Select the case types that can apply the new flag. Click the  button and mark the check 
boxes next to the case types you want to include. 

Programs 
Enter the name of the program you want to link to the flag. Click the  button and mark the 
check boxes next to the programs you want to link to the flag. 

Active  
Click this column to activate or inactivate your user defined flags. 
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Document Files 

 
Figure 6-143. Setup Menu - Document Files Submenu 

The Document Files submenu contains the following options: 
• Report Setup 
• Worksheet Setup 
• Signature Setup 
• Banner Setup 
• Document Section Setup 
• Label Setup 
• ABN Form Setup 
• User Defined Sub-Sections 
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Report Setup  

The Report Setup option allows you to prepare the layout of reports, including Final, Supplemental, 
Preliminary/Provisional, and Revised reports. All sections and their contents can be defined in this 
option. 
To access the Report Setup option, select Setup > Document Files > Report Setup from the main 
menu. The Accession Sequences Lookup window is displayed; select the accession sequence for the 
report you want to create by double-clicking it. The Report Setup window (Figure 6-144) for the 
specified accession sequence is displayed.  

 
Figure 6-144. Report Setup Window 

Accession Base 
This field displays the accession sequence code. To change the accession sequence, click the 

 button and select an accession sequence code from the list. 
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Edit Report Section 
Select the report type you wish to create from the list on the right side of the window. The options 
include, Final, Supplemental, Preliminary/Provisional, and Revised.  
The Report Setup window (Figure 6-145) for the selected report format (e.g., Final) is displayed in 
MS Word. You have full access to MS Word features and functionality to format the report. Use the 
buttons for the Insert Section, Insert Case Data Code, and Insert Common Data Code drop-down 
lists to choose data elements to be included in the report. 
NOTE: The system prohibits the saving of a template if bookmarks are missing or incorrectly 

placed. 

 
Figure 6-145. Report Setup Window for a Final Report 

Insert Section Button 
Select a section from the list and click this button to insert the selected section title into the 
document. If the selected section already exists in the document, a warning message is 
displayed. The document sections available for selection are defined in the Document 
Section Setup file. 

Insert Subsection Button 
Select a subsection from the list and click this button to insert the selected subsection title 
into the document. If the selected section already exists in the document, a warning message 
is displayed. The document sections available for selection are defined in the User-Defined 
Subsections setup file. 

Insert Case Data Code Button 
Case data codes include such items as sources and body sites. Insert the codes by positioning 
the cursor in the document where you want the data to appear. Select the appropriate data 
code from the drop-down list. To insert the code into the text, click the Insert Case Data 
Code button. The selected code will be inserted into the document. After the report is 
printed, all of the elements contained within the field codes are printed on the report for the 
respective patient.  

Insert Common Data Code Button 
Common data codes contain case-specific information such as patient name, physician, 
accession number, clinic name, etc. Insert the codes by positioning the cursor in the 
document where you want the data to appear. Select the appropriate data code from the drop-
down list. To insert the code into the text, click the Insert Common Data Code button. The 
selected code will be inserted into the document. After the report is printed, all of the 
elements contained within the field codes will be printed on the report for the respective 
patient.  
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Insert Placeholder 
Placeholders act as an indicator for the automatic insertion of images into the document from 
the Image Repository. Select a placeholder from the list and click this button to insert the 
selected placeholder into the document. 

Images Order 
Select whether you want images to insert from the image repository in a vertical or 
horizontal manner when placeholder functionality is used in the report. 
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Worksheet Setup  

The Worksheet Setup option allows you to prepare the layout of the worksheets for all case types. 
All sections and their contents can be defined using this option. 
To access the Worksheet Setup option, select Setup > Document Files > Worksheet Setup from the 
main menu. The Accession Sequences Lookup window is displayed; select the accession sequence 
for the report you want to create by double-clicking it. The Worksheet Setup window (Figure 
6-146) for the specified accession sequence is displayed.  

 
Figure 6-146. Worksheet Setup Window 

• Click the Resulting button to edit the resulting worksheet template for the accession 
sequence specified in the Accession Base field.  

• Click the Billing button to edit the billing worksheet template for the accession sequence 
specified in the Accession Base field. 

The system displays the specified template in an MS Word edit window (Figure 6-147), which 
allows you to edit the resulting, billing, or special stain worksheet template.   

 
Figure 6-147. Worksheet Setup – Resulting/Billing Button 
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Insert Section Button 
Select a section from the list above and click this button to insert the selected section title 
into the document. If the selected section already exists in the document, SoftPath displays a 
warning message. 

Insert Worksheet Data Code 
Worksheet data codes include such items as sources and body sites.  Insert the codes by 
positioning the cursor in the document where you want the data to appear. Select the 
appropriate data code from the drop-down list. To insert the code into the text, click the 
Insert Worksheet Data Code button. The selected code will be inserted into the document. 
After the report is printed, all of the elements contained within the field codes will be printed 
on the report for the respective patient.  

Insert Common Data Code 
Common data codes contain case-specific information, such as patient name, physician, 
accession number, clinic name, etc. Insert the codes by positioning the cursor in the 
document where you want the data to appear. Select the appropriate data code from the drop-
down list. To insert the code into the text, click the Insert Common Data Code button. The 
selected code will be inserted into the document. After the report is printed, all of the 
elements contained within the field codes will be printed on the report for the respective 
patient. 

Insert Acc Num As Bar Code 
This button allows you to insert an account number as a bar code. Click the button to display 
the Bar Code Setup window. This window allows you to define the default values of the bar 
code heights, widths, font sizes, and coding types. Refer to page 6-222 for more information 
on bar code setup. 
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Signature Setup 

The Signature Setup option allows you to prepare signature templates for all case and report types.  
To access the Signature Setup option, select Setup > Document Files > Signature Setup from the 
main menu. The Accession Sequence Lookup window is displayed; select the desired accession 
sequence. The Signature Setup: Signature Template for… window (Figure 6-148) is displayed.  

 
Figure 6-148. Signature Setup: Signature Template Window 

Accession Base 
This field displays the accession sequence code. To change the accession sequence, click the 

 button and select a new accession sequence from the list. 
Insert Field Button 

Insert fields by positioning the cursor on the segment of the page you want the data to 
appear. Select the field from the drop-down list and click Insert Field. The selected field 
will be inserted into the document. When the report is printed, all elements contained within 
the field codes will be printed on the signature line of the report for the respective patient. 
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Banner Setup  

The Banner Setup option allows you create or edit banner pages. 
To access the Banner Setup option, select Setup > Document Files > Banner Setup from the main 
menu. The Banner Setup window (Figure 6-149) is displayed. This window allows you to 
edit/create the clinic banner, doctor banner, auxiliary banner, and additional copy banner. 

 
Figure 6-149. Banner Setup Window 

Edit Banner Button 
Click the arrow to make your selection from the Edit Banner list button.  You can display 
and edit the banner you select in MS Word, using the full range of Word features and 
functions. The banners are used for the feature you select when printing a batch job. 
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Editing Banner Pages 
Select the type of banner you want to create/edit (clinic banner, doctor banner, auxiliary doctor 
banner, or additional copy banner) by using the list button. The system displays the Banner Setup 
window (Figure 6-150), which allows you to define a template for the banner page. 

 
Figure 6-150.  Open Banner Template 

Insert Banner Data Button 
Insert fields by positioning the cursor on the segment of the page you want the data to 
appear. Select the field from the drop-down list and click Insert Banner Data. The selected 
field will be inserted into the text window. When the banner is printed, all elements 
contained within the field codes will print on the banner. 
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Document Section Setup 

The Document Section Setup option allows you to define new, modify existing, or delete reports 
sections from your documents as created in the SoftPath system. These sections, once defined here, 
will be available in Report Setup.  
To access the Document Section Setup option, select Setup > Document Files > Document Section 
Setup from the main menu. The Document Section Setup window (Figure 6-149) is displayed. 

 
Figure 6-151. Document Section Setup Window 

Code Column 
The code column allows you to define a unique code for your document sections. 

Description Column 
Type the identifying name of your document section here. 

Canned Message Column 
In this column, you may associate your document sections with available canned messages. 

Active Column 
Click this column to activate or inactivate your document sections. 
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Label Setup 

The Label Setup option allows you to set up label sheets for printing groups of labels.  
To access the Label Setup option, select Setup > Document Files > Label Setup from the main 
menu. The Label Setup window (Figure 6-152) is displayed.  
NOTE: To enable the Label Setup option, the system administrator must activate the option in 

your SoftPath RPARAM file.  

 
Figure 6-152. Label Sheet Setup Window 

Label Type 
Select the template you want to use for the labels contained in the label sheet. After you 
select a label type and layout form, you can click Edit Template to edit the MS Word 
document that defines the content and format of the labels contained on the label sheet.  

Edit Templates Button 
In the Label Type field, select the template you want to use for the labels contained in the 
label sheet. After you select a label type and layout form, you can click Edit Template to 
edit the label template. Label templates are used to format the labels and determine the text 
and data codes printed on each label. The template uses the page layout information 
specified in the layout form you selected in the Layout Form drop-down list 
When you click the Edit Templates button, the system displays the template for the 
currently selected label type and case base in the Label Setup Case Label window (Figure 
6-153). When you have finished editing the template, click Close to return to the Label 
Setup window. 
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Figure 6-153. Label Sheet Setup Case Label Window 

Case Base 
This field displays the accession base for the current label template. You can change 
the accession base used for the label sheet by selecting a new base from the drop-
down list. To create a separate label template for multiple accession bases, select the 
first case base and format the template accordingly. Then select the next accession 
base from the Case Base drop-down list. Click Yes when the system prompts you to 
save your changes. You can then enter text and data codes for the newly selected 
accession base. You can repeat this process for each case base in order to create a 
unique label template for each accession sequence. 

Insert Label Data Code Button 
Select a data code from the drop-down list and click Insert Label Data Code to 
insert the selected data code into the label template. Label data codes allow you to 
print specific data items from the SoftPath database on the labels. For example, if 
you insert the <Accession Number> data code, each label will include the accession 
number of the particular case associated with the label. Label data codes can be 
formatted just like normal text.  

Insert Bar Code 
Mark this check box to include a bar code on each label. Click the Bar Code Setup 
button to display the Bar Code Setup window. This window allows you to define 
the default values of the bar code heights, widths, font sizes, and coding types. Refer 
to page 6-222 for more information on bar code setup. 

Layout Form 
Select the layout form to use for this label sheet from the drop-down list. The layout form 
determines the page layout, printer, page margin, and paper size for the label sheet. 
To create a new layout form, select [NEW FORM] from the Layout Form drop-down list 
and click the Config button. To edit an existing layout form, select the form from the drop-
down list and click Config. 
Select the accession base to use for this label sheet from the drop-down list. The case base 
you select determines which label template is used. 
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Config Button 
Select a layout form from the drop-down list and click this button to display a window 
(Figure 6-154) containing three tabs that allow you to define page layout information for the 
form. If you want to create a new form, select [NEW FORM] from the Layout Form drop-
down list and then click the Config button. When you have finished defining the layout 
form, click Save to save your data and return to the Label Setup window. 

 
Figure 6-154. Layout Form Configuration Window - Form Definition Tab 

Form Code  
Enter a name for the form in the Form Code field. 

Form Based On 
Select the printer type that you want to use to print labels that utilize this layout form 
from the drop-down list. The system displays the page margin and paper size for the 
specified printer type in the informational areas located in the bottom half of the 
window. 

Perforated Paper 
Mark the Perforated Paper check box if you want this label to print on a printer 
that uses perforated paper instead of single sheets.  

Delete Code Button 
Click this button to delete this layout form from the system. 
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Select the Paper Form tab (Figure 6-155) to define the position of the label on the page.  

 
Figure 6-155. Layout Form Configuration Window - Paper Form Tab 

Scale 
By default, the preview image located in the Preview area is displayed as the actual 
size (1:1) of the label. You can select a new scale from the Scale drop-down list to 
view a larger area of the page. This setting only affects the label display in the 
Preview area and has no effect on the printed label output. 

Left Pos and Top Pos 
Enter the distance between the edge of the labels and the left and top edges of the 
page.  
NOTE: SCC recommends you use a left position of 1.000 inch and a top 

position of 1.000 inch for most label sheets.  
Page Size 

Enter the dimensions of the paper you will use to print the label sheets. 
Number Across 

Enter a value of 1 if your organization uses single label rolls for printing label 
sheets.  

Label Height and Label Width 
Enter the dimensions (height and width) of the labels for this label sheet. 

Inches/Centimeters 
Mark this check box if you want to specify all measurements on this tab using 
inches. Unmark this check box to specify all measurements on this tab using 
centimeters. 



Chapter 6.9- Setup: Document Files SoftPath GUI v.4.2.1 User Manual 

Page 6-246  PATH4.2-G-U (6th Ed, Rel. 01/31/07) 

Import Form Button 
Click the Import Form button to use page layout settings from an existing layout 
form. When you click this button, a window displays similar to Figure 6-156. Select 
the layout form with the settings you want to import into your current layout form 
and click Import. The system populates the fields of the Paper Form tab with the 
imported page layout data. 

 
Figure 6-156. Import Form Window 

The Printer Attach tab (Figure 6-157) is used to associate printers located on the print 
server with the current layout form. All label sheets that use the layout form can be printed 
only from the attached printers specified in this tab.  
To associate a printer with the layout format, highlight the printer you want to add in the 
Print Server’s Printers list and click the right arrow button. The printer is removed from 
the list and displays in the Attached Printers list. To remove an attached printer, highlight 
the printer you want to remove in the Attached Printers list and click the left arrow button. 

 
Figure 6-157. Layout Form Configuration Window - Printer Attach Tab 
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Default Forms Button 
Click the Default Forms button (located in the Label Sheet Setup window) to display the 
Default Forms window (Figure 6-158). The first column in the window displays a 
description of each available layout form. The second column displays the unique identifier 
for each layout form. Select a layout form by highlighting it and clicking OK. 
NOTE: New forms that you create using the Config button become available in this 

window after you save the information. 

 
Figure 6-158. Default Forms Window 
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ABN Form Setup 

The ABN Form Setup option allows you to create, edit, and delete the available ABN forms that 
will be used by your SoftPath system. The forms that you create and edit here will be available to use 
in Specimen Registration (see Chapter 1.2 – Order: Specimen Registration).  
To access the ABN Form Setup option, select Setup > Document Files > ABN Form Setup from the 
main menu. The ABN Form Setup window (Figure 6-159) is displayed.   

 
Figure 6-159. Document Files menu – ABN Form Setup Window 

ABN Form Setup works with Microsoft Word functionality, which allows you to use its interface to 
create your forms.  
Add Button 

Select this button to create a new ABN form. Once selected, you will be brought to the Word 
interface. 

Edit Button 
Select this button to edit the existing ABN form selected in the list on the left of the window. 
Once selected, you will be brought to the Word interface to make your edits. 

Delete Button 
Select this button to delete the ABN form selected in the list on the left of the window. 

View Generic Button 
Select this button to view a read-only copy of the generic ABN form as provided to SoftPath 
by SoftCompliance.  



SoftPath v.4.2.1 User Manual Chapter 6.9 – Setup: Document Files 

PATH4.2-G-U (6th Ed, Rel. 01/31/07)   Page 6-249 

User Defined Sub-Sections 

The User Defined Sub-Sections option allows users to define the subsections available for 
placement in the system documents, including Final and Preliminary reports.  
To access the User Defined Sub-Sections option, select Setup > Document Files > User Defined 
Sub-Sections from the main menu. The SubSection Setup window (Figure 6-160) is displayed.   

 
Figure 6-160. SubSection Setup Window 

Code 
Assign a code to your subsections, which is used to identify the subsection throughout the 
program. Lower-case alphabetic characters only. 

Description 
Define the subsection heading used once it is inserted within a document. This description is 
also helpful for identifying subsections when setting up reports in Report Setup. 

Active 
A check is displayed in the box to indicate an active subsection.  To inactivate a subsection, 
deselect the check box. 

Canned Message 
The Canned Message check box can be used to associate a subsection with a canned 
message. 
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Auto Assignment 

The Auto Assignment option allows you to define parameters for the automatic assignment of 
incoming cases to personnel. These assignments can be made through the separation of case types 
(Autopsy, MED, GYN, and Surgical) and the levels of personnel (Clerks, Pathologists, etc.). 
Incoming cases can also be classified by source.  
To access the Auto Assignment option, select Setup > Auto Assignment from the main menu. The 
Auto Assignment Setup window (Figure 6-161) is displayed.   

 
Figure 6-161. Auto Assignment Window 

The Auto Assignment window contains the following tabs: 
• Personnel List  
• Client and Source 
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Personnel List Tab 

 
Figure 6-162. Auto Assignment Window – Personnel List Tab 

The Personnel List is expandable by employee type and then individual personnel. Once an 
employee is selected, you can choose the employee’s role in regards to processing a case. 
NOTE: By default, all employees have access to Specimen Processing. Permissions for the other 

options are defined in the Personnel Setup file. See Page 6-7 for more information. 
Clicking in the check boxes under the desired case type will automatically assign the step to the 
employee. 
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Client and Source Tab 
Auto Assignment also allows you to assign incoming cases according to the source or client code. To 
create a new assignment, click the Insert button on the right side of the tab. From there you can 
define the appropriate fields. To remove an assignment, select the entire row of the assignment and 
click the Delete button. 

 
Figure 6-163. Auto Assignment Window – Client and Source Tab 

Case Type 
Click this field to display a drop-down menu; select a case type for the assignment. 

Acc Seq 
Define an accession sequence for the assignment. 

Acc Group 
Define an accession group for the assignment. 

Source 
Click this field to display a drop-down menu; select a source code for the assignment. 

Client 
Enter a free text entry of a client code or use the code lookup screen. 

Assigned To 
Enter a free text entry of a pathologist’s ID code or use the lookup screen. 

Pathologist Name 
This field displays the full name associated to the Pathologist ID selected in read-only mode. 
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Custom Registration Setup 

To access the Custom Registration option, select Setup > Custom Registration Setup from the main 
menu. The Accession Base Select window (Figure 6-164) is displayed.   

 
Figure 6-164. Custom Registration Setup: Accession Base Selection Window 

Use the arrow keys on the keyboard to highlight the desired base and press Enter. The Custom 
Registration Setup window (Figure 6-165) is displayed.  
NOTE: Only one custom registration screen can be created for each accession base. 

 
Figure 6-165. Custom Registration Setup Window 
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Custom Registration Setup elements 

The Custom Registration Setup environment consists of 4 main elements: 
• Control Toolbar 
• Form Toolbox 
• Form Layout Workspace 
• Status Bar 
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Control Toolbar 
The Control Toolbar contains the following buttons: 

Load Form  

 

Select this button to launch the “Select case or base type” window shown in Step #2. 
If the active form has had edits made to it, the system will prompt you to save or 
discard the changes: 

Save Form  

 

Select this button to save any edits made to the active form. 

Template  

 

Select this button to load the system’s default form template for the current case type 
and discard the current layout of the active form. 
WARNING: This is an irreversible action; after this selection is made there is no 

way to recover the previous form layout. 

Tab Order  

 

Select this button to toggle on the feature that allows you to set the tab order of the 
current active form. Tab order is determined with sequential mouse clicks. When the 
Tab Order button is selected, the controls in the form are numbered sequentially. This 
is the default tab order. To change the tab order, select each control in the desired 
sequence with sequential mouse clicks. As the controls are selected, they are 
numbered with a small numeric box (Figure 6-166). 

 
Figure 6-166. Tab Order environment Window 

If a mistake is made, you must continue to assign sequence numbers until the end of 
the sequence when you may begin again with the first number at the start of your 
desired sequence. To save your sequence, select the Tab Order button, which will 
toggle off the feature and save your settings. 



Chapter 6.11- Setup: Custom Registration Setup SoftPath v.4.2 User Manual  

Page 6-256  PATH4.2-G-U (6th Ed, Rel. 01/31/07) 

Snap to Grid 

 

Select this button to toggle on the feature, which allows you to determine the 
dimensions of an invisible grid that allows precise alignment of the various controls 
in each Form. The dimensions of the grid are global across all nested forms, meaning 
that grid dimensions are applied to all forms. To set the grid dimensions, select the 
Snap to Grid button to toggle on the feature and right click in the body of the current 
active form (do not right click on controls). 

:  
Figure 6-167. Set Grid Size Window 

You may set the horizontal and vertical indexes for the grid; select OK to save your 
settings. Because the grid is not visible, it may take a little experimentation to set 
your grid specifications. 

Clear Form  

 

Select this button to delete all non-required field controls from the current active 
form. Use this feature when you are unhappy with the current layout of your form, 
and you want to start designing your form from scratch.  
WARNING: This is an irreversible action; the system will prompt you to 

confirm deletion of controls. 

Show Dem. 

 

Select this button to toggle on and off the display of the Patient Demographics form. 
This form displays by default when the Custom Registration Setup environment is 
first displayed.  
NOTE: This is a required form and is not editable. 

Exit Setup 

 

Select this button to exit the Custom Registration setup environment. If edits have 
been made to the current environment, you will be prompted to save changes. 
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Form Toolbox 
The Form Toolbox contains all of the field controls for a given form. When the Custom Registration 
Setup is activated for an accession base, the toolbox is in compact view. 

 
To display the toolbox in its extended view, mouse over the toolbox icon. The toolbox will extend 
out to the right. 

 
To lock the toolbox into full view, click the check box in the upper right corner of the toolbox. The 
Form Layout Workspace will shift to the right to accommodate the Toolbox. 

 

Form Layout Workspace 
The Form Layout Workspace is described in detail in the Form Layout section.  
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Status Toolbar 
The Status Toolbar displays information about the current active accession base.  
The example below describes, from left to right: 

 
• The system is Ready 
• The user is editing the Requisition Entry form 
• The case type of the accession base is Surgical 
• The active code of the accession base, Y, that is loaded into Custom Registration Setup 
• The system is in Edit mode. 

Form Layout 
The Form Layout Workspace is comprised of a series of nested forms. A schematic of the nested 
form layout is displayed below. 

 
Each form may contain two types of objects: children form objects and field control objects. A 
child form is a form that is nested within a parent form. Field controls are elements that represent 
data entry fields. Both form objects and field control objects can be positioned within the parent 
container layouts using drag and drop functionality.  
There are two types of field controls; required and non-required. Just as in the traditional data 
entry screens in the system, some of these data entry fields are required fields in which data entry is 
mandatory. The required controls are displayed in a bold red font in the Form Toolbox, and cannot 
be deleted from the container form in which they reside.  
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Requisition Entry Form 
The Requisition Entry form is opened when the Custom Registration Setup screen first displays. 
This form is the parent container of the four children forms where form layout design occurs. The 
Requisition Entry form cannot be edited, and is not labeled. The Requisition Entry form contains 
the Demographics form and the Case Data form. 

 

Demographics Form 
The Demographics form is required, is not editable, and includes no children forms. It contains the 
following field controls: 

• MRN 
• Billing number 
• Social Security number 
• Date of Birth 
• Age 
• Sex 
• Last Name 
• First/Middle Name 
• Case number 
• Ward 
• Room number 
• Admitting Doctor 
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Case Data Form 
The Case Data form contains one child form (Number of Specimens form). The Case Data form 
contains the following field control elements (required fields are displayed in bold): 

• Additional Client Fields 
• Case Comment 
• Clinical Info 
• Foreign Case 
• Operation Info 
• Other Case Data 
• Pathologist 
• Priority 
• Procedure Date & Time 
• Registered Date & Time 
• Reported To 
• Requesting Doctor 
• Resident 
• Specimens 

Number of Specimens Form 
The Number of Specimens form contains one child form (Single Specimen form). The Number of 
Specimens form contains only one control, which is required: 

• Number of Specimens 

Single Specimen Form 
The Single Specimen form contains no child forms. The Single Specimen form contains the 
following control elements (required fields are displayed in bold): 

• Body Site 
• Collection Method 
• Lab Tests 
• Modifier 
• (# of) Pieces 
• Received D&T 
• Source 
• Source Flags 
• Special Tests 
• Specimen Comment 
• Specimen Number 
• User Defined Flags 
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Form Design 
To design a form in Custom Registration Setup, it is recommended that the Control Toolbox is 
displayed in extended view (Figure 6-168). 

 
Figure 6-168. Custom Registration Setup Window – Control Toolbox in Extended View 

Double click the white area in the Case data form, which will open the Case Data form in edit mode. 
Notice that the cursor icon is shaped differently when it is positioned over a moveable object; in this 
case, the Call Request field control. When the cursor icon is shaped like  the drag and drop 
functionality is active and the object can be repositioned in the layout field. Additionally, the object 
will be highlighted in white (Figure 6-169).  

 
Figure 6-169. Custom Registration Setup Window – Drag-and-Drop Functionality 
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Child form objects can be positioned in the same manner. 

 
Figure 6-170. Drag-and-Drop Functionality of a Child Form Object 

Notice that the Call Request field control has been repositioned in-between the Other Case Data 
and the Undergo QA field controls. 
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Notice that the Foreign Case field control does not nave a check mark in the corresponding check 
box, which indicates that it is not currently included in the Case Data form. Now, drag and drop the 
Foreign Case field control from the Control Toolbox into the body of the Case Data form. The 
mouse cursor will change shape to indicate that the mouse cursor will add the field control where the 
cursor is when the control is dropped. 

 
Now the Foreign Case field control can be positioned as desired. If the Snap to Grid button is 
toggled on, the system will align the field control with the others. 

 
Notice that the Control Toolbar contains a new button, the Close Form button . Selecting 
this button will close the current active form. If edits have been made to current active form, you will 
be prompted to save any changes to the form layout. 

 



Chapter 6.11- Setup: Custom Registration Setup SoftPath v.4.2 User Manual  

Page 6-264  PATH4.2-G-U (6th Ed, Rel. 01/31/07) 
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Chapter 7. Utility 

The Utility menu options allow you to work with audit trails, perform action and billing entry, 
provide screening evidence, access archive utilities, set up remote printing, define ODBC reports, 
and more. 

 
Figure 7-1. Utility Menu 
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SoftPath Utility Menu Options 
The SoftPath Utility option contains the following features and applications: 

Audit Trail 
The Audit Trail option allows you to create and view reports regarding changes in system 
information.  
See Chapter 7.1—Utility: Audit Trail. 

Archive Utilities 
The Archive Utilities option allows you to access utilities to define parameters regarding the 
archiving of your system. 
See Chapter 7.2—Utility: Archive Utilities. 

Action Entry 
To monitor unresolved QA situations, select the Action Entry option.  
See Chapter 7.3—Utility: Action Entry. 

Billing Entry 
To modify a patient’s billing transaction record, select the Billing Entry option. 
See Chapter 7.4—Utility: Billing Entry. 

Screening Evidence 
To record statistics about screener performance, select the Screening Evidence option.  
See Chapter 7.5—Utility: Screening Evidence. 

Remote Printing 
To set up remote printing and faxing services, select the Remote Printing option.  
See Chapter 7.6—Utility: Remote Printing. 

Material/Letter Management Worklist 
The Material/Letter Management Worklist allows you to change technical billing 
locations, professional billing locations, specimen, block and slide storage, and the 
assignment of letters.  
See Chapter 7.7—Utility: Material/Letter Management Worklist. 

Interfaces Setup 
This option bridges to the Interfaces Setup file of SoftLab.  
See Chapter 7.8—Utility: Interfaces Setup. 

Case Utility 
To suppress or restore a signed-out case, select the Case Utility option.  
See Chapter 7.9—Utility: Case Utility. 

Define ODBC Reports 
The Define ODBC Reports option allows you to establish parameters regarding your 
database reporting features.  
See Chapter 7.10—Utility: Define ODBC Reports. 

Screen Shot Options 
Use Screen Shot Options to send screen shots from SoftPath either to a printer or to an 
interested party through e-mail.  
See Chapter 7.11—Utility: Screen Shot Options. 
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Audit Trail 

The Audit Trail viewer option allows you to: 
• Create reports detailing access to patient information 
• View changes made to patient demographics and results 
• View reports manually and automatically generated 
• View changes to setup 

The viewer will also allow the user to set a variety of search criteria for each trace type. 
There are four available trace types:  Patient Access, Patient Audit Trail, Batch Job, and Setup 
Audit Trail.  Associated with each trace type will be two parameters: category and action.  The 
category defines what type of data is accessed (demographics, order, results, verified, results, or 
setup) while the action defines what is being done to the data (addition, deletion, modification, 
reading, or printing). 

 
Figure 7-2. Audit Trail Viewer 

Trace Type 
Patient Access The Patient Access report contains information about anytime a patient 

record or case is viewed. This includes changes of assignment performed 
via the Manager’s Dashboard or My Workspace. 

Patient Audit Trail The Patient Audit Trail report contains information about edits that occur 
to patient records and cases. 

Batch Job The Batch Job report will display every print job that is run either 
manually or from the Scheduler. 
NOTE: This module is still currently under development. 

Setup Audit Trail The Setup Audit Trail report will display all changes made to the setup 
files. 
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Report Dependent Parameters 
From 

Enter the beginning date for the search or click the dynamic list button and select a 
date from the calendar. 

To 
Enter the date to end the search or click the dynamic list button and select a date 
from the calendar. 

Calendar 
Click on the down arrow to the right of the field to display a calendar for the 
current month. Select the desired day and month by clicking on them. 
Changed the month by clicking on the right and left arrows on the calendar.  Or 
you can click on the month and a drop-down list of months will display. Select the 
desired month by clicking on it. Select the year by clicking on the double arrows or 
the up/down arrow to the right of the year. 
Click OK to close. 

Product 
Select the Soft application.  The drop-down menu allows you to select any 
combination of products or to select all available products. 

User ID 
Enter the specific ID or leave the field blank to view all users. 

Option 
This field refers to the Security Option number in SoftSec.  This is a number that 
corresponds to the option/suboption in the product. 

Order 
This is the order number or applicable ID (case, folder, etc.). 

Label 
Used as an identifier for programmers to search for specific actions in audit trails.  
Programmers will use this field for troubleshooting. 

Site 
For client’s with a multisite only.  Specify the site code that the report will search. 

MRN 
The Medical Record Number assigned to the patient.  This number is unique and 
may be system-generated or pulled from the HIS.  Maximum 15 alphanumeric 
characters. 

Billing 
Enter the patient billing number.  Maximum of 12 alphanumeric characters. 

Terminal ID 
Equals the ttyy# located in the upper-left corner of the PC/terminal screen after login 
to the LIS system. For clients with terminal servers and network connections please 
contact an SCC representative from Hardware to configure these for you. 

Program Name 
The program name field is the name of the program or server that was used during 
the user's action in the application. 
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Trace Category 
Trace Category defines what type of data is accessed.  This is one of two parameters that are 
always associated with every audit trail function. 

• Setup • Results 

• Demographics • Verified Results 

• Order  

Trace Action 
Trace Action defines what is being done to the data.  This is one of two parameters that are 
always associated with every audit trail function. 

• Addition • Read-only Access 

• Deletion • Print 

• Modification  

Additional Parameters 
In this field you can enter additional parameters for the report, if you want all lines that have 
a specific pattern.  The syntax of the parameters is the same as for the egrep UNIX 
command. 

Send To 
Click the down arrow to select the printer option. 

Run 
Click to start run. 
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Audit Trail Reports 
Based on Trace Types, this section includes the following examples of Audit Trail Reports: Patient 
Access, Patient Audit Trail, Batch Job, and Setup Audit Trail. 
The Comment Details window (Figure 7-3) displays when you double click on a row from a Patient 
Audit Trail, Batch Job, or Setup Audit Trail Report.  The window includes a description of the 
specified field. 

 
Figure 7-3. Comment Details Window 

Patient Access Report 
The Patient Access Report contains information about anytime a patient record or case is 
viewed. 

 
Figure 7-4. Sample Patient Access Report 
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Patient Audit Trail Report 
The Patient Audit Trail Report gives a detailed report of all changes to Patient 
Maintenance or Case Records. 

 
Figure 7-5. Sample Patient Audit Trail Report 

Batch Job Report 
The Batch Job Report gives a detailed report of all batch print jobs attempted in the system. 

 
Figure 7-6. Sample Batch Job Report 
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Setup Audit Trail Report 
The Setup Audit Trail option allows you to monitor and report changes (including no 
action) to certain setup files after the initial installation period. This option creates a trace 
file that records each time a user accesses the Archive Utility sub-options. In addition, this 
feature records modifications to the Personnel file, Collection Method file, Consultation file, 
and Canned Message file. Since all of the actions are recorded in the database, it is possible 
that the audit trail becomes too large for the storage space available. Therefore, you should 
remove the audit trail every ten days. The first-in-first out (FIFO) theory is used by the 
system to determine which audit trail items should be removed. 

 
Figure 7-7. Sample Setup Audit Trail Report 
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Archive Utilities 

Internal Archiving 
The Internal Archiving option allows you to run the Archive Utility program and to establish or 
change the number of days a case remains in the active database before it is archived. Archiving 
purges unnecessary information from the active database and creates an archive pool of cases that 
you can access in the system. The Archive Utility program usually runs automatically each night 
and uses the criteria setup in this option to select the cases to archive. 
To access the Internal Archiving option, select Utility > Archive Utilities > Internal Archiving 
from the main menu. The Internal Archiving window (Figure 7-8) is displayed. Enter search 
criteria to determine which the cases the system will select during the archival process. 

 
Figure 7-8. Internal Archiving Window 

Sign Out Date Range  
Enter a range of dates. Click the  buttons to select the dates from the calendar. The system 
archives all cases signed out within the specified range of dates. Maximum 8 numeric 
characters using the mm/dd/yyyy format. 

Case Type 
Mark the check boxes next to the case types you want to include in the archive process. 

Pathologist 
Enter up three pathologist ID codes in these fields. Click the  button to select from a list of 
valid pathologists.  
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Consultation Cases 
Enter the required number of consultation cases that must exist before the system archives 
information. Consultation cases are cases with slides (including stains/tests) that have been 
sent out from the lab and returned (outgoing consultations) or received in the lab and 
returned (incoming consultations). 

Rejected Cases 
Enter the required number of rejected cases that must exist before the system archives 
information. Rejected cases are cases with a processing problem, a Specimen Adequacy 
code with a rejected flag set to yes, or a case where Action Entry is rejected. 

Registration Cases 
Enter the required number of registered cases that must exist before the system archives 
information.  

OK Button 
After you enter the archive criteria click OK to confirm the selection and start the scanning 
process. The Internal Archiving Status window (Figure 7-9) is displayed.  

 
Figure 7-9. Internal Archiving Status Window 

The following information is provided in the Internal Archiving Status window:  

Status The status of the scanning process. 

Scanned The number of scanned cases. 

Qualified The number of qualified cases. 

Performed The number of performed cases. 

Close 
Click the Close button to close the Internal Archiving Status window. 
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Action Entry 

The Action Entry option allows you to document, verify, or acknowledge unresolved QA situations 
such as proficiency testing and screening evidence, of final diagnosis. This option is reserved for the 
pathology lab supervisor or pathologist.  
To access the Action Entry option, select Utility > Action Entry from the main menu. The Action 
Search window (Figure 7-10) is displayed. Enter search criteria in the available fields to search for 
specific cases. Click Find to display the results of the search on the Cases tab and select a case. The 
Actions for Case tab displays, showing any actions required for the case and the option to add a new 
action to the case. 

 
Figure 7-10. Action Search Window 

The Actions for Case tab contains information concerning actions such as: default action, status, 
date of action execution, time of action execution, ID of the personnel who performed the action, the 
result of the action and the number of the action. Double-click an action entry to display the Action 
Entry window. You can use this window to edit/view the action entry. To add a new action, click the 
Add button on the Actions for Case tab and the Select Action to Add window (Figure 7-11) is 
displayed.  
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Figure 7-11. Select Action To Add Window 

Code Action Description 
V Deactivate Case Select this option to deactivate an unsigned case. When the case is 

deactivated, it is not available for processing or result entry and is 
displayed with a status of deactivated 

D Discrepancy Select this option to document QA discrepancies for cases that have an 
associated QA procedure with a QA code attached that is flagged as 
discrepancy in the corresponding setup file.   

N Not re-examined Select this option to document overdue, not performed Rescreen, 
Proreview, and Retroreview procedures.   

T Overdue Autopsy 
Correlation 

Select this option to document overdue, not preformed Autopsy 
Correlation procedures.  

F Overdue Follow 
Up Correlation 

Select this option to document overdue, not performed Follow Up 
Correlation procedures.   

I Overdue IOC 
Correlation 

Select this option to document overdue, not performed IOC Correlation 
procedures.   

C Preliminary 
Cancel 

Select this option to cancel an unsigned preliminary report.  If the 
preliminary report has been signed out, a message displays stating that 
the report is signed out and not available for cancellation. The report 
will display as cancelled in the Reports section of the Query case tab 
and will not be available for printing. 

R Rejected Case Select this option to mark a case as rejected when a processing 
problem code including the rejection flag is attached to the specimen.  
If all specimens for the case are flagged as rejected, the entire case is 
flagged as rejected and will no longer be pending for specimen 
processing. 

E Screener 
Evidence 

Select this option to display cases where the screeners slide limit was 
exceeded for the day. 

U Supplemental 
Cancel 

Select this option to cancel an unsigned supplemental report.  If the 
supplemental report has been signed out, a message displays stating 
that the report is signed out and not available for cancellation. The 
report will display as cancelled in the Reports section of the Query 
case tab and will not be available for printing. 

After you select the action type that you want to add to the current case, click OK and the Action 
Entry window (Figure 7-12) is displayed. Patient and case information is displayed at the top of the 
window and cannot be modified. 
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Figure 7-12. Action Entry Window 

Done By 
Enter the ID of the personnel performing the action or click the  button to select from a list 
of qualified personnel. This is a required field.  

Date 
Enter the date that the action was performed or click the  button to select the date from a 
calendar. This is a required field. 

Time 
Enter the time of the action. This field defaults to the current time. HH:MM format. This is 
a required field. 

Result 
Enter the QA code that describes result of the action. Click the  button to select from a list 
of valid QA codes. This is a required field. 

Action Comment 
Enter a free text comment for the action. 

Tag Letters 
Select up to three tag letters from the drop-down lists. Tag letters are defined during file 
setup in the Simple Codes option. 

Rescreen 
Mark this checkbox to flag this case for rescreening. 
NOTE: This checkbox is only available if the case has not been signed out. 
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Retroreview 
Mark this checkbox to flag this case for retroreview. 

Proreview 
Mark this checkbox to flag this case for proreview. 
NOTE: This checkbox is only available if the case has not been signed out. 

Deactivate 
Mark this checkbox to flag this case for deactivation. 
NOTE: This checkbox is only available if the case has not been signed out. 
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Case Description Tab 
The Case Description tab (Figure 7-13) allows you to view more detailed information regarding the 
case. This tab also links the information to other data in SoftPath. Clicking one of the hyperlinks 
bridges you to a specific tab in the Result Query where you view additional information. 

 
Figure 7-13. Action Entry Window – Case Description Tab 



Chapter 7.3 – Utility: Action Entry SoftPath GUI v.4.2.1 User Manual 

Page 7-16  PATH4.2-G-U (6th Ed, Rel. 01/31/07) 

Case Comment Tab 
The Case Comment tab (Figure 7-14) allows you to enter a free-text comment for the case. After 
entering all desired data click Cmpl (complete) or Save from the SoftPath toolbar. Clicking Cmpl 
marks the action as completed. If you save the data before marking the action as complete, you can 
still edit the action up until the number of days specified in the Options file. If you click the Cmpl 
toolbar button, the action is marked as complete and can no longer be edited.  

 
Figure 7-14. Action Entry Window – Case Comment Tab 
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Billing Entry 

The Billing Entry option modifies the patient’s billing transaction record. It is used in occurrences 
when an error is discovered after the billing report has been generated and sent to the billing agency 
(HIS or third party) for review. For example, an incorrect billing code or the number of times an item 
is billed are errors that can be corrected with this option. Billing is divided into two components: 
Technical (Part A) and Professional (Part B). Either can be corrected. 
To access the Billing Entry option, select Utility > Billing Entry from the main menu. The Billing 
Search window (Figure 7-15) is displayed. After entering search criteria, click Find. All of the 
qualifying cases or patients will display in the Billing Entry window (Figure 7-16). 

 
Figure 7-15. Billing Search Window 



Chapter 7.4 – Utility: Billing Entry SoftPath GUI v.4.2.1 User Manual 

Page 7-18  PATH4.2-G-U (6th Ed, Rel. 01/31/07) 

Part A Tab 
The Part A tab (Figure 7-16) contains a grid that lists the billing codes and the number of times each 
code is billed. This tab allows you to view, add, and modify Part A billing information. 

 
Figure 7-16. Billing Entry Window - Part A Tab 

You cannot modify the IBC, CPT, Name, Calculated and the Sent Changes fields. The Change To 
and Change Type fields can be modified, if necessary.  
To add a billing transaction to the list, click the Add button. The Technical Charge Lookup 
window is displayed with a listing the available CPT codes. Select a code and click OK. The 
selected CPT code is inserted into the grid. To delete a billing transaction, highlight the transaction 
you want to delete and click the Delete button. The deleted transaction is removed from the grid. 
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Part B Tab 
The Part B tab (Figure 7-17) contains a grid that lists the billing codes and the number of times each 
code is billed. This tab allows you to view, add, and modify Part B billing information. 

 
Figure 7-17. Billing Entry Window - Part B Tab 

You cannot modify the IBC, CPT, Name, Calculated and the Sent Changes fields. The Change To 
and Change Type fields can be modified if necessary. 
To add a billing transaction to the list, click the Add button. The Technical Charge Lookup 
window is displayed with a listing of the available CPT codes. Select a code and click OK. The 
selected CPT code is inserted into the grid. To delete a billing transaction, highlight the transaction 
you want to delete and click the Delete button. The deleted transaction is removed from the grid. 



Chapter 7.4 – Utility: Billing Entry SoftPath GUI v.4.2.1 User Manual 

Page 7-20  PATH4.2-G-U (6th Ed, Rel. 01/31/07) 

Assign ICD9 to CPT Codes Tab  
The Assign ICD9 to CPT Codes tab (Figure 7-18) allows you to assign ICD9 to CPT codes. 
NOTE: The billing report must be re-printed for the date that encompasses the case that was 

edited in order for the billing changes to be sent. 

 
Figure 7-18. Billing Entry Window - Assign ICD9 to CPT Codes Tab 

ICD9  
The grid displays the ICD9 fields.  Double clicking in the field will bring up the browser 
button.  Click the  button in each field to display the ICD9 Lookup window. This window 
allows you to select from a list of available ICD9 codes. 

CPT Codes Grid 
The grid that contains following columns: 
CPT The CPT code to assign to an ICD9 code. 
Code Description A description of the CPT code 
Count The number of ICD9 codes to associate with the CPT codes. 
ICD9 (1, 2, 3, 4) The specific ICD9 codes that you want to associate with this CPT code. 

Entering a number in these fields associates the CPT code with the 
ICD9 code entered in the corresponding numbered field in the ICD9 
area. 

NOTE: Mark multiple rows of the grid to assign the same code to all selected rows. 
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Insurances 
The Insurances tab (Figure 7-19) allows you to view and enter a patient’s insurance information. 

 
Figure 7-19. Billing Entry Window – Insurances Tab 
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Accounting Tab 
The Accounting tab (Figure 7-20) displays information regarding the default performing locations 
and the default patient insurance information for the case. 

 
Figure 7-20. Billing Entry Window – Accounting Tab 
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Screening Evidence 

The Screening Evidence option is used daily by screeners to record the number of hours spent 
screening and the number of slides screened by the employee within a 24 hour period. Screeners 
should record the actual number of hours spent screening each day and the number of hours worked 
on projects and procedures performed other than screening slides. The screened volumes for other 
laboratories can be recorded here as well. 
To access the Screening Evidence option, select Utility > Screening Evidence from the main menu. 
The Screener ID Lookup window is displayed; search for a screener ID. When an ID is selected, the 
Slide Screening Evidence window (Figure 7-21) for the selected screener ID is displayed. 

 
Figure 7-21. Slide Screening Evidence Window 

Screening Date 
Enter the screening date using the mm/dd/yyyy format or click the  button to select a date 
from the calendar.  
NOTE: The screening date cannot be a date in the future. If you enter a future date, the 

system displays the message “Cannot be a future day.” 
Screening Hours 

Enter the hours the screener spent screening slides. HH:MM format. 
Procedure Hours 

Enter the hours the screener spent performing the procedure. HH:MM format. 
Slides 

The Slides field is automatically calculated by the system based on the cases resulted on the 
date specified in the Screening Date field and the number of slides attached to each case. 
This is a READ ONLY field. 
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Credit Slides Button 
Select the Credit Slides button to credit slides that you did not work on to your count. When 
clicked, the system displays the Credit Slides window (Figure 7-22), where you can select 
how many slides in a case should be removed from your User ID. You may also enter a 
comment on why you are changing your slide count. These values will be appear in the 
Screening Evidence Report as described in Chapter 5.8 – Reports: QA Reports. 

 
Figure 7-22. Credit Slides Window 

Project Hours 
Manually enter the project hours. HH:MM format. 

Other Laboratory Area 
This Other Laboratory Area is used to enter additional screening hours and the number of 
slides screened in the other laboratories. Information for up to three laboratories can be 
entered. 

History Button 
Click the History button to view the screening evidence history for the current screener ID. 
The Screening Evidence - History window (Figure 7-23) is displayed.  

 
Figure 7-23. Screening Evidence - History Window 

The Screening Evidence - History window displays in READ ONLY mode with the date of 
the screening, screening hours spent in the lab, screening hours spent in the other lab, total 
screening hours, and the total number of slides screened. Click the Close button to return to 
the Screening Evidence window. 
NOTE: Data cannot be saved if there have not been any slides screened. The system will 

display a message window “In order to Save, slides must be screened.” 
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Remote Printing 

The Remote Printing option is used for single or batch report printing to an off-site printer or fax 
via a modem.  It allows you to set up remote printer/fax locations for the transmission of 
reports/faxes, track the status of all jobs sent through the modem and fax modem, and view the status 
of the modem server, fax server and the remote printing server.  Reports can be sent as soon as the 
report is created or at a specific time using the Print Scheduler option. 
To access the Remote Printing option, select Utility>Remote Printing. The Remote Printing 
window (Figure 7-24) is displayed.  

 
Figure 7-24. Remote Printing Window 

Remote Printing Option Descriptions 
To help make a selection from the Remote Printing menu, each option is listed below in the order it 
appears on the screen. 
Modems 

The Modems option allows you to view the Pending, Successful and Failed job logs along 
with the Modem server.  It also provides an option to purge the modem logs.   

Fax 
The Fax option allows you to view the Pending, Successful and Failed job logs along with 
the Fax servers.  It also provides an option to purge the fax logs.   

Scheduled 
The Scheduled option allows you to view the faxes that are scheduled to be queued.   
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Rptd 
The Rptd option allows you to view the status of the remote printing server and will allow 
you to start or stop the server.   

Setup 
The Setup option allows you to add, delete, edit, find, and view the various remote 
printer/FAX setup definitions.   

Modems 
The Modems option allows you to view the Pending, Successful and the Failed job logs 
along with the Modem servers and the option to purge the modem logs.  You can also View, 
Resend, Cancel_job, Delete_entry, Purge_log, view_Log and Quit. These functions are at 
the bottom of the Pending, Successful and Failed log screens. 

 
Figure 7-25.  Modems Options 

Pending Modem Jobs 
The Pending jobs log option will list all pending jobs as well as queued 
jobs to be sent via modem similar to Figure 7-26.  To access pending 
modem jobs, click the Modem Pending Jobs button, or click Modems 
[Pending jobs]. 

 
Figure 7-26.  Listing of Pending Jobs 
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The information displayed in the above listing includes; file name, job number, 
modem number, the date and time the job was queued, the date and time the job was 
attempted to be sent, the actual number of tries, the maximum number of tries 
(where 20 is the maximum), the result of the attempt, and the Modem number. 
NOTE: If a job is not transmitted successfully the first time, the system 

automatically retries to a maximum of 20 attempts.  After 20 attempts, 
the job goes to the Failed jobs log and must be queued again. 

Successful Modem Jobs 

 
To access successful modem jobs, click the Modem Successful Jobs 
button, or click Modems [Successsful jobs].The Successful jobs log will 
list all successfully reported jobs similar to Figure 7-27.   

 
Figure 7-27.  List of Successful Jobs 

This screen displays the file name, job number, modem number, date and time the 
job was queued, the date and time a job was attempted to be sent, number of times it 
was tried, maximum number of tries (20), and the result of the job (NORMAL 
indicates a successful attempt). 

Failed Modem Jobs 

 
To access failed modem jobs, click the Modem Failed Jobs button, or click 
Modems [Failed jobs].  The Failed jobs log will list all jobs that were 
unable to be completed similar to Figure 7-28. 

 
Figure 7-28.  List of Failed Jobs 

This screen displays the file name, the job number, the modem number, the queued 
date, the queued time, the date and time the job was attempted to be sent, the number 
of times it was tried, the maximum number of tries (20), and the result of the job. 
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NOTE: If a job was not transmitted successfully the first time, the system 
automatically retries to a maximum of 20 attempts. If, after 20 attempts, 
the job was not transmitted successfully, it displays on the Failed Jobs 
log and must be queued again.  Use the Resend option on the menu at 
the bottom of the screen to start the process again. 

Modem Servers 

 
To access Modem Servers, click the Modem Servers button, or click 
Modems [Modem Servers].  Modem Servers show the modem devices 
along with the baud rate, status and the phone number of the 
modem/modems similar to Figure 7-29.  The function keys at the bottom of 
the screen allow you to start, stop and delete the modems.  You will also be 
able to view the device trace and the process id trace. 

 
Figure 7-29.  List of Modem Devices 
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Purge Modem Logs 

 
To access the purge modem jobs option, click the Purge Modem Jobs 
button, or click Modems [Purge modem jobs].  The Purge Modem Logs 
option allows you to remove all log entries in the failed, pending and 
successful logs that are older than x amount of days.  (See Figure 7-30.)  
Click, OK to purge, or click Cancel to cancel. 

 
Figure 7-30.  Modem Purge 

Fax 
The Fax option (see Figure 7-31) allows you to view the Pending, Successful and Failed job 
logs along the Fax servers.  It also provides an option to purge the Fax logs.  You can also 
View, Resend, Cancel_job, Delete_entry, Purge_log, view_Log and Quit. These functions 
are at the bottom of the Pending, Successful and Failed log screens. 

 
Figure 7-31.  Utilities-Remote Printing-Fax 

Pending Fax Jobs 

 
To access the pending jobs option, click the Fax Pending Jobs button, or 
click Fax [Pending jobs].  Pending jobs displays a listing of what is 
queued to be faxed, similar to Figure 7-32. 
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Figure 7-32.  List of Queued Faxes 

The information displayed in the Pending Jobs listing includes; file name, request 
number (job number), user ID, the date and time the fax was queued, date and time 
the fax was attempted, result, and number of times it was tried. 
NOTE: If a job was not transmitted successfully the first time, the system 

automatically retries to a maximum of 5 attempts.  If, after 5 attempts, 
the job was not transmitted successfully it displays on the Failed Jobs 
log. 

Successful Fax Jobs 

 
To access the successful fax jobs option, click the Fax Successful Jobs 
button, or click Fax [Successful jobs].  The successful jobs log will list all 
successfully reported jobs similar to Figure 7-33. 

 
Figure 7-33.  List of Successful Fax Jobs 
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The information displayed in the above listing includes; file name, job (request) 
number, date and time attempt to fax was made, number of pages sent/number of 
pages sent with at least one error, user ID, fax number, result of the attempt 
(NORMAL indicates a successful attempt), and the actual number of tries. 

Failed Fax Jobs 

 
To access the failed fax jobs option, click the Fax Failed Jobs button, or 
click Fax [Failed jobs].  The Failed jobs log will list all failed jobs 
similar to Figure 7-34. 

 
Figure 7-34.  List of Failed Fax Jobs 

The information displayed in the above listing includes; file name, job (request) 
number, date and time attempt to fax was made, number of pages sent/number of 
pages sent with at least one error, user ID, fax number, result of the attempt, and the 
actual number of tries (5 maximum). 
NOTE: If a job was not transmitted successfully the first time, the system 

automatically retries to a maximum of 5 attempts.  If, after 5 attempts, 
the job was not transmitted successfully, it must be queued again.  Use 
the Resend option on the menu at the bottom of the screen to start the 
process over. 

Fax Servers 

 
To access the fax servers option, click the Fax Servers button, or click 
Fax [Fax servers].  The Fax server shows the fax name and the device 
name along with the status of the fax similar to Figure 7-35. 
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Figure 7-35.  Fax Servers Status 

Purge Fax Logs 

 
To access the Purge fax logs option, click the Purge fax logs button, or 
click Fax [Purge fax logs].  The Purge fax logs will allow you to remove 
all log entries in the failed, pending, and successful logs that are older than 
x number of days similar to Figure 7-36.  Click OK to purge fax logs, or 
click Cancel to cancel the purge. 

 
Figure 7-36.  Fax Purge 

Scheduler 

 
To access the Scheduler option, click the Scheduled Jobs button, or click Tools 
[Scheduler].  The Scheduler option displays a list of all faxes scheduled to be 
queued, as defined in Setup, similar to Figure 7-37. 

 
Figure 7-37.  Listing of Scheduled Faxes 

The information displayed in the above listing includes; the user ID/job (request) number, 
the date and time when the fax is scheduled to be sent, and program command 
(command/filename, etc.). 

Run RPTD (Remote Printing Daemon) 

 
To access the RPTD option, click the Run RPTD button, or click Tools [RPTD].  
The RPTD option allows you to view the status of the remote printing server and 
will allow you to start or stop the server.  (See Figure 7-38.)  You can also view the 
trace file for Remote Printing.  The RPTD option will display the remote printing 
daemon process identification number if it is running. 
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Figure 7-38.  RPTD (Remote Printing Daemon) 

Setup 

 
To access the Remote Printing Setup option, click the Remote Printing Setup 
button, or click Tools [Setup].  The Setup option allows you to add, delete, edit, 
find, and view the various remote printer/fax setups similar to Figure 7-39. 

 
Figure 7-39.  Remote Printers Setup Screen 

Each of the options at the bottom of the screen is described below.   
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Add 
Click the Add button to define a new remote printer/fax location.  Click Add and the 
Remote Printer Editing window displays similar to Figure 7-40.   

 
Figure 7-40.  Remote Printer Editing Window 

Remote Modem ID 
Enter a unique ID for each remote printer/fax location.  Maximum three 
characters. Required field. 

Phone number 
Enter the telephone number of the remote printer/fax location including any 
convention for dialing out (e.g., 9).  Commas can be included to indicate a 3-second 
pause.  Required field. 

Baud Rate 
Enter the baud rate of transmission, if desired, or press any key for a list of valid 
baud rates.  (Usually a baud rate of 2400 is standard.) 

Printer Type 
Click the drop-down list button to select the printer type/fax or press any key for a 
list of the valid types.  If you are using the fax, you must choose FAX as the printer 
type.  If you are sending a report to a remote printer, choose the appropriate printer 
at the remote location.  Required field. 

Printer Options 
The–c and the–f options are the only options that SCC is currently using. 

-c Add a CR character after a newline of a formfeed. 
-f Remove ending FF from input file. 

Please contact SCC’s Hardware department about these options when setting 
up your printers. 

Client ID 
Enter a client ID, if desired.  Maximum 7 alphanumeric characters.  

Client Location 
Enter a client location, if desired.  Maximum 31 alphanumeric characters. 
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Schedule 
Enter the starting and ending time schedule, if desired, for sending the reports to 
print.  Use the hh:mm-hh:mm format (repeat if necessary).  Usually a schedule of 
00:00-23:59 is standard.  (This field only needs to be defined when a schedule of 
other than 24 hours is required e.g., 14:00-20:00.) 

Min printout ln 
Enter the minimal length of lines for a printout.  Transmissions shorter than this 
length will be held until the length is exceeded.  Default is 0. 

Options 
The Options field is used to define a specific fax server name or a specific remote 
printer ID character, allowing a report to print through a specific fax server or 
through a specific Remote Printing daemon.  Intended for Multisite clients only. 
If you have more than one fax server, fax1 and fax2, SoftLab chooses the first 
available server when sending a fax.  If you would like to send a fax through a 
specific server, put the parameter –d followed by the fax server name on the options 
line of the Fax ID.  See Figure 7-41. 

 
Figure 7-41.  Example Remote Printer Setup 

Using the above Remote Setup (Figure 7-41) if ID TEE, the Options line is defined 
as –dfax2.  All reports that are to be faxed to TEE will always go through the server 
fax2. 
When using more than one remote printing daemon, mpd tty145 R and mpd tty142 
T, SoftLab will choose the daemons randomly unless they are defined in the Fax 
setup on the Options line.  At the end of the command line for each remote printing 
daemon is an SCC defined character (e.g., mpd tty 145 R).  (See Figure 7-42.)  The 
default character for the primary Remote Printing daemon is always R.  If a client 
has more than one remote-printing daemon, SCC will define the other daemons with 
different characters.  To specify which Remote Printing daemon is used, put the 
character for a specific daemon on the Options line in the Fax setup for the remote 
modem ID. 
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Figure 7-42.  Sample Remote Printer Setup 

Using the above Remote Setup for ID TEE, the Options line is defined as –dT.  All 
reports that are to be printed to TEE will always go through the Remote Printing 
daemon with the end character of T. 
When finished entering data, click OK and wait for the menu at the bottom to 
reappear.  Click the Save button to save the data, or click Cancel to exit without 
saving the changes. 

Editing an Existing Remote Printer/Fax Location 
To edit an existing remote printer/fax location, double-click the option you wish to 
edit.  The Remote Printer Editing screen displays similar to Figure 7-41.  When data 
entry is complete, click OK, than click Save to save your changes. 

Add a Remote Printer/Fax 
Instructions are the same as described in Setup. 
If you have a fax modem, it is important to create a dummy fax record.  The dummy 
fax record contains only the information displayed in Figure 7-43 and is used for ad 
hoc faxing. 

 
Figure 7-43.  Sample Dummy Fax Record 
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When you need to send a fax through Order Entry, choose Fax (Figure 7-44). 

 
Figure 7-44.  Printer Selection/Search Window-Order Entry 

Enter the desired fax number in the search window (Figure 7-44). 

FAX/Remote Reporting 
The FAX/Remote Reporting system is on a network, multi-directional, cable system, as 
shown in Figure 7-45.  The following descriptions apply to the system: 
RPTD Remote printing daemon Trace File (/tmp/rpt.trace). 
MPD Modem Printing Daemon. 
VSIFAX A software controlling queuing of jobs from the system to the fax machine 

 
Figure 7-45.  FAX Remote Reporting 
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Material/Letter Management Worklist 

The Material/Letter Management Worklist allows you to change technical billing locations, 
professional billing locations, specimen, block and slide storage, and the assignment of letters.  
To access the Material/Letter Management Worklist option, select Utility > Material/Letter 
Management Worklist from the main menu. The Material/Letter Management Worklist Search 
window (Figure 7-46) is displayed. 

 
Figure 7-46. Material/Letter Management Worklist Search Window 

To run a search, you must first select the action you would like to perform. The available actions are: 
• Change Block Location 
• Change Slide Location 
• Change Specimen Location 
• Change Technical Billing Location 
• Change Professional Billing Location 
• Assign Letters 
• Force Release of Held Cases 
• Change Original Screener ID (unsigned cases only) 

Once you have selected the action you wish to perform, you may search the available cases by 
multiple criteria, including accession groups and sequences, case types, sources, diagnosis codes, 
pathologists, requesting doctors, and diagnosis categories. To search by multiple options in the same 
criteria, simply select those options in the fields that will become available once you choose to 
search by a criterion. At the bottom of the search window, an option that allows you to define rules 
to sort your results by appears. Once you have entered the appropriate information, click Find. 
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Change Block Location 

The Change Block Location option allows you to enter a new storage location for blocks that meet 
your search criteria. Matching search criteria is displayed on the Block Location tab (Figure 7-47).  

 
Figure 7-47. Material/Letter Management Worklist Window – Block Location Tab 

Mark/Unmark All 
Click this button to select/deselect all of the cases in your list. 

Mark/Unmark Selected 
Click this button to select/deselect the highlighted case in the list. 

New Storage 

Enter a new storage location code for the selected cases or blocks or click the  button to 
select from the dynamic list.  

Apply 
Click this button to apply your new storage location choice to the selected cases/blocks. 

Save 
Select this button to save your changes. 
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Blocks 
Click the Blocks button to open the Blocks tab (Figure 7-47) for the highlighted case. This  
list displays the blocks contained within that case and can be used to select blocks rather 
than whole cases. 

 
Figure 7-48. Material/Letter Management Worklist Window – Block List Tab 

Cancel 
Click this button to return to the Main Menu. 
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Change Slide Location 

The Change Slide Location option allows you to enter a new storage location for slides that meet 
your search criteria. Matching search criteria is displayed on the Slides Location tab (Figure 7-49). 

 
Figure 7-49. Material/Letter Management Worklist Window – Slides Location Tab 

Mark/Unmark All 
Click this button to select/deselect all of the cases in your list. 

Mark/Unmark Selected 
Click this button to select/deselect the highlighted case in the list. 

New Storage 

Enter a new storage location code for the selected cases or slides or click the  button to 
select from the dynamic list.  

Apply 
Click this button to apply your new storage location choice to selected cases/slides. 

Save 
Select this button to save your changes. 
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Slides  
Click the Slides button to open the Slides tab for the highlighted case. This list displays the 
slides contained within that case and can be used to select slides rather than whole cases. 
NOTE: Up to 2 stains can be displayed in the Stains/Restains column. When two stains 

are exceeded, an ellipses (…) is displayed; hover the cursor over the field and a 
list of all slides is displayed.   

 
Figure 7-50. Material/Letter Management Worklist Window – Slides List Tab 

Cancel 
Click this button to return to the Main Menu. 
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Change Specimen Location 

The Change Specimen Location option allows you to enter a new storage location for specimens 
that met your search criteria. Matching search criteria is displayed on the Slides Location tab 
(Figure 7-51). 
NOTE: Only specimens that have exceeded the time limit specified in the Source Setup file will 

be shown in your search results. See Chapter 6.1 – Setup: Setup Files for more 
information about this file. 

 
Figure 7-51. Material/Letter Management Worklist Window – Specimen Location Tab 

Mark/Unmark All 
Click this button to select/deselect all of the cases in your list. 

Mark/Unmark Selected 
Click this button to select/deselect the highlighted case in the list. 

New Storage 

Enter a new storage location code for the selected cases or slides or click the  button to 
select from the dynamic list. 

Apply 
Click this button to apply your new storage location choice to the selected specimens. 

Save 
Select this button to save your changes. 

Cancel 
Click this button to return to the Main Menu. 
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Change Technical Billing Location 

The Change Technical Billing Location option allows you to enter a new technical billing location 
for cases that met your search criteria. Matching search criteria is displayed on the Technical Billing 
Location tab (Figure 7-52). 

 
Figure 7-52. Material/Letter Management Worklist Window – Technical Billing Location Tab 

Mark/Unmark All 
Click this button to select/deselect all of the cases in your list. 

Mark/Unmark Selected 
Click this button to select/deselect the highlighted case in the list. 

New Technical Billing Location 

Enter a new technical billing location code for the selected cases or click the  button to 
select from the dynamic list. 

Apply 
Click this button to apply your new billing location choice to the selected cases. 

Save 
Select this button to save your changes. 

Cancel 
Click this button to return to the Main Menu. 
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Change Professional Billing Location 

The Change Professional Billing Location option allows you to enter a new professional billing 
location for cases that met your search criteria. Matching search criteria is displayed on the 
Professional Billing Location tab (Figure 7-53). 

 
Figure 7-53. Material/Letter Management Worklist Window – Professional Billing Location 
Tab 

Mark/Unmark All 
Click this button to select/deselect all of the cases in your list. 

Mark/Unmark Selected 
Click this button to select/deselect the highlighted case in the list. 

New Professional Billing Location 

Enter a new professional billing location code for the selected cases or click the  button to 
select from the dynamic list. 

Apply 
Click this button to apply your new billing location choice to the selected cases. 

Save 
Select this button to save your changes. 

Cancel 
Click this button to return to the Main Menu. 
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Assign Letters 

The Assign Letters option allows you to change your current assignment of letters to the cases that 
met your search criteria. Matching search criteria is displayed on the Assign Letters tab (Figure 
7-54). 

 
Figure 7-54. Material/Letter Management Worklist Window – Assign Letters Tab 

Mark/Unmark All 
Click this button to select/deselect all of the cases in your list. 

Mark/Unmark Selected 
Click this button to select/deselect the highlighted case in the list. 

New Letter Assignment 

Enter a new letter code for the selected cases or click the  button to select from the 
dynamic list. 

Apply 
Click this button to apply your new letter assignment choice to the selected cases. 

Save 
Select this button to save your changes. 

Cancel 
Click this button to return to the Main Menu. 
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Force Release of Held Cases 

The Force Release of Held Cases option provides the ability to force the release of cases to the HIS, 
print server, and Query. Cases only qualify if they fall within the Hold Release time as defined on 
the Sign Out tab of Options (see Chapter 6.4 – Setup: Options). Matching search criteria is 
displayed on the Force Release tab (Figure 7-55). 

 
Figure 7-55. Material/Letter Management Worklist Window – Force Release Tab 

Mark/Unmark All 
Click this button to select/deselect all of the cases in your list. 

Mark/Unmark Selected 
Click this button to select/deselect the highlighted case in the list. 

Release Cases 
Click this button to release the selected cases in the list. 

Cancel 
Click this button to return to the Main Menu. 
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Change Original Screener ID (unsigned cases only) 

The Change Original Screener ID option allows you to change the original screener ID on an 
unsigned case or group of unsigned cases to a different screener ID. Matching search criteria is 
displayed on the Screener ID tab (Figure 7-56). 

 
Figure 7-56. Material/Letter Management Worklist Window – Screener ID Tab 

Mark/Unmark All 
Click this button to select/deselect all of the cases in your list. 

Mark/Unmark Selected 
Click this button to select/deselect the highlighted case in the list. 

New Screener ID 

Enter a new Screener ID for the selected cases or click the  button to select from the 
dynamic list. 

Apply 
Click this button to apply your new letter assignment choice to the selected cases. 

Save 
Select this button to save your changes. 

Cancel 
Click this button to return to the Main Menu.
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Interfaces Setup 

NOTE: This section originally appears in the SoftLab Version 3.19 User Manual, document ID 
LAB-G-U (Rel. 08/06/03) 

The Interfaces Setup option allows you to define and maintain the communication and operating 
parameters for interfacing not only each laboratory instrument, but for other systems (e.g., HIS, 
billing) and separate program functions (e.g., automatic downloading, posting) having a protocol 
different from the SoftLab system. 
To access this option, select [Utilities]>[Interfaces Setup] from the main menu.  The Open 
Database window displays.  Select the database you wish to open, then click OK.  The Interfaces 
Setup [Main System] window displays similar to Figure 7-57. 

 
Figure 7-57.  Select Setup Type Menu 

NOTE:  The Database path, Programs path, and No.of dirs (number of interface directories) 
fields are information fields ONLY and cannot be modified.  The number of 
interfaces defined for each type displays in the right-hand (#) column. 

Interfaces Setup Menu Options 
The following options are available for the Interfaces Setup menu.  Although the keys are similar to 
the function keys found on each individual interface screen (e.g., the Instruments Lab screen), there 
are some differences. 

Status Screen 
To access the Status option, select [Operations]>[All Interfaces]>[Status Screen] from 
the interfaces setup menu, or press ALT+F5.  The Interfaces Setup Status window displays 
similar to Figure 7-58.  This window displays the status of ALL interface programs: HIS, 
instrument's listening, autodownloading, autoprinting, etc.  If an instrument is not working, 
its name is displayed with the following message, NOT RUNNING.   
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Figure 7-58.  Status Screen 

The following data is displayed: 
START Time when the program was started. 
CPU-TIME Amount of processor time used.  If greater than 4.00, the value 

blinks. 
INSIZE Size of file (raw data). 
INLAST Time when last data was received on this instrument. 
TRSIZE Size of the trace file.  If greater than 2MB, the value blinks. 
TRLAST Time of the last transaction on this instrument. 

Start All 
To access the Start All option,  click Operations, All Interfaces [Start All], or press F6.  The 
Start All option STARTS or RESTARTS the communication with ALL of the interface 
programs.  If F6 is pressed while an instrument is running, the instrument will be 
disconnected and restarted.  FOR SCC ONLY. 

Stop All 
To access the Stop All option, click Operations, All Interfaces [Stop All] or press 
ALT+F8.  This Stops ALL communication with the interface programs.  FOR SCC USE 
ONLY. 
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Instruments Lab (Interface) 

The Instruments Lab Interface option describes the necessary fields used to set up lab instruments 
interfaces.  Upon choosing the Instruments Lab option from the Interfaces Setup menu the 
Instruments Lab Interface window displays similar to Figure 7-59. 

 
Figure 7-59.  Instruments Lab Interface Window 

Instruments Lab Interface Screen 
SCC personnel do the initial definition of the interface.  Do not modify any of the fields unless you 
are using the autoposting interface.  If you are using the autoposting interface, then you will need to 
set the following fields. 
 
Autopost 

Click the check box to insert a check mark in this field to set it to Yes.  The program than 
looks at Panic, Absurd, Delta, Abnormal flags setup.   

Panic, Absurd, Delta, Abnorm 
Select or clear the check box next to each of these fields to denote the system operation 
during manual batch and automatic posting procedures.  The posting procedure will stop and 
display a message indicating a Panic, Absurd, Delta Failure, or Abnormal result if a check 
mark is present for that flag.  The default values are: 

Checked Panic 
Checked Absurd 
Checked Delta 
Unchecked Abnormal 

The fields described below are for SCC use and should not be changed without SCC consultation. 
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ID 
Enter a unique acronym to identify this interface.  You must also enter the name of the 
interface in the Name field (e.g., TDX-FLX); so if possible, let this ID code be an 
abbreviation of the interface name (e.g., FLXR).  If two instruments of the same type are 
defined, differentiate each interface with a similar code (e.g., FLXR1, FLXR2).  Maximum 
5 alphanumeric characters. 

Instr. Name 
Displays the full or common name of the instrument.  This name is displayed in the 
Interface Selection window .  Maximum 18 alphanumeric characters. 

Idl 
The Idl is the name of the loadlist for a particular instrument.  Defined by SCC and should 
not be changed by the user.   

Lstn. Name 
Displays the name of the listening program for the instrument.  The Lstn. Name field is 
defined by SCC. 

Port Name 
The port name is the physical connection between the host computer and the instrument via a 
concentrator.  Configuration of the port is determined by SCC Hardware personnel.  

Wrkst 
Enter the name of the workstation to which the instrument is assigned.  Click the dynamic 
list button to display all workstations and select one to insert into this field.  This pre-selects 
individual tests while building the loadlist.  There are two fields for this option.  For a test to 
be added to a loadlist, the workstation code defined in the Individual Tests Setup file (see 
Chapter 2.1—Individual/Group Tests: Individual Test in the SoftLab Version 3.18 
Setup Manual) MUST match these fields. Fixed code. 
NOTE: If the Wrkst field is blank, the workstation is NOT checked.  If a loadlist is 

not produced, the workstation ID may not be correct. 
Templ 

Enter the code of the worksheet template the system will bridge to from the interface (\ 
Worklist key in the RESULTS menu, edit screen).  Fixed code. 

Instr. Type 
Depending on the instrument, the entry in this field describes the way the listening program 
functions.  Some of the common types of instruments are defined as the following:   

Chemistry 
Hematology 
Batch Assay 

The Instrument Type is set by SCC. 
Active 

Displays Y if this instrument is currently being used in the system, or displays N if it is not 
currently being used in the system. 
Another code, I, may display.  This is a special code for SCC use only. 
DO NOT CHANGE any of these codes. 

Not on Menu 
Click the check box to insert a check mark in this field to suppress displaying of instrument 
on the interface menu. 
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Help Label: HI 
SCC restricted.  DO NOT CHANGE. 

Instr.Charact. 
This field provides information that describes the mode by which the instrument operates.  
The most common modes include the following: 

Query 
Unidirectional 
Instrument Worklist  

Dir. Lstn. 
Displays the directory where the listening program is located. 

Translat Table 
A list of tests that are run by a given instrument. Each table entry contains the SoftLab test 
code, the corresponding test symbol recognized by the instrument, and (optionally) an 
extension or filter. 

Autod 
From the drop-down list, select settings that are Instrument dependent. Select “Y” to denote 
Yes to all, which downloads all information/orders directly to the loadlist. 

Overwrite Res  
Click the check box to insert a check mark in this field to turn the overwrite res on.  The 
system will overwrite posted results with new results.   

OR 
Leave unchecked to leave the overwrite res off.  The system will not overwrite results 
already verified.  If two sets of results are available, only the first set transmitted will be 
posted.   

Ldl Def 
Defines the default values for loadlist option. 

Ldl Type 
The options in this field control the way order and tests displays in a particular instrument’s 
loadlist.  Click the drop-down list button to select one of the options.  Some of the options 
available are described below: 

Sequence + Request Displays tests according to their assigned sequence 
number, order number, tests for each order, and the 
status of each test in a particular order. 

Batched Assay Displays an individual test, number of orders 
associated with the individual test and the order 
numbers for the test. 

Cup and Tray Shows the order number, cup and tray position, 
number of tests for the order number, and the date 
and time of the loadlist entry and the test for the 
order. 

B.A. doing sev. Tst. Displays several individual tests, the number of 
orders associated with the individual tests, and the 
order numbers for the tests. 

No loadlist   No loadlist will display 
Res.Dbase 

Enter the Results Database file name, which is where the results are stored for each day.  
This entry is viewable in the file path of the daily results. 
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Ldl Dbase 
Enter the pathway to the Loadlist Database file, which contains all loadlist entries for the 
day. 

Trace File 
Enter the pathway to the Trace file, which contains the daily trace. 

Chapters 
Enter a list of chapters to be used for the STAT report program.  This field is only used with 
old analyzers. 

Dir.Name 
Enter the pathway to the daily files, which is main directory for the instrument in which all 
of the daily files are kept. 

Inst.Dep1  
Instrument-dependent field.   
NOTE:  Do not change this field.  This field is normally blank, but can be used for multiple 

purposes.  It may control how results are stored, including whether all tests 
from the same order are stored together, communication modes, storage of 
test codes, and to define instrument software version. 

Max Seq R 
Enter the maximum number of results to be accepted by the interface.  Use caution when 
editing this field.  Entries should be slightly greater than the daily workload for the 
instrument.  SCC sets the number to 9999 when an instrument is installed.  If the number of 
requests sent to an analyzer in one day exceeds the number in this field , the additional 
records will not be stored. 

Mes.Len. 
If results are transmitted through the interface in free-text form, then SCC can define up to 
60 lines to place the text.  This field is generally used for the Reference Lab Interface.  
Consult SCC prior to entering any data in this field.  Click the dynamic list button to enter a 
character. 

QC Separ 
Define a separator, usually a dash (-), which will define where extension information will be 
stripped when posting a result to SoftLabQC 
NOTE:  This field is disabled if nothing is entered, and is only used when the “Q” column is 

not used within the translation table. 
Inst.Dep2 

Enter terminal ID that is located in workstation area that will display messages.  For 
windows application enter “gui_XXX” into the field, where XXX is the terminal ID of the 
terminal ID of the terminal where the messages are displayed. 

Max# Seqs 
Enter the maximum sequence number of orders allowed in the loadlist (used for Sequence 
and Request analyzers).  SCC sets this to 9999 when an interface is installed. It is suggested 
that you set this number close to the maximum number of orders received by this analyzer 
within a given time frame, including repeat testing.  This time frame is given in the 
Hosparam numauto, which tells the system how often to clean the loadlist automatically 
when run by crotab.  The system will automatically restart the numbering of the sequence 
number, starting at 0001m when the system sees that 75% of the maximum has been 
reached. 
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Max# Trays 
Enter the maximum number of trays assigned to the instrument.  This is used for cup and 
tray analyzers.  Rarely used with newer analyzers. 

Max# Cups 
Enter the maximum number of cups assigned to any given tray. 

Tracing Level 
Numeric entries determine how detailed the trace file will record.  The higher the number, 
the more detailed the trace.  When choosing a trace level, consider the following:   
• Some instruments transfer great amounts of data during the day. 
• The more data that is stored, the larger the file is.  This could cause the interface to 

shutdown. 
Please call your SCC representative to help you choose a trace level. 

Creat Modif Date 
This field is not available for data entry. 

Env 
This field is set for multisite clients when the interface should only be started on a particular 
environment/site. This setting causes the instrument to only restart on this environment at the 
normal midnight restart. 

Port Characteristic   
Defined by SCC. 

Instruments Lab Interface Function Key Descriptions 
ALT+Right Arrow 

Allows you to scroll/page forward. 
ALT+Left Arrow 

Allows you to scroll/page backward 

Flags Tab 
To access the Flags option click the Flags tab located at the bottom of the screen.  The flags 
setup window displays similar to Figure 7-60 and Figure 7-61.  Click on the check box to 
insert a checkmark for YES to define the operational functions of the interface, or leave 
unchecked for no if flags are not used to define the operational functions of the interface.  
NOTE: By default, all flags are unchecked for no.  Caution must be used when 

changing the defaults. 
Flags 1-15 are Loadlist and Results Flags.  Flags 16-33 are Instrument Dependent and 
Miscellaneous flags. 
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Figure 7-60.  Flags Setup Window 

Flags 34-39 are Automatic Posting Flags. 

 
Figure 7-61.  Flags Setup Window  
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Loadlist Flags 
DO NOT CHANGE any of the flags except Flag 4 without contacting SCC customer 
support.  Unassisted changes could cause problems with instrument/SCC 
communications. 
0 Build the loadlist with filter & profile checking? 

Click the check box to insert a check mark in this field if you want a 
window to appear when building the loadlist that allows you to enter a filter 
that is defined in the translation table. 

OR 
Leave unchecked if you do not want a window to appear. 

1 Get the stat specimen first in the loadlist? (Instrument Dependent) 
Click the check box to insert a check mark in this field if you want the Stat 
specimens to appear first on the loadlist. 

OR 
Leave unchecked if you do not want the Stat specimens to appear first on 
the loadlist. 
NOTE: It does not work with autodownloading. 

2 Check collection of specimen when building the ldl? 
Click the check box to insert a check mark in this field if you only want 
specimens flagged as collected/received to appear on the loadlist when the 
building loadlist manually. 

OR 
Leave unchecked if autodownloading is being used.  This flag MUST be 
defined as unchecked (all specimens). 

3 Download requests marked as SENT? (Instrument Dependent) 
Click the check box to insert a check mark in this field if you want the 
loadlist records with requests marked as sent to be downloaded to the 
instrument. 

OR 
Leave unchecked if you want the loadlist records flagged as original or 
being sent. 

4 Protect order field in edit screen? 
Click the check box to insert a check mark in this field if you want to protect 
the loadlist and result records from being edited.  

OR 
Leave unchecked if you do not want to protect the loadlist and records from 
being edited. 

5 Read patient data while building the ldl.?  
Click the check box to insert a check mark in this field if you want to 
transmit patient demographics to the instrument. 

  OR 
Leave unchecked if you do not want to transmit patient demographics. 
NOTE: This flag is instrument-dependent and should only be 

CHECKED if the instrument allows you to download 
demographics.  
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6 Download long order? 
Click the check box to insert a check mark in this field if you want to 
download the full SCC order number. 

OR 
Leave unchecked if you do not want to download. 
NOTE: When downloading requests, some instruments cannot 

accommodate the full length of the SCC order number (e.g., 
17040001).  If this flag is unchecked for no, the order number 
without the first two digits will be downloaded (e.g., 040001). 

7 Do not check workstation when building the ldl? (For multisite clients 
only) 
Disable filter when creating loadlist.  

Results Flags 
8  Check collection of specimen while posting? 

Click the check box to insert a check mark in this field if you want to verify 
that the specimen is flagged as collected when posting results.  A message 
will identify any specimen not flagged as collected, but results can be still 
posted. 

OR 
Leave unchecked if you do not want to verify the specimen.  The system 
will post results without verifying if the specimen is flagged as collected. 
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9  Ask if verify results while posting? 
Click the check box to insert a check mark in this field if you want the 
option of verifying the results when posting results.  The prompt: Do you 
want to verify result? Yes/No will display before posting each result. 

OR 
Leave unchecked if you do not want the option.  The prompt is not 
displayed and verification depends on Flag 10 (Post results without 
verification?). 
NOTE: If you answer Yes to the prompt, the result is flagged as 

Verified in the patient and results databases.  If you answer No 
to the prompt, the result is not verified in the patient database 
and is marked as P in the results database. 

10 Post results without verification? 
Used only if Flag 9 (Ask if verify results while posting?) is unchecked for 
no.  Click the check box to insert a check mark in this field if you want to 
post the results without verification. 

OR 
Leave unchecked if you want to verify the results. 

11  Do not post absurd result? 
Click the check box to insert a check mark in this field if you want to skip 
posting of results with absurd values. 

OR 
Leave unchecked if you do not want to skip posting. 
NOTE: ` 

12  Sort results in edit by template? 
Click the check box to insert a check mark in this field if you want to sort 
results in the order of the worksheet template instead of the order 
transmitted by the instrument. 

OR 
Leave unchecked if you do not want to sort the results in the order of the 
worksheet template. Results are displayed in the order the instrument 
transmits. 
NOTE: If checked, the following occurs during result editing: The 

system first searches for a template ID that matches the 
instrument ID field entered in the Instruments Lab Interface 
window.  If this template is found, the results are sorted to 
match this template. 

 If the system cannot find a template ID matching the 
instrument ID field, it then searches for a template ID that 
matches the code entered in the Templ field.  When this 
template is found, the results are sorted as defined by the 
template.   
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13  Automatically cancel reruns after posting? 
Click the check box to insert a check mark in this field if you want the 
system to automatically cancel all remaining test reruns once one order has 
been posted. 

OR 
Leave unchecked if manual cancellation of reruns is required. 

14  Stop posting procedure if rerun? 
Click the check box to insert a check mark in this field if you want the 
posting procedure to stop when the system encounters a rerun. 

OR 
Leave unchecked if you do not want the system to stop. 

15  Stop posting procedure if QC violation? (Only applies to manual 
posting) 
Click the check box to insert a check mark in this field if you want the 
posting procedure to stop and to display a message when a QC result fails 
the rule defined.   

OR 
Leave unchecked if you want the posting procedure uninterrupted.  

Instrument Dependent Flags 
DO NOT CHANGE the following flags without contacting SCC customer support.  
Unassisted changes could cause problems with instrument/SCC communications.   
16  Ignore checksum failed? 
17  Suspend sending messages? 
18  Omit sending checksum character? 
19 Do not automatically expand order number?  

Miscellaneous Flags 
DO NOT CHANGE the next four flags without contacting SCC customer support.  
Unassisted changes could cause problems with instrument/SCC communications. 
20  Do not download single ord# after loadlist build? 

This flag answers the question, Do you want to suppress from downloading 
requests to the instrument, either when in build option/manual loadlist or 
when using the autodownloading feature?  The type of instrument in use 
governs the flag setting.  Any non-querying instrument (e.g., EKTA) should 
be set to unchecked, whereas the querying-capable instruments (e.g., Hitachi 
747 and CX7) need to be checked for yes. 
Click the check box to insert a check mark in this field if you want to 
suppress downloading of a single order number when building the loadlist 
(manual or autodownloading).  

OR 
Leave unchecked if you want to download a single order/orders. 
NOTE: If unchecked for no when in the build/manual scanning, the 

order is downloaded after each scan. 
21  Wait for response when doing single download? 

This flag is valid only if Flag 20 (Do not download single ord# after loadlist 
build?) is unchecked for no. 
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Click the check box to insert a check mark in this field if you want to wait 
for a response when doing a single download.  After each scanned order, the 
user will receive a message if the download was not successful (e.g., 
instrument busy, not ready, or communication error). 

OR 
Leave unchecked if you do not want to wait for the instrument's response 
after each scanned order number.  This option speeds up the manual 
building of a loadlist.  After the loadlist is built, make sure that all order 
numbers were successfully downloaded to the instrument. 

22  Check tty when autodownloading? 
This flag is instrument dependent.  The user now has the ability to indicate 
how autodownloading is to be accomplished based on the terminal tty.   
Click the check box to insert a check mark in this field if you want the 
system to look at the tty defined in the Inst.Dep2 field of the Instruments 
Lab Interface window.  If a tty is defined, the test request must have been 
ordered using this terminal.  If not, the autodownloading program will not 
download this request to the instrument loadlist.  A laboratory that must 
restrict autodownloading to a specific terminal/department (e.g., Respiratory 
Therapy) normally uses this option. 

OR 
Leave unchecked if you want the system to automatically download the 
order to this instrument regardless of the tty used during Order Entry. 

23  Use instrument's sequence number in results? 
Click the check box to insert a check mark in this field if you do not want 
the listening program to generate the sequence number.  The listening 
program does not generate the sequence number but stores the number sent 
by the instrument.  Used when the sequence number is used to match 
loadlist (Clinitek) or to store tray and cup information (Array, Astra, CX3). 

OR 
Leave unchecked if you want the sequence number automatically generated 
by the listening program.  Sequence numbers start with 001 for the first 
result received after 00:00 midnight and increments by 1 with each next 
result received.  The sequence number format (01, 001, 0001, etc.) depends 
on the Max Seq R field in the Instruments Lab Interface screen (Figure 
8210-1).  The default format is 3-digits long where Max Seq R = blank or 
999 (e.g., 001).  If Max Seq R = 99, the format will be 2-digits long (e.g., 
01).  If Max Seq R = 99999, the format will be 5-digit long (e.g., 00001).  

24  Go to Order Entry Add option automatically? 
This flag is used to restrict users from accessing different parts of the 
system. 
Click the check box to insert a check mark in this field if you want the 
system to automatically bridge to the Order Entry option.  Upon 
completion of order entry, the system will automatically return to the 
Interface menu. 

OR 
Leave unchecked if you want the user to manually bridge to Order Entry or 
access the order entry option from the Main Menu. 
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25 Set verification date as run date during posting? 
Click the check box to insert a check mark in this field to set the verification 
date in the SoftLab database to the date and time of posting.  

OR 
Leave unchecked to set the verification date in the SoftLab database to the 
date and time the result was received from the instrument. 

26  Adjust results according to the rules in transl.tbl? 
Click the check box to insert a check mark in this field to adjust the results 
according to the rules defined in the Tests Translation Table (trnt) and Error 
Translation Table (errt).   

OR 
Leave unchecked to save the results as sent by instrument. 

27  Go to Look option automatically? 
Click the check box to insert a check mark in this field to advance the cursor 
to the RESULTS menu, Look option.  

OR 
Leave unchecked to position the cursor on the RESULTS menu, Open 
option.  

28  Disable posting results if specimen is not collected? 
Click the check box to insert a check mark in this field if you do not want 
post results if the specimen is not flagged as C (Collected). 

OR 
Leave unchecked if you want to post results even if the specimen is not 
flagged as C (Collected).  

29  Display warning while manual posting if rerun,abnorm 
Click the check box to insert a check mark in this field to display a warning 
during manual posting if a rerun or abnormal result is encountered.  

OR 
Leave unchecked if you do not want to display a warning during manual 
posting if a rerun or abnormal result is encountered. 

30  Do not store results of tests not present in trn.tbl 
Click the check box to insert a check mark in this field to store the results of 
the tests if the tests are not present in the translation table. 

OR 
Leave unchecked if you do not want to store the results of tests that are not 
present in the translation table. 

31  Add group tests when building loadlist?  
This flag is instrument-dependent.  
Click the check box to insert a check mark in this field to download the 
group test code. 

OR 
Leave unchecked to not download the group test.  

32  Protect all fields in edit screen? 
You cannot edit result records after they come across the interface. 
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33  Translate alphanumeric order number? 
Click the check box to insert a check mark in this field to translate 
alphanumeric order number to numeric for instruments that require numeric 
orders. 

Automatic Posting Flags 
34  Post results without verification if any abnormal? 

Click the check box to insert a check mark in this field if you want to post 
results, if any abnormal, without verification. 

OR 
Leave unchecked if you want to verify results. 

35 Post results without verification if any absurd? 
Click the check box to insert a check mark in this field if you want to post 
results, if any absurd, without verification. 

OR 
Leave unchecked if you want to verify results.  

36  Post results without verification if any delta? 
Click the check box to insert a check mark in this field if you want to post 
results, if any delta, without verification. 

OR 
Leave unchecked if you want to verify results. 

37  Post results without verification if any panic? 
Click on the check box to insert a check mark in this field for Yes if you 
want to post results, if any panic, without verification. 

OR 
Leave unchecked for No if you want to verify results. 

38  Post results without verification if any reflex? 
Click the check box to insert a check mark in this field if you want to post 
results, if any reflex, without verification. 

OR 
Leave unchecked if you want to verify results. 

39  Post results if reflex test is required? 
Click the check box to insert a check mark in this field if you want to post 
results when reflex test is required. 

OR 
Leave unchecked if you do not want to post results. 

40 Write multi free text? 
Select the check box to store all information received, even if it is identical 
to previously receivedlines, is added. 

41 Do not automatically expand order 3 on upload? 
Select the check box to prevent a number, sent from an analyzer in the order 
number field, fromexpanding. A common function within Soft will adjust 
the order numbers to the correct format adding month or month and day 
formatting-when shortened form of the order number is sent from an 
analyzer. 
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42 User instrument’s workstation for QC posting? 
Select the check box if you want the Instruments specific workstation to be 
used to post QC values. 

43 Overwrite all free text? 
Select the check box if you are interfacing with a Reference Lab that send 
results with many free text comments. When checked, the option to 
overwrite the information already posted from an interface with the new 
information is available. This flag works in conjunction with the Overwrite 
field in Interface setup record. 

44 POCT 
Select the check box for Point of Care interfaces-(this is set when the setup 
script is run). It will change the appearance of the screen in the Interface 
menu.  Logically it changes Autodownloading and AutoPosting 
programming. 

45 Use auxiliary number as sample id? 
Select the check box to enable the use of auxiliary order number with the 
generic ASTM interface program. This flag/funtion was developed 
specifically for Radiance Interface. 

46 Stop posting automatically if error flag is set? 
Select the check box to stop posting based on the Error Translation Table. 
Autoposting: any error with ‘^” will stop posting and cause question of 
“continue or skip” to appear. 

47 Ignore site restriction (HOSP: int_site_restriction)? 
Select the check box to utilize this hosparam in restricting users from 
posting orders if the order was placed from a site the user does not have 
access to. If this flag is checked, the Hosparam is disregarded for any user. 

48 Autoposting/Autoverification by test? 
Select the check box and Autoposting/verification will occur at the test 
level. Each test will be evaluated by the autoposting/autoverification criteria 
for the instrument and posted and verified accordingly. 

49 Partial Autoposting/Autoverification? 
Select the check box to control the use of automatic partial posting and 
verification. When checked, any tests setup with an “N” in the “P” column 
of the Instrument Translation Table column will NOT autoverify, regardless 
of any of the other autposting/autoverification criteria set up for this 
instrument. If unchecked, Autoposting/Autoverification will not look at the 
“P” posting column of the translation table. 

50 Disable posting results if specimen is not received? 
Select the check box and unreceived samples will not be able to be posted 
from the instrument. If unchecked, unreceived samples will be posed from 
the instrument in whatever manner has been setup for the instrument. 

51 Partial posting by results workstation (need 48) 
Select the check box and you will control stopping the posting and 
verification of all tests performed on the same resulting/performing 
workstation based on criteria check failure of one or more tests on the same 
instrument. This flag is only used with multi-instrument records (e.g., 
multiple instruments using a data manager). 
NOTE: In order to set flag 51 to “Y”, Flag 48 must be set to “Y” 
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52 Foreign labels? 
Select the check box and the instrument will be configured to read labels not 
produced from SoftLab. 

53 Enable audible alarm? 
Select the check box to allow this instrument to use alarm that is sounded 
through the computer speakers. 

Translation Table Tab 
To access the Translation Table click the Translation Table tab located at the bottom of the 
screen.  The information required for this table is derived from the instrument manufacturer's 
interface specifications.  The translation table is used: 
• To translate the tests ordered in SoftLab into codes understood by the instrument and to 

convert the instrument test codes with results into codes understood by SoftLab. 
• To qualify tests to be added to the loadlist.  When building the loadlist, only tests from 

the translation table are qualified and added to the loadlist. 
• To provide an interpretation of which SoftLab test code to use when more than one 

exists for the instrument test code. 
The translation table format will vary depending on the Translation Table type chosen.  
Figure 7-62 displays a Sample Translation Table. 

 
Figure 7-62.  Sample Translation Table  

The following is a brief description of the fields that appear on the Translation Table: 
Add Button  

The Add button enables you to add an additional instrument to the Translation 
Table. 

Delete Button  
The Delete button enables you to delete an instrument from the translation table. 

Search Button  
The Search button enables you to search for an instrument code, a system code, or a 
description. Click the Search button to display the Find Entry window. Click the 
dropdown arrow to make a selection and then enter your search criteria and click 
Find Next. 

Check Button  
The Check button enables you to check the translation table for any apparent errors 
in the table. The main checks performed within this table are for entries 
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Instrument 
This field contains the test code as defined in the instrument specifications. 

System 
This is the SoftLab test code for the same test.  SoftLab may have more than one test 
code for the same analyte on the instrument (e.g., GENT). 

Ext 
This field represents the extension for the order#/suffix.  Extension zero should be 
entered as 00.  Extension one should be entered as 01, etc. 
This is the same as the bar code suffix defined in the Specimen Tube Type Setup 
file (see Chapter 1.1—Basic Setup: Specimen Tube Types in the SoftLab 
Version 3.18 Setup Manual). 

Flt 
This is the fluid type defined in the instrument specifications.  Common types are 
numeric codes or: 

SE Serum 
SF Spinal fluid 
UR Urine 
TL Timed urine 
PL Plasma 

Depending on instrument type, a filter may be required along with instrument ID.  
SCC personnel will advise you if this is necessary. 

Description 
The individual SoftLab test name will automatically appear when the test code is 
entered. 
This field may also be used to define rules to automatically change the instrument 
result to an interpreted result: 

Set Flag #26 ("Adjust results according to the rules in the transl. tbl" to Y). 
In the translation table of this instrument, define one or more additional entries 

with the same instrument test code, but preceded by the special character "|".  
Leave the system test code, extension and suffix fields blank. 

For each of these entries, enter a rule in the blank description field.  Rule syntax 
is as follows: 

  <rule>:   <expression> <new value> 
  <expression>:  <operator><value> 

 <operator><value>&<operator><value> 
     <operator><value>|<operator><value> 
  <operator>:  > 
     < 
     >= 
     <= 
     == 
     = 
  <value>:  string 
  <new value>:  string 
     CANCEL 
Examples: 
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For the test HBCM, values less than 0.8 should be replaced by the word 
NEGATIVE, values greater than 1.2 by the word POSITIVE, and values 
between 0.8 and 1.2 reported as GRZ (gray zone), the translation table will 
look like: 

Instrument System  Description 

HBCM HBC HBCM test 

|HBCM  <.8 NEGATIVE 

|HCBM  >1.2 POSITIVE 

|HCBM  >=.8&<=1.2 GRZ 

For the test XYZ, values +++ should be replaced by 3+, ++ by 2+, and + by 
1+.  The translation table will look like: 

Instrument System  Description 

XYZ XXYZ xxyz test description 

|XYZ  =+++ 3+ 

|XYZ  =++ 2+ 

|XYZ  =+ 1+ 

For the test ABC values greater than 100.00 should cause automatic 
cancellation of this test (setting flag C without changing result value): 

Instrument System  Description 

ABC AABC aabc test description 

|ABC  >100 CANCEL 

P 
Answer the question, Post this result with the rest?  If set to N, the test will not post 
when all the other tests are posted.  It must be posted individually.  This is used for a 
partial posting. 

Q 
Answer the question, QC result goes here?  A Y (Yes) in this field directs the 
interface program to assign the result of quality control to this test when multiple 
SoftLab codes exist for the same instrument code. 

D 
Answer the question, Download?  Some instruments cannot process tests that are 
only calculations if they are downloaded.  An N (No) in this field will keep the test 
from being downloaded.  A blank field means, if asked, download the test to the 
instrument. 
NOTE: The interface program to convert SoftLab orders into tests understood 

by the instrument uses The Instrument, Flt, and D fields.  The interface 
program to convert results from the instrument into tests SoftLab 
can understand uses the System, Ext., Q, and P fields. 

To define a result which is below a minimum value as '<X.X', enter '<X.X<X.X' 
(e.g., <2.0<2.0 reads for any value less than 2, report those values less than 2).  A 
vertical bar (|) must precede the instrument code.  The System, Ext., and Flt. fields 
are left blank.   
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Error Translation Table Tab  
To access the Error Translation Table click on the Error Translation Table tab located at the 
bottom of the screen.  The information required for this table is derived from the instrument 
manufacturer's  interface specifications.  Many instruments generate error codes to alert the 
operator of possible abnormal results.  Some instruments are capable of transmitting these 
codes to a host computer, others are not.  If the instrument is capable of transmitting these 
codes, the interface program stores them in the results record.   
An exclamation mark (!) must be entered at the beginning of the Description field for 
automatic cancellation.  When an exclamation point (!) is the first character of the 
Description field in the Error Translation Table, this error, when sent by the instrument, will 
cause the automatic cancellation of the given result (flag C Canceled in the Interface Results 
Menu/Edit screen).  If a character (e.g., a) has multiple meanings, depending upon the 
position of the character, a wild card (*) cannot be used. 
Figure 7-63 displays a Sample Error Translation Table. 

 
Figure 7-63.  Sample Error Translation Table  

The following is a brief description of the fields that appear on the Error Translation Table: 
Add Button  

The Add button enables you to add additional entries to define how errors sent by 
the instrument to the LIS should be handled. 

Delete Button  
The Delete button enables you to delete entries that were defined for how errors 
were sent by the instrument to the LIS. 

Pos 
An asterisk (*) wild card in any position; error shows up in the Interface. 

Err 
User code, instrument interface recognizes error code translation table. 

Act 
Enter the action in this field that should be performed when this error (shown in the 
field) is received. 

Description 
Enter an instrument error code description. 



SoftPath GUI v.4.2.1 User Manual Chapter 7.8.1—Utility:  Interfaces Setup Instruments  

PATH4.2-G-U (6th Ed, Rel. 01/31/07)  Page 7-71  

This field may also be used to define an action that can be taken by the listening 
program when certain error codes are received from the instrument.  When an error 
code is received for a given test, the listening program is able to: 

Automatically cancel this test (set flag C). 
Replace received result by predefined value. 
Set an internal flag that will cause batch-posting procedure to stop at this result. 

In order for each action to be taken, a special character should be entered at the 
beginning of the description field of the error translation table for the given error 
code.  These characters are: 

! Exclamation point for automatic cancellation. 
| Vertical bar for value change. 
^ Caret for batch posting stopping. 

NOTE: These characters are independent of each other and may appear in any 
order. 

Start Interface 

 
Click the Start Interface button, or click Operations [Start Interface], or 
press ALT+F10.  Starts OR RESTARTS the communication for that one 
interface program.  USE WITH CAUTION! 

Stop Interface 

 
Click the Stop Interface button, or click Operations [Stop Interface], or 
press F8.  Stops communication with that one interface program. A 
confirmation message will appear with the PID number that was stopped.  

Trace 

 
Click the Trace button, or click View [Trace], or press F9.  The Trace 
option allows you to view a trace file on the instrument's transactions. 

Trace Tail  

 
Click the Trace Tail button, or click View [Trace Tail], or press 
CTRL+F9.  The Trace Tail option is used for troubleshooting.  An active 
trace file that allows checking if tests are being downloaded and if 
communication exists between host and instruments. 

Installation Notes 

 
Click the Installation Notes button, or click View [Installation Notes], or 
press CTRL+I.  Installation notes for hardware personnel. 

Status 

 
Click the Status button, or click View [Status], or press CTRL+U.  Checks 
to see if instrument is running. 

Autoposting Summary Tab 
Click the Autopost Summary tab to access the Automatic Posting Setup Summary, similar 
to Figure 7-64.   
NOTE: You cannot enter data in this window. 
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Figure 7-64.  Automatic Posting Setup Summary 
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HIS Order Entry Posting 

The HIS Order Entry Posting interface is a program that processes transactions from the HIS and 
posts to the SCC database.  The ROE server for Recurring Order Entry is frequently coupled with the 
HIS Order Entry Posting interface.  If you purchased ROE this is where you would find the ROE 
server setup. 
To access the HIS Order Entry Posting option from the Interface Setup menu, click HIS Order 
Entry Posting, than double-click on the one you wish to view.  The HIS.  The HIS Order Entry 
Posting window displays similar to Figure 7-65. 

 
Figure 7-65.  Main Menu-Interface-Setup, HIS Order Entry Posting 

HIS Order Entry Posting Screen 
With the HIS Order Entry Posting window displayed, enter data in each applicable field.  For 
common field descriptions, see Introduction: Common: Fields.  All other fields are described 
below. 
ID 

SCC will enter interface ID code. 
Name 

The name of the interface will be automatically entered in this field.  This field is NOT 
available for data entry.   

Active 
Click the drop-down list button to select Y if this instrument is currently being used in the 
system.  Select N (no) if this instrument is not currently being used in the system. 
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NOTE: Another code, I, may display.  This is a special code for SCC use only.  DO 
NOT CHANGE any of these codes. 

Stat time limit 
This field is currently not in use. 

Label printer no 
This field is currently not in use. 

Collection time low-high 
This field is currently not in use. 

Label wait__ min 
Enter the time to wait to automatically print labels through the interface.  Default = 1 min.;0 
= print labels immediately. 

Printer for error log 
This field is currently not in use. 

Purge day 
SCC exclusive.  The number of days that are stored in a temporary database that have been 
posted by the HIS. 

Config file 
SCC usage only. 

TB Ord Coll ___ min 
If the difference between a TIMED order and to be collected for ROUTINE specimens is 
greater than this parameter, then the priority for a ROUTINE specimen becomes TIMED. 

Default environment 
For Multisite only.  This is a default environment if the system cannot determine the testing 
environment that is found under Test Setup (Individual Test and Group Test). Defaults to 0. 

Flags Tab 
Click the Flags tab to view the defined flags for this option.   
Click the check box if the flag(s) is used to define the operational functions of the interface. 

OR 
Leave unchecked if the flag(s) is not used to define the operational functions of the interface. 

SCC Exclusive Parameters Tab 
Click the SCC Exclusive Parameters tab to access the SCC exclusive parameters window. 
Program Directory 

Enter the name of the directory for the posting program.  Maximum 13 
alphanumeric characters. 

Program Name 
Enter the name of the posting program.  Maximum 13 alphanumeric characters. 

Trace Directory 
SCC defined. 

Trace File 
The Trace File is the name given to the file that contains the daily trace. 
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Maximum Try No 
The maximum number of times that the program will try to post to the LIS before 
resulting in an error. 

Tracing Level 
Numeric entries determine how detailed the trace file will record.  The higher the 
number, then the more detailed the trace.  When choosing a trace, consider the 
following: some instruments transfer great amounts of data during the day.  The 
more data stored, the larger the file is, which in turn can cause the interface to 
shutdown.  For help in choosing a trace file, please call your SCC representative. 

Creat./Modif. Date 
This field is NOT available for data entry. 

Timeout 
SCC exclusive.  Program waits for time defined for next batch of data for 
processing. 

Tbo back 
Default = 0 (today's date).  SoftLab does not look at orders that have been placed by 
the HIS prior to today's date. 

Tim delay 
Not in use. 

When data entry is complete, click the Save button, or click File [Save].   The following 
message displays: 

 
Figure 7-66. Interface Setup Save Changes Message 

Click Yes to save the information to the database.  The cursor returns to the menu line. 
OR 

Click No or Cancel to return to the menu line without saving the information. 

Translation Table Tab 
Click the Translation Table tab to access the Translation Table.  The Translation Table 
displays similar to Figure 7-67. 
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Figure 7-67.  Translation Table Tab 

The Translation Table is CLIENT SPECIFIC.  There are certain cases when this table is 
used for a test conversion.  Depending on the HIS, a translation table is available for adding 
additional tests when a test is ordered through the HIS.  An example may be if the HIS does 
not have the ability to order packed cells when a cross-match is ordered.  SCC will prepare 
this table, if required. 

Error Translation Table  
Click the Error Translation Table tab to access the Error Translation Table.  The Error 
Translation Table displays similar to Figure 7-68. 

 
Figure 7-68.  Error Translation Table Tab 

HIS Order Entry Posting Toolbar Options 
Start Interface  

 
Click the Start Interface button, or click Operations [Start Interface], or press 
ALT+F10 to restart the interface program. The following message displays similar to 
Figure 7-69. 
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Figure 7-69.  Start Message 

Click the OK button to continue, or click the Cancel button to cancel.  If you click OK to 
continue, the date and time of the restart displays in the Restart Action Report similar to 
Figure 7-70. 

 
Figure 7-70.  Restart Action Report 

Stop Interface 

 
Click the Stop Interface button, or click Operations [Stop Interface], or press F8 
to stop communication with the interface program.  A message similar to the one 
shown in Figure 7-71 displays. 

 
Figure 7-71.  Communication Message 

Trace 

 
Click the Trace button, or click View [Trace], or press F9.  The Trace option 
allows you to view a trace file on the instrument's transactions (see Figure 7-72). 
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Figure 7-72.  Trace File Message 

Click OK to continue, or click Cancel to exit.  If you click OK to continue the trace 
information displays. 

Trace Tail 

 
Click the Trace Tail button, or click View [Trace Tail], or press CTRL+F9.  This 
option is currently not in use. 

Installation Notes 

 
Click the Installation Notes button, or click View [Installation Notes], or press 
CTRL+I.  Installs notes that are helpful when setting up interfaces. 

Status 

 
Click the Status button, or click View [Status], or press CTRL+U.  Checks to see if 
instrument is running. 

HIS Order Entry Posting Features 
The following stand-alone modules were combined into one "oehis": 

HIS Lab and Micro order entry 
HIS BloodBank order entry 
Multisite HIS order entry 
Purging HIS database 

Monitoring events (warnings, errors, cancellations, etc.) module has been added to print out, save in 
files, or to use to run user-specified actions. 

Monitoring Classes 
OE_ERROR: Critical error (either database or AIX system error) oehis is terminated.  

Restart oehis or call SCC. 
OE_CANC: Lab or Micro cancellation requests. 
OE_REJECT: Lab and Micro rejected requests (e.g., duplicate tests, bad HIS data, etc). 
OE_NOBILL: Request for nonexistent billing numbers. 
EXAMPLE: 

An order was received for a patient who has no billing number in SoftLab.  Either 
the HIS did not send the patient billing number at registration or it sent some 
erroneous or inconsistent information.  SoftLab will try to post this patient's data for 
two days, after which, the order will be automatically purged. 

OE_PURGE: Purged request that was not processed. 
OE_ERRTST: Invalid test ordered. 
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EXAMPLE: 
A test code was received from the HIS that is not in the SoftLab file setup.  This 
usually results from an incorrect entry in a test translation table on the HIS system or 
no HIS-compatible entry in the Individual Test Secondary ID field in SoftLab.  It 
might indicate some other problem on the HIS side or an error in communications. 

OE_BBCANC: SoftBank cancellation request. 
OE_BBERR: SoftBank demographic error, posting error,.. etc. 
OE_STAT: Stat requests for SoftLab, SoftBank, and SoftMic. 
OE_BADENV: Multisite error.  Wrong environment. 

Monitoring Actions 
F-File 
P-Printing 
X-Faxing 
T-Terminal - Sending message to status line + tone  
U-Customize - User-definable (set by SCC). 

Where to Set Up 
Error Translation Table tab-Field description of order entry posting program. 

 
Figure 7-73.  Error Translation Table 

How to Activate Monitoring Class and Assign the Action 
Define the monitoring class parameters, as follows, in the Translation Error Table. 

OE_ERROR|P|PRI| (Fields Delimiter = '|') 
OE_ERROR|F|errlog| 
OE_BBERR|F|bberr| 
OE_CANC|F|labcan| 
OE_STAT|T|tty21i| 
OE_REJECT|U|usrscript| 

(fields)     1     2     3  

Field Descriptions 
1 Monitoring class ID 
2/3 Action code/respective entry 

if 2=P (printing), then 3=printer ID 
if 2=X (faxing), then 3=fax ID 
if 2=U (user defined command), then 3=command 
if 2=F (append to a file), then 3=filename suffix [e.g., oehis.suffix/default "errlog"/] 
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if 2=T  terminal, then 3=tty?? number and terminal type 
[e.g. tty21i , tty11w,     tty11v   tty21/1w 
i-ibm3151    w-wyse 370   v-vt220 PC   

There is no limit to the number of monitoring classes, different printers, and files used.  If 
the same file suffix is used, messages from different monitoring classes are added into the 
same file. 
The first line printed or saved in the file begins with: 

11/26 17:22 OE_ERR: 

To view/print the above mentioned files, use SHIFT + F2. 
Automatic faxing to SCC in case of terminating "oehis" 

How to Set Up 
Define in the Translation Error Table an OE_ERROR monitoring class with the following 
parameter: 

OE_ERROR|X|SCC  ("SCC" - Soft Computer Consultants fax ID) 

This option is available only if the VISIFAX module is installed. 

User Defined Label Printing Setup. 
Fields: 

Pos. and Err. - Two-digit printer number from /usr/lib/printerc or security.  
(Set Pos.=0 for one-digit numbers.)  Used if the printer name was not 
specified in the Description field. 

Description - Contains rules of label printing  
description <=> template[:range][ prn] 

range <=> time:time[:days] 

where: 
Template - Look at table below 
Range - Time range for label printing 
Time - Hours and minutes (four digits, e.g., 1120) 
Days - Days of week (0-6 Saturday-Sunday-Monday, empty string = all 
week) 
prn - Unique label printer name (first three characters) 
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Type Template Examples 

   Labels will be printed for ... 

by procedure ,test ,CBC 
,BGM  

CBC tests 
BGM tests 

by clinic and priority .ward +priority .ICU +S  
 
.ICU +RT 

nurse collect specimens, ICU ward 
and Stat priority 
collected specimens, ICU ward, 
Routine and Time priority 

 ^ward +priority ^ICU +SUT phlebotomy collect specimens, ICU 
ward and Stat, Urgent and Time  
priority 

 ward +priority ICU +R ICU ward and R priority tests 

by clinic ward ICU ICU ward 

by patient type ‘patient type ‘O O patient type 

by priority +priority +T 
+SU 

T priority 
S and U priority 

by department =depot =U U department if other printer was 
found 

default printer DEFAULT DEFAULT default printer if previous rules 
doesn’t match printer 

microbiology media labels .MIC .MIC  
 

Priority codes must be entered as+S,+U,+R, or+T.  The clinic code for nurse-collected 
specimens must be entered as .clinic.  If a label printer is defined for the clinic, the labels 
will be printed on that printer.  Otherwise, the printer defined for the order priority will be 
used.  If no order priority printer is defined, the default printer is used.  If a .MIC printer is 
defined, it is used for media labels; otherwise, media labels are not printed.  If the procedure 
label printer is defined, other criteria are discarded. 
 Printing the labels for weekdays and time range of the above-mentioned category. 
Description field is used: 

EXAMPLE:  0  1 +S:0700:1720 
0  2 +S:0000:0700 
0  2 +S:1720:2400 

[Print labels for STAT from 7:00 a.m. to 5:00 p.m. on printer 1, 
otherwise,  on printer 2.] 

0  1  ER:0700:1700:135 

[Print from 7:00 a.m. to 5:00 p.m. on Monday, Wednesday, and Friday] 
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New User-Modifiable Flags 

 
Figure 7-74.  Flags Tab 

NOTE: 
Flag 13 is nonfunctional for OEHIS.   
All interface flags for the ROE server remain intentionally nonfunctional. 

HIS Order Entry grouping criteria 
It is important to notice that the parameters controlling order grouping are defined in 
four different places in the LIS system (further explanation of these files come 
together with LIS documentation). 
These four flags are: 

HOSPITAL PARAMETER FILE also referred to as Hosparam file. 
TEST SETUP  
INSTRUMENT SETUP (together with the Instrument Error Translation table). 
HIS Order Entry CONFIGURATION FILE also referred to as CONFIG file. 

NOTE: Stat time limit and Routine time limit are not used. 
Generally, criteria fall under four categories, although the number of categories can 
be configured.  Criteria priority are assigned in order of appearance. 

REJECTING - Standard configuration 
Under the following circumstances, the HIS procedure is rejected: 

HIS number is duplicated (for add or cancel) - CONFIG 
Procedure cannot be ordered individually - TEST SETUP 
Procedure timer-between-order is violated - TEST SETUP 
HIS has Routine priority and exists uncollected duplicate Routine test in LIS 

with the same collection scheduled date and time - CONFIG (scheduled date 
and time is usually referred to as sweep date and time) 

HIS has Timed priority an exists uncollected duplicate Timed test in LIS with 
the collection time within time between-order - CONFIG 

Same as above but both are Stat uncollected (regardless of collection date and 
time) - CONFIG 

CANCELING - This will be customized 
All tests with specified HIS number matching will be canceled - CONFIG 
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MERGING 
Merging Together of an order placed on HIS and an existing order on LIS in the 
following instances if BOTH orders are not COLLECTED and SHARE the same 
specimens (tube types). 

A STAT placed on HIS will combine with an existing Stat in LIS if the orders 
are placed up to 20 minutes apart. 

A STAT placed on HIS will combine with an existing TIMED on LIS if the to 
be collected time of the LIS order is up to 20 minutes difference. 

A TIMED placed on HIS will combine with an existing STAT on LIS if the to 
be collected time of the TIMED is within 15 minutes of the STAT. 

A ROUTINE placed on HIS will combine with an existing STAT on LIS if the 
scheduled collection time is within 15 minutes of the STAT collection time 
(assumes current time of order is placed). 

A TIMED placed on HIS will combine with an existing ROUTINE on LIS if 
the scheduled collection time (from Hosparam) for the ROUTINE is within 
30 minutes of the to be collected time of the TIMED. 

A ROUTINE placed on HIS will combine with an existing TIMED on LIS if 
the orders placed assume a scheduled collection time (from Hosparam) 
within 30 minutes of the to be collected time of the LIS order. 

A TIMED placed on HIS will combine with an existing TIMED on LIS if the 
to be collected time of both orders are within 20 minutes. 

A ROUTINE placed on HIS will combine with an existing ROUTINE on LIS 
according to the scheduled collection time defined in Hosparams. 

NOTE: The reason we differentiate merging criteria between like and unlike 
specimens is to prevent performing additional phlebotomy on a patient. 

Merging together of an order placed on HIS and an existing order on LIS in the 
following instances if BOTH orders are NOT COLLECTED and DO NOT 
SHARE the same specimens or partially share specimens. 

A STAT placed on HIS will combine with an existing Stat on LIS if the orders 
are placed up to 10 minutes apart. 

A STAT placed on HIS will combine with an existing TIMED on LIS if the to 
be collected time on the LIS order is up to 10 minutes difference. 

A TIMED placed on HIS will combine with an existing Stat on LIS if the to be 
collected time of the TIMED is within 10 minutes of the STAT collection 
time (assumes current time order is placed).  

A ROUTINE placed on HIS will combine with an existing Stat on LIS if the 
scheduled collection time of the Routine (from Hosparam) is within 10 
minutes of the Stat collection time (assumes time order is placed). 

A TIMED placed on HIS will combine with an existing ROUTINE on LIS if 
the scheduled collection time (from Hosparam) for the routine is within 15 
minutes of the to be collected time of the Timed.  

A ROUTINE placed on HIS will combine with an existing TIMED on LIS if 
the orders placed assume a scheduled collection time (from Hosparam) 
within 15 minutes of the to be collected time of the LIS order. 

A TIMED placed on HIS will combine with an existing TIMED on LIS if the 
to be collected time of BOTH orders are within 10 minutes. 

A ROUTINE placed on HIS will combine with an existing ROUTINE on LIS 
according to the scheduled collection time defined in Hosparams. 
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Both LIS and HIS are collected or labeled and share the same specimens and 
collection times are 30 minutes apart regardless of the priority. 

Hosparam parameters still apply 
Tests with the same OE_category will not be merged (OE_category is defined 

in TEST SETUP) 
Tests can be ordered OE_days_back days back 

Collection time for different priorities is estimated as follows: 
Routine  Based on collection schedule from Hosparam (cron format) 
Timed  Is specified on the transaction from HIS 
Stat, Urgent Current date and time is assumed 

As mentioned, the above criteria are standard configuration and they come together 
with our package as a setup and configuration file.  Customizations can be 
performed according to your needs and requirements. 
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Case Utility 

The Case Utility option is used to suppress or restore a signed-out case.  Suppression of a case will 
block the case from Query, Result Reports, Specimen Request, and Specimen Processing. 
To access the Case Utility option, select Utility > Case Utility from the main menu. The Case 
Utility Search window (Figure 7-46) is displayed.  

 
Figure 7-75. Case Utility Search Window 

Enter your desired search criteria and results will display on the grid; double-click a case and it will 
display in the Case Utility window (Figure 7-75).  

 
Figure 7-76. Case Utility Window 
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Define ODBC Reports 

The Define ODBC Reports option allows you to define your own custom reports using Structured 
Query Language (SQL). You can use this option to view, design, or print existing ODBC Reports. 
When you select the Define ODBC Reports option, Microsoft Access launches. MS Access 
provides you with the tools to produce SQL scripts for database inquiry. The report formats that you 
create can be stored for later use.  
To access the Define ODBC Reports option, select Utility > Define ODBC Reports from the main 
menu. The Main Switchboard window is displayed; select the Utility option to display the Utility 
window (Figure 7-77). 

 
Figure 7-77. Utility Window 

While in this window you can select a record to edit or relink. 
A description of the data fields and function buttons are provided below. 
Choose Report 

Click the drop-down list button to display the list with all accessible report codes. Select the 
required one by clicking it. 

Edit button 
Click this button to display the Microsoft Access window with the “pathSQL: Database” 
window (Figure 7-78) where you can perform any necessary changes. 

Relink Button 
This button allows you to relink all tables to the current Pathology settings in the SIMBA 
driver. When you click Relink, the pathSQL: Database window displays in MS Access 
(Figure 7-78). 
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Figure 7-78. Microsoft Access - pathSQL: Database Window 

The pathSQL: Database window contains seven buttons located on the left side of the 
window: 

Tables Allows you to view existing tables defined in different databases or add new 
tables to the database. 

Queries Allows you to view/edit existing queries or create new queries. 
Forms Allows you to create your own forms for displaying or entering data. 
Reports Allows you to view/edit existing reports or create new ones. 
Pages Displays all the shortcuts to data access pages in the database. 
Macros Allows you to run/edit existing macros or create new macros. 
Modules Allows you to edit existing modules or create new modules. 

NOTE: When you select the Define ODBC Reports option, the system opens the 
Microsoft Access application. MS Access provides you with the tools required to 
produce an ODBC report and contains comprehensive on-line help information. 
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Screen Shot Options 

Screen Shot Sender is a utility program that allows you to capture a screen image and send it to a 
printer or e-mail it to a destination. Screen shots can be scaled to a whole page, three-quarter page, 
half page, or not scaled at all.  Once you set up the Screen Shot Sender program, you can capture the 
screen shots by pressing the Print Screen button. You can then print the screen shot to the printer 
you specified by pressing the Print button in the Screen Shot Sender dialog box. 

Opening the Screen Shot Sender Options Dialog Box 
To open the Screen Shot Sender, choose Utility> Screen Shot Options from the menu bar. The 
Screen Shot Sender Options window (Figure 7-79) is displayed. 

 
Figure 7-79. Screen Shot Sender Options Window 

Setting the Screen Shot Options 
Before capturing the image, select your destination from the Screen Shot Sender window. 
In the Destinations section of the Screen Shot Sender window, click to highlight your selection of 
where to send the screen shots: Printer or Electronic Mail (email). Click the New button. 
Depending on your choice, either the Printer Destination or Mail Destination window will appear. 
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Printer as Destination – Data Entry Instructions 
The Printer Destination window (Figure 7-80) is used to set up the designated printer, give a 
description of the screen shot, and select your Settings. 

 
Figure 7-80.  Printer Destination Window 

Printer Destination Data Entry Instructions 
Name 
Enter the name of your printer. For example, if you wanted more than one printer set up as a 
destination you might name this printer “Printer 1.” 
Screen Shot Description 
Enter the description of the screen shot you will be taking. The description can be defined at 
setup or when you are ready to take the screen shot. 
Ask 
If the Ask box is checked, the system will prompt you to add a description for the screenshot 
before it is sent to its destination. 
Description Selection  
From the drop-down list, select one of the following options:  

With General Print the general and specific description 
Only it Print the specific description 
Only General Print the general description 
No Description Do not print a description 

Settings 
Active 
The Active check box reflects the state of the destination itself. It is marked if the 
destination has a check mark in the Screen Shot Sender dialog, Destinations tree. 
Center Image 
Check this box if you want the image centered on the page. 
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Always show Print Dialog 
Check this box to display the print dialog box to appear when printing a screen shot. 

Scale 
Set the scale of the screen shot image.  You can select from: 

• Full page 
• Half page 
• Quarter page 
• No Scaling 

OK 
Click the OK button to accept changes and save the settings. 
Setup 
Click the Setup button to access the Print Setup dialog box. The Print Setup dialog box 
allows you to make changes to the setup, including changing the paper orientation, selecting 
a printer other than the default printer, and printing a number of copies, among other options. 
Cancel 

Click the Cancel button to exit the screen without saving changes. 
Printer 

Displays the location of the default printer. 

Electronic Mail as Destination – Data Entry Instructions 
The Mail Destination window (Figure 7-80) is used to set up the designated email, give a 
description of the screen shot, and select your Settings. 

 
Figure 7-81.  Mail Destination Window 

Name 
Enter the name of your e-mail destination. For example, if you wanted more than one e-mail 
account set up as a destination you might name this destination “My e-mail.” 
Screen Shot Description 
Enter the description of the screen shot you will be taking. The description can be defined at 
setup or when you are ready to take the screen shot. 
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Ask 
If the Ask box is checked, the system will prompt you to add a description for the screenshot 
before it is sent to its destination. 
Description Selection  
From the drop-down list, select one of the following options:  

With General Print the general and specific description 
Only it Print the specific description 
Only General Print the general description 
No Description Do not print a description 

Settings 
Mail Profile 

Enter the mail profile to be used. 
Active 

Mark this checkbox to activate the mail profile. 
Password 

Enter the password for the designated mail profile. 
Others 

Use Archiver 
Mark the checkbox to use Archiver. Click on the Settings button to view or 
change the Archiver settings. 

Copy Description to Subject 
Mark the checkbox so that the description is placed in the subject field of 
the mail message. 

Delete Screenshot 
Mark the checkbox to delete the screenshot. 

OK 
Click the OK button to accept changes and save the settings. 
Setup 
Click the Setup button to access the Mail Setup dialog box. The Mail Setup dialog box 
allows you to make changes to the email setup. 
Cancel 

Click the Cancel button to exit the screen without saving changes. 
Default Mail Client 

Displays the default email client. 

Capturing and Printing/Sending a Screen Shot: 
To utilize the Screen Shot Sender option, begin with the desired image on your screen and press the 
Print Screen button on your keyboard. Open the Screen Shot Sender window (Figure 7-79), and 
highlight either a desired printer or email destination. Click on the Print button to print or OK to 
send the screen shot through email. 
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Chapter 8. Work Assignment 

The Work Assignment menu (Figure 8-1) options allow you to view the cases that have been 
assigned to specific personnel, to assign new cases, to view and manage the cases that have been 
assigned to you, and more.  

 
Figure 8-1. Work Assignment Menu 
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SoftPath Work Assignment Menu Options 
The SoftPath Work Assignment option contains the following features and applications: 

Manager’s Dashboard 
The Manager’s Dashboard option allows you to you to view the cases that have been 
assigned to each personnel member, to assign unassigned cases, and to reassign cases to 
different personnel.  
See Chapter 8.1—Work Assignment: Manager’s Dashboard. 

My Workspace 
The My Workspace option allows you to view the cases that have been assigned to you, 
bridge to other SoftPath options to perform an action on the case or reassign the case to 
another employee with the same personnel type as you, and view the list of unassigned cases 
and assign these to yourself or another employee with the same personnel type.  
See Chapter 8.2—Work Assignment: My Workspace. 
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Manager’s Dashboard 

The Manager’s Dashboard option allows you to view the cases that have been assigned to each 
personnel member, assign unassigned cases, and reassign cases to different personnel. 
To access the Manager’s Dashboard option, select Work Assignment > Manager’s Dashboard 
from the main menu. The Manager’s Dashboard window (Figure 8-2) is displayed.  

 
Figure 8-2. Manager’s Dashboard Window 

By default, the menu tree on the left side of this window lists the personnel types (categories), which 
are defined in Personnel setup (see Chapter 6.1—Setup: Setup Files – Personnel File).  To view 
only one category, click the Category drop-down arrow and select the desired category from the list. 
Click the plus sign (+) next to each category to view the personnel in that category.  If a person has 
cases assigned to them, a plus sign appears before their name and the number of cases as well as the 
number of slides for those cases appears in parentheses after their name.  Click the plus sign to 
expand the level and view the case numbers.   

To the left of each personnel member’s name is a workload 
indicator that shows whether the person has a low, medium, or 
high workload, as defined by the assigned case limit and overload 
percentages defined in the Managers’ Dashboard setup (see 
Chapter 6—Setup: Options). 

 The workload indicator is green if the person’s assigned case 
limit is less than the medium overload percentage. 

 The workload indicator is yellow if the person’s assigned 
case limit is equal to or greater than the medium overload 
percentage, but less than the high overload percentage. 

 The workload indicator is red if the person’s assigned case 
limit is greater than or equal to the high overload percentage. 

 
Figure 8-3. Personnel Tree 
Showing Workload Indicators 

When a person’s name is selected, a list of their cases also appears in the lower-right section of the 
window in the Cases Assigned To grid (Figure 8-4). 
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Figure 8-4. Manager’s Dashboard Window with Cases Displayed 

The upper-right section of the Manager’s Dashboard window, or the Unassigned Cases grid, lists 
all unassigned cases. 

Unassigned Cases and Cases Assigned To Grids  
Both the Unassigned Cases and Cases Assigned To grids contain columns with the 
following information: 

Case # Displays the case number. 
Priority  Displays the case priority. 
Patient Name Displays the patient’s name. 
Age Displays the patient’s age. 
Sex Displays the patient’s sex. 

Displays if the case activity is within the turnaround time specified 
for the case type (see Chapter 6—Setup:  Options, Workspaces 
Tab, My Workspace Tab).   
The following indicators describe the case TAT activity: 

 Green clock: the activity is within the designated turnaround 
time, and is less than the medium delay 

 Yellow clock: the activity is greater than or equal to the 
medium delay, but less than the high delay. 

TAT 

 Red clock: the activity has met or exceeded the high delay. 
Activity Displays the currently pending activity (e.g. Processing, Sign Out). 
High Risk Displays if the patient has been flagged as high risk for abnormal 

results based on a previous case report. 
Case Status Displays the case milestones met. 
# Spec Displays the number of specimens in the case. 
Source Code Displays the code of the specimen source. 
Source Description Displays the description of the specimen source. 
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# Blocks Displays the number of blocks in the case. 
Ord Date Displays the date the order was entered. 
Cmpl Date Displays the date the specimen was due for completion. 
# Slides Displays the number of slides in the case. 
Req Doctor Displays the requesting doctor. 

Print List 
The Print List function allows you to print a list of cases assigned to a selected employee ID 
on the local PC printer.  
To access the Print List option, select a User and click the Print List button. The Print List 
window (Figure 8-5) is displayed.  

 
Figure 8-5. Print List Window 

First List Displays a list of all fields that are available for printing. 
Print List Displays a list of all fields that you have chosen for printing. 
Remove Button Highlight an item in the print list and click this button 

to remove it. 

Remove All Button Click this button to remove all items from the print 
list. 

Add Button Highlight an item in the first list and click this button 
to add it to the print list. 

Add All Button Click this button to add all items to the print list. 
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Up Button Click this button to arrange an item on the print list up 
one position in printing order. 

Down Button Click this button to arrange an item on the print list 
down one position in printing order. 

Sort By Select one of the following fields from the drop down list to sort by: 
• Order Date 
• Case Number (Ascending Order) 
• Case Number (Descending Order) 
• Pending Activity 
• Patient Name 
• Requesting Doctor 

Print Click this button when ready to print the list. A List of 
printers defined for the local PC will be displayed for 
selection. 

Cancel 
 

Click this button to cancel defining the print list. 

Easy Customization 
To access the Easy Customization option, highlight a case in the cases grid and right-click. 
A right-click menu is displayed; select Easy Customization. The Easy Customization 
window (Figure 8-6) is displayed. 

 
Figure 8-6. Easy Customization Window 

To change an icon, first select the icon from the Icons list, select an activity from the 
Activity list, and the click the Assign Icon button. Click OK to save your changes. 

Assigning or Reassigning Cases 
To assign an unassigned case, or to reassign a case to a different employee, click on the case (or a 
group of cases) and then click-and-drag the case to the name of the assigned employee.   
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Viewing Processing History 
To view the processing history of any case, right-click on that case and select Processing History.  
The Processing History window (Figure 8-7) is displayed. 

 
Figure 8-7. Processing History Window 

To see a list of orders placed for the selected case number, click the Orders History button.  The 
Orders History window (Figure 8-8) is displayed. 

 
Figure 8-8. Orders History Window 
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My Workspace 

The My Workspace option allows you to view the cases that are assigned to you, bridge to other 
SoftPath options to perform actions on a case, reassign a case to another employee with the same 
personnel type as you and, view the list of unassigned cases and assign these to yourself or another 
employee with the same personnel type.  For example, if you are a pathologist, you can assign cases 
to another pathologist.  If you are a laboratory assistant, you can assign cases to another laboratory 
assistant (see Chapter 6—Setup: Setup Files – Personnel File).   
To access the My Workspace option, select Work Assignment > My Workspace from the main 
menu. The My Workspace window (Figure 8-9) is displayed. 

 
Figure 8-9. My Workspace Window 

By default, your assigned cases are displayed on the right side of the screen with the following 
information:   

Case # Displays the case number. 
You can invoke the next pending action for a case by pressing 
ENTER when the case is highlighted or scanning a bar code that 
has been added to the system. 

Priority  Displays the case priority. 
Patient Name Displays the patient’s name. 
Age Displays the patient’s age. 
Sex Displays the patient’s sex. 
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Displays if the case activity is within the turnaround time specified 
for the case type (see Chapter 6—Setup:  Options, Workspaces 
Tab, My Workspace Tab).   
The following indicators describe the case TAT activity: 

Green clock: the activity is within the designated turnaround 
time, and is less than the medium delay 

Yellow clock: the activity is greater than or equal to the 
medium delay, but less than the high delay. 

TAT 

Red clock: the activity has met or exceeded the high delay. 
Activity Displays the currently pending activity (e.g. Processing, Sign Out). 
High Risk Displays if the patient has been flagged as high risk for abnormal 

results based on a previous case report. 
Case Status Displays the case milestones met. 
# Spec Displays the number of specimens in the case. 
Source Code Displays the code of the specimen source. 
Source Description Displays the description of the specimen source. 
# Blocks Displays the number of blocks in the case. 
Ord Date Displays the date the order was entered. 
Cmpl Date Displays the date the specimen was due for completion. 
# Slides Displays the number of slides in the case. 
Req Doctor Displays the requesting doctor. 

Print List 
The Print List function allows you to print a list of cases assigned to a selected employee ID 
on the local PC printer.  
To access the Print List option, select a User and click the Print List button. The Print List 
window (Figure 8-5) is displayed.  

 
Figure 8-10. Print List Window 
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First List Displays a list of all fields that are available for printing. 
Print List Displays a list of all fields that you have chosen for printing. 
Remove Button Highlight an item in the print list and click this button 

to remove it. 

Remove All Button Click this button to remove all items from the print 
list. 

Add Button Highlight an item in the first list and click this button 
to add it to the print list. 

Add All Button Click this button to add all items to the print list. 

Up Button Click this button to arrange an item on the print list up 
one position in printing order. 

Down Button Click this button to arrange an item on the print list 
down one position in printing order. 

Sort By Select one of the following fields from the drop down list to sort by: 
• Order Date 
• Case Number (Ascending Order) 
• Case Number (Descending Order) 
• Pending Activity 
• Patient Name 
• Requesting Doctor 

Print Click this button when ready to print the list. A List of 
printers defined for the local PC will be displayed for 
selection. 

Cancel 
 

Click this button to cancel defining the print list. 

Easy Customization 
To access the Easy Customization option, highlight a case in the cases grid and right-click. 
A right-click menu is displayed; select Easy Customization. The Easy Customization 
window (Figure 8-6) is displayed. 

 
Figure 8-11. Easy Customization Window 
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To change an icon, first select the icon from the Icons list, select an activity from the 
Activity list, and the click the Assign Icon button. Click OK to save your changes. 

Queues Panel 
The top-left section of the screen displays a list of work queues.  
To view only the cases for a specific queue, select it from the 
list.  You can also change the queue by selecting it from the 
Address drop-down list at the top of the window.  To view all 
cases again, select My Cases. 
This area also enables you to view the unassigned cases.  Select 
Unassigned Cases from the list.  If queues have been added for 
unassigned cases, you can also view the unassigned cases from 
a particular case type by selecting it from the list.  Unassigned 
Cases do not have queues assigned by default. 

 
Figure 8-12. Queues Panel 

Adding a Queue 
To add a new queue, highlight My Cases in the Work Queue Area and right-click. A right-
click menu is displayed; select Add Queue. The Queue Window (Figure 8-13) is displayed. 

 
Figure 8-13. Queue Window 
Enter a name for the queue in the Name field.  Then, select the Pending Activities and Case 
Types to qualify for the queue.  Click OK to save the queue and return to the My 
Workspace window. 
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Editing a Queue 
To edit a queue, highlight the queue to edit in the Work Queue Area and right-click. A 
right-click menu is displayed; select Edit Queue. The Queue Window (Figure 8-14) is 
displayed. 

 
Figure 8-14. Queue Window – Edit 

Edit the Pending Activities and Case Types fields, as need, and click OK to save your 
changes and return to the My Workspace window. 
NOTE: A queue name cannot be edited.  To change the name of a queue, you must 

delete the existing queue and add a new one with the desired name. 

Deleting a Queue 
To delete a queue, highlight the queue to delete in the Work Queue Area and right-click. A 
right-click menu is displayed; select Delete Queue.  

Unassigning or Reassigning Cases 
If permitted for your personnel type, you can reassign cases to and from another employee with the 
same employee type as you or move your assigned cases back to the unassigned cases list.  For 
information on defining permissions, see Chapter 6—Setup: Options – Workspace Tab – 
Permissions Tab. 
To remove a case that has been assigned to you, highlight the case to move and then click-and-drag 
the case to the unassigned cases list. 
The lower-left section of the screen displays a list of employees with the same personnel type as you.  
Depending on the Options settings (see Chapter 6—Setup: Options – Workspace Tab – My 
Workspace Tab), expanding a pathologist’s list displays the number of cases in that pathologist’s 
queue as well as the case numbers. To move a case, click on the case to highlight it and then click-
and-drag the case to the name of the person to whom the case will be assigned.   
You can move multiple cases at one time; to select a range of cases, press and hold SHIFT while 
selecting the first and last case in the range.  All cases in between will be selected.  To select 
multiple, non-adjacent cases, press and hold CTRL while selecting each desired case.  Once the 
desired cases have been selected, drag them to the proper location. 
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Working with A Case 
To perform an action on a single case, double-click on the case. The case will open in the relevant 
screen for its pending activity.  

Batch Resulting of Cases 
You can bridge to other SoftPath options to perform actions on a case. First, select the case (or a 
group of cases) and then click the toolbar button that corresponds to the desired option.  Choose from 
the following: 

 OCP (One Case Processing)  QA Entry 

 Worklists  Sign Out 

 Result Entry   

Once you are finished working in the bridged option, close the option window to return to the My 
Workspace window. 

Standard Diagnosis  
Click the Standard Diagnosis button ( ) to enter the default diagnosis codes, descriptions 
and final diagnosis text defined in the Standard Dx function of the cascade window setup.  For more 
information about this option, see Chapter 3 – Results: Pre-Defined and Standard Diagnosis. 

Screener Evidence  
The Scr Evid portion of the toolbar displays the real-time number of slides previously screened on 
the current day for the Login ID. Based on the Daily Slides Screening limit defined in the Personnel 
Setup File for the login ID, this value displays in green when 11or more slides can still be screened 
or red when the user has 10 or fewer available slides to screen. 
NOTE: If the total number of slides associated to the selected case(s) exceeds the Daily Slides 

Screen Limit value defined in the Personnel setup file, a warning message is displayed 
when trying to open the case(s). Depending upon the options setting "Permission to 
Over-ride Maximum slide limit message", the user is either blocked from proceeding or 
given an option to override and continue. 

Viewing Processing History 
To view the processing history of any case, right-click on that case and select Processing History.  
The Processing History window (Figure 8-7) is displayed. 
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Appendix A - SoftPath Conversion on 
Demand Utility 

This section is designed to acquaint you with the use of the SoftPath Conversion on Demand utility. 
The Conversion on Demand utility allows you to upgrade/convert reports from SoftPath with Word 
Perfect systems to the new SoftPath III (GUI) system without having to perform a one-time 
conversion of your database that could take weeks or months (depending on the database size).  
The Conversion on Demand utility requires minimal user interaction. Signed out reports resulted in 
SoftPath with Word Perfect can be converted and viewed from any window that allows you to 
view/print reports. If the case has not been previously converted, the system will convert the report 
when it is viewed.  
For example, to view a report that was resulted in SoftPath with Word Perfect, you would simply 
access the Results Query option, query the appropriate case, and view the report. The utility would 
then automatically convert the report from Word Perfect format to Adobe Acrobat PDF (portable 
document file) format. The only noticeable difference is that the report is displayed in PDF format.  
However, the conversion is not always automatic. The following instances require you to perform a 
function or task to complete the conversion process for a report that was resulted in SoftPath with 
Word Perfect but not signed out: 
• Unsigned Word Perfect Reports - Word Perfect reports that have not been signed out must be 

processed in the Result Entry option and converted into MS Word format before processing can 
continue. You can still view the reports in any window that allows you to view/print reports.  

• Unsigned Cascading Windows - These reports are converted into MS Word format when the 
Conversion on Demand utility is set up. You can still view the unsigned Word Perfect reports in 
any window that allows you to view/print reports. The reports display in MS Word format.  
NOTE:  The only time that a case resulted in cascading windows will have a PDF document 

created is if there is an associated Supplemental or Revised report created in Word 
Perfect or if the case was signed out in SoftPath with Word Perfect.  
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Setup 
SCC programmers will enable and set up the Conversion on Demand utility. Once the utility has 
been set up, cases from SoftPath with Word Perfect will be modified as follows: 
• All signed out reports will qualify for conversion to PDF format. 
• Cases that have been processed and resulted (i.e., have completed reports) in Word Perfect, and 

are not signed out, will have their report status downgraded from completed to incomplete. 
These reports will need to be converted.  

• Cases that have been processed and resulted (i.e., have completed reports) in cascading windows 
will have relevant MS Word documents created. The report status of these documents is 
downgraded from completed to incomplete. This applies only to cases resulted in cascading 
windows that do not have an associated Word Perfect report (i.e. revised or supplemental report). 

• Cases that are pending quality assurance (QA) will qualify for conversion to MS Word format. 
NOTE: Careful client testing of a subset of cases with reports from the legacy system to 

SoftPath is recommended. An SCC Soft Computer representative will review ten (10) 
randomly chosen converted cases and reports from your legacy system to check for any 
obvious data errors. 

Conversion Instructions 
After the utility is set up, you can begin converting cases. This can be done in a number of ways, 
depending on the report status and whether the case was resulted in Word Perfect or in cascading 
windows. Perform the following to convert documents with the corresponding report statuses: 
• Signed Out Report (All) - Open the report using any SoftPath function that allows you to 

view/print reports. See page A-3. 
• Unsigned Word Perfect Report - Requires user interaction. See page A-4. 
• Unsigned Cascading Windows Report - Requires user interaction. See page A-5. 
• Batch Conversions (All) (Scheduler) - Requires user interaction. See page A-6. 

Converting Signed Out Reports from the Result Entry Option 
To access the Result Entry option, select Results > Case Result > Result Entry from the 
main menu. The Select Report window displays. Enter the case number associated with the 
report that you want to convert and click Find. The Results tab displays (Figure A-1). 

 
Figure A-1. Select Report window - Results tab  
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NOTE:  If none of the reports created for this case have been previously viewed, the report 
status is pending conversion. The date the report was signed out still appears in the 
Signed Out Date column. 

Highlight the report that you want to convert and then click View. The PDF viewer displays 
the document in PDF format. The report is successfully converted from Word Perfect to PDF 
format and saved automatically. Close all windows and return to the SoftPath main window.  

Converting Signed Out Reports from the Result Query Option  
Select Query > Result Query from the main menu. The Result Query Search window 
displays. Enter the case number associated with the report that you want to convert and click 
Find. The Result Query window displays, containing information for the specified case. 
Click the Reports tab. The window appears similar to Figure A-2. 

 
Figure A-2. Result Query - Reports tab. 

Highlight the report you want to convert and click View. The PDF viewer displays the 
document in PDF format. The report is successfully converted from Word Perfect to PDF 
format and saved automatically. Close all windows and return to the SoftPath main window.  
NOTE:  These instructions apply to all case types regardless of how they were resulted 

(i.e., Word Perfect or cascading windows). 
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Converting Unsigned Word Perfect Reports 
To convert reports created in Word Perfect that have not been signed out, select Results > 
Case Result > Result Entry from the main menu. The Select Report window displays. Enter 
the case number associated with the report that you want to convert and click Find. The 
Results tab displays similar to Figure A-3. 

 
Figure A-3. Select Report - Results tab. 

Highlight the report that you want to convert and then click View. The PDF viewer and MS 
Word open within the report window and display in split-screen format. All pertinent case 
information from the database, except for the gross description and final diagnosis, is 
inserted into the MS Word document.  
The gross description and final diagnosis are not inserted into the MS Word document 
automatically. You will need to manually transfer this information from the PDF viewer to 
the MS Word document. To do this, click the Select Text Tool button  on the PDF viewer 
toolbar. Use Select Text Tool to highlight the final diagnosis text. Press CTRL+C or select 
Edit > Copy from the PDF viewer menu to copy the text to the clipboard. Do not select 
headers or field titles. 
Select the Final Diagnosis tab in the MS Word report window. The system inserts the cursor 
in the final diagnosis section. Press CTRL+V or select Edit > Paste from the MS Word 
menu to insert the text you copied from the PDF viewer into the final diagnosis section. 
Now you will need to copy the gross description into the MS Word document. In the PDF 
viewer window, use the Select Text Tool  to highlight the gross description. Press 
CTRL+C or select Edit > Copy from the PDF viewer menu to copy the text to the clipboard. 
Select the Gross Description tab in the MS Word report window and press CTRL+V or 
select Edit > Paste from the MS Word menu to insert the copied text into the gross 
description section. 
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Click the Save Section button. The appropriate completion window displays at the bottom of 
the screen. Complete the required fields and click the Save button. The following message 
displays: “Is the Final Dx Procedure completed?” Click Yes to confirm that you have 
completed the final diagnosis. Another message displays: “Is the Gross Description 
Procedure completed?” Click Yes to continue. The system closes the window and displays 
the Results tab of the Select Report window.  
The case is now ready to be signed out using the normal sign out process. The PDF 
document is saved but cannot be viewed. If you need to view this document at a later date, it 
can be retrieved by SCC personnel. Only the MS Word document is available for viewing 
and processing. 

Converting Unsigned Reports Resulted in Cascading Windows 
To convert reports created using cascading windows, select Results > Case Result > Result 
Entry from the main menu. The Select Report window displays. Enter the case number 
associated with the report that you want to convert and click OK. The Results tab displays 
similar to Figure A-4. 

 
Figure A-4. Select Report - Results tab. 

Highlight the report that you want to convert and then click Edit. The MS Word report 
window displays, containing the relevant case data including the final diagnosis. Click the 
Save Section button. A completion window displays similar to Figure A-5. 
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Figure A-5. Report window with completion window displayed. 

Enter the appropriate information in the completion window and click Save. The system 
displays the following message: “Is the Final Diagnosis completed?” Click Yes to confirm 
that you have completed the final diagnosis. Close all windows. The report created using 
cascading windows is successfully converted to MS Word format. 
NOTE:  For cases that were originally resulted in cascading windows and had subsequent 

supplemental or revised reports, refer to Converting Unsigned Word Perfect 
Reports on page A-24. 

Batch Conversion Process 
Use this process to convert all reports within a given range. To begin the process, select 
Setup > Scheduler from the main menu. The Scheduler window opens and displays 
information for the first item of the Parameter Group list. Click the New button on the 
SoftPath toolbar. The Add Group window displays similar to Figure A-6. 

 
Figure A-6. Add Group window. 

Scroll to the bottom of the list and select WP Convert. Click OK. A new tab called WP 
Convert is created and displayed, similar to Figure A-7. 

 
Figure A-7. Scheduler window - WP Convert tab. 

In the Time area of the Scheduler window, mark the checkbox that corresponds to the day 
of the week that you want to perform the batch conversion process. Next, double-click one 
of the columns next to the list of days. The Hours and Minutes window displays similar to 
Figure A-8. Enter the time that you want to perform the process in the Hours and Minutes 
window. For example, if you wanted the process to run at 19:30 you would enter 19 in the 
first column and 30 in the second column of the Hours and Minutes window. Click OK.  
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Figure A-8. Hours and Minutes window.  

NOTE:  Because of the amount of system resources needed to run the conversion utility, 
SCC recommends that the utility is set to run at a time when system usage is low 
(e.g., nights and weekends). Running the utility at peak usage times could affect 
system performance. 

In the System area, select the Main option button to convert reports in the main database or 
select the Aux option button to convert reports in the auxiliary database. 

 
Figure A-9. System area of the Scheduler window. 

Select the WP Convert tab. Specify a range of dates in the From and To fields. The batch 
conversion will include all cases that fall within the specified date range. Do not leave these 
fields blank. Leaving these fields blank causes the system to attempt to convert all cases that 
are pending conversion in the system. Attempting to convert so many cases at one time can 
adversely affect system performance. 
In the Report Type area, mark the checkboxes to indicate which report types you want to 
include in the conversion process.  

 
Figure A-10. Report Type area of the WP Convert tab. 

In the Time Out After field, enter the maximum number of hours you want to allow the 
system to take to perform the conversion process. If you do not enter a value in this field, the 
system will run the utility until all selected cases have been processed and you will not have 
the ability to stop the process if it carries over into a high-usage time of the day. This option 
allows you to stop the conversion utility if it takes longer than expected to complete the task. 
Click the Save button on the SoftPath toolbar and close the window. If you want to make 
any changes, you can return to the Scheduler window and click the Edit button to modify 
the settings.  
This batch conversion process creates the PDF documents for reports that have been signed 
out and are pending conversion. This allows for faster access to these documents, since the 
system will not have to convert the report when it is viewed or printed. For the cases that are 
not signed out, you will still have to complete the conversion processes described earlier for 
each report format (Word Perfect or cascading windows). 
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Appendix B - Print Admin 3.2 Guide 

The Print Administrator is used to configure and monitor Print Server components, which include 
print workers, printers, faxes, etc. It also allows you to monitor print jobs. 

Main Menu 

 
Figure B-1. Main Menu: Tool Bar 

The main menu (Figure B-1), includes the following options: 

File 
The File menu contains the following options: New, Open, Print Setup, Recent files, and 
Exit. 

View 
The View menu allows you to toggle from view the Tool Bar and the Status Bar. 

Edit 
The Edit menu contains the following options: Add, Delete, Edit, Save, Reprint Job(s), 
Cancel Job(s), Show Faxes, and Show History.  

Setup 
The Setup menu contains the following options: Job List Setting, Printer List Test Setting, 
Printer Setup Setting, and Worker List Setting. 

Tools 
The Tools menu contains the following options: Job Control, Worker Control, Printer List 
Test, Printer Setup, and Export/Import Setup Wizard. 

NOTE: Menu options are accessible from the tool bar as well. Move the mouse over a tool bar 
icon to display a tool tip with the option name. 

Start/Stop Print Worker 
When the Worker Control window is opened, select an existing print worker with “Down” status and 
click Start Print Worker button to start the print worker; likewise, click the Stop Print worker 
button to stop a currently running print worker. 
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Monitoring Print Jobs 
The Job Control option is used to monitor print job(s). Selecting the Job Control button from the 
tool bar displays the Job Control window.  

View Print Jobs for a Connected Printer 
1. Select the printer name from the Printer drop-down list or leave the field blank to 

include all printers. 
2. Select the print job status from the Status drop down list 
3. Select a system from the System drop down list or leave the field blank to include all 

systems. 
4. Click the Refresh button from the tool bar 

Result: The list of jobs is displayed 

Display the Job History Window 
The Job History window displays the following information about the print job: job code 
(status), Host ID, Result Date and Time. Use the following steps to display the Job History 
window (Figure B-3). 
1. Select a rejected or a printed job and click the right mouse button 

Result: A pop-up menu displays similar to the one shown in Figure B-2 

 
Figure B-2. Job Pop-up Menu 

2. Select the Show History option. 
Result: The Job History window (Figure B-3) for the selected job is displayed. 

 
Figure B-3. The Job History screen 

3. When you have completed viewing the Job History screen, click OK. 
Result: The Job History window closes. 
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Display the Job Information Window 
The Job Information window displays information about the print job. Use the following 
steps to display the Job Information window. 
1. Select a printed job and click the right mouse button 

Result: A pop-up menu displays similar to Figure B-2 
2. Select the Show Job. 

Result: The Show Job Information window displays job information 

 
Figure B-4. Jobs for Selected Batch Window 

3. When you have completed viewing the Job Information window, click OK. 
Result: The Job Information window closes. 

NOTE:  By right-clicking and opening the Job Popup menu (Figure B-2), you can cancel 
or reprint the selected job. 

Monitoring Print Workers  
A Print Worker is a Print Server component that is run on the PC. It reads data from the database and 
runs the proper program to print jobs. The Print Worker Control option allows the user to monitor 
Print Workers.  

Adding a New Print Worker 
1. Select the Add button from the tool bar. 

Result: The Worker setup tab is displayed. 

 
Figure B- 5. Print Worker Control Window 

2. Select the Worker ID browse button ( ). 
Result: A list of computers is displayed. 

3. Select the PC with the Print Server (PrnSrv) installed. 
4. Click OK. 

Result: The Print Worker is displayed in the Worker ID field. 
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5. Click the Save button to save your changes. 

Monitoring Printers  
1. Select the Printer Setup button ( ) from tool bar. 

Result: The Printer Setup window (Figure B-6) opens. 

 
Figure B-6. Printer Setup window: Add Button Selected 

2. Click the Add button ( ) from the tool bar.  
Result: The Printer Setup window fields are editable. 

3. Select the ID (Security) browser button ( ). 
Result: The Security Printer Browser Window (Figure B-7) is displayed.  

 
Figure B-7. Security Printer Browser window 

4. Select a printer. 
5. Click OK. 

Result: The selected printer name is displayed in the Printer name field.  
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Next, you will need to map a security printer by a physical printer defined on PrnSrv.  
6. Click the Add button to the right side of the Aliases grid.  

Result: The Alias window (Figure B-8) is displayed.   

 
Figure B-8. Alias Window 

7. Select a host from the Host drop down list. 
Note:  A printer must be defined in Windows on the selected PC. If the printer is connected to 

another computer, you must define that printer on the PrnSrv PC as a network printer. 
8. Click the Printer Name browser button ( ). 

Result:  The Printers Browser window is displayed. 

 
Figure B-8. Printers Browser Window 

9. Select a printer from the list. 
10. Click OK. 
11. Set the Active field to Yes, using the drop down list. 
12. Click OK.  

13. Click  save your changes. 
Result: The added printer will be displayed in the Printer Setup window (Figure B-9). 
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Figure B-9. Printer Setup Window: New Printer Added 

Using the Print Administrator Wizard 
The Print Administration Wizard helps you configure the print server quickly. 

 
Figure B-10. Print Administrator Wizard Window 

1. Click the Print Administrator Wizard button. 
Result: The Print Administrator Wizard (Figure B-10) is started.  

2. Click the Next button.  
Result: The Add Security Printer Name window (Figure B-11) is displayed. 
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Figure B-11. Add Security Printer Name Window 

3. Click the Security ID browser button ( ). 
Result: The Security Printer Browser window (Figure B-12) is displayed 

 
Figure B-12. Security Printer Browser 

4. Select the security printer name.  
5. Click OK.  

Result: The selected printer is displayed in the Security Name field. 
6. Click Next.  

Result: The Select Worker ID window (Figure B-13) is displayed.  
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Figure B-13. Print Administrator Wizard: Select Worker ID Window 

7. Select a Print Worker from the Worker ID drop down list. 
Result: The Worker name is displayed in the Host name field. 

8. Click Next. 
9. Click the Printer name browser button ( ). 

Result: A list of installed printers (Figure B-14) is displayed.  

 
Figure B-14. Printers Browser: Physical Printers List 

10. Select a printer. 
11. Click OK. 

Result: The selected printer will be displayed in the Print Administrator Wizard (Figure B-15). 

 
Figure B-15. Print Administrator Wizard: Physical Printer is Added 

12. Click the Finish button. 
Result:  The Print Server configuration is complete. 
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Printer List Test 
The Printer List Test tool bar button is used to test if a User, as denoted by use of their User ID, is 
able to see a specified list of printers from SoftPRS.  
To examine a list of available printers for a user, use the following steps. 
1. Select the Specify User ratio button.  
2. Enter the User’s ID in the User ID field.  
3. Set the Printer Type field to Normal. 
4. Click Find.  

Result: The list of printers, which includes the Printer ID, Printer name, and Type, displays on 
the right side of the search screen 

 
Figure B-16. Printer List Test 
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Sample Print Server Configuration: One PrnSrv PC with One SamplePrn 
Printer for the SoftPath System 

Add Printer to SCC security system 
1. (Unix shell):Add following line to $PRINTERC file: 

SamplePrn   !P:xxx:echo "" >/dev/null 2>&1 
where: xxx is a unique number in $PRINTERC file 

2. Using the SoftSec security system, add the SamplePrn printer to SoftPath system. 
3. Give permissions for all SoftPath options to user scc. 

Configure PrintWorker on PrnSrv PC 
1. Install drivers for printers. 
2. Run the PrintAdmin program.  

Result: The PrintAdmin Screen is displayed 

 
Figure B- 17. Print Admin Screen 

3. Click  to open the Launch Worker Control option.  
4. Click on the Worker Setup tab (Figure B-18). 
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Figure B-18. Print Admin Screen - Worker Setup Tab 

5. Click  to add a Worker PC. 
6. Click the Worker ID browser ( ) 

Result: The Browse Hosts window (Figure B- 19) is displayed.  

 
Figure B- 19. Browse Hosts Window 

7. Select the PC with Print Server installed (PrnSrv). 
8. Click Save. 

Result: The added Print Worker will be displayed on the list. 

 
Figure B- 20. Print Admin Screen - PrnSrv Installed 

Configure Printer Settings 

1. Click . 
Result: The Printer Setup window (Figure B- 21) opens. 
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Figure B- 21. Printer Setup Window 

2. Click . 
Result: The Printer Setup window fields are editable. 

 
Figure B- 22. Printer Setup Window - Add Printer 

3. Click the ID (Security) browser ( ).  
Result: The Security Printer Browser window (Figure B-23) is displayed.  
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Figure B-23. Security Printer Browser window 

4. Select SamplePrn. 
5. Select a Printer Type. Allowed values are as follows: 

Normal Regular printer 

Label Label printer (e.g., Zebra, Solus, Oki) 

Fax SCC-FaxPrn printer 

6. Set the Active field to Yes, which will enable the printer. 
7. Click the Add button to the right side of the Aliases grid.  

Result: The Alias window (Figure B-8) is displayed. 
NOTE:  Preferably, defined printers should be setup as network printers on a hospital 

print server.  

 
Figure B-24. Alias Window 

8. Select a host from the Host drop down list. 
Note:  A printer must be defined on the selected PC. If the printer is connected to 

another computer, you must define that printer on the PrnSrv PC as a network 
printer. 

9. Click the Printer Name browser button ( ) to. 
Result:  The Printers Browser window (Figure B- 25) is displayed. 
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Figure B- 25. Printers Browser Window 

10. Select a printer from the list. 
11. Click OK. 
12. Set the Active field to Yes, using the drop down list. 
13. Click OK. 

14. Click .  
Result: The added printer will be displayed in the Printer Setup window. 
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Add Second Print Server Printer for PrnSrv PC 
In order to add a second printer named SecondPrn to Print Server configuration (as described in the 
previous exercise), follow the steps below:  

1. Add SecondPrn printer on PrnSrv PC 
2. Configure Print Server link to the printer, where SamplePrn is SecondPrn 
3. Add Print Server “Dummy” printer for PrnSrv PC 

Note:  In some situations, it is necessary to send a report label to the “Dummy” printer to 
force order report status. A document hard copy is not necessary. 

4. Configure Print Server link to the printer where your SamplePrn is Dummy. 

Adding a Dummy Printer to the PrnSrv PC 
In order to add a dummy printer named Dummy to the Print Server configuration, follow the steps 
below: 

1. From the PC Desktop, click Start > Settings > Printers and Faxes. 
2. Click on Add a Printer. 

Result: The Add Printer Wizard is displayed. 
3. Click the Next button. 

Result: The Local or Network Printer panel is displayed. 
4. Select Local Printer attached to this computer. 
5. Uncheck Automatically detect and install my plug and play printer. 
6. Click the Next button. 

Result: The Select the Printer Port panel is displayed. 
7. Select Create New Port. 
8. Select Local Port type from the dropdown list. 
9. Click the Next button. 

Result: The Port Name dialog box is displayed 
10. In, Enter the port name type null. 
11. Click OK. 
12. Click the Next button. 

Result: The Install Printer Software screen is displayed. 
13. Choose a printer type (e.g., “IBM 4019 LaserPrinter”). 
14. Click the Next button. 

Result: The Name Your Printer panel is displayed. 
15. In the Printer Name field, enter Dummy. 
16. For the question, Do you want to use this printer as the default printer?, select No. 
17. Click Next. 

Result: The Printer Sharing panel is displayed.  
18. Click Share Name. 

Result: Dummy is automatically filled entered as the Share Name. 
19. Click the Next button. 

Result: The Location and Comments panel is displayed. 
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20.  Click the Next button. 
Result: The Print Test Page panel is displayed. 

21. For the question, Do you want to print a test page?, select No. 
22. Click the Next button. 

Result: The Completing the Add Print Wizard screen is displayed with the 
selected properties for the Dummy printer. 

23. Click Finish. 
Result:  The Dummy printer has been added and displays in the Printers and Faxes 
list. 

 Fax configuration 
Print Server can merge and send documents to the Fax system (VisiFax). In order to add a Fax to 
your Print Server, a special configuration must be done. Use the following steps to configure a fax. 
NOTE: If Acrobat Reader version 6 will be used, the printer driver should be compatible with 

Postscript Level 2 – such as “QMS ColorScript 1000 Level 2”. In this case change the 
driver from “IBM 4019 LaserPrinter PS39” to “QMS ColorScript 1000 Level 2” 

Install a Printer for Creating Post Script Documents on PrnSrv PC 
1. From the PC Desktop, click Start > Settings > Printers and Faxes. 
2. Click on Add a Printer. 

Result: The Add Printer Wizard is displayed. 
3. Click the Next button. 

Result: The Local or Network Printer panel is displayed. 
4. Select Local Printer attached to this computer. 
5. Uncheck Automatically detect and install my plug and play printer. 
6. Click the Next button. 

Result: The Select the Printer Port panel is displayed. 
7. Select Create New Port. 
8. Select Local Port type from the dropdown list. 
9. Click the Next button. 

Result: The Port Name dialog box is displayed 
10. In, Enter the port name type null. 
11. Click OK. 
12. Click the Next button. 

Result: The Install Printer Software screen is displayed. 
13. Choose the printer type: IBM 4019 LaserPrinter PS39. 

Note: “PS” is very important. 
14. Click the Next button. 

Result: The Name Your Printer panel is displayed. 
15. In the Printer Name field, enter SCC-FaxPrn. 
16. For the question, Do you want to use this printer as the default printer?, select No. 
17. Click Next. 

Result: The Printer Sharing panel is displayed.  
18. Click Share Name. 



SoftPath v.4.2.1 User Manual Appendix B – PrintAdmin 3.2 Guide 

PATH4.2-G-U (6th Ed, Rel. 1/31/07)  Page B-17 

Result: Dummy is automatically filled entered as the Share Name. 
19. Click the Next button. 

Result: The Location and Comments panel is displayed. 
20.  Click the Next button. 

Result: The Print Test Page panel is displayed. 
21. For the question, Do you want to print a test page?, select No. 
22. Click the Next button. 

Result: The Completing the Add Print Wizard screen is displayed with the 
selected properties for the Dummy printer. 

23. Click Finish. 
Result:  SCC-FaxPrn has been added and displays in the Printers and Faxes list. 

Configure a Print Server Link to the Printer 
1. Open PrintAdmin. 

2. Click the Printer Setup Button ( ) 

3. Click . 
4. Select Fax from the Printer Type dropdown list. 

Result: The Printer Name and ID (Security) fields are automatically filled in. 
5. Select Yes from the Active dropdown list. 
6. Click the Add button to the right side of the Aliases grid.  

Result: The Alias window (Figure B-8) is displayed.   

 
Figure B-26. Alias Window 

7. Select a host from the Host drop down list. 
Note:  A printer must be defined on the selected PC. If the printer is connected to 

another computer, you must define that printer on the PrnSrv PC as a 
network printer. 

8. Click the Printer Name browser button ( ) to. 
Result:  The Printers Browser window (Figure B- 25) is displayed. 

 
Figure B- 27. Printers Browser Window 
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9. Select the printer from the list. 
10. Click OK. 
11. Set the Active field to Yes using the drop down list. 
12. Click OK. 

13. Click .  
Result: The SCC-FaxPrn printer is added to Printer Setup window (Figure B-28). 

 
Figure B-28. Printer Setup Window – SCC-FaxPrn Added 

Adobe Acrobat Reader Printing Settings for Faxes printing (PostScript 
options) 

It is very important to set proper Postscript Language level for faxes printed from PDF files. 
1. Open any PDF File in Adobe Acrobat Reader. 
2. Select File > Print. 

Result: The Print dialog box is displayed. 

 
Figure B-29. Adobe Reader - Print Dialog Box 

3. Select SCC-FaxPrn from the Name dropdown list. 
4. In the Postscript Option section, change the Print Method to Language Level 1. 

Note: In newer versions of Adobe Reader, select the Advanced button to access 
Postscript Options. 
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Portable Document Format converter configuration 
Print Server can create and convert Word documents to PDF (Portable Document Format) 
documents by using the GhostScript Postcript to PDF interpreter. In order to add the PDF converter 
to the Print Server, a special configuration must be done.  

Install Printer for Creating  PDF documents on PrnSrv PC 
By default “SCC-PDFConvPrn” is installed during install process. Check if “SCC-
PDFConvPrn” or “SCC-PDFConvPrnGS” exists in the Printer Folder. If they are not in the 
Printer folder, use the following steps. 
1. Click  the Add Printer button. 
2. Choose the “QMS ColorScript 1000 Level 2” printer. 
3.  Enter the printer name as “SCC-PDFConvPrn,” making sure that the port name is 

“SCCPDFCONV:” for normal install or  “SCCPDFCONVTEST:” for testing version. 

Configure Print Server link to the to PDF Converter on GhostScript 

1. Clicking the  button. 
Result: The Printer Setup window (Figure B-6) is displayed. 

2. Click the Add button ( ). 
Result: The Printer Setup window (Figure B-6) fields are editable. 

3. Select PDF Convert from the Printer Type dropdown list. 
Result: The Printer Name and Security ID is automatically entered. 

4. Enable the printer by setting the Active field to Yes. 
5. Click the Add button to the right of the Aliases list.  

Result: The Alias window (Figure B-8) is displayed.  

6. Click the Printer Name browser button ( ). 
Result: The Printers Browser window (Figure B-9) is displayed. 

7. Select “SCC-PDFConvPrn” (or the defined printer) and click OK. 

8. Click the Save button ( ). 
Result: The selection is saved. 
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Remote Printer configuration 
Print Server can merge and send documents to a Remote Printer system. In order to add a Remote 
Printer to the Print Server, a special configuration must be done. Use the following steps to configure 
a Remote Printer. 

Install a Remote Printer  
On the Print Server PC, install an alias printer in Microsoft Windows with the proper driver. The 
proper driver can be determined by checking any tag on the printer. This printer should be 
connected to any null port. For instructions on setting up a printer, refer to page B-15, keeping in 
mind to use the proper driver. 

Add A Remote Printer to SCC Security System 
1. (Unix shell): Add a new remote printer using the remsetup program. Set the remote 

printer name (e.g., RP1) 
2. (Unix shell): Add following line to $PRINTERC file: 

SCC-RemotePrn-RP1   !P:xxx:echo "" >/dev/null 2>&1 
where: xxx is a unique number in $PRINTERC file, RP1 or the 
unique name defined in the previous step. 

3. Using the SoftSec security system, add SCC-RemotePrn-RP1 to the SoftPath 
system. 

4. Give permissions for all SoftPath options to user scc. 

Configure Print Server Link to the Remote Printer 
1. Open PrintAdmin. 

2. Click the Printer Setup Button ( ) 

3. Click . 
4. Select Remote from the Printer Type dropdown list. 

Result: The Printer Name and ID (Security) fields are automatically filled in. 
5. Click the ID (Security) Browser button ( ) 

Result: The Security Printer Browser Window (Figure B-7) is displayed.  

 
Figure B-30. Security Printer Browser window 

6. Select the configured remote printer. 
7. Click OK. 
8. Select Yes from the Active dropdown list. 
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9. Click the Add button to the right side of the Aliases grid.  
Result: The Alias window (Figure B-8) is displayed.   

 
Figure B-31. Alias Window 

10. Select a host from the Host drop down list. 
Note:  A printer must be defined on the selected PC. If the printer is connected to 

another computer, you must define that printer on the PrnSrv PC as a 
network printer. 

11. Click the Printer Name browser button ( ) to. 
Result:  The Printers Browser window (Figure B- 25) is displayed. 

 
Figure B- 32. Printers Browser Window 

12. Select the printer from the list. 
13. Click OK. 
14. Set the Active field to Yes using the drop down list. 
15. Click OK. 

16. Click .  
Result: The Remote printer is added to Printer Setup window. 
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Add second PrnSrv2 PC 
The process of creating, merging and sending documents to a printer is very complicated and takes a 
lot of time on the PC where the Print Server runs. When a number of printers are connected to those 
PCs, the process of printing documents is faster than the process of preparing them to print, so 
printers and users will be waiting. In order to increase the speed of creating documents, a second PC 
for merging documents can be used. Both PCs can be connected to the same printers or can have 
separate ones printers. 
Notice: When two Print Server PC machines are preparing documents for the same printer, the 

document order in a batch print can be changed. 

Add PrnSrv2 PC to Print Server Workers List 
1. Open the PrintAdmin program. 
2. Click Tools > Worker Control. 

Result: The Worker Control window is displayed. 

  
Figure B- 33. Worker Control Window - Worker Setup Tab 

3. Click  to add a worker PC. 
4. In the Worker ID field, enter PRNSRV2. 

5. Click . 
Result: The new Print Worker, PRNSRV2, now displays on the left hand side of the 
Worker Control Window similar to Figure B- 33 
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Use Two Print Server PCs for Creating and Merging Documents for One 
Printer 

Printer Installation 
Install all physical printers connected to PrnSrv PC as network printers on PrnSrv2 PC. For 
more information about installing printers to the PrnSrv PCs, refer to Adding A Dummy 
Printer To PrnSrv PC, replacing specific references to the Dummy printer with the desired 
printer.  

Configure Print Server Link to the Printer 
1. Open the PrintAdmin program. 

2. Click the Printer Setup Button ( ). 
3. Select SimplePrn printer from the list. 
4. Click the Edit button.  
5. Click the Add button to the right side of Aliases. 

Result: The Alias window (Figure B-8) is displayed.   

 
6. In the Host field, enter PRNSRV2, or the selected name of the second Print Server PC. 
7. In the Printer Name field, enter a printer that is adequate to the first one but installed on 

PrnSrv2 PC. Use the browser button ( ), if needed. 
8. Select Yes from the Active dropdown list.  

9. Click . 
Result: Now both PCs will be used to prepare documents for one printer. Unfortunately, 
the document order in a batch print can be changed. See  

 
Figure B- 34. Printer Setup Window - Two Print Server PCs 
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Using Second Print Server PC as an Auxiliary Configuration 
You can limit the use of the second Print Server PC connection as an auxiliary configuration. 
Follow the steps for Configuring the Print Server Link to the Printer, except in step 8, select 
No from the Active dropdown list. In such situations, the second Print Server PC will merge, 
but you can easily switch between preparing documents from one Print Server PC to another 
by toggling on/off the Active field in Aliases list. In Figure B- 35, a sample configuration is 
presented. 

 
Figure B- 35. Auxiliary Configuration  - Printer Sample  

Division of the merging process can also be applied for Faxing and Dummy printing. In 
Figure B- 36, a sample configuration is presented.  

 
Figure B- 36. Auxiliary Configuration  - Faxing/Dummy Printing Sample 
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Exporting/Importing Printer Configuration Files 

NOTE: Reprinted from GUI Print Server Configuration Guideline  Document ID T01D067 

Exporting Print Server Configuration 
Sometimes, especially during Print Server upgrading, there is a need to export the entire Print Server 
Configuration (such as printer names, workers, aliases) to a file. For this task there is a special option 
in Printers Setup: Export Printers Setup. You can access this option from the PrintAdmin main 
menu by selecting, Tools > Export/Import > Export Printers Setup. 
NOTE:  Exporting the Print Server configuration should be done every time a change is made. 

 
The Export Printers Setup option allows you to save the entire Printer Configuration to a single file 
with the “.pss” (Print Server Settings) extension. After choosing this option from the menu, the 
standard “Save As” file dialog appears. Enter any valid file name to save to the selected file location. 
This file has a very simple format that follows the following format: 
Printer Name, Printer Type, Print Worker HOST, Printer Alias Name [,Priority - optional] where 

Printer Name Denotes a Printer Name defined in Security (e.g., Dummy). 
P Normal printer 

F Fax Printer 
C PDF Converter 
L Label printer 

Printer Type 

R Remote printer 

Print Worker Host Host name where specified printer has Exec-Addin. 

Printer Alias 
Name 

Physical printer name defined for specified host above 

See Figure B-37, for a Sample Printer Setup File.  
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# This file is used for modify configuration of printers 
# for setup Print Server - modify it at your own risk 
# Field Format: 
# Printer Name, Type, Print Worker HOST, Printer Alias Name [,Priority - optional] 
# where Type:  
#    P - Normal 
#    F - Fax 
#    C - PDF Convert 
#    R - Remote 
# 
 
 
# Printer: SCC-PDFConvPrn 
SCC-PDFConvPrn, C, PRNSRV, SCC-PDFConvPrn 
 
# Printer: SCC-FaxPrn 
SCC-FaxPrn, F, PRNSRV2, SCC-FaxPrn 
 
# Printer: CAT 
CAT, P, PRNSRV2, Redirect IBM 4019 LaserPrinter PS39 
CAT, P, PRNSRV, Redirect IBM 4019 LaserPrinter PS39 

Figure B-37. Sample Printers Setup File 

Importing Print Server Configuration 
The Import Printers Setup option is used for configuration importing or to create a configuration 
from a previously prepared Print Server Settings file. To import a configuration, follow these steps: 
1. From the PrintAdmin main menu, select Tools > Export/Import >Import Printers Setup.  

Result: The Open File dialog box is displayed. 
2. Choose the desired *.pss file. 
3. Click the Open button.  

Result: If no errors were encountered, the entire printer configuration is imported to the Printer 
Server.  
NOTE: If errors are encountered, the Import Error message (Figure B- 38) is displayed.  

 
Figure B- 38.  PrintAdmin Import Error Message 

Click Yes to view Error.log file.  Figure B- 39 is a sample Error log. 
 



SoftPath v.4.2.1 User Manual Appendix B – PrintAdmin 3.2 Guide 

PATH4.2-G-U (6th Ed, Rel. 1/31/07)  Page B-27 

Error log for Print Server Admin Import 
Import file path "C:\Export.pss" 
 
Line 14: SCC-PDFConvPrn, C, PRNSRV, SCC-PDFConvPrn 
Error: Host "PRNSRV" has not defined printer name "SCC-PDFConvPrn" 
 
 
Line 17: SCC-FaxPrn, F, PRNSRV, SCC-FaxPrn 
Error: Host "PRNSRV" has not defined printer name "SCC-FaxPrn" 
 
 
Line 28: CAT, P, PRNSRV2, Redirect IBM 4019 LaserPrinter PS39 
Error: Host "PRNSRV" has not defined printer name "Redirect IBM 4019 LaserPrinter 
PS39" 
 
 
Printer "CAT" with Host "PRNSRV" exist - not changed. 

Figure B- 39. Sample Error Log 

Clean Printer Setup 
The Clear Printer Setup option erases Printer Settings from the Print Server. 
WARNING: Please make a backup copy of printer settings (see: Export Printer Settings for 

more information on this option) before using this option. If you do not make a 
backup copy of the printer settings all of the settings will be lost. 

Access this option from the PrintAdmin main menu by selecting Tools > Export/Import > Clean 
Printers Setup. Before using this option, a message asks you to confirm the action. Click Yes to 
confirm or No to cancel the action.  
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Appendix C - Master Patient Index 

NOTE: This appendix is reprinted from the SoftLab 3.19 User Manual (Doc. ID LAB-G-U). 
The Master Patient Index (MPI) option is a mechanism used to link patients with different MRNs 
or HCNs (Canadian clients).  MPI is an optional feature available as an add-on to SoftLab. 
A server (MPIS) is utilized which is connected to the SoftLab, SoftMic, and SoftPath. The MPIS 
also allows you to search by Patient Previous Name and to broadcast warnings about 
Epidemiologically Significant Occurrences.  In the event the MPIS is down, a warning will be 
generated to notify users that the system cannot communicate with the server.  Any transactions 
during the down-time will be queued and sent once the MPIS is restarted. 
To access the MPIS option, select [Interfaces]>[Master Patient Index] from the main menu, or use 
the alternate keystroke ALT+I then type S.  You can also select [Master Patient Index] from the 
menu tree. The Interfaces Setup window displays similar to C-1.   

 
Figure C-1.  Interfaces, Interface Setup Screen 
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Double-click the Master Patient Index Server option. You can also use the UP/DOWN ARROW 
keys to select the correct option and then press ENTER.  A list of available servers displays (Figure 
C-2).  Select the MPI Server you want to view.  The Master Patient Index Server window displays 
similar to Figure C-2. 

 
Figure C-2.  Patient Linking Criteria 

A link can be established by selecting certain criteria in the Master Patient Index Server window.  
The criteria are as follows:  Patient’s Last Name, First Name, Middle Initial, DOB, Sex, Age, and 
SSN.  The link criteria for Middle Initial, DOB, Sex, Age, and SSN can be either Full or None.  The 
link criteria for Last Name and First Name can be Full, Partial, or None. 
A partial match for name is a match based on the shorter of the two names.  For example, if the link 
criteria is Full match for Last Name and Partial match for First Name, “Bob Smith” would be linked 
to “Bobby Smith”.  However, “Bob Smith” would not be linked to “Robert Smith” since the pattern 
“Bob” is not found in Robert.   
Even though the MPIS may be accessed under interfaces, it is not enough to restart the MPIS when 
making a change.  The entire MPI database must be rebuilt when making a change in linking criteria 
because the MPI number generated may be different with different criteria.  This rebuilding of the 
MPI database requires a programmer’s intervention. 
The MPI actually creates two numbers; one is an internal number that the MPIS uses and is never 
displayed; the other is displayed and is used for searches, etc.  The number that is displayed is 13 
characters in length and is generated based on an algorithm dependent upon linking criteria.  If 
linking criteria is Last Name, First Name, then the number generated uses the first four letters of the 
last name, first letter of the first name, date of birth, and an extension to make it unique for those rare 
cases where patients have same last names, first names, and dates of birth.  If linking criteria 
contains the Social Security Number (or HCN), then the MPI number generated is basically that 
SSN/HCN number with an extension added to make it unique. 



SoftPath v.4.2.1 User Manual Appendix C –Master Patient Index 

PATH4.2-G-U (6th Ed, Rel. 1/31/07)  Page C-3 

Order Entry-SoftLab, SoftMic 
The Order Entry search will look similar to C-3, when searching by a specific patient name. 

 
Figure C-3.  SoftLab Order Entry Search Window 

After specifying a patient’s name, the MPI database is searched to find any linked matching patients. 
The first list displayed (Figure C-3) shows data found in the MPI database.  Once you make a 
selection from the first screen, the SoftLab database is searched and a list of patients matching the 
specified criteria is displayed.  After this point, the system behaves as it normally would when 
selecting a patient in Order Entry.  This option may be turned off from the Hosparam level.  
Consequently, the system will behave as it would normally when selecting a patient.  The MPI 
database will not be searched first, however, an MPI number will be generated if necessary, or the 
patient will be linked to an existing MPI if one is found.  This will be transparent to the user. 
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Show Linked Patients 

 
Once a patient order is displayed in Order Entry, press ALT+V, then type L, or 
click the Show Linked Patients button to display all linked patients (see (Figure C-
4).  This is independent of the Hosparam setting. 

 
Figure C-4. List of matching patients found in MPI database 

Results–SoftLab 
The Results Entry system will perform delta checking and patient previous result searches 
across a patient’s MRNs.   

Simple Query-SoftLab 
The Simple Query program with the field other name is checked allows the MPI database to 
be searched when querying results on a patient. The first window displayed is a list of 
patients found in the MPI database which match entered selection criteria similar to Figure 
C-4. Once the search is complete, a list of matching patients found in the SoftLab database is 
displayed (Figure C-5). 

 
Figure C-5.  SoftLab Database Search 
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Patient History Report-SoftLab 
A new field is available to specify an MPI number in order to generate a cumulative report 
for a patient across MRNs.  If you do not know the MPI number, click the dynamic-list 
button to display a look-up screen to search by patient name or MRN similar to Figure C-6.  
The option Complete History must be selected. 

 
Figure C-6.  Patient History Search Window 

Query-SoftMic 
The SoftMic program does not actively query the MPI database when performing queries.  
Instead, it stores the generated MPI number in a hidden field (secondary ID) for the patient.  
You may query across MRNs but you cannot perform a look-up by patient’s previous name. 
There is not a field on the SoftMic search screen to search by MPI number.  The MPI 
number does not display on the patient selection screen during searches.  If a specified 
patient is linked by MPI to another patient, a secondary selection window will appear 
displaying all patients linked to that MPI number.  The SoftMic Query selection screen 
looks and behaves exactly the same way it would normally.  The only difference is when you 
press the backslash (\) key for patient history.  All orders for linked patients will display. 

SoftBank 
MPI will be available in a future release of SoftBank. 

SoftPath 
Specimen Registration does communicate with MPIS, but it does not retrieve patient data 
based on the MPI database.  If a patient is registered in the SoftPath module who was not 
previously registered in either SoftPath or SoftLab, then an MPI number will be generated 
and stored with the patient’s demographics.  If the patient was not previously registered in 
SoftPath but was registered in SoftLab, the patient’s demographics will be imported along 
with the MPI number. 
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Accessibility in SoftPath 
• The MPI number cannot be used to perform a search for patient or case data within 

the SoftPath system from a search screen. 
• Previous patient history for worksheets will search on the MPI number and will 

import all collated data on the worksheet. 
• The Cumulative Report located under the Report menu will perform a behind-the-

scenes search on the MPI number based on the MRN that you have entered. 

Additional Uses for the MPIS 
The ability to search by a patient’s previous or other name is a feature in SoftLab Order 
Entry and Simple Query.  When a patient’s last name is changed, either by manually 
editing in Order Entry or Patient Maintenance or through a demographic update from the 
ADT, the system will search the database for orders placed under both names. 
The system displays all linked patients in the database that currently have or have ad the 
name being used in the search. 

NOTE: 

 

When Last Name is used as a linking criteria and the last name is changed, the 
link will be broken.  However, the MPI database does store this patient with the 
previous name, which may be queried.  In order to relink these patients in the 
database, all previous records need to be updated with the current name. 
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Appendix D – PathQuery 

PathQuery is a utility that allows read-only access to Results Query information through the use of 
a stand-alone client application. This application can be installed on PCs that either cannot support or 
should not have access to the full SoftPath system. For example, PathQuery could be installed in a 
high-traffic area where personnel would only be searching for information, rather than entering data. 
PathQuery begins with a simple desktop and a menu bar with File, View, and Query options. Once 
the Query menu option is selected, the simple and advanced search windows found in the full version 
of SoftPath appear, as shown in Figures D-1 and D-2 below. 

 
Figure D-1. Result Query search window - Simple Search tab. 

 
Figure D-2. Results Query search window - Advanced Search tab. 
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Once you have selected your case, the Result Query window appears with your patient’s 
demographic data appearing at the top along with two tabs, the Case Data tab and the Reports tab. 
The Case Data tab displays all information about a case, just as it would in the full version of 
SoftPath. The difference, however, is that the information is presented in read-only format. The Case 
Data window displays similar to Figure D-3. 

 
Figure D-3. Result Query window - Case Data tab 

The other available tab, the Reports tab, displays similar to Figure D-4. Any active, signed out 
reports for your case display in the grid. To view a report, simply highlight it and select the Mark 
Selected button or double-click on the selection checkbox in the grid and select the View button. 
You may also select all available reports using the Mark All button. The report(s) you have selected 
will appear in PDF format. From there, you can print the PDF report.  
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Appendix E - Available Billing 
Routines 

The system provides the following hard-coded billing routines for display/use in the charge 
transaction tables for both part A & part B. 
 

ABC - Number of additional blocks per case 
This routine finds cases with additional/regross blocks and count the number of these 
blocks per case.  An additional block will be based on the existence of flags entered in 
the Regross Block field. 

ADBFS - number of additional blocks with FS  
This routine finds cases containing more than 1 FS block and will calculate the total 
number of FS blocks -1.  FS Blocks will be based on the field FS Block. 

ADRFS - number of recuts from FS blocks  
This routine finds cases with FS blocks that contain recuts and count the recuts. 

AGE - patient age  
This routine looks at the patient's age. 

Age at Sign Out 
This routine searches for cases based upon the patient age at the time of sign out 

BLKCS - number of cell suspensions blocks    
This routine finds cases with Cell Suspension blocks and count the number of blocks.  A 
Cell Suspension Block will be based on the block flag Cell Suspensions. 

BLKCT - number of cryo tissue bank blocks    
This routine finds cases with Cryo Tissue Bank blocks and count the number of blocks.  
A Cryo Tissue Bank block will be based on the block flag Cryo Tissue Bank. 

BLKEM - number of EM blocks  
This routine finds cases with EM blocks and count the number of blocks.  An EM block 
will be based on the block flag EM Block. 

BLOB5 - number of blocks with B5 
This routine finds cases with B5 blocks and count the number of blocks.  A B5 block 
will be based on the block flag Block with B5. 
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BLe10 - Total number of levels 10 for all blocks 
This routine counts the total number of slides that are the 10th level for all blocks 
attached to the case. 

BLev1 - Total number of levels 1 for all blocks  
This routine counts the total number of slides that are the 1st level for all blocks attached 
to the case. 

BLev2 - Total number of levels 2 for all blocks  
This routine counts the total number of slides that are the 2nd level for all blocks 
attached to the case. 

BLev3 - Total number of levels 3 for all blocks  
This routine counts the total number of slides that are the 3rd level for all blocks attached 
to the case. 

BLev4 - Total number of levels 4 for all blocks  
This routine counts the total number of slides that are the 4th level for all blocks attached 
to the case. 

BLev5 - Total number of levels 5 for all blocks  
This routine counts the total number of slides that are the 5th level for all blocks attached 
to the case. 

BLev6 - Total number of levels 6 for all blocks  
This routine counts the total number of slides that are the 6th level for all blocks attached 
to the case. 

BLev7 - Total number of levels 7 for all blocks  
This routine counts the total number of slides that are the 7th level for all blocks attached 
to the case. 

BLev8 - Total number of levels 8 for all blocks  
This routine counts the total number of slides that are the 8th level for all blocks attached 
to the case. 

BLev9 - Total number of levels 9 for all blocks  
This routine counts the total number of slides that are the 9th level for all blocks attached 
to the case. 

BRect - total number of recuts   
This routine finds cases with recuts and count the number of recuts for all blocks.  A 
Recut will be based on the Recut button used to create slides from blocks that are noted 
with an R. 

CENTR - Number of cytocentrifuges ( MED cyt. )   
This routine finds cases with Cytocentrifuges and count the number of Cytocentrifuges.  
A Cytocentrifuge will be based on the field Cytocentrifuge. 

CONLY - case reviewed by MD,(slides to the lab)  
This routine finds cases with an Incoming Consultations where slides were received and 
the consultation report date is not a null value. 
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COREV - case reviewed by MD  
This routine finds cases with an Incoming Consultation where No Material was received 
and the consultation report date is not a null value. 

CPREP - case reviewed by MD,(slides done in the lab)  
This routine finds cases with an Incoming Consultation where no slides are received and 
tissue is received. 

CTC - total number of cell blocks  
This routine finds cases with Cell Blocks and count the number of Cell Blocks.  A Cell 
Block will be based on the field Cell Block. 

DGNA - Abnormal diagnosis is assigned   
This routine finds cases with the abnormal diagnosis code entered in the transaction 
table.  This must be used in conjunction with the dx code field in the table. 

DGNN - Normal diagnosis is assigned 
This routine finds cases with the normal diagnosis code entered in the transaction table.  
This must be used in conjunction with the dx code field in the table. 

DTC - total number of decal blocks 
This routine finds cases with decal blocks and count the total number of decal blocks.  
The Decal Blocks will be based on the block flag Decal Block. 

EXTGR - specimens with Extensive Gross   
This routine finds cases marked for extensive gross.  The Extensive Gross will be based 
on the specimen flag Extensive Gross Description and a true value contained within the 
field. 

FIXNO - Number of fixed slides per case  
This routine counts the number of slides associated to the case that have been flagged 
as fixed. 

FSBLK - number of blocks with FS 
This routine finds cases with FS Blocks and count the total number of FS blocks per 
case.  The FS Block will be based on the field FS Block. 

GDAS - Gross description entered by Pathologist Assistant   
This routine finds cases marked for Gross Assistance.  The Gross Assistance will be 
based on the specimen flag Gross Assistance and a true value contained within the field. 

FIDO - number of specimens For Identification Only  
This routine finds cases marked For Identification Only. This routine return the numeric 
value of the field "For Identification Only". 

IOC - Gross Intraoperative Consultation    
This routine finds cases marked for Gross Intraoperative Consultation.  The Gross 
Intraoperative Consultation will be based on the case flag Gross Intraoperative 
Consultation and the numeric value entered within the field. 

INTRC - Intraopertative Consultation - Case Level Billing 
This routine finds cases marked for Intraoperative Consultation, base on the case flag 
Intraoperative Consultation and the numeric value entered within the field. 

INTRS - Intraoperative Consultation - Specimen Level Billing 
This routine finds specimens marked for Intraoperative Consultation, based on the 
specimen field Intraoperative Consultation and the numeric value entered within the field. 
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MDREV - case requires MD slides/smears review    
This routine finds cases containing a true value in the field "Required interpretation by 
physician" for cytology cases. 

MEMFL - Number of membrane filters  
This routine finds all cases containing membrane filters and count the total number per 
case.  The Membrane Filters will be based on the field Membrane Filter. 

MONOL - Number of monolayers per case 
This routine finds all cases containing monolayers and count the total number per case.  
The Monolayers will be based on the field Monolayers for the case types where it is 
available. 

NCI - Total number of regular slides per case  
This routine finds all cases containing slide and count the total number of standard slides 
per case.  The slides will be based on the creation of standard slides from a block. 

NOFSR - number of slides for review  
This routine counts the number of slides on the case when Proreview has been 
performed. 

OFBR - number of blocks received ( incoming consultations ) 
This routine finds all cases with an incoming consultation and blocks received and will 
count the blocks. 

OFSR - number of slides received ( incoming consultations ) 
This routine finds all cases with an incoming consultation and slides received and will 
count the slides. 

ONCE - count transaction once   
This routine finds the values entered in the current transaction and regardless of the total 
number of items matching the transaction in the case will only count one. 

PBC - Number of primary blocks per case    
This routine finds the number of primary blocks on a case and will represent the numeric 
value.  The primary block will be based on the field Primary Block and the numeric value 
it contains. 

PBK - primary + additional blocks  
This routine finds the number of primary and the number of additional/regross blocks on 
a case and will represent the total numeric value of these two fields.  The primary block 
field will be based on the field Primary Block and the additional block field will be based 
on the Additional Block field. 

PRIOR - stat case priority   
This routine finds cases where the priority of the case is stat. 

PROC - Processing Only 
This routine finds cases marked for Processing Only.  The Processing Only shall be 
based on the specimen flag Processing Only and a true value contained within the field. 

QARES - QA rescreening done by Senior Cytotechnologist   
This routine finds cases where the rescreen was performed with the personnel type of 
"S". 
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REJCA - Rejected Cases 
This routine finds all cases that have been flagged as '”rejected” or “deactivated”. This 
routine will be used in the Billing Charge Transaction as an "Exclude All" type that will 
replace all previously calculated billing. 

RESTA - total number of restains 
This routine finds cases that contain restains and will count the total number per case.  
Restains will be based on the application of a stain after the initial stain has been 
applied. 

SC - number of specimens  
This routine finds all cases that contain specimens and count the total number of 
specimens per case. 

SEXM - Patient Sex Male 
The system provides the ability to find all cases where the patient sex has been 
identified as male. 

SEXF - Patient Sex Female 
The system provides the ability to find all cases where the patient sex has been 
identified as female. 

SEXU - Patient Sex Unknown 
The system provides the ability to find all cases where the patient sex has been 
identified as unknown. 

SOUSP - Number of Specimens Defined by User Source. 
This routine counts the number of specimens that are equal to the total number of 
related specimens on the case. 

SPEB5 - number of specimens with B5  
This routine finds cases that contain B5 blocks associated with sources and will count 
the B5 value once for each specimen occurence regardless of the number of B5 blocks 
on the specimen.  The B5 Block will be based on the B5 Block flag in block flags. 

SPEFS - Number of specimens with FS  
This routine finds cases with FS Blocks associated with sources and will count the FS 
value once for each specimen occurence regardless of the number of FS blocks on the 
specimen.  The FS Block will be based on the FS Block field. 

SPEPH - Number of specimens with photography 
This routine finds cases with specimens flagged for photography and will count the total 
number of photography flags for each specimen on the case.  The Photography value 
will be based on a true value in the Photography field in the source flags. 

SPERA - number of specimens with radiography 
This routine finds cases with specimens flagged for radiography and will count the total 
number of radiography flags for each specimen on the case.  The Radiography value will 
be based on a true value in the Radiography field in the source flags. 

SPERJ - Number of rejected specimens 
This routine finds cases with rejected specimens and count the total number of rejected 
specimens per case.  The rejection of the specimen will be based on the processing 
problem flag associated to the specimen and the code entered in the processing 
problem must be flagged for specimen rejection in the Processing Problem setup file. 
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SPETP - number of specimens with touch prep. 
This routine finds cases with specimens that have associated touch prep slides and will 
count the numeric value for all touch prep slides on all sources within the case.  The 
Touch Prep value will be based on the numeric value entered in the Touch Prep field. 

SPGR1 - number of specimens with source billing level 1  
This routine finds cases with specimens that have a defined billing level of 1 in the 
source setup file and will count the all sources on the case meeting this criteria. 

SPGR2 - number of specimens with source billing level 2  
This routine finds cases with specimens that have a defined billing level of 2 in the 
source setup file and will count the all sources on the case meeting this criteria. 

SPGR3 - number of specimens with source billing level 3  
This routine finds cases with specimens that have a defined billing level of 3 in the 
source setup file and will count the all sources on the case meeting this criteria. 

SPGR4 - number of specimens with source billing level 4  
This routine finds cases with specimens that have a defined billing level of 4 in the 
source setup file and will count the all sources on the case meeting this criteria. 

SPGR5 - number of specimens with source billing level 5  
This routine finds cases with specimens that have a defined billing level of 5 in the 
source setup file and will count the all sources on the case meeting this criteria. 

SPGR6 - number of specimens with source billing level 6  
This routine finds cases with specimens that have a defined billing level of 6 in the 
source setup file and will count the all sources on the case meeting this criteria. 

SPGR7 - number of specimens with source billing level 7  
This routine finds cases with specimens that have a defined billing level of 7 in the 
source setup file and will count the all sources on the case meeting this criteria. 

SRCSP - number of specimens with defined by user parent source   
This routine counts the number of specimens that are related with a parent child 
relationship and the value will be equal to the total number of related specimens on the 
case. 

SSLD - Total number of special stained slides per case  
This routine finds cases with slides that have a special stained applied and count the 
total number of these within each case.  A special stain will be recognized as a stain that 
is not defined as the standard stain for the respective case type. 

TAGA - Tag letter equal to A    
This routine counts all block tag letters equal to A and give the total. 

TAGB - Tag letter equal to B    
This routine counts all block tag letters equal to B and give the total. 

TBLA1 - number of blocks with tests from group 1 A applied   
This routine captures the total number of blocks that have an associated test that has 
been defined as Billing Level I in the Technical Billing Group field in the stain/test setup 
file. 

TBLA2 - number of blocks with tests from group 2 A applied   
This routine captures the total number of blocks that have an associated test that has 
been defined as Billing Level II in the Technical Billing Group field in the stain/test setup 
file. 
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TBLA3 - number of blocks with tests from group 3 A applied   
This routine captures the total number of blocks that have an associated test that has 
been defined as Billing Level III in the Technical Billing Group field in the stain/test setup 
file. 

TBLA4 - number of blocks with tests from group 4 A applied   
This routine captures the total number of blocks that have an associated test that has 
been defined as Billing Level IV in the Technical Billing Group field in the stain/test setup 
file. 

TBLA5 - number of blocks with tests from group 5 A applied   
This routine captures the total number of blocks that have an associated test that has 
been defined as Billing Level V in the Technical Billing Group field in the stain/test setup 
file. 

TBLA6 - number of blocks with tests from group 6 A applied   
This routine captures the total number of blocks that have an associated test that has 
been defined as Billing Level VI in the Technical Billing Group field in the stain/test setup 
file. 

TBLA7 - number of blocks with tests from group 7 A applied   
This routine captures the total number of blocks that have an associated test that has 
been defined as Billing Level VII in the Technical Billing Group field in the stain/test 
setup file. 

TBLA8 - number of blocks with tests from group 8 A applied   
This routine captures the total number of blocks that have an associated test that has 
been defined as Billing Level VIII in the Technical Billing Group field in the stain/test 
setup file. 

TBLA9 - number of blocks with tests from group 9 A applied   
This routine captures the total number of blocks that have an associated test that has 
been defined as Billing Level IX in the Technical Billing Group field in the stain/test setup 
file. 

TBLB1 - number of blocks with tests from group 1 B applied   
This routine captures the total number of blocks that have an associated test that has 
been defined as Billing Level I in the Professional Billing Group field in the stain/test 
setup file. 

TBLB2 - number of blocks with tests from group 2 B applied   
This routine captures the total number of blocks that have an associated test that has 
been defined as Billing Level II in the Professional Billing Group field in the stain/test 
setup file. 

TBLB3 - number of blocks with tests from group 3 B applied   
This routine captures the total number of blocks that have an associated test that has 
been defined as Billing Level III in the Professional Billing Group field in the stain/test 
setup file. 

TBLB4 - number of blocks with tests from group 4 B applied   
This routine captures the total number of blocks that have an associated test that has 
been defined as Billing Level IV in the Professional Billing Group field in the stain/test 
setup file. 
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TBLB5 - number of blocks with tests from group 5 B applied   
This routine captures the total number of blocks that have an associated test that has 
been defined as Billing Level V in the Professional Billing Group field in the stain/test 
setup file. 

TBLB6 - number of blocks with tests from group 6 B applied   
This routine captures the total number of blocks that have an associated test that has 
been defined as Billing Level VI in the Professional Billing Group field in the stain/test 
setup file. 

TBLB7 - number of blocks with tests from group 7 B applied   
This routine captures the total number of blocks that have an associated test that has 
been defined as Billing Level VII in the Professional Billing Group field in the stain/test 
setup file. 

TBLB8 - number of blocks with tests from group 8 B applied   
This routine capture the total number of blocks that have an associated test that has 
been defined as Billing Level VIII in the Professional Billing Group field in the stain/test 
setup file. 

TBLB9 - number of blocks with tests from group 9 B applied   
This routine captures the total number of blocks that have an associated test that has 
been defined as Billing Level IX in the Professional Billing Group field in the stain/test 
setup file. 

TBNum - number of blocks to which particular test was applied    
This routine captures the total number of blocks per case that have an associated test 
that is defined in the transaction table in the Test ID field.  This routine represent the total 
number of times the entered test was applied to all blocks for the case. 

TNCYT - smear slides + cytocentrifuges + membrane filters    
This routine captures the total number of smear slides, cytocentrifuges, and membrane 
filters on the case.  The total of all three types of slides will be the value represented by 
the routine.  The Smear Slides may be entered in the system in the field Smear Slides.  
The Cytocentrifuges may be entered in the system in the field Cytocentrifuges.  The 
Membrane Filters may be entered in the system in the field Membrane Filters. 

TNum - number of times that particular test was applied 
This routine captures the total number of times a particular test was applied on the case.  
This routine will be used in conjunction with the Test ID field in the transaction table.  
The Test will be captured in the system when it associated with the specimen/block. 

TSCYT - smr slides+cytocentrifuges+membrane filters+cell blocks  
This routine captures the total number of smear slides, cytocentrifuges, membrane 
filters, and cell blocks on the case.  The total of all four items will be the value 
represented by the routine.  The Smear Slides may be entered in the system in the field 
Smear Slides.  The Cytocentrifuges may be entered in the system in the field 
Cytocentrifuges.  The Membrane Filters may be entered in the system in the field 
Membrane Filters.  The Cell Blocks may be entered in the system in the field Cell Block. 

TT1A1 - # of tests from group 1 A applied once per case  
This routine captures the total number of tests for the case that have been defined as 
Billing Level I in the Technical Billing Group field in the stain/test setup file. 

TT1A2 - # of tests from group 2 A applied once per case  
This routine captures the total number of tests for the case that have been defined as 
Billing Level II in the Technical Billing Group field in the stain/test setup file. 
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TT1A3 - # of tests from group 3 A applied once per case  
This routine captures the total number of tests for the case that have been defined as 
Billing Level III in the Technical Billing Group field in the stain/test setup file. 

TT1A4 - # of tests from group 4 A applied once per case  
This routine captures the total number of tests for the case that have been defined as 
Billing Level IV in the Technical Billing Group field in the stain/test setup file. 

TT1A5 - # of tests from group 5 A applied once per case  
This routine captures the total number of tests for the case that have been defined as 
Billing Level V in the Technical Billing Group field in the stain/test setup file. 

TT1A6 - # of tests from group 6 A applied once per case  
This routine captures the total number of tests for the case that have been defined as 
Billing Level VI in the Technical Billing Group field in the stain/test setup file. 

TT1A7 - # of tests from group 7 A applied once per case  
This routine captures the total number of tests for the case that have been defined as 
Billing Level VII in the Technical Billing Group field in the stain/test setup file. 

TT1A8 - # of tests from group 8 A applied once per case  
This routine captures the total number of tests for the case that have been defined as 
Billing Level VIII in the Technical Billing Group field in the stain/test setup file. 

TT1A9 - # of tests from group 9 A applied once per case  
This routine captures the total number of tests for the case that have been defined as 
Billing Level IX in the Technical Billing Group field in the stain/test setup file. 

TT1B1 - # of tests from group 1 B applied once per case  
This routine captures the total number of tests for the case that have been defined as 
Billing Level I in the Professional Billing Group field in the stain/test setup file. 

TT1B2 - # of tests from group 2 B applied once per case  
This routine captures the total number of tests for the case that have been defined as 
Billing Level II in the Professional Billing Group field in the stain/test setup file 

TT1B3 - # of tests from group 3 B applied once per case  
This routine captures the total number of tests for the case that have been defined as 
Billing Level III in the Professional Billing Group field in the stain/test setup file. 

TT1B4 - # of tests from group 4 B applied once per case  
This routine captures the total number of tests for the case that have been defined as 
Billing Level IV in the Professional Billing Group field in the stain/test setup file. 

TT1B5 - # of tests from group 5 B applied once per case  
This routine captures the total number of tests for the case that have been defined as 
Billing Level V in the Professional Billing Group field in the stain/test setup file. 

TT1B6 - # of tests from group 6 B applied once per case  
This routine captures the total number of tests for the case that have been defined as 
Billing Level VI in the Professional Billing Group field in the stain/test setup file. 

TT1B7 - # of tests from group 7 B applied once per case  
This routine captures the total number of tests for the case that have been defined as 
Billing Level VII in the Professional Billing Group field in the stain/test setup file. 



Appendix E – Available Billing Routines SoftPath v.4.2.1 User Manual 

Page E-10  PATH4.2-G-U (6th Ed, Rel. 1/31/07) 

TT1B8 - # of tests from group 8 B applied once per case  
This routine captures the total number of tests for the case that have been defined as 
Billing Level VIII in the Professional Billing Group field in the stain/test setup file. 

TT1B9 - # of tests from group 9 B applied once per case  
This routine captures the total number of tests for the case that have been defined as 
Billing Level IX in the Professional Billing Group field in the stain/test setup file. 

TT2A1 - # of tests from group 1 A applied twice per case 
This routine captures the total number of tests applied twice for the case that have been 
defined as Billing Level I in the Technical Billing Group field in the stain/test setup file. 

TT2A2 - # of tests from group 2 A applied twice per case 
This routine captures the total number of tests applied twice for the case that have been 
defined as Billing Level II in the Technical Billing Group field in the stain/test setup file. 

TT2A3 - # of tests from group 3 A applied twice per case 
This routine captures the total number of tests applied twice for the case that have been 
defined as Billing Level III in the Technical Billing Group field in the stain/test setup file. 

TT2A4 - # of tests from group 4 A applied twice per case 
This routine captures the total number of tests applied twice for the case that have been 
defined as Billing Level IV in the Technical Billing Group field in the stain/test setup file. 

TT2A5 - # of tests from group 5 A applied twice per case 
This routine captures the total number of tests applied twice for the case that have been 
defined as Billing Level V in the Technical Billing Group field in the stain/test setup file. 

TT2A6 - # of tests from group 6 A applied twice per case 
This routine captures the total number of tests applied twice for the case that have been 
defined as Billing Level VI in the Technical Billing Group field in the stain/test setup file. 

TT2A7 - # of tests from group 7 A applied twice per case 
This routine captures the total number of tests applied twice for the case that have been 
defined as Billing Level VII in the Technical Billing Group field in the stain/test setup file. 

TT2A8 - # of tests from group 8 A applied twice per case 
This routine captures the total number of tests applied twice for the case that have been 
defined as Billing Level VIII in the Technical Billing Group field in the stain/test setup file. 

TT2A9 - # of tests from group 9 A applied twice per case 
This routine captures the total number of tests applied twice for the case that have been 
defined as Billing Level IX in the Technical Billing Group field in the stain/test setup file. 

TT2B1 - # of tests from group 1 B applied twice per case 
This routine captures the total number of tests applied twice for the case that have been 
defined as Billing Level I in the Professional Billing Group field in the stain/test setup file. 

TT2B2 - # of tests from group 2 B applied twice per case 
This routine captures the total number of tests applied twice for the case that have been 
defined as Billing Level II in the Professional Billing Group field in the stain/test setup file. 

TT2B3 - # of tests from group 3 B applied twice per case 
This routine captures the total number of tests applied twice for the case that have been 
defined as Billing Level III in the Professional Billing Group field in the stain/test setup 
file. 
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TT2B4 - # of tests from group 4 B applied twice per case 
This routine captures the total number of tests applied twice for the case that have been 
defined as Billing Level IV in the Professional Billing Group field in the stain/test setup 
file. 

TT2B5 - # of tests from group 5 B applied twice per case 
This routine captures the total number of tests applied twice for the case that have been 
defined as Billing Level V in the Professional Billing Group field in the stain/test setup 
file. 

TT2B6 - # of tests from group 6 B applied twice per case 
This routine captures the total number of tests applied twice for the case that have been 
defined as Billing Level VI in the Professional Billing Group field in the stain/test setup 
file. 

TT2B7 - # of tests from group 7 B applied twice per case 
This routine captures the total number of tests applied twice for the case that have been 
defined as Billing Level VII in the Professional Billing Group field in the stain/test setup 
file. 

TT2B8 - # of tests from group 8 B applied twice per case 
This routine captures the total number of tests applied twice for the case that have been 
defined as Billing Level VIII in the Professional Billing Group field in the stain/test setup 
file. 

TT2B9 - # of tests from group 9 B applied twice per case 
This routine captures the total number of tests applied twice for the case that have been 
defined as Billing Level IX in the Professional Billing Group field in the stain/test setup 
file. 

TT3A1 - # of tests from group 1 A applied 3 times per case   
This routine captures the total number of tests applied three times for the case that have 
been defined as Billing Level I in the Technical Billing Group field in the stain/test setup 
file. 

TT3A2 - # of tests from group 2 A applied 3 times per case   
This routine captures the total number of tests applied three times for the case that have 
been defined as Billing Level II in the Technical Billing Group field in the stain/test setup 
file. 

TT3A3 - # of tests from group 3 A applied 3 times per case   
This routine captures the total number of tests applied three times for the case that have 
been defined as Billing Level III in the Technical Billing Group field in the stain/test setup 
file. 

TT3A4 - # of tests from group 4 A applied 3 times per case   
This routine captures the total number of tests applied three times for the case that have 
been defined as Billing Level IV in the Technical Billing Group field in the stain/test setup 
file. 

TT3A5 - # of tests from group 5 A applied 3 times per case   
This routine captures the total number of tests applied three times for the case that have 
been defined as Billing Level V in the Technical Billing Group field in the stain/test setup 
file. 
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TT3A6 - # of tests from group 6 A applied 3 times per case   
This routine captures the total number of tests applied three times for the case that have 
been defined as Billing Level VI in the Technical Billing Group field in the stain/test setup 
file. 

TT3A7 - # of tests from group 7 A applied 3 times per case   
This routine captures the total number of tests applied three times for the case that have 
been defined as Billing Level VII in the Technical Billing Group field in the stain/test 
setup file. 

TT3A8 - # of tests from group 8 A applied 3 times per case   
This routine captures the total number of tests applied three times for the case that have 
been defined as Billing Level VIII in the Technical Billing Group field in the stain/test 
setup file. 

TT3A9 - # of tests from group 9 A applied 3 times per case   
This routine captures the total number of tests applied three times for the case that have 
been defined as Billing Level IX in the Technical Billing Group field in the stain/test setup 
file. 

TT3B1 - # of tests from group 1 B applied 3 times per case   
This routine captures the total number of tests applied three times for the case that have 
been defined as Billing Level I in the Professional Billing Group field in the stain/test 
setup file. 

TT3B2 - # of tests from group 2 B applied 3 times per case   
This routine captures the total number of tests applied three times for the case that have 
been defined as Billing Level II in the Professional Billing Group field in the stain/test 
setup file. 

TT3B3 - # of tests from group 3 B applied 3 times per case   
This routine captures the total number of tests applied three times for the case that have 
been defined as Billing Level III in the Professional Billing Group field in the stain/test 
setup file. 

TT3B4 - # of tests from group 4 B applied 3 times per case   
This routine captures the total number of tests applied three times for the case that have 
been defined as Billing Level IV in the Professional Billing Group field in the stain/test 
setup file. 

TT3B5 - # of tests from group 5 B applied 3 times per case   
This routine captures the total number of tests applied three times for the case that have 
been defined as Billing Level V in the Professional Billing Group field in the stain/test 
setup file. 

TT3B6 - # of tests from group 6 B applied 3 times per case   
This routine captures the total number of tests applied three times for the case that have 
been defined as Billing Level VI in the Professional Billing Group field in the stain/test 
setup file. 

TT3B7 - # of tests from group 7 B applied 3 times per case   
This routine captures the total number of tests applied three times for the case that have 
been defined as Billing Level VII in the Professional Billing Group field in the stain/test 
setup file. 
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TT3B8 - # of tests from group 8 B applied 3 times per case   
This routine captures the total number of tests applied three times for the case that have 
been defined as Billing Level VIII in the Professional Billing Group field in the stain/test 
setup file. 

TT3B9 - # of tests from group 9 B applied 3 times per case   
This routine captures the total number of tests applied three times for the case that have 
been defined as Billing Level IX in the Professional Billing Group field in the stain/test 
setup file. 

TT4A1 - #of tests from group 1A applied 4 times & more per case  
This routine captures the total number of tests applied four or more times for the case 
that have been defined as Billing Level I in the Technical Billing Group field in the 
stain/test setup file. 

TT4A2 - #of tests from group 2A applied 4 times & more per case  
This routine captures the total number of tests applied four or more times for the case 
that have been defined as Billing Level II in the Technical Billing Group field in the 
stain/test setup file. 

TT4A3 - #of tests from group 3A applied 4 times & more per case  
This routine captures the total number of tests applied four or more times for the case 
that have been defined as Billing Level III in the Technical Billing Group field in the 
stain/test setup file. 

TT4A4 - #of tests from group 4A applied 4 times & more per case  
This routine captures the total number of tests applied four or more times for the case 
that have been defined as Billing Level IV in the Technical Billing Group field in the 
stain/test setup file. 

TT4A5 - #of tests from group 5A applied 4 times & more per case  
This routine captures the total number of tests applied four or more times for the case 
that have been defined as Billing Level V in the Technical Billing Group field in the 
stain/test setup file. 

TT4A6 - #of tests from group 6A applied 4 times & more per case  
This routine captures the total number of tests applied four or more times for the case 
that have been defined as Billing Level VI in the Technical Billing Group field in the 
stain/test setup file. 

TT4A7 - #of tests from group 7A applied 4 times & more per case  
This routine captures the total number of tests applied four or more times for the case 
that have been defined as Billing Level VII in the Technical Billing Group field in the 
stain/test setup file. 

TT4A8 - #of tests from group 8A applied 4 times & more per case  
This routine captures the total number of tests applied four or more times for the case 
that have been defined as Billing Level VIII in the Technical Billing Group field in the 
stain/test setup file. 

TT4A9 - #of tests from group 9A applied 4 times & more per case  
This routine captures the total number of tests applied four or more times for the case 
that have been defined as Billing Level IX in the Technical Billing Group field in the 
stain/test setup file. 
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TT4B1 - #of tests from group 1B applied 4 times & more per case  
This routine captures the total number of tests applied four or more times for the case 
that have been defined as Billing Level I in the Professional Billing Group field in the 
stain/test setup file. 

TT4B2 - #of tests from group 2B applied 4 times & more per case  
This routine captures the total number of tests applied four or more times for the case 
that have been defined as Billing Level II in the Professional Billing Group field in the 
stain/test setup file. 

TT4B3 - #of tests from group 3B applied 4 times & more per case  
This routine captures the total number of tests applied four or more times for the case 
that have been defined as Billing Level III in the Professional Billing Group field in the 
stain/test setup file. 

TT4B4 - #of tests from group 4B applied 4 times & more per case  
This routine captures the total number of tests applied four or more times for the case 
that have been defined as Billing Level IV in the Professional Billing Group field in the 
stain/test setup file. 

TT4B5 - #of tests from group 5B applied 4 times & more per case  
This routine captures the total number of tests applied four or more times for the case 
that have been defined as Billing Level V in the Professional Billing Group field in the 
stain/test setup file. 

TT4B6 - #of tests from group 6B applied 4 times & more per case  
This routine captures the total number of tests applied four or more times for the case 
that have been defined as Billing Level VI in the Professional Billing Group field in the 
stain/test setup file. 

TT4B7 - #of tests from group 7B applied 4 times & more per case  
This routine captures the total number of tests applied four or more times for the case 
that have been defined as Billing Level VII in the Professional Billing Group field in the 
stain/test setup file. 

TT4B8 - #of tests from group 8B applied 4 times & more per case  
This routine captures the total number of tests applied four or more times for the case 
that have been defined as Billing Level VIII in the Professional Billing Group field in the 
stain/test setup file. 

TT4B9 - #of tests from group 9B applied 4 times & more per case  
This routine captures the total number of tests applied four or more times for the case 
that have been defined as Billing Level IX in the Professional Billing Group field in the 
stain/test setup file. 

TTNA1 - # of tests from group 1 A applied to the case    
This routine captures the total number of tests applied for the case that have been 
defined as Billing Level I in the Technical Billing Group field in the stain/test setup file. 

TTNA2 - # of tests from group 2 A applied to the case    
This routine captures the total number of tests applied for the case that have been 
defined as Billing Level II in the Technical Billing Group field in the stain/test setup file. 

TTNA3 - # of tests from group 3 A applied to the case    
This routine captures the total number of tests applied for the case that have been 
defined as Billing Level III in the Technical Billing Group field in the stain/test setup file. 
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TTNA4 - # of tests from group 4 A applied to the case    
This routine captures the total number of tests applied for the case that have been 
defined as Billing Level IV in the Technical Billing Group field in the stain/test setup file. 

TTNA5 - # of tests from group 5 A applied to the case    
This routine captures the total number of tests applied for the case that have been 
defined as Billing Level V in the Technical Billing Group field in the stain/test setup file. 

TTNA6 - # of tests from group 6 A applied to the case    
This routine captures the total number of tests applied for the case that have been 
defined as Billing Level VI in the Technical Billing Group field in the stain/test setup file. 

TTNA7 - # of tests from group 7 A applied to the case    
This routine captures the total number of tests applied for the case that have been 
defined as Billing Level VII in the Technical Billing Group field in the stain/test setup file. 

TTNA8 - # of tests from group 8 A applied to the case    
This routine captures the total number of tests applied for the case that have been 
defined as Billing Level VIII in the Technical Billing Group field in the stain/test setup file. 

TTNA9 - # of tests from group 9 A applied to the case    
This routine captures the total number of tests applied for the case that have been 
defined as Billing Level IX in the Technical Billing Group field in the stain/test setup file. 

TTNB1 - # of tests from group 1 B applied to the case    
This routine captures the total number of tests applied for the case that have been 
defined as Billing Level I in the Professional Billing Group field in the stain/test setup file. 

TTNB2 - # of tests from group 2 B applied to the case    
This routine captures the total number of tests applied for the case that have been 
defined as Billing Level II in the Professional Billing Group field in the stain/test setup file. 

TTNB3 - # of tests from group 3 B applied to the case    
This routine captures the total number of tests applied for the case that have been 
defined as Billing Level III in the Professional Billing Group field in the stain/test setup 
file. 

TTNB4 - # of tests from group 4 B applied to the case    
This routine captures the total number of tests applied for the case that have been 
defined as Billing Level IV in the Professional Billing Group field in the stain/test setup 
file. 

TTNB5 - # of tests from group 5 B applied to the case    
This routine captures the total number of tests applied for the case that have been 
defined as Billing Level V in the Professional Billing Group field in the stain/test setup 
file. 

TTNB6 - # of tests from group 6 B applied to the case    
This routine captures the total number of tests applied for the case that have been 
defined as Billing Level VI in the Professional Billing Group field in the stain/test setup 
file. 

TTNB7 - # of tests from group 7 B applied to the case    
This routine captures the total number of tests applied for the case that have been 
defined as Billing Level VII in the Professional Billing Group field in the stain/test setup 
file. 
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TTNB8 - # of tests from group 8 B applied to the case    
This routine captures the total number of tests applied for the case that have been 
defined as Billing Level VIII in the Professional Billing Group field in the stain/test setup 
file. 

TTNB9 - # of tests from group 9 B applied to the case    
This routine captures the total number of tests applied for the case that have been 
defined as Billing Level IX in the Professional Billing Group field in the stain/test setup 
file. 

TTYA1 - # of types of tests from group 1 A applied to the case   
This routine captures the type of test (not tests) from group 1A and give the total value. 

TTYA2 - # of types of tests from group 2 A applied to the case   
This routine captures the type of test (not tests) from group 2A and give the total value. 

TTYA3 - # of types of tests from group 3 A applied to the case   
This routine captures the type of test (not tests) from group 3A and give the total value. 

TTYA4 - # of types of tests from group 4 A applied to the case   
This routine captures the type of test (not tests) from group 4A and give the total value. 

TTYA5 - # of types of tests from group 5 A applied to the case   
This routine captures the type of test (not tests) from group 5A and give the total value. 

TTYA6 - # of types of tests from group 6 A applied to the case   
This routine captures the type of test (not tests) from group 6A and give the total value. 

TTYA7 - # of types of tests from group 7 A applied to the case   
This routine captures the type of test (not tests) from group 7A and give the total value. 

TTYA8 - # of types of tests from group 8 A applied to the case   
This routine captures the type of test (not tests) from group 8A and give the total value. 

TTYA9 - # of types of tests from group 9 A applied to the case   
This routine captures the type of test (not tests) from group 9A and give the total value. 

TTYB1 - # of types of tests from group 1 B applied to the case   
This routine captures the type of test (not tests) from group 1B and give the total value. 

TTYB2 - # of types of tests from group 2 B applied to the case   
This routine captures the type of test (not tests) from group 2B and give the total value. 

TTYB3 - # of types of tests from group 3 B applied to the case   
This routine captures the type of test (not tests) from group 3B and give the total value. 

TTYB4 - # of types of tests from group 4 B applied to the case   
This routine captures the type of test (not tests) from group 4B and give the total value. 

TTYB5 - # of types of tests from group 5 B applied to the case   
This routine captures the type of test (not tests) from group 5B and give the total value. 

TTYB6 - # of types of tests from group 6 B applied to the case   
This routine captures the type of test (not tests) from group 6B and give the total value. 

TTYB7 - # of types of tests from group 7 B applied to the case   
This routine captures the type of test (not tests) from group 7B and give the total value. 
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TTYB8 - # of types of tests from group 8 B applied to the case   
This routine captures the type of test (not tests) from group 8B and give the total value. 

TTYB9 - # of types of tests from group 9 B applied to the case   
This routine captures the type of test (not tests) from group 9B and give the total value. 
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Appendix F –Synoptic Reporting 

To access Synoptic Reports Setup, double-click the Synoptic Reports Setup icon from your desktop. 
The Synoptic Reports Setup window (Figure F-1) is displayed.  
NOTE: Synoptic Reporting must be selected from Custom installation on the SoftPath 

installation disk. 

 
Figure F-1. Synoptic Reports Setup Window 

The Synoptic Reports Setup module contains the following setup options: 
• CDE (Common Data Elements) Setup 
• Fragments Setup 
• Sections Setup 
• Protocols Setup 

For further information on use and setup of synoptic functionality within the SoftPath application, 
see SoftPath Synoptic Functionality. 
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CDE (Common Data Elements) Setup 
The basic element of Synoptic Reporting is the CDE (Common Data Element), which is used to 
define fragments.  
To access the Common Data Elements Setup window (Figure F-2), click the CDE button or select 
File > CDE Setup from the Synoptic Reports Setup window (Figure F-1). 

 
Figure F-2. Common Data Elements Setup Window 

The common data elements are the root items of the tree and will display as the descriptor within the 
MS Word template in SoftPath.  
The child items within the CDEs are the choice that will be available for selection and inclusion in 
the MS Word document.  Each child may have sub-choices, which are presented as nested items. 
Only the child items insert into the final report document; the name of the item does not insert into 
the document. If more than one sub-choice is selected, a comma is placed between each selection. 

Function Buttons 

 

Add Item Adds a new common data element at the end of the existing tree. 

 

Add Sub Adds a choice (sub-item) to the highlighted data element or a sub-
choice to a highlighted choice. 

 

Del Item Delete the currently selected data element.  
NOTE: When deleting a data element with choices (or a choice 

that has sub-choices), all sub-items are also deleted. 

 

Edit Item Allows you to change the name of the highlighted item or sub-item. 
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From Clip Allow you to insert common data elements and sub-items from an 
outside source.  
NOTE: Items to be inserted should already be available on the 

clipboard. 

 

Save Saves any changes. 
NOTE: Always make sure to save when you have made 

changes. 

Fields 
Format of 
Child Items 

Select one of the following formats for which child items will be imported 
into the MS Word document (in SoftPath): 

• line wrap 
• new line  
• bulleted list  

Item Comment With an item or sub-item highlighted, enter a comment, which will be 
displayed as a tool tip in the SoftPath report or on the status bar when a user 
manually adds a CDE to a report. 

SNOMED Define the SNOMED code to be captured for this common data element of 
sub-item when selected in the Final Report template. This many be entered 
using keyboard entry or lookup from the SNOMED dictionary using the 
provided ellipsis button. 

Class Define the SNOMED class, if applicable. The adjoining description field 
displays the description of the selected SNOMED code in read only mode 
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Fragments Setup 
A fragment is the part of the document defined with MS Word, which is inserted into and used to 
compose a SoftPath Final Report document. Fragments can be assembled into Protocols to default 
to a specimen source or can be inserted manually into the final report document. 
To set up fragments, click the Fragments button or select File > Fragments Setup from the Synoptic 
Reports Setup window (Figure F-1). The Select Fragment… window (Figure F-3) displays, which 
contains a list of existing fragments. Either select an existing fragment and click the OK button or 
click the Add New button to add a new fragment. 
NOTE: Any formatting of the fragment must be done in Fragment Setup. 

 
Figure F-3. Select Fragment… Window 

Status From the drop-down list, select one of the following fragment statuses for display in 
the Select Fragment… window: 

• Inactive – displays inactive fragments. 
• Active – displays all active fragments. 
• All – displays all fragments.  

NOTE: Click the Find button to update the list with your selection. 

Find Click the Find button to search for fragments based on the Status drop down list.  

Add New Click the Add New button to add a new fragment.  
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Selecting an Existing Fragment 
When you select an existing fragment, the Synoptic Reports Setup window is displayed in 
the MS Word Synoptic template with defined fields. 

 
Figure F-4. Synoptic Reports Setup Window (Existing Fragment) 

Adding a New Fragment 
When you select the Add New button, a blank MS Word document is displayed for the 
creation of the fragment template. 

 
Figure F-5. Synoptic Reports Setup Window (New Fragment) 
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Synoptic Reports Setup Window – Fragment Fields 

 
Figure F-6. Synoptic Reports Setup Window – Fragment Fields 

Fragment Name For each fragment, enter a name to identify the fragment. Because this field is 
used for identification purposes, each name must be unique 
NOTE: Fragment names cannot contain spaces or special characters.  

CDE Items To 
Insert 

Select a CDE item to insert from the drop down list. This drop down list 
contains all CDEs that have been defined in the Common Data Element 
Setup. Once your cursor is in the desired place in the template, click the 
Insert button to insert the CDE into the Fragment. 
NOTE: CDEs display as descriptors in the template. Titles do not insert 

from the Common Data Element Setup and must be typed into 
the Synoptic template.  

Defaults Name Default choices can be defined for each fragment or CDE.  The default can be 
incorporated into a Synoptic protocol or selected when the fragment is 
imported into the final report. 
Click the New button from the Defaults Name field. The Add New Set 
window  is displayed; enter a name for the new default setting and click OK. 

 
Figure F-7. Add New Set Window 

To define the default selections for the fragment, , place the mouse pointer on 
the CDE and click the left mouse button. Select the items or sub-items to be 
marked by default; click OK to save the selections. Click the Save button to 
save the selections under the new default name. 

Specimen 
Specific 

Mark this check box if the fragment should be inserted separately into the 
document for each specimen registered for the case. If the check box is not 
marked, the fragment will only be inserted once into the document 
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Fields to Insert If the fragment is Specimen Specific, specimen identification fields, which act 
as merge codes and will insert data from the set up dictionaries, can be 
inserted: 

• Source Code 
• Source Name 
• Collection Method Name 
• Modifier 
• Body Site Name 

The Specimen Specific check box cannot be deselected for a fragment that 
contains specimen identification fields. 

Section Define the document section, which is defined in the Section Setup, that the 
fragment will be inserted into with SoftPath 
NOTE: Fragments will only be available for insertion into the defined 

document section. 

Active Select this check box to mark the fragment as active. Likewise, deselect this 
check box to deactivate this fragment. 
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Section Setup 
You can define Synoptic Section, which specifies where the Synoptic fragment will be used in the 
SoftPath Final Report document. Sections are available for selection in Fragments Setup. 
To set up sections, click the Sections button or select File > Sections Setup from the Synoptic 
Reports Setup window (Figure F-1). The Select Section… window (Figure F-8) displays with a list 
of existing sections. Either select an existing section and click the OK button or click the Add New 
button to display the Sections Setup window (Figure F-9) for adding a new section.  
 

 
Figure F-8. Select Section… Window 
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Sections Setup Window – Fields 

 
Figure F-9. Section Setup Window 

Section Name Enter a section name, which will display for selection in the Fragments setup 
file. All Section names must be unique. 

SoftPath Section If the section is to be defined as a SoftPath section, select the SoftPath 
document section into which the Fragment will be inserted.  
NOTE: You must select a document section if this radio button is marked.

If the section is to be defined as a Custom Section, use the following options 
to specify the section in the report where the synoptic report will be inserted:  

Phrase Enter keywords that will be used to find the desired section 
in the document.  
NOTE: The phrase must be defined in the report 

template in order for the protocol to insert into 
the report. 

Distinguisher Specify if the system will look for words or a bookmark in 
the document. 

Custom Section 

Placement Specify if the section will be placed before or after the 
define phrase. 
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Protocols Setup 
Based on the Fragments setup, you can define protocols that contain multiple Fragments.  Only 
Protocols can be defaulted to a Source for automatic insertion into a report document. 
To set up protocols, click the Protocols button or select File > Protocols Setup from the Synoptic 
Reports Setup window (Figure F-1). The Select Protocol… window (Figure F-10) displays with a 
list of existing protocols. Either select an existing protocol and click the OK button or click the Add 
New button to display the Protocols Setup window (Figure F-11) for adding a new section.  

 
Figure F-10. Select Protocol… Window 
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Protocols Setup Window – Fields  

 
Figure F-11. Protocol Setup Window 

Protocol Code Enter a unique code to identify the Protocol 

Active Select this check box to mark the protocol as active. Likewise, deselect this 
check box to inactivate the protocol. 

Protocol Name Enter a unique name to identify the Protocol 

Select the Fragments to include in the defined Protocol.  

# Displays the number of the fragment on the grid. 

Fragment Click the Fragment column to display a drop down menu, which 
contains a list of defined Fragments. 
NOTE: If a Protocol contains both specimen specific and 

non-specimen specific fragments, the specimen 
specific fragment will insert into the template for 
each occurrence of the specimen and the non-
specimen specific fragment will only insert for the 
first occurrence of the specimen. 

Fragments 
(grid) 

Defaults Click the Defaults column to display a drop down menu, which 
contains a list of defined Defaults for the selected Protocol.  
NOTE: By default the “Generic” set of defaults will be 

imported into the grid. 

Add Click the Add button to add a new row to the Fragments grid 

Del To delete a fragments from the Protocol, highlight the Fragment and click the 
Del button 

Up/Down If multiple Fragments are defined for the Protocol, use the Up/Down buttons to 
define the order of their appearance. 
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Protocol Toolbar Buttons 

 
New Click this button to add a new protocol. 

 

Open Click this button to open an existing protocol. 

 

Refresh Click this button to refresh the Protocol Setup window. 
NOTE: If you have not saved your changes before clicking this button, 

your unsaved changes will be lost. 

 

Delete Click this button to delete the currently opened Protocol. 

 

Save Click this button to save changes to the currently opened Protocol. 

 

Edit Click this button to edit the currently displayed Protocol. 

 

Clear Click this button to clear any changes to the currently opened Protocol. 
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SoftPath Synoptic Functionality 

This section describes how to use the synoptic functionality in the SoftPath application. The 
following items are explained in this section: 

• Setup 
 Source Setup 
 Synoptic Reporting Tab 

• Use 
 Result Entry 
 Synoptic Query 
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Setup 

Source Setup 
To access the Source Setup, select Setup > Setup Files > Source from the SoftPath main menu. The 
Source Codes Browser is displayed with a list of existing Source codes in the system; Select an 
existing code or click the Add Record button to add a new source. The Source Setup window 
(Figure F-12) is displayed. 

 
Figure F-12. Source Setup Window 

In the Source Setup file, a Synoptic Protocol can be assigned to a source code.  When assigned the 
system will import the defined Protocol into the Final Report template for cases accessioned with 
that Source. 
Synoptic Protocol 

Enter the Protocol to be associated with the displayed Source code. This may be done using 
manual entry or by clicking the browser button, which will display a list of available 
Protocols for selection. 
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Synoptic Reporting Tab 
To activate the Synoptic Reporting functionality, select Setup > Options > System Settings Tab> 
Synoptic Reporting tab from the SoftPath Main Menu. The Synoptic Reporting tab (Figure F-13) is 
displayed. 

 
Figure F-13. Options Window – System Settings Tab - Synoptic Reporting Tab 

Case Types Available for Synoptic Reporting 
These check boxes allow you to define for which case types synoptic reporting functionality 
will be made available. 

Case Types to Auto-Insert SNOMED Codes from Synoptic Setup 
These check boxes allow you to define for which case types SNOMED codes will 
automatically be captured from the Synoptic Fragment setup based on the fragments selected 
in the report. 
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Use 

This section describes the main SoftPath uses for the synoptic reporting functionality. 

Results Entry 
When the Results Entry grid displays for a case for which Synoptic Reporting is available, the 
Synoptic Reports check box will display as active (Figure F-14).  
NOTE: If a Synoptic Protocol has been assigned to the specimen source and you do not wish to 

use it for a particular case, deselect the Synoptic Reports check box. 

 
Figure F-14. Select Report Window – Results Tab (Synoptic Reporting Check Box Marked) 

Select a report, and click the Word Editor button. The report template is opened in MS Word, and if 
a Synoptic Protocol is assigned to the specimen source in the Source file, it will display in the correct 
report section. 
NOTE:  At this time, Synoptic Reporting is only available with MS Word. 
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Figure F-15. Final Report (Synoptic Fragment Inserted) 

To enter data, click on the yellow synoptic entry box; a Synoptic checklist will display.  

 
Figure F-16. Final Report (Synoptic Checklist) 

Make your selections, and then click the OK button.  Your selections (Figure F-17) will appear in 
the report. 
NOTE: When selecting an item that has nested subchoices, all subchoices are selected by 

default. 
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Figure F-17. Final Report (Selections) 

Results Entry –Toolbar Buttons  

 Insert Fragment Click this button to insert a synoptic fragment in the current cursor 
position in the document. The Fragments to Insert window is 
displayed with available fragments; select a fragment and click OK. 

 
Figure F-18. Fragments To Insert Window 

 Delete Fragment Click this button to delete the currently selected fragment from the 
report. 

 Fragment Defaults Click this button to apply the default entries, as defined in he 
Synoptic Reporting Setup utility, to the selected fragment. 
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Completion Windows – Synoptic Dx button 
All save completion windows throughout SoftPath, including those for QA procedures and 
Sign Out, now include a Synoptic Dx button, which will automatically enter the appropriate 
SNOMED codes into the Dx code grid. Please see the Synoptic Reports setup utility section 
of this document for further information about assigning SNOMED codes to CDEs. 

 
Figure F-19. Competition Window (Synoptic Dx Button) 
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Synoptic Query 
Synoptic Query allows you to run a detailed search for cases where synoptic reporting functionality 
has been used during Result Entry. Synoptic Query provides both an ad hoc search capability as well 
as the ability to save user-defined searches for later use. 
To access the Synoptic Query option, select Query > Synoptic Query from the main menu. The 
Synoptic Query window (Figure F-20) displays. 

 
Figure F-20. Synoptic Query Window 

The ad hoc search screen allows you to search for three different synoptic data elements. Also, three 
options within those data elements can be selected below the elements for limiting the search. To 
include more data elements in the search grid, specify those elements in the Additional Synoptic 
Data Elements section. 
NOTE: The Additional Synoptic Data Elements do not have an effect on the search. They 

simply appear in the search results grid as a way to isolate a specific case or cases. 
Once a search has been specified, it can be saved for future use by clicking the Save button at the top 
right of the window. The system will then ask you to provide a name for your search. The search can 
be accessed and run again using the User-Defined Synoptic Search tab (Figure F-21). 
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Figure F-21.  Synoptic Query Window - User Defined Synoptic Search Tab 
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Appendix G - Voice Integration 
Commands - Navigation and Dictation 
Glossary 

Processing 

From the Main menu, “Processing” launches Processing sub-menu 

One Case Processing 

"One Case Processing" launches the Simple Search Screen 

Simple Search Screen 

 
Case Number Field 

"Case number". Dictate Case Number. 
Search Case Number 

"Lookup for". Launches Accession Sequences Lookup browser window. 
MRN Field 

"Medical Record Number". Dictate MRN. 
Search MRN Number 

"Lookup for". Launches Patient Lookup browser window. 
Last Name Field 

"Last name”. Dictate last name.  
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First Name Field 
"First name”. Dictate first name.  

Billing Number Field 
"Billing Number". Dictate billing number. 

Find Button 
"Find". Selects the Find button. 

Clear Button 
"Clear". Selects the Clear Button. 

Cancel Button 
"Cancel". Selects the Cancel button. 

Cases Tab, Result List 

 
"Select [row number]".  Select desired case row from the Case tab. 
OK button 

“OK”.  Loads selected case into One Case Processing. 

One Case Processing Tab 

 
Case Tab 

"Case". Selects the Case tab. 
Navigation of Tree Grid Display 

"Expand". Expands the tree grid display of the highlighted case. 
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Req. Dr Field 
"Requesting Doctor". Selects the Req. Dr. field. 

Req Dr Lookup 
"Lookup for". Launches Requesting Doctor Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired doctor in the 
Requesting Doctor Lookup browser window. Follow with the command "OK" to 
select doctor and close Requesting Doctor Lookup browser window. 

Priority Field 
"Priority". Selects the Priority field. 
Priority Field Expansion 

“Expand". Expands the Priority field drop-down list. 
Priority Field Selection 

"[Name]". Selects an item from the Priority drop-down list. 
Pathologist Field 

"Pathologist". Selects the Pathologist field. 
Lookup for Pathologist field 

"Lookup for". Launches Pathologist Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired pathologist in the 
Pathologist Lookup browser window. Follow with the command "OK" to select 
pathologist and close Pathologist Lookup browser window. 

Reported To Field 
“Reported to". Select the Reported To Field 
Lookup for Reported To field 

"Lookup for". Launches Doctor Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired doctor in the Doctor 
Lookup browser window. Follow with the command "OK" to select doctor and close 
Doctor Lookup browser window. 

Number of Specimen Field 
"Number of Specimen". Select the Number of Specimen field. 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current number. 
Subtract Number Value 

"Subtract [number]". Dictate desired number that will be subtracted from current 
number. 

Case Flags Button 
"Case Flags". Selects the Case Flags button. 
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Still Birth Checkbox 

"Still Birth". Selects Still Birth checkbox. 
Undiagnosed Infection Checkbox 

"Undiagnosed Infection". Selects the Undiagnosed Infection checkbox. 
Partial Autopsy Checkbox 

“Partial Autopsy". Selects the Partial Autopsy checkbox. 
Complete Autopsy Checkbox 

"Complete Autopsy". Selects the Complete Autopsy checkbox. 
Follow Up Checkbox 

"Follow Up". Selects the Follow Up checkbox. 
Intraoperative Consultation Field 

"Intraoperative Consultation". Selects the Intraoperative Consultation field. 
Dictate Number Value 

“[Number]”. Dictate desired number 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current number. 
Subtract Number Value 

"Subtract [number]". Dictate desired number that will be subtracted from current 
number. 

For ID Only Field 
"For ID Only". Selects the For ID Only field. 
Dictate Number Value 

“[Number]”. Dictate desired number 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current number. 
Subtract Number Value 

"Subtract [number]". Dictate desired number that will be subtracted from current 
number. 

Adequacy Field 
"Adequacy". Selects the Adequacy field. 
Lookup for Adequacy field 

"Lookup for". Launches Quality Codes Lookup browser window. 
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Browser Selection 
"Select [number]". Selects the number of the row of the desired quality code in the 
Quality Codes Lookup browser window. Follow with the command "OK" to select 
code and close Quality Codes Lookup browser window. 

Processing Problem Field 
"Processing Problem". Selects the Processing Problem field. 
Lookup for Processing Problem field 

"Lookup for". Launches Processing Problem Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired quality code in the 
Processing Problem Lookup browser window. Follow with the command "OK" to 
select code and close Processing Problem Lookup browser window. 

Tag Letter Field 
"Tag Letter". Selects the Tag Letter field. 
Tag Letter Field Expansion 

"Expand". Expands the Tag Letter field drop-down list. 
Tag Letter Field Selection 

"[Name]". Selects an item from the Tag Letter drop-down list. 
OK Button 

"OK". Selects the OK button. 
Cancel Button 

"Cancel". Selects the Cancel button. 
Help Button 

"Help". Selects the Help button. 

Clinical Info Button 
"Clinical Info". Selects the Clinical Info button 
Text Entry 

Enter text using voice dictation. 
OK Button 

"OK". Selects OK button. 
Cancel Button 

"Cancel". Selects Cancel button. 

Operation Button 
"Operation". Selects the Operation button. 
Text Entry 

Enter text using voice dictation. 
OK Button 

"OK". Selects the OK button. 
Cancel Button 

"Cancel". Selects the Cancel button. 
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UDF Button 
"User Defined Flags". Selects the UDF button. 
Flag Selection 

"UDF Name". Selects the name of the UDF flag. 

Orders Button 
"Orders". Selects the Orders Button. 

 
Select Order 

"Select [row number].” Selects a specific row in the Orders grid. 
Flag as Done 

"Done". Marks the Done checkbox of the selected row. 
Process Button 

"Process". Selects the Process button. 
Process All Button 

"Process all". Selects the Process All button. 
Notes Button 

"Notes". Selects the Notes button. 
Text Entry 

Enter text using voice dictation. 
Current D&T Button 

"Current date and time". Selects the Current D&T User button. 
Close Button 

"Close". Selects the close button. 
Orders History 

"Orders History". Selects the Orders History button. 
Close Button 

"Close". Selects the close button. 
Assigned To Field 

“Assigned To". Selects the Assigned To field. Enter Text using voice dictation. 
Lookup for Assigned To field 

"Lookup for". Launches Personnel Lookup browser window. 
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Browser Selection 
"Select [number]". Selects the number of the row of the desired individual in the 
Personnel Lookup browser window. Follow with the command "OK" to select 
personnel and close Personnel Lookup browser window.  

Close Button 
"Close". Selects the Close button. 
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All Specimens Tabs 

Expanding Tree Grid Display 
"Expand". Expands the materials under the Specimen level to the block level. 

 

Specimen Autopsy Tab 
"Specimen Autopsy". Selects the Specimen Autopsy tab. 
Body Site Field 

"Body Site". Selects Body Site field 
Lookup for Body Site field 

“Lookup for". Launches Body Site Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired Body Site in the 
Personnel Lookup browser window. Follow with the command "OK" to select body 
site and close Body Site Lookup browser window. 

Source Field 
"Source”. Selects the Source field. 
Lookup for Source field 

"Lookup for". Launches the Source Codes Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired Source in the Source 
Codes Lookup browser window. Follow with the command "OK" to select source 
code and close Source Codes Lookup browser window. 
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Collection Method Field 
"Collection Method". Selects the Collection Method field. 
Lookup for Collection Method field 

"Lookup for". Launches the Collection Method Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired collection method in 
the Collection Method Source Codes Lookup browser window. Follow with the 
command "OK" to select collection method and close Collection Method Lookup 
browser window. 

Primary Block Field 
"Primary Block". Selects the Primary Block field. 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current number. 
Subtract Number Value 

"Subtract [number]". Dictate desired number that will be subtracted from current 
number. 

Pieces Field 
"Pieces". Selects the Pieces field. 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current number. 
Subtract Number Value 

"Subtract [number]". Dictate desired number that will be subtracted from current 
number. 

Membrane Filters Field 
"Membrane Filters". Selects the Membrane Filters field 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current number. 
Subtract Number Value 

"Subtract [number]". Dictate desired number that will be subtracted from current 
number. 
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Frozen Section Blocks Field 
"Frozen Section Blocks". Selects the Frozen Section Blocks field. 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current number. 
Subtract Number Value 

"Subtract [number]". Dictate desired number that will be subtracted from current 
number. 

Frozen Section Date Field 
“Frozen Section Date”. Selects the Frozen Section Date field. Follow with voice dictation to 
add date in the following format: “[MMDDYYYY]”. 

Frozen Section Time Field 
”Go Next”. Moves cursor from Frozen Section Date field and selects the Frozen Section 
Time field. Follow with voice dictation to add time in the following format: “[# # # #]. Use 
Military time format 

Cell Blocks Field 
"Cell Blocks". Selects the Cell Blocks field. 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current number. 
Subtract Number Value 

"Subtract [number]". Dictate desired number that will be subtracted from current 
number. 

Gross IOC Field 
"Gross I O C". Selects the Gross IOC field. 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current number. 
Subtract Number Value 

"Subtract [number]". Dictate desired number that will be subtracted from current 
number. 

Monolayers Field 
"Monolayers". Selects the Monolayers field 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current number. 
Subtract Number Value 

"Subtract [number]". Dictate desired number that will be subtracted from current 
number. 
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Smear Field 
“Smear". Selects the Smear field. 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current number. 
Subtract Number Value 

"Subtract [number]". Dictate desired number that will be subtracted from current 
number. 

Touch Prep Field 
"Touch Prep". Selects the Touch Prep field. 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current number. 
Subtract Number Value 

"Subtract [number]". Dictate desired number that will be subtracted from current 
number. 

Regross Block or Additional Block Field 
"Regross Blocks" or "Additional Blocks". Selects the Regross Block or Additional Block 
field (dependent on system settings). 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current number. 
Subtract Number Value 

"Subtract [number]". Dictate desired number that will be subtracted from current 
number. 

Cytocentrifuges Field 
"Cytocentrifuges". Selects the Cytocentrifuges field 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current number. 
Subtract Number Value 

"Subtract [number]". Dictate desired number that will be subtracted from current 
number. 

Modifier Field 
"Modifier". Selects the Modifier field. 
Modifier Comment Dictation 

Enter text using voice dictation. 
Source Flags Button 

"Source Flags". Selects the Source Flags Button 
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Extensive Gross Description Checkbox 

"Extensive Gross". Selects the Extensive Gross Description checkbox. 
Gross Assistance Checkbox 

"Gross Assistance". Selects the Gross Assistance checkbox 
Specimen Photography Checkbox 

"Specimen Photography". Selects the Specimen Photography checkbox. 
Specimen Photography Info Button 

"Photography Info". Selects the Specimen Photography Info button. 
Text Entry 

Enter text using voice dictation. 
OK Button 

"OK". Selects the OK button. 
Cancel Button 

"Cancel". Selects the Cancel button 
Specimen Radiography Checkbox 

"Specimen Radiography". Selects the Specimen Radiography checkbox. 
Specimen Radiography Info Button 

"Radiography Info". Selects the Specimen Radiography Info button. 
Text Entry 

Enter text using voice dictation. 
OK Button 

"OK". Selects the OK button. 
Cancel Button 

"Cancel". Selects the Cancel button. 
Delayed Dissection Checkbox 

"Delayed Dissection". Selects the Delayed Dissection checkbox. 
Delayed Dissection Info Button 

"Dissection Info". Selects the Delayed Dissection Info button. 
Text Entry 

Enter text using voice dictation. 
OK Button 

"OK". Selects the OK button. 
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Cancel Button 
"Cancel". Selects the Cancel button. 

Gross Description Only Field 
"Gross Description Only". Selects the Gross Description Only field 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current 
number. 

Subtract Number Value 
"Subtract [number]". Dictate desired number that will be subtracted from 
current number. 

Specimen Adequacy Field 
"Specimen Adequacy". Selects the Specimen Adequacy field. 
Lookup for Specimen Adequacy Field 

"Lookup for". Launches the Quality Codes Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired Quality 
Code in the Quality Codes Lookup browser window. Follow with the 
command "OK" to select quality code and close Quality Codes Lookup 
browser window. 

Specimen Adequacy Info Button 
"Adequacy Info". Selects the Specimen Adequacy Info button. 
Text Entry 

Enter text using voice dictation. 
OK Button 

"OK". Selects the OK button. 
Cancel Button 

“Cancel". Selects the Cancel button. 
Processing Problems Field    

"Processing Problems". Selects the Processing Problems field 
Lookup for Processing Problems 

"Lookup for". Launches the Processing Problem Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired Processing 
Problem Code in the Processing Problems Lookup browser window. Follow 
with the command "OK" to select processing problem code and close 
Processing Problems Lookup browser window. 

Tag Letter Field 
"Tag Letter". Selects the Tag Letter field. 
Tag Letter Field Expansion 

"Expand". Expands the Tag Letter field drop-down list. 
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Tag Letter Field Selection 
"[Name]". Selects an item from the Tag Letter drop-down list. 

OK Button 
"OK" Selects the OK button. 

Cancel Button 
“Cancel". Selects the Cancel button. 

Help Button 
"Help". Selects the Help button. 

Special Tests Button. 
"Special Tests". Selects the Special Tests button. 

 
Special Test Field 

"Special Test". Selects the Special Tests field. 
Lookup for Special Tests Field 

"Lookup for". Launches the Special Stains/Test/Stains Panels Lookup 
browser window. 

Browser Selection 
"Select [number]". Selects the number of the row of the desired special test 
in the Special Tests Lookup browser window. Follow with the command 
"OK" to select quality code and close Special Tests Lookup browser 
window. 

Block/Material Field 
"Block Material". Selects the Block Material drop-down list. 
Block/Material Field Expansion 

"Expand". Expands the Block Material drop-down list. 
Block/Material Field Selection 

"[Name]". Selects an item from the Block Material drop-down list. 
OK Button 

"OK". Selects the OK button. 
Cancel Button 

"Cancel". Selects the Cancel button. 
Help Button 

"Help". Selects the Help button. 
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Comment Button 
"Comment" Selects the Comment button. 
Text Entry 

Enter text using voice dictation. 
OK Button 

"OK". Selects the OK button 
UDF Button 

"User Defined Flags". Selects the UDF button 
Flag Selection 

"UDF Name". Selects the name of the UDF flag as displayed. 
OK Button 

"OK". Selects the OK button 
Cancel Button 

"Cancel". Selects the Cancel button. 
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Specimen Gynecological Tab 
"Specimen Gynecological". Selects the Specimen Gynecological Tab. 

 
Body Site Field 

"Body Site". Selects the Body Site field 
Lookup for Body Site field 

"Lookup for". Launches the Body Site Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired body site in the 
Body Site Lookup browser window. Follow with the command "OK" to select body 
site and close Body Site Lookup browser window. 

Source Field 
"Source". Selects the Source field. 
Lookup for Source field 

"Lookup for". Launches the Source Codes Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired source code in the 
Source Codes Lookup browser window. Follow with the command "OK" to select 
source code and close Source Codes Lookup browser window. 

Collection Method Field 
"Collection Method". Selects the Collection Method field. 
Lookup for Collection Method field 

"Lookup for". Launches the Collection Method Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired collection method in 
the Collection Method Lookup browser window. Follow with the command "OK" to 
select collection method Collection Method Lookup browser window. 

Smear Slides Field 
"Smears". Selects the Smear Slides field. 
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Dictate Number Value 
“[Number]”. Dictate desired number. 

Add Number Value 
"Add [number]". Dictate desired number that will be added to current number. 

Subtract Number Value 
Subtract [number]". Dictate desired number that will be subtracted from current 
number. 

Monolayers Field 
"Monolayers". Selects the Monolayers field. 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current number. 
Subtract Number Value 

Subtract [number]". Dictate desired number that will be subtracted from current 
number. 

Modifier Field 
"Modifier". Selects the Modifier field. 
Modifier Comment Dictation 

Enter text using voice dictation. 
Source Flags Button 

"Source Flags". Selects the Source Flags button. See Specimen Autopsy Tab for detailed 
description of voice commands for this option. 

Special Tests Button 
"Special Tests". Selects the Special Tests button. See Specimen Autopsy Tab for detailed 
description of voice commands for this option. 

Comment Button 
"Comment". Selects the Comment button 
Text Entry 

Enter text using voice dictation. 
OK Button 

"OK" Selects the OK button. 
UDF Button. 

"User Defined Flags". Selects the UDF button 
Flag Selection 

"UDF Name". Selects the name of the UDF flag as displayed. 
OK Button 

"OK". Selects the OK button 
Cancel Button 

"Cancel". Selects the Cancel button. 

Specimen Medical Tab 
"Specimen Medical". Selects the Specimen Medical Tab. 
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Body Site Field 

"Body Site". Selects the Body Site field. 
Lookup for Body Site field 

"Lookup for". Launches the Body Site Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired body site in the 
Body Site Lookup browser window. Follow with the command "OK" to select body 
site and close Body Site Lookup browser window. 

Source Field 
"Source". Selects the Source field. 
Lookup for Source field 

"Lookup for". Launches the Source Codes Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired source code in the 
Source Codes Lookup browser window. Follow with the command "OK" to select 
source code and close Source Codes Lookup browser window. 

Collection Method Field 
"Collection Method". Selects the Collection Method field 
Lookup for Collection Method field 

"Lookup for". Launches the Collection Method Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired collection method in 
the Collection Method Lookup browser window. Follow with the command "OK" to 
select collection method Collection Method Lookup browser window. 
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Smear Slides Field 
"Smear Slides". Selects the Smear Slides field. 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current number. 
Subtract Number Value 

“Subtract [number]". Dictate desired number that will be subtracted from current 
number. 

Membrane Filters Field 
"Membrane Filters". Selects the Membrane Filters field. 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current number. 
Subtract Number Value 

“Subtract [number]". Dictate desired number that will be subtracted from current 
number. 

Monolayers Field 
"Monolayers". Selects the Monolayers field. 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current number. 
Subtract Number Value 

“Subtract [number]". Dictate desired number that will be subtracted from current 
number. 

Cell Blocks Field 
"Cell Blocks". Selects the Cell Blocks field. 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current number. 
Subtract Number Value 

“Subtract [number]". Dictate desired number that will be subtracted from current 
number. 
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Cytocentrifuges Field 
"Cytocentrifuges". Selects the Cytocentrifuges field. 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current number. 
Subtract Number Value 

“Subtract [number]". Dictate desired number that will be subtracted from current 
number. 

Modifier Field 
"Modifier". Selects the Modifier field. 
Modifier Comment Dictation 

Enter text using voice dictation. 
Gross Description Button 

"Gross Description". Selects the Gross Description button 

 
Volume Field 

“Volume”. Selects the Volume field. 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Consistency Field 

"Consistency". Selects the Consistency field. 
Consistency Field Expansion 

"Expand". Expands the Consistency field drop-down list. 
Consistency Field Selection 

"[Name]". Selects the desired item from the drop-down list. 
Color Field 

"Color". Selects the Color field. 
Color Field Expansion 

"Expand". Expands the Color field drop-down list. 
Color Field Selection 

"[Name]". Selects the desired item from the drop-down list. 
Fixed Checkbox 

"Fixed". Selects the Fixed checkbox. 
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Clear Checkbox 
“Clear". Selects the Clear Checkbox. 

Blood Checkbox 
"Bloody". Selects the Bloody checkbox. 

Clotted Checkbox 
"Clotted". Selects the Clotted checkbox. 

Other Comment Field 
"Other". Selects the Other text box. Enter text using voice dictation. 

OK Button 
"OK". Selects the OK button. 

Cancel Button 
"Cancel" Selects the Cancel button. 

Help Button 
"Help" Selects the Cancel button. 

Special Tests Button 
“Special Tests" Selects the Special Tests button. See Specimen Autopsy Tab for detailed 
description of voice commands for this option. 

Source Flags Button 
"Source Flags". Selects the Source Flags button. See Specimen Autopsy Tab for detailed 
description of voice commands for this option. 

Comment Button 
"Comment". Selects the Comment button. 
Text Entry 

Enter text using voice dictation. 
OK Button 

"OK". Selects the OK button. 
Cancel Button 

"Cancel". Selects the Cancel button. 
UDF Button 

"User Defined Flags". Selects the UDF button 
Flag Selection 

"UDF Name". Selects the name of the UDF flag as displayed. 
OK Button 

"OK". Selects the OK button 
Cancel Button 

"Cancel". Selects the Cancel button. 
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Specimen Surgical Tab 
"Specimen Surgical". Selects the Specimen Surgical Tab. 

 
Body Site Field 

"Body Site". Selects the Body Site field. 
Lookup for Body Site field 

"Lookup for". Launches the Body Site Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired body site in the 
Body Site Lookup browser window. Follow with the command "OK" to select body 
site and close Body Site Lookup browser window. 

Source Field 
"Source". Selects the Source field. 
Lookup for Source field 

"Lookup for". Launches the Source Codes Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired source code in the 
Source Codes Lookup browser window. Follow with the command "OK" to select 
source code and close Source Codes Lookup browser window. 

Collection Method Field 
"Collection Method". Selects the Collection Method field 
Lookup for Collection Method field 

"Lookup for". Launches the Collection Method Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired collection method in 
the Collection Method Lookup browser window. Follow with the command "OK" to 
select collection method Collection Method Lookup browser window. 
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Primary Blocks Field 
“Primary Blocks”. Selects the Primary Blocks field. 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current number. 
Subtract Number Value 

“Subtract [number]". Dictate desired number that will be subtracted from current 
number. 

FS Blocks Field 
"Frozen Section Blocks". Selects the Frozen Section Blocks field 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current number. 
Subtract Number Value 

"Subtract [number]". Dictate desired number that will be subtracted from current 
number. 

Frozen Section Date Field 
“Frozen Section Date”. Selects the Frozen Section Date field. Follow with voice dictation to 
add date in the following format: “[MMDDYYYY]”. 

Frozen Section Time Field 
”Go Next”. Moves cursor from Frozen Section Date field and selects the Frozen Section 
Time field. Follow with voice dictation to add time in the following format: “[# # # #]. Use 
Military time format 

Regross Block or Additional Block Field 
"Regross Blocks" or "Additional Blocks". Selects the Regross Block or Additional Block 
field (dependent on system settings). 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current number. 
Subtract Number Value 

"Subtract [number]". Dictate desired number that will be subtracted from current 
number. 

Pieces Field 
“Pieces”. Selects the Pieces field. 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current number. 
Subtract Number Value 
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"Subtract [number]". Dictate desired number that will be subtracted from current 
number. 

Gross IOC Field 
“Gross I O C”. Selects the Gross IOC field. 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current number. 
Subtract Number Value 

"Subtract [number]". Dictate desired number that will be subtracted from current 
number. 

Touch Prep Slides Field 
“Touch Prep Slides”. Selects the Touch Prep Slides field. 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current number. 
Subtract Number Value 

"Subtract [number]". Dictate desired number that will be subtracted from current 
number. 

Smear Slides 
“Smear Slides”. Selects the Smear Slides field. 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current number. 
Subtract Number Value 

"Subtract [number]". Dictate desired number that will be subtracted from current 
number. 

Modifier Field 
"Modifier". Selects the Modifier field. 
Modifier Comment Dictation 

Enter text using voice dictation. 
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Source Flags Button 
"Source Flags". Selects the Source Flags button. 

 
Extensive Gross Description Checkbox 

"Extensive Gross". Selects the Extensive Gross Description checkbox. 
Gross Assistance Checkbox 

"Gross Assistance". Selects the Gross Assistance checkbox 
Specimen Photography Checkbox 

"Specimen Photography". Selects the Specimen Photography checkbox. 
Specimen Photography Info Button 

"Photography Info". Selects the Specimen Photography Info button. 
Text Entry 

Enter text using voice dictation. 
OK Button 

"OK". Selects the OK button. 
Cancel Button 

"Cancel". Selects the Cancel button 
Specimen Radiography Checkbox 

"Specimen Radiography". Selects the Specimen Radiography checkbox. 
Specimen Radiography Info Button 

"Radiography Info". Selects the Specimen Radiography Info button. 
Text Entry 

Enter text using voice dictation. 
OK Button 

"OK". Selects the OK button. 
Cancel Button 

"Cancel". Selects the Cancel button. 
Delayed Dissection Checkbox 

"Delayed Dissection". Selects the Delayed Dissection checkbox. 



Appendix G - Voice Integration Commands – Navigation  SoftPath v.4.2.1 User Manual 
 and Dictation Glossary   

Page G-26  PATH4.2-G-U (6th Ed, Rel. 1/31/07) 

Delayed Dissection Info Button 
"Dissection Info". Selects the Delayed Dissection Info button. 
Text Entry 

Enter text using voice dictation. 
OK Button 

"OK". Selects the OK button. 
Cancel Button 

"Cancel". Selects the Cancel button. 
Gross Description Only Field 

"Gross Description Only". Selects the Gross Description Only field 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current number. 
Subtract Number Value 

"Subtract [number]". Dictate desired number that will be subtracted from current 
number. 

Specimen Adequacy Field 
"Specimen Adequacy". Selects the Specimen Adequacy field. 
Lookup for Specimen Adequacy Field 

"Lookup for". Launches the Quality Codes Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired Quality Code in the 
Quality Codes Lookup browser window. Follow with the command "OK" to select 
quality code and close Quality Codes Lookup browser window. 

Specimen Adequacy Info Button 
"Adequacy Info". Selects the Specimen Adequacy Info button. 
Text Entry 

Enter text using voice dictation. 
OK Button 

"OK". Selects the OK button. 
Cancel Button 

“Cancel". Selects the Cancel button. 
Processing Problems Field    

"Processing Problems". Selects the Processing Problems field 
Lookup for Processing Problems 

"Lookup for". Launches the Processing Problem Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired Processing Problem 
Code in the Processing Problems Lookup browser window. Follow with the 
command "OK" to select processing problem code and close Processing Problems 
Lookup browser window. 
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Tag Letter Field 
"Tag Letter". Selects the Tag Letter field. 
Tag Letter Field Expansion 

"Expand". Expands the Tag Letter field drop-down list. 
Tag Letter Field Selection 

"[Name]". Selects an item from the Tag Letter drop-down list. 
OK Button 

"OK" Selects the OK button. 
Cancel Button 

“Cancel". Selects the Cancel button. 
Help Button 

"Help". Selects the Help button. 

Special Tests Button 
"Special Tests". Selects the Special Tests button. 

 
Special Test Field 

"Special Test". Selects the Special Tests field. 
Lookup for Special Tests Field 

"Lookup for". Launches the Special Stains/Test/Stains Panels Lookup browser 
window. 

Browser Selection 
"Select [number]". Selects the number of the row of the desired special test in the 
Special Tests Lookup browser window. Follow with the command "OK" to select 
quality code and close Special Tests Lookup browser window. 

Block/Material Field 
"Block Material". Selects the Block Material drop-down list. 
Lookup for Block/Material Field 

"Expand". Expands the Block Material drop-down list. 
Browser Selection 

"[Name]". Selects an item from the Block Material drop-down list. 
OK Button 

"OK". Selects the OK button. 
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Cancel Button 
"Cancel". Selects the Cancel button. 

Help Button 
"Help". Selects the Help button. 

Comment Button 
"Comment" Selects the Comment button. 
Text Entry 

Enter text using voice dictation. 
OK Button 

"OK". Selects the OK button 
Cancel Button 

"Cancel". Selects the Cancel button. 

UDF Button. 
"User Defined Flags". Selects the UDF button 
Flag Selection 

"UDF Name". Selects the name of the UDF flag as displayed. 
OK Button 

"OK". Selects the OK button 
Cancel Button 

"Cancel". Selects the Cancel button. 
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Blocks Tab 

"Blocks". Selects the Blocks Tab in One Case Processing 

 
Expand Tree Grid Display 

"Expand". Expands the materials under the Block level to the Slide level 
Navigation between multiple Blocks 

The system allows traversal between each listed block by speaking the following commands: 
First Block 

"First". Navigates to the first block for the selected specimen in the tree grid display. 
Next Block 

"Next". Navigates to the next block in the order of blocks listed in the tree grid view. 
This command will move the cursor down one block at a time. 

Previous Block 
"Previous". Navigates to the previous block in the order of blocks listed in the tree 
grid view This command will move the cursor up one block at a time. 

Last Block 
“Last". Navigates to the last block for the selected specimen in the tree grid display 

 Number of Pieces Field 
"Number of Pieces". Selects the Number of Pieces field. 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current number. 
Subtract Number Value 

"Subtract [number]". Dictate desired number that will be subtracted from current 
number. 

Complete Cutting Checkbox 
"Complete Cutting". Selects the Complete Cutting Checkbox 
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Embed/Unembed Button 
"Embed Unembed". Selects the Embed/Unembed button. 

Re-Embed Button 
"Re embed". Selects the Re-embed button. 

Add Slide Button 
"Add Slide". Selects the Add Slide button. 
Number of Slides Field 

"New slide number". Selects the Number of Slides field adjacent to the Add Slides 
button 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current 
number. 

Subtract Number Value 
"Subtract [number]". Dictate desired number that will be subtracted from 
current number. 

Add Recut Button 
"Add Recut". Selects the Add Recut button. 

Delete Last Slide Button 
"Delete Last Slide". Selects the Delete Last Slide button. 

Update Last Slide Button 
"Update Last Slide". Selects the Update Last Slide button. 

Number of Slides Field 
"Last slide number". Selects the Number of Slides field adjacent to the Update Last Slides 
button. 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current number. 
Subtract Number Value 

"Subtract [number]". Dictate desired number that will be subtracted from current 
number. 

Add Default Slides Button 
“Add Default Slides". Selects the Add Default Slides button. 

Split Block Button 
"Split Block". Selects the Split Block button. 

Number of Blocks Field 
"Block number". Selects the Number of Blocks field adjacent to the Split Block button. 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current number. 
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Subtract Number Value 
"Subtract [number]". Dictate desired number that will be subtracted from current 
number. 

Delete Current Block Button 
"Delete Current Block". Selects the Delete Current Block button. 

Block Flags Button 
"Block Flags". Selects the Block Flags button. 

 
EM Block Checkbox 

"EM Block". Selects the EM Block checkbox. 
Cryo Tissue Bank Checkbox 

"Cryo Tissue Bank". Selects the Cryo Tissue Bank checkbox. 
Decal Block Checkbox 

"Decal Block". Selects the Decal Block checkbox. 
Block with B5 Checkbox 

"B5 Block". Selects the Block with B5 checkbox 
Control Reference Checkbox 

"Control Reference". Selects the Control Reference checkbox. 
Stain Field for Control Reference 

"Stain". Selects the Stain field. 
Lookup for Stain field 

"Lookup for". Launches the Special Stains / Test / Stain Panels 
Lookup browser window. 

Browser Selection 
"Select [number]". Selects the number of the row of the desired 
code in the Special Stains / Test / Stain Panels Lookup browser 
window. Follow with the command "OK" to select desired code and 
close Special Stains / Test / Stain Panels Lookup browser window. 

Cell Suspensions Checkbox 
"Cell Suspensions". Selects the Cell Suspensions checkbox. 

Hold for One Day Checkbox 
"Hold for One Day". Selects the Hold for One Day checkbox. 
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Cancelled Checkbox 
"Cancelled". Selects the Cancelled checkbox. 

Completely Used Checkbox 
"Completely Used". Selects the Completely Used checkbox. 

Fixatives Field 
"Fixatives". Selects the Fixatives field. 
Fixatives Field Expansion 

"Expand". Expands the Fixatives drop-down list. 
Fixatives Field Selection 

"[Name]". Selects an item from the Fixatives drop-down list. 
Block Tag Letter Field 

"Block Tag Letter". Selects the Block Tag Letter field. 
Block Tag Letter Field Expansion 

"Expand". Expands the Block Tag Letter drop-down list. 
Block Tag Letter Field  Selection 

"[Name]". Selects an item from the Block Tag Letter drop-down list. 
OK Button 

"OK". Selects the OK button. 
Cancel Button 

"Cancel". Selects the OK button. 
Help Button 

"Help". Selects the Help button. 
Inventory Button 

"Inventory". Selects the Inventory button. 

 
Block Storage/Location Field 

"Block Storage". Selects the Block Storage/Location field. 
Lookup for Block Storage/Location field 

"Lookup for". Launches the Storage Lookup browser window. 
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Browser Selection 
"Select [number]". Selects the number of the row of the desired code in the 
Storage Lookup browser window. Follow with the command "OK" to select 
desired code and close the Storage Lookup browser window. 

Slide Storage/Location 
"Slide Storage". Selects the Slide Storage/Location field. 
Lookup for Slide Storage/Location field 

"Lookup for". Launches the Storage Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the 
Storage Lookup browser window. Follow with the command "OK" to select 
desired code and close the Storage Lookup browser window. 

Special Locations 
"Special Locations".  Selects the Special Locations grid. 
Location Text Entry 

Enter test using voice dictation. 
OK Button 

"OK". Selects the OK button. 
Cancel Button 

"Cancel". Selects the Cancel button. 
Help Button 

"Help". Selects the Help button. 
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Slide Stain Tab 

"Slide Stain" Selects the Slide Stain tab. 

 
Expand Tree Grid Display 

"Expand". Expands the materials under the Block level to the Slide level 
Navigation Between Multiple Slides 

The system allows traversal between each listed slide by speaking the following commands: 
First Slide 

"First". Navigates to the first slide for the selected block in the tree grid display. 
Next Slide 

"Next". Navigates to the next slide in the order of slides listed in the tree grid 
display. This command will move the cursor down one slide at a time. 

Previous Slide 
"Previous". Navigates to the previous slide in the order of slides listed in the tree 
grid display. This command will move the cursor up one slide at a time. 

Last Slide 
"Last". Navigate to the last slide for the selected block in the tree grid display. 

Slide Selection in Slide Stain Tab Grid 
"Select [Number]”. Selects the line number that corresponds to that specific slide in the Slide 
Stain Tab Grid. 

Add Standard Stain Button 
"Add Standard Stain". Selects the Add Standard Stain button 

Add Special Stain Button 
"Add Special Stain". Selects the Add Special Stain button 
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Special Stain Selection Field 
"Special Stain". Selects the Special Stain field. 
Lookup for Special Stain Selection field 

"Lookup for". Launches the Special Stains/Test/Stain Panels Lookup browser 
window. 

Browser Selection 
"Select [number]". Selects the number of the row of the desired code in the Special 
Stains/Test/Stain Panels browser window. Follow with the command "OK" to select 
desired code and close the Special Stains/Test/Stain Panels browser window. 

Add Std All Button 
"Add Standard All". Selects the Add Standard All button. 

Del Std All Button 
"Delete Standard All". Selects the Delete Standard All button. 

Delete Stain Button 
"Delete Stain". Selects the Delete Stain button. 

Mark All Button 
"Mark All". Selects the Mark All button. 

Unmark All Button 
"Unmark All". Selects the Unmark All button. 

Mark Selected Button 
"Mark Selected". Selects the Mark Selected button. 

Unmark Selected Button 
"Unmark Selected". Selects the Unmark Selected button. 
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Stain Panel Wizard Button 
"Stain Panel Wizard". Selects the Stain Panel Wizard button. 

 
Panel Field 

"Panel". Selects the Panel field. 
Panel Field Expansion 

"Expand". Expands the Panel drop-down list. 
Panel Field Selection 

"[Name]". Selects the name in the Panel drop-down list. 
Slide Selection 

"Select Slide [Row Number]". Selects a slide from the Slides list. 
Slide Stain 

"Select Stain [Row Number]". Selects a stain from the Stains list. 
Move Button  (<) 

"Move". Selects the Move button (<). 
Move All Button  (<<) 

"Move All". Selects the Move All button (<<). 
Remove Button  (>) 

"Remove". Selects the Remove button (>). 
Remove All Button  (>>) 

"Remove All". Selects the Remove All button (>>). 
Add Slides Button 

"Add Slides". Selects the Add Slides button. 
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Add Recuts Button 
"Add Recuts". Selects the Add Recuts button. 
Number of Slides 

"Slide Number". Selects the Number of Slides field adjacent to the Add 
Slides button. 

Dictate Number Value 
“[Number]”. Dictate desired number. 

Add Number Value 
"Add [number]". Dictate desired number that will be added to current 
number. 

Subtract Number Value 
"Subtract [number]". Dictate desired number that will be subtracted from 
current number. 

OK Button 
"OK". Selects the OK button 

Cancel Button 
"Cancel". Selects the Cancel button. 

Apply Button 
"Apply". Selects the Apply button. 
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Worklists 

"Worklists". Launches the Worklists Search Screen. 

 
Ordered Date From Field 

"Ordered Date From”. Selects the Ordered Date From field. Dictate desired date in the 
following format “[MMDDYYYY]". 

Ordered Date To Field 
"Ordered Date To”. Selects the Ordered Date To field. Dictate desired date in the following 
format “[MMDDYYYY]". 

Case Range From Field 
"Case Range From”. Selects the Case Range From field. Dictate the desired case number 
“[Case Number]” 

Case Range To Field 
"Case Range To”. Selects the Case Range To field. Dictate the desired case number “[Case 
Number]". 

Case Types Field 
"Case Types". Selects the Case Types field 
Case Types Field Expansion 

"Expand". Expands the Case Types drop-down list. 
Case Types Field Selection 

"[Name]". Selects an item from the Case Types drop-down list. 
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Special Stains/Tests 
"Special Stains/Tests". Selects the Special Stains Tests field. 
Lookup For 

"Lookup for". Launches the Special Stains/Test/Stains Panel Lookup browser 
window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the 
Special Stains/Test/Stains Panel Lookup browser window. Follow with the 
command "OK" to select desired code and close the Special 
Stains/Test/Stains Panel Lookup browser window. 

Source Field 
"Source". Selects the Source field. 
Lookup for 

"Lookup for". Launches the Source Codes Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the 
Source Codes Lookup browser window. Follow with the command "OK" to 
select desired code and close the Source Codes Lookup browser window. 

Body Site Field 
"Body Site". Selects the Body Sites field. 
Lookup for 

"Lookup for". Launches the Body Site Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the 
Body Site Lookup browser window. Follow with the command "OK" to 
select desired code and close the Body Site Lookup browser window. 

Only Cell Blocks Checkbox 
"Only Cell Blocks". Selects the Only Cell Blocks checkbox. 

Only with FS Checkbox 
"Only with Frozen Section". Selects the Only with FS checkbox. 

Clinic Field 
"Clinic". Selects the Clinic field. 
Lookup for 

“Lookup for". Launches the Clinic Code Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the 
Clinic Code Lookup browser window. Follow with the command "OK" to 
select desired code and close the Clinic Code Lookup browser window. 

Priority Field 
"Priority". Selects the Priority field. 
Priority Field Expansion 

"Expand". Expands the Priority drop-down list. 
Priority Field Selection 

"[Name]". Selects an item from the Priority drop-down list. 



Appendix G - Voice Integration Commands – Navigation  SoftPath v.4.2.1 User Manual 
 and Dictation Glossary   

Page G-42  PATH4.2-G-U (6th Ed, Rel. 1/31/07) 

 
Prefix Field 

"Prefix". Selects the Prefix field. 
Lookup for 

"Lookup for". Launches the Accession Sequences Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the 
Accession Sequences Lookup browser window. Follow with the command 
"OK" to select desired code and close the Accession Sequences Lookup 
browser window. 

Default Worklist Field 
"Default Worklist". Selects the Default Worklist field. 
Default Worklist Field Expansion 

"Expand". Expands the Default Worklist drop-down list. 
Default Worklist Field Selection 

"[Name]". Selects an item from the Default Worklist drop-down list. 
Sort Rules Field 

"Sort Rules". Selects the Sort Rules field. 
Sort Rules Field Expansion 

"Expand". Expands the Sort Rules drop-down list. 
Sort Rules Field Selection 

"[Name]". Selects an item from the Default Worklist drop-down list. 
Find Button 

"Find". Selects the Find button 
Cancel Button 

"Cancel". Selects the Cancel button. 
Help button 

“Help”. Selects the Help button. 
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Specimen Processing Worklist Tab 

 "Specimen Processing Worklist". Selects the Specimen Processing Worklist tab. 

 
Navigation between Multiple Specimens 

The system allows traversal between each listed specimen by speaking the following 
commands: 
First 

"First". Navigates to the first specimen in the tree grid display. 
Next 

"Next". Navigates to the next specimen in the tree grid display. This command will 
move the cursor down one specimen at a time. 

Previous 
"Previous". Navigates to the previous specimen in the tree grid display. This 
command will move the cursor up one specimen at a time. 

Last 
"Last". Navigates to the last specimen in the tree grid display. 

Modifier Field 
“Modifier”. Selects the modifier field. 
Modifier Field, Text Entry 

Enter text using voice dictation. 
Specimen Comment Field 

"Specimen Comment". Selects the Specimen Comment field. 
Specimen Comment Field, Text Entry 

Enter text using voice dictation. 
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Primary Block Field 
"Primary Block". Selects the Primary Block field. 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current number. 
Subtract Number Value 

"Subtract [number]". Dictate desired number that will be subtracted from current 
number. 

Smear Field 
“Smear". Selects the Smear field. 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current number. 
Subtract Number Value 

"Subtract [number]". Dictate desired number that will be subtracted from current 
number. 

Touch Prep Field 
"Touch Prep". Selects the Touch Prep field. 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current number. 
Subtract Number Value 

"Subtract [number]". Dictate desired number that will be subtracted from current 
number. 

Regross Block or Additional Block Field 
"Regross Blocks" or "Additional Blocks". Selects the Regross Block or Additional Block 
field (dependent on system settings). 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current number. 
Subtract Number Value 

"Subtract [number]". Dictate desired number that will be subtracted from current 
number. 
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Monolayers Field 
"Monolayers". Selects the Monolayers field 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current number. 
Subtract Number Value 

"Subtract [number]". Dictate desired number that will be subtracted from current 
number. 

Cytocentrifuges Field 
"Cytocentrifuges". Selects the Cytocentrifuges field 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current number. 
Subtract Number Value 

"Subtract [number]". Dictate desired number that will be subtracted from current 
number. 

Membrane Filters Field 
"Membrane Filters". Selects the Membrane Filters field 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current number. 
Subtract Number Value 

"Subtract [number]". Dictate desired number that will be subtracted from current 
number. 

Cell Blocks Field 
"Cell Blocks". Selects the Cell Blocks field. 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current number. 
Subtract Number Value 

"Subtract [number]". Dictate desired number that will be subtracted from current 
number. 
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Gross IOC Field 
"Gross I O C". Selects the Gross IOC field. 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current number. 
Subtract Number Value 

"Subtract [number]". Dictate desired number that will be subtracted from current 
number. 

Pieces Field 
"Pieces". Selects the Pieces field. 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current number. 
Subtract Number Value 

"Subtract [number]". Dictate desired number that will be subtracted from current 
number. 

Frozen Section Blocks Field 
"Frozen Section Blocks". Selects the Frozen Section Blocks field. 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current number. 
Subtract Number Value 

"Subtract [number]". Dictate desired number that will be subtracted from current 
number. 

Frozen Section Date Field 
“Frozen Section Date”. Selects the Frozen Section Date field. Follow with voice dictation to 
add date in the following format: “[MMDDYYYY]”. 

Frozen Section Time Field 
“Go Next”. Moves cursor from Frozen Section Date field and selects the Frozen Section 
Time field. Follow with voice dictation to add time in the following format: “[# # # #]. Use 
Military time format 

Complete (Compl.) Checkbox 
"Completed". Selects the Completed checkbox. 

Blocks Pieces Button 
"Blocks Pieces". Selects the Blocks Pieces button 

Mark All Button 
"Mark All". Selects the Mark All button. 
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Find Case Button 
"Find Case". Selects the Find Case button. 
Case Number  

“[Case number]”. Enter a case number using voice dictation.  
Processing History Button 

"Processing History". Selects the Processing History button. 
Print List Button 

"Print List". Selects the Print List button. 
Print Preview Button 

"Print Preview". Selects the Print Preview button. 
Source Flags Button 

"Source Flags". Selects the Source flags button and launches the Source flags window. 

 
Extensive Gross Description Checkbox 

"Extensive Gross". Selects the Extensive Gross Description checkbox. 
Gross Assistance Checkbox 

"Gross Assistance". Selects the Gross Assistance checkbox 
Specimen Photography Checkbox 

"Specimen Photography". Selects the Specimen Photography checkbox. 
Specimen Photography Info Button 

"Photography Info". Selects the Specimen Photography Info button. 
Text Entry 

Enter text using voice dictation. 
OK Button 

"OK". Selects the OK button. 
Cancel Button 

"Cancel". Selects the Cancel button 
Specimen Radiography Checkbox 

"Specimen Radiography". Selects the Specimen Radiography checkbox. 



Appendix G - Voice Integration Commands – Navigation  SoftPath v.4.2.1 User Manual 
 and Dictation Glossary   

Page G-48  PATH4.2-G-U (6th Ed, Rel. 1/31/07) 

Specimen Radiography Info Button 
"Radiography Info". Selects the Specimen Radiography Info button. 
Text Entry 

Enter text using voice dictation. 
OK Button 

"OK". Selects the OK button. 
Cancel Button 

"Cancel". Selects the Cancel button. 
Delayed Dissection Checkbox 

"Delayed Dissection". Selects the Delayed Dissection checkbox. 
Delayed Dissection Info Button 

"Dissection Info". Selects the Delayed Dissection Info button. 
Text Entry 

Enter text using voice dictation. 
OK Button 

“OK". Selects the OK button. 
Cancel 

"Cancel". Selects the Cancel button. 
Gross Description Only Field 

"Gross Description Only". Selects the Gross Description Only field 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current 
number. 

Subtract Number Value 
"Subtract [number]". Dictate desired number that will be subtracted from 
current number. 

Specimen Adequacy Field 
"Specimen Adequacy". Selects the Specimen Adequacy field. 
Lookup for Specimen Adequacy Field 

"Lookup for". Launches the Quality Codes Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired Quality 
Code in the Quality Codes Lookup browser window. Follow with the 
command "OK" to select quality code and close Quality Codes Lookup 
browser window. 
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Specimen Adequacy Info Button 
"Adequacy Info". Selects the Specimen Adequacy Info button. 
Text Entry 

Enter text using voice dictation. 
OK Button 

"OK". Selects the OK button. 
Cancel Button 

“Cancel". Selects the Cancel button. 
Processing Problems Field    

"Processing Problems". Selects the Processing Problems field 
Lookup for Processing Problems 

"Lookup for". Launches the Processing Problem Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired Processing 
Problem Code in the Processing Problems Lookup browser window. Follow 
with the command "OK" to select processing problem code and close 
Processing Problems Lookup browser window. 

Tag Letter Field 
"Tag Letter". Selects the Tag Letter field. 
Tag Letter Field Expansion 

"Expand". Expands the Tag Letter field drop-down list. 
Tag Letter Selection 

"[Name]". Selects an item from the Tag Letter drop-down list. 
 OK Button 

"OK" Selects the OK button. 
Cancel Button 

“Cancel". Selects the Cancel button. 
 Help Button 

"Help". Selects the Help button. 
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Block Embedding Worklist Tab 

"Block Embedding Worklist". Selects the Block Embedding Worklist tab. 

 
Specimen Comment Field 

"Specimen Comment". Selects the Specimen comment section. 
Specimen Comment Text Entry 

“[Comment]”. Enter text into the Specimen Comment section using voice dictation. 
Embed All Button 

"Embed All". Selects the Embed All button. 
Find Case Button 

"Find Case". Selects the Find Case button. 
Case Number  

“[Case number]”. Enter a case number using voice dictation.  
Processing History Button 

"Processing History". Selects the Processing History button. 
Print List Button 

"Print List". Selects the Print List button. 
Print Preview Button 

"Print Preview". Selects the Print Preview button. 
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Block Processing Worklist Tab 

"Block Processing Worklist". Selects the Block Processing Worklist Tab. 

 
Specimen Comment Field 

"Specimen Comment". Selects the Specimen comment section. 
Specimen Comment 

“[Comment]”. Enter text into the Specimen Comment section using voice dictation. 
Add Slide Button 

"Add Slide". Selects the Add Slide button. 
Number of Slides Field 

"New slide number". Selects the Number of Slides field adjacent to the Add Slides 
button 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current 
number. 

Subtract Number Value 
"Subtract [number]". Dictate desired number that will be subtracted from 
current number. 

Add Recut Button 
"Add Recut". Selects the Add Recut button. 
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Update Last Slide Button 
"Update Last Slide". Selects the Update Last Slide button. 
Number of Slides Field 

"Last slide number". Selects the Number of Slides field adjacent to the 
Update Last Slides button. 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to 
current number. 

Subtract Number Value 
"Subtract [number]". Dictate desired number that will be subtracted 
from current number. 

Delete Last Slide Button 
"Delete Last Slide". Selects the Delete Last Slide button. 

Completed Checkbox 
"Completed". Selects the Completed checkbox. 

Pieces Field 
"Pieces". Selects the Pieces field. 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current 
number. 

Subtract Number Value 
"Subtract [number]". Dictate desired number that will be subtracted from 
current number. 



Appendix G - Voice Integration Commands – Navigation  SoftPath v.4.2.1 User Manual 
 and Dictation Glossary   

Page G-54  PATH4.2-G-U (6th Ed, Rel. 1/31/07) 

Orders Button 
"Orders". Opens the Orders window. 

 
Selecting an Order 

"Select [row number]. Selects a specific row in the Orders grid. 
Flag as Done 

"Done". Marks the Done checkbox of the selected row. 
Process Button 

"Process". Selects the Process button. 
Process All Button 

"Process all". Selects the Process All button. 
Notes Button 

"Notes". Selects the Notes button. 
Text Entry 

Enter text using voice dictation. 
Current D&T Button 

"Current date and time". Selects the Current D&T User button. 
Close Button 

"Close". Selects the Close button. 
Orders History Button 

"Orders History". Selects the Orders History button. 
Close Button 

"Close". Selects the Close button. 
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Assigned To Field 
“Assigned To". Selects the Assigned To field. Enter Text using voice 
dictation. 
Lookup for Assigned To field 

"Lookup for". Launches Personnel Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired 
individual in the Personnel Lookup browser window. Follow with 
the command "OK" to select personnel and close Personnel Lookup 
browser window.  

Close Button 
"Close". Selects the Close button. 

Mark All 
"Mark All". Selects the Mark All button. 

Find Case Button 
"Find Case". Selects the Find Case Button 
Case Number Field 

“[Case number]”. Enter a case number using voice dictation. 
Processing History Button 

"Processing History". Selects the Processing History button. 
Print List Button 

"Print List". Selects the Print List Button. 
Print Preview Button 

"Print Preview". Selects the Print Preview button. 
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Stains Worklist Tab 

"Stains Worklist". Selects the Stains Worklist Tab. 

 
 Navigation Between Multiple Slides 

The system allows traversal between each listed slide by speaking the following commands: 
First Slide 

"First". Navigates to the first slide for the selected block in the tree grid display. 
Next Slide 

"Next". Navigates to the next slide in the order of slides listed in the tree grid 
display. This command will move the cursor down one slide at a time. 

Previous Slide 
"Previous". Navigates to the previous slide in the order of slides listed in the tree 
grid display. This command will move the cursor up one slide at a time. 

Last Slide 
"Last". Navigate to the last slide for the selected block in the tree grid display. 

Slide Selection in Slide Stain Tab Grid 
"Select [Number]”. Selects the line number that corresponds to that specific slide in the Slide 
Stain Tab Grid. 

Add Standard Stain Button 
"Add Standard Stain". Selects the Add Standard Stain button 

Add Special Stain Button    
"Add Special Stain". Selects the Add Special Stains button 
Special Stain Selection Field 

“Special Stain”. Selects the Special Stain Field. 
Lookup for Special Stains 

"Lookup for". Launches the Special Stains Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired Special Stain Code 
in the Special Stains Lookup browser window. Follow with the command "OK" to 
select special stain code and close Special Stains Lookup browser window. 
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Add Std All Button 
"Add Standard All". Selects the Add Standard All button. 

Del Std All Button 
"Delete Standard All". Selects the Delete Standard All button 

Delete Stain Button 
"Delete Stain". Selects the Delete Stain button. 

Mark All Button 
"Mark All". Selects the Mark All button. 

Mark Selected Button 
"Mark Selected". Selects the Mark Selected button 

Unmark All Button 
"Unmark All". Selects the Unmark All button 

Unmark Selected Button 
"Unmark Selected". Selects the Unmark Selected button 

Orders Button 
"Orders". Selects the Orders button. 
See previous section, Block Processing Worklist Tab, for complete functionality of the 
Orders button and its’ options. 

Find Case Button 
"Find Case". Selects the Find Case 
Case Number  

The system shall provide the ability to dictate the case number.  
Processing History Button 

"Processing History". Selects the Processing History button. 
Print List Button 

"Print List". Selects the Print List button. 
Print Preview Button 

"Print Preview". Selects the Print Preview button. 
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Case Results 

From the main menu, "Case Results" launches the Case Results Search Screen 

Simple Search 
"Simple Search". Selects the Simple Search Tab. 

 
Case Number Field 

“Case number". Selects the Case number field. Enter a case number using voice dictation. 
Lookup for Case Number 

"Lookup for". Launches the Accession Sequences Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired Accession 
Sequences Code in the Accession Sequences Lookup browser window. Follow with 
the command "OK" to select Accession Sequences code and close Accession 
Sequences Lookup browser window. 

Last Name Field 
"Last name". Selects the Last Name  Field. Enter a last name using voice dictation. 

First Name 
"First name”. Selects the First Name Field. Enter a first name using voice dictation. 
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MRN Field 
"Medical Record Number [#####... ]". Selects the MRN field. followed by the command 
"Find" 
Lookup for MRN Field 

"Lookup for". Launches the Patient Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired Patient code in the 
Patient Lookup browser window. Follow with the command "OK" to select Patient 
code and close Patient Lookup browser window. 

Find Button 
"Find". Selects the Find button. 

Clear Button 
"Clear". Selects the Clear button. 

Cases List 
“Cases list”. Selects the Cases List Tab. 

 
Select Row Number 

"Select [row number]” followed by the command "Mark Selected". Select a row number and 
mark its’ selection box.  

OK Button 
"OK". Selects the OK button. 

Results Tab (All Case Types – Autopsy, Gynecological, Medical, 
Surgical) 

“Results Tab.” Selects the Results Tab. 
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Final Reports (Gynecological, Medical, Surgical) 

"Final". Selects the Final report type. 
RTF Editor Button 

"RTF Editor". Selects the RTF Editor button. 
Word Editor Button 

"Word Editor". Selects the Word Editor button. 
Dictation into MS Word Editor 

The system provides the ability to select Sections, Navigate, and Dictate into MS Word. 

 
Section Tab Name Selection 

“[Tab name]”. Selects the Section tab. Cursor is positioned for data entry into section. 
Sub-Section Tab Name Selection 

Sub-Section tabs shall be limited to mouse selection only. 
Final Diagnosis Section 

"Final Diagnosis". Selects the Final Diagnosis Section. Cursor is positioned for data entry 
into section. 

Gross Description Section 
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"Gross Description". Selects the Gross Description Section. Cursor is positioned for data 
entry into section. 

IOC (Intraoperative Consultation) Section 
"IntraOperative Consultation". Selects the IntraOperative Consultation Section. Cursor is 
positioned for data entry into section. 

Clinical Data 
"Clinical Data". Selects the Clinical Data Section. Cursor is positioned for data entry into 
section. 

Pre-Op Information 
"Pre-Op Information". Selects the Pre-Op Information Section. Cursor is positioned for data 
entry into section. 

Section Dictation 
The system provides two methods to dictate data using voice functionality: 1) Standard Dragon 
Dictation functionality that employs a dictation box;   OR   2) direct dictation into the MS Word 
template. 

To Use Standard Dragon Dictation functionality, follow these steps: 

Section Tab Name Selection 
 “[Tab name]”. Selects the Section tab. Cursor is positioned for data entry into section. 
 

Launch Dictation Box 
“Start Dictation”. Launches the Dragon dictation box. 
 

Text Entry 
Enter text using voice dictation. 
 

Close Dictation Box 
“End Dictation”. Closes the Dragon dictation box and inserts dictated text into the selected report section 
 

To Use Direct Dictation into the MS Word Template, follow these steps: 

Section Tab Name Selection 
 “[Tab name]”. Selects the Section tab. Cursor is positioned for data entry into section. 
 

Text Entry 
Enter text using voice dictation. The text will automatically be inserted into the selected report section. 
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NOTE:  The system requires an option to be set in Setup, Options, Voice Recognition for 
Direct Dictation into MS Word to be enabled: 

 

Navigating in the document 
The system has the ability to navigate through the entered text using standard Dragon voice 
functionality as follows: 
Find Text (Text Search) 

The system shall have the ability to find text within the document by entering dictation mode 
with the phrase "Find [text]". Searches for the named text, closes dictation mode after text is 
found. 

Home 
"Home". Navigates to the top of the document. 

End 
"End". Navigates to the bottom of the document. 

End Of Line 
"End of line". Navigates to the end of the currently selected line of text. 

Beginning of line 
"Beginning of line". Navigates to the start of the currently selected line of text. 

Up 
"Page Up". Navigates the cursor up one line of text at a time. 

Down 
"Page Down". Navigates the cursor down one line of text at a time. 

Tab 
"Tab". Selects the Tab Key on the keyboard. 

New line 
The system shall have the ability to start a new line with the phrase "New line" 

Formatting 
The system shall provide the ability to format the dictated text using standard Dragon 
formatting functionality. Please refer to Dragon reference material. 

Correction 
The system shall provide the ability to correct the dictated text using standard Dragon 
correction functionality. Please refer to Dragon reference material. 
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Dictation into RTF Editor 
The system provides the ability to dictate into the RTF Editor. All Section selection, Navigation, and 
Dictation techniques are identical with commands for Dictation into MS Word Editor. Please refer to 
previous section for details. 
NOTE: Sub Sections are selectable using voice functionality in the RTF editor. 
Sub Section Tab Name Selection 

 “[Tab name]”. Selects the Sub Section tab. Cursor is positioned for data entry into section. 
 
 
 
 

 
Save Section – Final Diagnosis 

“Save ”. Select the Save button in the Report toolbar to begin the Save and Completion 
process. 

“Save” command 
selects the Save 
button 
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Final Diagnosis Tab 
“Final Diagnosis”. Selects the Final Diagnosis tab. 

 
Done By Field 

"Done by". Selects the Done By field. 
Lookup for Done By Field 

"Lookup for". Launches the Person Dictating Final Diagnosis Lookup browser 
window. 

Browser Selection 
"Select [number]". Selects the number of the row of the desired code in the Person 
Dictating Final Diagnosis Lookup browser window. Follow with the command 
"OK" to select Person Dictating Final Diagnosis code and close Person Dictating 
Final Diagnosis Lookup browser window. 

Pathologist Field 
"Pathologist". Selects the Pathologist field. 
Lookup for Pathologist Field 

"Lookup for". Launches the Pathologist Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the 
Pathologist Lookup browser window. Follow with the command "OK" to select 
Pathologist code and close Pathologist Lookup browser window. 

Resident Button 
"Resident". Selects the Resident button. 

 
Lookup for Resident Field 

"Lookup for". Launches the Resident browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the Resident 
Lookup browser window. Follow with the command "OK" to select Resident code 
and close Resident Lookup browser window. 
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Copies To Button 
“Copies to". Selects the Copies To button. 

 
Lookup for Requesting Doctor Field 

"Lookup for". Launches the Requesting Doctor browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the 
Requesting Doctor Lookup browser window. Follow with the command "OK" to 
select Requesting Doctor code and close Requesting Doctor Lookup browser 
window. 

 
Consultants Button 

"Consultations". Selects the Consultants button. 
Lookup for Consultants Fields 

"Lookup for". Launches the Requesting Doctor browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the 
Requesting Doctor Lookup browser window. Follow with the command "OK" to 
select Requesting Doctor code and close Requesting Doctor Lookup browser 
window. 

Consultant Comment Field 
“Comment”. Selects the Comment field. Enter a comment using voice dictation 
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Undergo QA Button 
"Undergo QA". Selects the Undergo QA button. 

 
Proreview Checkbox 

"Proreview". Selects the Proreview checkbox. 
Rescreen Checkbox 

"Rescreen". Selects the Rescreen checkbox. 
Retroreview Checkbox 

"Retroreview". Selects the Retroreview checkbox. 
UDF Button. 

"User Defined Flags". Selects the UDF button 
Flag Selection 

"UDF Name". Selects the name of the UDF flag as displayed. 

Final DX Codes Field(s) 
The system has the ability to enter final diagnosis codes: 
Add Code Button 

"Add Code". Selects the Add Code button. 
Dx Find Button 

"DX Find". Selects the Dx Find button. 
Delete Code Button 

"Delete Code". Selects the Delete Code button. 
Dx History 

"Dx History". Selects the Dx History button. 

Billing Button 
"Billing". Selects the Billing button. 
Billing Part A Tab 

"Billing Part A".  Selects the Billing Part A tab. Note: Data entry within this tab shall be 
limited to keyboard/mouse entry. 

Billing Part B Tab 
"Billing Part B". Selects the Billing Part B tab. Note: Data entry within this tab shall be 
limited to keyboard/mouse entry. 
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Dx Cat (Category) Field 
"Category". Selects the Dx Cat field. 
Lookup for Dx Cat Field 

"Lookup for". Launches the Diagnosis Category Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the 
Diagnosis Category Lookup browser window. Follow with the command "OK" to 
select Diagnosis Category code and close Diagnosis Category Lookup browser 
window. 

Order Stains/Slides Button 
“Order Stains Slides”. Selects the Order Stains/Slides button. 

 
Select Material (Line Number) 

"Select [Line Number]". Selects the line number of the specified material. 
Add Stain Field 

"Order Stain". Selects the Order Stain field adjacent to the Add Stain button. 
Lookup for Add Stain Field 

"Lookup for". Launches the Special Stains/Test/Stain Panels Lookup 
browser window. 

Browser Selection 
"Select [number]". Selects the number of the row of the desired code in the 
Special Stains/Test/Stain Panels Lookup browser window. Follow with the 
command "OK" to select Special Stains/Test/Stain Panels code and close 
Special Stains/Test/Stain Panels browser window. 

Add Stain 
"Add Stain". Selects the Add Stains button. Applies the selected stain that was 
looked up in previous step to the selected material in the Order Stains/Slides Grid. 
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Assign To 
"Assign To". Selects the Assign To field. 
Lookup for Assign To Field 

"Lookup for". Launches the Personnel Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the 
Personnel Lookup browser window. Follow with the command "OK" to 
select Personnel code and close Personnel browser window. 

Notes Button 
"Notes". Selects the Notes button 
Text Entry 

Enter text using voice dictation 
Current D&T Button 

"Current Date and Time". Selects the Current D&T button. 
Close Button 

"Close". Selects the Close button. 
OK Button 

"OK". Selects the OK button 
Cancel Button 

"Cancel". Selects the Cancel button. 
Screener Evidence Count Field 

"Screener Evidence". Selects the Screener Evidence Count Field. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current number. 
Subtract Number Value 

"Subtract [number]". Dictate desired number that will be subtracted from current 
number. 
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More Button 
"More".  Selects the More button. 

 
Billing Part A Tab 

"Billing Part A".  Selects the Billing Part A tab. Data entry within this tab shall be limited to 
keyboard/mouse entry. 

Billing Part B Tab 
"Billing Part B".  Selects the Billing Part B tab. Data entry within this tab shall be limited to 
keyboard/mouse entry. 

Calls Tab 
"Calls". Selects the Calls tab. Data entry within this tab shall be limited to keyboard/mouse 
entry. 

Letters Tab 
"Letters".  Selects the Letters tab.  Data entry within this tab shall be limited to 
keyboard/mouse entry. 

Undergo QA Tab 
"Undergo QA".  Selects the Undergo QA tab. Voice commands to select Rescreen, 
Proreview, and Retroreview are the same as previously described and will not be repeated. 

Adequacy/Problems Tab 
"Adequacy Problems". Selects the Adequacy/Problems tab. Data entry within this tab shall 
be limited to keyboard/mouse entry. 

Consultations Tab 
"Consultations". Selects the Consultations tab. Voice commands within this tab are the same 
as previously described and will not be repeated. 
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Other Case Data Tab 
"Other Case Data". Selects the Other Case Data tab. Voice functionality within this tab is as follows:   

 
Additional Copies 

The system shall provide the ability to edit the Additional Copies field by using the 
command "Additional Copies". 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current number. 
Subtract Number Value 

"Subtract [number]". Dictate desired number that will be subtracted from current 
number. 

For ID only 
The system shall provide the ability to edit the For ID only field using the command "For ID 
Only" 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current number. 
Subtract Number Value 

"Subtract [number]". Dictate desired number that will be subtracted from current 
number. 

UDF Button
"User Defined Flags". Selects the UDF button 
Flag Selection 

"UDF Name". Selects the name of the UDF flag as displayed. 
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Case Comment 
"Case Comment". Selects the Case Comment button.   
Case Comment Window 

Enter a comment using voice dictation. 
OK Button 

"OK". Selects the OK button for the Case Comment window. 
Cancel Button 

"Cancel" Selects the Cancel button for the Case Comment window. 
Clinical Info Button 

"Clinical Info".  Selects the Clinical Info button. 
Clinical Info Window 

Enter a comment using voice dictation.  
OK Button 

"OK". Selects the OK button. 
Cancel Button 

"Cancel". Selects the Cancel button 
Operation Info Button 

"Operational Info". Selects the Operation Info button. 
Operation Info Window 

Enter a comment using voice dictation.  
OK Button 

"OK" Selects the OK button. 
Cancel Button 

"Cancel" Selects the Cancel button. 
Intraoperative Consultations Field 

"Intraoperative Consultations". Selects the Intraoperative Consultations field. 
Dictate Number Value 

“[Number]”. Dictate desired number. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current number. 
Subtract Number Value 

"Subtract [number]". Dictate desired number that will be subtracted from current 
number. 

Stillbirth Checkbox 
"Stillbirth". Selects the Stillbirth checkbox. 

Partial Autopsy Checkbox 
"Partial Autopsy". Selects the Partial Autopsy checkbox. 

Complete Autopsy Checkbox 
"Complete Autopsy". Selects the Complete Autopsy checkbox. 

Undiagnosed Infection Checkbox 
"Undiagnosed Infection". Selects the Undiagnosed Infection checkbox. 
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Tag Letter Field 
"Tag Letter". Selects the Tag Letter field. 
Tag Letter Field Expansion 

"Expand". Expands the Tag Letter field drop-down list. 
Tag Letter Selection 

"[Name]". Selects an item from the Tag Letter drop-down list. 
Reported To Field 

"Reported To". Selects the Reported To field. 
Lookup for Reported To Field 

"Lookup for". Launches the Doctor Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the Doctor 
Lookup browser window. Follow with the command "OK" to select Doctor code and 
close Doctor browser window. 

Total Number of Service Units 
"Service Units" Selects the Total Number of Service Units field. Dictate a number into this 
field using voice dictation. 
Level One # of Units 

"Level One [number]". Selects the number field for Level One. Dictate number 
using voice dictation. Use  “Add [Number]” and “Subtract [Number] to change 
value. 

Level Two # of Units 
"Level Two [number]". Selects the number field for Level Two. Dictate number 
using voice dictation. Use “Add [Number]” and “Subtract [Number] to change 
value. 

Level Three # of Units 
"Level Three [number]". Selects the number field for Level Three. Dictate number 
using voice dictation. Use “Add [Number]” and “Subtract [Number] to change 
value. 

Level Four # of Units 
"Level Four [number]". Selects the number field for Level Four Dictate number 
using voice dictation. Use  “Add [Number]” and “Subtract [Number] to change 
value. 

Level Five # of Units 
"Level Five [number]". Selects the number field for Level Five. Dictate number 
using voice dictation. Use  “Add [Number]” and “Subtract [Number] to change 
value. 

Level Six # of Units 
"Level Six [number]". Selects the number field for Level Six. Dictate number using 
voice dictation. Use  “Add [Number]” and “Subtract [Number] to change value. 
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Order Stains/Slides Tab 
"Order Stains Slides". Selects the Order Stains/Slides tab. Voice commands within this tab are the 
same as previously described and will not be repeated here. 

Assign ICD9 to CPT Tab 
"Assign ICD9 to CPT". Selects the Assign ICD9 to CPT tab.  Data entry within this tab shall be 
limited to keyboard/mouse entry. 

 
 
 
 
 

 
Save Section – Gross Description 

“Save ”. Select the Save button in the Report toolbar to begin the Save and Completion 
process. 

Gross Description (Examination) Tab 
“Gross Examination”. Selects the Gross Examination tab. 

 
Done By Field 

“Done By”. Selects the Done By field. 
Lookup for Done By Field 

"Lookup for". Launches the Person Dictating Gross Description Lookup browser 
window. 

Browser Selection 
"Select [number]". Selects the number of the row of the desired code in the Person 
Dictating Gross Description Lookup browser window. Follow with the command 
"OK" to select Person Dictating Gross Description code and close Person Dictating 
Gross Description browser window. 

“Save” command 
selects the Save 
button 
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Copies To Field 
"Copies to". Selects the Copies To button.  
Lookup for Requesting Doctor Field 

"Lookup for". Launches the Requesting Doctor browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the 
Requesting Doctor Lookup browser window. Follow with the command "OK" to 
select Requesting Doctor code and close Requesting Doctor Lookup browser 
window. 

IOC/FS/GIC Tab 
The system shall have the ability to invoke the save screen for IOC Entry for all case types via voice 
recognition by using the command "Save" 

 
Done By Field 

"Done By” Selects the Done By field. 
Lookup for Person Dictating IO Consultation Lookup Field 

"Lookup for". Launches the Person Dictating IO Consultation browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the Person 
Dictating IO Consultation Lookup browser window. Follow with the command 
"OK" to select Person Dictating IO Consultation code and close Person Dictating IO 
Consultation Lookup browser window. 

Clinical Data, Pre-Op (All case types) 
The system shall have the ability to save from these options through voice recognition  

Save Button 
"Save". Selects the Save button. Completes the completion process and saves the result 
entry. 

Save and Close Button 
"Save and close". Selects the Save and Close button. Completes the completion process, 
saves the result entry, and closes the report window. 

Cancel Button 
“Cancel". Selects the Cancel button. Aborts the completion process, closes the completion 
window, and returns user to result report. 
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Sign Out Tab 

"Sign Out". Selects the Sign Out tab when Result Entry has been completed. 

 

QA Online Window 
The system provides the ability to navigate and perform data entry within the QA Online window 

 
Assigned To 

"Assigned To". Selects the Assigned To Checkbox. The voice command “Tab” selects the 
Assigned To Lookup Field. 
Lookup for Assigned To Field 

"Lookup for". Launches the Person Can Rescreen browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the Person 
Can Rescreen Lookup browser window. Follow with the command "OK" to select 
Person Can Rescreen code and close Person Can Rescreen Lookup browser window. 

Save & Close Button 
"Save  and Close". Selects the Save & Close button. 

Close Button 
"Close". Selects the Close button. 

Next QA Button 
"Next QA". Selects the Next QA button. 

Help Button 
"Help". Selects the Help button. 
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Previous QA Button 
"Previous QA". Selects the Previous QA button. 

Comment Button 
"Comment". Selects the Comment button. 
Comment Window 

Enter text using voice dictation.  
OK Button 

"OK". Selects the OK button. 
Cancel Button 

"Cancel". Selects the Cancel button. 

 
Sign Out/Done By Field 

"Sign Out ID". Selects the Sign Out/Done By field. 
Lookup for Sign Out/Done By Field 

"Lookup for". Launches the Person Can Signout Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the Person 
Can Signout Lookup browser window. Follow with the command "OK" to select 
Person Can Signout code and close Person Can Signout Lookup browser window. 

Pathologist Field 
"Pathologist". Selects the Pathologist field. 
Lookup for Pathologist Field 

"Lookup for". Launches the Pathologist Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the 
Pathologist Lookup browser window. Follow with the command "OK" to select 
Pathologist code and close Pathologist Lookup browser window. 

Screener Evidence Count Field 
"Screener Evidence". Selects the Screener Evidence Count field. 
Add Number Value 

"Add [number]". Dictate desired number that will be added to current number. 
Subtract Number Value 

"Subtract [number]". Dictate desired number that will be subtracted from current 
number. 
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Resident Button 
"Resident". Selects the Resident button. 

 
Lookup for Resident Field 

"Lookup for". Launches the Resident browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the Resident 
Lookup browser window. Follow with the command "OK" to select Resident code 
and close Resident Lookup browser window. 

Release Case Checkbox 
"Release case". Selects the Release Case checkbox 

Dx Category Field 
"Category". Selects the Dx Category field. 
Lookup for Dx Category Field 

"Lookup for". Launches the Resident browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the Resident 
Lookup browser window. Follow with the command "OK" to select Resident code 
and close Resident Lookup browser window. 

Diagnosis Code Buttons (Add Code, Delete Code, Dx Find) 
"Add Code", “Delete Code”, “Dx Find”. Selects the  corresponding buttons. This 
functionality is the same as previously described. Please see Final Diagnosis Tab section 
for more details. 

Order Stains/Slides Button 
"Order Stains Slides". Selects the Order Stains/Slides button. This functionality is the same 
as previously described. Please see Final Diagnosis Tab section for more details. 

More Button 
"More". Selects the More button. This functionality is the same as previously described. 
Please see Final Diagnosis Tab section for more details 

Sign Out Button 
"Sign Out". Selects the Sign Out button. 

Cancel Button 
"Cancel". Selects the Cancel button. 



SoftPath v.4.2.1 User Manual Appendix G - Voice Integration Commands - Navigation  
 and Dictation Glossary  

PATH4.2-G-U (6th Ed, Rel. 1/31/07)  Page G-79 

Toolbar Button Functions 
Dx Cascade 

"Cascade". Selects the DX Cascade button. 
Navigate Cascaded windows 

The system has the ability to recognize numbers when selecting cascading windows; for 
instance, "Select 1", "Select 2", "Select 3", etc. 

Free Text Entry 
Enter free text using voice dictation. 

Save Cascade Window Sequence 
"OK". Selects the OK button and saves the cascade sequence. 

Canned Messages Button 
"Canned message". Selects the Canned Messages button, launches the Canned Messages 
Lookup window. 

 
Message Field 

"Message". Selects the Message field. 
Message Field Navigation 

“Up”, “Down”. Scrolls up and down through the items that belong to the 
Message field. 

Code Field 
"Code". Selects the Code field. Enter text into this field using voice dictation. 

Description Field 
"Description". Selects the Message field. Enter text into this field using voice 
dictation. 

Active Radio Button 
"Active". Selects the Active radio button. 

Not Active Radio Button 
"Not Active". Selects the Not Active radio button. 



Appendix G - Voice Integration Commands – Navigation  SoftPath v.4.2.1 User Manual 
 and Dictation Glossary   

Page G-80  PATH4.2-G-U (6th Ed, Rel. 1/31/07) 

All Records Radio Button 
"All Records". Selects the All Records radio button.  

Find Button 
"Find". Selects the Find button, initiates search for canned message corresponding to 
search criteria. 

Select Canned Message 
“Select [number]”. Selects the number of the row of the desired Canned Message in 
the search results grid of the Canned Messages Lookup window.  “OK”. Selects the 
selected canned message to be edited. Enter additional text into canned message 
using voice dictation. 

OK Button  
"OK". Selects the OK button and saves the canned message, inserting it at cursor site 
in report. 

Cancel Button  
"Cancel". Selects the Cancel button and aborts the canned message procedure, 
returning user to cursor site in report. 

Lab Results Button 
The system shall have the ability to invoke the search screen for lab results through voice 
recognition with the phrase "Lab Results" 
Test Selection 

The system shall have the ability to select from a list of tests through voice 
navigation as described in Common Directions.  
Multiple tests 

The system shall have the ability to select multiple tests by speaking the 
selection numbers of the tests desired.  i.e. "Select #1, #2, #3, ..." 

Ability to insert lab results 
The system shall have the ability to insert selected lab results with the phrase 
"Import results." 

Patient History Button (Version 3.17.x) 
"Patient History". Selects the Patient History button. Launches the Patient History window. 
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Case Selection 
“Select [Number]” Selects the row number of the case of interest. 

Mark All Button 
“Mark All” Selects the Mark All button. 

Mark Selected Button 
“Mark Selected” Selects the Mark Selected button. 

Unmark All Button 
“Unmark All” Selects the Unmark All button. 

Unmark Selected Button 
“Unmark Selected” Selects the Unmark All button. 

Hx (History) Report Button 
"History Report". Selects the Hx Report button; generates Patient History report 
based on selections made in the  

Patient History Button (Version 4.2.x) 
"Patient History". Selects the Patient History button and automatically generates a Patient 
History report. 

DX (Diagnosis) History Button 
"Dx History". Selects the Dx History button. 

SoftWeb Button 
"SoftWeb". Selects the SoftWeb button. 

Query 
"Query". Selects the Query button. “Yes” to the prompt loads the Query window. “Close 
window” closes the Query window and returns user to patient case in Results Entry. 

Arrow Navigation 
"Previous Case". Selects the left pointing arrow for case navigation. 
"Next Case". Selects the right pointing arrow for case navigation. 

Change case number 
"Go To Case". Selects the Case Number field. Once field is selected, use voice dictation to 
enter a case number. “Enter”. Selects the enter key on the keyboard and loads case into 
Result Entry screen. 
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Final Anatomic Diagnosis Report – FAD (Autopsy) 

"Final". Selects the Final report type. 

 
RTF Editor Button 

"RTF Editor". Selects the RTF Editor button. 
Word Editor Button 

"Word Editor". Selects the Word Editor button. 

Dictation into MS Word Editor 
The system provides the ability to select Sections, Navigate, and Dictate into MS Word. All voice 
functionality within this section is the same as previously described and will not be repeated. Please 
refer to Final Report Section for details. 

Dictation into RTF Editor 
The system provides the ability to dictate into the RTF Editor. All Section selection, Navigation, and 
Dictation techniques are identical with commands for Dictation into MS Word Editor. Please refer to 
Final Report Section for details. 
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Gross Description (Examination) Save Section 
"Save". Selects the Save button. Data must be entered in the Gross description section. 

 
Done By Field 

“Done By”. Selects the Done By field. 
Lookup for Done By Field 

"Lookup for". Launches the Person Dictating Gross Description Lookup browser 
window. 

Browser Selection 
"Select [number]". Selects the number of the row of the desired code in the Person 
Dictating Gross Description Lookup browser window. Follow with the command 
"OK" to select Person Dictating Gross Description code and close Person Dictating 
Gross Description browser window. 

Deiner Field 
"Deiner". Selects the Deiner field. 
Lookup for Deiner Field 

"Lookup for". Launches the Assist As Deiner Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the Assist 
As Deiner Lookup browser window. Follow with the command "OK" to select 
Assist As Deiner code and close Assist As Deiner browser window. 

Copies To Button 
“Copies to". Selects the Copies To button. 
Lookup for Requesting Doctor Field 

"Lookup for". Launches the Requesting Doctor browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the 
Requesting Doctor Lookup browser window. Follow with the command "OK" to 
select Requesting Doctor code and close Requesting Doctor Lookup browser 
window. 

More Button 
"More". Selects the More button. 
Age Info/Body Tab 

"Age Info Body”. Selects the Age Info/Body tab.  Data Entry within this tab shall be 
limited to keyboard/mouse entry. 

Organs/Bones Tab 
"Organs Bones". Selects the Organs/Bones tab. Data Entry within this tab shall be 
limited to keyboard/mouse entry. 
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Save Button 
"Save" Selects the Save button. 

Save and Close Button 
"Save and close". Selects the Save and Close button. 

Cancel Button 
"Cancel". Selects the Cancel button. 

Clinicopathologic Correlation Save Section 
"Save". Selects the Save button. Data must be entered into the Clinicopathologic Correlation section. 

 
Done By Field 

“Done By”. Selects the Done By field. 
Lookup for Done By Field 

"Lookup for". Launches the Pathologist and Resident ID Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the 
Pathologist and Resident ID Lookup browser window. Follow with the command 
"OK" to select Pathologist and Resident ID code and close Pathologist and Resident 
ID browser window. 

Save Button 
"Save". Selects the Save button. 

Save and Close Button 
"Save and close". Selects the Save and Close button. 

Cancel Button 
"Cancel". Selects the Cancel button. 
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Final Diagnosis (FAD) Save Section  
"Save". Selects the Save button. Data must be entered into the Final Anatomic Diagnosis section. 

 
Done By Field 

“Done By”. Selects the Done By field. 
Lookup for Done By Field 

"Lookup for". Launches the Person Dictating Final Diagnosis Lookup browser 
window. 

Browser Selection 
"Select [number]". Selects the number of the row of the desired code in the Person 
Dictating Final Diagnosis Lookup browser window. Follow with the command 
"OK" to select Person Dictating Final Diagnosis code and close Person Dictating 
Final Diagnosis browser window. 

Pathologist Field 
"Pathologist". Selects the Pathologist field. 
Lookup for Pathologist Field 

"Lookup for". Launches the Pathologist Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the 
Pathologist Lookup browser window. Follow with the command "OK" to select 
Pathologist code and close Pathologist Lookup browser window. 

Deiner Field 
"Deiner". Selects the Deiner field. 
Lookup for Deiner Field 

"Lookup for". Launches the Assist As Deiner Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the Assist 
As Deiner Lookup browser window. Follow with the command "OK" to select 
Assist As Deiner code and close Assist As Deiner browser window. 

Resident Button 
"Resident". Selects the Resident button. 
Lookup for Resident Field 

"Lookup for". Launches the Resident browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the Resident 
Lookup browser window. Follow with the command "OK" to select Resident code 
and close Resident Lookup browser window. 
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Billing Button 
"Billing". Selects the Billing button. 
Billing Part A Tab 

"Billing Part A".  Selects the Billing Part A tab. Note: Data entry within this tab 
shall be limited to keyboard/mouse entry. 

Billing Part B Tab 
"Billing Part B". Selects the Billing Part B tab. Note: Data entry within this tab shall 
be limited to keyboard/mouse entry. 

Consultants Button 
"Consultations". Selects the Consultants button. 
Lookup for Consultants Fields 

"Lookup for". Launches the Requesting Doctor browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the 
Requesting Doctor Lookup browser window. Follow with the command "OK" to 
select Requesting Doctor code and close Requesting Doctor Lookup browser 
window. 

Consultant Comment Field 
“Comment”. Selects the Comment field. Enter a comment using voice dictation 

Order Stains/Slides Button 
"Order Stains Slides". Selects the Order Stains/Slides button. All voice functionality within 
this option is the same as previously described and will not be repeated. Please refer to Final 
Report Section for details. 

More Button 
"More". Selects the More button. 
History Tab 

“History". Selects the History tab. 
Autopsy Info Tab 

"Autopsy Info" Selects the Autopsy Info tab. 
Calls Tab 

"Calls". Selects the Calls tab. Data entry within this tab shall be limited to 
keyboard/mouse entry. 

Letters Tab 
"Letters". Selects the Letters tab. Data entry within this tab shall be limited to 
keyboard/mouse entry. 

Age Info/Body Tab 
"Age Info Body". Selects the Age Info/Body tab. Data entry within this tab shall be 
limited to keyboard/mouse entry. 

Organs/Bones Tab 
"Organs Bones". Selects the Organs/Bones tab. Data entry within this tab shall be 
limited to keyboard/mouse entry. 

Other Case Data Tab 
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"Other Case Data". Selects the Other Case Data tab. All voice functionality within 
this option is the same as previously described and will not be repeated. Please refer 
to Final Report Section for details. 

Adequacy/Problems Tab 
"Adequacy Problems". Selects the Adequacy/Problems tab. Data entry within this 
tab shall be limited to keyboard/mouse entry. 

Order Stains/Slides Tab 
"Order Stains Slides". Selects the Order Stains/Slides tab. All voice functionality 
within this option is the same as previously described and will not be repeated. 
Please refer to Final Report Section for details. 

Dx Cat (Category) Field 
"Category". Selects the Dx Cat field. 
Lookup for Dx Cat Field 

"Lookup for". Launches the Diagnosis Category Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the 
Diagnosis Category Lookup browser window. Follow with the command "OK" to 
select Diagnosis Category code and close Diagnosis Category Lookup browser 
window. 

Final DX Codes Field(s) 
The system has the ability to enter final diagnosis codes: 
Add Code Button 

"Add Code". Selects the Add Code button. 
Dx Find Button 

"DX Find". Selects the Dx Find button. 
Delete Code Button 

"Delete Code". Selects the Delete Code button. 
Dx History 

"Dx History". Selects the Dx History button. 
Save Button 

"Save". Selects the Save button. 
Save and Close Button 

"Save and close". Selects the Save and Close button. 
Cancel Button 

"Cancel". Selects the Cancel button. 
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Preliminary Anatomic Diagnosis Report - PAD (Autopsy) 
"Provisional". Selects the Provisional Report type. 

 
RTF Editor Button 

"RTF Editor". Selects the RTF Editor button. 
Word Editor Button 

"Word Editor". Selects the Word Editor button. 

Dictation into MS Word Editor 
The system provides the ability to select Sections, Navigate, and Dictate into MS Word. All voice 
functionality within this section is the same as previously described and will not be repeated. Please 
refer to Final Report Section for details. 

Dictation into RTF Editor 
The system provides the ability to dictate into the RTF Editor. All Section selection, Navigation, and 
Dictation techniques are identical with commands for Dictation into MS Word Editor. Please refer to 
Final Report Section for details. 
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Provisional Save Section  
"Save Section". Selects the Save button. All report sections must have data entered. 

 
Done By Field 

“Done By”. Selects the Done By field. 
Lookup for Done By Field 

"Lookup for". Launches the Person Dictating Final Diagnosis Lookup browser 
window. 

Browser Selection 
"Select [number]". Selects the number of the row of the desired code in the Person 
Dictating Final Diagnosis Lookup browser window. Follow with the command 
"OK" to select Person Dictating Final Diagnosis code and close Person Dictating 
Final Diagnosis browser window. 

Pathologist Field 
"Pathologist". Selects the Pathologist field. 
Lookup for Pathologist Field 

"Lookup for". Launches the Pathologist Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the 
Pathologist Lookup browser window. Follow with the command "OK" to select 
Pathologist code and close Pathologist Lookup browser window. 

Deiner Field 
"Deiner". Selects the Deiner field. 
Lookup for Deiner Field 

"Lookup for". Launches the Assist As Deiner Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the Assist 
As Deiner Lookup browser window. Follow with the command "OK" to select 
Assist As Deiner code and close Assist As Deiner browser window. 

Resident Button 
"Resident". Selects the Resident button. 
Lookup for Resident Field 

"Lookup for". Launches the Resident browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the Resident 
Lookup browser window. Follow with the command "OK" to select Resident code 
and close Resident Lookup browser window.  
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More Button 
"More". Selects the More button. 
Age Info/Body Tab 

"Age Info Body”. Selects the Age Info/Body tab.  Data Entry within this tab shall be 
limited to keyboard/mouse entry. 

Organs/Bones Tab 
"Organs Bones". Selects the Organs/Bones tab. Data Entry within this tab shall be 
limited to keyboard/mouse entry. 

Save Button 
"Save". Selects the Save button. 

Save and Close Button 
"Save and close". Selects the Save and Close button. 

Cancel Button 
"Cancel". Selects the Cancel button. 
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Revised Reports (All Case types) 
"Revised [letter code]". Selects the Revised case of interest. 

 
RTF Editor Button 

"RTF Editor". Selects the RTF Editor button. 
Word Editor Button 

"Word Editor". Selects the Word Editor button. 
Report Matrix Selection 

"Revised New" or "Final". Selects the report template of interest from the Report Matrix 
Selection window and loads the report template into the appropriate text editor. 

Dictation into MS Word Editor 
The system provides the ability to select Sections, Navigate, and Dictate into MS Word. All voice 
functionality within this section is the same as previously described and will not be repeated. Please 
refer to Final Report Section for details. 

Dictation into RTF Editor 
The system provides the ability to dictate into the RTF Editor. All Section selection, Navigation, and 
Dictation techniques are identical with commands for Dictation into MS Word Editor. Please refer to 
Final Report Section for details. 

 



Appendix G - Voice Integration Commands – Navigation  SoftPath v.4.2.1 User Manual 
 and Dictation Glossary   

Page G-92  PATH4.2-G-U (6th Ed, Rel. 1/31/07) 

Save Section(s) 
"Save". Selects the Save button 

 
Done By Field 

“Done By”. Selects the Done By field. 
Lookup for Done By Field 

"Lookup for". Launches the Person Dictating Revised Report Lookup browser 
window. 

Browser Selection 
"Select [number]". Selects the number of the row of the desired code in the Person 
Dictating Revised Report Lookup browser window. Follow with the command "OK" 
to select Person Dictating Revised Report code and close Person Dictating Revised 
Report browser window. 

Resident Button 
"Resident". Selects the Resident button. 
Lookup for Resident Field 

"Lookup for". Launches the Resident browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the Resident 
Lookup browser window. Follow with the command "OK" to select Resident code 
and close Resident Lookup browser window. 

Final DX Codes Field(s) 
The system has the ability to enter final diagnosis codes: 
Add Code Button 

"Add Code". Selects the Add Code button. 
Delete Code Button 

"Delete Code". Selects the Delete Code button. 
Dx Find Button 

"DX Find". Selects the Dx Find button. 
Report Reason/Comment Button  

"Comment" Selects the Report Reason/Comment button. 
Text Entry 

Enter text using voice dictation. 
OK Button 

"OK". Selects the OK button. 
Cancel Button 
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“Cancel". Selects the Cancel button. 
Dx Cat (Category) Field 

"Category". Selects the Dx Cat field. 
Lookup for Dx Cat Field 

"Lookup for". Launches the Diagnosis Category Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the 
Diagnosis Category Lookup browser window. Follow with the command "OK" to 
select Diagnosis Category code and close Diagnosis Category Lookup browser 
window 

Order Stains/Slides Button 
"Order Stains Slides". Selects the Order Stains/Slides button. All voice functionality within 
this option is the same as previously described and will not be repeated. Please refer to Final 
Report Section for details. 

Save Button 
"Save". Selects the Save button. 

Cancel Button 
"Cancel". Selects the Cancel button. 

Preliminary Result Reports (Gynecological, Medical, Surgical) 
"Preliminary [Letter code]". Selects the Preliminary Report of interest. 

 
RTF Editor Button 

"RTF Editor". Selects the RTF Editor button. 
Word Editor Button 

"Word Editor". Selects the Word Editor button. 
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Dictation into MS Word Editor 
The system provides the ability to select Sections, Navigate, and Dictate into MS Word. All voice 
functionality within this section is the same as previously described and will not be repeated. Please 
refer to Final Report Section for details. 

Dictation into RTF Editor 
The system provides the ability to dictate into the RTF Editor. All Section selection, Navigation, and 
Dictation techniques are identical with commands for Dictation into MS Word Editor. Please refer to 
Final Report Section for details 

Save Section(s) 
"Save". Selects the Save button. 

 
Done By Field 

“Done By”. Selects the Done By field. 
Lookup for Done By Field 

"Lookup for". Launches the Pathologist Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the 
Pathologist Lookup browser window. Follow with the command "OK" to select 
Pathologist code and close Pathologist browser window. 

Resident Button 
"Resident". Selects the Resident button. 
Lookup for Resident Field 

"Lookup for". Launches the Resident browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the Resident 
Lookup browser window. Follow with the command "OK" to select Resident code 
and close Resident Lookup browser window. 

Report Reason/Comment Button  
"Comment" Selects the Report Reason/Comment button. 
Text Entry 

Enter text using voice dictation. 
OK Button 

"OK". Selects the OK button. 
Cancel Button 

“Cancel". Selects the Cancel button. 
Save Button 

"Save". Selects the Save button. 
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Cancel Button 
"Cancel". Selects the Cancel button. 

Supplemental Reports (All case types) 
"Supplemental [Letter code]". Selects the Supplemental Report of interest. 

 
RTF Editor Button 

"RTF Editor". Selects the RTF Editor button. 
Word Editor Button 

"Word Editor". Selects the Word Editor button. 
Report Matrix Selection 

"Supplemental New" or "Final". Selects the report template of interest from the Report 
Matrix Selection window and loads the report template into the appropriate text editor. 

Dictation into MS Word Editor 
The system provides the ability to select Sections, Navigate, and Dictate into MS Word. All voice 
functionality within this section is the same as previously described and will not be repeated. Please 
refer to Final Report Section for details. 

Dictation into RTF Editor 
The system provides the ability to dictate into the RTF Editor. All Section selection, Navigation, and 
Dictation techniques are identical with commands for Dictation into MS Word Editor. Please refer to 
Final Report Section for details 
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Save Section(s) 
"Save". Selects the Save button. 
Done By Field 

“Done By”. Selects the Done By field. 
Lookup for Done By Field 

"Lookup for". Launches the Pathologist Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the 
Pathologist Lookup browser window. Follow with the command "OK" to select 
Pathologist code and close Pathologist browser window. 

Resident Button 
"Resident". Selects the Resident button. 
Lookup for Resident Field 

"Lookup for". Launches the Resident browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the Resident 
Lookup browser window. Follow with the command "OK" to select Resident code 
and close Resident Lookup browser window. 

Report Reason/Comment Button  
"Comment" Selects the Report Reason/Comment button. 
Text Entry 

Enter text using voice dictation. 
OK Button 

"OK". Selects the OK button. 
Cancel Button 

“Cancel". Selects the Cancel button. 
Save Button 

"Save". Selects the Save button. 
Cancel Button 

"Cancel". Selects the Cancel button. 
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My Results Worklist 

From the Main Menu, "My Results Worklist" launches the Cases List. 

 
Case Selection 

"Select [row number].” Selects and highlights the row number of interest. 
Next Button 

"Next". Selects the Next button and loads next search set of cases, based on Page Length 
Field setting. 

Previous Button 
"Previous". Selects the Previous button and loads Previous search set of cases, based on Page 
Length Field setting. 

Mark All Button 
“Mark All.” Selects all checkboxes of all displayed rows. 

Mark Selected Button 
“Mark Selected” Selects the checkbox of the highlighted row. 

Unmark All Button 
“Unmark All”. Deselects all marked checkboxes of all displayed rows. 

Unmark Selected Button 
“Unmark Selected”. Deselects the checkbox of the highlighted row. 

Print List Button 
“Print List". Selects the Print List button.  

OK Button 
“OK". Selects the OK button. 

Result Entry Functionality 
All Result Entry functionality within this section is the same as previously described and will not be 
repeated. Please refer to Case Results Section for details. 
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Sign Out by Case 

From the Main menu, “Sign Out by Case" launches the Sign Out by Case Search Screen. 

 
Case Number Field 

"Case number". Selects the Case Number field. Case number may be entered using voice 
dictation. 
Case Number Field Lookup 

"Lookup for". Launches Accession Sequences Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the 
Accession Sequences Lookup browser window. Follow with the command "OK" to 
select code and close Accession Sequences Lookup browser window. Dictate 
remainder of accession sequence. 

Sign Out ID Field 
"Sign Out ID". Selects the Sign Out ID field. Sign Out ID may be entered using voice 
dictation. 
Sign Out ID Field Lookup 

"Lookup for". Launches Person Can Sign Out Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the Person 
Can Sign Out Lookup browser window. Follow with the command "OK" to select 
code and close Person Can Sign Out Lookup browser window. 
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Pathologist ID Field 
"Pathologist ID". Selects the Pathologist ID field. Pathologist ID may be entered using voice 
dictation. 
Pathologist ID Field Lookup 

"Lookup for". Launches Pathologist Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the 
Pathologist Lookup browser window. Follow with the command "OK" to select code 
and close Pathologist Lookup browser window. 

Requesting Doctor Field 
"Requesting Doctor". Selects the  Requesting Doctor field. Requesting Doctor ID may be 
entered using voice dictation. 
Requesting Doctor Field Lookup 

"Lookup for". Launches Requesting Doctor Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the 
Requesting Doctor Lookup browser window. Follow with the command "OK" to 
select code and close Requesting Doctor Lookup browser window. 

Last Name Field 
"Last name". Selects the Last Name field. Last name may be entered using voice dictation. 

First Name Field 
"First name". Selects the First Name field. First name may be entered using voice dictation. 

MRN Field 
"Medical record number". Selects the Medical Record Number field. MRN may be entered 
using voice dictation. 
MRN Field Lookup 

"Lookup for". Launches Patient Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the Patient 
Lookup browser window. Follow with the command "OK" to select code and close 
Patient Lookup browser window. 

Clinic Field 
"Clinic". Selects the Clinic field. Clinic ID may be entered using voice dictation. 
Clinic Field Lookup 

"Lookup for". Launches Clinic Code Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the Clinic 
Code Lookup browser window. Follow with the command "OK" to select code and 
close Clinic Code Lookup browser window. 

Billing Number Field 
"Billing number". Selects the Billing Number field. Enter billing number using voice 
dictation. 

Find Button 
"Find". Selects the Find button.  
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Clear Button 
"Clear". Selects the Clear button. 

Cancel Button 
"Cancel". Selects the Cancel button. 

Cases List Navigation 
Case Selection 

"Select [row number]”. Selects the row number of interest. 

 
Mark All Button 

"Mark All". Selects the Mark All button. 
Mark Selected Button 

"Mark Selected”. Selects the Mark Selected button. 
Unmark All Button 

"Unmark All". Selects the Unmark All button. 
Unmark Selected Button 

"Unmark Selected". Selects the Unmark Selected button. 
RTF Editor Button 

"RTF Editor". Selects the RTF Editor button; all selected cases will be loaded into the RTF 
Editor for Sign Out. 

Word Editor Button 
"Word Editor". Selects the Word Editor button; all selected cases will be loaded into the 
Word Editor for Sign Out. 

OK Button 
"OK". Selects the OK button; all selected cases will be loaded into the Word Editor for Sign 
Out. 
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Sign Out Functions 
Document Editing 

The system provides the ability to edit the document using voice dictation functions using 
the same functionality as previously described: 

Dictation into MS Word Editor 
The system provides the ability to select Sections, Navigate, and Dictate into MS Word. All voice 
functionality within this section is the same as previously described and will not be repeated. Please 
refer to Final Report Section for details. 

Dictation into RTF Editor 
The system provides the ability to dictate into the RTF Editor. All Section selection, Navigation, and 
Dictation techniques are identical with commands for Dictation into MS Word Editor. Please refer to 
Final Report Section for details. 

 
Sign/Done By Field 

“Done By”. Selects the Sign/Done By field. 
Sign/Done By Field Lookup 

"Lookup for". Launches Person Can Sign Out Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the Person 
Can Sign Out Lookup browser window. Follow with the command "OK" to select 
code and close Person Can Sign Out Lookup browser window. 

Pathologist Field 
"Pathologist". Selects the Pathologist field. 
Pathologist Field Lookup 

"Lookup for". Launch Pathologist Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the 
Pathologist Lookup browser window. Follow with the command "OK" to select code 
and close Pathologist Lookup browser window 

Residents Button 
"Resident". Selects the Residents button. 
Lookup for Resident Field 

"Lookup for". Launches the Resident browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the Resident 
Lookup browser window. Follow with the command "OK" to select Resident code 
and close Resident Lookup browser window. 
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Release Case Checkbox 
"Release Case". Selects the Release Case checkbox. 

Dx Category Field 
"Category”. Select the Dx Category field. 
Lookup for Dx Category Field 

"Lookup for". Launches the Diagnosis Category Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the 
Diagnosis Category Lookup browser window. Follow with the command "OK" to 
select Resident code and close Diagnosis Category Lookup browser window. 

Add Code Button 
“Add Code". Selects the Add Code button.  

Delete Code Button 
"Delete Code". Selects the Delete Code button 

Dx Find 
"Dx Find". Selects the Dx Find button. 

More Button 
"More". Selects the More button. This functionality is the same as previously described. 
Please see Final Diagnosis Tab section for more details 

Order Stains/Slides Button 
"Order Stains Slides". Selects the Order Stains/Slides button. All voice functionality within 
this option is the same as previously described and will not be repeated. Please refer to Final 
Report Section for details. 

Sign Out Button 
"Sign Out". Selects the Sign Out button. 

Cancel Button  
"Cancel". Selects the Cancel button. 
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My Sign Out Worklist  

From the Main Menu,  "My Sign Out Worklist" launches the My Sign Out Worklist Search Screen. 

 
Sign Out ID Field 

The system shall have the ability to automatically drop in the logged in Pathologist ID or 
change it as previously defined. 

Case Types Field 
The system shall have the ability to select the Case Types field with the phrase "Case Types" 
Select Case Types 

The system shall have the ability to display the available case types by using the 
command "expand" 

Accession Group Field 
The system shall have the ability to specify accession group by using the phrase "Accession 
Group [ XX ]"  
Search 

The system shall have the ability to invoke the search screen for the Accession 
Group field by using the command "Lookup for" 

Only Completed Cases Checkbox 
"Only completed cases". Selects the Only Completed Cases checkbox. 

Find Button 
"Find". Selects the Find button. 

Clear Button 
"Clear". Selects the Clear button. 

Cancel Button 
"Cancel". Selects the Cancel button. 
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Sign Out Functions 
Document Editing 

The system provides the ability to edit the document using voice dictation functions using 
the same functionality as previously described: 

Dictation into MS Word Editor 
The system provides the ability to select Sections, Navigate, and Dictate into MS Word. All voice 
functionality within this section is the same as previously described and will not be repeated. Please 
refer to Final Report Section for details. 

Dictation into RTF Editor 
The system provides the ability to dictate into the RTF Editor. All Section selection, Navigation, and 
Dictation techniques are identical with commands for Dictation into MS Word Editor. Please refer to 
Final Report Section for details. 

 
Sign/Done By Field 

“Done By”. Selects the Sign/Done By field. 
Sign/Done By Field Lookup 

"Lookup for". Launches Person Can Sign Out Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the Person 
Can Sign Out Lookup browser window. Follow with the command "OK" to select 
code and close Person Can Sign Out Lookup browser window. 

Pathologist Field 
"Pathologist". Selects the Pathologist field. 
Pathologist Field Lookup 

"Lookup for". Launch Pathologist Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the 
Pathologist Lookup browser window. Follow with the command "OK" to select code 
and close Pathologist Lookup browser window 

Residents Button 
"Resident". Selects the Residents button. 
Lookup for Resident Field 

"Lookup for". Launches the Resident browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the Resident 
Lookup browser window. Follow with the command "OK" to select Resident code 
and close Resident Lookup browser window. 
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Release Case Checkbox 
"Release Case". Selects the Release Case checkbox. 

Dx Category Field 
"Category”. Select the Dx Category field. 
Lookup for Dx Category Field 

"Lookup for". Launches the Diagnosis Category Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the 
Diagnosis Category Lookup browser window. Follow with the command "OK" to 
select Resident code and close Diagnosis Category Lookup browser window. 

Add Code Button 
“Add Code". Selects the Add Code button.  

Delete Code Button 
"Delete Code". Selects the Delete Code button 

Dx Find 
"Dx Find". Selects the Dx Find button. 

More Button 
"More". Selects the More button. This functionality is the same as previously described. 
Please see Final Diagnosis Tab section for more details 

Order Stains/Slides Button 
"Order Stains Slides". Selects the Order Stains/Slides button. All voice functionality within 
this option is the same as previously described and will not be repeated. Please refer to Final 
Report Section for details. 

Sign Out Button 
"Sign Out". Selects the Sign Out button. 

Cancel Button  
"Cancel". Selects the Cancel button. 
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Sign Out by Case Range 

From the Main Menu, “Sign Out by Case” launches the Sign Out by Case Search Screen. 
“Sign Out by Case Range”. Selects the Sign Out by Case Range Search Screen. 

 
Ordered From Date Field 

"Ordered From". Selects the Ordered From Date field. Enter a date using voice dictation. 
Lookup for Date Field 

"Lookup for". Launches the Date browser window. 
Browser Selection 

"Left", “Right”, “Up”, “Down”. Moves the active date field in the date grid.  
“Enter”. Selects active date field in the date grid and closes Date Browser window. 

Ordered To Date Field 
"Ordered To". Selects the Ordered To Date field. Enter a date using voice dictation. 
Lookup for Date Field 

"Lookup for". Launches the Date browser window. 
Browser Selection 

"Left", “Right”, “Up”, “Down”. Moves the active date field in the date grid.  
“Enter”. Selects active date field in the date grid and closes Date Browser window. 
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Case Range From Field 
"Case range from". Selects the Case Range From field. Enter a case number using voice 
dictation. 
Lookup for Case Range From Field 

"Lookup for". Launches the Accession Sequences Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the 
Accession Sequences Lookup browser window. Follow with the command "OK" to 
select Accession Sequences code and close Accession Sequences Lookup browser 
window. 

Case Range To 
"Case range to". Selects the Case Range From field. Enter a case number using voice 
dictation. 
Lookup for Case Range To Field 

"Lookup for". Launches the Accession Sequences Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the 
Accession Sequences Lookup browser window. Follow with the command "OK" to 
select Accession Sequences code and close Accession Sequences Lookup browser 
window. 

Priority Field 
"Priority". Selects the Priority field. 
Priority Field Expansion 

"Expand". Expands the Priority drop-down list. 
Priority Field Selection 

"[Name]". Selects an item from the Priority drop-down list 
Source Field 

"Source". Selects the Source field. 
Lookup for Source Field 

"Lookup for". Launches the Source Codes browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the Source 
Codes browser window. Follow with the command "OK" to select Source code and 
close Source Codes browser window. 

Only Completed Cases Checkbox 
"Only completed cases". Selects the Only Completed Cases checkbox. 

With Frozen Section Checkbox 
"With frozen section". Selects the With Frozen Section checkbox. 

With Cell Blocks Checkbox 
"With cell blocks". Selects the With Cell Blocks checkbox. 
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With Special Stain/Test Field 
"Special Stains Tests". Selects the With Special Stain/Test field. 
Lookup for Special Stain/Test Field 

"Lookup for". Launches the Special Stains/Test/Stain Panels Lookup browser 
window. 

Browser Selection 
"Select [number]". Selects the number of the row of the desired code in the Special 
Stains/Test/Stain Panels Lookup browser window. Follow with the command "OK" 
to select code and close Special Stains/Test/Stain Panels Lookup browser window. 

Case Types Field 
"Case types". Selects the Case Types field. 
Case Types Field Expansion 

"Expand". Expands the Case Types drop-down list. 
Case Types Field Selection 

"[Name]". Selects an item from the Case Types drop-down list 
Find Button 

"Find". Selects the Find button. 
Clear Button 

"Clear". Selects the Clear button. 
Cancel Button 

"Cancel". Selects the Cancel button. 

Sign Out Functions 
Document Editing 

The system provides the ability to edit the document using voice dictation functions using 
the same functionality as previously described: 

Dictation into MS Word Editor 
The system provides the ability to select Sections, Navigate, and Dictate into MS Word. All voice 
functionality within this section is the same as previously described and will not be repeated. Please 
refer to Final Report Section for details. 

Dictation into RTF Editor 
The system provides the ability to dictate into the RTF Editor. All Section selection, Navigation, and 
Dictation techniques are identical with commands for Dictation into MS Word Editor. Please refer to 
Final Report Section for details. 
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Sign/Done By Field 

“Done By”. Selects the Sign/Done By field. 
Sign/Done By Field Lookup 

"Lookup for". Launches Person Can Sign Out Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the Person 
Can Sign Out Lookup browser window. Follow with the command "OK" to select 
code and close Person Can Sign Out Lookup browser window. 

Pathologist Field 
"Pathologist". Selects the Pathologist field. 
Pathologist Field Lookup 

"Lookup for". Launch Pathologist Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the 
Pathologist Lookup browser window. Follow with the command "OK" to select code 
and close Pathologist Lookup browser window 

Residents Button 
"Resident". Selects the Residents button. 
Lookup for Resident Field 

"Lookup for". Launches the Resident browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the Resident 
Lookup browser window. Follow with the command "OK" to select Resident code 
and close Resident Lookup browser window. 

Release Case Checkbox 
"Release Case". Selects the Release Case checkbox. 

Dx Category Field 
"Category”. Selects the Dx Category field. 
Lookup for Dx Category Field 

"Lookup for". Launches the Diagnosis Category Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the 
Diagnosis Category Lookup browser window. Follow with the command "OK" to 
select Resident code and close Diagnosis Category Lookup browser window. 

Add Code Button 
“Add Code". Selects the Add Code button.  

Delete Code Button 
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"Delete Code". Selects the Delete Code button 
Dx Find 

"Dx Find". Selects the Dx Find button. 
More Button 

"More". Selects the More button. This functionality is the same as previously described. 
Please see Final Diagnosis Tab section for more details 

Order Stains/Slides Button 
"Order Stains Slides". Selects the Order Stains/Slides button. All voice functionality within 
this option is the same as previously described and will not be repeated. Please refer to Final 
Report Section for details. 

Sign Out Button 
"Sign Out". Selects the Sign Out button. 

Cancel Button  
"Cancel". Selects the Cancel button. 
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Results Query 

From the Main Menu, "Results Query" launches the Results Query Simple Search Screen. 

 
Case Number Field 

"Case number". Selects the Case Number field. Case number may be entered using voice 
dictation. 
Case Number Field Lookup 

"Lookup for". Launches Accession Sequences Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the 
Accession Sequences Lookup browser window. Follow with the command "OK" to 
select code and close Accession Sequences Lookup browser window. Dictate 
remainder of accession sequence. 

MRN Field 
"Medical record number". Selects the Medical Record Number field. MRN may be entered 
using voice dictation. 
MRN Field Lookup 

"Lookup for". Launches Patient Lookup browser window. 
Browser Selection 

"Select [number]". Selects the number of the row of the desired code in the Patient 
Lookup browser window. Follow with the command "OK" to select code and close 
Patient Lookup browser window. 

Last Name Field 
“Last name”. Selects the Last Name field. Enter a First Name using voice dictation. 

 



SoftPath v.4.2.1 User Manual Appendix G - Voice Integration Commands - Navigation  
 and Dictation Glossary  

PATH4.2-G-U (6th Ed, Rel. 1/31/07)  Page G-117 

First Name Field 
"First name". Selects the First Name field. Enter a Last Name using voice dictation. 

Billing Number Field 
"Billing number". Selects the Billing Number field. Enter billing number using voice 
dictation. 

Sign Out Field 
"Unsigned". Selects the Unsigned item in the Sign Out field.  
"Signed out". Selects the Signed Out item in the Sign Out field. 

Find Button 
"Find". Selects the Find button. 

Clear Button 
"Clear". Selects the Clear button. 

Cancel Button 
"Cancel". Selects the Cancel button. 

Query Screen Tab Selection 
The system allows for selection of the Query Result tabs using voice recognition. 

 
Case Description Tab 

"Case Description". Selects the Case Description tab. 
Case Data Tab 

"Case Data". Selects the Case Data tab. 
Specimens Tab 

"Specimens". Selects the Specimens tab. 
Patient Tab 

"Patient". Selects the Patient tab. 
Risk Factors Tab 

"Risk Factors". Selects the Risk Factors tab. 
Calls Tab 

"Calls". Selects the Calls tab. 
Letters Tab 

"Letters". 
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Undergo QA Tab 
"Undergo QA". Selects the Undergo QA tab. 

Adequacy/Problems Tab 
"Adequacy Problems". Selects the Adequacy/Problems tab. 

Other Case Data Tab 
"Other Case Data". Selects the Other Case Data tab. 

Consultations Tab 
"Consultations". Selects the Consultations tab. 

Patient History Tab 
"Patient History". Selects the Patient History tab. 

Billing Part A Tab 
"Billing Part A". Selects the Billing Part A tab. 

Billing Part B Tab 
"Billing Part B". Selects the Billing Part B tab. 

Processing History Tab 
"Processing History". Selects the Processing History tab. 

Outgoing Consultation Tab 
"Outgoing Consultation" 

Reports Tab 
"Reports". Selects the Reports Tab. 
Report Selection 

"Select [row number]”. Selects the row number of interest. 
Mark Selected 

"Mark Selected”. Marks the checkbox of the selected row of interest. 
View Button 

"View". Selects the View button. 
Print Button 

"Print". Selects the Print button. 
Diagnosis Tab 

"Diagnosis". Selects the Diagnosis tab. 
Incoming Consultation Tab 

"Incoming Consultation". Selects the Incoming Consultation tab. 
GYN Info Tab 

"G Y N Info". Selects the GYN Info tab. Dictate each letter in GYN, e.g. “G. Y. N. Info”. 
MED Info Tab 

"Med Info". Selects the MED Info tab. 
Organs/Bones Tab 

"Organs Bones". Selects the Organs/Bones tab. 
Age Info/Body Tab 

"Age Info Body". Selects the Age Info/Body tab. 
Autopsy Info Tab 
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"Autopsy Info". Selects the Autopsy Info tab. 
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Common Directions 

The system has the ability to use specific commands through voice recognition throughout the 
system. 
Yes 

"Yes". Selects the answer Yes in a message prompt. 
No 

"No". Selects the answer No in a message prompt. 
OK  

"OK". Selects the answer OK in a message prompt. 
Enter 

"Enter". Selects the Enter key on the keyboard. 
Save  

"Save". Saves data or actions where applicable. 
Cancel 

"Cancel". The system shall have the ability to cancel any process with the phrase 
Close window 

"Close window". Closes the current active window. 
Search Screen 

"Lookup for". Selects the Lookup for ellipse button for fields provided with this 
functionality. 

Navigation Within Lookup Browsers 
The system has the ability to navigate the cursor with the following commands: "Move Up", 
"Move Down", "Move left", "Move right", "Page Up", Page Down", "Tab forward", "Tab 
backward",  "First entry", and "Last entry" 

Next 
"Next". Selects the Next button within list grid displays. 

Previous 
"Previous". Selects the Previous button within list grid displays. 

Find 
"Find". Initiates a search from a search screen with current search criteria. 

Print 
"Print". Selects the Print button. 
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Number Field Commands 

Dictate Number Values 
The system provides the ability to enter a numeric value in a numeric field by dictating the value to 
be entered. 
Add to a Current Value 

"Add [number]". Adds the dictated value to the current numeric value. 
Add One 

"Add One". Increases current numeric value by one. 
Add Two 

"Add Two". Increases current numeric value by two. 
Add Three 

"Add Three". Increases current numeric value by three. 
Add Four 

"Add Four". Increases current numeric value by four. 
Add Five 

"Add Five". Increases current numeric value by five. 
Add Six 

"Add Six". Increases current numeric value by six. 
Add Seven 

"Add Seven". Increases current numeric value by seven. 
Add Eight 

"Add Eight". Increases current numeric value by eight. 
Add Nine 

"Add Nine". Increases current numeric value by nine. 
Add Ten 

"Add Ten". Increases current numeric value by ten. 

Subtract from a Current Value 
"Subtract [number]". Subtracts the dictated value from the current numeric value. 
Subtract One 

"Subtract One". Decreases current numeric value by one. 
Subtract Two 

"Subtract Two". Decreases current numeric value by two. 
Subtract Three 

"Subtract Three". Decreases current numeric value by three. 
Subtract Four 

"Subtract Four". Decreases current numeric value by four. 
Subtract Five 

"Subtract Five". Decreases current numeric value by five. 
Subtract Six 

"Subtract Six". Decreases current numeric value by six. 
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Subtract Seven 
"Subtract Seven". Decreases current numeric value by seven. 

Subtract Eight 
"Subtract Eight" Decreases current numeric value by eight. 

Subtract Nine 
"Subtract Nine". Decreases current numeric value by nine. 

Subtract Ten 
"Subtract Ten". Decreases current numeric value by ten. 
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Dragon 7 Voice Dictation Installation and Training Guide 

System Notes: 
 

 Dragon 7 Naturally Speaking installed on each dictation station (PC) 
 Noise canceling headset  
 SoftPath IV installed thick client (not metaframe) on each dictation station (PC) 
 PC Requirements (End of guide) 

Installation 
 

1. Insert the installation media into the CD Rom drive of the workstation and initiate setup 
routine. 

2. Select Next. 

 
3. Select Yes. 

 



Appendix G - Voice Integration Commands – Navigation  SoftPath v.4.2.1 User Manual 
 and Dictation Glossary   

Page G-126  PATH4.2-G-U (6th Ed, Rel. 1/31/07) 

4. Enter information and serial number and select Next. 

 
5. Select Next. 

 
6. Select Typical Installation and select Next. 
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7. Select Yes; installation will proceed. 

 
8. When installation is complete, select the Finish button. Do not select Enable Quick Start. 

 
Please confirm at this time that you have the most up to date version of Dragon software. 
You may check to see if there have been any updates or service packs released at ScanSoft’s 
website, http://www.scansoft.com. 
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Voice Training 
Each user that will utilize voice functionality on the workstation must create a user profile and train 
Dragon 7 in order for voice functionality to operate accurately. Voice training takes about 20 
minutes to complete. If an individual user needs voice functionality on multiple workstations, an 
individual’s voice profile must be stored on each workstation to be utilized. It is possible to export 
the user profile created on the first workstation to a network share and propagate this profile to 
additional workstations as needed for ease of deployment. 

User Profile Setup 
1. Select the Dragon Icon to launch the program. 

 
2. The first time Dragon launches, the New User Wizard window displays. Select the Your 

Name field, and enter a user name using the following format: <XXX-default>, where XXX 
is the user’s login code to SoftPath. This allows SoftPath to identify and load the correct 
Dragon user profile when a specific user logs into the SoftPath application. For the 
Language field, select U.S. English; for Dictation source, select Microphone plugged into 
Mic-In jack; for Vocabulary, select Pathology. Select Next. 

 
To set up a user profile from the Dragon Toolbar (after the first time Dragon launches), 
select the Naturally Speaking button on the Toolbar, select the Manage Users menu item. 
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Select the New button. This launches the New User Wizard. 

 
3. Set microphone position and select Next. 
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4. Select Start Volume Check and read indicated text. 

 
5. After Volume Check is complete, select Next. 

 
6. Select Start Quality Check and read indicated text. 
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7. After Quality Check has successfully passed, select Next. 

 
8. Select Go and follow the prompts in reading aloud. 

 
9. Select an excerpt to read from. It is recommended to select Pathology Reports. 
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When training is complete, the system displays an acknowledgement prompt. Select OK to complete 
training. 
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Install SoftPath IV  
The next step is to have SoftPath IV installed on the PC in thick client mode. When installing 
SoftPath with Voice, the installer must choose Custom installation, and then select the Voice option 
from the components screen. Ensure that the user ID has access to voice dictation in the SoftSec 
module (Option 8910 – Voice Recognition Setup) Login with the required user ID and select Setup – 
Options – Voice Recognition.  Select User and Edit from the toolbar. 
Select the voice recognition system (Dragon) to be used from the drop down menu and save the 
changes.  Each time the selected user ID logs into the system the application will start the Dragon 
application for use. 
NOTE: Do not have Dragon 7 running on the desktop if you are planning to use Voice 

Dictation in SoftPath IV.  You must allow SoftPath to open Dragon if you wish to 
use the navigation capability of the system. 

 
Exit and login to the system with the user ID configured to use Dragon 
The system will open SoftPath and Dragon 7.  This will be indicated by the presence of a 
microphone in the status bar 
The microphone state is displayed via the microphone icon in the status bar.  Red indicates that the 
microphone is turned off.  Yellow indicates the microphone is “asleep”.  Green indicates that the 
microphone is awake and ready for command. 
Click on the microphone to access the Train Speech files option and verify that the default speech 
file is trained. 

 
The system will display the user file that has been loaded.  This will be the trained default based on 
the login ID 
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To add customized words to the trained vocabulary select the default speech file and click the 
Vocabulary Editor button 

 
Enter each word to be added in the written form field and click the Add button.  The system will add 
the word to the list and activate the Train button.   
Train the system to recognize the word or phrase by clicking the Train button and following the 
directions. 
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Performing Additional Training for Enhanced Recognition 
NOTE: The user must exit from the SoftPath application before opening Dragon from the 

desktop 
When the system is first set up the user performs a limited training.  To improve the accuracy of the 
word recognition load Dragon 7had been a from the desktop and perform additional training 
Select the Accuracy Center from the Dragon Tools menu 

 
Click the Perform Additional Training link form the displayed menu to continue the training process 
Follow the directions and read the text provided.  Additional training takes about 20 minutes. 

Installation of User Files on Multiple PC’s 
Once a Voice profile has been created and trained it may be propagated to multiple PC’s without 
requiring users to perform training on each PC they may utilize. 
To allow users to utilize Voice Recognition and Dragon at multiple PC’s you may use the 
Import/Export capability of Dragon. 
Select the Open/Manage Users option from the Naturally Speaking option of the Dragon toolbar. 
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Select the user profile to be copied and select Export.  Export the user file to a local network drive 
At the second PC, create the user profile, and import the user files from the network drive. 
This can be performed as often as needed to populate the available PC’s 

SoftPath 4.2 GUI and Dragon Naturally Speaking 7 Software and 
Hardware Requirements 

Hardware Requirements 
Clients have one option for deploying the SoftPath v4.2 GUI application in conjunction with 
ScanSoft’s Dragon Naturally Speaking 7: 
“Thick” client, where local workstations run the software directly and connect to a UNIX 
server (backend) 

Hardware/Software Matrix 
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 Parameter Minimum Recommended 
Machine OLTP  (online transaction 
processing)  5 20-200 

Processor, # of processors  1 4 
RAM 512 MB RAM 2-6 Gb RAM 

SERVER 
 
(Backend) 

Disk space (without database) 2 Gb 3 Gb 
Processor Frequency PIII 500MHz P4 2.0MHz* 
RAM 256 MB RAM 512 MB RAM* 
Monitor Size 17 inch 17 inch 

space required to 
install the product files 60 MB 100 MB 

space required to 
download the product 
distribution package 

50 MB 60 MB 

space required for 
data, trace and 
temporary files 

190 MB 540 MB 

Client 
Workstation 
 
(Frontend) 

Disk Space  
(single user 
environment) 

Total disk space (per 
environment) 300 MB 700 MB* 

Processor Frequency PIII 500MHz PIII 800MHz 
RAM 256 MB RAM 512 MB RAM 
Monitor Size 17 inch 17 inch 

space required to 
install the product files 60 MB 100 MB 

space required to 
download the product 
distribution package 

50 MB 60 MB 

space required for 
data, trace and 
temporary files 

300 MB 500 MB 

PrintServer 
Client 
(Frontend) 

Disk Space  
(one 
environment) 

Total disk space (per 
environment) 310 MB 660 MB 

• Tested and approved by SCC Product Development. 
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Appendix H – PatAdmin 

The PatAdmin module is available from a separate desktop icon and access to the module is 
controlled through the SoftSec application. 
The PatAdmin (SoftPath Administrator Program) utility is used to convert MS Word documents 
into RTF format, MS Word templates to Text Control format, unlock documents, distribute 
macros and signatures, enable document sections and subsections for use with the RTF Editor, edit 
the setup for Complex Data Templates, edit code descriptions within the RffData and Simple Codes 
files, update the ODBC Reports file, unlock an accession sequence, and view Hosparam settings. 
Users can be given access to this system and limited options within the system, but this feature 
should only be used by the system administrator and trusted users. The PatAdmin main user interface 
displays similar to Figure H-1. 

 
Figure H-1. PatAdmin Main User Interface 
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File 
The File menu is used to setup a printer, open a recent file, or exit the PatAdmin program. 

View 
The View menu is used to toggle the Toolbar, Status Bar, and PatAdmin Bar from view. The 
PatAdmin Bar contains access to many of the same features available through the PatAdmin menus. 

Conversion 
The Conversion menu allows the user to access the RTF Conversion option. 

RTF Conversion 
RTF Conversion converts all unsigned reports and templates from MS Word storage 
documents (.DOC) to .RTF format.  
NOTE: Access to this option is limited to the login ID SCC. 
NOTE: This option needs to be run when upgrading versions 3.17.x, 4.1.x, or 4.2.0 to 

version 4.2.1.x or higher. 
To access the Convert RTF option, select Conversion > RTF Conversion and the Convert 
to RTF Window (Figure H-2) is displayed.  
To convert files, click the Convert to RTF button ( ). The following file types 
will be converted: Report, Letter, Worksheet, Signature, Banner, and ABN Form Templates, 
and Edited Letter and Unsigned Report documents. When the conversion is completed, a list 
of all of the templates that could not be converted and the reason why is displayed. 
NOTE: MS Word must be installed on the PC where this option is used. 

 
Figure H-2. Convert To RTF Window 

Documents 
The Documents menu allows the user to access the Unlock Documents, Macro Distribution, 
Signature Distribution, Rewrite Sections, and Complex Data Template Setup options. 

Unlock Documents 
The Unlock Documents option unlocks any locked report documents.  
To access the Unlock Documents feature, select Documents > Unlock Documents and the 
Unlock Documents window (Figure H-3) is displayed. Documents that users are actively 
working on are displayed on this list. 
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Figure H-3. Unlock Documents Window 

Case  
Displays the case number of the locked document. 

Report  
Displays the report type that has been locked. 

Client Name 
Displays the User ID of the user that has locked the document. 

PC Name/IP Address 
Displays the PC name (if available) or the IP Address of the machine on which the 
report was locked. 

Lock Status 
Displays the lock status. 

Unlock Document   
Click the Unlock button to unlock the selected document. The grid updates the lock 
status once the document is unlocked 

Refresh  
Click the Refresh button to refresh the locked documents grid. 

Macro Distribution 
The Macro Distribution option distributes the customized PatClient.dot file to the RISC 
box for use by other users. 
NOTE: Access to this option is limited to the login ID SCC. 
WARNING: Only select the PatClient.doc document for distribution.  
To access this option, select Documents > Macro Distribution. The Macro Distribution 
window (Figure H- 4) is displayed.  
NOTE: For versions 4.2.1.x and higher, most macros are stored as *.rtf files instead of 

*.dot files. SoftLab and SoftMic files are still stored as *.dot files. 
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Figure H- 4. Macro Distribution Window 

Location 
Enter the location of the customized PatClient.dot file. Use the Browse button 
( ) to search for the location of the file. 

Export Template  
Click the Export Template button to distribute the selected PatClient.dot file to the 
RISC box for use by all users. 

Restore Previous  
Click the Restore Previous button to restore the previous version of the 
PatClient.dot file to the RISC box, if a previous version exists. 

Signature Distribution 
The Signature Distribution option distributes the client signature picture files to the RISC 
box for use by all users.  This option is designated for Client Service Representatives and 
Implementers who create a client’s setup files and templates. 
NOTE: Access to this option is limited to the login ID SCC. 
To access this option, select Documents > Signature Distribution. The Signature 
Distribution window (Figure H-5) is displayed. 

 
Figure H-5. Signature Distribution Window 

Location 
Enter the location of the signature picture file. Click the Browse button ( ) to 
search for the location of the file. 

Doctor ID 
Enter the Personnel ID code that should be associated with the signature file. Click 
the Browse button ( ) to search for the Personnel ID. 

Export  
Click the Export button to distribute the signature picture file to the RISC box. 
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Rewrite Sections 
The Rewrite Sections option enables document sections and subsections for use with the 
RTF Editor.  
NOTE: Access to this option is limited to the login ID SCC. 
NOTE: This installation procedure is required during the upgrade from 3.17.x versions 

to 4.x versions. 
To access this option, select Documents > Rewrite Sections. The Rewrite Sections window 
(Figure H-5) is displayed. 

 
Figure H-6. Rewrite Section Window 

Click the Rewrite Sections button ( ) to enable users to use the existing 
document sections and subsection in the RTF Editor for editing Result Reports in Result 
Entry, QA, and Sign Out Entry.  

Complex Data Template Setup 
The Complex Data Template Setup option allows the user to edit the Complex Data 
Templates setup, which provides the ability to replace Word macros in the SoftPath system. 
NOTE: Access to this option is limited to the login ID SCC. 
To access this option, select Documents > Complex Data Template Setup. The Macro 
Template window (Figure H-7) is displayed. 

 
Figure H-7. Macro Template Window 

The Macro Template window allows the user to edit standard generic macros and save 
updated macros as custom macros.  
Macro Type 

Displays the level of the selected Macro. This field is READ ONLY. 
Macro Name 

Displays the name of the Macro to be edited. This field is READ ONLY. 
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Browser  
Click the browser button to open the Macro Browser window (Figure H-8). The 
Macro Browser window displays both client and generic macros. 

 
Figure H-8. Macro Browser Window 

Macro Name 
Displays the name of the select macro to edit in the Add Macro window. 
This field is READ ONLY. 

Add Macro  
Click the Add Macro button to display the Add Macro window (Figure H- 
9), which allows the user to select an existing macro to add to the selected 
level. Select a macro from the dropdown list and click OK to confirm the 
selection. Click Cancel to exit without adding a macro. 

 
Figure H- 9. Add Macro Window 

Custom macros can be added at any level in the tree grid. For instance, 
adding a custom macro at the Result level for “List of Sources & Body 
Sites” will be available for all Results Reports in all Case Types in All 
Accession Sequences. Additionally, macros can be added to a specific 
accession sequence. 
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Macro Browser Grid 
Displays all macros that exist in the system both the generic and client 
specific. Click the plus or minus signs to expand or contract the tree grid 
lists. All existing Macros are listed under the Generic Root item and are 
READ ONLY.  
The editable macros are arranged in the following order: 

 

 Letter 
 Result 
 Worklist 

• Autopsy 
• GYN Cytology 
• MED Cytology 
• Surgical 
 <Accession 

Sequence> 

Find  
Click the Find button to read and refresh the entire macro structure of the 
system. 

Delete Macro 
Click the Delete Macro button to delete any previously saved custom level 
Client macro. A message displays asking for confirmation to delete the 
macro; click Yes to delete the macro or No to exit without deleting. 
NOTE: This button is inactive when a generic level macro is selected.  

OK   
Click OK to associate the selected Client Macro Level with a specific macro 
to edit. 

Cancel  
Click Cancel to return to the Macro Template window. 

Edit Macro  
Click the Edit Macro button to edit the selected macro, associate it with the selected 
level, and open the Word Macro Template Editor window (Figure H-10). The 
Word Template Editor allows the user to edit macros in the MS Word editing 
workspace, save edited macros for use in SoftPath as custom macros, and edit 
custom macros. 
NOTE:  If the Code or Macro section is not defined correctly, the report will not 

open and an error message will display.  
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Figure H-10. Word Macro Template Editor Window 

Define Sub-Macro  
Click the Define Sub-Macro button to create a new sub-macro. The Add 
Sub-Macro window (Figure H-11) will display. Enter a name in the Sub-
Macro Name field. Click OK to save the new sub-macro name and insert it 
in the position of the cursor in the Macro Template Editor window. Click 
Cancel to discard information entered in the window. 

 
Figure H-11. Add Sub-Macro window 

Go to Sub-Macro  
Select a sub-macro that has already been defined from the dropdown list and 
click the Go to Sub-Macro button to navigate to the selected sub-macro in 
the document.  

Define Fields  
Click the Define Fields button to display the Define Variable window, 
which allows the user to compose and save computational expressions that 
contain conditional values and can execute complex data processing 
functions available from the Insert Defined Fields button and the Macro 
Template window. 
Macro Name 

Displays the macro name. This field is READ ONLY. 
Variable Name 

Select a variable from a list of all previously saved variables. 



SoftPath v.4.2.1 User Manual Appendix H – PatAdmin  

PATH4.2-G-U (6th Ed, Rel. 1/31/07)  Page H-9 

Add New 
Click the Add New button to open the Add Variable window. 
Enter a name for the new variable in the free-text field. Maximum 
48 alphanumeric characters. Click OK to add the new variable or 
Cancel to exit without saving.  

Delete 
Click the Delete button to delete the variable currently selected in 
the Variable Name field.  

Insert Sub-Macro 
Select a sub-macro from the dropdown list and click the Insert Sub-
Macro button to insert the macro into either the Value if Condition 
Met or the Value if Condition Not Met field, based on cursor 
position. 
NOTE: This list contains all of the sub-macros defined with the 

Define Sub-Macro button. 
Insert Defined Field 

Select a variable from the dropdown list and click the Insert 
Defined Field button to insert the defined field into either the Value 
if Condition Met or the Value if Condition Not Met field, based 
on cursor position. 
NOTE: This list contains all of the system variable names 

defined with the Add New button from the Variable 
Name field. 

Insert Field 
Select a field from the dropdown list and click the Insert Field 
button to insert the field into either the Value if Condition Met or 
the Value if Condition Not Met field, based on cursor position. 
NOTE: This list contains all of the system field names 

associated with the macro as defined in the Macro 
Name field.  

Condition 
Create or edit conditional complex data statement, which includes 
DocVariables, decimal and text constants, and Boolean expressions. 
Maximum 256 alphanumeric characters.  Use the Defined Field 
button, the Insert Field button, or the Insert Sub-Macro button for 
further input. 

Value if Condition Met 
Define the value of the result of the expression if the condition in 
the Condition field is met. Maximum 256 alphanumeric 
characters.  Use the Defined Field button or the Insert Field 
button for further input. 

Value if Condition Not Met 
Define the value of the result of the expression if the condition in 
the Condition field is NOT met. Maximum 256 alphanumeric 
characters.  Use the Defined Field button or the Insert Field 
button for further input. 
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Test 
Click the test button to verify the syntax consistency of the 
conditional statement defined in the Condition, Value if Condition 
is Met, and Value of the Condition is Not Met fields. The system 
prompts with a message that verifies the syntax consistency if 
passed or message stating that it failed, the error type, and the 
position of the error if an error occurred.  

Cancel 
Click the Cancel button to discard all changes made in the Define 
Variable window and return to the Macro Template window.  

OK 
Click OK to save all changes made in the Define Variable window 
and return to the Macro Template window.  

Insert Defined Field  
Select a custom defined field variable from the dropdown list and click the 
Insert Defined Field button to insert the variable in the current cursor 
position. 

Insert Field  
Select one of the predefined data fields from the dropdown list and click the 
Insert Field button to insert the variable in the current cursor position. 
NOTE:  These fields are Macro specific. 

Insert Sub-Macro  
Select a defined macro from the dropdown list and click the Insert Sub-
Macro button to insert the sub-macro in the current cursor position. 
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Settings 
The Settings menu allows the user to access the Edit RffData option.  
NOTE: Access to this menu is limited to the login ID SCC. 

Edit RffData 
The Edit RffData option edits code descriptions within the RffData and Simple Codes files. 
This option is designated for use by Client Service Representatives and Implementers for 
updating and refreshing RffData in the database. 
NOTE: Access to this option is limited to the login ID SCC. 
To access this option, select Settings > Edit RffData. The Rff Data Window (Figure H-12) 
is displayed. 
 

 
Figure H-12. Rff Data Window 

Groups Display 
Displays a list of descriptions of all existing RffData groups, including Simple 
Codes. This is a READ ONLY field. 

Group Code 
Displays the database code for the selected group. This is a READ ONLY field. 

Code Type 
Displays the Code Type (char, numeric, or string) associated with the selected 
group. This is a READ ONLY field. 

Permissions 
Displays the available edit permissions for the selected group. This is a READ 
ONLY field.  
Add Addition of new codes is allowed. 
Edit Editing of existing codes is allowed. 
Delete Deletion of existing codes is allowed. 
Simple Code Available for display or edit in the Simple Codes setup file. 
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Default Codes from RffData.txt File Grid 
Displays the default codes and descriptions for the selected group, which are 
distributed in the RffData.txt file in SoftPath. These are READ ONLY fields. 

Codes from Database Grid 
Displays the current codes and descriptions available in the Setup Database for the 
selected group. 
NOTE: If any group is editable or the installation procedure was not performed 

properly, the codes or descriptions may be different than the default file. 
If needed, this can be corrected by pressing the Add or Reset buttons. 

Add  
Click the Add button to add a selected code from the RffData.txt file to the Setup 
Database. Only codes that are not currently exist in Setup will be added and the 
descriptions are not updated. 

Reset  
Click the Reset button to update all codes for the selected group in the Setup 
Database based on the RffData.txt file. 

ODBC 
The Settings menu allows the user to access the ODBC Upgrade option.  

ODBC Upgrade 
The ODBC Upgrade option updates the SoftPath ODBC Reports *.dbd file on the current 
PC from the most current version of the file available on the RISC box. 
NOTE: Access to this option is limited to the login ID SCC. 
To access this option, select ODBC > ODBC Upgrade. 

Setup 
The Setup menu contains the Case Unlock and Hosparam View options.  

Case Unlock 
The Case Unlock option allows the user to manually unlock an accession number. 
To access this option, select Setup > Case Unlock. The Case Unlock window (Figure H-13) 
is displayed. 
NOTE: This function is not dependent on the established time frame set in the 

RACC_REACT parameter.  

 
Figure H-13. Case Unlock Window 

Accession Number 
Enter the two-character year, accession sequence, and the case number to unlock. 
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Unlock  
Click the unlock button to unlock the locked case. 

Cancel  
Click the Cancel button to cancel the unlock request and return to the main menu. 

Hosparam View 
The Hosparam View option displays all Hosparam settings that have been defined in the 
$RPARAM file. This option is READ ONLY. 
To access this option, select Setup > Hosparam View. The Hosparam View window (Figure 
H-14) is displayed. 

 
Figure H-14. Hosparam View Window 

Help 
The Help menu contains information about the PatAdmin program. 
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Appendix I – SoftMedia 

NOTE: If you have purchased the SoftMedia software, please see the SoftMedia Guide for 
further information about using it with SoftPath. 

SoftPath can be used with SoftMedia in the following ways: 

 To access the Image Repository window, click the Image Repository button from toolbars in 
one of the following locations: 

• Specimen Registration ( ) 
• Processing ( ) 
• Result Entry ( ) 
• Results Query 
• Billing Entry 

 From Result Entry, click the One Touch Image Require button ( ) to automatically insert an 
image from a TWAIN device. The image will insert at the current cursor position and will 
automatically be added to the SoftMedia Image Repository.  

NOTE: After adding images with a TWAIN device, it is best if you go into SoftMedia 
and ensure that they have been labeled correctly and assign any placeholders or 
other necessary information. 
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